
Khi đọc qua tài liệu này, nếu phát hiện sai sót hoặc nội dung kém chất lượng 
xin hãy thông báo để chúng tôi sửa chữa hoặc thay thế bằng một tài liệu cùng 
chủ đề của tác giả khác. Tài liệu này bao gồm nhiều tài liệu nhỏ có cùng chủ 
đề bên trong nó. Phần nội dung bạn cần có thể nằm ở giữa hoặc ở cuối tài liệu 
này, hãy sử dụng chức năng Search để tìm chúng. 

Bạn có thể tham khảo nguồn tài liệu được dịch từ tiếng Anh tại đây:

http://mientayvn.com/Tai_lieu_da_dich.html

Thông tin liên hệ: 

Yahoo mail: thanhlam1910_2006@yahoo.com

Gmail: frbwrthes@gmail.com



Khi đọc qua tài liệu này, nếu phát hiện sai sót hoặc nội dung kém chất lượng 
xin hãy thông báo để chúng tôi sửa chữa hoặc thay thế bằng một tài liệu cùng 
chủ đề của tác giả khác. Tài liệu này bao gồm nhiều tài liệu nhỏ có cùng chủ 
đề bên trong nó. Phần nội dung bạn cần có thể nằm ở giữa hoặc ở cuối tài liệu 
này, hãy sử dụng chức năng Search để tìm chúng. 

Bạn có thể tham khảo nguồn tài liệu được dịch từ tiếng Anh tại đây:

http://mientayvn.com/Tai_lieu_da_dich.html

Thông tin liên hệ: 

Yahoo mail: thanhlam1910_2006@yahoo.com

Gmail: frbwrthes@gmail.com
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Chương 4 

Microsoft WORD 
Microsoft Word hay còn gọi là Winword, là một phần mềm trong bộ Microsoft Office 
của hãng phần mềm nổi tiếng Microsoft, chuyên dùng để soạn thảo các loại văn bản, sách 
vở, tạp chí ... phục vụ cho công tác văn phòng. Có thể liệt kê các đặc điểm nổi bật của 
phần mềm này như sau: 

 Cung cấp đầy đủ các kỹ năng soạn thảo và định dạng văn bản đa dạng và dễ sử dụng. 

 Khả năng đồ hoạ khá mạnh,  kết hợp với công nghệ OLE (Objects Linking and 
Embeding) bạn có thể chèn được nhiều hơn những gì ngoài hình ảnh và âm thanh lên 
tài liệu word như biểu đồ, bảng tính, ... 

 Có thể kết xuất, nhập dữ liệu dưới nhiều loại định dạng khác nhau. Đặc biệt khả năng 
chuyển đổi dữ liệu giữa Word với các phần mềm khác trong bộ Microsoft Office đã làm 
cho việc xử lý các ứng dụng văn phòng trở nên đơn giản và hiệu quả hơn. 

 Dễ dàng kết chuyển tài liệu thành dạng HTML để chia sẻ dữ liệu trên mạng nội bộ, 
cũng như mạng Internet. 

4.1. Các thao tác cơ bản  
1. Khởi động, thoát khỏi Winword  

 Khởi động Winword:  

Dùng lệnh Start |  All Programs |  Microsoft Office | MicrosoftWord. 

Ngoài cách khởi động trên, ta còn có thể khởi động Winword theo các cách sau: 

 Click biểu tượng Word  trên Destop. 
 Click biểu tượng Word  trên Start Menu. 

 Thoát khỏi Winword: Nên ghi lại tập tin soạn thảo trước khi thoát, nếu không 
Winword sẽ hỏi:  

 Chọn Yes nếu muốn ghi. 
 Chọn No nếu không muốn ghi. 
 Chọn Cancel nếu muốn hủy lệnh thoát. 

 

Các cách thoát : 
 Click nút Close  ở góc trên phải cửa sổ của Winword. 
 Dùng lệnh  File |  Exit. 
 Double click biểu tượng của chương trình ở góc trên trái màn hình. 
 Nhấn tổ hợp phím  Alt + F4. 
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2. Màn hình Winword 
 
 

 
 

 Title Bar (thanh tiêu đề): Thanh chứa tên của tập tin văn bản. 

 Menu Bar (thực đơn ngang): Thanh chứa các lệnh của Word, mỗi mục trên Menu 
Bar ứng với một Menu Popup (thực đơn dọc). Thao tác để mở một Menu Popup là 
click vào tên mục hoặc nhấn tổ hợp phím Alt + ký tự đại diện của tên mục.  

 Toolbars (các thanh công cụ): Các thanh công cụ chứa một số biểu tượng hoặc nút 
điều khiển thể hiện một số lệnh thông dụng. Muốn biết chức năng của một biểu tượng 
hay một nút điều khiển nào đó ta chỉ cần rà mũi tên chuột lên biểu tượng hay nút đó 
và chờ vài giây (nếu chưa có tính chất này thì ta dùng lệnh Tools | Customize | 
Options, chọn mục Show ScreenTips on Toolbars). Để hiển thị hay ẩn các thanh 
công cụ, ta dùng lệnh View | Toolbars,  sau đó click đánh dấu hoặc bỏ dấu check   
tại các mục tương ứng.  

- Standard (thanh công cụ chuẩn): chứa các biểu tượng, nút điều khiển thực hiện 
các chức năng thông dụng như ghi văn bản vào đĩa, mở văn bản, in văn bản .... 
Thay vì phải vào các menu để chọn lệnh, chỉ cần click biểu tượng hoặc nút điều 
khiển tương ứng. Chẳng hạn, muốn lưu văn bản đang soạn thảo lên đĩa, thay vì 
vào menu File chọn Save, chỉ cần click biểu tượng . 

 
- Formatting (thanh định dạng): chứa các biểu tượng, nút điều khiển dùng cho việc định 

dạng văn bản như loại font chữ, cỡ font, căn lề ... 

 
- Tables and Borders: chứa các công cụ để kẻ khung và thao tác trên bảng biểu. 

Title Bar Menu Bar Standard Toolbar Formatting Toolbar 

Status barDrawing Toolbar 
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- Drawing: chứa các công cụ để vẽ hình, tô màu ...  

 
 Ruler (thước): dùng để canh chỉnh lề  và định Tab cho văn bản. Để thay đổi đơn vị 
đo (Inches, Centimeters, Millimeters, Points, Picas), ta thực hiện lệnh Tools | 
Options | General, rồi vào hộp Measurement units để thay đổi. Thường chọn đơn vị 
là Centimeters hoặc Inchs. Ruler có thể tắt hay mở bằng lệnh View | Ruler. 

 Status Bar (thanh trạng thái): hiển thị tình trạng của cửa sổ hiện tại như số thứ tự 
trang hiện hành, tổng số trang, vị trí con trỏ (dòng, cột) ... Thanh này nằm ở dòng 
cuối cùng của cửa sổ. 

 Scroll Bar (thanh cuốn): dùng để di chuyển màn hình cửa sổ văn bản bằng chuột. 

- Thanh cuốn dọc (Vertical scroll bar) 

  

           

- Thanh cuốn ngang (Horizontal scroll bar): cách sử dụng như thanh cuốn dọc. 

3. Tạo mới, mở, lưu văn bản 
a. Tạo mới một văn bản: Để tạo mới một văn bản, ta có thể dùng các cách sau: 

Cách 1:    

 Dùng lệnh File | New. 
 Trong hộp thoại New, chọn biểu tượng Blank Document. 

Cách 2:  Click biểu tượng New Blank Document  trên thanh  Standard. 

Cách 3:  Nhấn tổ hợp phím Ctrl+N. 

b. Mở một văn bản đã có trên đĩa: Để mở một văn bản đã có trên đĩa, ta có thể tiến 
hành theo các bước sau: 

 Dùng lệnh File | Open (hoặc click biểu tượng  trên thanh Standard, hoặc nhấn 
tổ hợp phím Ctrl+O) để mở hộp thoại Open. 

Click để cuốn xuống 1 trang 

Click để cuốn lên 1 trang 

Click để kéo xuống từ từ

Click để cuốn lên từ từ

 Drag  di chuyển đến chỗ mong muốn 
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 Trong hộp thoại Open, chọn tên tập tin muốn mở. 

 Click nút Open hoặc gõ Enter. 

Lưu ý: Nếu ta không nhớ tên hay vị trí của tập tin muốn mở thì thực hiện như sau: 
• Nhập tên hay ký tự đại diện (?, *) vào khung File name. 
• Chọn tên ổ đĩa hay tên thư mục muốn tìm trong khung Look in. 
• Click nút Open hoặc gõ Enter. 

c. Lưu văn bản vào đĩa:  
Lưu với tên mới:  

 Dùng lệnh File | Save As. 

 Chọn thư mục lưu trong khung Save in, nhập tên mới trong khung File name và 
chọn dạng của tập tin để lưu trong khung Save as type. 

 Click nút Save hoặc gõ Enter. 

Lưu với tên cũ:  
Dùng lệnh File |  Save hoặc click biểu tượng , thao tác cũng có thể sử dụng khi lưu 
văn bản lần đầu tiên. 
Nếu tài liệu của bạn đã được ghi vào một tập tin, khi ra lệnh Save tất cả những sự 
thay đổi trên tài liệu sẽ được ghi lại lên đĩa. 

 
 

Bạn nên thực hiện thao tác ghi tài liệu thường xuyên trong khi soạn tài liệu, để tránh mất 
dữ liệu khi gặp các sự cố mất điện, hay những trục trặc của máy tính. 
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4. Các phím thường dùng khi soạn thảo: 

 Các loại con trỏ trên cửa sổ soạn thảo: 
• Con trỏ nhập văn bản có dạng “ | “ (vạch đứng) Khi gõ một ký tự trên bàn phím, 

ký tự sẽ được chèn vào chỗ con trỏ nhập. 
• Con trỏ chuột trong vùng văn bản có dạng “ I “ (dấu vạch đứng với hai dấu gạch 

ngang ở hai đầu). Muốn chuyển con trỏ nhập tới một vị trí mới trong văn bản để 
nhập, ta đưa con trỏ chuột đến vị trí mới và click chuột.      

 Di chuyển con trỏ (cursor) bàn phím:  
 →     : qua phải một ký tự. 

 ←     : qua trái một ký tự. 

       ↓       : xuống một dòng. 

       ↑       : lên một dòng. 

Ctrl + →     : qua phải một từ.  
Ctrl + ←    : qua trái một từ.             

Home     : về đầu dòng. 
End    : đến cuối dòng. 
Ctrl + Home : về đầu văn bản. 
Ctrl + End    : đến cuối văn bản. 
Page Up    : lên một trang màn hình. 
Page Down   : xuống một trang màn hình. 

 Phím xoá ký tự: 
Delete     : xoá ký tự tại vị trí con trỏ. 

Backspace    : xoá ký tự bên trái con trỏ 
 Các phím khác: 

Enter     : xuống hàng, kết thúc đoạn. 

Shift + Enter : xuống hàng, chưa kết thúc đoạn. 

Insert      : dùng để chuyển đổi giữa chế độ chèn ký tự và đè ký tự. 

Alt      : dùng để chọn các lệnh trên menu bằng bàn phím. 

Esc      : dùng để  ngắt một lệnh đang thực hiện. 

5. Cách đánh tiếng Việt trên văn bản: 
Trong mục này sẽ giới thiệu hai kiểu đánh tiếng Việt thông dụng nhất hiện nay: kiểu 
gõ VNI và kiểu gõ TELEX. 

a. Kiểu gõ VNI: Kiểu gõ này dùng các phím chữ số ở hàng phím phía trên các phím 
chữ cái để thể hiện dấu trong tiếng Việt. Trong tiếng Việt, dấu được đặt ở trên các 
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nguyên âm. Vì vậy, muốn thể hiện được dấu, ta phải gõ vào nguyên âm trước, sau đó 
mới gõ các phím thể hiện dấu theo quy tắc sau: 

-  Dấu sắc  : phím số 1 

-  Dấu huyền  : phím số 2 

-  Dấu hỏi  : phím số 3 

-  Dấu ngã  : phím số 4 

-  Dấu nặng  : phím số 5 

-  Dấu mũ (â/ê/ô) : phím a/e/o + phím số 6 

-  Dấu móc (ơ/ư) : phím o/u + phím số 7 

-  Dấu liềm (ă) : phím chữ a + phím số 8 

-  Dấu ngang (đ) : phím chữ d + phím số 9 
 

b. Kiểu gõ TELEX:   

-  Dấu sắc : phím s 

-  Dấu huyền : phím f 

-  Dấu hỏi : phím r 

-  Dấu ngã : phím x 

-  Dấu nặng : phím j 

- â (aa),  ê (ee),  ô (oo),  đ (dd) 

-   ă (aw), ơ (ow), ư (uw) 

- xóa dấu (z) 
 

Lưu ý:  
• Nếu muốn bỏ dấu cho chữ hoa thì phải nhấn đồng thời phím Shift với phím thể 

hiện dấu. 
• Thường gõ dấu ở cuối từ.  

6. Nhập văn bản: 
a. Định dạng ký tự: Trước khi nhập một văn bản, ta cần phải chọn định dạng ký tự 

cho văn bản. Có thể dùng thanh Formatting Toolbar để định dạng nhanh. 

 Chọn Font chữ thích hợp cho văn bản trong hộp Font.   

Lưu ý: Font chữ tiếng Việt VNI có tên bắt đầu bằng VNI, Font chữ tiếng Việt 
ABC có tên bắt đầu bằng .Vn 

 Chọn kích cỡ chữ trong hộp Size. 
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  .VnTime, 14   :  Tin học Văn phòng 

.VnTime, 14, Italic  :  Tin học Văn phòng 
  .VnHelvetInsH, 14  :  TIN HỌC VĂN PHÒNG 

 VNI-Awchon, 13 :  Tin học Văn phòng  
Ngoài ra, ta có thể định dạng ký tự trong hộp thoại Font sẽ nói ở phần 4.2. 

b. Nhập văn bản: Sau khi định dạng ký tự, ta có thể tiến hành nhập văn bản tại vị trí 
con trỏ nhập. 
− Khi con trỏ nhập chạm biên phải của trang, Word sẽ tự động đưa nó xuống dòng 

dưới. 

− Muốn tạo thêm một đoạn, nhấn phím Enter. Ta có thể cho hiển thị hoặc che các 
dấu kết thúc đoạn bằng cách click vào nút  trên thanh Standard. 

− Muốn bắt đầu một dòng mới không có dấu kết thúc đoạn, nhấn Shift + Enter. 

− Để hủy thao tác vừa làm, click biểu tượng , hoặc nhấn Ctrl + Z. 

− Để lặp lại thao tác vừa làm, click biểu tượng , hoặc nhấn F4, hoặc nhấn Ctrl 
+ Y. 

c. Ngắt cột, trang: Trong Word, việc ngắt cột hoặc trang được thực hiện một cách tự 
động tùy thuộc Page setup. Tuy nhiên ta cũng có thể quy định các vị trí ngắt cột và 
ngắt trang như sau : 

− Đưa con trỏ nhập đến vị trí cần ngắt. 

− Dùng lệnh Insert |  Break, chọn các tùy chọn sau: 
• Page break  : ngắt trang. 
• Column break   : ngắt cột. 

Lưu ý: có thể sử dụng các phím tắt như sau:  
• Ctrl + Enter  : ngắt trang. 
• Ctrl + Shift + Enter : ngắt cột. 

7. Thao tác trên một khối chọn 

 Font chữ Cỡ chữ Đậm Nghiêng Gạch chân 
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a. Chọn một khối: Để chọn một khối văn bản ta có thể dùng chuột hoặc bàn phím, 
hoặc dùng kết hợp cả chuột và bàn phím. Sau đây là một vài phương pháp chọn khối. 

- Chọn một từ : Double click vào từ muốn chọn. 

- Chọn các ký tự liên tiếp nhau: Drag lên các ký tự muốn chọn; hoặc dùng bàn 
phím bằng cách đưa con trỏ nhập vào ký tự đầu tiên muốn chọn, sau đó nhấn 
phím Shift đồng thời nhấn các phím mũi tên thích hợp. 

- Chọn một dòng: Click vào khoảng trống bên trái của dòng đó. 

- Chọn một câu: Nhấn phím Ctrl, đồng thời click vào vị trí bất kỳ trong câu. 

- Chọn một đoạn: Double click vào khoảng trống bên trái của đoạn muốn chọn. 

- Chọn toàn bộ văn bản: Nhấn phím Ctrl, đồng thời click vào khoảng trống bên 
trái văn bản; hoặc nhấn tổ hợp phím Ctrl + A.  

Chú ý : 

 Nếu chọn một số dòng bằng chuột, có thể click và Drag vào khoảng trống bên 
trái các dòng. 

 Chọn từ vị trí con trỏ nhập đến cuối văn bản : gõ Shift + Ctrl + End 

 Chọn từ vị trí con trỏ nhập đến đầu  văn bản : gõ Shift + Ctrl + Home 

 Chọn từ vị trí con trỏ nhập đến đầu dòng      : gõ Shift + Home 

 Chọn từ vị trí con trỏ nhập đến cuối dòng     : gõ Shift + End 

b. Các thao tác trên khối: Sau khi đã chọn một khối văn bản, ta có thể tiến hành các 
thao tác sau : 

- Xóa khối: Nhấn phím Delete. 

- Di chuyển khối:  

 Dùng lệnh Edit | Cut, hoặc click biểu tượng  trên thanh Standard, hoặc 
nhấn Ctrl + X. 

 Di chuyển con trỏ nhập đến vị trí mới. 
 Dùng lệnh Edit | Paste, hoặc click biểu tượng   trên thanh Standard, hoặc 

nhấn Ctrl + V. 

Lưu ý: Ta có thể di chuyển một khối văn bản bằng cách đưa trỏ chuột vào khối rồi 
Drag đến vị trí mới và nhả phím chuột. 

- Sao chép khối:  
 Dùng lệnh Edit | Copy, hoặc click biểu tượng  trên thanh Standard, hoặc 

nhấn Ctrl + C. 
 Di chuyển con trỏ nhập đến vị trí cần sao chép. 
 Dùng lệnh Edit | Paste, hoặc click biểu tượng   trên thanh Standard, hoặc 

nhấn Ctrl + V. 
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Lưu ý: Ta có thể sao chép một khối văn bản bằng cách đưa trỏ chuột vào khối, 
nhấn phím Ctrl, đồng thời Drag đến vị trí mới và nhả phím chuột. 

Ý nghĩa của Clipboard: Clipboard là một vùng nhớ tạm dùng để lưu trữ khối 
chọn khi thực hiện thao tác Copy hay Cut. 

8. Trình bày văn bản trên màn hình 
a. Các kiểu xem văn bản trên màn hình: 

- Dùng lệnh View | Normal để xem văn bản ở chế độ bình thường. Đây là chế độ 
mặc nhiên của Word, phần lớn các kiểu định dạng đặc biệt đều nhìn thấy được 
trên màn hình. Riêng một số trường hợp được đơn giản hóa để tăng tốc độ truy 
xuất (chẳng hạn, không thấy được các tiêu đề và số trang, không thực hiện được 
các thao tác vẽ đồ họa ...). Trong chế độ này, các trang được ngăn cách nhau bởi 
đường chấm chấm nằm ngang. 

- Dùng lệnh View | Print Layout để xem văn bản giống như lúc được in ra. Các 
tiêu đề đầu và cuối trang, số trang đều được thể hiện. Muốn sử dụng các thao tác 
vẽ đồ họa, chèn hình ảnh phải chuyển qua chế độ này. 

- Dùng lệnh View | Outline để xem tổng quan văn bản, chỉ xem những mục tiêu đề 
lớn của tài liệu, giấu đi các chi tiết nhỏ. 

b. Chế độ phóng to, thu nhỏ màn hình:   

- Dùng lệnh View | Zoom. 

 
- Trong hộp thoại Zoom, chọn cỡ bạn muốn phóng to hay thu nhỏ trong khung 

Zoom to, hoặc chọn số phần trăm trong hộp Percent. 

- Click nút OK để đồng ý với kích cỡ phóng màn hình vừa chọn. 

Lưu ý: Có thể click hộp Zoom  rồi click chọn cỡ muốn phóng. 

c. Xem toàn màn hình: Có thể cho vùng của người sử dụng nhiều hơn bằng cách bỏ 
hết các thanh menu, thanh công cụ ... Để thực hiện việc này, dùng lệnh View | Full 
Screen. Trở lại màn hình cũ bằng phím Esc. 
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4.2.  Định dạng văn bản  
1.  Định dạng ký tự (Font)  

Việc quy định dạng trình bày của một ký tự, một từ hay một nhóm từ gọi là định dạng 
ký tự. Có thể sử dụng hộp thoại Font, hoặc các biểu tượng trên thanh công cụ, hoặc 
các phím tắt để định dạng ký tự.  

a. Dùng hộp thoại Font: 
- Chọn khối gồm các ký tự muốn định đạng. 

- Dùng lệnh Format | Font. Hộp thoại Font xuất hiện và chọn lớp Font. 

   
 Xác định Font chữ trong khung Font. 

 Xác định kiểu chữ: thường (Regular hoặc Normal), đậm (Bold), nghiêng 
(Italic) ... trong khung Font style. 

 Xác định kích cỡ chữ trong khung size. 

 Click hộp Font color để xác định màu chữ. 

 Click hộp Underline style để xác định dạng gạch chân của chữ. 

 Xác định hiệu ứng cho chữ trong khung Effects. Ví dụ : H2O (Subscrip),  50 
m2 (Superscrip), INTERNET  (Strikethrought) ... 

 Sau mỗi chọn lựa, ta có thể xem trước kết quả trong khung Preview. 

 Click nút OK để đồng ý với các chọn lựa trên. 
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b. Sử dụng các tổ hợp phím:  
Một số  chức năng định đạng ký tự  thường sử dụng có thể thực hiện nhanh chóng thông 
qua các tổ hợp phím: 

Mục đích Gõ 

Tăng kích cỡ ký tự 
Giảm kích cỡ ký tự 
Bật/tắt chữ dậm (bold) 
Bật/tắt chữ nghiêng (Italic) 
Bật/tắt chữ gạch dưới đơn (Single Underline) 
Bật/tắt chữ gạch dưới kép (Double Underline) 
Đổi chữ in thành chữ thường và ngược lại 
Bật/tắt chỉ số dưới 
Bật/tắt chỉ số trên 
Trả về định dạng mặc định   

Ctrl + ] 
Ctrl + [ 
Ctrl + B 
Ctrl + I 
Ctrl + U 
Ctrl + Shift + D 
Shift + F3 
Ctrl + dấu bằng  
Ctrl + Shift + dấu bằng 
Ctrl + Space 

2.  Định dạng đoạn văn bản (Paragraph) 
Việc quy định dạng trình bày của một hay nhiều đoạn liên tục gọi là định dạng đoạn. 
Có thể sử dụng hộp thoại Paragraph, hoặc các biểu tượng trên Formatting Toolbar, 
hoặc các phím tắt để định dạng đoạn văn bản. 

a. Sử dụng hộp thoại Paragraph: 
- Chọn khối gồm các đoạn muốn định dạng (nếu chỉ định dạng cho một đoạn thì 

chỉ cần chuyển con trỏ nhập vào đoạn đó). 

- Dùng lệnh Format | Paragraph, xuất hiện hộp thoại Paragraph và chọn lớp 
Indents and Spacing. 
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 Alignment: quy định việc bố trí các dòng theo lề trái (left), lề phải (Right), 
đều cả hai lề (Justified) hay canh giữa (Centered). 

 Indentation: dùng để xác định lề cho đoạn. 
Left: khoảng cách từ lề trái đến đoạn văn bản. 
Right: khoảng cách từ lề phải đến đoạn văn bản. 
Special: có ba trường hợp chọn 

 None: lề theo quy định của Left và Right Indent. 
 First line: chỉ dời lề trái của dòng đầu tiên (xác định trong By). 
 Hanging: chỉ dời lề trái của các dòng không phải dòng đầu tiên (xác 
định trong By). 

 Spacing: quy định khoảng cách giữa các dòng. 
Before: xác định khoảng trống phía trên mỗi đoạn. 
After: xác định khoảng trống phía sau mỗi đoạn. 
Line Spacing: xác định khoảng cách các dòng trong cùng đoạn. 

- Sau mỗi chọn lựa, ta có thể xem trước kết quả trong khung Preview. 

- Click nút OK để hoàn tất thao tác định dạng đoạn. 

b. Sử dụng các biểu tượng trên Formatting Toolbar: 

    
  

  

 
  
 Có thể dời lề của đoạn bằng cách di chuyển chuột trên bốn biểu tượng nằm trên 
Ruler gồm: First line Indent, Left Indent, Hanging Indent và Right Indent. 

  
 

    
 
  

c. Sử dụng các tổ hợp phím: Một số  chức năng định đạng đoạn thường sử dụng có thể 
thực hiện nhanh chóng thông qua các tổ hợp phím: 

Mục đích Gõ 

Cách dòng đơn 
Cách dòng đôi 
Cách một dòng rưỡi 
Canh trái     (Left Align) 

Ctrl  + 1 
Ctrl  + 2 
Ctrl  + 5 
Ctrl + L 

First line Hanging 

Left Indent Right 

Canh trái 

Canh giữa Canh phải Canh đều Giảm lề trái 

Tăng lề trái 

Thay đổi 
khoảng 
cách dòng 
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Canh giữa   (Center Align) 
Canh phải   (Right Align) 
Canh đều  (Justify Align) 
Tăng lề trái 
Giảm lề trái 
Tăng lề trái trừ dòng đầu 
Giảm lề trái trừ dòng đầu 
Trả về định dạng đoạn mặc định 

Ctrl + E 
Ctrl + R 
Ctrl + J 
Ctrl + M 
Ctrl + Shift + M 
Ctrl + T 
Ctrl + Shift + T 
Ctrl + Q 

3.  Định dạng cột trong văn bản 
Có thể trình bày toàn bộ văn bản, một phần văn bản hay một nhóm các Paragraph 
trên nhiều cột (dạng như cột báo). Thông thường có hai cách định dạng cột trong 
văn bản: nhập nội dung văn bản trước sau đó định dạng cột, hoặc định dạng cột 
trước rồi nhập văn bản. Thông thường, ta hay dùng cách thứ nhất. Để dịnh dạng 
cột văn bản, ta thực hiện như sau: 

 Chọn khối văn bản cần chia cột. 

 Dùng lệnh Format | Columns, hộp thoại Columns xuất hiện. 

 
 Presets: xác định dạng chia cột theo mẫu định sẵn.  

 Number of columns: xác định số cột cần chia. 

 Width and Spacing: xác định chiều rộng và khoảng cách giữa các cột. 
 Các ô trong cột Col #: hiển thị tên cột. 
 Các ô trong cột Width: chọn chiều rộng của các cột tương ứng. 
 Các ô trong cột Spacing: chọn khoảng cách giữa các cột tương ứng. 

Nếu đánh dấu check vào ô kiểm tra Equal column width thì độ rộng của 
các cột bằng nhau. 
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 Line between : xác định có hay không đường gạch đứng phân chia giữa 
các cột. 

 Click nút OK để hoàn tất việc định dạng cột. 

Ghi chú: Có thể thực hiện nhanh định dạng cột bằng cách click vào biểu tượng 
  trên Standard Toolbar, sau đó Drag để chọn số cột. Khi muốn thay đổi chiều 

rộng cột, ta có thể điều chỉnh trực tiếp trên Ruler. 

4.  Định dạng Tab  
Mỗi lần gõ phím Tab, con trỏ sẽ dừng tại một vị trí. Khoảng cách từ vị trí dừng của 
Tab này đến vị trí dừng của Tab khác gọi là chiều dài của Tab Stop,  khoảng cách 
mặc định là 0.5 inch. Việc dùng các Tab Stop rất tiện lợi khi ta gõ một văn bản có 
dóng theo các cột. Ví dụ bảng danh sách các học sinh trong lớp gồm: Số thứ tự, Họ 
tên, Ngày sinh, Quê quán, Điểm thi ... 

Các Tab Stop nằm trên thanh Ruler, nếu thanh Ruler chưa hiện thì ta phải cho nó hiện 
bằng lệnh View | Ruler. Đầu phía trái của Ruler có nút định dạng Tab Stop, khi click 
liên tiếp vào nút này sẽ xuất hiện các cách định dạng của Tab Stop. 

 
 

 

Định dạng Tab Stop trên Ruler :  

 Click chọn kiểu Tab trên góc trái Ruler. 

 Click chuột tại một vị trí muốn đặt Tab Stop trên Ruler. 

 Để di chuyển một dấu Tab Stop trên Ruler: Drag đến vị trí mới. Muốn xóa một 
dấu Tab Stop: click và Drag ra khỏi thanh Ruler. Muốn xóa hết các Tab Stop trên 
Ruler: dùng lệnh Format | Tabs | Clear All. 

5.  Định dạng Bullets & Numbering  
Ta có thể điền tự động các dấu chấm hình tròn, quả trám, dấu sao, dấu mũi tên ... 
hoặc đánh thứ tự theo số, theo ký tự Alphabet ở đầu dòng các đoạn nhằm giúp cho 
các đề mục trong văn bản dễ đọc và nổi bật hơn.  

Nút định dạng Dóng trái cột Dóng phải Canh giữa Dóng theo 
dấu chấm
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Cách thức thực hiện như sau: 

 Di chuyển con trỏ nhập vào đoạn muốn định dạng hay chọn các đoạn muốn định 
dạng. 

 Dùng lệnh Format | Bullets & Numbering. Xuất hiện hộp thoại Bullets & 
Numbering. Chọn mục Bulleted và chọn kiểu chấm, hoặc chọn mục Numbered 
và chọn kiểu số hay chữ.  

 
 Nếu muốn chọn dạng Bullets hay dạng Numbering khác thì click vào nút 

Customize để thay đổi.  

6.  Tạo chữ cái lớn đầu dòng (Drop Cap)  
ó thể sử dụng khả năng của Drop Cap để tạo chữ cái lớn đầu dòng như trong 
đoạn văn bản này. Để tạo chữ cái lớn, ta thực hiện như sau: 
 

 Di chuyển con trỏ nhập vào đoạn muốn tạo Drop Cap. 
 Dùng lệnh Format | Drop Cap. Xuất hiện hộp thoại Drop Cap: 

   

 C 
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 Position: Có 3 mẫu để chọn dạng trình bày. 
Option:  

 Định dạng của kiểu chữ cho ký tự Drop Cap trong hộp Font.  
 Xác định số dòng mà ký tự Drop Cap thể hiện trong hộp Lines to drop.  
 Xác định khoảng cách giữa ký tự Drop Cap và kí tự tiếp theo trong hộp 

Distance From text. 
 Click nút OK để hoàn tất thao tác định dạng Drop Cap.  

7.  Định dạng khung và nền (Borders & Shading)   
Việc thêm những đường viền hay làm nổi bật nền của văn bản gọi là định dạng khung 
và nền. Có thể định dạng khung và nền cho một số ký tự, một số đoạn hay trang in. 
Để định dạng khung và nền, ta thực hiện như sau: 

 Chọn khối văn bản cần định dạng khung & nền (nếu định dạng khung & nền một 
đoạn thì chỉ cần chuyển con trỏ nhập vào đoạn đó). 

 Dùng lệnh Format |  Borders and Shading.  
 Để định dạng khung, chọn lớp Borders, xuất hiện hộp thoại : 

 
 Style : chọn kiểu đường viền mỗi cạnh của khung. 

 Color : chọn màu đường kẻ. 

 Width : chọn độ rộng đường kẻ. 

 Setting : chọn các mẫu kẻ khung. 

 Preview : xác định cạnh nào có đường viền. 

 Để định dạng nền, chọn lớp Shading, xuất hiện hộp thoại: 
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 Style : chọn mẫu tô (nhiều mẫu tô có đường kẻ). 
 Color : chọn màu cho các đường kẻ trong mẫu tô. 
 Fill : chọn nền của văn bản. Chọn No Fill : không có màu nền. 

 Để định dạng khung cho trang in, chọn lớp Page Border, xuất hiện hộp 
thoại: 

   
Setting, Style và Preview có tác dụng giống định dạng khung cho đoạn. 
Apply to để xác định những trang được làm khung. 

Ghi chú: Một số chức năng định dạng khung và nền thông dụng có thể thực hiện 
nhanh chóng thông qua các biểu tượng trên thanh công cụ Tables and Borders. 
Để xuất hiện thanh công cụ này, dùng lệnh: View | Toolbars | Tables and 
Borders, hoặc click vào biểu tượng  trên Standard Toolbar. 
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8.  Định khuôn dạng chung (Style)   
 Trong quá trình định dạng văn bản, để tiết kiệm thời gian và công sức, bạn có thể tạo kiểu 

định dạng cho một đoạn bất kỳ, sau đó sao chép kiểu định dạng này đến các đoạn khác. 
Đây là một hình thức giúp cho văn bản của ta thống nhất về kiểu chữ, kích cỡ chữ, định 
dạng đoạn, định dạng Tab stop ... 

 Trong Word đã có sẵn một số style chuẩn như: Normal, Heading 1, Heading 2,... Trong đó 
style Normal áp dụng cho mọi đoạn văn bản trong các tài liệu mới. 

a. Tạo một paragraph style mới:  
− Chọn một đoạn có chứa dạng mà ta muốn sử dụng cho style. 
− Click vào bên trong hộp Styles and Formatting trên Formatting Toolbar 

(không click vào nút mũi tên của ô), nhập đè lên tên một style đang có để tạo ra 
tên cho style mới, gõ Enter. 

b. Tạo một character style mới:  

− Dùng lệnh Format | Styles and Formatting, hay click vào biểu tượng   trên 
Formatting Toolbar. 

− Click vào . Xuất hiện 
hộp thoại New Style. 

− Nhập tên của character style ở hộp 
Name. 

− Trong hộp Style type, click chọn 
Character. 

− Chọn các tuỳ chọn khác, rồi click 
OK. 

 
c. Áp dụng một style cho một đoạn 

văn bản:  
− Để áp dụng một paragraph style, hãy chọn các đoạn văn bản muốn thay đổi. Để 

áp dụng một character style, hãy chọn các kí tự cần thay đổi. 

− Vào Styles and Formatting, click lên tên style muốn áp dụng. 

Kiểu đường Độ lớn đường Màu

Màu đường Chọn đường
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9. Định dạng trang và in ấn  
a. Khái niệm Section: Bình thường một tài liệu được chia thành nhiều trang, các 

trang có định dạng giống nhau. Nhưng đôi khi ta muốn một số phần văn bản có định 
dạng trang khác (như in theo chiều ngang khổ giấy A4), khi đó cần chia văn bản thành 
nhiều vùng (Section), mỗi Section có thể có định dạng trang khác nhau. Nếu không 
chia Section thì Word mặc nhiên coi toàn bộ văn bản là một Section duy nhất. 

− Lệnh Insert | Break: dùng để tạo một ngắt trang, ngắt cột hay ngắt Section bằng 
tay. Khi dùng lệnh này, xuất hiện hộp thoại : 

 Page Break để chèn một ngắt trang. 
 Column Break để chèn một ngắt cột trong 

trường hợp soạn văn bản theo nhiều cột. 
 Khung Section break types để tạo một ngắt 

Section, nó có 4 lựa chọn: Next page 
(section mới sẽ sang trang tiếp theo), 
continuous (section mới vẫn nằm liên tục với 
section trước đó), Even page (section mới sẽ bắt đầu ở một trang đánh số 
chẵn), Odd page (section mới bắt đầu ở một trang đánh số lẻ). 

− Xóa các ngắt trang và ngắt Section: đặt màn hình ở chế độ Normal View, khi 
đó ngắt trang là một đường gạch ngang chấm chấm ở giữa có chữ Page Break, 
ngắt section là một đường gạch kép chấm chấm nằm ngang ở giữa có chữ Section 
Break, đưa con trỏ tới các đường này và gõ phím Delete.  

b. Chọn cỡ giấy và đặt lề: Trước khi bắt tay vào soạn một văn bản, thông thường ta 
chọn cỡ giấy định in và đặt lề cho trang in bằng lệnh File | Page Setup, xuất hiện hộp 
thoại Page Setup. 

− Chọn cỡ giấy : Trong hộp thoại Page Setup, chọn lớp Paper.  

 
 Hộp Paper size: xác định kích cỡ trang giấy. Đối với các công văn giấy tờ ta 

thường chọn khổ giấy A4, 210 x 297 mm. 
 Hộp Width và Height: định dạng lại chiều rộng và chiều dài của trang giấy. 
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Khi đó cỡ giấy được gọi là Custome size (cỡ của người dùng tự định nghĩa).  
 Hộp Apply to, chọn một trong ba khả năng: This Secsion (để áp dụng cho 

secsion văn bản hiện tại), This Point Forward (áp dụng cho vùng từ vị trí hiện 
tại trở về sau), Whole Document (áp dụng cho toàn bộ tài liệu). 

 Chọn OK để xác nhận các thông số mới thiết lập. Có thể chọn Default để lưu 
các thông số vào tập tin khuôn mẫu sử dụng cho nhiều tài liệu về sau. 

− Đặt lề cho trang in: Trong hộp thoại Page Setup, chọn lớp Margins. 

 Thay đổi khoảng cách từ mép 
giấy đến phần văn bản trong các 
hộp: Top (trên), Bottom (dưới), 
Left (trái), Right (phải).  

 Hộp Gutter : xác định chiều 
rộng của gáy sách. 

 Khung Orientation: chọn hướng 
in là Portrait (hướng in dọc) hay 
Landscape (hướng in ngang). 

 Khung Preview: cho thấy hình 
dạng tương đối của văn bản so 
với kích thước giấy.  

 Hộp Apply to tương tự như ở 
phần Page size. 

 Click nút OK để chấp nhận. 

c. Tạo tiêu đề đầu trang, cuối trang: Một số văn bản có cùng nội dung ở đầu hoặc 
cuối mỗi trang in. Muốn thực hiện việc này phải tạo Header (đầu trang) hoặc Footer 
(cuối trang). 

− Dùng lệnh  View | Header and Footer. 

 
  

 

− Trong khung Header và Footer  gõ nội dung vào, có thể chọn các ký hiệu đánh số 
trang hay ngày giờ để đưa vào đầu / cuối trang. 

− Click Close để hoàn tất việc tạo tiêu đề và đánh số trang. 

d. Đánh số trang: Dùng lệnh Insert | Page Number. Hộp thoại Page Number xuất 
hiện: 

Số của mỗi trang Tổng số trang Định dạng đánh số trang 

Ngày Giờ Chọn đầu/cuối trang
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− Hộp Position: Chọn vị trí đánh số trang trong. Top of Page (ở đầu trang), Bottom 

of Page (ở cuối trang). 

− Hộp Alignment: Chọn việc dóng số trang. Left (bên trái), Right (bên phải), 
Center (ở giữa) ...  

− Nút kiểm tra Show number on first page: có hay không hiển thị số thứ tự của 
trang ở trang đầu tiên tài liệu. 

− Click nút Format để thiết lập các thông số: Start At (bắt đầu đánh từ số mấy), 
Continue from previous section (tiếp theo số trang của phần trước), Number 
Format (định dạng số).  

e.  Xem trước trên màn hình cách bố cục các trang in: Giả sử toàn bộ văn bản đã 
được định dạng xong. Để xem trước cách trình bày các trang trước khi in ra giấy, ta 
dùng lệnh File | Print Preview hoặc click biểu tượng  trên Standard Toolbar. Nếu 
các trang phân không hợp lệ ta có thể sửa đổi. Khi màn hình soạn thảo biến mất, xuất 
hiện màn hình mới với các trang đã phân, đỉnh màn hình có thanh công cụ: 

 
 
 
 
 

   
 
 
  

  
 
 

f. In văn bản: Dùng lệnh File | Print hoặc dùng tổ hợp phím Ctrl + P. Hộp thoại Print 
xuất hiện: 

In VB ra 
máy in 

Phóng to/thu 
nhỏ trang. Khi 
biểu tượng này 
không sáng, ta 
có thể hiệu 
chỉnh được VB. 

hiển thị 
1 trang 

hiển thị đồng 
thời nhiều trang 

chọn tỷ lệ phóng 
to/ thu nhỏ trang 

tắt/mở thước kẻ 
trên màn hình 

dành toàn màn 
hình để xem. 

về lại màn 
hình soạn thảo 
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− Mục Printer: Chọn loại máy in. 

− Mục Page Range: Chọn trang muốn in : All (in toàn bộ), Current Page (in trang 
hiện hành), Pages (in các trang nào, ví dụ : 1,4,6-9), Selection (in khối văn bản đang 
chọn). 

− Mục Copies: Chọn số bản cần in. 
− Mục Options: Xác định cách thức in văn bản. 
− Nút Properties: Xác định chất lượng in, cỡ giấy in và in theo chiều ngang hay chiều 

dọc trang giấy. 
− Click nút OK để in. 

Lưu ý: Để in toàn bộ văn bản một lần theo kiểu máy in định sẵn, ta có thể click 
biểu tượng  trên Standard Toolbar. 

4.3. Làm việc với các đối tượng trên văn bản 
1. Chèn ký tự đặc biệt  

 Đưa con trỏ nhập đến vị trí cần chèn. 

 Dùng lệnh Insert | Symbol.  

 Trong hộp thoại Symbol, chọn ký tự cần chèn. Có thể chọn nhiều bảng ký tự khác 
nhau trong hộp Font. 
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 Double click vào ký tự, hoặc click nút Insert để chấp nhận chèn. 

 Click nút Close  để đóng hộp thoại Symbol.  

Lưu ý : Trong trường hợp thường xuyên sử dụng một số ký hiệu đặc biệt nào đó, nên 
định nghĩa cho nó một tổ hợp phím theo trình tự sau: Dùng lệnh Insert | Symbol, 
chọn ký hiệu cần định nghĩa, click nút Shortcut Key, hộp thoại Customize xuất hiện. 
Con trỏ lúc này nằm ở hộp Press New Shortcut Key, bấm tổ hợp phím cần định 
nghĩa. Click nút Assign,  click nút Close để trở về hộp Symbol. Kể từ đó, chỉ cần 
bấm tổ hợp phím đã định nghĩa thì ký hiệu tương ứng sẽ xuất hiện tại vị trí con trỏ. 

2. Chèn và hiệu chỉnh hình ảnh  
a. Chèn hình ảnh vào văn bản  

− Chèn từ Clip Art:  
 Đưa con trỏ nhập đến vị trí muốn chèn hình, thực hiện lệnh Insert | Picture | 

ClipArt.  Xuất hộp thoại  Clip Art:  

 
 Trong hộp văn bản Search For, nhập từ khoá để tìm Clip Art tương ứng (từ khoá 

là tiếng Anh như “computer” chẳng hạn).  

Nhập từ khoá 
tìm kiếm ở đây 

Giới hạn vùng 
tìm kiếm 

Giới hạn kết 
quả tìm kiếm 
(âm thanh, 
hình, phim...) 
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 Bạn có thể rê chuột lên hình ảnh trong bảng các Clip Art vừa tìm được để biết 
thêm các thông tin như: các từ khoá tìm kiếm, kích thước ảnh (tính bằng 
pixel), độ lớn của hình, kiểu tập tin... 

 Đưa hình vào văn bản bằng cách Click chuột lên hình, có thể bạn sẽ thấy 
thanh công cụ hình ảnh sau xuất hiện: 

 
 

Nút Chức năng Mô tả 
 Chèn hình Mở hộp thoại chèn hình ảnh 

 Màu sắc Cho phép chuyển sang 1 trong 4 chế độ màu. 

 Tăng/giảm tương phản Tăng/giảm độ tương phản giữa màu sáng và 
tối. 

 Tăng/giảm độ sáng Tăng/giảm độ sáng của ảnh. 

 Cắt hình ảnh Cắt khúc các cạnh ngang/dọc của hình 

 Xoay trái Xoay hình ảnh 900 về bên trái. 

 Kiểu đường Hiển thị các độ dày, kiểu đường để đóng khung 
hình. 

 Nén ảnh Giảm kích cỡ tập tin bằng cách giảm độ phân 
giải hình hay loại bỏ những vùng trống. 

 Định dạng ảnh Cho phép đặt lại một số thuộc tính như kích 
thước, màu sắc, vị trí trên màn hình... 

 Đặt màu trong suốt Tạo vùng trong suốt với màu được chọn nếu 
như kiểu tập tin có hổ trợ tạo màu trong suốt. 

 Tái tạo ảnh Huỷ bỏ những thay đổi về độ tuơng phản, màu 
sắc, độ sáng, đường biên, kích thước.  

− Chèn từ tập tin hình:  
 Đưa con trỏ nhập đến vị trí muốn chèn hình, thực hiện lệnh Insert | Picture | 

From File.  Xuất hiện hộp thoại Insert Picture : 

 
 Chọn đường dẫn đến tập tin hình trong hộp Look in. 
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 Chọn tên tập tin hình cần chèn. Double click vào tên tập tin, hoặc click vào 
nút Insert để chấp nhận chèn. 

 Click nút Cancel hoặc nút  để đóng hộp thoại Insert Picture. Lúc này, hình 
ảnh được chèn vào văn bản và có kích thước mặc định. 

b. Hiệu chỉnh hình ảnh: 

− Di chuyển, xóa hình ảnh: 
 Chọn hình ảnh cần di chuyển/ xóa. 
 Để di chuyển, drag đến vị trí mới. Để xóa hình, gõ phím Delete. 

− Hiệu chỉnh kích thước hình ảnh: 
 Chọn hình ảnh cần hiệu chỉnh, các nút hiệu chỉnh hình xuất hiện. 
 Đưa trỏ chuột đến nút hiệu chỉnh, drag để phóng to hay thu nhỏ hình ảnh. 

− Định dạng cách trình bày hình ảnh: 
 Right click vào hình ảnh cần cần định dạng, chọn Format Picture. 

 
 Trong hộp thoại Format Picture, chọn lớp Layout. 

 Trong Layout, chọn kiểu trình bày hình ảnh thích hợp trong khung 
Wrapping style. 

 Click nút OK để chấp nhận định dạng mới. 

3. Vẽ hình trong văn bản  
a. Vẽ hình: Để vẽ hình trong Word, ta sử dụng thanh công cụ vẽ (Drawing Toolbar). 

Nếu trên màn hình Word chưa hiển thị Drawing Toolbar, click biểu tượng  trêns 
Standard Toolbar, hoặc dùng lệnh View | Toolbars | Drawing. Có thể chọn các biểu 
tượng trên Drawing để vẽ hình. 

 
 

 
 
 

đường  
thẳng 

mũi  
tên

chữ  
nhật

Oval  bóng  3 chiểu  

xoay 
hình 

màu nền 
hình 

màu nét 
vẽ 

dạng 
nét vẽ 

dạng 
mũi tên
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Trong Drawing Toolbar, lệnh Autoshapes để vẽ theo những mẫu hình làm sẵn trong 
Word, lệnh Draw | Order quy định hình được trình bày trên/dưới các hình khác hoặc 
văn bản.  

Thực hiện vẽ hình như sau: 

− Chọn biểu tượng vẽ. 

− Đưa trỏ chuột đến vị trí thích hợp, sau đó drag để thực hiện vẽ hình. 

Lưu ý : Để vẽ hình vuông hoặc hình tròn, chọn biểu tượng  hoặc  sau đó nhấn Ctrl 
đồng thời drag cho đến khi đạt được hình vừa ý. 

b. Di chuyển và thay đổi kích thước hình: 
− Chọn hình. Nếu chỉ chọn một hình thì click vào hình cần chọn, nếu chọn nhiều hình thì  

giữ phím Shift và click vào các hình muốn chọn. 

− Drag hình đến vị trí mới hoặc drag tại các nút hình vuông xung quanh hình để 
thay đổi kích thước. 

c. Xóa hình:  
− Chọn hình. 

− gõ phím Delete.  

4. Tạo chữ nghệ thuật WordArt 
Trong Word ta có thể tạo những dạng kiểu chữ đặc biệt để làm các trang bìa hay các 
dòng chữ quảng cáo ... Ví dụ : 

 
Cách thực hiện:  

− Định vị con trỏ nhập tại nơi muốn chèn WordArt. 

− Dùng lệnh Insert | Picture | WordArt hoặc click vào biểu tượng  trên 
Drawing Toolbar, hộp thoại WordArt Gallery xuất hiện: 

  
− Chọn một mẫu và click nút OK, hộp thoại Edit WordArt Text xuất hiện. 
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− Chọn font chữ trong hộp Font, chọn cỡ chữ trong hộp Size, sau đó gõ vào 

chuỗi ký tự mới trong khung Text và click nút OK để hoàn tất thao tác tạo 
WordArt. 

− Sau khi tạo WordArt, thanh công cụ WordArt xuất hiện để hổ trợ việc thay 
đổi mẫu mã và nội dung WordArt vừa tạo ra. 

  
1.  Chèn thêm WordArt. 2.  Sửa nội dung. 
3.  Chọn lại WordArt.  4.  Định dạng WordArt. 
5.  Chọn kiểu hiệu ứng. 6.  Xoay WordArt. 
7.  Đổi dạng chữ thường thành chữ hoa và ngược lại. 
8.  Đổi chữ hàng ngang thành hàng dọc và ngược lại. 
9.  Canh dòng (trái, phải, giữa, đều hai bên). 
10. Hiệu chỉnh dạng WordArt. 

5. Định dạng Text Box 
Text Box là một đối tượng hình vẽ trong văn bản và cũng được xem như là một văn 
bản con mà trên đó ta có thể nhập vào văn bản, hình ảnh ... 

a. Tạo Text Box: 

− Dùng lệnh Insert | Text Box, hoặc click biểu tượng  trên Drawing Toolbar. 

− Đưa con trỏ nhập đến vị trí cần tạo Text Box, click & drag để thực hiện chèn 
Text Box vào văn bản, một khung trống xuất hiện trên màn hình nằm trên văn bản 
nền, lúc này có thể nhập dữ liệu vào Text Box. 

b.  Di chuyển và thay đổi kích thước Text Box: 
− Di chuyển Text Box đến vị trí mới: chọn Text Box bằng cách click vào Text Box, 

sau đó đưa trỏ chuột đến đường viền của Text Box cho đến khi trỏ chuột chuyển 

sang hình , drag đến vị trí mới. 

− Thay đổi kích thước Text Box: chọn Text Box và drag các nút trên biên của Text 
Box. 
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− Xóa Text Box: chọn Text Box và gõ phím Delete. 

d. Định dạng một Text Box: Chọn Text Box và thực hiện lệnh Format | Text Box, 

hoặc Right Click và chọn  xuất hiện hộp thoại Format Text Box. 

− Lớp Colors and Lines : Chọn dạng nền (Fill) và dạng khung (Line).  

 
− Lớp Size: Chọn kích thước (Height và Width) của Text Box. 

 
− Lớp Layout: Để quy định Text Box nằm song song với văn bản nền (trên hoặc 

dưới), hoặc chen vào giữa văn bản (đẩy các ký tự của văn bản nền sang nơi khác) 
... 
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− Lớp Text Box : Xác định lề để trình bày dữ liệu trong Text Box. 

Lưu ý :  
 Có thể đổi hướng văn bản trong Text Box bằng cách dùng lệnh Format | Text 

Direction, xuất hiện hộp thoại Text Direction - Text Box và chọn hướng thích 
hợp. 

 
 Có thể làm bóng (Shadow) hoặc làm khung 3 chiều (3-D) bằng cách sử dụng các 

biểu tượng  trên Drawing Toolbar. 

6. Đánh công thức Toán - Equation  
Equation chuyên dùng để đánh các ký hiệu hoặc công thức toán trong văn bản. Ví dụ: 

 

a.  Tạo biểu thức toán học: 
− Đưa con trỏ nhập đến vị trí thích hợp. Thực hiện lệnh Insert | Object 

− Trong hộp thoại Object, chọn lớp Create New. Sau đó double click vào mục 
Microssoft Equation 3.0. 

− Click nút OK để mở thanh Equation. Lúc này, Word chuyển sang chế độ soạn 
thảo Equation, đồng thời xuất hiện khung soạn thảo Equation để ta nhập các ký 
hiệu toán học vào. Mỗi khung chứa một biểu thức toán học. 

   

− Click chọn các ký hiệu toán học cần dùng trên thanh Equation để đưa nó vào 
biểu thức toán học cần tạo. 
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− Click vào vị trí bất kỳ ngoài khung Equation để chấm dứt việc tạo biểu thức toán 
học và trở về màn hình soạn thảo văn bản thông thường. 

b.  Hiệu chỉnh biểu thức toán học: Để hiệu chỉnh biểu thức toán học, ta thực hiện 
các thao tác sau :  

− Double click vào biểu thức toán học muốn hiệu chỉnh. Lúc này Word chuyển 
sang chế độ soạn thảo Equation và sau đó có thể tiến hành các thao tác chỉnh sửa. 

− Dùng lệnh Style | Other, sau đó chọn font chữ thích hợp trong hộp Other Style. 

− Dùng lệnh Format | Spacing, sau đó chọn kích cỡ thích hợp trong hộp Spacing. 

− Click ngoài khung Equation để chuyển về màn hình soạn thảo văn bản.  

Lưu ý: Ta có thể thay đổi kích thước của biểu thức bằng cách click vào biểu thức, sau 
đó đưa trỏ chuột đến các nút hiệu chỉnh để phóng to hoặc thu nhỏ kích thước của biểu 
thức.   

7. Máy tính trong Word 
− Trong Word cũng có một chiếc máy tính ẩn, và có thể làm xuất hiện công cụ tính 

toán này như sau: 

− Click phải lên thanh công cụ, chọn Customize. 

− Chọn tab Command. Trong mục Categories, tìm và click chọn dòng All 
Commands. Trong hộp Commands bên phải, tìm dòng ToolsCalculate, click 
chọn và nắm kéo thả lên thanh công cụ. 

 
− Đóng cửa sổ Customize lại. Từ giờ có thể sử dụng chiếc máy tính này rồi, 

và cách sử dụng như sau: 
 Trong Word, bạn gõ một biểu thức tính toán nào đó. Ví dụ: (2+4*3)^2.  

 Quét chọn biểu thức này, rồi click biểu tượng Tools Calculate trên thanh 
công cụ. 

 Nhấn tổ hợp phím Ctrl-V.  Kết quả tính toán sẽ xuất hiện ngay tại vị trí con 
trỏ. 
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4.4. Lập bảng biểu (Table) 
1. Tạo một bảng mới   

Để tạo một bảng mới ta có thể sử dụng một trong hai cách sau: 

Cách 1 : 

 Đưa con trỏ nhập đến vị trí cần tạo bảng. 

 Dùng lệnh Table | Insert | Table. Xuất hiện hộp thoại Insert Table: 

 Trong hộp thoại Insert Table, xác định các thông số cho bảng: 

 Hộp Number of columns: xác định số cột 
cho bảng. 

 Hộp  Number of rows: xác định số hàng 
cho bảng. 

 Hộp Fixed column with: xác định chiều 
rộng cho các cột. Có thể chọn Auto để 
Word tự động điều chỉnh giá trị này. 

 Click nút OK để chấp nhận tạo bảng với 
thông số vừa xác định. 

Cách 2 : 

 Đưa con trỏ nhập đến vị trí cần tạo bảng. 

 Click biểu tượng  trên Standard Toolbar. 

 Drag để chọn số cột và số dòng, và tạo bảng. 

2.  Các thao tác trên bảng  
a.  Nhập và di chuyển con trỏ nhập trên bảng:  

− Để nhập chữ trên bảng, đưa con trỏ nhập vào ô cần nhập, sau đó gõ các ký tự vào.  
− Sau khi gõ chữ vào bảng có thể tiến hành định dạng chữ với các thao tác giống 

như trên văn bản. 
− Di chuyển con trỏ nhập trong bảng: Dùng phím ↑ hay ↓ để lên hay xuống một 

dòng; nhấn Tab hay Shift + Tab để sang phải hay sang trái một cột; nhấn Alt + 
Home hay Alt + End để đến ô đầu tiên hay ô cuối cùng của dòng hiện tại; nhấn 
Alt + PgUp hay Alt + PgDn để đến ô đầu tiên hay ô cuối cùng của cột hiện tại 

− Nếu muốn nhập phím Tab trong một ô phải gõ Ctrl + Tab. 
− Có thể trình bày dữ liệu trong ô theo chiều đứng bằng cách dùng lệnh Format | 

Text Direction. Chọn kiểu hiển thị trong khung Orientation. 
b.  Đánh dấu chọn các ô trên bảng: 

− Chọn một ô: Đưa con trỏ nhập đến ô muốn chọn, rồi dùng lệnh Table | Select | 
Cell, hoặc đưa chuột đến mép trái của ô cho đến khi trỏ chuột chuyển sang hình 

 thì click. 
− Chọn nhiêu ô: Đưa con trỏ nhập đến ô đầu tiên muốn chọn, drag đến ô cuối. 
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− Chọn hàng: Đưa con trỏ nhập đến hàng muốn chọn rồi dùng lệnh Table | Select | 
Row, hoặc đưa chuột đến lề trái của hàng cho đến khi trỏ chuột chuyển sang hình 

 thì click, và drag xuống hay lên để chọn nhiều hàng. 
− Chọn cột: Đưa con trỏ nhập đến cột muốn chọn rồi dùng lệnh Table | Select | 

Column, hoặc đưa chuột đến mép trên của cột cho đến khi trỏ chuột chuyển sang 
hình  thì click, và drag qua phải hay qua trái để chọn nhiều cột. 

− Chọn cả bảng: Đưa con trỏ nhập đến ô bất kỳ trong bảng, dùng lệnh Table | 
Select | Table, hoặc nhấn tổ hợp phím Alt+Shift+5 (trên phần bàn phím số) 

c.  Chèn thêm hàng, cột vào bảng: 
− Chèn một hàng duy nhất vào cuối bảng: Đặt con trỏ nhập vào ô cuối cùng của 

bảng và nhấn phím Tab.    
− Chèn nhiều hàng vào cuối bảng: Đặt con trỏ nhập vào vào hàng cuối cùng của 

bảng và dùng lệnh Table | Insert Rows, xuất hiện hộp thoại Insert Rows, nhập 
vào số hàng cần thêm. 

− Chèn thêm nhiều hàng ở giữa bảng: Lựa chọn các hàng đã có sẵn (nơi sẽ đặt 
các hàng mới), dùng lệnh Table | Insert Rows. 

− Chèn thêm các cột: Lựa chọn các cột đã có sẵn, dùng lệnh Table | Insert 
Columns. Các cột mới thêm sẽ nằm bên trái các cột đã chọn. 

d.  Hủy bỏ hàng, cột trong bảng: 
− Chọn các hàng/cột muốn hủy bỏ.    
− Dùng lệnh Table | Delete Rows để hủy bỏ hàng, hay Table | Delete Columns để 

hủy bỏ cột. 

e.  Nhập nhiều ô thành một ô: 
− Chọn các ô muốn nhập chung.    

− Dùng lệnh Table  |  Merge cells, hay Right Click và chọn  

f.  Tách một ô thành nhiều ô: 
− Đưa con trỏ nhập vào ô muốn tách.    
− Dùng lệnh Table |  Split cells, hay Right Click và 

chọn  

 Number of columns : xác định ô được tách ra 
mấy cột. 

 Number of rows : xác định ô được tách ra mấy 
hàng. 

− Click nút OK để hoàn tất thao tác tách ô. 

g.  Thay đổi kích thước của cột và hàng: Sau khi tạo bảng, ta có thể chỉnh sửa lại 
chiều rộng của cột và chiều cao của hàng như sau: 
− Đánh dấu chọn một hay nhiều cột (hoặc một hay nhiều hàng). 
− Đưa trỏ chuột đến đường phân cách của cột (hoặc hàng) cần thay đổi cho đến khi 

trỏ chuột đổi sang hình  (hoặc hình ). 
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− Drag để thay đổi kích thước của cột (hay hàng) cho đến khi đạt được kích thước 
vừa ý. 

3.  Tạo tiêu đề cho bảng 
 Trường hợp văn bản có chứa một bảng thể hiện trên nhiều trang, ta thường tạo tiêu đề 

cho bảng được lặp lại ở tất cả các trang. Cách thực hiện : 

− Chọn các hàng muốn tạo tiêu đề. 

− Dùng lệnh Table | Heading Rows Repeat.  

Lưu ý :  

Để xóa bỏ việc tạo tiêu đề cho bảng, ta chọn bảng, sau đó dùng lệnh Table | heading 
Rows Repeat. 

4.  Sắp xếp các dữ liệu trên một bảng  
− Chọn khối dữ liệu cần sắp xếp nội dung. 
− Dùng lệnh Table | Sort. 
− Chọn kiểu cần sắp xếp trong hộp thoại 

Sort.  
 Sort by và Then by để chọn các 

khóa sắp xếp. 
 Type để xác định sắp xếp theo kiểu 

dữ liệu nào. Kiểu ký tự (Text), kiểu 
số (Number), kiểu ngày (Date). 

 Ascending hay Descending để chọn 
thứ tự sắp xếp tăng dần hay giảm 
dần. 

− Click nút OK để hoàn tất thao tác sắp 
xếp dữ liệu trong bảng. 

5.  Tính tổng cuối cột số trong một bảng  
− Đưa con trỏ đến ô cuối cùng của cột số. 
− Dùng lệnh Table | Formula. 

 
− Click nút OK, kết quả tổng sẽ trình bày tại ô cuối cùng. 
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4.5. Các kỹ năng hỗ trợ 
1. Tìm kiếm và thay thế   
a.  Tìm kiếm: 

− Dùng lệnh Edit | Find, hoặc nhấn Crtl + F. Hộp thoại Find and Replace xuất 
hiện: 

 
− Chọn lớp Find.  

 Nhập nội dung cần tìm vào hộp Find What. 
 Click nút Find Next để tìm. Nếu tìm thấy, Word sẽ hiển thị phần vừa tìm thấy 

trên màn hình.  
 Click nút Find Next để tiếp tục tìm. 
 Click nút Cancel để ngắt không tìm tiếp. 

b.  Tìm kiếm và thay thế: 
− Dùng lệnh Edit | Replace, hoặc nhấn Ctrl + H. Hộp thoại Find and Replace 

xuất hiện: 

 
− Chọn lớp Replace. 

 Nhập nội dung cần tìm vào hộp Find What. 
 Nhập nội dung cần thay thế vào hộp Replace with. 
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 Click nút Replay All để thay thế tất cả các từ trong hộp Find What bởi các từ 
trong hộp Replace with.  

 Click nút Find Next để tìm. Nếu tìm thấy, Word sẽ hiển thị phần vừa tìm thấy 
trên màn hình.  

 Click nút Replace nếu muốn thay từ vừa tìm được, nếu không thì tiếp tục 
click nút Find Next để tìm đến từ khác.  

 Click nút Cancel để ngắt không tìm tiếp. 

2.  Thiết lập AutoCorrect   
Khi nhập nội dung cho một văn bản trong đó có lập lại nhiều lần một số nhóm từ nào 
đó. Để tiết kiệm thời gian và công sức, ta có thể thiết lập chức năng AutoCorrect 
nhằm thay thế một vài ký tự viết tắt cho nhóm từ trên. Cách thực hiện như sau: 

− Dùng lệnh Tools | AutoCorrect Options. Xuất hiện hộp thoại AutoCorrect  

 
− Chọn lớp AutoCorrect. 

 Nhập nội dung viết tắt vào hộp Replace và nội dung thay thế cho nội dung 
viết tắt vào hộp With. Sau đó, click nút Add để đưa vào danh sách 
AutoCorrect.  

 Click nút OK để đóng hộp thoại AutoCorrect. 

− Muốn sử dụng AutoCorrect, ta nhập từ viết tắt, sau đó nhập thêm dấu phân cách 
từ (ký tự trắng, dấu phẩy, dấu chấm, chấm hỏi ...) để đưa nội dung thay thế tương 
ứng vào văn bản. 

3.  Kiểm tra chính tả và ngữ pháp tiếng Anh (Spelling and Grammar)   
Khi nhập một nội dung văn bản tiếng Anh, Word cung cấp một chức năng kiểm tra 
lỗi chính tả và lỗi cấu trúc ngữ pháp tiếng Anh một cách tự động. Cách thực hiện như 
sau : 
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− Dùng lệnh Tools | Option. Xuất hiện hộp thoại Option: 

− Chọn lớp Spelling & Grammar. 

 Trong khung Spelling: đánh dấu check vào ô Check spelling as you type, 
nếu muốn bật chức năng 
kiểm tra lỗi chính tả tự động. 

 Trong khung Grammar: 
đánh dấu check vào ô Check 
grammar as you type, nếu 
muốn bật chức năng kiểm tra 
lỗi ngữ pháp tự động. 

 Click nút OK để đóng hộp 
thoại Option. 

Lưu ý : Sau khi thiết lập hai chế 
độ trên, nếu văn bản nhập vào có 
lỗi chính tả và ngữ pháp thì các 
từ bị lỗi sẽ xuất hiện nét gạch 
dưới. Thông thường, các lỗi 
chính tả có nét gạch dưới màu 
đỏ, các lỗi ngữ pháp có nét gạch 
dưới màu xanh lục.  

4.  Sử dụng Mail Merge   
Trong trường hợp muốn gửi một văn bản có cùng nội dung đến nhiều người như giấy 
báo họp, giấy báo thi, giấy mời ... ta phải in nhiều Họ Tên, Địa chỉ ... cho nhiều người 
khác nhau. Chức năng Mail Merge trong Word  có chức năng trộn nội dung thư với 
danh sách Họ Tên, Địa chỉ ... 

Để thực hiện trộn thư, ta phải có sẵn hai tập tin: 

 Tập tin chính (Main Document) chứa nội dung chung của văn bản. 

Ví dụ : 

 

 

 

 

 

 

 

 

 

 

Trường PTCS  ABC CỘNG HÒA XÃ HỘI CHỦ NGHĨA VIỆT NAM 
          Độc lập -  Tự do - Hạnh phúc 
 

GI□Y M□I 

Kính mời :  Ông/Bà  
Là phụ huynh em :  
Lớp : 9A1 
Đến tại phòng : 12 
để tham dự buổi họp phụ huynh đầu năm học. 
Nội dung : Phổ biến quy chế và chủ trương của Nhà trường trong 

năm học mới. 

Rất mong quý phụ huynh tham dự đông đủ. 
 

  TP. Hồ Chí Minh, ngày 05 tháng 9 năm 2004 
                 GV chủ nhiệm  



                                                                               
 

 
  

94 

 Tập tin dữ liệu (Data Document) chứa các trường (field) nội dung cần trộn vào 
tập tin chính. 

Ví dụ: 
Phụ huynh Học sinh 

Nguyễn Dũng Nguyễn Thị Lan 
Hồ Văn Hùng Hồ Trân 
Lê Bá Lê Hoàng 
Trần Văn Trần Hòa 
Võ Văn Lân Võ Hòa 

Các bước thực hiện trộn thư: 

− Tạo tập tin chính, dùng lệnh File | Save as để ghi tên tập tin vào đĩa, ví dụ: 
giaymoi-1.doc. 

− Dùng lệnh Tools | Letters and Maillings | Mail Merge, xuất hiện hộp thoại Mail 
Merge, hướng dẫn ta làm 6 bước: 

 Bước 1: Trong cửa sổ Mail Merge, dưới 
mục Select document type, click chọn mục 
Letters, sau đó nhấn Next để qua bước 2.   

 Bước 2: Trong vùng Select Start Document 
chọn mục Use the current document và 
click vào Next để đến bước 3 hoặc Previous 
để về lại bước 1 hiệu chỉnh lựa chọn lại     

 
 Bước 3: Trong mục Select recipients, ta 

chọn Uses an existing list. Tiếp tục click vào 
Next để thực hiện kết nối với dữ liệu đã được 
tạo sẵn. 

 
 Sau khi click vào Next thì hộp thoại sau xuất hiện: 

 

 

 

 

 

 trong vùng Look In chọn thư mục chứa tập tin dữ liệu đã tạo ra trước đó, trong vùng File nam
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Nhấn vào nút lệnh Open để hiển thị bảng danh sách các record cần thực hiện 
trộn thư: 

    
nhấn vào Edit để hiệu chỉnh dữ liệu và Close để đóng hộp thoại. Tiếp tục 
bước 4 

 Bước 4: Trong mục Write your letter. Để đưa nội dung các trường cần trộn 
vào thư, click chọn nơi cần đưa nội dung vào rồi chọn More items… chọn tên 
trường tương ứng rồi click insert. 

Tiếp tục click vào Next để sang bước 5  

 
 Bước 5: click vào Next để sang bước cuối cùng  

 
 Bước 6: Hộp thoại sau sẽ xuất hiện.  

 
Chọn Edit Individual letters… Xuất hiện hộp thoại Merge to New Document 
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Click nút OK để bắt đầu trộn tập tin chính và tập tin dữ liệu.  

Sau khi trộn các văn bản ta có thể dùng lệnh File \ Print để in ra máy in. Mỗi 
một giấy mời sẽ được in bắt đầu từ một trang mới. Tên tập tin văn bản sau khi 
trộn có tên ngầm định là Letters1, ta có thể ghi vào đĩa với tên khác. 
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Bài thực hành 1 
1. Khởi động chương trình Microsoft Word, chọn lệnh File | New  hay Click biểu 

tượng  trờn Standard Toolbar để thực hiện việc tạo mới tập tin, nhập vào nội 
dụng như sau: 

     ĐÂY THÔN VĨ DẠ 
Sao anh không về thăm thôn Vĩ? 
Nhìn nắng hàng cau nắng mới lên, 

Vườn ai mướt quá xanh như ngọc, 
Lỏ trúc che ngang mặt chữ điền. 
Gió theo lối gió, mây đường mây; 
Dòng nước buồn thiu hoa bắp lay. 

Thuyền ai đậu bến sông trăng đó? 
Có chở trăng về kịp tối nay? 
Mơ khách đường xa, khách đường xa, 
Áo em trắng quá nhìn không ra 

Ở đây sương khói mờ nhân ảnh 
Ai biết tình ai có đậm đà? 

2. Chọn menu File | Save hay nhấn tổ hợp phím Ctrl + S để ghi tập tin với tên  
bai-1.doc 

3. Định dạng bài thơ có dạng như sau: 
ĐÂY THÔN VĨ DẠ 

Sao anh kh□ng v□ th□m th□n V□? 

Nhìn n□ng hàng cau n□ng m□i lên, 

V□□n ai m□□t quá xanh nh□ ng□c, 

L□ trúc che ngang m□t ch□ □i□n. 
Gió theo l□i gió, m□y □□□ng m□y; 

Dòng n□□c bu□n thiu hoa b□p lay. 

Thuy□n ai □□u b□n s□ng tr□ng □ó? 

Có ch□ tr□ng v□ k□p t□i nay? 

M□ khách □□□ng xa, khách □□□ng 

xa, 

□o em tr□ng quá nhìn kh□ng ra 

□ □□y s□□ng khói m□ nh□n □nh 

Ai bi□t tình ai có □□m □à? 
4. Đánh dấu khối toàn bộ bài thơ trên. Dùng lệnh Format | Paragragh, chọn giá trị 

trong Line spacing là 1.5 lines. Quan sát khoảng cách các dòng của bài thơ, sau 
đó gỏ giá trị 1.2 tại At. 

5. Chọn menu File |  Save As... để ghi tập tin văn bản đang soạn thảo lên đĩa với tên 
là bai-2.doc. Thoát khỏi chương trình Microsoft Word. 
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Bài thực hành 2 
 

1.   Khởi động Microsoft Word, click biểu tượng        trên Standard Toolbar để mở tập tin 
mới. Dùng lệnh Format | Column để đánh vào đoạn văn bản sau theo ba cột :  

Một số hiện tượng nhận biết   
MÁY ĐÃ BỊ NHIỄM VIRUS 

-------------------------- 
 

Các tập tin chương 
trình của bạn cứ thấy 
nở ra, mỗi ngày một 
ít, nghĩa là kích thước 
tập tin cứ tăng dần lên.   
Tập tin chương trình có 
phần mở rộng COM, 

EXE  trước đây vốn 
chạy bình thường nay 
không chạy được 
hoặc chạy sai. 
Màn hình chỉ xuất hiện 
dấu nháy lấp lánh đứng 
yên một chỗ, các phím 

đều bị tê liệt, chỉ còn 
cách bấm tổ hợp phím 
Ctrl-Alt-Del hoặc 
dùng nút Reset để khởi 
động máy, song máy 
vẫn ở tình trạng ban 
đầu ... 

 
2.  Gõ Ctrl+S để ghi tập tin lên đĩa với tên BAI-3.DOC. Rồi mở tiếp tập tin mới nhập 

và trình bày văn bản sau : 
 

 
   

 
MỤC TIÊU :  

ào tạo học viên soạn thảo văn bản, lập biểu báo cáo, xử lý số liệu ... trên môi 
trường Windows. 

CHƯƠNG TRÌNH: (Có phát giáo trình miễn phí) 
 WINDOWS 
 Phần mềm xử lý văn bản   : WINWORD  
 Phần mềm xử lý bảng tính : EXCEL  

THỜI GIAN VÀ LỊCH HỌC: 
 Thời gian : 8 tuần (48 tiết LT  -  48 tiết TH) 
 Lịch học  :   

  Ngày khai giảng     Thời gian          Giảng viên 
 
 05/09 13g30 - 16g45 Lê Văn Hùng 
 10/09 17g30 - 20g45 Võ Tấn Long 
 15/09 08g00 - 11g15 Lê Dũng 

  Hỏi chi tiết và ghi danh từ 15/08/04  đến 15/09/04, trong giờ làm việc tại: 

  TRUNG TÂM ĐÀO TẠO & ỨNG DỤNG TIN HỌC ABC 
  5 NAM QUỐC CANG - Q.1 - TP. HCM 
  ĐT : 8862824  

3.  Gõ Ctrl+S để ghi tập tin văn bản đang soạn lên đĩa với tên là BAI-4.DOC rồi thoát 
khỏi  Microsoft Word.

 Đ 

THÔNG BÁO TUYỂN SINH 
Lớp Tin học Văn phòng  
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Bài thực hành 3 

 
 
 
 

  
 
 
 

THỜI GIAN HỌC  ( 8 THÁNG )  
   NGÀY KHAI GIẢNG 

BUỔI HỌC GIỜ HỌC 
GIẢNG VIÊN 

04/04/2004 2 - 4 - 6 14g00 - 17g00 Nguyễn Minh Châu 

05/04/2004 3 - 5 - 7 17g30 - 20g30 Hoàng Thị Hương 

10/04/2004 2 - 5 - CN 08g00 - 11g00 Trần Túc 

 
           BAN ĐÀO TẠO 
 

2.  Gõ Ctrl+S để ghi tập tin văn bản đang soạn lên đĩa với tên là BAI-5.DOC rồi thoát khỏi  
Microsoft Word. 

 
 
 

  KẾ HOẠCH HỌC TẬP 
  LỚP KỸ THUẬT VIÊN VĂN PHÒNG 
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Bài thực hành 4 

1.  Vào Microsoft Word, mở tập tin mới và đánh vào nội dung sau : 

 

áy tính điện tử là công cụ xử lý thông tin một cách tự động theo một chương trình 
được xác định trước mà không cần sự tham gia trực tiếp của con người. 

Khi sử dụng máy tính để giải quyết một vấn đề nào đó :  
Bản thân máy tính không thể tự tìm được cách giải quyết, con người 
phải cung cấp đầy đủ ngay từ đầu cho máy tính các chỉ thị để 
hướng dẫn cho máy tính thực hiện đúng vấn đề đặt ra. Tập 
hợp các chỉ thị do con người soạn ra theo một ngôn ngữ mà 
máy tính hiểu được gọi là chương trình.  
 

SƠ ĐỒ KHỐI CƠ BẢN 
CỦA MỘT HỆ THỐNG MÁY VI TÍNH 

 
 
      
 
             
 
        
 
          
     
                          
 
 
 

2.  Gõ Ctrl+S để ghi tập tin văn bản đang soạn lên đĩa với tên là BAI-6.DOC rồi thoát khỏi  
Microsoft Word. 

 
 
 
 
 
 
 

 

M 

Các thiết bị nhập 
(INPUT DEVICE) 

 Bàn phím, 
   Con chuột ... 

 
Bộ nhớ trong 

(ROM + RAM) 

Khối xử lý trung tâm 
(CPU) 

Các thiết bị xuất 
(OUTPUT DEVICE)

Màn hình, 
Máy in ... 

Bộ nhớ ngoài 
(AUXILIARY STORAGE)

Đĩa cứng, 
    Đĩa mềm ... 
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Bài thực hành 5 

Khởi động chương trình Microsoft Word. Soạn thảo và định dạng văn bản như sau (Lưu tập tin với tên 
bai-7.doc):: 

 
 

 
 
 
 

 

 

 

A
SI

A
 

Phiếu bình chọn 
 Bài hát hay nhất  : 
 Bài hát bạn thích : 
 Số người dự đoán: 
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Bài thực hành 6 

1.  Vào Microsoft Word, mở tập tin mới và đánh vào nội dung sau: 

 
STT HỌ LÓT TÊN PHÁI NƠI SINH ĐIỂM 

1 
2 
3 
4 
5 
6 

Hồ Thị 
Lê Văn 
Nguyễn Thị 
Nguyễn Văn 
Trần Đức 
Võ Văn 

Hồng 
An 
Tâm 
Long 
Bình 
Hoa 

Nữ 
Nam 
Nữ 
Nam 
Nam 
Nam 

Huế 
Nha Trang 
Long An 
Hà Nội 
Vũng Tàu 
Long An 

8 
7 
10 
4 
9 
5 

       (Bảng 1) 
2.  Đánh dấu khối toàn bộ bảng và sao chép thêm 2 bảng nữa, gọi là bảng 2 và bảng 3. 
3.  Sắp xếp bảng 2 theo cột điểm giảm dần. 
4.  Sắp xếp bảng 3 theo cột Tên tăng dần. 
5.  Lập bảng sau thống kê sau : 
 

Nghiệp vụ Tin học  Thời gian công tác Tin học 

Cấp đào tạo 

 

Cấp quản lý 

Trung
ương 

Địa 
phương 

Sử 
dụng 

Hướng 
dẫn 

Dưới 3 năm Từ 3 năm trở lên 

Trung ương  
(463) 

64 399 363 100 314 149 

Địa phương   
(388) 

43 345 287 101 306 82 

Tư nhân 

(165) 
12 153 118 47 131 34 

Tổngsố 
(1016) 

     

 
6.  Dùng lệnh Table | Formula tính tổng các cột trong bảng ghi vào dòng cuối tương 

ứng. 

7.  Gõ Ctrl+S để ghi tập tin văn bản đang soạn lên đĩa với tên là BAI-8.DOC rồi thoát 
khỏi  Ms. Word. 

 

KẾT QUẢ THI 
LỚP TIN HỌC CĂN BẢN - K1 
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Bài thực hành 7 

1.  Vào Microsoft Word, mở tập tin mới và đánh vào nội dung sau: 
 
Các loại đĩa mềm thông dụng hiện nay 

 

Loại đĩa 

Kích thước Mật độ 
Dung lượng 

5.25 inch 
5.25 inch 
  3.5 inch 
  3.5 inch 

 

kép 
cao 
kép 
cao 

360 KB 
 1.2 MB 
720 KB 
1.44 MB         

 
 
 

MỘT MINH HỌA CHU KỲ HOẠT ĐỘNG CỦA MÁY VI TÍNH 
 

 Một chương trình được chép từ đĩa và chứa 
trong bộ nhớ trong. 

 Dưới sự điều khiển của chương trình 
được chứa, dữ liệu được nhập từ bàn 
phím và chứa trong bộ nhớ trong. 

 CPU thao tác dữ liệu. 

 Kết quả của chương trình sau khi được CPU xử lý 
xong được chứa trở lại trong bộ nhớ trong. 

 Cuối cùng kết quả được xuất ra. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5. Gõ Ctrl+S để ghi tập tin văn bản đang soạn lên đĩa với tên là BAI-9.DOC rồi thoát 

khỏi  Ms Word. 
 

  

CPU

 
Kết quả Chương 

trỡnh 

 
Dữ liệu 

Main Memory

(1) 

(3) (4)

(5) 

(2) 

Chương trình

phổ biến nhất 
hiện nay 
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Bài thực hành 8 

1.  Vào Microsoft Word, mở tập tin mới và đánh vào nội dung sau: 
 

A- Biện luận phương trình bậc hai:  ax2 + bx + c = 0  (a ≠ 0)  

Lập ∆ = b2 - 4ac s 

 ∆ < 0 : PT vô nghiệm 
 ∆ = 0 : PT có nghiệm kép x1 = x2 = 

a
b
2

− .  

 ∆ > 0 : PT có 2 nghiệm phân biệt x1,2 = 
a

b
2

∆±− . 

B- eexx
x
x

x
x

x
x

==
⎥
⎥
⎦

⎤

⎢
⎢
⎣

⎡
+=+

→→
2
12

sin

sin
1

0
2
1

0
)sin1(lim)sin1(lim  

C- Tính các tích phân : 

       a) ∫ xx
dx

22 cos.sin
;    b)  ∫ xdxg 2cot ; c)  ∫ −++ dxxx

x
44

3 21
 

D-  Xác định hạng của ma trận A theo tham số thực λ : 

   A =

⎥
⎥
⎥
⎥

⎦

⎤

⎢
⎢
⎢
⎢

⎣

⎡

3314
417101
2741
213 λ

. 

E- Giải hệ phương trình tuyến tính sau: 

   
⎪
⎩

⎪
⎨

⎧

=−−
=+−
−=++

2563
23

952

321

321

321

xxx
xxx
xxx

. 

 
F- Sơ đồ câu lệnh IF trong Pascal    

   
           Biểu thức       sai 

  logic 

        đúng 

                             Lệnh_P 

 

 

2. Ghi tập tin văn bản đang soạn lên đĩa với tên là BAI-10.DOC rồi thoát khỏi  Ms. Word. 
 



 
 
 

Microsoft word 
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ĐÂY LÀ TÀI LIỆU VỀ WORD 03-07-10 TUY 

KHÔNG NÓI HẾT ĐƢƠC TẤT CẢ NHƢNG 

CŨNG 1 PHẦN NÀO ĐÓ CÓ ÍCH CHO MỌI 

NGƢỜI 

( MỌI NGƢỜI NÊN DÙNG OFFICE 2010 VÌ 

NÓ CÓ NHIỀU TÍNH NĂNG HAY MÀ KHI 

NHỮNG NGƢỜI DÙNG PHIÊN BẢN THẤP 

HƠN CŨNG CÓ THỂ MỞ ĐƢỢC BẠN CÓ 

THỂ LƢU DƢỚI DẠNG .DOC HOẶC PDF…..) 

Microsoft word  

 

  

Bài mở đâu 

  

1. Giíi thiÖu phÇn mÒm Microsoft Winword  

So¹n th¶o v¨n b¶n lµ c«ng viÖc ®−îc sö dông rÊt nhiÒu trong c¸c c¬ 

quan, xÝ nghiÖp còng nh− nhu cÇu cña bÊt kú c¸ nh©n nµo hiÖn nay.  

Tõ thña xa x−a con ng−êi ®· biÕt sö dông m¸y mãc vµo viÖc so¹n th¶o 

v¨n b¶n (m¸y gâ ch÷). Gâ ®Õn ®©u, v¨n b¶n ®−îc in ra ngay ®Õn ®ã trªn 

giÊy. C¸c c«ng viÖc dÞch chuyÓn trªn v¨n b¶n, còng nh− c¸c kü n¨ng so¹n 

th¶o v¨n b¶n cßn rÊt th« s¬, ®¬n gi¶n. §Ó t¹o ra ®−îc mét v¨n b¶n, ®ßi hái 

ng−êi so¹n th¶o ph¶i cã nh÷ng kü n¨ng sö dông m¸y gâ rÊt tèt (kh«ng 

nh− m¸y tÝnh b©y giê, hÇu nh− ai còng cã thÓ häc vµ so¹n th¶o ®−îc mét 

c¸ch râ rµng). So¹n th¶o lµ nh− vËy, cßn vÒ in Ên còng cã v« cïng khã 

kh¨n. §ã lµ ngµy x−a, khi mµ c«ng nghÖ th«ng tin cßn ch−a ph¸t triÓn.  

Ngµy nay, khi mµ c«ng nghÖ th«ng tin ®ang ph¸t triÓn rÇm ré, c«ng 

nghÖ thay ®æi tõng ngµy, nh÷ng bµi to¸n, nh÷ng khã kh¨n cña con ng−êi 
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®ang dÇn dÇn ®−îc m¸y tÝnh ho¸, th× viÖc so¹n th¶o nh÷ng v¨n b¶n b»ng 

m¸y tÝnh ®· trë thµnh nh÷ng c«ng viÖc rÊt b×nh th−êng cho bÊt kú ai biÕt 

sö dông m¸y tÝnh. Mét trong nh÷ng phÇn mÒm m¸y tÝnh ®−îc sö dông 
réng r·i nhÊt hiÖn nay lµ Microsoft Word cña h·ng Microsoft hay cßn gäi 
phÇn mÒm Winword.  

Ra ®êi tõ cuèi nh÷ng n¨m 1980, ®Õn nay phÇn mÒm Winword ®· ®¹t 

®−îc tíi sù hoµn h¶o trong lÜnh vùc so¹n th¶o v¨n b¶n còng nh− trong 
lÜnh vùc v¨n phßng cña bé phÇn mÒm Microsoft Office nãi chung. Cã thÓ 

liÖt kª c¸c ®Æc ®iÓm næi bËt cña phÇn mÒm nµy nh− sau:  

 - Cung cÊp ®Çy ®ñ nhÊt c¸c kü n¨ng so¹n th¶o vµ ®Þnh d¹ng v¨n b¶n 
®a d¹ng, dÔ sö dông;  

 - Kh¶ n¨ng ®å ho¹ ®· m¹nh dÇn lªn, kÕt hîp víi c«ng nghÖ OLE 

(Objects Linking and Embeding) b¹n cã thÓ chÌn ®−îc nhiÒu h¬n 

nh÷ng g× ngoµi h×nh ¶nh vµ ©m thanh lªn tµi liÖu word nh−: biÓu 
®å, b¶ng tÝnh,.v.v.  

 - Cã thÓ kÕt xuÊt, nhËp d÷ liÖu d−íi nhiÒu lo¹i ®Þnh d¹ng kh¸c 
nhau. §Æc biÖt kh¶ n¨ng chuyÓn ®æi d÷ liÖu gi÷a Word víi c¸c 
phÇn mÒm kh¸c trong bé Microsoft Office ®· lµm cho viÖc xö lý 
c¸c øng dông v¨n phßng trë nªn ®¬n gi¶n vµ hiÖu qu¶ h¬n.  

 - DÔ dµng kÕt chuyÓn tµi liÖu thµnh d¹ng HTML ®Ó chia sÎ d÷ liÖu 

trªn m¹ng néi bé, còng nh− m¹ng Internet.  

 

2. C¸ch khëi ®éng  

Cã rÊt nhiÒu c¸ch cã thÓ khëi ®éng ®−îc phÇn mÒm Word. Tuú vµo 
môc ®Ých lµm viÖc, së thÝch hoÆc sù tiÖn dông mµ ta cã thÓ chän mét 
trong c¸c c¸ch sau ®©y ®Ó khëi ®éng:  

C¸ch 1: Chän lÖnh Start cña Windows: Start | Programs | 

Microsoft Word  

C¸ch 2: Nh¸y kÐp chuét lªn biÓu t−îng cña phÇn mÒm Word 

  nÕu nh− nh×n thÊy nã bÊt kú ë chç nµo: trªn thanh t¸c vô 
(task bar), trªn mµn h×nh nÒn cña Windows, vv..  

C¸ch 3: NÕu muèn më nhanh mét tÖp v¨n b¶n võa so¹n th¶o gÇn ®©y 

nhÊt trªn m¸y tÝnh ®ang lµm viÖc, cã thÓ chän Start | Documents, chän 

tªn tÖp v¨n b¶n (Word) cÇn më. Khi ®ã Word sÏ khëi ®éng vµ më ngay 
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tÖp v¨n b¶n võa chØ ®Þnh.  

3. M«i truêng lµm viÖc  

Sau khi khëi ®éng xong, mµn h×nh lµm viÖc cña Word th−êng cã d¹ng 

nh− sau:  

   

 

Th−êng th× m«i tr−êng lµm viÖc trªn Word gåm 4 thµnh phÇn chÝnh:  

 - Cöa sæ so¹n th¶o tµi liÖu: Lµ n¬i ®Ó chÕ b¶n tµi liÖu. B¹n cã thÓ 

gâ v¨n b¶n, ®Þnh d¹ng, chÌn c¸c h×nh ¶nh lªn ®©y. Néi dung trªn 

cöa sæ nµy sÏ ®−îc in ra m¸y in khi sö dông lÖnh in.  

 - HÖ thèng b¶ng chän (menu): chøa c¸c lÖnh ®Ó gäi tíi c¸c chøc 

n¨ng cña Word trong khi lµm viÖc. B¹n ph¶i dïng chuét ®Ó më 
c¸c môc chän nµy, ®«i khi còng cã thÓ sö dông tæ hîp phÝm t¾t ®Ó 
gäi nhanh tíi c¸c môc chän.  

 - HÖ thèng thanh c«ng cô: bao gåm rÊt nhiÒu thanh c«ng cô, mçi 

thanh c«ng cô bao gåm c¸c nót lÖnh ®Ó phôc vô mét nhãm c«ng 
viÖc nµo ®ã. VÝ dô: khi so¹n th¶o v¨n b¶n, b¹n ph¶i sö dông ®Õn 

thanh c«ng cô chuÈn Standard vµ thanh c«ng cô ®Þnh d¹ng 

Formating; hoÆc khi vÏ h×nh cÇn ®Õn thanh c«ng cô Drawing ®Ó 

lµm viÖc.  

 - Th−íc kÎ: gåm 2 th−íc (ruler) bao viÒn trang v¨n b¶n. Sö dông 

th−íc nµy b¹n cã thÓ ®iÒu chØnh ®−îc lÒ trang v¨n b¶n, còng nh− 
thiÕt lËp c¸c ®iÓm dÞch (tab) mét c¸ch ®¬n gi¶n vµ trùc quan.     
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 - Thanh tr¹ng th¸i: gióp b¹n biÕt ®−îc mét vµi tr¹ng th¸i cÇn thiÕt 

khi lµm viÖc. VÝ dô: b¹n ®ang lµm viÖc ë trang mÊy, dßng bao 
nhiªu, .v.v.  

 

4. T¹o mét tµi liÖu míi  

Lµm viÖc víi word lµ lµm viÖc trªn c¸c tµi liÖu (Documents). Mçi tµi 

liÖu ph¶i ®−îc cÊt lªn ®Üa víi mét tÖp tin cã phÇn më réng .DOC. Th−êng 

th× c¸c tÖp tµi liÖu cña b¹n sÏ ®−îc cÊt vµo th− môc C:\My Documents 

trªn ®Üa cøng. Tuy nhiªn, b¹n cã thÓ thay ®æi l¹i th«ng sè nµy khi lµm 
viÖc víi Word.  

Th«ng th−êng sau khi khëi ®éng Word, mét mµn h×nh tr¾ng xuÊt hiÖn. 
§ã còng lµ tµi liÖu míi mµ Word tù ®éng t¹o ra. Tuy nhiªn ®Ó t¹o mét tµi 
liÖu míi, b¹n cã thÓ sö dông mét trong c¸c c¸ch sau:  

 

Cöa sæ so¹n th¶o tµi liÖu 

 
HÖ thèng b¶ng chän  
 
HÖ thèng thanh c«ng cô  
 

Th−íc kÎ 
 
Thanh tr¹ng th¸i 

- Më môc chän File | New..;  

hoÆc  

- NhÊn nót New   trªn thanh c«ng cô Standard;  

hoÆc  

- NhÊn tæ hîp phÝm t¾t Ctrl + N.  

5. Ghi tµi liÖu lªn ®Üa  

 §Ó ghi tµi liÖu ®ang lµm viÖc lªn ®Üa, b¹n cã thÓ chän mét trong c¸c c¸ch 
sau:  

 - Më môc chän File | Save..;  

 

hoÆc  
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 - NhÊn nót Save   trªn thanh c«ng cô Standard;  

 

hoÆc  

 - NhÊn tæ hîp phÝm t¾t Ctrl + S.  

 

SÏ cã hai kh¶ n¨ng x¶y ra:  

NÕu ®©y lµ tµi liÖu míi, hép tho¹i Save As xuÊt hiÖn, cho phÐp ghi tµi 

liÖu nµy bëi mét tÖp tin míi:  

   

 

H·y x¸c ®Þnh th− môc (Folder)- n¬i sÏ chøa tÖp tin míi nµy råi gâ tªn 

tÖp tin vµo môc File name: (vÝ dô Vanban1 råi nhÊn nót Save ®Ó kÕt thóc 

viÖc ghi néi dung tµi liÖu.  

NÕu tµi liÖu cña b¹n ®· ®−îc ghi vµo mét tÖp, khi ra lÖnh cÊt tÊt c¶ 

nh÷ng sù thay ®æi trªn tµi liÖu sÏ ®−îc ghi l¹i lªn ®Üa.  

  

  

 
Gâ tªn tÖp tin vµo ®©y!  
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 B¹n nªn thùc hiÖn thao t¸c ghi tµi liÖu võa råi th−êng xuyªn trong khi so¹n tµi liÖu, ®Ó tr¸nh mÊt d÷ 
liÖu khi gÆp c¸c sù cè mÊt ®iÖn, hay nh÷ng trôc trÆc cña m¸y tÝnh.  

6. Më tµi liÖu ®∙ tån t¹i trªn ®Üa  

Tµi liÖu sau khi ®· so¹n th¶o trªn Word ®−îc l−u trªn ®Üa d−íi d¹ng 

tÖp tin cã phÇn më réng lµ .DOC. §Ó më mét tµi liÖu Word ®· cã trªn ®Üa, 

b¹n cã thÓ chän mét trong c¸c c¸ch sau ®©u:  

 - Më môc chän File | Open;  

 

hoÆc  

 - NhÊn tæ hîp phÝm t¾t Ctrl+O.  

 

Hép tho¹i Open xuÊt hiÖn:  

   

H·y t×m ®Õn th− môc n¬i chøa tÖp tµi liÖu cÇn më trªn ®Üa, chän tÖp tµi 

liÖu, cuèi cïng nhÊn nót lÖnh   ®Ó tiÕp tôc. TÖp tµi liÖu sÏ ®−îc 
më ra trªn mµn h×nh Word.  

MÆt kh¸c, b¹n còng cã thÓ thùc hiÖn më rÊt nhanh nh÷ng tÖp tµi liÖu ®· 

lµm viÖc gÇn ®©y nhÊt b»ng c¸ch më môc chän File nh− sau:  
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 TiÕp theo nhÊn chuét lªn tªn tÖp tµi liÖu cÇn më.  

7. Tho¸t khái m«i tr−êng lµm viÖc  

Khi kh«ng lµm viÖc víi Word, b¹n cã thÓ thùc hiÖn theo mét trong c¸c 
c¸ch sau:  

 - Më môc chän File | Exit    

 

hoÆc  

 - NhÊn tæ hîp phÝm t¾t Alt + F4.  

 
 
NhÊn chuét lªn tÖp tµi liÖu cÇn më !  

Ch−¬ng 1: 

so¹n th¶o c¬ b¶n  

  

1.1 Mét sè thao t¸c so¹n th¶o c¬ b¶n  

1.1.1 NhËp v¨n b¶n  

NhËp v¨n b¶n lµ kh©u ®Çu tiªn trong qui tr×nh so¹n th¶o tµi liÖu. 

Th«ng th−êng l−îng v¨n b¶n (Text) trªn mét tµi liÖu lµ rÊt nhiÒu, b¹n 

tiÕp cËn ®−îc cµng nhiÒu nh÷ng tÝnh n¨ng nhËp v¨n b¶n th× cµng tèt, 
bëi lÏ nã sÏ lµm t¨ng tèc ®é chÕ b¶n tµi liÖu.  

a. Sö dông bé gâ tiÕng ViÖt  
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Ban ®Çu, m¸y tÝnh ch−a cã b¶ng m· tiÕng ViÖt mµ chØ cã duy nhÊt 
b¶ng m· chuÈn ASCCI. B¶ng m· nµy bao gåm 128 kü tù La tinh (c¸c 
phÝm ch÷, c¸c phÝm sè vµ mét sè c¸c ký hiÖu ®Æc biÖt).   

§Ó cã thÓ ®−a ®−îc tiÕng ViÖt sö dông trªn m¸y tÝnh, c¸c nhµ lËp 
tr×nh ph¶i x©y dùng phÇn mÒm gâ tiÕng ViÖt vµ c¸c bé ph«ng ch÷ tiÕng 
ViÖt ®i kÌm.  

HiÖn nay cã kh¸ nhiÒu c¸c bé gâ tiÕng ViÖt ®ang ®−îc sö dông nh−: 

VNI- ®−îc sö dông réng r·i ë phÝa Nam, VietWare- ®−îc sö dông 

nhiÒu ë miÒn Trung vµ ABC, Vietkey th× ®−îc sö dông réng r·i ngoµi 

B¾c.  

Do mçi n¬i sö dông nh÷ng bé gâ riªng (b¶ng m· tiÕng ViÖt còng 
kh¸c nhau) nªn viÖc trao ®æi th«ng tin gÆp rÊt nhiÒu khã kh¨n. Míi ®©y 

ChÝnh phñ ®· khuyÕn c¸o sö dông bé gâ vµ bé ph«ng ch÷ Unicode. 

Víi hÖ thèng míi nµy viÖc trao ®æi th«ng tin ®· trë nªn ®¬n gi¶n h¬n 

rÊt nhiÒu. Tuy nhiªn nã vÉn gÆp ph¶i mét sè khã kh¨n v× tÝnh t−¬ng 
thÝch víi c¸c hÖ thèng phÇn mÒm cò trªn m¸y tÝnh kh«ng cao. TÊt 

nhiªn, Unicode sÏ lµ gi¶i ph¸p tiÕng ViÖt trong t−¬ng lai.  

PhÇn mÒm tiÕng ViÖt chóng t«i giíi thiÖu trong cuèn gi¸o tr×nh nµy 

lµ ABC hoÆc Vietkey víi kiÓu gâ Telex. M¸y tÝnh cña b¹n ph¶i ®−îc 

gµi ®Æt phÇn mÒm nµy ®Ó cã ®−îc bé gâ vµ bé ph«ng ch÷ ®i kÌm.  

Khi nµo trªn mµn h×nh cña b¹n xuÊt hiÖn biÓu t−îng:   hoÆc 

  lµ khi b¹n cã thÓ gâ ®−îc tiÕng ViÖt. NÕu biÓu t−îng xuÊt 

hiÖn ch÷ E   (kiÓu gâ tiÕng Anh), b¹n ph¶i nhÊn chuét lªn biÓu 

t−îng lÇn n÷a hoÆc nhÊn tæ hîp phÝm nãng Alt + Z  ®Ó chuyÓn vÒ chÕ 

®é gâ tiÕng ViÖt. Qui t¾c gâ tiÕng ViÖt nh− sau:  

Gâ  §−îc ch÷    Gâ  §−îc dÊu  

aa  ©    f  huyÒn  

aw  ¨    s  s¾c  

oo  «    r  hái  

ow  ¬    x  ng·  

w  −    j  nÆng  

 

VÝ dô:  
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 Muèn gâ tõ: “ Céng hoµ x∙ héi chñ nghÜa ViÖt Nam”  

B¹n ph¶i bËt tiÕng ViÖt vµ gâ lªn tµi liÖu nh− sau:  

      “Coongj hoaf xax hooij chur nghiax Vieetj Nam”  

* NÕu gâ z, tõ tiÕng ViÖt sÏ bÞ bá dÊu.  

b. Sö dông bµn phÝm   

BËt tiÕng ViÖt (nÕu b¹n muèn gâ tiÕng ViÖt) vµ sö dông nh÷ng thao 

t¸c so¹n th¶o th«ng th−êng ®Ó so¹n th¶o tµi liÖu nh− lµ:  

 - C¸c phÝm ch÷ a, b, c, .. z;  

 - C¸c phÝm sè tõ 0 ®Õn 9;  

 - C¸c phÝm dÊu: ‘,><?[]{}…  

 - Sö dông phÝm Shift ®Ó gâ ch÷ in hoa vµ mét sè dÊu;  

 - Sö dông phÝm Caps Lock ®Ó thay ®æi kiÓu gâ ch÷ in hoa vµ ch÷ 

th−êng;  

 - Sö dông phÝm ↵ Enter ®Ó ng¾t ®o¹n v¨n b¶n;  

 - Sö dông phÝm Tab ®Ó dÞch ®iÓm Tab;  

 - Sö dông phÝm Space Bar ®Ó chÌn dÊu c¸ch;  

 - Sö dông c¸c phÝm mòi tªn: ←↑↓→ ®Ó dÞch chuyÓn con trá trªn tµi 
liÖu;  

 - Sö dông phÝm Page Up vµ Page Down ®Ó dÞch chuyÓn con trá vÒ 

®Çu hoÆc cuèi tõng trang mµn h×nh;  

 - PhÝm Home, End ®Ó ®−a con trá vÒ ®Çu hoÆc cuèi dßng v¨n b¶n;  

 - PhÝm Delete ®Ó xo¸ ký tù v¨n b¶n ®øng kÒ sau ®iÓm trá;  

 - PhÝm Backspace ®Ó xo¸ ký tù ®øng kÒ tr−íc ®iÓm trá  

 

1.1.2 Thao t¸c trªn khèi v¨n b¶n  

Môc nµy cung cÊp nh÷ng kü n¨ng thao t¸c trªn mét khèi v¨n b¶n bao 
gåm : sao chÐp, c¾t d¸n, di chuyÓn khèi v¨n b¶n. Gióp lµm t¨ng tèc ®é 
so¹n th¶o v¨n b¶n.  
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a. Sao chÐp   

Sao chÐp khèi v¨n b¶n lµ qu¸ tr×nh t¹o mét khèi v¨n b¶n míi tõ mét 

khèi v¨n b¶n ®· cã s½n. Ph−¬ng ph¸p nµy ®−îc ¸p dông khi b¹n cÇn 
ph¶i gâ l¹i mét ®o¹n v¨n b¶n gièng hÖt hoÆc gÇn gièng víi mét ®o¹n 

v¨n b¶n ®· cã s½n trªn tµi liÖu vÒ mÆt néi dung còng nh− ®Þnh d¹ng 
(chóng ta sÏ t×m hiÓu kh¸i niÖm ®Þnh d¹ng ë phÇn tiÕp theo). C¸ch lµm 

nh− sau:  

B−íc 1: Lùa chän (b«i ®en) khèi v¨n b¶n cÇn sao chÐp. §Ó lùa chän 

khèi v¨n b¶n b¹n lµm nh− sau:  

 - Di chuét vµ khoanh vïng v¨n b¶n cÇn chän;  

 

hoÆc  

 - Dïng c¸c phÝm mòi tªn ←↑↓→ kÕt hîp viÖc gi÷ phÝm Shift ®Ó 

chän vïng v¨n b¶n. Chän ®Õn ®©u b¹n sÏ thÊy v¨n b¶n ®−îc b«i 

®en ®Õn ®ã.  

 

B−íc 2: Ra lÖnh sao chÐp d÷ liÖu b»ng mét trong c¸c c¸ch:  

- Më môc chän Edit | Copy ;  

hoÆc  

 - NhÊn nót Copy   trªn thanh c«ng cô Standard;  

hoÆc  

- NhÊn tæ hîp phÝm nãng Ctrl + C;  

 

B−íc 3: D¸n v¨n b¶n ®· chän lªn vÞ trÝ cÇn thiÕt. B¹n lµm nh− sau:  

§Æt con trá vµo vÞ trÝ cÇn d¸n v¨n b¶n, ra lÖnh d¸n b»ng mét trong 
c¸c c¸ch sau:  

 - Më môc chän Edit | Paste ;  

 

hoÆc  

 - NhÊn nót Paste   trªn thanh c«ng cô Standard;  



 

 

GIÁO TRÌNH WORD 2003-2007-2010 Page 11 

 

BÙI QUYẾT TIẾN 2011 

 

 hoÆc  

 - NhÊn tæ hîp phÝm nãng Ctrl + V.  

 

B¹n sÏ thÊy mét ®o¹n v¨n b¶n míi ®−îc d¸n vµo vÞ trÝ cÇn thiÕt. B¹n 

cã thÓ thùc hiÖn nhiÒu lÖnh d¸n liªn tiÕp, d÷ liÖu ®−îc d¸n ra sÏ lµ d÷ 
liÖu cña lÇn ra lÖnh Copy gÇn nhÊt.  

b. Di chuyÓn khèi v¨n b¶n   

Víi ph−¬ng ph¸p sao chÐp v¨n b¶n, sau khi sao chÐp ®−îc ®o¹n v¨n 
b¶n míi th× ®o¹n v¨n b¶n cò vÉn tån t¹i ®óng vÞ trÝ cña nã. NÕu muèn 

khi sao chÐp ®o¹n v¨n b¶n ra mét n¬i kh¸c vµ ®o¹n v¨n b¶n cò sÏ ®−îc 

xo¸ ®i (tøc lµ di chuyÓn khèi v¨n b¶n ®Õn mét vÞ trÝ kh¸c), ph−¬ng 

ph¸p nµy sÏ gióp lµm ®iÒu ®ã. Cã thÓ thùc hiÖn theo hai c¸ch nh− sau:  

 C¸ch 1:   

  B−íc 1: Lùa chän khèi v¨n b¶n cÇn di chuyÓn;  

B−íc 2: Ra lÖnh c¾t v¨n b¶n cã thÓ b»ng mét trong c¸c c¸ch sau:  

 - Më môc chän Edit | Cut ;  

 

  hoÆc  

 - NhÊn nót Cut   trªn thanh c«ng cô Standard;  

 

 hoÆc  

 - NhÊn tæ hîp phÝm nãng Ctrl + X.  

V¨n b¶n ®· chän sÏ bÞ c¾t ®i, chóng sÏ ®−îc l−u trong bé nhí ®Öm 
(Clipboard) cña m¸y tÝnh.  

 

B−íc 3: Thùc hiÖn lÖnh d¸n v¨n b¶n (Paste) nh− ®· giíi thiÖu ë trªn 

vµo vÞ trÝ ®Þnh tr−íc.  

 C¸ch 1:   

  B−íc 1: Lùa chän khèi v¨n b¶n cÇn di chuyÓn;  
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B−íc 2: Dïng chuét kÐo rª vïng v¨n b¶n ®ang chän vµ th¶ lªn vÞ trÝ 

cÇn di chuyÓn ®Õn.  

Ph−¬ng ph¸p nµy gäi lµ kÐo – th¶ (drag and drop).  

1.1.3 ThiÕt lËp Tab  

Tab lµ c«ng cô ®−îc sö dông rÊt nhiÒu trong viÖc nhËp v¨n b¶n. 

Ngoµi kh¶ n¨ng dÞch chuyÓn ®iÓm trá theo tõng b−íc nhÈy, môc nµy sÏ 

giíi thiÖu c¸ch sö dông Tab cho viÖc t¹o mét v¨n b¶n hiÓn thÞ d−íi 
d¹ng c¸c cét.  

Bµi to¸n ®Æt ra: h·y t¹o b¶ng d÷ liÖu nh− sau:  

 STT Hä vµ tªn §Þa chØ  

 1 NguyÔn V¨n Quang 123, T©y S¬n  

 2 Hå H¶i Hµ 68, NguyÔn Du  

 3 D−¬ng Quèc To¶n 23/10 NguyÔn Tr·i  

 4 NguyÔn Anh §øc 32/7 NguyÔn Tr·i  

  C¸c b−íc lµm nh− sau:  

  B−íc 1: §Þnh nghÜa kho¶ng c¸ch cho c¸c cét cña b¶ng bëi hép tho¹i Tab 

nh− sau:  

 Më b¶ng chän Format | Tab.., hép tho¹i Tab xuÊt hiÖn:  

   

 - Hép Default tab stops: ®Ó thiÕt lËp b−íc nhÈy ngÇm ®Þnh cña 

Tab. H×nh trªn b−íc nhÈy ngÇm ®Þnh lµ 0.5 cm (tøc lµ mçi khi 
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nhÇn phÝm Tab, con trá sÏ dÞch mét ®o¹n 0.5 cm trªn mµn h×nh 

so¹n th¶o). B¹n cã thÓ thay ®æi gi¸ trÞ b−íc nh¶y ngÇm ®Þnh Tab 
trªn mµn h×nh so¹n th¶o Word b»ng c¸ch gâ mét gi¸ trÞ sè ( ®¬n vÞ 
lµ cm) vµo hép nµy;  

 - B¶ng trªn cã 3 cét, mçi cét sÏ ®−îc b¾t ®Çu t¹i mét vÞ trÝ cã 
kho¶ng c¸ch cè ®Þnh ®Õn lÒ tr¸i trang v¨n b¶n mµ ta ph¶i thiÕt lËp 
ngay sau ®©y. Gi¶ sö cét STT c¸ch lÒ tr¸i 1cm, cét Hä vµ tªn c¸ch 
lÒ tr¸i 3 cm, cét §Þa chØ c¸ch lÒ tr¸i 8 cm. Khi ®ã ph¶i thiÕt lËp c¸c 

th«ng sè nµy trªn hép tho¹i Tab nh− sau:  

Hép Tab stop position: gâ 1 (gâ kho¶ng c¸ch tõ cét STT ®Õn mÐp 

lÒ tr¸i trang v¨n b¶n; ë môc Alignment- chän lÒ cho d÷ liÖu trong 

cét nµy (cét STT): Left ‟ canh lÒ d÷ liÖu bªn tr¸i cét, Right- canh 

lÒ bªn ph¶i cét, Center ‟ c¨n lÒ gi÷a cét, h·y chän Center. Chän 

xong nhÊn nót Set. T−¬ng tù lÇn l−ît khai b¸o vÞ trÝ Tab cho c¸c 

cét cßn l¹i: Hä vµ tªn (3) vµ cét §Þa chØ (8). §Ðn khi hép tho¹i Tab 
cã d¹ng:  

   

Cuèi cïng nhÊn nót Ok ®Ó hoµn tÊt viÖc thiÕt lËp tab cho c¸c cét 

vµ cã thÓ sö dông chóng nót Clear- ®Ó xo¸ bá ®iÓm Tab ®ang 

chän; nót Clear All - ®Ó xo¸ bá toµn bé c¸c ®iÓm tab ®ang thiÕt 

lËp trªn hép tho¹i).  

B−íc 2: C¸ch sö dông nh÷ng ®iÓm Tab võa thiÕt lËp ë trªn ®Ó t¹o 

b¶ng d÷ liÖu:  
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Khi con trá ®ang n»m ë ®Çu dßng v¨n b¶n, nhÊn Tab ®Ó nhËp d÷ 
liÖu cét STT. NhËp xong nhÊn Tab, con trá sÏ chuyÓn ®Õn vÞ trÝ tab 
tiÕp theo (vÞ trÝ cét hä vµ tªn) vµ nhËp tiÕp d÷ liÖu Hä vµ tªn. NhËp 

xong nhÊn Tab ®Ó nhËp d÷ liÖu cét §Þa chØ. Lµm t−¬ng tù víi c¸c 

dßng tiÕp theo, b¹n ®· cã thÓ t¹o ®−îc b¶ng d÷ liÖu nh− yªu cÇu ë 
trªn.  

§Æc biÖt, chØ cÇn dïng chuét xö lý trªn th−íc kÎ n»m ngang 
(Vertical Ruler) b¹n còng cã thÓ thiÕt lËp vµ ®iÒu chØnh c¸c ®iÓm tab 

nh− võa råi. C¸ch lµm nh− sau:  

§Ó t¹o ®iÓm tab cho cét STT (cã kho¶ng c¸ch lµ 1cm, lÒ gi÷a), h·y 

nhÊn chuét tr¸i lªn vÞ trÝ 1 cm trªn th−íc kÎ n»m ngang. Mét ®iÓm 

Tab cã kho¶ng c¸ch 1cm, lÒ tr¸i (Left) ®· ®−îc thiÕt lËp nh− sau: 

 .   

Muèn thay ®æi lÒ cho ®iÓm tab nµy lµ gi÷a (Center), lµm nh− sau:  

NhÊn kÐp chuét lªn ®iÓm tab võa thiÕt lËp, hép tho¹i Tab xuÊt 

hiÖn. TiÕp theo chän lÒ cho ®iÓm tab ®ang chän trªn hép tho¹i nµy ë 

môc Alignment lµ Center  

 

 
 

C¸c vÞ trÝ ®iÓm tab võa thiÕt lËp!  
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 TiÕp theo nhÊt nót Set ®Ó thiÕt 

lËp.  

T−¬ng tù, h·y t¹o tiÕp c¸c ®iÓm tab cho cét Hä tªn vµ cét §Þa chØ.  

Muèn xo¸ bá mét ®iÓm tab nµo ®ã, chØ viÖc dïng chuét kÐo chóng 

(®iÓm tab ®ã) ra khái th−íc kÎ.  

1.2 C¸c kü n¨ng ®Þnh d¹ng v¨n b¶n  

NhËp v¨n b¶n bao gåm c¸c thao t¸c ®Ó gâ ®−îc v¨n b¶n lªn tµi liÖu. 
Cßn ®Þnh d¹ng v¨n b¶n bao gåm c¸c thao t¸c gióp b¹n lµm ®Ñp v¨n b¶n 
theo ý muèn.  

1.2.1 §Þnh d¹ng ®¬n gi¶n  

Gióp b¹n cã ®−îc nh÷ng kü n¨ng ®Þnh d¹ng v¨n b¶n ®Çu tiªn, ®¬n 

gi¶n nhÊt nh− lµ: ph«ng ch÷, mµu s¾c, cì ch÷, lÒ v.v.  

  H·y gâ ®o¹n v¨n b¶n sau:  

MÉu v¨n b¶n ®Þnh d¹ng  

a. Chän ph«ng ch÷  

§Ó chän ph«ng ch÷ cho ®o¹n v¨n b¶n trªn, h·y lµm nh− sau:  

  B−íc 1: Chän (b«i ®en) ®o¹n v¨n b¶n;  

B−íc 2: Dïng chuét bÊm lªn hép Font   trªn thanh 

c«ng cô Standard. Mét danh s¸ch c¸c kiÓu ph«ng ch÷ xuÊt hiÖn:  
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B¹n cã thÓ chän mét kiÓu phï hîp. VÝ dô, sau khi chän kiÓu ph«ng 
.VnTimeH, ®o¹n v¨n b¶n ®· chän sÏ cã d¹ng:  

MÉu v¨n b¶n ®Þnh d¹ng  

 

Chän Center  

 

NhÊn Set ®Ó thiÕt lËp  

 

 

  

  

  

b. Chän cì ch÷  

§Ó chän cì ch÷ cho ®o¹n v¨n b¶n trªn, h·y lµm nh− sau:  

  B−íc 1: Chän (b«i ®en) ®o¹n v¨n b¶n;  

B−íc 2: Dïng chuét bÊm lªn hép Size   trªn thanh c«ng cô 

Standard. Mét danh s¸ch c¸c cì ch÷ xuÊt hiÖn cho phÐp chän lùa. 

HoÆc còng cã thÓ gâ trùc tiÕp cì ch÷ vµo môc Size nµy.  

VÝ dô: sau khi chän cì ch÷ 18 (lóc ®Çu lµ cì 14), ®o¹n v¨n b¶n trªn 
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sÏ trë thµnh:  

MÉu v¨n b¶n ®Þnh d¹ng  

  

  

  

c. Chän kiÓu ch÷  

§Ó chän kiÓu ch÷ (kiÓu ch÷ bÐo, kiÓu ch÷ nghiªng, kiÓu ch÷ cã g¹ch 

ch©n) cho ®o¹n v¨n b¶n trªn, h·y lµm nh− sau:  

  B−íc 1: Chän (b«i ®en) ®o¹n v¨n b¶n;  

B−íc 2: Dïng chuét bÊm lªn nót kiÓu ch÷ trªn thanh c«ng cô 

Standard:  

 :  KiÓu ch÷ bÐo (phÝm nãng Ctrl + B)  

MÉu v¨n b¶n ®Þnh d¹ng  

 :  KiÓu ch÷ nghiªng (phÝm nãng Ctrl + I)  

MÉu v¨n b¶n ®Þnh d¹ng  

 :  KiÓu ch÷ g¹ch ch©n (phÝm nãng Ctrl + U)  

MÉu v¨n b¶n ®Þnh d¹ng 

 

MÆt kh¸c cã thÓ thiÕt lËp v¨n b¶n bëi tæ hîp nhiÒu kiÓu ch÷: võa 

bÐo, võa nghiªng hoÆc võa cã g¹ch ch©n nh− lµ:  

 

 - B¹n cã thÓ bÊm tæ hîp phÝm nãng Ctrl + Shift + F ®Ó gäi nhanh b¶ng chän ph«ng ch÷;  

  - Víi bé gâ Vietkey hoÆc ABC, nh÷ng ph«ng ch÷ cã tªn b¾t ®Çu bëi dÊu chÊm (.) lµ ph«ng ch÷ tiÕng 
ViÖt. VÝ dô: .vnTime, .vnArial, .vnTimeH;  

   - Ph«ng tiÕng ViÖt kÕt thóc bëi ch÷ in hoa H, sÏ chuyÓn v¨n b¶n ®ang chän thµnh ch÷ in hoa. VÝ dô: 
.vnTimeH- lµ mét trong nh÷ng ph«ng ch÷ in hoa.  

 

  B¹n cã thÓ bÊm tæ hîp phÝm nãng Ctrl + Shift + P ®Ó ®Þnh vÞ nhanh ®Õn hép thiÕt lËp cì ch÷.  
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MÉu v¨n b¶n ®Þnh d¹ng  

d. Chän mµu ch÷  

§Ó chän mµu s¾c ch÷ cho ®o¹n v¨n b¶n trªn, h·y lµm nh− sau:  

  B−íc 1: Chän (b«i ®en) ®o¹n v¨n b¶n trªn;  

B−íc 2: Dïng chuét bÊm lªn hép Font Color    trªn thanh c«ng 

cô Standard. Mét b¶ng mµu xuÊt hiÖn cho phÐp chän lùa:  

   

B¹n cã thÓ chän lo¹i mµu phï hîp b»ng c¸ch nhÊn chuét lªn « mµu 
cÇn chän. Ngoµi ra, b¹n cã thÓ chän nh÷ng mÉu mµu ®éc ®¸o h¬n khi 

nhÊn nót   :  

   

ThÎ Standard cho phÐp chän mµu cã s½n cã thÓ chän;  

H¬n n÷a, thÎ Custom cho phÐp ®Þnh nghÜa mµu cho riªng m×nh:  
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B¹n cã thÓ chän mµu ë b¶ng c¸c ®iÓm mµu, ®ång thêi còng cã thÓ 

®iÒu chØnh ®−îc tû lÖ c¸c mµu ®¬n trong tõng gam mµu (Red- tû lÖ 

mµu ®á; Green- tû lÖ mµu xanh lµ c©y; Blue- tû lÖ mµu xanh da trêi).  

e. Chän mµu nÒn v¨n b¶n  

  §Ó chän mµu nÒn cho ®o¹n v¨n b¶n trªn, vÝ dô nh−:  

MÉu v¨n b¶n ®Þnh d¹ng  

h·y lµm nh− sau:  

  B−íc 1: Chän (b«i ®en) ®o¹n v¨n b¶n trªn;  

 B−íc 2: Dïng chuét bÊm lªn hép Hight light    trªn thanh c«ng 

cô Standard. Mét b¶ng mµu xuÊt hiÖn cho phÐp chän lùa:  

   

Cã thÓ chän lo¹i mµu nÒn phï hîp b»ng c¸ch nhÊn chuét lªn « mµu 

cÇn chän. NÕu chän None- t−¬ng ®−¬ng viÖc chän mµu tr¾ng.  

f. Hép tho¹i Font  

Ngoµi nh÷ng tÝnh n¨ng ®Þnh d¹ng c¨n b¶n ë trªn, hép tho¹i Font 

cung cÊp nh÷ng tÝnh n¨ng ®Þnh d¹ng ®Æc biÖt h¬n. §Ó më hép tho¹i 

Font, kÝch ho¹t môc chän Format | Font..  
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Xem mµu ®ang chän ë ®©y. 

  

ThÎ Font: Cho phÐp thiÕt lËp c¸c ®Þnh d¹ng c¨n b¶n vÒ ph«ng ch÷ 

nh− ®· tr×nh bµy ë trªn, vÝ dô:  

 - Hép Font- cho phÐp chän ph«ng ch÷;  

 

 - Hép Font style- chän kiÓu ch÷: Regular- kiÓu ch÷ b×nh th−êng; 

Italic- kiÓu ch÷ nghiªng; Bold ‟ kiÓu ch÷ bÐo; Bold Italic ‟ 

kiÓu võa bÐo, võa nghiªng;  

 - Hép Size- chän cì ch÷;  

 - Font color- chän mµu cho ch÷;  

 - Hép Underline style: ®Ó chän kiÓu ®−êng g¹ch ch©n (nÕu kiÓu 

ch÷ ®ang chän lµ underline).  

 - Ngoµi ra, môc Effect cho phÐp thiÕt lËp mét sè hiÖu øng ch÷ ®¬n 

gi¶n, b¹n cã thÓ chän chóng vµ xem thÓ hiÖn ë môc Preview.  

 - NÕu nhÊn nót Default ‟ kiÓu ®Þnh d¹ng nµy sÏ ®−îc thiÕt lËp lµ 

ngÇm ®Þnh cho c¸c ®o¹n v¨n b¶n míi sau nµy;  
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ThÎ Text Effect: cho phÐp thiÕt lËp mét sè hiÖu øng tr×nh diÔn s«i 

®éng cho ®o¹n v¨n b¶n. H·y chän kiÓu tr×nh diÔn ë danh s¸ch 

Animations: vµ xem tr−íc kÕt qu¶ sÏ thu ®−îc ë hép Preview.   

1.2.2 §Þnh d¹ng ®o¹n v¨n b¶n  

ë môc 1.2.1 chóng ta ®· lµm quen víi c¸c thao t¸c ®Þnh d¹ng v¨n b¶n 

cho vïng v¨n b¶n ®· ®−îc chän (®−îc b«i ®en). Trong phÇn nµy, chóng 
ta t×m hiÓu c¸ch ®Þnh d¹ng v¨n b¶n trªn cïng ®o¹n v¨n b¶n.   

Mçi dÊu xuèng dßng (Enter) sÏ t¹o thµnh mét ®o¹n v¨n b¶n. Khi 
®Þnh d¹ng ®o¹n v¨n b¶n, kh«ng cÇn ph¶i lùa chän toµn bé v¨n b¶n 
trong ®o¹n ®ã, mµ chØ cÇn ®Æt ®iÓm trá trong ®o¹n cÇn ®Þnh d¹ng.   

§Ó më tÝnh n¨ng ®Þnh d¹ng ®o¹n v¨n b¶n, më môc chän Format | 

Paragraph, hép tho¹i Paragraph xuÊt hiÖn:  

 
KÕt qu¶ sÏ thu ®−îc ! 
 
Chän kiÓu hiÖu øng ! 
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  Môc Aligment: chän kiÓu c¨n lÒ cho ®o¹n:  

 - Justified ‟ c¨n ®Òu lÒ tr¸i vµ lÒ ph¶i;  

 - Left ‟ c¨n ®Òu lÒ tr¸i  

 - Right ‟ c¨n ®Òu lÒ bªn ph¶i  

 - Center ‟ c¨n gi÷a 2 lÒ tr¸i vµ ph¶i.  

 

Môc Indentation: thiÕt lËp kho¶ng c¸ch tõ mÐp lÒ ®o¹n so víi lÒ 

trang:  

 - Left ‟ kho¶ng c¸ch tõ lÒ tr¸i ®o¹n ®Õn lÒ tr¸i cña trang v¨n b¶n;  

 - Right- kho¶ng c¸ch tõ lÒ ph¶i cña ®o¹n ®Õn lÒ ph¶i cña trang v¨n 

b¶n  

NgÇm ®Þnh, hai kho¶ng c¸ch nµy ®Òu lµ 0.  

- Trong môc Special nÕu chän:  

 „ First line: khi ®ã cã thÓ thiÕt lËp ®é thôt dßng cña dßng ®Çu 

tiªn trong ®o¹n vµo môc By:  
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§©y lµ vÝ dô vÒ mét ®o¹n v¨n b¶n thiÕt lËp ®é thôt ®Çu dßng 

(First line) so víi c¸c dßng tiÕp theo trong ®o¹n mét kho¶ng 

c¸ch 0.5 cm.  

„ Hanging: ®Ó thiÕt lËp ®é thôt dßng cña dßng thø 2 trë ®i trong 

®o¹n so víi dßng ®Çu tiªn mét kho¶ng c¸ch ®−îc gâ vµo môc 
By:.  

 -   §©y lµ vÝ dô vÒ mét ®o¹n v¨n b¶n thiÕt lËp ®é thôt cña 

c¸c dßng thø 2 trë ®i (Hanging) so víi dßng ®Çu tiªn trong 

®o¹n mét kho¶ng c¸ch 0.5 cm.  

 „ None: ®Ó hñy bá chÕ ®é thôt ®Çu dßng trªn ®o¹n.  

§©y lµ vÝ dô vÒ mét ®o¹n v¨n b¶n khi kh«ng thiÕt lËp chÕ ®é 

thôt ®Çu dßng trªn ®o¹n (None).  

 - NÕu môc Special lµ First line, khi ®ã cã thÓ thiÕt lËp ®é thôt dßng 

cña dßng ®Çu tiªn trong ®o¹n vµo môc By:  

 - Môc Spacing: cho phÐp thiÕt lËp c¸c kho¶ng c¸ch dßng:  

 - Before ‟ kho¶ng c¸ch dßng gi÷a dßng ®Çu tiªn cña ®o¹n tíi 

dßng cuèi cïng cña ®o¹n v¨n b¶n trªn nã;  

 - After- ®Ó thiÕt lËp kho¶ng c¸ch dßng gi÷ dßng cuèi cïng cña 

®o¹n víi dßng ®Çu tiªn cña ®o¹n sau nã;  

 - Line Spacing - ®Ó chän ®é d·n dßng. NgÇm ®Þnh ®é d·n dßng lµ 

1 (Single);  

 

Mµn h×nh Preview cho phÐp xem tr−íc nh÷ng kÕt qu¶ ®Þnh d¹ng 

®o¹n võa thiÕt lËp.  

NhÊn Ok ®Ó chÊp nhËn nh÷ng thuéc tÝnh võa thiÕt lËp cho ®o¹n v¨n 

b¶n ®ang chän; tr¸i l¹i nhÊn Cancel ®Ó huû bá c«ng viÖc võa lµm.  

  

1.3 ThiÕt lËp Bullets vµ numbering  

 PhÇn nµy sÏ h−íng dÉn c¸ch thiÕt lËp c¸c lo¹i ®¸nh dÊu ®Çu ®o¹n 
(Bullets) vµ c¸ch ®¸nh sè chØ môc (Numbering) cho c¸c tiªu ®Ò trªn tµi 
liÖu word.  
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1.3.1 ThiÕt lËp Bullets  

§Ó ®¸nh dÊu ®Çu dßng mét ®o¹n v¨n b¶n, h·y lµm theo c¸c b−íc sau 
®©y:  

B−íc 1: §Æt con trá lªn ®o¹n cÇn ®¸nh dÊu ®Çu dßng vµ kÝch ho¹t 

tÝnh n¨ng ®¸nh dÊu ®Çu dßng b»ng c¸ch më môc chän: Format | 

Bullets and Numbering .., hép tho¹i sau ®©y xuÊt hiÖn:  

   

B−íc 2: ThiÕt lËp th«ng tin vÒ dÊu ®Çu dßng ë thÎ Bulleted nh− sau:  

  Dïng chuét nhÊn lªn kiÓu Bullet muèn thiÕt lËp (®o¹n v¨n b¶n nµy 
®ang sö dông kiÓu bullet chän ë h×nh trªn);  

  NhÊn nót Picture.., ®Ó chän mét kiÓu bullet lµ c¸c h×nh ¶nh kh¸c, 

khi ®ã hép tho¹i sau ®©y xuÊt hiÖn:  
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Chän mét lo¹i bullet råi nhÊn OK ®Ó hoµn tÊt.  

 Cã thÓ nhÊn nót Customize.. ®Ó thùc hiÖn mét vµi thao t¸c ®Þnh d¹ng 

cÇn thiÕt cho bullet ®ang chän:  

   

 - Cã thÓ chän l¹i kiÓu bullet ë danh s¸ch Bullet character;  

 - NhÊn nót Font.. ®Ó chän lo¹i ph«ng ch÷ cho bullet;  

 - NhÊn nót Bullet.. ®Ó cã thÓ chän bullet lµ mét ký tù ®Æc biÖt 

(Symbol);  

 - Môc Bullet position ®Ó thiÕt lËp kho¶ng c¸ch dÊu bullet so víi 

mÐp trong lÒ bªn tr¸i tµi liÖu;  

 - Môc Text position ®Ó thiÕt lËp kho¶ng c¸ch tõ v¨n b¶n (text) tíi 

mÐp trong lÒ tr¸i cña tµi liÖu.  
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 Nót lÖnh Bullet   trªn thanh c«ng cô chuÈn sÏ gióp b¹n thiÕt lËp nhanh hoÆc bá thiÕt lËp ®Þnh 
d¹ng ®¸nh dÊu ®Çu ®o¹n v¨n b¶n.   

1.3.2 ThiÕt lËp Numbering  

§Ó ®¸nh sè chØ môc cho c¸c tiªu ®Ò tµi liÖu, h·y lµm theo c¸c b−íc 
sau ®©y:  

B−íc 1: §Æt con trá lªn ®o¹n cÇn ®¸nh sè chØ môc vµ kÝch ho¹t tÝnh 

n¨ng ®¸nh sè chØ môc b»ng c¸ch më môc chän: Format | Bullets and 

Nubering .., hép tho¹i sau ®©y xuÊt hiÖn:  

   

B−íc 2: ThiÕt lËp th«ng tin vÒ ®¸nh sè chØ môc ë thÎ Numbered 

nh− sau:  

  H·y dïng chuét nhÊn lªn kiÓu ®¸nh sè chØ môc muèn thiÕt lËp ;  

  Nót Customize..., ®Ó ®Þnh d¹ng cho sè chØ môc nµy bëi hép tho¹i 

sau:  
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ý nghÜa c¸c môc tin trªn hép tho¹i nµy nh− sau:  

 - Nót Font…, cho phÐp chän kiÓu ph«ng ch÷ cho sè chØ môc;  

 - Môc Start at: ®Ó chän chØ môc ®Çu tiªn cÇn ®¸nh sè: nÕu chän 1, 

sÏ thùc hiÖn ®¸nh chØ môc lµ 1, 2, ..; nh−ng nÕu chän lµ 5 th× sÏ 
®¸nh sè tõ 5 trë ®i lµ 5, 6, 7..;  

 - Môc Number position ®Ó thiÕt lËp vÞ trÝ cña chØ môc trªn ®o¹n 

v¨n b¶n;  

 - Text position ®Ó thiÕt lËp kho¶ng c¸ch v¨n b¶n so víi mÐp lÒ cña 

trang tµi liÖu.  

  

  

  

 

1.4 So¹n th¶o c«ng thøc to¸n häc  

§Ó cã thÓ so¹n th¶o ®−îc c«ng thøc to¸n häc, m¸y tÝnh cña b¹n ph¶i 

®−îc cµi ®Æt bé Microsoft Equation 3.0 cïng víi bé Microsoft Office. 

C¸ch so¹n th¶o mét c«ng thøc to¸n häc ®−îc tiÕn hµnh nh− sau:  

B−íc 1: Chän mét vÞ trÝ trªn tµi liÖu, n¬i sÏ chÌn c«ng thøc to¸n häc 

vµo;  

B−íc 2: KÝch ho¹t tr×nh so¹n th¶o c«ng thøc to¸n häc b»ng c¸ch: më 

môc chän Insert | Object… Hép tho¹i Object xuÊt hiÖn:  
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Dïng chuét chän môc Microsoft Equation 3.0 (nh− h×nh trªn), råi 

nhÊn OK. Thanh c«ng cô Equation cïng hép so¹n th¶o c«ng thøc xuÊt 

hiÖn:  

  

   

 

   

 - Hép so¹n th¶o c«ng thøc, lµ n¬i ®Ó so¹n th¶o c«ng thøc to¸n häc.  

 - Thanh c«ng cô Equation chøa c¸c nót lÖnh cho phÐp chän c¸c 

mÉu c«ng thøc vµ c¸c ký tù, ký hiÖu, phÇn tö trong mét c«ng thøc 
to¸n häc.  

B−íc 3: So¹n th¶o c«ng thøc: §¬n gi¶n b»ng c¸ch chÌn c¸c mÉu 

c«ng thøc råi x©y dùng c¸c thµnh phÇn c«ng thøc.  

 

1.5 Chia v¨n b¶n thµnh nhiÒu cét  

 Microsoft Word cung cÊp tÝnh n¨ng Columns gióp ng−êi dïng dÔ dµng 

chia v¨n b¶n cña m×nh thµnh nhiÒu cét (gièng nh− ®Þnh d¹ng trªn c¸c 

trang b¸o vµ t¹p chÝ). Mçi ®o¹n v¨n b¶n cã thÓ ®−îc chia thµnh c¸c cét cã 

®é réng kh¸c nhau. Trªn mçi cét, cã thÓ thùc hiÖn chÌn c¸c th«ng tin nh−: 

b¶ng biÓu, h×nh vÏ,.. nh− thao t¸c trªn c¸c trang tµi liÖu b×nh th−êng.   
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Thanh c«ng cô ®Ó so¹n th¶o c«ng thøc  
 
Hép so¹n th¶o c«ng thøc to¸n häc  
 

 Nót lÖnh Numbering   trªn thanh c«ng cô chuÈn sÏ gióp b¹n thiÕt lËp nhanh hoÆc bá thiÕt lËp 
®Þnh d¹ng ®¸nh chØ môc ®Çu ®o¹n v¨n b¶n.   

1.5.1 Chia cét v¨n b¶n  

B−íc 1: Lùa chän (b«i ®en) vïng v¨n b¶n cÇn chia lµm nhiÒu cét;  

B−íc 2: KÝch ho¹t môc chän Format | Columns.. Hép tho¹i 

Columns xuÊt hiÖn:  

   

ThiÕt lËp c¸c th«ng sè cho hép tho¹i Columns víi c¸c ý nghÜa nh− 

sau:  

 - ý nghÜa c¸c hép chän ë môc Presets nh− sau :  

One  - 1 cét;  

Two  - 2 cét;  

Three - 3 cét;  

Left  - chia v¨n b¶n thµnh 2 cét, cét bªn tr¸i cã chiÒu réng b»ng 
mét nöa cét bªn ph¶i;  

Right - chia v¨n b¶n thµnh 2 cét, cét bªn ph¶i cã chiÒu réng b»ng 
mét nöa cét bªn tr¸i;  
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 - B¹n cã thÓ thiÕt lËp sè cét cÇn t¹o ra nhiÒu h¬n b»ng c¸ch gâ sè 

cét vµo môc Number of Columns;  

 - Môc Width and Spacing: cho phÐp thiÕt lËp c¸c th«ng sè vÒ 

chiÒu réng vµ kho¶ng c¸ch gi÷a c¸c cét. B¹n cã thÓ dïng chuét 

(hoÆc gâ) thay ®æi gi¸ trÞ môc Width, ®é réng cña cét t−¬ng øng 

sÏ ®−îc thay ®æi (h·y nh×n h×nh ë môc Preview ®Ó xem tr−íc kÕt 

qu¶). HoÆc thay ®æi gi¸ trÞ môc Spacing.   

 - Kho¶ng c¸ch gi÷a hai cét kÒ nhau còng ®−îc thay ®æi khi môc 

Equal columns width ®−îc chän (checked)- th× ®é réng cña c¸c 

cét vµ kho¶ng c¸ch gi÷a c¸c cét ®Òu b»ng nhau. Muèn thay ®æi ®é 
réng mçi cét hoÆc kho¶ng c¸ch gi÷a c¸c cét kh¸c nhau, h·y bá 
chän môc nµy. Khi ®ã, cã thÓ ®iÒu chØnh ®é réng hoÆc kho¶ng 
c¸ch gi÷a hai cét nµo ®ã mét c¸ch trùc tiÕp.  

 - H·y quan s¸t môc Col #: ®Ó biÕt ®−îc cét sÏ cÇn ®iÒu chØnh vµ 

kh«ng quªn xem hép Preview ®Ó nh×n thÊy tr−íc ®−îc kÕt qu¶ sÏ 

®¹t ®−îc.  

 - Môc Apply to: cho biÕt ph¹m vi v¨n b¶n sÏ chia thµnh c¸c cét.  

+ NÕu chän Seleted Text th× chØ chia cét cho v¨n b¶n ®· ®−îc 

chän (b«i ®en)  

+ NÕu chän Whole Document, toµn bé c¸c trang v¨n b¶n sÏ 

®−îc chia cét theo thiÕt lËp nh− trªn.  

 

1.5.2 Söa l¹i ®Þnh d¹ng  

§Ó söa l¹i ®Þnh d¹ng cét ®· chia, h·y lµm theo 2 b−íc  

B−íc 1: §Æt ®iÓm trá vµo mét vÞ trÝ bÊt kú trªn vïng v¨n b¶n ®· chia 

cét.  

B−íc 2: KÝch ho¹t menu Format | Columns.. , Hép tho¹i Columns 

xuÊt hiÖn cho phÐp chØnh söa c¸c th«ng sè vÒ c¸c cét ®· chia.  

1.6 T¹o ch÷ c¸i lín ®Çu ®o¹n v¨n b¶n  

 TÝnh n¨ng DropCap cña word gióp t¹o c¸c kiÓu ch÷ c¸i lín ®Çu tiªn cho 

mét ®o¹n v¨n b¶n.   
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1.6.1 C¸ch t¹o  

 §Ó t¹o ch÷ c¸i lín ®Çu ®o¹n v¨n b¶n, h·y lµm theo c¸c b−íc sau:  

 B−íc 1: §Æt con trá lªn ®o¹n cÇn t¹o ch÷ c¸i lín ®Çu ®o¹n; khëi ®éng 

tÝnh n¨ng Drop Cap b»ng c¸ch: më môc chän Format | Drop Cap.. 

Hép tho¹i Drop cap xuÊt hiÖn:  

   

B−íc 2: thiÕt lËp c¸c th«ng sè cho ch÷ lín nµy:  

 - Môc Position- ®Ó chän kiÓu ch÷ cÇn ®Æt. Cã 3 kiÓu ch÷ lµ: None 

‟ kh«ng thiÕt lËp; Dropped vµ In Margin. H·y xem mÉu trªn 
h×nh;  

 - Hép Font:- chän ph«ng ch÷ cho ch÷ c¸i nµy;  

 - Môc Line to drop:- thiÕt lËp sè dßng v¨n b¶n lµm chiÒu cao cho 

ch÷;  

 

 - Môc Distance from text:- gâ vµo kho¶ng c¸ch tõ ch÷ c¸i lín nµy 

®Õn ký tù tiÕp theo nã.  

 - Cuèi cïng, nhÊn OK ®Ó hoµn tÊt  

 D−íi ®©y lµ 2 vÝ dô minh häa khi sö dông 2 lo¹i ch÷ c¸i lín ®Çu 
®o¹n lµ Dropped vµ In Margin  

  

o¹n v¨n b¶n nµy ®Ó m« t¶ c¸c lo¹i ch÷ c¸i lín ®Çu ®o¹n v¨n 
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b¶n. Khi chän Position lµ kiÓu Dropped, víi chiÒu cao cña ch÷ lµ 

2 dßng (Lines to drop=2)  

o¹n v¨n b¶n nµy ®Ó m« t¶ c¸c lo¹i ch÷ c¸i lín ®Çu ®o¹n 

v¨n b¶n. Khi chän Position lµ kiÓu In margin, víi chiÒu cao 

cña ch÷ lµ 2 dßng (Lines to drop=2).  

.  

 

1.6.2 §iÒu chØnh ch÷ c¸i lín ë ®Çu ®o¹n  

 §Ó thay ®æi l¹i ch÷ c¸i lín ®Çu ®o¹n ®· t¹o ®−îc, h·y lµm nh− sau:  

B−íc 1: §Æt con trá lªn ®o¹n cÇn söa ch÷ c¸i lín ®Çu ®o¹n; khëi 

®éng tÝnh n¨ng Drop Cap ;  

   

B−íc 2: Thùc hiÖn thiÕp lËp l¹i c¸c th«ng sè trªn hép tho¹i nµy. Cuèi 

cïng nhÊn OK ®Ó chÊp nhËn sù thay ®æi.  

1.7 T¹o vµ qu¶n lý c¸c Style  

 Trong qu¸ tr×nh so¹n th¶o v¨n b¶n, nhiÒu khi cÇn ®Þnh d¹ng nhiÒu ®o¹n 

v¨n b¶n theo cïng mét kiÓu ®Þnh d¹ng. NÕu ph¶i ®Þnh d¹ng lÇn l−ît tõng 

®o¹n nh− vËy sÏ mÊt rÊt nhiÒu thêi gian, v¶ l¹i khã chÝnh x¸c v× ph¶i thao 
t¸c qu¸ nhiÒu. Mét trong nh÷ng c¸ch ®¬n gi¶n nhÊt trong Word gióp ®¬n 

gi¶n t×nh huèng trªn lµ Style.  

 Style lµ mét tËp hîp c¸c ®Þnh d¹ng v¨n b¶n cña mét ®o¹n, cã tªn gäi vµ 
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cã thÓ ®−îc g¸n bëi mét tæ hîp phÝm nãng.  

 Style ®Æc biÖt cÇn thiÕt khi ph¶i so¹n th¶o mét gi¸o tr×nh, mét tµi liÖu cã 
chøa nhiÒu môc, nhiÒu lo¹i ®o¹n v¨n b¶n kh¸c nhau.  

1.7.1 T¹o mét Style  

§Ó t¹o mét Style h·y lµm nh− sau:  

B−íc 1: Më môc chän Format | Style.. Hép tho¹i Style xuÊt hiÖn:  

   

B−íc 2: §Ó t¹o Style míi, nhÊn nót New, hép tho¹i: New Style xuÊt 

hiÖn cho phÐp thiÕt lËp th«ng tin cho Style míi:  
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 - Gâ tªn cho Style míi vµo môc Name: vÝ dô Muc1;  

 - NhÊn nót Format ®Ó chän c¸c chøc n¨ng ®Þnh d¹ng cho Style 

nµy:  

  Bao gåm c¸c th«ng tin:  

- Font… ®Ó ®Þnh d¹ng ph«ng ch÷ cho Style;  

- Paragraph… ®Þnh d¹ng ®o¹n;  

- Tabs.. ®Ó ®Æt ®iÓm Tab cho Style (nÕu cÇn);  

- Border.. ®Ó chän kiÓu ®−êng viÒn cho Style (nÕu cÇn);  

- Frame.. ®Ó chän kiÓu khung cho Style (nÕu cÇn);  

- Numbering.. ®Ó chän kiÓu g¹ch ®Çu dßng (nÕu cÇn);  

- NhÊn nót Shortcut key.. ®Ó g¸n phÝm nãng cho Style nµy, hép 

tho¹i Customize Keyboard xuÊt hiÖn cho phÐp thiÕt lËp phÝm 
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nãng:  

   

- Khi con trá ®ang ë môc Press new shortcut key: h·y bÊm tæ hîp 

phÝm nãng cÇn g¸n trªn bµn phÝm. VÝ dô: Ctrl + 1;  

- TiÕp theo nhÊn nót Assign ®Ó ®ång ý phÝm nãng nµy;  

- Cã thÓ g¸n nhiÒu tæ hîp phÝm nãng cho mét Style, chóng ®−îc 

chøa ë danh s¸ch Current keys:   

- Nót Remove, nót Reset All.. gióp qu¶n lý c¸c phÝm nãng võa t¹o;  

- Sau khi g¸n xong tæ hîp phÝm nãng, hép tho¹i Customize 

keyboard sÏ cã d¹ng:  

   

- NhÊn nót Close ®Ó tiÕp tôc.  
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- NÕu chän   , khi ®ã ®Þnh d¹ng cña Style sÏ ®−îc 
tù ®éng thay ®æi. Tøc lµ, trong qu¸ tr×nh so¹n th¶o v¨n b¶n, gi¶ sö 
mét ®o¹n v¨n b¶n nµo ®ã b¹n chän ®Þnh d¹ng kiÓu Style nµy 
(Muc1) bÞ thay ®æi ®Þnh d¹ng th× kiÓu ®Þnh d¹ng cña Style Muc1 
còng tù ®éng bÞ thay ®æi theo;  

- NÕu chän   , Style ®ã sÏ ®−îc l−u l¹i tÖp Normal.dot 

cña word. Khi ®ã Style nµy cã thÓ ®−îc sö dông trªn mäi tÖp v¨n 

b¶n. NÕu kh«ng chän môc nµy, th× Style Muc1 chØ cã t¸c dông 

trªn tÖp v¨n b¶n ®ang më.  

- Sau khi thiÕt lËp ®Çy ®ñ th«ng tin cho Style míi, nhÊn nót OK ®Ó 

hoµn tÊt.  

- Gi¶ sö ®Þnh d¹ng cña Style Muc1 lµ:  

 

Tªn style: Muc1  

Ph«ng ch÷: .VnBlackH  

Cì ch÷: 14  

PhÝm nãng: Ctrl + 1  

 

B−íc 3: Sö dông Style võa t¹o ®−îc: Gi¶ sö cã ®o¹n v¨n b¶n sau:  

NÕu muèn ®o¹n v¨n b¶n nµy cã ®Þnh d¹ng nh− Style Muc1 ®· t¹o 

®−îc ë trªn, h·y lµm nh− sau:  

B−íc 1: §Æt ®iÓm trá lªn ®o¹n v¨n b¶n cÇn ®Þnh d¹ng;  

B−íc 2: NhÊn tæ hîp phÝm nãng Ctrl + 1 ®Ó gäi Style Môc1. 

§o¹n v¨n b¶n ®· chän sÏ cã ®Þnh d¹ng nh− style Muc1:  

1.7.2 G¸n Style cho mÉu ®· ®−îc ®Þnh d¹ng  

Khi ®· cã mét ®o¹n ®· ®−îc ®Þnh d¹ng trªn tµi liÖu, muèn g¸n nã 

bëi mét style, h·y lµm nh− sau:  

B−íc 1: §Æt ®iÓm trá lªn ®o¹n cÇn g¸n style;  

B−íc 2: Më hép tho¹i Style b»ng c¸ch më môc chän Format | 

Style..  

B−íc 3: NhÊn nót New ®Ó t¹o mét style míi:  
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 - Môc Name, gâ vµo tªn Style muèn t¹o;  

 - NhÊn lªn nót Shortcut key.. ®Ó g¸n phÝm t¾t cho Style nµy;  

 - Cã thÓ tu söa ®Þnh d¹ng Style nµy khi nhÊn nót lÖnh Format vµ 

chän c¸c tÝnh n¨ng ®Þnh d¹ng cÇn thiÕt;  

 - Cuèi cïng nhÊn OK ®Ó hoµn tÊt viÖc g¸n style míi nµy cho ®o¹n 

v¨n b¶n ®ang chän trªn tµi liÖu.  

 
 

Style lµ mét tËp hîp c¸c ®Þnh d¹ng v¨n b¶n cña mét ®o¹n, cã tªn gäi vµ cã thÓ 

®−îc g¸n bëi mét tæ hîp phÝm nãng.  

 

Style lµ mét tËp hîp c¸c ®Þnh d¹ng v¨n b¶n cña mét ®o¹n cho tr−íc, cã tªn gäi 

vµ cã thÓ ®−îc g¸n bëi mét tæ hîp phÝm nãng.  

1.7.3 §iÒu chØnh Style  

§Ó tu söa l¹i ®Þnh d¹ng cho Style, h·y lµm nh− sau:  

B−íc 1: Më hép tho¹i Style vµ chän tªn Style cÇn tu söa ë danh 

s¸ch Styles: (vÝ dô muèn tu söa l¹i ®Þnh d¹ng style Muc1)  

   

B−íc 2: NhÊn nót Modify.. hép tho¹i Modify Style xuÊt hiÖn cho 

phÐp thay ®æi l¹i ®Þnh d¹ng cña style nµy:  
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 - Cã thÓ thay ®æi l¹i c¸c ®Þnh d¹ng khi nhÊn lªn nót Format, chän 

kiÓu ®Þnh d¹ng vµ thùc hiÖn thay ®æi chóng;  

 - Cã thÓ thiÕt lËp l¹i phÝm nãng khi nhÊn nót Shortcut key..;  

 - Vµ cã thÓ lµm ®−îc tÊt c¶ nh÷ng viÖc ®èi víi Style nµy nh− ®· 
lµm khi t¹o Style míi.  

 - Cuèi cïng, nhÊn OK ®Ó ®ång ý mäi sù thay ®æi.  

  

 
 
Chän style cÇn ®iÒu chØnh !  

1.7.4 Qu¶n lý c¸c Styles  

§Ó qu¶n lý c¸c Style trªn Word còng nh− c¸c styles ®ang sö dông 

trªn tÖp tµi liÖu ®ang më, h·y lµm nh− sau:  

B−íc 1: Më hép tho¹i Style vµ nhÊn nót Organizer..:  
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Hép tho¹i Oganizer xuÊt hiÖn cho phÐp qu¶n lý c¸c style cã trªn 

word còng nh− trªn tÖp tµi liÖu ®ang më:  

 

 Trªn tÖp tin Normal.dot cña word lu«n chøa s½n style cã tªn Normal. §©y lµ ®Þnh d¹ng ngÇm ®Þnh 

cho v¨n b¶n khi so¹n th¶o trªn word. B¹n nªn söa ®Þnh d¹ng style nµy phï hîp víi ®Þnh d¹ng v¨n b¶n 
th−êng xuyªn lµm viÖc. VÝ dô:  

 - Font ch÷ (Font name): .vnTime  

 - Cì ch÷ (Font size): 13  

 - LÒ (Alignment) : Justify  

 - §é gi·n dßng (Line spacing): Single  

 - Kho¶ng c¸ch dßng tr−íc cña ®o¹n (Spacing before): 6  

 - Kho¶ng c¸ch dßng sau cña ®o¹n (Spacing after): 4  

 
 
NhÊn lªn ®©y ®Ó tiÕp tôc..  
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 - Danh s¸ch In Document1: liÖt kª c¸c style ®ang sö dông trªn tÖp 

Document1.doc (tÖp ®ang më);  

 - Danh s¸ch To Normal.dot: liÖt kª danh s¸ch c¸c style cã trªn tÖp 

Normal.dot cña word (c¸c style trªn tÖp normal.dot cã thÓ chia sÎ 

cho tÊt c¶ c¸c tÖp word kh¸c sö dông ®−îc);  

 - MÆt kh¸c ta còng cã thÓ thay ®æi c¸c styles trªn danh s¸ch nµy 

b»ng c¸ch chän tÖp tµi liÖu ë hép Styles available in:  

 - Qu¶n lý style lµ thªm vµo, xo¸ ®i hoÆc ®æi tªn c¸c style cho tµi 
liÖu ®ang më hoÆc cho tÖp normal.dot cña word.  

 - Sö dông nót Copy ®Ó sao chÐp mét style gi÷a hai danh s¸ch trªn;  

 - Sö dông nót Delete ®Ó xo¸ style ®ang chän;  

 - Sö dông nót Rename ®Ó ®æi tªn style ®ang chän;  

 - Cuèi cïng nhÊn Close ®Ó kÕt thóc.  

 

 1.8 T×m kiÕm vµ thay thÕ v¨n b¶n  

TÝnh n¨ng Find & Replace trong Word gióp t×m kiÕm v¨n b¶n, ®ång 

thêi gióp thay thÕ mét côm tõ bëi mét côm tõ míi. §iÒu nµy gióp Ých rÊt 

nhiÒu khi b¹n ph¶i lµm viÖc trªn mét sè l−îng trang v¨n b¶n rÊt lín (mét 
gi¸o tr×nh, mét b¸o c¸o dµi ch¼ng h¹n).  

1.8.1 T×m kiÕm v¨n b¶n   

§Ó t×m kiÕm mét côm tõ trong tµi liÖu cña m×nh, lµm nh− sau:  

  B−íc 1: Chän vïng v¨n b¶n muèn t×m kiÕm;  

NÕu kh«ng lùa chän mét vïng v¨n b¶n, Word sÏ thùc hiÖn t×m kiÕm 
trªn toµn bé tµi liÖu.  
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B−íc 2: Khëi ®éng tÝnh n¨ng t×m kiÕm v¨n b¶n b»ng c¸ch: kÝch ho¹t 

môc chän Edit | Find.. hoÆc nhÊn tæ hîp phÝm t¾t Ctrl + F, hép tho¹i 

Find and Replace xuÊt hiÖn:  

 
Danh s¸ch c¸c style cã thÓ qu¶n lý 

  

 

 

B−íc 3: ThiÕt lËp c¸c th«ng tin vÒ t×m kiÕm trªn thÎ Find. ý nghÜa 

c¸c môc tin nh− sau:  

 - Gâ tõ cÇn t×m kiÕm vµo môc Find what: vÝ dô: Viet nam;  

 - ThiÕt lËp c¸c tuú chän t×m kiÕm ë môc Search Options nh− sau:  

 - Match case- t×m kiÕm mµ kh«ng ph©n biÖt ch÷ hoa, ch÷ th−êng;  

 - Find whole words only- chØ t×m trªn nh÷ng tõ ®éc lËp  

 

B−íc 4: NhÊn nót Find next, m¸y sÏ chØ ®Õn vÞ trÝ v¨n b¶n chøa 

côm tõ cÇn t×m.  

1.8.2 T×m vµ thay thÕ v¨n b¶n   

TÝnh n¨ng nµy gióp t×m ra nh÷ng côm tõ trªn v¨n b¶n, ®ång thêi cã 

thÓ thay thÕ côm tõ t×m ®−îc bëi mét côm tõ míi. §Ó thùc hiÖn tÝnh 

n¨ng nµy, lµm nh− sau:   
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B−íc 1: Chän vïng v¨n b¶n muèn t×m kiÕm; khëi ®éng tÝnh n¨ng 

t×m kiÕm v¨n b¶n;  

B−íc 2: ThiÕt lËp th«ng tin vÒ côm tõ cÇn t×m vµ côm tõ sÏ thay thÕ 

ë thÎ Replace cña hép tho¹i:  

   

 - Gâ côm tõ cÇn t×m kiÕm vµo môc Find what:  

 - Gâ côm tõ sÏ thay thÕ ë môc Replace with:  

 
 
Gâ côm tõ cÇn t×m vµo ®©y ! 
 
Gâ côm tõ sÏ thay thÕ ! 
 
Gâ côm tõ cÇn t×m ! 
 
NhÊn lªn ®©y ®Ó tiÕp tôc 

Hép tho¹i trªn thiÕt lËp th«ng tin t×m kiÕm côm tõ Viet nam, nÕu t×m 
thÊy cã thÓ thay thÕ côm tõ ®ã bëi ViÖt Nam.  

B−íc 3: NhÊn nót Find next ®Ó t×m ®Õn vÞ trÝ v¨n b¶n chøa côm tõ 

cÇn t×m. Khi t×m thÊy, cã thÓ bÊm nót Replace ®Ó thay thÕ côm tõ t×m 

®−îc bëi côm tõ ®· chØ ®Þnh ë môc Replace with: hoÆc nhÊn nót 

Replace All, Word sÏ tù ®éng thay thÕ toµn bé c¸c côm tõ sÏ t×m ®−îc 

nh− chØ ®Þnh.  

1.9 TÝnh n¨ng AutoCorrect  

§©y lµ tÝnh n¨ng tù ®éng söa lçi chÝnh t¶ rÊt m¹nh trªn Word. Nã gióp 
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tèc ®é so¹n th¶o v¨n b¶n cña b¹n nhanh h¬n nhê nh÷ng tõ viÕt t¾t vµ 

tr¸nh ®−îc c¸c lçi chÝnh t¶ kh«ng cÇn thiÕt bëi kh¶ n¨ng tù ®éng söa lçi 

chÝnh t¶ cña nã.  

1.9.1 Thªm mét tõ viÕt t¾t  

  §Ó thªm mét tõ viÕt t¾t, thùc hiÖn theo c¸c b−íc sau:  

B−íc 1: Khëi ®éng tÝnh n¨ng AutoCorrect b»ng c¸ch më môc chän 

lÖnh: Tools | AutoCorrect.., Hép tho¹i AutoCorrect xuÊt hiÖn:  

   

 

 - Gâ côm tõ viÕt t¾t vµo môc Replace:  

 - Gâ côm tõ sÏ thay thÕ vµo môc With:  

 

VÝ dô: muèn viÕt t¾t tõ v¨n b¶n bëi vb th×:  

Replace  gâ  vb  

With      gâ    v¨n b¶n  

B−íc 2: NhÊn nót Add ®Ó ghi thªm tõ nµy vµo danh s¸ch viÕt t¾t cña 
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Word.  

1.9.2 Xo¸ ®i mét tõ viÕt t¾t  

 
Côm tõ viÕt t¾t 
 
Côm tõ sÏ thay thÕ 

§Ó xo¸ ®i mét tõ viÕt t¾t, thùc hiÖn theo c¸c b−íc sau:  

B−íc 1: Khëi ®éng tÝnh n¨ng AutoCorrect;  

B−íc 2: T×m ®Õn tõ viÕt t¾t cÇn xo¸ b»ng c¸ch gâ tõ viÕt t¾t vµo 

môc Replace. VÝ dô muèn xo¸ tõ vb – v¨n b¶n võa thiÕt lËp ë trªn, 

h·y gâ vb vµo môc Replace;  

B−íc 3: NhÊn nót Delete ®Ó xo¸ côm tõ viÕt t¾t nµy.   

1.9.3 C¸c tuú chän vÒ söa lçi chÝnh t¶  

AutoCorrect cho phÐp thiÕt lËp mét sè tÝnh chÊt tù ®éng söa c¸c lçi 
chÝnh t¶ trong qu¸ tr×nh so¹n th¶o. §Ó thiÕt lËp c¸c tÝnh chÊt tù ®éng 

söa lçi chÝnh t¶, h·y lµm nh− sau:  

B−íc 1: Khëi ®éng tÝnh n¨ng AutoCorrect;  

B−íc 2: ThiÕt lËp c¸c th«ng sè vÒ tù ®éng söa lçi chÝnh t¶ b»ng 

c¸ch chän (checked) c¸c môc sau:  

  - tù ®éng söa nh÷ng tõ nÕu cã 2 ký tù hoa 

®Çu dßng sÏ chØ ®Ó l¹i ký tù hoa ®Çu tiªn. VÝ dô TWo sÏ tù ®éng söa 

thµnh Two;  

  - tù ®éng söa ký tù ®Çu tiªn cña mét c©u 
thµnh ký tù in hoa;  

  - viÕt in hoa cho ký tù ®Çu tiªn  cña ngµy. 

VÝ dô: sÏ lu«n söa lµ Monday;  

 - tù ®éng söa lçi kiÓu nh− cAPS 

LOCK khi bËt nhÇm phÝm Caps lock. Khi ®ã m¸y sÏ söa thµnh Caps 

lock.  

1.10 ChÌn ký tù ®Æc biÖt  
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Trong qu¸ tr×nh so¹n th¶o v¨n b¶n, nhiÒu lóc chóng ta cÇn chÌn mét sè 

ký tù ®Æc biÖt vµo tµi liÖu (kh«ng cã trªn bµn phÝm) vÝ dô nh−: ∀, ∑, ↑, ↓, 

±, ≥, ... TÝnh n¨ng Insert Symbol cña Word gióp ®¬n gi¶n lµm viÖc nµy.   

1.10.1 ChÌn ký tù ®Æc biÖt  

Chän vÞ trÝ cÇn ®¨t ký tù ®Æc biÖt, tiÕp theo më môc chän Insert | 

Symbol… Hép tho¹i Symbol xuÊt hiÖn:  

 

 Khi chóng ta so¹n th¶o trªn Word, th−êng hay gÆp ph¶i lçi sau:  
NÕu gâ ch÷ thi, m¸y sÏ tù ®éng söa thµnh thI  
Gâ ch÷ thiÖn, m¸y tù ®éng söa thµnh thIÖn  

Tøc lµ ch÷ i (i th−êng) sÏ tù ®éng chuyÓn thµnh I (I hoa). Lçi nµy do AutoCorect ®Æt söa lçi chÝnh t¶ 
ithµnh I (v× trong tiÕng Anh I cã nghÜa lµ t«i, vµ chóng lu«n ®−îc viÕt in hoa trong c©u). §Ó söa lçi nµy, 

h·y thùc hiÖn xo¸ ®i kiÓu viÕt t¾t ch÷ i bëi tÝnh n¨ng Delete cña AutoCorrect.  

  

  

ë thÎ Symbol,  cã thÓ t×m ký tù ®Æc biÖt cÇn chÌn lªn v¨n b¶n. Trong 

tr−êng hîp kh«ng t×m thÊy, cã thÓ t×m ký tù ë danh môc kh¸c b»ng 

c¸ch chän mét danh môc tËp hîp c¸c ký tù ë môc Font: 

   

Mµn h×nh trªn hiÓn thÞ tËp hîp c¸c ký tù ®Æc biÖt cña danh s¸ch 

Symbol. Gi¶ sö khi chän hép Font lµ   danh s¸ch 

c¸c ký tù ®Æc biÖt sÏ nh− sau:  
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Khi thÊy ký tù cÇn t×m, cã thÓ chÌn chóng lªn tµi liÖu bëi mét trong 
hai c¸ch sau:  

C¸ch 1: NhÊn kÐp chuét lªn ký tù cÇn chÌn;  

hoÆc  

C¸ch 2: Chän ký tù cÇn chÌn b»ng c¸ch nhÊn chuét tr¸i lªn nã, råi 

nhÊn nót Insert ®Ó chÌn ký tù lªn tµi liÖu.  

Víi tÝnh n¨ng nµy, b¹n cã thÓ chÌn mét lóc nhiÒu c¸c ký tù ®Æc biÖt 
lªn tµi liÖu.  

§Æc biÖt: cã hai chøc n¨ng rÊt thuËn tiÖn nÕu ta ph¶i dïng nhiÒu ký 

tù ®Æc biÖt nµo ®ã trong so¹n th¶o, ®ã lµ g¸n tæ hîp phÝm nãng vµ thiÕt 
lËp côm tõ viÕt t¾t cho ký tù ®Æc biÖt.  

1.10.2 G¸n tæ hîp phÝm nãng cho ký tù ®Æc biÖt  

Mçi ký tù ®Æc biÖt, b¹n cã thÓ g¸n mét tæ hîp phÝm nãng ®Ó sau nµy 

khi so¹n th¶o chØ cÇn bÊm tæ hîp phÝm  ®ã, ký tù ®Æc biÖt t−¬ng øng sÏ 

®−îc chÌn lªn tµi liÖu. H·y lµm nh− sau:  

B−íc 1: Më hép tho¹i Symbol;  

B−íc 2: T×m ®Õn ký tù ®Æc biÖt cÇn g¸n phÝm t¾t, nhÊn chuét tr¸i lªn 

ký tù ®ã ®Ó chän:  
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B−íc 3: NhÊn nót Shortcut Key.. , hép tho¹i Customize Keyboard 

xuÊt hiÖn:  

   

Khi con trá ®ang ë môc Press new shortcut key: h·y nhÊn tæ hîp 

phÝm nãng cÇn g¸n. ë vÝ dô trªn, gi¶ sö muèn g¸n tæ hîp phÝm Alt + O 

cho ký tù φ, h·y bÊm tæ hîp phÝm Alt + O, tiÕp theo bÊm nót Assign ®Ó 

®¨ng ký phÝm t¾t nµy. Khi hép tho¹i sau ®©y xuÊt hiÖn, tøc lµ b¹n ®· 

g¸n phÝm t¾t Alt + O cho ký tù φ   
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C¸ch sö dông:  

Sau khi ®· thiÕt lËp tæ hîp phÝm t¾t cho ký tù φ, ®Ó chÌn ký tù nµy 
lªn tµi liÖu b¹n kh«ng cÇn quay l¹i tÝnh n¨ng Insert Symbol n÷a, mµ 

chØ cÇn nhÊn tæ hîp phÝm Alt + O. Ký tù φ sÏ ®−îc chÌn vµo vÞ trÝ mµ 
con trá ®ang chän.  

1.10.3 G¸n tõ viÕt t¾t cho ký tù ®Æc biÖt  

Ngoµi viÖc g¸n tæ hîp phÝm nãng cho mét ký tù ®Æc biÖt, ta cßn cã 
thÓ g¸n tæ hîp ký tù thay cho ký tù ®Æc biÖt th«ng qua tÝnh n¨ng 
AutoCorrect.  

VÝ dô, ®Ó chÌn ký tù ®Æc biÖt φ b¹n cã thÓ g¸n nã bëi tæ hîp ký tù fi, 

c¸ch lµm nh− sau:  

B−íc 1: Khëi ®éng tÝnh n¨ng Insert Symbol;  

B−íc 2: T×m ®Õn ký tù ®Æc biÖt cÇn g¸n phÝm t¾t, nhÊn chuét tr¸i lªn 

ký tù ®ã ®Ó chän:  
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B−íc 3: NhÊn chuét lªn nót AutoCorrect, hép tho¹i AutoCorrect 

xuÊt hiÖn:  

 
PhÝm nãng ®· ®−îc g¸n ! 

  

H·y gâ vµo tæ hîp ký tù th−êng cÇn g¸n cho ký tù ®Æc biÖt nµy vµo 

môc Replace. ë vÝ dô nµy, muèn g¸n tæ hîp ký tù fi cho ký tù ®Æc biÖt 

φ, h·y gâ fi vµo môc Replace;  

B−íc 4: nhÊn nót Add ®Ó ®ång ý cho viÖc g¸n võa råi. Cuèi cïng 

nhÊn Ok ®Ó ®ãng hép tho¹i.  

C¸ch sö dông:  
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Gi¶ sö b¹n ®· thiÕt lËp fi cho ký tù φ nh− trªn, nÕu ph¶i gâ biÓu 
thøc:   

φ = 2n+1 chØ cÇn gâ fi = 2n+1  

Ch−¬ng 2: 

b¶ng biÓu  

  

2.1 T¹o cÊu tróc b¶ng  

2.1.1 ChÌn b¶ng míi  

C¸ch 1: Sö dông môc chän Insert Table  

§Ó chÌn mét b¶ng míi lªn tµi liÖu, më môc chän: Table | Insert | 

Table… Hép tho¹i Insert Table xuÊt hiÖn:  

   

H·y ®iÒn th«ng tin vÒ cÊu tróc b¶ng míi lªn hép tho¹i nµy:  

 - Môc Table size: cho phÐp thiÕt lËp sè cét (Columns) vµ sè dßng 

(Rows) cho b¶ng:  

 - Gâ sè cét cña b¶ng vµo môc: Number of columns:  

 - Gâ sè dßng cña b¶ng vµo môc Number of rows:  

 - Môc AutoFit behavior: thiÕt lËp mét sè c¸c thuéc tÝnh tù ®éng 

c¨n chØnh:  
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 - Fixed column with: sÏ cè ®Þnh chiÒu réng cña mçi cét lµ: Auto 

‟ tù ®éng c¨n chØnh chiÓu réng cho cét; hoÆc b¹n gâ vµo ®é réng 
cña mçi cét vµo môc nµy (tèt nhÊt chän Auto, v× b¹n cã thÓ c¨n 
chØnh ®é réng cña c¸c cét sau nµy);  

 - AutoFit contents: tù ®éng ®iÒu chØnh ®é réng c¸c cét khÝt víi d÷ 

liÖu trong cét Êy;  

 - AutoFit window: tù ®éng ®iÒu chØnh ®é réng c¸c cét trong b¶ng 

sao cho b¶ng cã chiÒu réng võa khÝt chiÒu réng trang v¨n b¶n.  

Nªn chän kiÓu Auto cña môc Fixed column with:  

- Nót Auto format cho phÐp b¹n chän lùa ®Þnh d¹ng cña b¶ng sÏ 

t¹o theo mét sè mÉu b¶ng ®· cã s½n nh− lµ:  

   

 

H·y chän mét kiÓu ®Þnh d¹ng ë danh s¸ch Formats: (nÕu b¹n c¶m 

thÊy −ng ý). Ng−îc l¹i cã thÓ bÊm Cancel ®Ó bá qua b−íc nµy.  

 - NÕu chän môc  , th× th«ng tin vÒ cÊu tróc 
b¶ng hiÖn t¹i sÏ lµ ngÇm ®Þnh cho c¸c b¶ng t¹o míi sau nµy.  

 - Cuèi cïng nhÊn OK ®Ó chÌn b¶ng lªn tµi liÖu:  

 

C¸ch 2: Sö dông thanh c«ng cô: B¹n cã thÓ nhÊn nót Insert Table 

trªn thanh c«ng cô Standard ®Ó chÌn mét b¶ng lªn tµi liÖu. B¶ng chän 

sau ®©y xuÊt hiÖn, cho phÐp chän sè dßng vµ sè cét cña b¶ng:  
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H×nh trªn chän mét b¶ng míi víi 3 dßng vµ 3 cét. Sau khi thùc hiÖn 

lÖnh trªn, sÏ thu ®−îc kÕt qu¶ nh− sau:  

      

      

 

2.1.2 Söa cÊu tróc b¶ng  

Sau khi ®· chÌn mét b¶ng lªn tµi liÖu, b¹n vÉn cã thÓ thay ®æi cÊu 
tróc b¼ng b»ng c¸ch: chÌn thªm hoÆc xo¸ ®i c¸c cét, c¸c dßng cña 
b¶ng.  

Gi¶ sö b¹n ®· chÌn vµ nhËp d÷ liÖu cho b¶ng nh− sau:  

STT  Hä tªn  Ngµy sinh  

1  NguyÔn V¨n Nam  12/3/1983  

2  TrÇn ThÞ B×nh  22/1/1981  

 
 
Chän kiÓu ®Þnh d¹ng ë ®©y!  

B©y giê muèn chÌn thªm mét cét Giíi tÝnh vµo sau cét Hä tªn. B¹n cã 

thÓ lµm nh− sau:  

B−íc 1: §Æt ®iÓm trá lªn cét Hä tªn;  

B−íc 2: Më môc chän Table | Insert | Columns to the right (tøc lµ 

chÌn thªm mét cét vµo bªn ph¶i cét ®ang chän). Mét cét míi ®−îc chÌn 

vµo bªn ph¶i cét Hä tªn:  

STT  Hä tªn    Ngµy sinh  

1  NguyÔn V¨n Nam    12/3/1983  

2  TrÇn ThÞ B×nh    22/1/1981  
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 H·y thùc hiÖn nhËp d÷ liÖu cho cét Giíi tÝnh nµy:  

STT  Hä tªn  Giíi tÝnh  Ngµy sinh  

1  NguyÔn V¨n Nam  Nam  12/3/1983  

2  TrÇn ThÞ B×nh  N÷  22/1/1981  

 

Muèn chÌn thªm dßng vµo cuèi b¶ng ®Ó nhËp thªm d÷ liÖu, lµm nh− 

sau:  

B−íc 1: §Æt ®iÓm trá vµo dßng cuèi cïng (TrÇn ThÞ B×nh);  

B−íc 2: Më môc chän: Table | Insert | Row below (tøc lµ chÌn 

thªm dßng míi vµo phÝa d−êi dßng ®ang chän). Mét dßng míi ®−îc 
chÌn vµo b¶ng.  

STT  Hä tªn  Giíi tÝnh  Ngµy sinh  

1  NguyÔn V¨n Nam  Nam  12/3/1983  

2  TrÇn ThÞ B×nh  N÷  22/1/1981  

        

 

Ngoµi ra, khi sö dông c¸c thao t¸c vÒ con trá trùc tiÕp lªn b¶ng b¹n 
cã thÓ ®¬n gi¶n khi thùc hiÖn viÖc chØnh söa cÊu tróc b¶ng.  

§Ó chÌn thªm (c¸c) cét míi vµo b¶ng, b¹n lµm nh− sau:  

B−íc 1: Chän (b«i ®en) toµn bé cét muèn chÌn: gi¶ sö muèn chÌn 

thªm 1 cét vµo tr−íc cét Ngµy sinh, b¹n b«i ®en toµn bé cét Ngµy 

sinh;  

B−íc 2: NhÊn ph¶i chuét lªn vïng b«i ®en cña b¶ng, råi më môc 

chän  . Mét cét míi sÏ ®−îc chÌn vµo tr−íc cét 
Ngµy sinh.  

T−¬ng tù, ®Ó chÌn thªm (c¸c) dßng míi vµo b¶ng, b¹n lµm nh− sau:  

B−íc 1: Chän (b«i ®en) toµn bé dßng muèn chÌn: gi¶ sö muèn chÌn 

thªm 2 dßng lªn ®Çu b¶ng, b¹n b«i ®en toµn bé 2 dßng cã STT lµ 1 vµ 
2;  

B−íc 2: NhÊn ph¶i chuét lªn vïng b«i ®en cña b¶ng, råi më môc 
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chän  . Hai dßng míi sÏ ®−îc chÌn lªn tr−íc hai 
dßng cò.  

§Ó xo¸ (c¸c) cét ra khái b¶ng, lµm nh− sau:  

B−íc 1: Chän (b«i ®en) toµn bé c¸c cét muèn xo¸;  

B−íc 2: NhÊn ph¶i chuét lªn vïng b«i ®en cña b¶ng, råi më môc 

chän  . C¸c cét ®−îc chän sÏ bÞ xo¸ ra khái 
b¶ng.  

§Ó xo¸ (c¸c) dßng ra khái b¶ng, lµm nh− sau:  

B−íc 1: Chän (b«i ®en) toµn bé c¸c dßng muèn xo¸;  

B−íc 2: NhÊn ph¶i chuét lªn vïng b«i ®en cña b¶ng, råi më môc 

chän  . Toµn bé c¸c dßng ®· chän sÏ ®−îc xo¸ 
ra khái b¶ng.  

2.1.3 Trén «  

Trén « lµ thao t¸c trén nhiÒu « kÒ nhau trªn mét b¶ng l¹i thµnh mét «. 
XÐt vÝ dô sau:  

  

 

  

STT  Hä tªn  
Häc kú 1  Häc kú 2  

HL  HK  HL  HK  

1  NguyÒn V¨n Nam  Tèt  Tèt  Kh¸  Kh¸  

2  TrÇn Thanh B×nh  Tèt  Tèt  Kh¸  Tèt  

 

C¸ch lµm:  

§Çu tiªn b¹n t¹o b¶ng nh− sau:  

STT  Hä tªn  Häc kú 1    Häc kú 2    

    HL  HK  HL  HK  

1  NguyÒn V¨n Nam  Tèt  Tèt  Kh¸  Kh¸  
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2  TrÇn Thanh B×nh  Tèt  Tèt  Kh¸  Tèt  

 

Sau ®ã lÇn l−ît trén c¸c «. vÝ dô, ®Ó trén « Hä vµ tªn:  

B−íc 1: B«i ®en 2 « cÇn trén cña « Hä tªn;  

   

B−íc 2: Më môc chän Table | Merge Cell. Khi ®ã 2 « ®· chän sÏ 

®−îc trén thµnh mét «.   

T−¬ng tù, b¹n h·y lÇn l−ît trén c¸c « cßn l¹i.  

2.1.4 VÏ b¶ng  

Trong tr−êng hîp muèn vÏ thªm c¸c ®−êng cho b¶ng, b¹n cã thÓ sö 
dông chøc n¨ng nµy.  

H·y më thanh c«ng cô Tables and Borders, nhÊn nót Draw Table 

 . Con chuét lóc nµy chuyÓn sang h×nh chiÕc bót vÏ vµ b¹n cã thÓ 

dïng nã ®Ó kÎ thªm c¸c ®−êng kÎ cho b¶ng.  

 
C¸c « ®· ®−îc trén 

2.2 §Þnh d¹ng b¶ng biÓu  

2.2.1 §Þnh d¹ng d÷ liÖu trong «  

ViÖc ®Þnh d¹ng ph«ng ch÷, mµu ch÷ trªn b¶ng biÓu thùc hiÖn theo 

nh− phÇn ®Þnh d¹ng ch÷ ®· tr×nh bµy ë (môc 1.2).   

§Þnh d¹ng lÒ  

B−íc 1: Chän (b«i ®en) c¸c « cÇn ®Þnh d¹ng;  

B−íc 2: Nh¸y ph¶i chuét lªn vïng b«i ®en, më môc chän  

  råi chän kiÓu lÒ muèn ®Þnh d¹ng theo b¶ng:  



 

 

GIÁO TRÌNH WORD 2003-2007-2010 Page 56 

 

BÙI QUYẾT TIẾN 2011 

   

§Þnh d¹ng h−íng v¨n b¶n  

B¹n cã thÓ ®Þnh d¹ng h−íng v¨n b¶n trong « (hiÓn thÞ theo chiÒu däc, 

hay chiÒu ngang). §Ó ®Þnh d¹ng h−íng, b¹n lµm nh− sau:  

B−íc 1: Chän « cÇn ®Þnh d¹ng h−íng;  

B−íc 2: Nh¸y ph¶i chuét lªn vïng ®· chän, më môc chän 

 , hép tho¹i Text Direction xuÊt hiÖn:  

   

H·y dïng chuét nhÊn vµo h−íng muèn thiÕt lËp ë môc Orientation.   

B−íc 3: NhÊn OK ®Ó hoµn tÊt.  

2.2.2 T« nÒn, kÎ viÒn   

§Ó t« mµu nÒn hay kÎ viÒn cho mét vïng cña b¶ng, c¸ch lµm nh− 
sau:  

B−íc 1: Chän c¸c « (b«i ®en) cÇn t« nÒn hay ®Æt viÒn;  

B−íc 2: NhÊn ph¶i chuét lªn vïng ®· chän, më môc chän 

 . Hép tho¹i Border and Shading xuÊt hiÖn:  
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ThÎ Border cho phÐp thiÕt lËp c¸c ®Þnh d¹ng vÒ ®−êng kÎ cña vïng 

lùa chän:  

 - Môc Style: chän kiÓu ®−êng ®Þnh thiÕt lËp;  

 - Môc Color: chän mµu cho ®−êng th¼ng;  

 - Môc Width: chän ®é dµy, máng cho ®−êng;  

 - Môc Setting: chän ph¹m vi ®−êng cÇn thiÕt lËp. Ngoµi ra b¹n cã 

thÓ chän ph¹m vi c¸c ®−êng cÇn thiÕt lËp ®Þnh d¹ng ë môc 
Preview;  

 - Môc Apply to: ®Ó chän ph¹m vi c¸c « thiÕt lËp cho phï hîp: 

Table ‟ sÏ thiÕt lËp ®Þnh d¹ng nµy cho toµn bé b¶ng; Cell- chØ 

thiÕt lËp cho c¸c « ®· chän;  

 - NhÊn Ok ®Ó kÕt thóc c«ng viÖc.  

 

ThÎ Shading cho phÐp thiÕt lËp c¸c ®Þnh d¹ng vÒ t« nÒn b¶ng:  
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 - Môc Fill: chän chän mµu cÇn t«. §· cã s½n mét hép víi rÊt nhiÒu 

mµu. B¹n cã thÓ nhÊn nót More Colors.. ®Ó tù chän cho m×nh 

nh÷ng mµu kh¸c:  

   

- Môc Apply to: ®Ó chän ph¹m vi c¸c « cÊn t« mÇu nÒn: Table ‟ 

t« toµn bé b¶ng; Cell- chØ t« cho c¸c « ®· chän;  

- NhÊn Ok ®Ó kÕt thóc c«ng viÖc.  

 

2.3 TÝnh to¸n trªn b¶ng  

B¹n cã thÓ thùc hiÖn mét sè phÐp tÝnh ®¬n gi¶n trªn b¶ng cña Word. 
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Mét khÝa c¹nh nµo ®Êy th× Word còng cã kh¶ n¨ng nh− mét b¶ng tÝnh 

®iÖn tö (Excel), tuy nhiªn nã chØ xö lý ®−îc nh÷ng phÐp to¸n ®¬n gi¶n, rÊt 
lµ ®¬n gi¶n.   

2.3.1 TÝnh tæng  

Gi¶ sö cã mét b¶ng sè liÖu nh− sau:  

TT  Hä tªn  L−¬ng  Phô cÊp  Thùc lÜnh 

1  NguyÔn Nam  507000  150000  ?  

2  TrÇn Kh¸nh  600000  150000  ?  

3  Minh Hoa  630000  200000  ?  

Tæng céng:  ?  ?  ?  

 

Hµm tÝnh tæng SUM cña Word ®Ó ®iÒn gi¸ trÞ tæng vµo c¸c « cã dÊu ?  

B−íc 1: §Æt ®iÓm trá lªn « cÇn chøa gi¸ trÞ tæng. VÝ dô mét « trªn dßng 

Tæng céng:  

B−íc 2: Më môc chän Table | Formula.., hép tho¹i Formula xuÊt 

hiÖn:  

   

ë môc Formula, gâ vµo c«ng thøc cÇn tÝnh. Cã 3 lo¹i c«ng thøc tÝnh 

tæng:  

=SUM(ABOVE) ‟ tÝnh tæng c¸c dßng tõ trªn dßng ®Æt ®iÓm trá. 

C«ng thøc nµy ®−îc ¸p dông ®Ó tÝnh tæng cho dßng Tæng céng;  

=SUM(LEFT) ‟ tÝnh tæng cho c¸c dßng bªn tr¸i dßng ®Æt ®iÓm 

trá. C«ng thøc nµy ®−îc ¸p dông tÝnh tæng cho cét Thùc lÜnh ( = 

L−¬ng + Phô cÊp);  
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T−¬ng tù, =SUM(RIGHT) ‟ tÝnh tæng cho c¸c dßng bªn ph¶i 

dßng ®Æt ®iÓm trá.  

Cuèi cïng nhÊn OK ®Ó hoµn tÊt viÖc tÝnh tæng.  

Sau khi thùc hiÖn d¸n c¸c c«ng thøc tÝnh tæng cho dßng Tæng céng, vµ 

cét Thùc lÜnh ta ®−îc b¶ng kÕt qu¶ nh− sau:  

TT  Hä tªn  L−¬ng  Phô cÊp  Thùc lÜnh  

1  NguyÔn Nam  507000  150000  657000  

2  TrÇn Kh¸nh  600000  150000  750000  

3  Minh Hoa  630000  200000  830000  

Tæng céng:  1737000  500000  2237000  

 

 

  

2.3.2 TÝnh trung b×nh céng  

Gi¶ sö cã mét b¶ng sè liÖu nh− sau:  

TT  Hä tªn  §TB HK1 §TB HK2 §TB c¶ n¨m  

1  NguyÔn Nam  5.7  6.5  ?  

2  TrÇn Kh¸nh  7.6  7.4  ?  

3  Minh Hoa  7.5  8.3  ?  

§TB chung c¶ líp:  ?  ?  ?  

 

Hµm tÝnh trung b×nh céng AVERAGE cña Word ®Ó ®iÒn gi¸ trÞ vµo 

c¸c « cã dÊu ?  

B−íc 1: §Æt ®iÓm trá lªn « cÇn tÝnh. VÝ dô mét « trªn dßng §TB c¶ 

n¨m:  

B−íc 2: Më môc chän Table | Formula.., hép tho¹i Formula xuÊt 

hiÖn:  

 
=SUM(LEFT) 
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=SUM(ABOVE) 

  

ë môc Formula, gâ vµo c«ng thøc cÇn tÝnh. Cã 3 lo¹i c«ng thøc tÝnh 

trung b×nh céng:  

=AVERAGE(ABOVE) ‟ tÝnh trung b×nh céng c¸c dßng tõ trªn 

dßng ®Æt ®iÓm trá. C«ng thøc nµy ®−îc ¸p dông ®Ó tÝnh gi¸ trÞ cho 

dßng §TB chung c¶ líp:;  

=AVERAGE(LEFT) ‟ tÝnh trung b×nh céng cho c¸c dßng bªn tr¸i 

dßng ®Æt ®iÓm trá. C«ng thøc nµy ®−îc ¸p dông tÝnh gi¸ trÞ cho cét 

§TB c¶ n¨m  = (§TB HK1 + §TB HK2)/2;  

T−¬ng tù, =AVERAGE(RIGHT) ‟ tÝnh trung b×nh céng cho c¸c 

dßng bªn ph¶i dßng ®Æt ®iÓm trá.  

Cuèi cïng nhÊn OK ®Ó hoµn tÊt viÖc tÝnh tæng.  

Sau khi thùc hiÖn d¸n c¸c c«ng thøc tÝnh trung b×nh céng cho dßng 

§TB chung c¶ líp:, vµ cét §TB c¶ n¨m: ta ®−îc b¶ng kÕt qu¶ nh− sau:  

TT  Hä tªn  §TB HK1 §TB HK2 §TB c¶ n¨m  

1  NguyÔn Nam  5.7  6.5  6.1  

2  TrÇn Kh¸nh  7.6  7.4  7.5  

3  Minh Hoa  7.5  8.3  7.9  

§TB chung c¶ líp:  6.93  7.4  7.17  

 

2.4 S¾p xÕp d÷ liÖu trªn b¶ng  

D÷ liÖu trªn b¶ng cã thÓ ®−îc s¾p xÕp theo mét thø tù nµo ®ã.   

Gi¶ sö cã b¶ng d÷ liÖu sau:  
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TT  Hä ®Öm  Tªn  §iÓm TB  

1  NguyÔn Quang  Anh  7.5  

2  TrÇn M¹nh  Hµ  8.0  

3  NguyÔn §øc  B×nh  7.2  

4  NguyÔn Xu©n  Th¾ng  6.5  

5  NguyÔn ThÞ  Oanh  8.0  

 

S¾p xÕp b¶ng theo Tªn vµ Hä ®Öm  

§Æt ®iÓm trá lªn b¶ng cÇn s¾p xÕp råi më môc chän Table | Sort.., hép 

tho¹i Sort xuÊt hiÖn:  

   

ThiÕt lËp thuéc tÝnh cho hép tho¹i nµy nh− sau:  

 - Môc Sort by: chän cét ®Çu tiªn cÇn s¾p xÕp (cét Tªn);  

   

  

  

- Môc Type : chän kiÓu d÷ liÖu cña cét ®ã ®Ó s¾p xÕp. Cã 3 kiÓu d÷ 

liÖu mµ Word hç trî: Text ‟ kiÓu ký tù;  Number ‟ kiÓu sè häc 
vµ Date ‟ kiÓu ngµy;  

- C¸c môc Then By: SÏ ®−îc so s¸nh khi gi¸ trÞ s¾p xÕp tr−êng ®Çu 
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tiªn trïng nhau. VÝ dô trªn, khi Tªn trïng nhau th× s¾p xÕp tiÕp 

theo Hä ®Öm;  

- Môc My list has: chän Header row- dßng ®Çu tiªn cña b¶ng sÏ 

kh«ng tham gia vµo qu¸ tr×nh s¾p xÕp (lµm dßng tiªu ®Ò); nÕu 

chän No header row- m¸y tÝnh sÏ s¾p xÕp c¶ dßng ®Çu tiªn cña 

b¶ng (chän khi b¶ng kh«ng cã dßng tiªu ®Ò);  

- Cuèi cïng nhÊn OK ®Ó thùc hiÖn.  

 

 

Sau khi s¾p xÕp theo Tªn vµ Hä ®Öm, thu ®−îc b¶ng kÕt qu¶ nh− sau:  

TT  Hä ®Öm  Tªn  §iÓm TB  

1  NguyÔn Quang  Anh  7.5  

3  NguyÔn §øc  B×nh  7.2  

2  TrÇn M¹nh  Hµ  8.0  

5  NguyÔn ThÞ  Oanh  8.0  

4  NguyÔn Xu©n  Th¾ng  6.5  

 
 
Cét cÇn s¾p xÕp  
 
S¾p xÕp theo kiÓu d÷ liÖu 
 
S¾p theo chiÒu t¨ng 
 
S¾p theo chiÒu gi¶m 
 

 B¹n chØ cã thÓ s¾p xÕp ®−îc d÷ liÖu cña b¶ng trªn ph¹m vi c¸c « kh«ng bÞ trén (Merged)  

  

S¾p xÕp b¶ng theo §iÓm TB råi ®Õn Tªn  

§Æt ®iÓm trá lªn b¶ng cÇn s¾p xÕp råi më môc chän Table | Sort.., hép 

tho¹i Sort xuÊt hiÖn vµ thiÕt lËp c¸c th«ng sè cho hép tho¹i nµy nh− sau:  
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KÕt qu¶ s¾p xÕp thu ®−îc lµ:  

TT  Hä ®Öm  Tªn  §iÓm TB 

2  TrÇn M¹nh  Hµ  8.0  

5  NguyÔn ThÞ  Oanh  8.0  

1  NguyÔn Quang  Anh  7.5  

3  NguyÔn §øc  B×nh  7.2  

4  NguyÔn Xu©n  Th¾ng  6.5  

 

2.5 Thanh c«ng cô Tables and Borders  

Thanh c«ng cô nµy chøa c¸c tÝnh n¨ng gióp b¹n dÔ dµng thùc hiÖn 
nh÷ng thao t¸c xö lý trªn b¶ng biÓu.  

§Ó hiÓn thÞ thanh c«ng cô, kÝch ho¹t môc chän View | Toolbars | 

Tables and Borders:  

   

ý nghÜa c¸c nót trªn thanh c«ng cô nµy nh− sau:  

 :  
Dïng  ®Ó kÎ hoÆc ®Þnh d¹ng c¸c ®−êng;  
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 :  Dïng ®Ó tÈy bá ®−êng th¼ng;  

 :  
§Ó chän kiÓu ®−êng th¼ng;  

 :  Chän ®é ®Ëm cña ®−êng;  

 :  
§Þnh d¹ng mµu cho ®−êng;  

 :  
KÎ khung cho c¸c «;  

 :  
T« mÇu nÒn c¸c «;  

 :  
§Ó chÌn thªm b¶ng míi lªn tµi liÖu;  

 :  
§Ó trén c¸c « ®· chän thµnh 1 «;  

 :  
§Ó chia mét « thµnh nhiÒu « nhá;  

 :  
§Ó ®Þnh d¹ng lÒ v¨n b¶n trong «;  

 :  
§Ó kÝch ho¹t tÝnh n¨ng tù ®éng ®Þnh d¹ng  

 :  §Þnh d¹ng h−íng v¨n b¶n trong «;  

 :  
S¾p xÕp gi¶m dÇn theo cét ®ang chän;  

 :  
S¾p xÕp t¨ng dÇn theo cét ®ang chän;  

 :  
TÝnh tæng ®¬n gi¶n.  

 

Ch−¬ng 3: 

§å ho¹  

  

  

Ngoµi nh÷ng kh¶ n¨ng vÒ so¹n th¶o vµ ®Þnh d¹ng v¨n b¶n, kh¶ n¨ng ®å 

ho¹ cña Word còng rÊt m¹nh. Trong ch−¬ng nµy, chóng ta sÏ ®−îc t×m 

hiÓu vµ tiÕp cËn nh÷ng kü thuËt vÏ h×nh còng nh− xö lý mét sè khèi h×nh 
ho¹ trùc tiÕp trªn Word.  
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§Ó lµm viÖc víi m«i tr−êng ®å ho¹ trªn Word, b¹n ph¶i sö dông ®Õn 
thanh c«ng cô Drawing.   

   

NÕu ch−a nh×n thÊy thanh c«ng cô nµy trªn mµn h×nh cã thÓ më nã 
b»ng c¸ch kÝch ho¹t môc chän View | Toolbar | Drawing  

3.1 VÏ khèi h×nh ®¬n gi¶n  

3.1.1 Sö dông c¸c mÉu h×nh ®¬n gi¶n  

B¹n cã thÓ vÏ mét sè khèi h×nh rÊt ®¬n gi¶n lªn tµi liÖu cña m×nh b»ng 

c¸ch sö dông mét sè nót vÏ h×nh trªn thanh c«ng cô Drawing nh−:  

 :  VÏ h×nh ch÷ nhËt;  

 :  VÏ h×nh « val, h×nh trßn;  

 :  T¹o « h×nh ch÷ nhËt chøa v¨n b¶n;  

 :  VÏ ®−êng th¼ng;  

 :  VÏ mòi tªn.  

 

  

C¸ch vÏ h×nh nh− sau:  

B−íc 1: Dïng chuét nh¾p lªn nót chøa h×nh cÇn vÏ;   

B−íc 2: Dïng chuét vÏ h×nh ®ã lªn tµi liÖu.  

  

D−íi ®©y lµ mét h×nh ch÷ nhËt võa ®−îc vÏ:  
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§iÓm ®¸nh dÊu 
 
Khi con trá chuyÓn h×nh mòi tªn, b¹n cã thÓ thay ®æi kÝch cì h×nh vÏ.  

Chóng ta ®Ó ý, trªn khèi h×nh th−êng cã c¸c ®iÓm ®¸nh dÊu  , 
nÕu ®Æt con trá chuét vµo nh÷ng ®iÓm ®¸nh dÊu nµy b¹n cã thÓ co d·n 

®−îc kÝch cì cña h×nh vÏ b»ng c¸ch kÐo rª chuét.  

3.1.2 Sö dông c¸c khèi h×nh AutoShape  

Ngoµi c¸c khèi h×nh ®¬n gi¶n mµ b¹n thÊy trªn thanh c«ng cô 

Drawing, nót AutoShapes cßn cung cÊp rÊt nhiÒu c¸c mÉu h×nh vÏ ®a 

d¹ng.  

§Ó sö dông mét mÉu h×nh trong AutoShapes, B¹n lµm nh− sau:  

NhÊp nót AutoShapes trªn thanh c«ng cô Drawing:  

   

Danh s¸ch c¸c mÉu h×nh ®−îc liÖt kª ra, b¹n cã thÓ chän vµ vÏ 

chóng lªn tµi liÖu nh− ®· h−íng dÉn ë trªn.  

3.1.3 §Þnh d¹ng h×nh vÏ  

Thanh c«ng cô Drawing cung cÊp nhiÒu nót tÝnh n¨ng gióp b¹n ®Þnh 

d¹ng trªn khèi h×nh vÏ:  

 :  Nót nµy dïng ®Ó chän ®èi t−îng cÇn ®Þnh d¹ng;  

 :  Chän ®é dÇy máng cña ®−êng;  

 :  Chän kiÓu nÐt cña ®−êng;  
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 :  Chän chiÒu mòi tªn (khi vÏ mòi tªn trªn h×nh);  

 :  Chän mµu s¾c cho ®−êng;  

 :  T« mÇu nÒn cho mét h×nh kÝn;  

 :  Chän mµu s¾c cho ch÷;  

 :  T¹o bãng cho h×nh vÏ;  

 :  Chän khèi h×nh trong kh«ng gian 3 chiÒu (3D);  

 :  §Ó quay h×nh vÏ.  

 

3.1.4 Lµm viÖc tËp hîp c¸c h×nh vÏ  

Mét khèi h×nh vÏ th−êng bao gåm tæ hîp nhiÒu h×nh vÏ ghÐp l¹i. 
TÝnh n¨ng nhãm (Group) gióp gom nhãm  c¸c h×nh nhá cÇn thiÕt thµnh 

mét khèi h×nh lín. §iÒu nµy rÊt thu©n lîi cho viÖc sö dông còng nh− 
qu¶n lý khèi h×nh vÏ trªn tµi liÖu.  

a. Gom nhãm (Group)  

§Ó gom nhãm mét tËp hîp c¸c h×nh, b¹n lµm nh− sau:  

B−íc 1: Sö dông nót   trªn thanh c«ng cô Drawing, kÕt hîp viÖc 

gi÷ phÝm Shift. Råi lÇn l−ît chän c¸c h×nh nhá cÇn nhãm l¹i (b»ng 

c¸ch nhÊn chuét lªn tõng h×nh) hoÆc dïng chuét khoanh vïng bao 
quanh khèi h×nh cÇn nhãm;  

B−íc 2: KÝch ho¹t tÝnh n¨ng nhãm b»ng c¸ch: nhÊn nót Draw trªn 

thanh c«ng cô Drawing, chän Group   . TÊt c¶ 

c¸c h×nh nhá ®· chän sÏ ®−îc nhãm l¹i thµnh mét h×nh lín.  

b. Gì nhãm (Ungroup)  

Trong tr−êng hîp muèn söa l¹i tõng cÊu tróc h×nh nhá trªn khèi ®· 

nhãm, b¹n ph¶i thùc hiÖn gì nhãm. C¸ch lµm nh− sau:  

B−íc 1: Sö dông nót   ®Ó chän h×nh (lín) cÇn gì nhãm;  

B−íc 2: KÝch ho¹t tÝnh n¨ng gì nhãm b»ng c¸ch: nhÊn nót Draw 
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trªn thanh c«ng cô Drawing, chän Ungroup   . 

TÊt c¶ c¸c h×nh nhá trong h×nh lín sÏ ®−îc trë l¹i tr¹ng th¸i nh− tr−íc 
lóc bÞ nhãm.   

§Õn ®©y, b¹n cã thÓ hiÖu chØnh tõng h×nh nhá theo ý muèn.  

c. Nhãm l¹i (Regroup)  

Sau khi gì nhãm vµ chØnh söa xong, muèn nhãm l¹i thµnh khèi h×nh 

nh− ban ®Çu b¹n kh«ng cÇn ph¶i thùc hiÖn l¹i tÝnh n¨ng nhãm, mµ chØ 

cÇn gäi tÝnh n¨ng nhãm l¹i (Regroup). C¸ch lµm nh− sau;  

B−íc 1: Sö dông nót   ®Ó chän bÊt kú mét h×nh nhá nµo trong sè 

c¸c h×nh nhá cÇn nhãm l¹i;  

B−íc 2: KÝch ho¹t tÝnh n¨ng nhãm l¹i b»ng c¸ch: nhÊn nót Draw 

trªn thanh c«ng cô Drawing, chän Regroup  . 

C¸c h×nh nhá sÏ ®−îc tù ®éng nhãm l¹i nh− viÖc nhãm ®· lµm ban 
®Çu.  

3.2 T¹o ch÷ nghÖ thuËt  

3.2.1 ChÌn ch÷ nghÖ thuËt  

§Ó chÌn mét dßng ch÷ nghÖ thuËt (Word Art) lªn tµi liÖu, b¹n lµm 

nh− sau:  

B−íc 1: NhÊp nót Insert WordArt   trªn thanh céng cô 

Drawing, hép tho¹i WordArt Gallery xuÊt hiÖn:  
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B−íc 2: Dïng chuét chän kiÓu ch÷ nghÖ thuËt cÇn t¹o, b»ng c¸ch 

nhÊn vµo « chøa kiÓu ch÷ mµ b¹n muèn;  

B−íc 3: Gâ vµo dßng ch÷ b¹n muèn t¹o ë môc Text trªn hép tho¹i 

Edit WordArt Text:  

   

B¹n cã thÓ chän ph«ng ch÷, kiÓu ch÷, cì ch÷ cho ®o¹n v¨n b¶n nµy.   

B−íc 4: NhÊn Ok ®Ó kÕt thóc. Dßng ch÷ nghÖ thuËt sÏ ®−îc hiÖn lªn 

tµi liÖu:  
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3.2.2 HiÖu chØnh  

B¹n cã thÓ thùc hiÖn c¸c phÐp hiÖu chØnh cho dßng ch÷ nghÖ thuËt 

®· t¹o ®−îc bëi thanh c«ng cô WordArt:  

   

ý nghÜa c¸c nót lÖnh trªn thanh c«ng cô nµy nh− sau:  

 
NhÊn chuét lªn « cã mÉu ch÷ cÇn t¹o!  

 :  §Ó chÌn thªm dßng ch÷ nghÖ thuËt kh¸c;  

 :  §Ó söa néi dung v¨n b¶n cña dßng ch÷;  

 :  §Ó chän l¹i kiÓu ch÷ nghÖ thuËt;  

 :  §Ó ®Þnh d¹ng mµu cho khèi ch÷;  

 :  §Ó chän mét sè kiÓu ch÷ nghÖ thuËt kh¸c;  

 :  §Ó quay khèi ch÷;  

 :  §Ó xoay h−íng v¨n b¶n;  

 :  §Ó ®Þnh d¹ng lÒ v¨n b¶n trong khèi h×nh;  

 :  §Ó ®iÒu chØnh kho¶ng c¸ch gi÷a c¸c ký tù.  

 

3.3 ChÌn ¶nh lªn tµi liÖu  

 B¹n cã thÓ chÌn ®−îc h×nh ¶nh tõ nhiÒu nguån kh¸c nhau trªn m¸y tÝnh 

lªn tµi liÖu Word nh−: ¶nh tõ mét tÖp tin; ¶nh tõ th− viÖn ¶nh Clip Gallery 
hoÆc ¶nh tõ mµn h×nh m¸y tÝnh.  

3.5.1 ChÌn ¶nh tõ mét tÖp tin  

§Ó chÌn ¶nh tõ mét tÖp tin lªn tµi liÖu, b¹n lµm nh− sau:  

Më môc chän Insert | Picture | From file, hép tho¹i Insert Picture 

xuÊt hiÖn cho phÐp b¹n t×m tÖp ¶nh  cÇn chÌn lªn tµi liÖu:  
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H·y chän tÖp ¶nh, råi nhÊn nót Insert ®Ó hoµn tÊt.  

   

¶nh tõ tÖp ®· chän ®−îc chÌn lªn tµi liÖu cïng thanh c«ng cô Picture 

gióp b¹n thùc hiÖn c¸c phÐp ®Þnh d¹ng, hiÖu chØnh ¶nh. ý nghÜa c¸c 

nót lÖnh trªn thanh c«ng cô Picture nh− sau:  

 :  §Ó chÌn thªm ¶nh tõ tÖp tin kh¸c;  

 :  §Þnh d¹ng mµu cho ¶nh;  

   :  §iÒu chØnh ®é t−¬ng ph¶n cho ¶nh;  

   :  §iÒu chØnh ®é s¸ng, tèi cña ¶nh;  

 :  Dïng ®Ó c¾t ¶nh;  

 :  Chän kiÓu ®−êng viÒn cho ¶nh;  

 :  BËt c¸c tÝnh n¨ng ®Þnh d¹ng ®èi t−îng ¶nh;  
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 :  ThiÕt lËp thuéc tÝnh xuyªn thÊu (Transparent) ¶nh;  

 :  Huû bá c¸c ®Þnh d¹ng ¶nh.  

 

Trong tr−êng hîp kh«ng xuÊt hiÖn thanh c«ng cô Picture, b¹n cã thÓ 

gäi môc chän View | Toolbar | Picture ®Ó hiÓn thÞ nã.  

3.5.2 ChÌn ¶nh tõ th− viÖn ¶nh Clip Gallery  

§Ó chÌn ¶nh tõ th− viÖn ¶nh Clip Gallery lªn tµi liÖu, b¹n lµm nh− 
sau:  

Më môc chän Insert | Picture | Clip Art, hép tho¹i Insert 

ClipArt xuÊt hiÖn cho phÐp t×m h×nh ¶nh  cÇn chÌn lªn tµi liÖu:  

   

¶nh ®−îc l−u trong c¸c môc (Categories), b¹n ph¶i më c¸c môc 

nµy ra ®Ó t×m ¶nh.   

Nót Back   vµ Forward   gióp b¹n quay vÒ thao t¸c tr−íc 

hoÆc thao t¸c sau trong khi dÞch chuyÓn gi÷a c¸c Categories.   

Sau khi t×m ®−îc ¶nh, nhÊn chuét lªn ¶nh t×m ®−îc, mét thùc ®¬n 
xuÊt hiÖn cho phÐp b¹n chän c¸c t×nh huèng xö lý ®èi víi ¶nh ®ang 
chän:  
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H·y nhÊn nót Insert   ®Ó chÌn ¶nh lªn tµi liÖu.  

Sau khi ¶nh ®−îc chÌn lªn tµi liÖu, b¹n cã thÓ sö dông thanh c«ng cô 

Picture ®Ó ®Þnh d¹ng ¶nh nh− ®· h−íng dÉn ë trªn.  

3.5.3 Chôp ¶nh tõ mµn h×nh vµo tµi liÖu  

Trong qu¸ tr×nh chÕ b¶n tµi liÖu, nhiÒu khi chóng ta cÇn chÌn nh÷ng 
h×nh ¶nh ®ang xuÊt hiÖn trªn mµn h×nh m¸y tÝnh vµo tµi liÖu. Sau ®©y 

lµ c¸c b−íc cÇn thiÕt gióp b¹n lµm viÖc ®ã:  

B¹n muèn chôp toµn bé mµn h×nh m¸y tÝnh vµo tµi liÖu?  

B−íc 1: Më mµn h×nh cÇn chôp, nhÊn phÝm Print Screen. Toµn bé 

h×nh ¶nh cña mµn h×nh sÏ ®−îc l−u vµo bé nhí ®Öm (Clipboard) d−íi 
d¹ng h×nh ¶nh;  

B−íc 2: Chän vÞ trÝ cÇn chÌn lªn tµi liÖu, nhÊn tæ hîp phÝm Ctrl + V 

hoÆc nót Paste ®Ó d¸n h×nh tõ bé nhí ®Öm lªn v¨n b¶n.  

B¹n muèn chôp hép tho¹i hoÆc cöa sæ ®ang ®−îc kÝch ho¹t trªn mµn 

h×nh vµo tµi liÖu?  

 
NhÊn lªn ®©y ®Ó chÌn ¶nh lªn tµi liÖu!  

B−íc 1: Më mµn h×nh cÇn chôp, nhÊp tæ hîp phÝm Alt + Print 

Screen. H×nh ¶nh cña hép tho¹i hoÆc cöa sæ ®ang kÝch ho¹t sÏ ®−îc 

l−u vµo bé nhí ®Öm;  

B−íc 2: Chän vÞ trÝ cÇn chÌn ¶nh trªn tµi liÖu, nhÊn tæ hîp phÝm Ctrl 

+ V hoÆc nót Paste ®Ó d¸n h×nh tõ bé nhí ®Öm lªn v¨n b¶n.  

B¹n chØ muèn chôp mét vïng nµo ®ã cña mµn h×nh vµo tµi liÖu?  
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B−íc 1: Më mµn h×nh cÇn chôp, nhÊp phÝp Print Screen.  

B−íc 2: H·y më ch−¬ng tr×nh Paint brush cña Window hay bÊt kú 

mét phÇn mÒm xö lý ¶nh nµo cã trªn m¸y tÝnh; t¹o mét tÖp míi vµ d¸n 

mµn h×nh võa chôp ®−îc vµo. TiÕp theo, sö dông tÝnh n¨ng c¾t h×nh cña 

phÇn mÒm nµy ®Ó c¾t phÇn h×nh ¶nh cÇn lÊy. NhÊn Ctrl+C hoÆc nót 

Copy ®Ó sao chÐp chóng.  

B−íc 3: Cuèi cïng, b¹n chän vÞ trÝ cÇn chÌn lªn tµi liÖu, nhÊn tæ hîp 

phÝm Ctrl + V hoÆc nót Paste ®Ó d¸n h×nh ®· c¾t ®−îc lªn tµi liÖu.  

  

Ch−¬ng 4: 

In Ên  

  

4.1 Qui tr×nh ®Ó in Ên  

In Ên lµ c«ng ®o¹n rÊt quan träng vµ lµ kh©u cuèi cïng trong qui tr×nh 
so¹n th¶o tµi liÖu.   

§Ó lµm tèt viÖc in Ên cho tµi liÖu cña m×nh, b¹n nªn thùc hiÖn theo qui 
tr×nh sau:  

  

 

 - §Þnh d¹ng trang in: ®©y lµ b−íc b¹n ph¶i lµm ®Çu tiªn khi so¹n 
th¶o mét tµi liÖu trªn Word;  

 - So¹n th¶o tµi liÖu: bao gåm tÊt c¶ c¸c kü n¨ng mµ b¹n ®· ®−îc 

t×m hiÓu tõ ch−¬ng 1 ®Õn ch−¬ng 5;  

 - ThiÕt lËp tiªu ®Ò ®Çu, tiªu ®Ò cuèi trang;  

 - Print Preview- lµ kh©u rÊt quan träng. Cho phÐp b¹n cã thÓ xem 

néi dung c¸c trang in tr−íc khi in;  

 - Thùc hiÖn in tµi liÖu ra giÊy.  
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4.2 TÝnh n¨ng Page Setup  

 TÝnh n¨ng nµy gióp thiÕt lËp cÊu tróc trang in, khæ giÊy in. H·y më môc 
chän File | Page Setup.. ®Ó kÝch ho¹t. Hép tho¹i Page Setup xuÊt hiÖn:  

1. §Þnh d¹ng trang in (Page Setup) 
2. So¹n th¶o tµi liÖu  

  
3. ThiÕt lËp tiªu ®Ò ®Çu, tiªu ®Ò cuèi trang, ®¸nh sè trang (nÕu cÇn)  

4. Xem tµi liÖu tr−íc khi in     
 (Print preview)  
5.  In Ên tµi liÖu 

  

 - ThÎ Paper Size: cho phÐp b¹n lùa chän khæ giÊy in:  

 - Môc Paper size: ®Ó chän khæ giÊy in. Bao gåm c¸c khæ: Letter, 

A0, A1, A2, A3, A4, A5,.. tuú thuéc vµo tõng lo¹i m¸y in cña b¹n. 

B×nh th−êng, v¨n b¶n ®−îc so¹n th¶o trªn khæ A4;  

 - Ngoµi ra b¹n cã thÓ thiÕt lËp chiÒu réng (môc Width), chiÒu cao 

(môc Height) cho khæ giÊy;  

 - Môc Orientation: ®Ó chän chiÒu in trªn khæ giÊy. NÕu lµ 

Portrait ‟ in theo chiÒu däc; Lanscape ‟ in theo chiÒu ngang 

khæ giÊy;  

 - Môc Apply to: ®Ó chØ ®Þnh ph¹m vi c¸c trang in ®−îc ¸p dông 

thiÕt lËp nµy. NÕu lµ Whole Document - ¸p dông cho toµn bé tµi 
liÖu; This point forward - ¸p dông b¾t ®Çu tõ trang ®ang chän trë 
vÒ cuèi tµi liÖu;  

 - Môc Preview ‟ cho phÐp b¹n nh×n thÊy cÊu tróc trang in ®· thiÕt 

lËp;  
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 - NhÊn nót Default.. ‟ nÕu b¹n muèn ¸p dông thiÕt lËp nµy lµ 

ngÇm ®Þnh cho c¸c tÖp tµi liÖu sau cña Word;  

 - NhÊn OK ®Ó ®ång ý vµ ®ãng hép tho¹i l¹i.  

 

ThÎ Margin: cho phÐp thiÕt lËp lÒ trang in:  

   

 - Môc Top: ®Ó thiÕt lËp chiÒu cao cña lÒ trªn cña trang in;  

 - Môc Bottom: ®Ó thiÕt lËp chiÒu cao cña lÒ d−íi cña trang in;  

 - Môc Left: ®Ó thiÕt lËp chiÒu réng cña lÒ bªn tr¸i cña trang in;  

 - Môc Right: ®Ó thiÕt lËp chiÒu réng cña lÒ bªn ph¶i cña trang in;  

 - Môc Gutter: ®Ó thiÕt lËp bÒ réng phÇn g¸y tµi liÖu;  

    

- Môc Header ‟ thiÕt lËp chiÒu cao cña phÇn tiªu ®Ò ®Çu trang 

(Header);  

- Môc Footer ‟ thiÕt lËp chiÒu cao cña phÇn tiªu ®Ò cuèi trang 

(Footer);  
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- Môc Apply to: ®Ó chØ ®Þnh ph¹m vi c¸c trang in ®−îc ¸p dông 

thiÕt lËp nµy. NÕu lµ Whole Document - ¸p dông cho toµn bé tµi 

liÖu; This point forward - ¸p dông b¾t ®Çu tõ trang ®ang ®Æt ®iÓm 
trá trë vÒ cuèi tµi liÖu;  

- Môc Preview cho phÐp b¹n nh×n thÊy cÊu tróc trang in ®· thiÕt 

lËp;  

- NhÊn nót Default.. ‟ nÕu b¹n muèn ¸p dông thiÕt lËp nµy lµ 

ngÇm ®Þnh cho c¸c tÖp tµi liÖu sau cña Word;  

- NhÊn OK ®Ó ®ång ý vµ ®ãng hép tho¹i l¹i.  

 

 

4.3 Tiªu ®Ò ®Çu, tiªu ®Ò cuèi trang  

 Cã thÓ miªu t¶ vÞ trÝ cña phÇn tiªu ®Ò ®Çu, tiªu ®Ò cuèi trang qua h×nh 
sau:   
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C¸ch x©y dùng tiªu ®Ò ®Çu vµ tiªu ®Ò cuèi:  

Më môc chän View | Header and Footer, con trá lËp tøc chuyÓn 

ngay vµo phÇn tiªu ®Ò ®Çu (Header):  

 
Top 
 
Left  
 
Gutter  
 
Right 
 
Bottom 
 
Header 
 
Footer  

  

Thanh c«ng cô Header and Footer còng xuÊt hiÖn:  

   

B¹n cã thÓ so¹n th¶o tiªu ®Ò b»ng c¸ch gâ trùc tiÕp v¨n b¶n, råi ®Þnh 
d¹ng chóng. B¹n còng cã thÓ chÌn c¸c h×nh ¶nh, ®å häa, b¶ng biÓu,.. lªn 

tiªu ®Ò nh− lµ chÌn lªn tµi liÖu. Ngoµi ra, b¹n cã thÓ chÌn thªm c¸c th«ng 

tin kh¸c n÷a tõ thanh c«ng cô Header and Footer nh− sau:  

 :  
Nót nµy cho phÐp chÌn vµo mét sè c¸c th«ng tin tiªu 

®Ò cña tÖp tµi liÖu nh− lµ:  

 :  ChÌn T¸c gi¶, trang, ngµy;  

 :  ChÌn tªn t¸c gi¶;  

 :  ChÌn tªn m¸y tÝnh t¹o tÖp tin;  

 :  ChÌn tªn tÖp tin cïng ®−êng dÉn;  

 :  ChÌn tªn tÖp tin;  
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 :  ChÌn ngµy in v¨n b¶n gÇn nhÊt;  

 :  ChÌn thêi ®iÓm cuèi sö v¨n b¶n;  

 
:  

ChÌn trang thø X cña tæng sè trang Y  

 :  ChÌn sè thø tù trang hiÖn t¹i;  

 :  ChÌn tæng sè trang cña tµi liÖu;  

 :  ChÌn ngµy hiÖn t¹i;  

 :  ChÌn giê hiÖn t¹i;  

 :  §Þnh d¹ng sè trang;  

 :  ChuyÓn ®æi lµm viÖc gi÷a Header vµ Footer;  

 :  §ãng thanh tiªu ®Ò l¹i.  

 

4.4 ChÌn sè trang tù ®éng  

 Ngoµi viÖc chÌn sè trang tù ®éng bëi tÝnh n¨ng Header and Footer, b¹n 

cã thÓ chÌn sè trang tù ®éng lªn tiªu ®Ò trang b»ng c¸ch:  

 Më môc chän: Insert Page numbers… Hép tho¹i Page numbers xuÊt 

hiÖn:  

   

 - Môc Position ‟ chän vÞ trÝ sÏ chÌn sè trang: Bottom of page  

chÌn vµo tiªu ®Ò cuèi; hoÆc Top of page  chÌn vµo tiªu ®Ò ®Çu 
trang;  

 - Môc Aligment ‟ dãng hµng cho sè trang: Right- bªn ph¶i trang; 
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Left ‟ bªn tr¸i trang hoÆc Center- ë gi÷a trang;  

 - NÕu chän môc   sÏ thùc hiÖn ®¸nh sè trang 

®Çu tiªn, tr¸i l¹i trang ®Çu tiªn sÏ kh«ng ®−îc ®¸nh sè, chØ ®¸nh sè 
tõ trang thø 2 trë ®i;  

 - Môc Preview-  ®Ó xem kÕt qu¶ thiÕt lËp trªn trang tµi liÖu;  

 - NhÊn OK ®Ó hoµn tÊt c«ng viÖc.  

 

4.5 Xem tµi liÖu tr−íc khi in  

 Xem tr−íc khi in (hay cßn gäi Print preview) lµ viÖc rÊt quan träng, ®Æc 

biÖt ®èi víi nh÷ng ng−êi míi häc word, ch−a cã nhiÒu c¸c kü n¨ng vÒ in 

Ên. Qua mµn h×nh Print Preview, b¹n cã thÓ quan s¸t tr−íc ®−îc cÊu tróc 

trang in còng nh− néi dung chi tiÕt trªn trang in. Qua ®ã sÏ cã nh÷ng ®iÒu 

chØnh hîp lý, kÞp thêi ®èi víi tµi liÖu cña m×nh ®Ó khi in ra sÏ thu ®−îc 

kÕt qu¶ cao nh− ý muèn.  

§Ó bËt mµn h×nh Print preview, b¹n cã thÓ lµm theo mét trong hai 

c¸ch:  

C¸ch 1: Më môc chän File | Print Preview  

C¸ch 2: NhÊn nót Print preview   trªn thanh c«ng cô Standard.  

Mµn h×nh Preview cïng thanh c«ng cô Print preview xuÊt hiÖn:  
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Mµn h×nh Preview lµ n¬i hiÓn thÞ cÊu tróc, còng nh− néi dung c¸c 

trang tµi liÖu tr−íc khi in;  

Thanh c«ng cô Print Preview cung cÊp c¸c nót chøc n¨ng ®Ó lµm 

viÖc trªn mµn h×nh Preview, ®ã lµ:  

 
:  

§Ó phãng to, thu nhá (Zoom) th«ng tin trªn mµn h×nh Preview;  

 :  
Cho phÐp hiÓn thÞ hay kh«ng hiÓn thÞ th−íc kÎ (Rule) trªn mµn 
h×nh nµy;  

 :  ChØ hiÓn thÞ mét trang tµi liÖu trªn mµn h×nh nµy;  

 :  
Cã thÓ chän n trang tµi liÖu cïng hiÓn thÞ trªn cïng mét mµn 

h×nh nµy (n=1..6);  
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 :  
§Ó chuyÓn ®æi chÕ ®é chØ xem vµ xem + cã thÓ söa néi dung 
trùc tiÕp trªn tµi liÖu;  

 :  In tµi liÖu ra m¸y in;  

 :  
§ãng mµn h×nh nµy l¹i, trë vÒ mµn h×nh so¹n th¶o tµi liÖu ban 

®Çu. B¹n còng cã thÓ lµm viÖc nµy khi nhÊn phÝm ESC.  

 

4.6 In Ên tµi liÖu  

 Sau khi ®· chÕ b¶n xong tµi liÖu, ®· kiÓm tra l¹i c¸c lçi chÕ b¶n. B−íc 
nµy b¹n sÏ thùc hiÖn in Ên tµi liÖu ra m¸y in.  

 Cã nhiÒu c¸ch cho b¹n chän lùa ra lÖnh in Ên:  

 C¸ch 1: Më môc chän File | Print..  

C¸ch 2: NhÊn tæ hîp phÝm Ctrl + P  

Hép tho¹i Print xuÊt hiÖn:  

   

 - Hép Printer cho phÐp b¹n chän m¸y in cÇn in (trong tr−êng hîp 

m¸y tÝnh b¹n cã nèi tíi nhiÒu m¸y in). Nót Properties cho phÐp 

b¹n thiÕt lËp c¸c thuéc tÝnh cho m¸y in nÕu cÇn;  

 - Hép Page range- cho phÐp thiÕt lËp ph¹m vi c¸c trang in:  

 - Chän All ‟ in toµn bé c¸c trang trªn tÖp tµi liÖu;  
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 - Current page ‟ chØ in trang tµi liÖu ®ang chän;  

 - Pages ‟ chØ ra c¸c trang cÇn in. Qui t¾c chän ra c¸c trang cÇn in 

nh− sau:  

<tõ trang>-<®Õn trang>  

VÝ dô:   

ChØ in trang sè 5: 5  

In tõ trang 2 ®Õn trang 10: 2-10  

In tõ trang 2 ®Õn trang 10; tõ trang 12 ®Õn 15: 2-10, 12-15  

 - Hép Copies ‟ chØ ra sè b¶n in, ngÇm ®Þnh lµ 1. NÕu b¹n in nhiÒu 

h¬n 1 b¶n, h·y gâ sè b¶n in vµo ®©y;  

 - Hép Page per sheet ®Ó chØ ra sè trang tµi liÖu sÏ ®−îc in ra mét 

trang giÊy. NgÇm ®Þnh lµ 1, tuy nhiªn b¹n cã thÓ thiÕt lËp nhiÒu h¬n 
sè trang in trªn mét trang giÊy, khi ®ã cì sÏ rÊt bÐ;  

 - Cuèi cïng nhÊn nót OK ®Ó thùc hiÖn viÖc in Ên.  

 

 

Ch−¬ng 5: 

trén tµi liÖu  

  

5.1 Kh¸i niÖm vÒ trén tµi liÖu  

Mét tÝnh n¨ng rÊt m¹nh cña phÇn mÒm so¹n th¶o v¨n b¶n Microsoft 
Word lµ trén tµi liÖu (Mail Merge). §iÒu nµy ®· gióp Ých cho c¸c nh©n 
viªn v¨n phßng rÊt nhiÒu trong viÖc in c¸c danh s¸ch cña m×nh ra c¸c 
phiÕu nhá. Chóng ta h·y t×m hiÓu t×nh huèng sau:  

Lan lµ BÝ th− chi ®oµn líp Q9A1, c« ®ang ph¶i so¹n th¶o c¸c giÊy mêi 
®Ó göi tíi c¸c b¹n sinh viªn tham dù buæi liªn hoan v¨n nghÖ do Chi ®oµn 

tæ chøc. Danh s¸ch kh¸ch mêi ®· ®−îc liÖt kª trªn mét b¶ng Word (hoÆc 

trªn Excel) nh− sau:  

TT  Hä tªn  Líp  

1  NguyÔn V¨n Quang  Q9A2  
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2  Th¹ch H¶i V©n  Q9A2  

3  Bïi ThÞ Ninh  Q9A3  

4  Lª Quang T¸m  Q9A3  

5  NguyÔn ThÞ Hµ  Q9A4  

 

Lan ph¶i lµm nh− thÕ nµo?  

TÝnh n¨ng Mail Merge cña Word sÏ gióp Lan ®¬n gi¶n vµ rÊt nhanh 

chãng t¹o ra ®−îc c¸c giÊy mêi ghi ®Çy ®ñ th«ng tin cÇn thiÕt.  

5.2 ChuÈn bÞ d÷ liÖu  

Ph¶i ch¾c ch¾n b¹n ®· t¹o ®−îc danh s¸ch kh¸ch mêi nh− sau:  

TT  Hä tªn  Líp  

1  NguyÔn V¨n Quang  Q9A2  

2  Th¹ch H¶i V©n  Q9A2  

3  Bïi ThÞ Ninh  Q9A3  

4  Lª Quang T¸m  Q9A3  

5  NguyÔn ThÞ Hµ  Q9A4  

 

B¶ng nµy cã thÓ ®−îc so¹n trªn Word, trªn Excel hoÆc mét b¶ng trªn 
Access, Foxpro.  

5.3 So¹n mÉu tµi liÖu trén  

So¹n th¶o mét mÉu giÊy mêi nh− sau:  
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5.4 KÝch ho¹t tÝnh n¨ng Mail merge  

KÝch ho¹t tÝnh n¨ng trén tµi liÖu cña Word b»ng c¸ch më môc chän 
Tools | Mail Merge.. , Hép tho¹i Mail Merge Helper xuÊt hiÖn:  

   

ë môc   bÊm chuét nót Creat vµ chän môc Mailing 

Label, hép tho¹i sau ®©y xuÊt hiÖn:  
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H·y chän Active Window ®Ó tiÕp tôc:  

ë môc  , nhÊn chuét nót Get Data vµ chän môc Open 

Data Source.., hép tho¹i Open Data Source xuÊt hiÖn, b¹n h·y chän tÖp 

chøa danh s¸ch kh¸c mêi ®· t¹o råi nhÊn Open.  

Sau khi më ®−îc tÖp chøa danh s¸ch kh¸ch mêi, cã thÓ nhÊn Close ®Ó 

®ãng hép tho¹i Mail Merge Helper vµ sö dông thanh c«ng cô Mail 

merger ®Ó chÌn c¸c tr−êng tin cÇn thiÕt lªn tµi liÖu:  

   

NÕu kh«ng thÊy thanh c«ng cô Mail Merge xuÊt hiÖn trªn mµn h×nh, cã 

thÓ hiÓn thÞ nã b»ng c¸ch chän thùc ®¬n View | Toolbars | Mail Merge.  

5.5 ChÌn c¸c tr−êng tin lªn tµi liÖu  

§Ó chÌn mét tr−êng tin lªn giÊy mêi, lµm nh− sau:  

B−íc 1: §Æt ®iÓm trá vµo vÞ trÝ cÇn chÌn th«ng tin trªn tµi liÖu: ®Æt lªn 

phÇn ®Þnh chÌn tªn (nÕu muèn chÌn tr−êng Hä tªn) hoÆc ®Æt ®iÓm trá lªn 

môc líp (nÕu muèn chÌn tr−êng Líp);  

B−íc 2: Trªn thanh c«ng cô Mail merge nhÊn nót Insert Merge 

Field, råi chän tr−êng tin cÇn chÌn lªn tµi liÖu.  

Sau khi chÌn ®Çy ®ñ c¸c tr−êng tin vµo nh÷ng vÞ trÝ hîp lý cña chóng 

trªn tµi liÖu, b¹n cã thÓ chuyÓn sang b−íc tiÕp theo ®Ó tiÕn hµnh trén ra 
c¸c GiÊy mêi.  

5.6 Thùc hiÖn trén tµi liÖu  

NhÊn nót   trªn thanh c«ng cô Mail merge, hép tho¹i tuú chän 

trén th− Merge xuÊt hiÖn:  
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Cã thÓ thiÕt lËp th«ng sè cho hép tho¹i nµy nh− sau:  

 - Môc Merge to: cho biÕt nh÷ng giÊy mêi ®−îc t¹o ra sÏ ®Æt ë ®©u: 

New document- ë mét tÖp word míi; hoÆc Printer ‟ sÏ ®−îc in 

ngay ra m¸y in;  

 - Môc Records to be merged: cho biÕt ph¹m vi c¸c b¶n ghi sÏ 

®−îc trén ra: All- sÏ thùc hiÖn trén tÊt c¶ c¸c b¶n ghi hoÆc From: 

‟ h·y chØ ra trén tõ b¶n ghi nµo ®Õn To: b¶n ghi nµo?  

 - Cuèi cïng nhÊn nót Merge ®Ó thùc hiÖn trén ra c¸c GiÊy mêi nh− 

®· thiÕt lËp.  

 

5.7 Thanh c«ng cô Mail merge  

Thanh c«ng cô Mail Merge cung cÊp c¸c nót chøc n¨ng gióp b¹n 

lµm viÑc nhanh chãng vµ thuËn tiªn trong qu¸ tr×nh trén tµi liÖu trªn 
word.  

   

 
:  

§Ó chÌn mét tr−êng tin (cét) tõ danh s¸ch lªn tµi 
liÖu trén;  

 :  
§Ó chuyÓn ®Õn vÞ trÝ c¸c tµi liÖu sau khi ®· trén 

®−îc;  

 :  
§Ó hiÓn thÞ hép tho¹i Mail Merge Helper tiÕp tôc 
nh÷ng thiÕt lËp ë môc 5.4;  
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 :  
§Ó kiÓm tra xem cã mét lçi nµo trong qu¸ tr×nh 
thiÕt lËp c¸c th«ng tin trén tµi liÖu hay kh«ng?  

 :  
Thùc hiÖn trén tµi liÖu vµ ®−a c¸c kÕt qu¶ ra mét 
tÖp Word míi;  

 :  
Thùc hiÖn trén tµi liÖu vµ in lu«n kÕt qu¶ ra m¸y 
in;  

 :  
Më hép tho¹i thiÕt lËp c¸c th«ng tin tr−íc khi trén 

th− Merge. 

 

Ch−¬ng 6: 

Mét sè øng dông kh¸c cña word  

  

6.1 TÝnh n¨ng ®Õm tõ  

 TÝnh n¨ng ®Õm tõ cho phÐp b¹n thèng kª ®−îc c¸c th«ng tin vÒ ký tù, tõ, 
®o¹n, trang trªn mét tÖp tµi liÖu. Nã rÊt cÇn thiÕt khi b¹n lµ nhµ b¸o, viÕt 
s¸ch hoÆc lµm nh÷ng viÖc cã liªn quan.  

 Më môc chän Tools | Word Count ®Ó gäi tÝnh n¨ng nµy. Hép tho¹i 

Word Count xuÊt hiÖn:  
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NÕu chän môc   , sÏ thùc hiÖn ®Õm c¶ c¸c tõ vµ 
®o¹n trªn nh÷ng phÇn ghi chó cña tµi liÖu.  

6.2 B¶o vÖ tµi liÖu  

 ViÖc b¶o vÖ d÷ liÖu trªn Word ®−îc ph©n thµnh c¸c møc ®é. Møc ®é cao 
nhÊt lµ b¶o vÖ khi më tÖp tµi liÖu, vµ møc ®é thø hai lµ b¶o vÖ sù thay ®æi 
d÷ liÖu trªn tÖp tµi liÖu. Sö dông møc ®é nµo lµ do b¹n quyÕt ®Þnh, tuú 
thuéc vµo môc ®Ých cña b¹n.  

 Nguyªn t¾c b¶o vÖ cho mçi møc lµ: b¹n g¸n mét mËt khÈu (Password). 

Khi ®ã, chØ khi nµo ng−êi dïng nhËp ®óng mËt khÈu ®· g¸n míi cã thÓ 

lµm ®−îc viÖc mµ b¹n ®· b¶o vÖ.  

6.2.1 B¶o vÖ khi më tÖp tµi liÖu  

  B−íc 1: Më tµi liÖu cÇn b¶o vÖ trªn word;  

 B−íc 2: Më môc chän: Tools | Options.., hép tho¹i Options xuÊt 

hiÖn:  

 
Tæng sè trang 
 
Tæng sè tõ 
 
Tæng sè ký tù (kh«ng tÝnh dÊu c¸ch) 
 
Tæng sè ký tù (kÓ c¶ dÊu c¸ch) 
 
Tæng sè ®o¹n 
 
Tæng sè dßng 
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Trªn thÎ Save, b¹n h·y gâ vµo mËt khÈu b¶o vÖ tÖp khi më ë môc 

Password to Open:, gâ xong nhÊn OK. Hép tho¹i Confirm Password 

xuÊt hiÖn, yªu cÇu b¹n nhËp l¹i mËt khÈu võa gâ:  

   

H·y gâ l¹i mËt khÈu võa gâ tr−íc ®ã vµo môc Reenter password to 

open: Gâ xong nhÊn OK ®Ó hoµn tÊt.  

NÕu b¹n gâ ®óng, hép tho¹i sÏ ®ãng l¹i, viÖc thiÕt lËp mËt khÈu khi 
më v¨n b¶n ®· thµnh c«ng. NÕu b¹n gâ sai, th«ng b¸o sau ®©y xuÊt 
hiÖn:  

   

TiÕp theo b¹n ph¶i nhËp l¹i mËt khÈu ®· gâ tr−íc ®ã.  

 Sau khi ®· thiÕt lËp mËt khÈu b¶o vÖ tµi liÖu khi më tÖp nµy thµnh 
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c«ng, nÕu ng−êi dïng më tÖp tµi liÖu nµy ra ®Ó lµm viÖc, hép tho¹i sau 
®©y xuÊt hiÖn yªu cÇu nhËp vµo mËt khÈu b¶o vÖ:  

   

Ng−êi dïng ph¶i nhËp ®óng mËt khÈu mµ b¹n ®· thiÕt lËp lªn hép 

tho¹i nµy míi cã thÓ më ®−îc tÖp tµi liÖu.  

6.2.2 B¶o vÖ khi söa néi dung tµi liÖu  

  B−íc 1: Më tµi liÖu cÇn b¶o vÒ trªn word;  

 B−íc 2: Më hép tho¹i Options;  

   

Trªn thÎ Save, b¹n h·y gâ vµo mËt khÈu b¶o vÖ khi söa ®æi néi dung 

v¨n b¶n ë môc Password to modify:, gâ xong nhÊn OK. Hép tho¹i 

Confirm Password xuÊt hiÖn, yªu cÇu b¹n nhËp l¹i mËt khÈu võa gâ:  
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H·y gâ l¹i mËt khÈu võa gâ tr−íc ®ã vµo môc Reenter password to 

modify: Gâ xong nhÊn OK ®Ó hoµn tÊt.  

NÕu b¹n gâ ®óng, hép tho¹i sÏ ®ãng l¹i, viÖc thiÕt lËp mËt khÈu 
thµnh c«ng. NÕu b¹n gâ sai, th«ng b¸o sau ®©y xuÊt hiÖn:  

   

 Sau khi ®· thiÕt lËp ®−îc mËt khÈu, nÕu ng−êi dïng më tÖp nµy ra ®Ó 

sö dông, mét hép tho¹i yªu cÇu hä nhËp mËt khÈu ®Ó cã thÓ söa ®−îc 
néi dung tµi liÖu:  

   

 - NÕu nhËp mËt khÈu ®óng, ng−êi dïng ®ã sÏ cã quyÒn söa néi 
dung tµi liÖu;  

 - NÕu kh«ng cã mËt khÈu, hä còng cã thÓ nhÊn nót Read Only ®Ó 

më tÖp tµi liÖu nµy d−íi d¹ng chØ ®äc- Read Only (d¹ng nµy th× 

kh«ng söa vµ cÊt ®−îc néi dung v¨n b¶n). Khi ®ã, thanh tiªu ®Ò 
word xuÊt hiÖn dßng ch÷:  
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6.3 Hép tho¹i Options  

 Khi lµm viÖc víi word (còng nh− lµm viÖc trªn bÊt kú phÇn mÒm cã qui 

m« lín nµo ®ã) b¹n th−êng ph¶i thiÕt lËp cho m×nh mét m«i tr−êng lµm 

viÖc thuËn tiÖn, phï hîp víi së thÝch vµ c«ng viÖc. Hép tho¹i Options cho 

phÐp b¹n lµm nh÷ng viÖc ®ã.  

 B¹n kÝch ho¹t môc chän Tool | Options. Hép tho¹i Options xuÊt hiÖn 

víi nhiÒu thÎ, gióp b¹n cã thÓ thiÕt lËp m«i tr−êng lµm viÖc theo c¸c 
nhãm:  

6.3.1 ThÎ View  

 §Ó thiÕt lËp c¸c th«ng tin mang tÝnh hiÓn thÞ (Viewable) trªn m«i 

tr−êng lµm viÖc:  

   

 

 C¸ch b¶o vÖ nµy kh«ng ®−îc hiÖu qu¶ l¾m khi mµ c¸c kü n¨ng xö lý  d÷ liÖu trªn tµi liÖu hiÖn nay 
lµ rÊt ®¬n gi¶n. B¹n nªn dïng c¸ch b¶o vÖ møc khi më tÖp d÷ liÖu th× hiÖu qu¶ sÏ cao h¬n.  

Cã rÊt nhiÒu c¸c thuéc tÝnh mµ b¹n cã thÓ thiÕt lËp ®−îc ë ®©y, 

nh−ng d−íi ®©y lµ mét sè thuéc tÝnh hay ®−îc sö dông nhÊt:  
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 - Status bar: ®Ó hiÓn thÞ thanh tr¹ng th¸i Status bar;  

 - ScreenTips: cho phÐp hiÓn thÞ nh÷ng mÉu giíi thiÖu (Tips) trªn 

mµn h×nh cña word;  

 - Animated text: cho phÐp hiÓn thÞ nh÷ng hiÖu øng tr×nh diÔn cña 

v¨n b¶n (®Ó thiÕt lËp nh÷ng hiÖu øng nµy, b¹n tham kh¶o môc 
1.2.1.f Hép tho¹i Font);  

 - Hozirontal scrollbar: ®Ó hiÓn thÞ thanh cuén ngang cña cöa sæ 

tµi liÖu;  

 - Vertical scrollbar: ®Ó hiÓn thÞ thanh cuén däc cña cöa sæ tµi liÖu;  

 - Drawing: cho phÐp hiÓn thÞ h×nh vÏ lªn tµi liÖu vµ in ®−îc chóng 

ra m¸y in. NÕu kh«ng chän môc nµy, b¹n kh«ng thÓ nh×n thÊy c¸c 

h×nh vÏ b»ng thanh c«ng cô Drawing còng nh− kh«ng thÓ in ®−îc 

c¸c h×nh nµy ra m¸y in;  

 - Text Boundary: hiÓn thÞ ®−êng viÒn bao cho trang v¨n b¶n còng 

nh− nh÷ng ®èi t−îng kh¸c trªn tµi liÖu. §iÒu nµy gióp b¹n ph©n 

®Þnh ®−îc râ rµng biªn giíi c¸c ®èi t−îng cã trªn tµi liÖu ®ang lµm 
viÖc;  

 

6.3.2 ThÎ General  

 §Ó thiÕt lËp mét sè th«ng tin mang tÝnh chung trªn m«i tr−êng lµm 
viÖc:  
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Chóng t«i chØ giíi thiÖu 2 thuéc tÝnh b¹n cã thÓ quan t©m nhÊt:  

 - Recently used file list: h·y nhËp vµo sè tÖp word ®−îc sö dông 

dông gÇn ®©y nhÊt lªn môc chän File cña word. §iÒu nµy rÊt 

thuËn tiÖn cho viÖc më mét tÖp v¨n b¶n mµ b¹n chóng míi ®−îc 
sö dông gÇn ®©y chØ b»ng c¸ch nhÊp chuét. NgÇm ®Þnh sè tÖp lµ 4, 
b¹n nªn thiÕt lËp con sè nµy nhiÒu h¬n;  

 - Measurement units: ®Ó thay ®æi ®¬n vÞ ®o chiÒu dµi trªn word 

cho phï hîp víi b¹n. Cã 2 kiÓu ®¬n vÞ ®o chiÒu dµi ®−îc sö dông 
ë ®©y lµ Inch vµ Centimeter.  

 

6.3.3 ThÎ Spelling & Grammar  

 §Ó thiÕt lËp nh÷ng th«ng tin vÒ kiÓm tra lçi chÝnh t¶ v¨n b¶n:  
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 - Check spelling as you type: ®Ó kÝch ho¹t tÝnh n¨ng kiÓm tra lçi 

chÝnh t¶. B¹n nªn chän môc nµy, bëi lÏ nÕu nã ®−îc chän th× 
nh÷ng tõ viÕt t¾t vµ nh÷ng thiÕt lËp kiÓm tra lçi chÝnh t¶ trªn hép 
tho¹i AutoCorrect míi cã t¸c dông;  

 - Check grammar as you type: ®Ó kÝch ho¹t tÝnh n¨ng kiÓm tra lçi 

ng÷ ph¸p (ng÷ ph¸p tiÕng Anh). B¹n chØ bËt nã khi tµi liÖu lµ v¨n 
b¶n tiÕng Anh, tr¸i l¹i b¹n nªn bá môc nµy.  

 

6.3.4 ThÎ File Locations  

 ThiÕt lËp nh÷ng th«ng tin vÒ th− môc trªn ®Üa cã liªn quan ®Õn m«i 

tr−êng lµm viÖc word:  
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H·y chän môc cÇn thiÕt lËp l¹i th− môc ë danh s¸ch File types: råi 

nhÊn nót Modify ®Ó chän l¹i th− môc lµm viÖc. VÝ dô, muèn thay ®æi 

th− môc ngÇm ®Þnh khi më vµ cÊt v¨n b¶n míi, lµm nh− sau:  

B−íc 1: Chän môc Documents trªn danh s¸ch File types;  

B−íc 2: NhÊn nót Modify, hép tho¹i sau xuÊt hiÖn cho phÐp b¹n 

chän l¹i th− môc míi.  

   

B−íc 3: Sau khi chän xong th− môc ngÇm ®Þnh ®Ó më vµ cÊt tµi liÖu, 
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nhÊn nót OK ®Ó ®ång ý sù thay ®æi nµy.  

6.4 Lµm viÖc víi Macro  

 Khi lµm viÖc víi word nhiÒu khi b¹n ph¶i lÆp l¹i mét sè c¸c thao t¸c xö 

lý trªn tµi liÖu. §iÒu nµy sÏ ®−îc ®¬n gi¶n h¬n khi b¹n ¸p dông kü thuËt 
Macro.  

 Macro cã thÓ hiÓu lµ mét lÖnh ®Ó gäi mét thñ tôc (thñ tôc lµ mét ch−¬ng 

tr×nh ®−îc lËp tr×nh trªn m¸y tÝnh cã thÓ bao gåm nhiÒu lÖnh yªu cÇu m¸y 

tÝnh lµm viÖc) nµo ®ã. LÖnh Macro cã thÓ ®−îc g¾n bëi tæ hîp phÝm t¾t 

hoÆc ®−îc g¾n vµo mét nót lÖnh trªn thanh c«ng cô mµ khi bÊm tæ hîp 
phÝm t¾t nµy hoÆc nhÊn chuét lªn nót ®· g¸n trªn thanh c«ng cô, Macro 

®ã sÏ ®−îc thùc hiÖn.  

6.4.1 T¹o Macro  

§Ó dÔ hiÓu h¬n, chóng t«i sÏ ®−a ra bµi to¸n vµ c¸ch gi¶i quyÕt nã 
sau ®©y:  

B¹n lµ mét nh©n viªn v¨n phßng, rÊt hay ph¶i so¹n th¶o c¸c b¸o c¸o, 
hîp ®ång,.. mµ cã dßng tiªu ®Ò ®Çu tiªn lµ:  

Céng hoµ x∙ héi chñ nghÜa ViÖt Nam  

§éc lËp ‘ Tù do ‘ H¹nh phóc  

--o0o--  

H·y t¹o mét Macro cã tªn CHXHCNVN vµ g¾n nã bëi mét tæ hîp 

phÝm nãng Ctrl + T ch¼ng h¹n, b¹n lµm nh− sau:  

B−íc 1: KÝch ho¹t tÝnh n¨ng t¹o míi Macro b»ng c¸ch: më môc 

chän Tools | Macro | Record new Macro.. Hép tho¹i Record Macro 

xuÊt hiÖn:  
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B−íc 2: Khai b¸o tªn vµ thiÕt lËp phÝm t¾t cho Macro nµy:  

 - ¤ Macro name: b¹n h·y gâ vµo tªn cña Macro cÇn t¹o lµ: 

CHXHCNVN;  

 - §Ó thiÕt lËp phÝm t¾t cho Macro, h·y nhÊn lªn nót Keyboard  

, hép tho¹i Customize Keyboard xuÊt hiÖn:  

 

   

Khi con trá ®ang nhÊp nh¸y ë hép Press new shortcut key: b¹n h·y 

bÊm tæ hîp phÝm nãng cÇn thiÕt lËp (ë ®©y lµ Ctrl + T), tiÕp theo nhÊn 

Asign ®Ó ®ång ý. Cuèi cïng nhÊn Close ®Ó ®ãng hép tho¹i nµy l¹i. Mét 

thanh c«ng cô míi xuÊt hiÖn nh− sau:  
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Vµ con trá trªn mµn h×nh sÏ trë thµnh:  . Khi ®ã b¹n cã thÓ ra 
c¸c lÖnh cho Macro nµy.  

B−íc 3: Ra c¸c lÖnh cho Macro: Thùc chÊt lÖnh cho Macro ®ang t¹o 

lµ: So¹n th¶o dßng ch÷  

Céng hoµ x· héi chñ nghÜa ViÖt Nam  

§éc lËp ‟ Tù do ‟ H¹nh phóc  

--o0o--  

vµ ®Þnh d¹ng dßng ch÷ ®ã ®Ó trë thµnh:  

Céng hoµ x∙ héi chñ nghÜa ViÖt Nam  

§éc lËp ‘ Tù do ‘ H¹nh phóc  

--o0o--  

B¹n h·y lµm c¸c c«ng viÖc so¹n th¶o ®Ó ®−îc kÕt qu¶ nh− vËy.  

B−íc 4: KÕt thóc viÖc t¹o Macro: Sau khi so¹n th¶o ®−îc mÉu tiªu 

®Ò nh− ý muèn, h·y kÕt thóc viÖc t¹o Macro nµy b»ng c¸ch nhÊn lªn 

nót Stop recording   trªn thanh c«ng cô Stop. B¹n ®· t¹o ®−îc 

Macro cã tªn CHXHCNVN víi phÝm nãng lµ Ctrl + T.  

6.4.2 Sö dông Macro ®· t¹o ®−îc  

  Gi¶ sö ®· t¹o ®−îc Macro CHXHCNVN. Khi muèn hiÓn thÞ tiªu ®Ò nh− 

vËy b¹n chØ cÇn gäi Macro nµy bëi phÝm nãng cña nã lµ Ctrl + T. B¹n sÏ 

thu ®−îc kÕt qu¶ nh− mong muèn.  

 

 

 

 

 

HƢỚNG DẪN SỬ DỤNG WORD 2007 

CHƢƠNG I 
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1. Làm quen với giao diện mới  

Trong Word 2007, bạn sẽ không còn thấy các menu lệnh như phiên bản 

trước mà thay vào đó  

là hệ thống “ribbon” với 3 thành phần chính: thẻ (Tab), nhóm (Group) và 

các nút lệnh  

(Command button). Các nút lệnh có liên quan đến nhau được gom vào 

một nhóm, ví dụ như các  

nút chọn font, cỡ chữ, in đậm, nghiêng, gạch chân... được gom vào nhóm 

Font. Nhiều nhóm có  

chung một tác vụ lại được gom vào trong một thẻ.  

Bạn hãy để ý, ở góc trên bên tay trái có một nút hình tròn , nó có tên là 

Microsoft Office Button. Nhấn nút này sẽ xuất hiện một bảng lệnh tương 

tự như menu File của phiên bản Word trước, bao gồm các lệnh: New, 

Open, Save, Print...  

Quick Access Toolbar là thanh công cụ nằm cạnh nút Microsoft Office 

Button, giúp truy cập nhanh đến những nút lệnh thường dùng. Bạn có thể 

nhấn chuột vào nút mũi tên ở cuối thanh và bổ sung thêm những nút lệnh 

bạn hay dùng khác vào thanh công cụ này bằng cách đánh dấu chọn vào 

nó.  

2. Sử dụng phím tắt để mở các thẻ, nút lệnh  

Ngoài phương pháp nhấn chuột, bạn có thể sử dụng phím tắt để truy cập 

đến các thẻ, nút lệnh  

một cách nhanh chóng. Rất đơn giản, hãy giữ phím Alt trong 2 giây, lập 

tức xuất hiện các chữ cái trên các thẻ, bạn nhấn tiếp chữ cái trên thẻ nào 

mình muốn mở, thẻ đó sẽ được kích hoạt. Bây giờ trên các nút lệnh lại 

xuất hiện một loạt chữ cái để bạn kích hoạt nó với cách tương tự.  
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3. Tạo một tài liệu mới  

Tương tự như Word 2003, phím tắt để tạo một tài liệu mới trong Word 

2007 là Ctrl+N. Cách  

khác: Nhấn chuột vào Microsoft Office Button , chọn New, nhấn đúp 

chuột vô mục Blank  

document.  

Tạo một tài liệu mới từ mẫu có sẵn: Nhấn Microsoft Office Button , 

chọn New. Nhấn Installed Templates, sau đó chọn một mẫu đã cài vào 

máy hay chọn một mẫu từ Microsoft Office Online (yêu cầu có kết nối 

Internet để tải về). Nhấn nút Create để tạo một tài liệu mới từ mẫu đã 

chọn 
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Höôùng daãn söû duïng Word 2007  

Baèng Laêng 2  

4. Mở tài liệu có sẵn trên máy  

Tương tự như Word 2003, phím tắt mở tài liệu có sẵn là Ctrl+O. Bạn 

cũng có thể vào  

Microsoft Office Button , chọn Open 
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5. Lƣu tài liệu  

Phím tắt để lưu tài liệu là Ctrl+S (giống Word 2003). Cách khác: Nhấn 

Microsoft Office  

Button , chọn Save.  

Nếu file tài liệu này trước đó chưa được lưu lần nào, bạn sẽ được yêu cầu 

đặt tên file và chọn  

nơi lưu.  

Để lưu tài liệu với tên khác (hay định dạng khác), bạn nhấn Microsoft 

Office Button , chọn  

Save As (phím tắt F12, tương tự như Word 2003).  

6. Mặc định lƣu tài liệu dạng Word 2003 trở về trƣớc  

Mặc định, tài liệu của Word 2007 được lưu với định dạng là *.DOCX, 

khác với *.DOC mà bạn đã quen thuộc. Với định dạng này, bạn sẽ không 

thể nào mở được trên Word 2003 trở về trước nếu không cài thêm bộ 

chuyển đổi. Để tương thích khi mở trên Word 2003 mà không cài 
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Höôùng daãn söû duïng Word 2007  

Baèng Laêng 3  

thêm chương trình, Word 2007 cho phép bạn lưu lại với định dạng Word 

2003 (trong danh sách  

Save as type của hộp thoại Save As, bạn chọn Word 97-2003 Document).  

Muốn Word 2007 mặc định lưu với định dạng của Word 2003, bạn 

nhấn Microsoft Office Button , chọn Word Options để mở hộp thoại 

Word Options. Trong khung bên trái, chọn Save. Tại mục Save files in 

this format, bạn chọn Word 97-2003 Document (*.doc). Nhấn OK 

Trong Word 2003 cũng có tính năng mặc định lưu theo một định dạng 

nào đó (dĩ nhiên không có định dạng của Word 2007). Để truy cập tính 

năng tương ứng trên Word 2003, bạn vào menu Tools > Options > thẻ 

Save > chọn định dạng trong mục Save Word files as > OK.  

7. Giảm thiểu khả năng mất dữ liệu khi chƣơng trình bị đóng bất ngờ  

Để đề phòng trường hợp treo máy, cúp điện làm mất dữ liệu, bạn nên 
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bật tính năng sao lưu tự động theo chu kỳ. Cũng trong hộp thoại Word 

Options, chọn mục Save ở bên trái, đánh dấu check vào Save 

AutoRecover information every, sau đó nhập số phút tự động lưu vào ô 

bên cạnh. Nhấn OK.  

8. Lƣu tài liệu với định dạng PDF/XPS  

Một tính năng mới có trong Word 2007 là khả năng lưu tài liệu với 

dạng file *.PDF và *.XPS. Có lẽ bạn đã khá quen thuộc với định dạng 

PDF. Còn XPS? Tương tự PDF, XPS (XML Paper Specification) là loại 

file điện tử có bố cục cố định, đảm bảo khi file được xem trên mạng hay 

đem in nó vẫn giữ lại chính xác các phần định dạng bạn cần, dữ liệu trong 

file không dễ thay đổi.  

Để lưu hoặc xuất sang định dạng PDF/XPS, trước hết bạn cần cài đặt 

thêm phần hỗ trợ  

Microsoft Save as PDF or XPS cho hệ thống Office 2007: truy cập vào  

http://r.office.microsoft.com/r/rlidMSAddinPDFXPSha y 

http://tinyurl.com/y32j78 và làm theo hướng dẫn  

trong đó để cài đặt.  

Cài xong bạn có thể lưu tài liệu lại với dạng PDF/XPS bằng cách nhấn 

Microsoft Office  

Button , chọn Save As, chọn PDF or XPS 
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9. Phóng lớn / thu nhỏ tài liệu  

Có lẽ bạn đã khá quen thuộc với hộp Zoom trên thanh công cụ 

Standard của Word 2003, nó giúp phóng to hay thu nhỏ tài liệu với nhiều 

tùy chọn. Còn trên Word 2007, công cụ này nằm ở đâu? Bạn hãy đưa mắt 
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xuống góc dưới bên phải cửa sổ, trên thanh trạng thái sẽ thấy thanh trượt 

Zoom . Bạn chỉ việc kéo thanh trượt qua phải để phóng lớn hay qua trái 

để thu nhỏ tài liệu.  

10. Xác lập chế độ phóng lớn / thu nhỏ đặc biệt  

Trong thẻ View, nhóm Zoom, nhấn 100% để đưa tài liệu về đúng kích cỡ 

của nó. Cũng trong  

nhóm Zoom, nút One Page cho phép bạn hiển thị vừa đúng 1 trang trên 

màn hình, nút Two Pages  

hiển thị đúng 2 trang, còn Page Width là chế độ Zoom mà chiều rộng 

trang vừa với chiều rộng màn hình. Nhấn nútZoom sẽ cho nhiều tùy chọn 

hơn nữa.  

11. Xem tài liệu ở chế độ Full Screen Reading  

Ở Word 2003, bạn có thể xem tài liệu giống như xem sách (2 trang đối 

diện nhau, và chiều rộng màn hình được tận dụng tối đa để có thể đọc và 

ghi chú vào tài liệu một cách dễ dàng). Cách thực hiện: vào menu View – 

Reading Layout.  

Đối với Word 2007, công cụ này nằm ở thẻ View, nhóm Document 

Views, mục Full Screen Reading. Khi ở chế độ Full Screen Reading, 

nhấn phím mũi tên ở góc dưới của trang để di chuyển qua lại giữa các 

trang. Nhấn ESC để trở về chế độ Print Layout. Cũng trong nhóm 

Document Views bạn có thể chọn nhiều chế độ hiển thị khác như Web 

Layout, Outline, Draft 

 

12.Thanh thƣớc kẻ (Ruler)  

Thước kẻ dọc và ngang rất tiện lợi cho bạn canh chỉnh, thế nhưng trong 

phiên bản Word 2007 này hình như Microsoft đã  

loại bỏ nó rồi? Không phải vậy, cũng như Word 2003 cho phép bạn tùy ý 

bật tắt thanh Ruler  

(menu View– Ruler), trong phiên bản 2007, chức năng này đã được đưa 

vào thẻ View, nhóm  

Show/Hide. Bạn chỉ việc đánh dấu check vào mục Ruler để cho nó hiện 

lên lại.  

Một cách khác để cho thước kẻ hiện ra là nhấn chuột vào nút View Ruler 

ở phía trên thanh  
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cuộn dọc.  

Nếu thực hiện cách này mà bạn chỉ thấy có mỗi thước kẻ ngang xuất 

hiện, không thấy thước kẻ dọc đâu cả, hãy làm thêm bước sau để bật 

thước kẻ dọc lên: Nhấn Microsoft Office Button , nhấn tiếp Word 

Options. Trong hộp thoại xuất hiện, ở khung bên trái chọn Advanced. 

Kéo thanh trượt ở khung bên phải xuống dưới nhóm Display, đánh dấu 

chọn hộp kiểm Show vertical ruler in Print Layout view. Nhấn OK  

Lưu ý: Bạn phải xem tài liệu ở chế độ Print Layout thì mới hiện đủ được 

các thanh thước kẻ.  

13. Duyệt tài liệu ở chế độ hình thu nhỏ (Thumbnails)  

Chế độ này rất hữu ích nếu trong tài liệu của bạn có quá nhiều trang vì nó 

cho bạn một cái  

nhìn tổng thể về các trang, và bạn có thể nhảy nhanh đến một trang bất 

kỳ.  

Trong thẻ View, nhóm Show/Hide, bạn đánh dấu check vào hộp kiểm 

Thumbnails. Lập tức bên trái cửa sổ xuất hiện một khung chứa hình thu 

nhỏ của các trang trong tài liệu, kèm theo số trang ở bên dưới. Bạn nhấn 

chuột vào một trang để nhảy đến trang đó.  
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14. Thay đổi xác lập lề trang 

Trong Word 2003, để thay đổi những xác lập trang, bạn vào menu File – 

Page Setup. Còn 

trong Word 2007 thì sao? Các xác lập trang giấy nằm trong thẻ Page 

Layout, nhóm Page Setup. 

-Để thay đổi lề trang, nhấn nút Margins, một menu xổ xuống cho bạn 

chọn những kiểu lề 

trang mình thích (mỗi kiểu lề đều có ghi chú thông số bên cạnh, ví dụ 

kiểu Normal thì lề trên, 

dưới, trái, phải đều cách mép giấy 1 inch...) 
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- Nếu như các thông số lề trang bạn muốn xác lập không có sẵn trong 

danh sách, hãy nhấn  

Custom Margins ở cuối menu, sau đó tự mình nhập vào thông số mới.  

15. Hiển thị các lề trang  

Nhấn Microsoft Office Button, nhấn tiếp Word Options. Trong hộp 

thoại xuất hiện, ở khung bên trái nhấn Advanced, khung bên phải kéo 

thanh trượt xuống nhóm Show document content và đánh dấu check vào 

hộp kiểm Show text boundaries. Nhấn OK.  

16. Các lề trang sẽ xuất hiện trong tài liệu dƣới dạng đƣờng đứt nét  

Trong Word 2003, bạn có thể thực hiện chức năng tương ứng bằng cách 

vào menu Tools –  
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Options > thẻ View > đánh dấu check mục Text boundaries trong nhóm 

Print and Web Layout  

options > OK.  

17. Chọn hƣớng giấy cho toàn bộ tài liệu  

Trong thẻ Page Layout, nhóm Page Setup, nhấn nút Orientation và chọn 

một trong hai kiểu là  

Portrait (trang dọc) hoặc Landscape (trang ngang).  

18. Xác lập trang dọc và trang ngang trong cùng một tài liệu  

- Dùng chuột quét chọn các đoạn văn bản mà bạn muốn thay đổi sang 

hướng dọc hoặc ngang.  

-  Trong thẻ Page Layout, nhóm Page Setup, nhấn nút Margins.  

- Nhấn Custom Margins, chọn tiếp Portrait (trang dọc) hoặc Landscape 

(trang ngang) trong  

mục Orientation.  

- Trong mục Apply to, chọn Selected text. Nhấn OK.  

19. Thay đổi cỡ giấy  

Nếu muốn thay đổi kích cỡ trang giấy, trong thẻ Page Layout, nhóm Page 

Setup, bạn nhấn nút  

Size. Menu xổ xuống cho bạn chọn một trong các cỡ giấy có sẵn như: 

Letter, A4, A5, A6,  

Postcard...  

Muốn xác lập một cỡ giấy đặc biệt không có trong danh sách, bạn chọn 

More Paper Sizes ở  

cuối menu và nhập vào chiều rộng (Width), chiều cao (Height) mình 

thích.  

20. Khắc phục hiện tƣợng: Lề trên bị biến mất  

Khi bạn xem tài liệu ở chế độ Print Layout, điểm chèn nằm ở sát góc trên 

bên trái trang, giống  

như là không có lề trên vậy. Cách khắc phục:  

1. Khi lề trên hoặc lề dưới không hiển thị, bạn đưa con trỏ chuột đến lề 

trên hoặc lề dưới của  

trang cho đến khi con trỏ biến thành mũi tên hai đầu rồi nhấn đúp chuột 

vào.  
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2. Lề trên và lề dưới giờ đây đã được hiển thị.  

Một cách khác để khắc phục hiện tượng bị mất lề trên:  

-  Trong thẻ View, nhóm Document Views, đảm bảo rằng nút Print 

Layout đang được chọn.  

-  Nhấn Microsoft Office Button , nhấn tiếp Word Options.  

- Trong khung bên trái, chọn Display.  

- Ở khung bên phải, dưới nhóm Page display options, đánh dấu chọn mục 

Show white space  

between pages in Print Layout view. Nhấn OK.  

Khác với Word 2007 phải nhấn đúp chuột, trong Word 2003 để hiển thị 

lại lề trên, bạn đưa  

con trỏ chuột đến lề trên hoặc lề dưới của trang cho đến khi con trỏ biến 

thành mũi tên hai đầu  

rồi nhấn một lần chuột trái vào 

21. Chèn Header, Footer cho toàn bộ tài liệu  

Trong Word 2003, để chèn Header hay Footer vào tài liệu, chúng ta vào 

menu View –Heade r  

and Footer. Còn trong Word 2007, tại thẻ Insert, nhóm Header & Footer, 

bạn nhấn chuột vào nút  

Header hay Footer.  

Một menu xổ xuống với các Header, Footer mẫu cho bạn chọn. Kế đến 

bạn nhập nội dung cho Header hay Footer đó. Nhập xong nhấn đúp chuột 

vào vùng nội dung của trang, lập tức Header / Footer sẽ được áp dụng 

cho toàn bộ trang của tài liệu.  
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2. Thay đổi Header / Footer cũ bằng Header / Footer mới 

Tại thẻ Insert, nhóm Header & Footer, bạn nhấn chuột vào nút Header 

hay Footer. Sau đó 

chọn lại một Header / Footer mới để thay cho Header / Footer hiện tại. 

23. Không sử dụng Header / Footer cho trang đầu tiên 

 

Tại thẻ Page Layout, bạn nhấn chuột vào nút góc dưới phải của nhóm 

Page Setup để mở hộp thoại Page Setup. Kế đến mở thẻ Layout ra. Đánh 

dấu kiểm mục Different first page bên dưới mục Headers and footers. 

Nhấn OK. 

Vậy là Header / Footer đã được loại bỏ khỏi trang đầu tiên của tài liệu 

Trong Word 2003, bạn cũng có thể loại bỏ Header / Footer cho trang đầu 

tiên bằng cách vào  

menu File – Page Setup > chọn thẻ Layout > đánh dấu check Different 

first page > OK.  

24. Áp dụng Header / Footer khác nhau cho trang chẵn và trang lẻ  

Tại thẻ Page Layout, bạn nhấn chuột vào nút góc dưới phải của nhóm 

Page Setup để mở hộp thoại Page Setup. Kế đến mở thẻ Layout ra. Đánh 

dấu kiểm mục Different odd and even bên dưới mục Headers and footers. 

Nhấn OK.  
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Bây giờ bạn có thể chèn Header / Footer cho các trang chẵn trên một 

trang chẵn bất kỳ, chèn  

Header / Footer cho các trang lẻ trên một trang lẻ bất kỳ.  

Trong Word 2003, bạn cũng có thể thực hiện tương tự bằng cách vào 

menu File – Page Setup  

> chọn thẻ Layout > đánh dấu check Different odd and even > OK.  

25. Thay đổi nội dung của Header / Footer  

Tại thẻ Insert, nhóm Header & Footer, bạn nhấn chuột vào nút Header 

hay Footer. Kế đến chọn Edit Header / Edit Footer trong menu xổ xuống 

để chỉnh sửa nội dung của Header / Footer. Trong khi chỉnh sửa bạn có 

thể định dạng lại font chữ, kiểu chữ, màu sắc... cho tiêu đề Header / 

Footer bằng cách chọn chữ và sử dụng thanh công cụ Mini xuất hiện bên 

cạnh.  

Chỉnh sửa xong bạn nhấn đúp chuột ra ngoài vùng nội dung của trang tài 

liệu.  

26. Xóa Header / Footer  

Tại thẻ Insert, nhóm Header & Footer, bạn nhấn chuột vào nút Header 

hay Footer. Kế đến  

chọn Remove Header / Remove Footer trong danh sách xổ xuống.  

27. Tạo Header / Footer khác nhau cho các vùng khác nhau của tài liệu  

Trước tiên, bạn cần tạo các ngắt vùng để phân chia các vùng trong tài 

liệu. Nhấn chuột vào 

 

vị trí muốn đặt một vùng mới. Trong thẻ Page Layout, nhóm Page Setup, 

nhấn nút Breaks và chọn một kiểu ngắt vùng phù hợp trong Section 

Breaks, ví dụ Continuous (chúng ta sẽ tìm hiểu kỹ hơn về ngắt trang / 

ngắt vùng ở những bài viết sau). 

-Tại thẻ Insert, nhóm Header & Footer, bạn nhấn chuột vào nút Header 

hay Footer. Kế đến 

chọn Edit Header / Edit Footer để chỉnh sửa nội dung cho Header / 

Footer. 

-Trên thẻ Header & Footer, nhóm Navigation, nếu thấy nút Link to 

Previous đang sáng thì 
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nhấn vào nút này một lần nữa để ngắt kết nối giữa Header / Footer trong 

vùng mới này với vùng 

trước đó. Bạn sẽ thấy mục Same as Previous ở góc trên bên phải của 

Header / Footer biến mất. 

-Sau đó bạn chỉnh sửa Header / Footer cho vùng mới này và yên tâm rằng 

những Header / 

Footer của các vùng trước đó không bị thay đổi theo. 

28. Thay đổi giao diện cho Office 

 

Theo những ảnh trên bạn có thấy là màu xanh truyền thống của Microsoft 

Word đã bị thay đổi? Office 2007 có tính năng thay đổi giao diện hiển thị 

(cho tất cả các chương trình nằm trong bộ Office 2007) và có 3 màu để 

bạn có thể lựa chọn: Màu xanh (Blue), màu đen (Black), màu bạc 

(Silver). Bạn có thể thay đổi bằng cách nhấn Microsoft Office Button, 

nhấn tiếp Word Options. Trong hộp thoại xuất hiện, ở khung bên trái 

nhấn Popular, tại phần Color Scherme chọn màu mà bạn muốn (Chú ý: 

thay đổi sẽ được áp dụng khi khởi động lại chương trình Office đang mở) 

 

CHƢƠNGII  

Chương trước chúng ta đã được làm quen với cách chèn Header và 
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Footer trong tài liệu Word 2007. Bạn có thể chèn vào đây bất cứ nội dung 

gì mình thích, trong đó có thể bao gồm cả số trang của văn bản. Tuy 

nhiên bạn sẽ không cần phải gõ từng số trang vào một cách thủ công mà 

Word sẽ hỗ trợ bạn.  

1. Chèn số trang vào văn bản  

Số trang này sẽ được đưa vào Header hay Footer tùy ý bạn. Để thực 

hiện, bạn chọn thẻ Insert, tại nhóm Header & Footer, bạn nhấn nút Page 

Number. Trong menu xuất hiện, bạn trỏ tới Top of Page (chèn số trang 

vào phần Header) hoặc Bottom of Page (chèn vào Footer). Word 2007 

cung cấp sẵn khá nhiều mẫu đánh số trang và bạn chỉ việc chọn một trong 

các mẫu này là xong.  
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a. Thay đổi dạng số trang 

 

Bạn có thể thay đổi dạng số trang theo ý thích của mình mà định dạng 

chuẩn không có sẵn. Để thực hiện, bạn nhấn đúp vào Header hay Footer, 

nơi bạn đã đặt số trang. Tại thẻ Design, nhóm Header & Footer, bạn nhấn 

nút Page Number, chọn tiếp Format Page Numbers. 

Trong hộp thoại Page Number, tại mục Number format, bạn hãy chọn 

một kiểu đánh số mình 

thích, sau đó nhấn OK. 
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b. Thay đổi kiểu chữ, cỡ chữ, màu sắc của số trang 

Nhấn đúp chuột vào Header hay Footer, nơi bạn đã đặt số trang tại đó 

Dùng chuột chọn số trang. Tại thanh công cụ mini vừa xuất hiện ở bên 

trên, bạn có thể chọn lại font chữ, cỡ chữ, định dạng lại chữ đậm, 

nghiêng, hay chọn màu tùy thích. Khi hiệu chỉnh xong bạn nhấn đúp 

chuột vào vùng nội dung chính của tài liệu. 

c. Bắt đầu đánh số trang bằng một số khác 

 

Bạn có thể bắt đầu đánh số trang bằng một con số khác, thay vì 1 như 

mặc định. Cách thực hiện: Tại thẻ Insert, nhóm Header & Footer, bạn 

nhấn nút Page Number, chọn Format Page Numbers. Trong hộp thoại 

xuất hiện, bạn chọn Start at và nhập vào con số bắt đầu khi đánh số trang. 

Nhấn OK. 

Ghi chú: Nếu tài liệu của bạn có trang bìa và bạn muốn trang đầu tiên sau 

đó được bắt đầu 

bằng 1, tại ô Start at, bạn hãy gõ vào 0. 

d. Xóa số trang đã đánh 

Tại thẻ Insert, nhóm Header & Footer, bạn nhấn nút Page Number, sau đó 

chọn Remove Page 

Numbers ở cuối menu. 

e. Xóa số trang ở trang đầu tiên của tài liệu 

 

Trong tài liệu, thường trang đầu tiên không được đánh số vì nó là trang 

bìa. Áp dụng phần ghi chú ở thủ thuật “Bắt đầu đánh số trang bằng một 

số khác” bên trên, trang bìa vẫn được đánh số là 0. Vì vậy bạn hãy thực 

hiện thêm bước sau để xóa hẳn số trang ở trang đầu tiên của tài liệu. 

- Nhấn chuột vào bất kỳ vùng nào của tài liệu 

- Tại thẻ Page Layout, bạn nhấn chuột vào ô vuông góc dưới bên phải của 

nhóm Page Setup 

để mở hộp thoại Page Setup ra. 
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-Nhấn chuột vào thẻ Layout trong hộp thoại, bên dưới Headers and 

footers, bạn đánh dấu 

chọn vào hộp kiểm Different first page. Nhấn OK. 

Bây giờ bạn hãy kiểm tra lại xem, có đúng là trang đầu tiên không có số 

trang, sau đó trang kế 

được đánh số 1 không nhé. 

2. Ngắt trang 

Trong Word 2003, người dùng thường vào menu Insert – Break để chèn 

vào tài liệu các ngắt 

trang, ngắt vùng. Còn trong Word 2007 bạn hãy thực hiện như sau. 

a. Chèn một ngắt trang đơn thuần 

Trước tiên bạn để con trỏ vào vị trí muốn bắt đầu trang mới. Trong thẻ 

Insert, nhómP a ges, 

bạn nhấn vào nút Page Break. 

Lập tức, phần nội dung phía sau con trỏ sẽ được đưa vào một trang mới. 

b. Tránh ngắt trang giữa một đoạn 

- Chọn một đoạn mà bạn muốn tránh ngắt thành 2 trang. 

-Trong thẻ Page Layout, nhấn vào nút ô vuông ở góc dưới phải của nhóm 

Paragraph để mở 

hộp thoại Paragraph 
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Trong hộp thoại này, bạn chọn thẻ Line and Page Breaks, kế đến đánh 

dấu chọn vào hộp 

kiểm Keep lines together. Nhấn OK là xong. 

c. Tránh ngắt trang giữa các đoạn 

-Chọn các đoạn mà bạn muốn giữ trên 1 trang đơn. 

- Tại thẻ Page Layout, nhấn vào nút ô vuông ở góc dưới phải của nhóm 

Paragraph để mở hộp 

thoại Paragraph. 

- Trong hộp thoại này, bạn chọn thẻ Line and Page Breaks, kế đến đánh 

dấu chọn vào hộp 

kiểm Keep with next. Nhấn OK là xong. 

d. Tạo ngắt trang trước một đoạn 

-Nhấn chuột vào đoạn mà bạn muốn tạo ngắt trang trước nó. 

- Tại thẻ Page Layout, nhấn vào nút ô vuông ở góc dưới phải của nhóm 

Paragraph để mở hộp 

thoại Paragraph. 

- Trong hộp thoại này, bạn chọn thẻ Line and Page Breaks, kế đến đánh 

dấu chọn vào hộp 

kiểm Page break before. Nhấn OK 
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Tránh ngắt trang trong một hàng của bảng 

-Nhấn chuột vào hàng của bảng mà bạn không muốn ngắt, hoặc chọn 

toàn bộ bảng nếu bạn 

không muốn bảng bị ngắt. 

- Trên thanh công cụ, nhấn vào thẻ Layout. 

- Tại nhóm Table, nhấn nút Properties. 

- Trong hộp thoại Table Properties, mở thẻ Row, bỏ dấu kiểm Allow row 

to break across 

pages. Nhấn OK. 

3. Ngắt vùng 

a. Các loại ngắt vùng có thể chèn 

- Lệnh Next Page chèn ngắt vùng vào và bắt đầu vùng mới trên trang mới 

kế tiếp. Loại này 

thích hợp để bắt đầu một chương trong tài liệu. 

- Lệnh Continuous chèn ngắt vùng và bắt đầu vùng mới trên cùng một 

trang. Loại này hữu 

dụng cho việc thay đổi định dạng, chẳng hạn trình bày số cột khác nhau 

trên cùng một trang. 
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- Lệnh Even Page hoặc Odd Page chèn một ngắt vùng và bắt đầu vùng 

mới trên trang chẵn 

hoặc lẻ kế tiếp. Nếu bạn muốn các chương trong tài liệu luôn bắt đầu ở 

trang chẵn hoặc trang lẻ, 

hãy dùng tùy chọn Even Page hoặc Odd Page. 

b. Thay đổi bố cục hoặc định dạng tài liệu 

Nhấn chuột vào nơi muốn thay đổi định dạng.  

-  Trong thẻ Page Layout, nhóm Page Setup, bạn nhấn nút Breaks.  

- Trong phần Section Breaks, bạn hãy chọn một kiểu ngắt vùng phù hợp. 

Chẳng hạn, nếu bạn  

chia tài liệu thành các chương và mỗi chương bạn muốn bắt đầu ở trang 

lẻ, hãy chọn Odd Page 
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c. Xóa các thay đổi của bố cục tài liệu 

Ngắt vùng dùng để chỉ ra nơi thay đổi định dạng trong tài liệu. Khi xóa 

ngắt vùng đi thì phần 

văn bản ở vùng trước và sau sẽ được áp dụng chung định dạng. 

- Trong thẻ View, nhóm Document Views, chọn nút Draft để có thể nhìn 

thấy các đường đứt 

đôi của vùng ngắt. 

-Dùng chuột chọn ngắt vùng mà bạn muốn xóa. Nhấn Delete. 

4. Thêm trang, xóa trang 

-Nhấn chuột vào bất cứ nơi nào mà bạn muốn chèn vào thêm một trang 



 

 

GIÁO TRÌNH WORD 2003-2007-2010 Page 132 

 

BÙI QUYẾT TIẾN 2011 

mới. 

- Trong thẻ Insert, nhóm Pages, nhấn nút Blank Page. 

Trang mới sẽ được chèn vào vị trí sau con trỏ chuột đang đứng. 

a. Thêm một trang bìa 

Word 2007 cung cấp sẵn cho bạn một bộ sưu tập các trang bìa khá đẹp 

mắt. Các trang bìa 

luôn được chèn vào đầu tài liệu, không phụ thuộc vào vị trí hiện tại của 

con trỏ trong tài liệu. 

- Trong thẻ Insert, nhóm Pages, bạn nhấn nút Cover Page. 

-Trong menu xuất hiện, bạn hãy nhấn chọn một kiểu trang bìa mình thích. 

Trang bìa đó sẽ 

được áp dụng vào tài liệu và bạn có thể sửa đổi nội dung các dòng chữ 

mặc định bằng dòng chữ 

mình thích 
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b. Xóa trang bìa 

Để xóa trang bìa, bạn nhấn chuột vào thẻ Insert, nhấn nút Cover Page 

trong nhóm Pages, sau 

đó nhấn Remove Current Cover Page. 

c. Xóa một trang trống 

 

Bạn có thể xóa một trang trống trong tài liệu bằng cách xóa đi các ngắt 

trang. Hãy đảm bảo rằng bạn đang xem tài liệu ở chế độ Draft (trong thẻ 

View, nhóm Document Views, nhấn nút Draft). Chọn 2 dấu ngắt ---Page 

Break--- liên tiếp nhau và xóa nó đi. 

Lưu ý: Nếu trang trống nằm ở cuối tài liệu thì bạn sẽ chỉ thấy một dấu 

ngắt ---Page Break--- 
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mà thôi, và bạn cũng chỉ việc xóa nó đi là trang trống sẽ biến mất. 

d. Xóa một trang đơn có chứa nội dung 

-Đặt con trỏ vào trang bạn muốn xóa. 

-Trong thẻ Home, nhóm Editing, nhấn nút mũi tên bên cạnh nút Find, 

chọn Go To (hoặc nhấn 

phím tắt Ctrl+G). 

- Trong hộp thoại xuất hiện, bạn gõ \page vào ô nhập liệu và nhấn Enter. 

Toàn bộ nội dung 

của trang hiện hành sẽ được chọn. 

- Nhấn nút Close. Sau đó nhấn phím Delete để xóa đi nội dung của trang. 

5. Đếm số từ trong tài liệu 

Word 2007 có thể đếm số từ của tài liệu trong khi bạn gõ văn bản. Ngoài 

ra chương trình còn 

có thể đếm số trang, số đoạn, số dòng, số ký tự có hoặc không có khoảng 

trắng 

 

a. Đếm số từ trong khi gõ văn bản 

 

Trong khi bạn gõ văn bản, Word 2007 sẽ tự động đếm số trang và số từ 

có trong tài liệu. Thông tin này được hiển thị trên thanh trạng thái ở góc 

dưới bên trái màn hình: mục Page (số trang) và Wor ds (số từ). 
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b. Đếm số từ trong vùng chọn 

Bạn có thể đếm số từ trong các vùng chọn, và các vùng chọn này không 

nhất thiết phải liền 

mạch nhau. 

- Trước tiên bạn dùng chuột chọn vùng cần đếm. Nếu các vùng không 

liền mạch nhau, sau khi 

chọn vùng đầu tiên, bạn giữ phím Ctrl và chọn thêm các vùng khác. 

- Trên thanh trạng thái ở cuối màn hình sẽ hiển thị số từ có trong vùng 

chọn. Ví dụ 110/1025 

có nghĩa là trong vùng chọn có 110 từ trên tổng số 1025 từ của tài liệu. 

Bao gồm cả textbox, footnote và endnote trong khi đếm từ 

- Trong thẻ Review, nhóm Proofing, nhấn nút Word Count. 

- Trong hộp thoại Word Count, đánh dấu check vào mục Include 

textboxes, footnotes and 

endnotes. 

c. Đếm số từ trong textbox 

- Chọn textbox mà bạn muốn đếm từ. 

-Trên thanh trạng thái ở cuối màn hình sẽ hiển thị số từ có trong textbox. 

Ví dụ 110/1025 có 

nghĩa là trong textbox có 110 từ trên tổng số 1025 từ của tài liệu 

d. Xem số trang, số ký tự, số đoạn và số dòng  

Để có đầy đủ thông tin về số trang, số ký tự, số đoạn và số dòng, bạn thực 

hiện một trong hai  

cách sau:  

- Trong thẻ Review, nhóm Proofing, nhấn nút Word Count.  

-  Trên thanh trạng thái ở góc dưới bên trái màn hình, bạn nhấn chuột vào 

mục Words.  

Hộp thoại Word Count xuất hiện cho bạn đầy đủ thông tin mà bạn muốn 

CHƢƠNG III 



 

 

GIÁO TRÌNH WORD 2003-2007-2010 Page 136 

 

BÙI QUYẾT TIẾN 2011 

1. Tìm và thay thế. 

a. Tìm văn bản 

Bạn có thể nhanh chóng tìm kiếm một từ hoặc cụm từ theo cách sau: 

- Trong thẻ Home, nhóm Editing, nhấn nút Find (hoặc nhấn phím tắt 

Ctrl+F) 

 

- Trong mục Find what của hộp thoại Find and Replace vừa xuất hiện, 

bạn hãy nhập vào đoạn 

văn bản cần tìm. 

- Để tìm mỗi một từ hoặc cụm từ, bạn nhấn Find Next. Để tìm tất cả từ 

hoặc cụm từ cùng một 

lúc trong văn bản, bạn nhấn Find in, sau đó nhấn Main Document. 

-Muốn kết thúc quá trình tìm kiếm, bạn nhấn ESC. 

b. Tìm và thay thế văn bản 

 

- Trong thẻ Home, nhóm Editing, nhấn nút Replace (hoặc nhấn phím tắt 

Ctrl+H). 

-Ở mục Find what, bạn nhập vào đoạn văn bản muốn tìm. 

-Ở mục Replace with, bạn nhập vào đoạn văn bản muốn thay thế. 
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-Để tìm đoạn văn bản tiếp theo, bạn nhấn Find Next. 

-Để thay thế đoạn văn bản, bạn nhấn Replace. Sau khi nhấn xong, Word 

sẽ chuyển sang đoạn 

văn bản tiếp theo. 

-Để thay thế tất cả các đoạn văn bản tìm được, bạn nhấn Replace All. 

c. Tìm và tô sáng đoạn văn bản tìm được 

Để dễ dàng nhận biết các cụm từ tìm được, bạn có thể tô sáng nó trên 

màn hình (không tô 

sáng khi in ra). 

 

-Trong thẻ Home, nhóm Editing, nhấn nút Find (Ctrl+F). 

-Trong hộp Find what, nhập văn bản mà bạn muốn tìm. 

-Nhấn Reading Highlight, sau đó chọn Highlight All 

Tất cả từ tìm được sẽ được tô sáng. Để tắt tính năng này đi, bạn nhấn 

Reading Highlight lần 

nữa, chọn Clear Highlighting. 

 

d. Tìm và thay thế những định dạng đặc biệt  

-  Trong thẻ Home, nhóm Editing, bạn nhấn nút Replace (Ctrl+H).  

- Nhấn nút More nếu bạn không nhìn thấy nút Format.  
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-Để tìm kiếm đoạn văn bản với định dạng đặc biệt, bạn hãy nhập đoạn 

văn đó trong ô Find 

what. Nếu chỉ để tìm kiếm định dạng, hãy để trống ô này. 

-Nhấn nút Format, sau đó chọn định dạng mà bạn muốn tìm. 

-Nhấn vào ô Replace with, sau đó nhấn Format, chọn định dạng thay thế. 
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Nếu bạn cũng muốn 

thay thế bằng đoạn văn bản, hãy nhập đoạn text đó vào ô Replace with. 

-Nhấn Find Next, nhấn tiếp Replace để tìm và thay thế các định dạng đặc 

biệt. Để thay thế 

toàn bộ, nhấn Replace All. 

e. Tìm và thay thế các dấu đoạn, ngắt trang và các mục khác 

- Trong hộp thoại Find and Replace xuất hiện sau khi nhấn Ctrl+H, bạn 

nhấn nút More nếu 

không thấy nút Special. 

- Nhấn vào ô Find what, sau đó nhấn nút Special và chọn một mục cần 

tìm 

Nhập những gì bạn muốn thay thế trong ô Replace with. 

-Nhấn Find Next, Replace hoặc Replace All. 

f. Sử dụng ký tự đại diện khi tìm kiếm 

-Bật hộp thoại Find and Replace lên. 

-Nhấn nút More để mở rộng hộp thoại. 

- Đánh dấu kiểm vào ô Use wildcards. 

 

-Nhập từ cùng những ký tự đại diện vào ô Find what. 

-Nhập những gì bạn muốn thay thế trong ô Replace with. 

-Nhấn Find Next, Replace hoặc Replace All. 

Bảng các ký tự đại diện 

Đại diện 

N 

hập 

Ví dụ 

Một ký tự bất kỳ 

? 

“s?t” tìm “sat” và “set”. 

Một dãy ký tự 

* 
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“s*d” tìm “sad” và “started”. 

Bắt đầu một từ 

< 

“<(inter)” 

tìm 

“interesting”, 

“intercept”. Không tìm “splintered”. 

Cuối một từ 

> 

“(in)>” tìm “in”, “within”. Không 

tìm “interesting”. 

Một trong những ký tự chỉ 

định 

[] 

“w[io]n” tìm “win” và “won”. 

Một ký tự bất kỳ trong dãy 

[-] 

“[r-t]ight” tìm “right” và “sight”. 

Dãy phải theo thứ tự tăng dần. 

 

Một ký tự bất kỳ, trừ những ký tự cho sẵn trong ngoặc 

[!x 

-z] 

“t[!a-m]ck” tìm “tock”, “tuck”. 

Không tìm “tack” hay “tick”. 

Để tìm một ký tự định nghĩa như một ký tự đại diện, bạn gõ dấu\ trước ký 

tự đó. Chẳng hạn 

gõ \? để tìm dấu hỏi. Bạn có thể sử dụng dấu ngặc đơn để nhóm các ký tự 

đại diện và đoạn text 

để chỉ ra thứ tự phép tính. Ví dụ gõ <(pre)*(ed)> để tìm “presorted” và 

“prevented”. 
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Bạn có thể sử dụng ký tự đại diện\n để tìm kiếm một biểu thức và thay 

thế bằng một biểu thức được sắp xếp. Ví dụ gõ (Office) (Word) vào ô 

Find what và gõ \2 \1 vào ô Replace with. Kết quả là chương trình sẽ tìm 

cụm từ Office Word và thay bằng Word Office. 

 

2. Chèn biểu tƣợng hoặc ký tự đặc biệt 

a. Chèn biểu tượng 

 

-Nhấn chuột vào nơi bạn muốn chèn biểu tượng trong tài liệu. 

-Tại thẻ Insert, nhóm Symbols, bạn nhấn nút Symbol. 

-Thực hiện tiếp một trong hai thao tác sau: 

Nhấn chuột vào biểu tượng bạn muốn chèn trong danh sách xổ xuống. 

Nếu biểu tượng cần chèn không có trong danh sách, bạn nhấn More 

Symbols ở cuối danh sách. Hộp thoại Symbol xuất hiện. Tại mục Font, 

bạn chọn một font chữ mình thích, nhấn chọn biểu tượng cần chèn trong 

khung bên dưới, nhấn nút Insert để chèn. Xong nhấn Close để đóng hộp 

thoại Symbol lại. 

Ghi chú: Nếu bạn chọn một loại font chữ mở rộng, chẳng hạn Arial hoặc 

Times New Roman, 

danh sách Subset sẽ xuất hiện bên cạnh mục chọn Font. Sử dụng danh 

sách này để chọn các ký 

tự của ngôn ngữ mở rộng. 

b. Chèn một ký tự đặc biệt 

- Nhấn chuột vào nơi bạn muốn chèn vào một ký tự đặc biệt. 

-Tại thẻ Insert, nhóm Symbols, bạn nhấn nút Symbol. Sau đó chọn More 

Symbols 
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- Trong hộp thoại Symbol, nhấn chọn thẻ Special Characters. 

-Bạn chọn trong danh sách một ký tự cần chèn và nhấn nút Insert. 

-Nhấn nút Close để đóng hộp thoại lại. 

c. Chèn một ký tự Unicode từ hộp thoại Symbol 

Khi bạn chọn một ký tự Unicode trong hộp thoại Symbol, mã của nó hiển 

thị trong hộp 

Character code. 

 

- Nhấn chuột vào vị trí bạn muốn chèn ký tự Unicode. 

-Trong thẻ Insert, nhóm Symbols, nhấn nút Symbol và chọn More 

Symbols. 

-Trong hộp thoại Symbol, thẻ Symbols, tại hộp Font bạn chọn font chữ 

mình thích. 

- Tại ô From, bạn chọn Unicode (hex). 
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-Nếu hộp Subset hiển thị, nhấn chọn một ký tự subset. 

- Nhấn vào ký tự bạn muốn chèn trong danh sách và nhấn nút Insert. 

-Nhấn Close. 

d. Dùng bàn phím để chèn ký tự Unicode vào tài liệu 

 

Nếu bạn biết mã của ký tự cần chèn, bạn có thể nhập vào mã đó trong tài 

liệu và nhấn phím Alt+X để chuyển đổi nó sang ký tự. Chẳng hạn bạn 

nhập vào 00A9 và nhấn Alt+X ngay sau đó sẽ được ký tự. Ngược lại, để 

hiển thị một mã ký tự Unicode của một ký tự nào đó trong tài liệu, bạn 

đặt con nháy phía sau ký tự đó và nhấn Alt+X. 

e. Chèn một biểu tượng được định nghĩa sẵn bằng cách sử dụng 

AutoCorrect 

Để sử dụng được tính năng này, trước hết bạn cần bật AutoCorrect lên: 

 

-Nhấn Microsoft Office Button, sau đó chọn Word Options. 

-Trong hộp thoại Word Options, chọn Proofing ở khung bên trái. 

- Nhấn nút AutoCorrect Options. Trong hộp thoại xuất hiện, chọn thẻ 

AutoCorrect. 
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- Đánh dấu chọn mục Replace text as you type. 

-Nhấn OK hai lần để đóng các hộp thoại lại 

 

f. Tạo mục AutoCorrect của riêng bạn 

-Trong thẻ Insert, nhóm Symbols, nhấn nút Symbol, chọn More Symbols. 

- Ở hộp thoại Symbol xuất hiện, bạn nhấn vào thẻ Symbols hay Special 

Characters tùy ý. 

- Chọn một biểu tượng hay ký tự đặc biệt mà bạn muốn đưa vào mục 

AutoCorrect. 

- Nhấn nút AutoCorrect. Biểu tượng bạn chọn sẽ xuất hiện trong hộp 

With. 

-Trong mục Replace, bạn gõ các ký tự mà Word sẽ tự động chuyển sang 

biểu tượng hay ký tự 

đặc biệt mà bạn chọn ở trên. 
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- Nhấn nút Add. 

- Nhấn OK. 

-Nhấn Close để đóng hộp thoại Symbol lại. 

3. Dấu gạch nối (-) 

 

Khi một từ quá dài, không vừa khít với vị trí cuối dòng, Word sẽ chuyển 

từ này sang vị trí đầu dòng mới thay vì gạch nối nó. Tuy nhiên bạn có thể 

dùng tính năng Hyphenation để gạch nối tự động hoặc gạch nối bằng tay 

đoạn text, xác lập số khoảng cách lớn nhất cho phép giữa một từ và lề 

phải mà không gạch nối từ đó. 

Khi sử dụng tính năng gạch nối tự động, Word 2007 sẽ tự động chèn gạch 

nối vào vị trí cần 

thiết. Khi gạch nối bằng tay, Word sẽ tìm text để gạch nối và hỏi bạn có 

muốn chèn gạch nối vào 

hay không. 

a. Tự động chèn gạch nối trong toàn bộ tài liệu 

-Đảm bảo rằng không có đoạn text nào đang được chọn. 

- Trong thẻ Page Layout, nhóm Page Setup, bạn nhấn nút Hyphenation, 

sau đó chọn 

Automatic 
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b. Chèn dấu gạch nối tùy ý 

Bạn có thể điều khiển vị trí ngắt của một từ hoặc một cụm từ nếu từ đó 

“rớt” ở cuối dòng. Ví 

dụ, bạn có thể chỉ định vị trí ngắt của từ “nonprinting” là “non-printing” 

thay vì “nonprint-ing”. 

 

- Trong thẻ Home, nhóm Paragraph, nhấn nút Show/Hide. 

- Nhấn chuột vào vị trí trong từ, nơi bạn muốn chèn dấu gạch nối. 

-Giữ Ctrl và nhấn phím gạch nối. 

c. Tự động chèn dấu gạch nối trong một phần tài liệu 

-Chọn đoạn text mà bạn muốn gạch nối. 

-Trong thẻ Page Layout, nhóm Page Setup, bạn nhấn nút Hyphenation, 

sau đó chọn 

Automatic. 

d. Gạch nối bằng tay trong một phần tài liệu 
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Khi bạn gạch nối bằng tay, Word 2007 sẽ tìm đoạn text để gạch nối. Sau 

khi bạn chỉ định vị trí muốn gạch nối trong đoạn text, Word sẽ chèn một 

dấu gạch nối tùy ý. Nếu sau đó bạn soạn thảo tài liệu và thay đổi ngắt 

dòng, Word sẽ chỉ hiển thị và in ra những dấu gạch nối còn rớt ở cuối 

dòng mà không gạch nối lại trong tài liệu. 

- Chọn đoạn văn bản muốn gạch nối. 

- Trong thẻ Page Layout, nhóm Page Setup, bạn nhấn nút Hyphenation, 

sau đó chọn Manual. 

e. Chèn một dấu gạch nối không ngắt 

Các dấu gạch nối không ngắt giúp ngăn ngừa các từ, số hoặc cụm từ bị 

ngắt nếu nó rớt ở cuối 

dòng. Ví dụ, bạn có thể ngăn ngừa dãy số 999-1234 bị ngắt giữa chừng, 

thay vào đó toàn bộ cụm 

dãy số này sẽ được chuyển xuống đầu dòng kế tiếp. 

- Nhấn chuột vào nơi bạn muốn chèn dấu gạch nối không ngắt. 

- Nhấn giữ Ctrl, Shift và nhấn phím gạch nối. 

f. Xác lập vùng gạch nối 

 

Vùng gạch nối là số khoảng trống tối đa cho phép giữa một từ và lề phải 

mà không gạch nối từ này. Bạn có thể thay đổi vùng gạch nối: để giảm số 

lượng gạch nối, hãy làm cho vùng gạch nối rộng hơn; để giảm tính chất 

rời rạc của lề phải, bạn làm cho vùng gạch nối hẹp hơn. 

- Trong thẻ Page Layout, nhóm Page Setup, nhấn nút Hyphenation, sau 

đó chọn Hyphenation 

Options. 

-Trong Hyphenation zone, nhập vào khoảng cách mà bạn muốn 

g. Xóa bỏ dấu gạch nối tự động  

Trong thẻ Page Layout, nhóm Page Setup, nhấn nút Hyphenation, sau đó 

chọn None.  

h. Xóa bỏ dấu gạch nối bằng tay  

-  Trong thẻ Home, nhóm Editing, nhấn nút Replace (hoặc nhấn phím 

Ctrl+H). 
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- Nhấn nút More>> để mở rộng hộp thoại Find and Replace. 

-  Nhấn nút Special, sau đó chọn: 

Optional Hyphen: nếu muốn xóa dấu gạch nối bằng tay.  

Nonbreaking Hyphen: để xóa dấu gạch nối không ngắt.  

- Để trống ô Replace with.  

- Nhấn Find Next, Replace, hoặc Replace All.  

4. Gỡ rối các vấn đề trong khi soạn thảo  

a. Chữ mới “đè” chữ cũ  

Triệu chứng: Mỗi khi gõ chữ mới, chữ cũ tại điểm chèn bị xóa đi.  

Nguyên nhân: Chế độ viết chồng đã được bật lên.  

Giải pháp: Tắt chế độ viết chồng bằng cách:  

-  Nhấn chuột vào nút Microsoft Office Button, sau đó nhấn nút Word 

Options.  

-Nhấn Advanced trong khung bên trái.  

- Bên dưới nhóm Editing options, bạn xóa dấu kiểm trước mục Use 

overtype mode. Nhấn OK 

 

b. Không thể tìm thấy lệnh Clear Contents 

Triệu chứng: Bạn muốn xóa chữ hoặc các đối tượng đồ họa nhưng không 

thể tìm thấy lệnh 

Clear Contents để thực hiện việc này. 
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Nguyên nhân: Khác với các phiên bản trước, lệnh Clear Contents không 

có trong bản Word 

2007. 

Giải pháp: Bạn có thể sử dụng phím Delete để xóa text hoặc các đối 

tượng đồ họa sau khi đã 

chọn nó. 

c. Word cuộn quá nhanh khi rê chuột chọn chữ 

Triệu chứng: Khi bạn chọn chữ bằng cách giữ và rê chuột theo hướng 

xuống dưới, Word cuộn 

tài liệu nhanh đến nỗi khó mà nhả chuột vào vị trí chính xác, nơi bạn 

muốn kết thúc vùng chọn. 

Nguyên nhân: Trong khi bạn rê chuột để chọn chữ, Word sẽ cuộn tài liệu 

theo hướng bạn 

chọn. 

Giải pháp: Để giải quyết vấn đề này, bạn nên kết hợp giữa chuột và bàn 

phím trong khi chọn 

chữ. 

- Nhấn chuột vào nơi bắt đầu vùng chọn 

Sử dụng thanh cuộn để trượt đến vị trí muốn kết thúc vùng chọn. 

- Giữ phím Shift trong khi nhấn chuột trái vào vị trí kết thúc vùng chọn. 

d. Lệnh Insert File biến đâu mất? 

Triệu chứng: Bạn muốn chèn chữ từ một tài liệu khác vào tài liệu hiện 

hành nhưng không thể 

tìm thấy lệnh Insert File để thực hiện việc này. 

Nguyên nhân: Trong Word 2007, lệnh Insert File đã được đổi tên thành 

Text from File và 

được chuyển vào menu Object trong thẻ Insert. 

Giải pháp: 

- Nhấn chuột tại vị trí muốn chèn tài liệu vào. 

- Trong thẻ Insert, nhóm Text, bạn nhấn chuột vào mũi tên bên cạnh nút 

Object, chọn Text 
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from File  

Bây giờ bạn có thể chọn văn bản và dùng chuột kéo – thả đoạn văn đó 

sang vị trí mới để di 

chuyển (hoặc giữ thêm phím Ctrl trong khi thực hiện để sao chép). 

f. Chữ Unicode bị “nhảy” khi copy 
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Höôùng daãn söû duïng Word 2007  

Baèng Laêng 25  

Triệu chứng: Khi sử dụng font chữ Unicode, nếu copy một dòng văn bản 

thì hiện tượng nhảy  

chữ xuất hiện.  

Giải pháp:  

-  Nhấn chuột vào nút Microsoft Office Button, sau đó nhấn nút Word 

Options.  

- Nhấn Advanced trong khung bên trái.  

- Bên dưới nhóm Cut, copy, and paste, bạn nhấn nút Settings 

Bỏ dấu chọn ở hộp kiểm Adjust sentence and word spacing 

automatically. Nhấn OK hai lần 

để đóng các hộp thoại lại. 

CHƢƠNG IV 

1. Viết một phƣơng trình 

Với Word 2007, để viết một phương trình, bạn có thể chèn các biểu 

tượng trong hộp thoại 

Symbol; sử dụng tính năng Math AutoCorrect để chuyển chữ thành biểu 

tượng; hay sử dụng 

cách sau: 
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- Trong thẻ Insert, nhóm Symbols, nhấn vào mũi tên bên dưới nút 

Equation, sau đó chọn 

Insert New Equation 

 

Trên thanh công cụ xuất hiện thêm thẻ Design, và bạn có thể nhấn chuột 

vào các nút trong 

nhóm Symbols để chèn các ký hiệu toán học, hay nhấn chuột vào các nút 

trong nhóm Structures 

để chèn vào tài liệu một cấu trúc toán học có sẵn, sau đó chỉnh sửa lại. 

Chú ý: Để hiển thị danh sách đầy đủ các ký hiệu toán học trong nhóm 

Symbols, bạn nhấn nút 
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a. Sử dụng các biểu tƣợng trong Math AutoCorrect 

-Nhấn Microsoft Office Button, sau đó nhấn Word Options. 

-Trong khung bên trái, nhấn Proofing, sau đó nhấn nút AutoCorrect 

Options. 

- Trong hộp thoại AutoCorrect, nhấn chọn thẻ Math AutoCorrect, sau đó 

đánh dấu kiểm trước 

2 mục Use Math AutoCorrect rules outside of math regions và mục 

Replace text as you type. Ghi 

nhớ các ký tự ở mục Replace (ký tự bạn nhập) và mục With (ký tự toán 

học sẽ thay thế). 
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Nhấn OK 2 lần để đóng các hộp thoại lại. 

- Bây giờ bạn hãy gõ thử các ký tự (mục Replace) và nhấn phím khoảng 

trắng, nó sẽ biến đổi 

thành ký tự toán học tương ứng. Ví dụ:\approx, nhấn khoảng trắng sẽ 

biến thành dấu . 

b. Chèn một phƣơng trình thông dụng 

 

Trong thẻ Insert, nhóm Symbols, bạn nhấn chuột vào mũi tên bên dưới 

nút Equation. Một menu xuất hiện với danh sách các phương trình thông 

dụng. Muốn sử dụng cái nào, bạn chỉ việc nhấn chọn cái đó để chèn vào 

tài liệu và chỉnh sửa lại theo ý thích. 

Thêm một phương trình vào danh sách các phương trình thông dụng 

- Chọn một phương trình muốn thêm. 
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- Bên dưới Equation Tools, trong thẻ Design, nhóm Tools, nhấn nút 

Equation, sau đó chọn 

Save Selection to Equation Gallery. 

-Trong hộp thoại Create New Building Block, bạn nhập vào tên của 

phương trình tại mục 

Name. 

- Tại danh sách Gallery, chọn Equations. Nhấn OK 

 

c. Thay đổi phƣơng trình đƣợc soạn thảo trong Word 2007 

Bạn chỉ việc nhấn chuột vào phương trình muốn chỉnh sửa và thay đổi 

theo ý thích. 

Thay đổi phương trình được soạn thảo trong Word phiên bản cũ hơn 

Để thay đổi một phương trình được soạn thảo ở phiên bản cũ, sử dụng 

Equation 3.0 add-in 

hay Math Type add-in, bạn cần sử dụng add-in mà đã viết phương trình 

này. 

 

Ngoài ra, khi bạn mở tài liệu có chứa phương trình được viết trong phiên 

bản cũ của Word, bạn không thể sử dụng các chương trình viết và thay 

đổi phương trình được cung cấp sẵn, trừ khi bạn chuyển tài liệu sang định 

dạng Word 2007. 
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* Chuyển tài liệu sang định dạng Word 2007 

-Nhấn Microsoft Office Button, sau đó nhấn Convert. 

-Nhấn OK trong hộp thoại xác nhận. 

- Nhấn Microsoft Office Button, sau đó nhấn Save. 

* Thay đổi phương trình được soạn thảo bằng Equation 3.0 

-Nhấn đúp chuột vào phương trình muốn chỉnh sửa. 

- Thay đổi phương trình theo ý muốn. 

* Thay đổi phương trình được soạn thảo bằng Math Type 

- Hãy đảm bảo rằng Math Type đã được cài đặt trên máy. 

 

-Nhấn đúp chuột vào phương trình muốn chỉnh sửa. 

-Trong Math Type, chỉnh sửa lại phương trình theo ý muốn. 

- Ở menu File, nhấn chọn Close and Return to... để trở về cửa sổ soạn 

thảo Word. 

2. Kiểm tra chính tả và ngữ pháp 

Tự động kiểm tra lỗi chính tả và ngữ pháp (các đường gợn sóng màu đỏ, 

xanh dương, xanh lá 

cây) 

 

Khi bạn bật chế độ kiểm tra chính tả tự động trong khi gõ, bạn có thể an 

tâm rằng không bị mắc nhiều lỗi chính tả trong tài liệu. Word 2007 sẽ 

đánh dấu những từ bị lỗi giúp ta phát hiện ra lỗi một cách nhanh chóng. 

Ví dụ: Bạn có thể nhấn chuột phải lên từ sai để xem những cách sửa lỗi 

được đề nghị. 

Tương tự, nếu bật chế độ kiểm tra ngữ pháp tự động, Word sẽ đánh dấu 

những lỗi ngữ pháp 

trong tài liệu trong khi bạn soạn thảo 

Ví dụ: Bạn có thể nhấn chuột phải và chọn những kiểu sửa lỗi đề nghị. 

Bạn cũng có thể chọn 

Ignore Once để “lờ” đi lỗi này, hoặc chọn About This Sentence để xem 

tại sao Word xem câu đó 

là lỗi. 
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a. Bật hoặc tắt chế độ kiểm tra chính tả, ngữ pháp tự động 

- Nhấn chuột vào Microsoft Office Button , chọn 

Word Options. 

-Trong hộp thoại hiện ra, chọn Proofing ở khung 

bên trái. 

-Để bật/tắt chế độ kiểm lỗi tự động trong tài liệu 

hiện hành (đang mở), bạn thực hiện như sau: 

Tại mục Exceptions for, chọn tên của tài liệu hiện hành. 

Chọn hoặc bỏ chọn mục Hide spelling errors in this document only và 

Hide 

grammar errors in this document only. 

-Để bật/tắt chế độ kiểm lỗi tự động trong tất cả tài liệu từ giờ trở đi, bạn 

thực hiện như sau: 

Tại mục Exceptions for, chọn All NewDo cument s. 

Chọn hoặc bỏ chọn mục Hide spelling errors in this document only và 

Hide 

grammar errors in this document only. 

b. Kiểm tra tất cả lỗi chính tả và ngữ pháp sau khi soạn thảo văn bản 

- Chọn đoạn văn bản bạn muốn kiểm lỗi (hoặc không chọn nếu 

muốn kiểm toàn bộ văn bản). 

-Bấm phím F7 (hoặc chọn thẻ Review, nhấn nút Spelling & 

Grammar trong nhóm Proofing). 

- Nếu chương trình phát hiện ra lỗi chính tả, hộp thoại Spelling 

and Grammar xuất hiện, tô đỏ từ sai. 

 

Tại khung Suggestions, bạn có thể chọn những gợi ý sửa lỗi mà chương 

trình đưa ra và nhấn nút Change để sửa theo gợi ý đó. 

 

Nếu bạn muốn tự mình sửa, hãy nhấn chuột vào tài liệu, nơi từ đang bị 

phát hiện là lỗi và sửa lại theo ý mình. Sửa xong nhấn nút Resume để 

kiểm tra tiếp những từ khác. 
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Trong trường hợp từ mà Word phát hiện là lỗi nhưng lại là từ mà bạn cho 

là chính xác và bạn muốn Word nhận ra từ này là đúng chính tả để lần 

sau khỏi “bắt lỗi” nữa, hãy thêm nó vào từ điển bằng cách nhấn nút Add 

to Dictionary. 

Nếu muốn “lờ” đi từ sai và chuyển sang kiểm tra tiếp những từ khác, bạn 

nhấn 

nút Ignore Once (lờ 1 lần) hoặc Ignore All (lờ tất cả). 

 

Trường hợp bạn thường xuyên bị mắc lỗi ở từ này và bạn muốn Word tự 

động sửa lại thành từ đúng trong khi bạn gõ văn bản, hãy chọn từ đúng 

trong khung Suggestions và nhấn nút AutoCorrect. 

- Ngoài ra, nếu bạn muốn kiểm tra luôn ngữ pháp, hãy đánh dấu chọn 

Check grammar trong 

hộp thoại Spelling and Grammar. Sau khi kiểm tra chính tả, chương trình 

sẽ chuyển sang kiểm 

tra ngữ pháp cho bạn. Cách sửa lỗi cũng tương tự như trên. 

2. Tìm từ trong từ điển 

Sử dụng tính năng Research, bạn có thể tìm các từ trong từ điển. Cách 

thực hiện: 

- Trong thẻ Review, nhóm Proofing, nhấn nút Research. 

- Để tìm một từ đơn trong tài liệu, giữ phím Alt và nhấn chuột vào từ cần 

tra cứu 

- Để tra nghĩa một cụm từ, bạn dùng chuột chọn các từ đó, giữ phím Alt 

và nhấn chuột trái 

vào vùng chọn. 

-Tại khung Research bên phải màn hình, mục Search for, bạn sẽ thấy từ 

cần tra hiển thị trong 

đây. Bên dưới là phần giải nghĩa của nó. 

-Bạn cũng có thể gõ trực tiếp từ cần tra nghĩa vào ô Search for và nhấn 

OK. 

3. Tra từ đồng nghĩa, phản nghĩa 

Sử dụng tính năng Research, bạn còn có thể tra từ đồng nghĩa và từ phản 

nghĩa. 
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- Trong thẻ Review, nhóm Proofing, bạn nhấn nút Thesaurus. 

-Giữ phím Alt và nhấn chuột vào từ cần tra. Kết quả sẽ hiển thị trong 

khung Research ở bên 

phải. 

- Để chèn từ đồng nghĩa hoặc phản nghĩa đó vào tài liệu hiện hành, nơi 

con trỏ đang đứng, 

bạn đưa chuột vào từ trong danh sách kết quả, nhấn chuột vào mũi tên 

bên cạnh từ, chọn Insert. 

- Để tìm tiếp từ đồng nghĩa / phản nghĩa của từ trong danh sách tìm được, 

bạn nhấn chuột vào 

từ đó trong danh sách kết quả. 

Ghi chú: Bạn có thể tìm từ đồng nghĩa, phản nghĩa trong ngôn ngữ khác 

(ngoài tiếng Anh) 

bằng cách nhấn chuột vào hộp danh sách bên dưới khung nhập liệu 

Search for và chọn một ngôn 

ngữ, ví dụ như tiếng Pháp (French) chẳng hạn. 

4. Dịch văn bản 

Khác với cách tra nghĩa từng từ, trong phần này chúng ta sẽ cùng tìm 

hiểu cách dịch một đoạn 

văn bản dài. 

- Trong thẻ Review, nhóm Proofing, bạn nhấn nút Translate. 

-Hoặc bạn cũng có thể nhấn chuột phải vào vị trí bất kỳ trong tài liệu, 

chọn Translate - 

Translate. 
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- Để chọn ngôn ngữ dịch, tại khung Translation ở bên phải, chọn ngôn 

ngữ nguồn tại mục 

From, ngôn ngữ đích tại mục To. 

- Để dịch một từ bất kỳ trong tài liệu, bạn giữ phím Alt và nhấn chuột trái 

vào từ. Nghĩa của 

nó sẽ được hiển thị trong khung Translation ở bên phải 

Để dịch một đoạn văn bản, bạn dùng chuột chọn đoạn văn bản đó, giữ Alt 

và nhấn chuột trái 

vào vùng chọn. Nghĩa của nó sẽ được hiển thị trong khung Translation ở 

bên phải. 
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Để dịch toàn bộ tài liệu, tại khung Translation, bạn nhấn chuột vào nút 

Translate the whole 

document . Sau đó bấm Yes trong hộp thoại xác nhận. Bản dịch sẽ được 

hiển thị trong một cửa 

sổ duyệt Web mới mở ra. 

- Ngoài ra bạn cũng có thể dịch từ hoặc đoạn văn bằng cách tự mình nhập 

vào khung Search 

for, sau đó nhấn nút Start Searching . 
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5.Bật tính năng “đƣa chuột vào từ để hiển thị nghĩa trong một Screentip” 

Chỉ cần đưa chuột vào từ, nghĩa của nó (đã được dịch sang ngôn ngữ 

khác) sẽ hiển thị trong 

một Screentip bên cạnh, rất tiện lợi. 

Để bật tính năng này, bạn thực hiện như sau: 

- Tại thẻ Review, nhóm Proofing, nhấn chuột vào mũi tên bên cạnh nút 

Translation 

ScreenTip 

 

Chọn một ngôn ngữ muốn dịch sang trong menu xuất hiện. 

- Muốn tắt tính năng này, bạn chọn Turn Off Translation ScreenTip. 

6. Tự động tạo hyperlink cho địa chỉ Web 

 

Word tự động tạo một hyperlink khi bạn gõ vào một địa chỉ Web (chẳng 

hạn www.microsoft.com) và nhấn Enter hoặc phím khoảng trắng. Nếu 

muốn tắt/ bật tính năng này, bạn nhấn Microsoft Office Button , chọn 

Word Options. Nhấn Proofing. Nhấn nút AutoCorrect Options, nhấn chọn 

thẻ AutoFormat As You Type. Tại hộp Internet and network paths with 

hyperlinks, bạn bỏ chọn hoặc chọn để tắt/ bật tính năngn à y. 

7. Tạo một hyperlink tùy ý đến một tài liệu, tập tin hay trang Web 

 

a. Chọn đoạn text hoặc hình ảnh mà bạn muốn dùng để hiển thị như một 

hyperlink. 
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b. Trong thẻ Insert, nhóm Links, bạn nhấn nút Hyperlink. 

c. Hộp thoại Insert Hyperlink xuất hiện. 

-Để liên kết đến một file hoặc trang Web có sẵn, bạn nhấn nút Existing 

File or Web Page bên 

 

dưới mục Link to, sau đó nhập vào địa chỉ mà bạn muốn liên kết đến 

trong hộp Address. Nếu không biết địa chỉ của một file, bạn có thể dùng 

khung duyệt file/ thư mục trong cửa sổ này để chọn file mình muốn liên 

kết. 

-Để liên kết đến một file mà bạn chưa hề tạo nó, hãy nhấn nút Create 

New Document bên 

dưới mục Link to, sau đó nhập tên của file mới sẽ tạo tại mục Name of 

new document. Tại mục 

When to edit bạn có thể chọn là Edit the new document later (soạn tài liệu 

này sau) hoặc Edit the 

new document now (soạn ngay bây giờ). 

 

Để tùy biến ScreenTip (hiển thị khi bạn rê chuột lên hyperlink), bạn nhấn 

nút ScreenTip và gõ vào dòng ghi chú. Nếu bạn không chỉ định dòng ghi 

chú này, Word sẽ sử dụng đường dẫnha y địa chỉ của file liên kết đến làm 

ScreenTip. 

-Nhấn OK khi tạo xong hyperlink. 

8. Tạo một hyperlink đến trang e-mail trống 

Thực hiện bước 1 và bước 2 như trên để hiển thị hộp thoại Insert 

Hyperlink. 

3. Bên dưới mục Link to, bạn nhấn nút E-mail Address. 

b. Tại mục E-mail address, nhập vào địa chỉ e-mail mà bạn muốn khi 

nhấn vào hyperlink sẽ 

gửi thư cho địa chỉ này. 

4. Tại mục Subject, bạn nhập tiêu đề thư. Nhấn OK 
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9. Tạo một hyperlink đến vị trí bất kỳ trong tài liệu hay trang Web hiện 

hành 

Để sử dụng tính năng này, trước hết bạn cần đánh dấu vị trí đích muốn 

liên kết đến trong tài 

liệu hiện hành. 

* Chèn một bookmark: 
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1. Trong tài liệu hiện hành, chọn đoạn text hay đối tượng mà bạn muốn 

gán một bookmark. 

2. Trong thẻ Insert, nhóm Links, bạn nhấn nút Bookmark. 

3. Cửa sổ Bookmark xuất hiện. Tại Bookmark name, bạn gõ vào một tên 

để nhận dạng 

bookmark này (lưu ý, tên không được chứa khoảng trắng). Nhấn Add để 

thêm vào 
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Thêm liên kết đến bookmark: 

 

1. Chọn text hoặc đối tượng mà bạn muốn hiển thị như một hyperlink. 

2. Nhấn chuột phải và chọn Hyperlink trong menu ngữ cảnh. 
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3. Bên dưới mục Link to, bạn nhấn nút Place in This Document. 

4. Trong danh sách bạn chọn một bookmark muốn liên kết đến. Nhấn OK 

 

10. Tạo một hyperlink đến vị trí bất kỳ trong tài liệu hay trang Web khác 

(không phải 

trang hiện hành) 

1. Trước tiên bạn tạo những bookmark trong file đích (file mà bạn sẽ liên 

kết đến) tương tự 

 

cách ở trên. 

2. Mở tài liệu nguồn, chọn đoạn text hay đối tượng muốn hiển thị là 

hyperlink. 

3. Nhấn chuột phải, chọn Hyperlink trong menu ngữ cảnh. 

4. Bên dưới mục Link to, nhấn nút Existing File or Web Page. 

5. Tại khung Look in, bạn duyệt đến file đích muốn liên kết đến. 

6. Nhấn nút Bookmark, sau đó chọn những bookmark muốn liên kết đến 

trong tài liệu đích. 

Nhấn OK. 
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11. Gỡ bỏ một hyperlink 

Bạn nhấn chuột phải vào hyperlink muốn gỡ bỏ, chọn Remove Hyperlink 

trong menu ngữ 

cảnh. 

12. Áp dụng nhanh một kiểu mẫu (Quick Style) 

Áp dụng một kiểu mẫu 

1. Chọn đoạn text bạn muốn áp dụng kiểu mẫu. 

2. Trong thẻ Home, nhóm Styles, nhấn chuột vào một kiểu mà bạn thích. 

Nếu không thấy kiểu 

định dạng mà mình mong muốn, bạn nhấn nút More để mở rộng khung 

Quick Styles 

 

Ví dụ, bạn muốn đoạn text đang chọn được áp dụng kiểu tiêu đề, nhấn 

nút Title trong khung 

danh sách. 

Bạn có thể xem trước kiểu định dạng được áp dụng như thế nào bằng 

cách rê chuột vào từng 

kiểu mình muốn xem, nó sẽ áp dụng “thử” với đoạn text bạn đang chọn. 
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Tạo một kiểu mẫu 

1. Chọn đoạn text mà bạn muốn tạo một kiểu mới. Ví dụ, bạn muốn tạo 

một định dạng in đậm, 

chữ màu đỏ. 

2. Trong thẻ Home, nhóm Font, bạn lần lượt in đậm (nhấn nút B) và tô đỏ 

chữ (chọn màu từ 

nút Font Color). 

3. Nhấn chuột phải vào vùng chọn, trỏ tới Styles, và nhấn Save Selection 

as a New Quick 

Style. 

4. Nhập vào tên của style mới (chẳng hạn Style 1) và nhấn OK. 

Lập tức kiểu chữ mới tạo sẽ nằm gọn trong nhóm Styles ở thẻ Home, sẵn 

sàng để bạn sử 

dụng. 

Thay đổi kiểu mẫu 

1. Định dạng đoạn text theo ý thích của bạn. 

2. Trong thẻ Home, nhóm Styles, nhấn chuột phải vào style mà bạn muốn 

thay đổi, chọn 

Update to Match Selection. 

Trong tài liệu, tất cả những đoạn text đã được áp dụng kiểu này trước đó 

sẽ được cập nhật lại 

với định dạng mới. 

Gỡ bỏ một kiểu mẫu 

1. Trong thẻ Home, nhóm Styles, bạn nhấn chuột phải vào kiểu mẫu 

muốn gỡ bỏ. 

2. Chọn Remove from Quick Styles gallery. 

13. Cài đặt điểm dừng tab (Tab stops) 

Để cho việc cài đặt tab được thuận tiện, bạn nên cho hiển thị thước ngang 
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trên đỉnh tài liệu 

bằng cách nhấn nút View Ruler ở đầu trên thanh cuộn dọc. 

 

Bạn có thể nhanh chóng chọn tab bằng cách lần lượt nhấn vào ô tab 

selector – là ô giao nhau giữa thước dọc và thước ngang (ở góc trên bên 

trái trang tài liệu) cho đến khi chọn được kiểu tab mong muốn, sau đó 

nhấn chuột vào thanh thước ngang nơi bạn muốn đặt tab. 

Tùy từng trường hợp cụ thể mà bạn có thể sử dụng một trong các loại tab 

sau 
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Höôùng daãn söû duïng Word 2007  

Baèng Laêng 36  

Tab trái: Đặt vị trí bắt đầu của đoạn text mà từ đó sẽ chạy sang phải khi 

bạn nhập  

liệu.  

Tab giữa: Đặt vị trí chính giữa đoạn text. Đoạn text sẽ nằm giữa vị trí đặt 

tab khi  

bạn nhập liệu.  

Tab phải: Nằm ở bên phải cuối đoạn text. Khi bạn nhập liệu, đoạn text sẽ 

di  

chuyển sang trái kể từ vị trí đặt tab.  

Tab thập phân: Khi đặt tab này, những dấu chấm phân cách phần thập 

phân sẽ  

nằm trên cùng một vị trí.  
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Bar Tab: Loại tab này không định vị trí cho text. Nó sẽ chèn một thanh 

thẳng  

đứng tại vị trí đặt tab 

CHƢƠNG V 

1. Định dạng chữ trong word 2007 

a. In đậm 

1. Chọn đoạn text mà bạn muốn in đậm, đưa con trỏ chuột vào vùng chọn 

cho đến khi xuất 

hiện thanh công cụ Mini. 

2. Nhấn nút Bold (B). 

Bạn cũng có thể sử dụng 

phím tắt Ctrl+B. 

Lưu ý, nhấn Bold (hoặc 

Ctrl+B) lần nữa nếu bạn 

muốn bỏ in đậm. 

b. In nghiêng 

Thực hiện tương tự như in đậm, nhưng thay vì nhấn nút Bold thì bạn 

nhấn nút Italic (phím tắt 

Ctrl+I). 

c. Gạch dưới đoạn text 

Nhấn Ctrl+U để gạch dưới đoạn text đang chọn. Nhấn Ctrl+U lần nữa để 

bỏ gạch dưới. 

Ngoài ra còn có nhiều kiểu gạch dưới khác: 

 

* Gạch dưới các từ, trừ khoảng trắng: 

- Chọn đoạn text bạn muốn gạch dưới. 

- Tại thẻ Home, nhóm Font, bạn nhấn nút mũi tên ở góc dưới bên phải. 
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- Trong hộp Underline style, bạn chọn Word only. Nhấn OK. 

* Gạch đôi ở dưới từ: 

Thực hiện bước 1, 2 tương tự trên. 

Trong hộp Underline style, bạn chọn biểu tượng dòng đôi. Nhấn OK. 

* Đường gạch dưới trang trí: 

Thực hiện bước 1, 2 tương tự trên. 

-Trong hộp Underline style, bạn chọn kiểu mình thích. 

- Để đổi màu của đường gạch dưới, nhấn chuột vào hộp Underline color 

và chọn màu mình 

thích. Nhấn OK. 

d. Đổi màu chữ 

1. Chọn đoạn text bạn muốn đổi màu, di chuyển con trỏ chuột vào vùng 

chọn để xuất hiện 

thanh công cụ Mini. 

2. Nhấn nút Font Color và chọn màu mình thích. 

f. Đổi kích cỡ chữ 

1. Chọn đoạn text, di chuyển con trỏ chuột vào để xuất hiện thanh công 

cụ Mini 

2. Để tăng kích cỡ chữ, bạn nhấn nút Grow Font (phím tắt Ctrl+Shift+>). 

Để giảm kích cỡ 

chữ, nhấn nút Shrink Font (phím tắtC trl+S hift+<). 

g. Đánh dấu (Highlight) đoạn text 

 

Đánh dấu đoạn text để làm nó trông nổi bật hơn. Cách thực hiện: 

1. Tại thẻ Home, nhóm Font, bạn nhấn vào mũi tên bên cạnh nút Text 

Highlight Color. 

2. Chọn một màu dùng để tô sáng mà bạn thích (thường là màu vàng). 
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3. Dùng chuột tô chọn đoạn text muốn đánh dấu. 

4. Muốn ngừng chế độ đánh dấu, bạn nhấn chuột vào mũi tên cạnh nút 

Text Highlight Color, 

chọn Stop Highlighting, hoặc nhấn ESC. 

h. Gỡ bỏ chế độ đánh dấu text 

 

1. Chọn đoạn text muốn gỡ bỏ chế độ đánh dấu. 

2. Trong thẻ Home, nhóm Font, bạn nhấn chuột vào mũi tên cạnh nút 

Text Highlight Color. 

3. Chọn No Color. 

i. Tìm kiếm nhanh những dòng chữ được đánh dấu 

 

1. Trong thẻ Home, nhóm Editing, nhấn nút Find. 

2. Nếu bạn không thấy nút Format, hãy nhấn nút More. 

3. Nhấn nút Format, sau đó chọn Highlight. 

4. Nhấn Find Next. 

k. Tạo một chữ hoa thụt cấp (Dropped Cap) 

Có 2 chế độ: 

1. Dropped cap. 

2. In-margin dropped cap. 

Cách thực hiện: 

1. Nhấn chuột vào đoạn văn bản mà bạn muốn bắt đầu bằng một chữ hoa 

thụt cấp. 

2. Trong thẻ Insert, nhóm Text, bạn nhấn nút Drop Cap. 

3. Chọn tiếp chế độ Dropped hoặc In margin tùy ý. 

l. Định dạng chỉ số trên (Superscript), chỉ số dưới (Subscript) 
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1. Chỉ số trên (Superscript); 2. Chỉ số dưới (Subscript) 

 

Chọn đoạn text cần định dạng. Trong thẻ Home, nhóm Font, bạn nhấn nút 

Superscript (phím tắt Ctrl+Shift+=) để định dạng chỉ số trên, hoặc nhấn 

nút Subscript (phím tắt Ctrl+=) để định dạng chỉ số dưới. 

2. Canh chỉnh văn bản 

Canh trái, phải, giữa, hoặc canh đều hai bên 

1. Chọn đoạn văn bản bạn muốn canh chỉnh 

2. Trong thẻ Home, nhóm Paragraph, nhấn nút Align Left để canh 

lề trái, nhấn Align Right để 

canh phải, nhấn nút Center để canh giữa (giữa 2 lề trái và phải), 

hay nhấn nút Justify để canh đều 

hai bên. 

a. Canh chỉnh nhiều chế độ trên cùng 1 dòng 

1. Chuyển chế độ xem văn bản là Print Layout hoặc Web Layout 

(Trong thẻ View, nhóm 

Document Views, chọn nút Print Layout hoặc Web Layout). 

2. Nhấn chuột vào dòng mới và thực hiện như sau: 

-Chèn đoạn text canh trái: Di chuyển con trỏ chuột chữ I sang trái 

cho đến vị trí cần gõ text, 

nhấn đúp chuột và gõ vào đoạn text. 

- Chèn đoạn text canh giữa: Di chuyển con trỏ chuột chữ I vào 

khoảng giữa dòng cho đến vị 

trí cần gõ text. Nhấn đúp chuột và gõ vào đoạn text. 

- Chèn đoạn text canh phải: Di chuyển con trỏ chuột chữ I sang 

phải cho đến vị trí cần gõ text, 

nhấn đúp chuột và gõ vào đoạn text. 

b. Thay đổi các canh chỉnh theo chiều dọc đoạn text 
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1. Trong thẻ Page Layout, nhóm Page Setup, nhấn chuột vào nút 

mũi tên ở góc dưới bên phải. 

2. Trong hộp thoại Page Setup, nhấn vào thẻ Layout. Tại mục 

Vertical alignment, bạn chọn 

một loại canh chỉnh mình thích (Top, Center, Justified, Bottom) 

 

3. Tại mục Apply to, bạn chọn phạm vi áp dụng là Whole 

document (toàn văn bản), This 

section (vùng hiện tại), hay This point forward (kể từ đây trở về 

sau). Nhấn OK.  
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c. Canh giữa lề trên và lề dưới 

1. Chọn đoạn văn bản bạn muốn canh giữa so với lề trên và lề 

dưới. 

2. Trong thẻ Page Layout, nhóm Page Setup, nhấn chuột vào nút 

mũi tên ở góc dưới bên phải. 

3. Trong hộp thoại Page Setup, nhấn vào thẻ Layout. Tại mục 

Vertical alignment, bạn chọn 

Center. 

4. Tại mục Apply to, chọn Selected text. Nhấn OK. 

d. Thụt lề dòng đầu tiên của đoạn 

1. Nhấn chuột vào đoạn mà bạn muốn thụt lề dòng đầu tiên. 

2. Trong thẻ Page Layout, nhấn vào nút mũi tên góc dưới bên phải 

của nhóm Paragraph. 

3. Ở hộp thoại Paragraph, chọn thẻ Indents and Spacing. Tại mục 

Special, bạn chọn First line. 

Tại mục By, chọn khoảng cách thụt vào. Nhấn OK. 

e. Điều chỉnh khoảng cách thụt lề của toàn bộ đoạn 

1. Chọn đoạn văn bản muốn điều chỉnh. 

2. Tại thẻ Page Layout, nhóm Paragraph, nhấn chuột vào mũi tên 

lên, xuống bên cạnh mục 

Left để tăng, giảm khoảng cách thụt lề trái, hay tại mục Right để 

điều chỉnh thụt lề phải. 

f. Thụt dòng tất cả, trừ dòng đầu tiên của đoạn 

1. Chọn đoạn văn bản mà bạn muốn điều chỉnh. 

2. Trên thanh thước ngang, hãy nhấn chuột vào dấu Hanging 

Indent và rê đến vị trí bạn muốn 

bắt đầu thụt dòng. 

Nếu bạn không thấy thanh thước ngang đâu cả, hãy nhấn nút View 

Ruler ở phía trên củathanh 

cuộn dọc để hiển thị nó. 

g. Tạo một thụt âm 

Thay vì thụt dòng vào trong, bạn có thể điều chỉnh thụt ra ngoài so 

với lề trái bằng cách: 

1. Chọn đoạn văn bản mà bạn muốn mở rộng sang trái. 

2. Tại thẻ Page Layout, nhóm Paragraph, nhấn nút mũi tên hướng 

xuống trong mục Left cho 
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đến khi đoạn văn bản nằm ở vị trí bạn vừa ý. 

3. Thay đổi khoảng cách trong văn bản 

a. Tạo khoảng cách đôi giữa các dòng cho toàn bộ tài liệu 

Khoảng cách mặc định giữa các dòng cho bất kỳ tài liệu trống nào 

là 1.15. Bạn có thể tạo 

khoảng cách đôi (2) nếu muốn bằng cách sau: 

1. Trong thẻ Home, nhóm Styles, nhấn chuột phải vào nút Normal, 

chọn Modify 

2. Bên dưới nhóm Formatting, nhấn nút Double Space. Nhấn OK. 

3. b. Thay đổi khoảng cách dòng cho đoạn văn bản đang chọn 

Höôùng daãn söû duïng Word 2007 

Baèng Laêng 41 

1. Chọn đoạn văn bản muốn thay đổi. 

2. Trong thẻ Home, nhóm Paragraph, nhấn nút Line Spacing. 

3. Chọn khoảng cách bạn muốn, chẳng hạn 2.0 

Ghi chú: Nếu muốn đặt nhiều khoảng cách giữa các dòng nhưng 

khoảng cách này không có 

trong menu xuất hiện khi nhấn nút Line Spacing, bạn hãy chọn 

Line Spacing Options, và nhập 

vào khoảng cách mà bạn thích. 

Các kiểu khoảng cách dòng mà Word hỗ trợ: 

- Single (dòng đơn). Tùy chọn này hỗ trợ font lớn nhất trong 

dòng đó, thêm vào một lượng 

khoảng trống nhỏ bổ sung. Lượng khoảng trống bổ sung tùy 

thuộc vào font chữ mà bạn đang sử 

dụng. 

-1.5 lines: Gấp 1,5 lần khoảng cách dòng đơn. 

- Double: Gấp 2 lần khoảng cách dòng đơn. 

-At least: Lựa chọn này xác lập khoảng cách dòng tối thiểu cần 

thiết để phù hợp với font hoặc 

đồ họa lớn nhất trên dòng. 

- Exactly: Cố định khoảng cách dòng và Word sẽ không điều 

chỉnh nếu sau đó bạn tăng hoặc 

giảm cỡ chữ. 

- Multiple: Xác lập khoảng cách dòng tăng hoặc giảm theo tỉ lệ 

% so với dòng đơn mà bạn chỉ 
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định. Ví dụ, nhập vào 1.2 có nghĩa là khoảng cách dòng sẽ tăng 

lên 20% so với dòng đơn. 

c. Thay đổi khoảng cách trước hoặc sau các đoạn 

1. Chọn đoạn văn bản bạn muốn thay đổi khoảng cách trước 

hoặc sau nó. 

2. Trong thẻ Page Layout, nhóm Paragraph, bạn nhấn chuột vào 

mũi tên cạnh mục Before 

(trước) hoặc After (sau) để thay đổi bằng giá trị bạn muốn. 

d. Thay đổi khoảng cách giữa các ký tự 

1. Chọn đoạn văn bản mà bạn muốn thay đổi. 

2. Trong thẻ Home, nhấn chuột vào nút mũi tên ở góc dưới phải 

của nhóm Font để mở hộp 

thoại Font. 

3. Nhấn chọn thẻ Character Spacing ở hộp thoại này. Trong 

mục Spacing, nhấn Expanded để 

mở rộng hay Condensed để thu hẹp khoảng cách và chỉ định số khoảng 

cách trong mục By 

 

. Co dãn văn bản theo chiều ngang 
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1. Chọn đoạn văn bản bạn muốn căng ra hoặc thu lại. 

2. Trong thẻ Home, nhấn chuột vào nút mũi tên ở góc dưới phải 

của nhóm Font để mở hộp 

thoại Font. 

3. Nhấn chọn thẻ Character Spacing ở hộp thoại này. Tại mục 

Scale, nhập vào tỉ lệ % mà bạn 

muốn. Nếu tỉ lệ này lớn hơn 100% thì đoạn văn bản sẽ được kéo 

ra, ngược lại, nó sẽ được thu lại. 

4. Đánh dấu sự thay đổi và ghi chú trong tài liệu 

Theo dõi sự thay đổi trong khi chỉnh sửa 

1. Mở tài liệu mà bạn muốn theo dõi. 

2. Trong thẻ Review, nhóm Tracking, nhấn nút Track Changes. 

3. Thay đổi tài liệu theo ý bạn (chèn, xóa, di chuyển hay định 

dạng văn bản...). Lập tức ở bên 

hông trang tài liệu sẽ xuất hiện những bong bóng hiển thị sự 

thay đổi này. 

5. Tắt chế độ theo dõi sự thay đổi 

Trong thẻ Review, nhóm Tracking, nhấn vào nút Track 

Changes một lần nữa để tắt chế độ 

theo dõi trong khi chỉnh sửa. 

6. Thay đổi cách Word đánh dấu 

-Bạn có thể đổi màu và những định dạng mà Word dùng để 

đánh dấu sự đổi trong tài liệu 

bằng cách nhấn vào mũi tên bên cạnh nút Track Changes, và 

nhấn chọn mục Change Tracking 
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Options  

Nếu bạn muốn xem tất cả những thay đổi ngay trong tài liệu 

thay vì hiển thị những bong 

bóng bên hông tài liệu, ở nhóm Tracking, nhấn vào nút Ballons, 

sau đó chọn Show all revisions 

inline. 

-Để làm nổi bật vùng hiển thị những bong bóng (bên lề tài liệu), 

hãy nhấn nút Show Markup 

và chọn Markup Area Highlight. 

7. Tạo một ghi chú 

1. Chọn đoạn text hoặc đối tượng bất kỳ trong tài liệu bạn muốn 

ghi 

chú. 

2. Trong thẻ Review, nhóm Comments, nhấn nút New 

Comment. 

3. Nhập vào ghi chú của bạn trong bong bóng hiển thị ở khung 

bên 

cạnh tài liệu. 

a. Xóa ghi chú 

-Để xóa một ghi chú, nhấn chuột phải vào ghi chú đó, chọn 

Delete Comment. 

- Để xóa nhanh tất cả ghi chú trong tài liệu, nhấn chuột vào một 

ghi chú bất kỳ. Trong thẻ 
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Review, nhóm Comments, nhấn vào mũi tên bên dưới nút 

Delete và chọn Delete All Comments 

in Document. 

b. Thay đổi ghi chú 

1. Nếu các ghi chú không hiển thị trong tài liệu, bạn nhấn nút 

Show Markup trong nhóm 

Tracking của thẻ Review, sau đó đánh dấu chọn Comments. 

2. Nhấn chuột vào bên trong một bong bóng có ghi chú cần sửa. 

Sau đó sửa lại nội dung theo 

ý bạn. 

c. Thay đổi tên người ghi chú 

Bên cạnh mỗi ghi chú luôn có tên của người sử dụng. Nếu bạn 

muốn thay đổi tên này, hãy 

thực hiện như sau: 

1. Trong thẻ Review, nhóm Tracking, nhấn chuột vào mũi tên 

bên dưới nút Track Changes, 

sau đó chọn mục Change User Name 

2 Trong hộp thoại xuất hiện, bên dưới mục Personalize..., bạn 

nhập vào tên của mình, sau đó 

nhấn OK 
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Lưu ý là những ghi chú kể từ bây giờ trở đi mới có tác dụng với 

tên mới. 

8. In tài liệu kèm theo ghi chú và những đánh dấu thay đổi 

1. Nhấn nút Microsoft Office Button , sau đó chọn Print. 

2. Trong hộp thoại Print, tại mục Print what, chọn Document 

showing markup và nhấn OK. 

9. In danh sách những thay đổi trong tài liệu 

1. Nhấn nút Microsoft Office Button , sau đó chọn Print. 

2. Trong hộp thoại Print, tại mục Print what, chọn List of 

markup và nhấn OK. 

10. Không in những đánh dấu thay đổi và ghi chú 

1. Nhấn nút Microsoft Office Button , sau đó chọn Print. 

2. Trong hộp thoại Print, tại mục Print what, chọn Document và 

nhấn OK 

CHƢƠNG VI 

1. Dùng tính năng Bullets - Numbering để đánh dấu/đánh số tự 

động 
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a. Tạo danh sách đánh dấu (bullet) hay đánh số (number) tự 

động 1 cấp 

1. Gõ vào dấu * để bắt đầu một danh sách các đánh dấu đầu 

dòng hoặc nhập 1. Để bắt đầu 

một danh sách đánh số tự động, sau đó nhấn phím cách (space 

bar) hoặc phím Tab. 

2. Nhập bất cứ chữ nào bạn muốn. 

3. Nhấn phím Enter. Word sẽ tự động chèn thêm một dấu bullet 

hoặc số thứ tự tiếp theo. 

4. Để kết thúc việc đánh dấu, đánh số tự động, nhấn Enter hai 

lần hoặc nhấn phím Backspace 

để xóa dấu bullet hoặc số cuối cùng. 

b. Nếu chức năng đánh dấu / đánh số tự động không có hiệu 

lực, bạn bật nó lên bằng cách 

sau: 

 

1. Nhấn nút Microsoft Office Button , sau đó chọn Word 

Options. 

2. Nhấn Proofing. 

3. Nhấn nút AutoCorrect Options, sau đó nhấn vào thẻ 

AutoFormat As You Type. 

4. Bên dưới nhóm Apply as you type, bạn đánh dấu chọn vào 2 

mục Automatic bulleted lists 

và Automatic numbered lists. Nhấn OK để đóng các hộp thoại 

lại 
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c. Thêm dấu bullet hay numbering vào trong danh sách 

1. Chọn một mục bạn muốn thêm vào. 

2. Trong thẻ Home, nhóm Paragraph, nhấn nút Bullets hoặc nút 
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Numbering  

Ghi chú: Bạn có thể tìm thấy nhiều kiểu bullet hoặc kiểu số 

khác bằng cách nhấn vào mũi tên 

bên cạnh nút Bullets / Numbering. 

d. Giãn khoảng cách giữa các mục trong danh sách Bullets / 

Numbering 

1. Trong thẻ Home, nhóm Styles, nhấn chuột vào mũi tên 

hướng xuống bên cạnh phải để mở 

 

rộng danh sách Styles. Sau đó nhấn chuột phải vào kiểu List 

Paragraph, chọn Modify. 

2. Trong hộp thoại Modify Style, nhấn nút Format, chọn 

Paragraph. 
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3. Bỏ chọn mục Don’t add space between paragraphs of the 

same style. Nhấn OK để đóng các 

hộp thoại lại 

Chuyển danh sách Bullets / Numbering từ một cấp sang đa cấp 

1. Nhấn chuột vào một mục trong danh sách mà bạn muốn 

chuyển nó thành một cấp khác. 

2. Trong thẻ Home, nhóm Paragraph, nhấn vào mũi tên bên 

cạnh nút Bullets hoặc Numbering, 

chọn Change List Level và chọn một cấp bạn muốn. 

f. Thêm các bullets hình ảnh hoặc biểu tượng vào danh sách 

1. Chọn mục mà bạn muốn bổ sung các bullets hình ảnh hay các 

biểu tượng. 

2. Trong thẻ Home, nhóm Paragraph, nhấn vào mũi tên bên 

cạnh nút Bullets. 

3. Chọn Define New Bullet. Trong hộp thoại Define New 

Bullet, bạn nhấn nút Symbol (biểu 

tượng) hay Picture (hình ảnh) tùy mục đích. 

4. Chọn hình ảnh hoặc biểu tượng bạn muốn sử dụng, sau đó nhấn 

OK hai lần 

5.  
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. Thêm một bullet hình ảnh hoặc biểu tượng vào trong thư viện 

Bullet 

1. Mở tài liệu có chứa biểu tượng bullet mà bạn muốn thêm vào 

thư viện. 

2. Trong thẻ Home, nhóm Paragraph, nhấn vào mũi tên cạnh 

nútBull ets. 

3. Bên dưới nhóm Document Bullets, nhấn chuột phải vào kiểu 

bullet mà bạn muốn thêm vào 

thư viện, sau đó chọn Add to Library. 

h. Xóa một kiểu ra khỏi thư viện Bullet 

1. Trong thẻ Home, nhóm Paragraph, nhấn vào mũi tên bên 

cạnh nút Bullets. 

2. Bên dưới nhóm Bullet Library, nhấn chuột phải vào một kiểu 

bạn muốn loại bỏ khỏi danh 

sách, sau đó chọn mục Remove. 

i. Tạo danh sách các ô đánh dấu chọn (checklist) 

 

Khi tạo một tài liệu dạng trắc nghiệm, chắc chắn bạn phải thiết 

kế những ô đánh dấu để người dùng đánh dấu vào . Có 2 dạng 

đánh dấu trong tài liệu: một dạng là dùng đem đi in (để người 

dùng đánh dấu vào giấy), dạng thứ hai là cho người dùng đánh 

dấu trực tiếp trong nội dung file. 

k. Tạo một checklist để đem đi in 

Có 2 cách cơ bản để tạo một checklist đem đi in: 

- Nếu tài liệu của bạn không chứa nhiều kiểu bullets khác nhau, 

bạn có thể sử dụng cách tạo 

một danh sách bullets tùy biến định dạng. 

-Nếu tài liệu của bạn có sẵn nhiều định dạng bullets khác nhau, 

bạn có thể ngăn ngừa các 

bullets cũ thay đổi bằng cách tạo một danh sách checklist trong 

bảng. 

l. Tạo checklist bằng tính năng tùy biến định dạng bullets 

 

1. Nhập vào những mục trong danh sách của bạn. 

2. Chọn danh sách này. 
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3. Trong thẻ Home, nhóm Paragraph, nhấn vào mũi tên cạnh nút 

Bullets. 

4. Chọn Define New Bullet. 

5. Nhấn nútS ymbol . 

6. Trong hộp thoại Font, chọn một font biểu tượng đã cài sẵn 

trên máy, ví dụ như font 

Wingdings 

. Nhấn đúp chuột vào biểu tượng check box mà bạn muốn chèn 

vào tài liệu. Nhấn OK. 

m. Tạo bảng để ngăn ngừa các bullets cũ thay đổi khi tạo 

checklist 

Bước 1: Tạo bảng 

 

1. Trong thẻ Insert, nhóm Tables, nhấn nút Table. 

2. Chọn Insert Table. 

3. Tại mục Number of columns, bạn nhập 2. 

4. Tại mục Number of rows, nhập vào số dòng bạn muốn, lưu ý 

là mỗi dòng chứa một khoản 

mục chọn trong checklist. 

5. Nhấn OK. 

Bước 2: Chèn những ô check box và nhập liệu 

 

1. Nhấn vào ô đầu tiên ở trên bên trái trong bảng. 

2. Trong thẻ Insert, nhóm Symbols, nhấn nút Symbol và chọn 

More Symbols. 

3. Nhấn vào thẻ Symbols. 

4. Trong hộp Font, chọn một font biểu tượng đã cài trên máy, 

chẳng hạn font Wingdings. 

5. Nhấn đúp chuột vào biểu tượng check box mà bạn muốn. 

6. Nhấn Close. 

7. Nhấn chuột vào ô kế tiếp mà bạn muốn chèn một check box, 

nhấn tổ hợp phím Ctrl+Y, bạn 

sẽ thấy một check box mới xuất hiện. 

8. Sau khi chèn các ô check box mà bạn muốn, nhấn chuột vào 

ô đầu tiên ở trên bên phải và 

nhập vào các khoản mục tương ứng với các check box đã tạo 
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Bước 3: Trau chuốt lại bố cục 

Các tab căn chỉnh Table 

1. Nhấn chuột phải vào bảng, trỏ đến mục AutoFit và chọn 

AutoFit to Contents. 

2. Nhấn chuột phải vào bảng, chọn Table Properties. Sau đó mở 

thẻ Table trong hộp thoại mới 

xuất hiện. 

3. Nhấn nút Options, ở hộp Left, Right, nhập vào khoảng cách 

giữa check box và đoạn text 

 

bên cạnh, ví dụ .02 inches. Nhấn OK. 

4. Trong thẻ Table, nhấn nút Borders and Shading, sau đó nhấn 

vào thẻ Borders. 

5. Bên dưới mục Setting, nhấn None, và nhấn OK hai lần để 

đóng các hộp thoại lại. 

Ghi chú: Sau khi bạn bỏ đường viền của bảng, bạn sẽ vẫn thấy 

một đường viền đứt khúc, tuy 

 

nhiên bạn có thể yên tâm là đường viền này sẽ không được hiển 

thị khi in. Nếu bạn muốn những đường viền đứt khúc này biến 

mất hoàn toàn, bạn có thể nhấn nút View Gridlines ở nhóm 

Table của thẻ Layout bên dưới Table Tools. 

2. Cách tạo ô đánh dấu để ngƣời dùng đánh dấu trực tiếp vào 

nội dung file 

Bước 1: Tạo bảng 

1. Trong thẻ Insert, nhóm Tables, nhấn nút Table, sau đó chọn 

Insert Table. 
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2. Trong hộp Number of columns, gõ vào 2. 

3. Trong hộp Number of rows, nhập vào số dòng mà bạn muốn, 

mỗi dòng là một mục chọn 

trong danh sách sẽ tạo. Nhấn OK. 

Bước 2: Chèn vào những ô check box và nhập liệu 

Để thêm vào những ô cho phép người dùng đánh dấu check trực 

tiếp trong file,bạn cần sử 

dụng thẻ Developer. 

* Hiện thẻ Developer 

 

1. Nhấn nút Microsoft Office Button , chọn Word Options. 

2. Trong hộp thoại xuất hiện, chọn mục Popular ở khung bên 

trái. 

3. Đánh dấu chọn mục Show Developer tab in the Ribbon. 

Nhấn OK 
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1. Nhấn vào ô đầu tiên bên trái của bảng. 

2. Trong thẻ Developer, nhóm Controls, nhấn nút Legacy Tools. 

3. Bên dưới Legacy Forms, chọn Check Box Form Field. 

Ghi chú: Nếu ô check box có nền màu xám, bạn nhấn nút Legacy Tools , 

chọn Form Field  

Shading để gỡ bỏ nền xám đó đi.  

4. Nhấn vào ô kế tiếp, nơi bạn muốn chèn tiếp một check box. Sau đó 

nhấn Ctrl+Y để chèn  

check box vào.  

5. Sau khi đã chèn xong hết các check box, bạn nhấn chuột vào ô đầu tiên 

bên phải của bảng  

và nhập vào các khoản mục tương ứng với từng check box bên trái.  

Bước 3: Hoàn thiện lại bố cục  

1. Nhấn chuột phải vào bảng, trỏ đến mục AutoFit và chọn AutoFit to 

Contents 
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2. Nhấn chuột phải vào bảng, chọn Table Properties. Sau đó mở 

thẻ Table trong hộp thoại mới 

xuất hiện 

3. Nhấn nút Options, ở hộp Left, Right, nhập vào khoảng cách 

giữa check box và đoạn text 

bên cạnh, ví dụ 0.19cm. Nhấn OK 



 

 

GIÁO TRÌNH WORD 2003-2007-2010 Page 196 

 

BÙI QUYẾT TIẾN 2011 

 
4. Trong thẻ Table, nhấn nút Borders and Shading, sau đó nhấn 

vào thẻBor ders. 

5. Bên dưới mục Setting, nhấn None, và nhấn OK hai lần để 

đóng các hộp thoại lại. 
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Bước 4: Khóa form 

 

Để người dùng có thể đánh dấu chọn trực tiếp vào file tài liệu, 

bạn cần khóa form lại. Lưu ý, khi khóa form lại bạn không thể 

chỉnh sửa chữ cũng như bố cục của tài liệu, do đó hãy đảm bảo 

thực hiện bước này sau cùng. 

1. Nhấn vào nút Design Mode trong nhóm Controls của thẻ 

Developer để tắt chế độ Design. 

2. Trong thẻ Developer, nhóm Protect, nhấn nút Protect 

Document, sau đó chọn Restrict 

F Trong khung Protect Document, bên dưới Editing restrictions, 

đánh dấu chọn Allow only 

this type of editing in the documentormatting and Editing 

. Trong combo box bên dưới, chọn Filling in forms. 

5. Bên dưới Start enforcement, nhấn nút Yes, Start 

Enforcing Protection. 

6. Để đặt mật khẩu, không cho người dùng gỡ bỏ chế độ 

bảo vệ, hãy nhập vào mật khẩu trong ô Enter new password 

(optional) và xác nhận lại mật khẩu ở ô bên dưới. 

 

Bây giờ bạn có thể gửi file tài liệu này cho người dùng đánh dấu chọn 

vào, sau đó họ lưu lại và gửi lại cho bạn. Rất hữu ích nếu bạn muốn thực 

hiện một cuộc thăm dò khảo sát nào đó qua e-mail... 
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Word 2010 

 

I. Những điểm mới trong Microsoft Word 2010 

1. Tối ƣu Ribbons 

Nếu bạn vẫn đang dùng bộ Office 2003 và quen thuộc với thanh menu chuẩn 

nằm ở phía trên cửa sổ thì hãy chuẩn bị cho một sự đổi mới trong bộ Office 

2010.  

Với thanh menu theo giao diện Ribbon, các chức năng sẽ được chia ra theo 

từng tab riêng biệt trên menu chứ không hiển thị ra toàn bộ như kiểu menu cũ.  

Thực ra bộ Office 2007 cũng đã được trang bị kiểu menu Ribbon, tuy nhiên, 

menu của Office 2010 được tối ưu để thuận tiện hơn cho người dùng. Ngoài ra, 



 

 

GIÁO TRÌNH WORD 2003-2007-2010 Page 199 

 

BÙI QUYẾT TIẾN 2011 

bạn cũng có thể tạo thêm các tab mới để chứa các chức năng của riêng mình. 

 

Menu Ribbon trên Word 2010 

Có thể khi mới chuyển qua menu mới, bạn sẽ gặp ít nhiều khó khăn về sự mới 

lạ, tuy nhiên, một khi đã quen thuộc, bạn sẽ khó mà chấp nhận quay trở lại sử 

dụng mẫu menu cũ trên Office 2003. 
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2. Hệ thống menu mới    

 

Trước đây, Office 2007 đã tạo ra sự khác biệt hoàn toàn so với Office 2003 

cũng như các phiên bản Office cũ về mặt giao diện, đặc biệt là menu của 

chương trình thì giờ đây, Office 2010 lại là tạo nên 1 cấp độ mới và là một sự 

thay đổi về menu công cụ của chương trình. Khi lựa chọn trên menu công cụ, 
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thay vì sổ xuống 1 menu như trước đây, toàn bộ cửa sổ Office 2010sẽ thay đổi 

màu sắc và sẽ cung cấp cho bạn các tùy chọn như Save, Open, Close, 

Preview… 

 Và trên cùng, hệ thống menu mới cung cấp các thông tin chi tiết về tác giả, 

kích thước tập tin, và các thông tin về sửa đổi file…. Thêm vào đó là một cửa 

sổ cho phép bạn xem trước tài liệu ở dạng trang in để chắc chắn rằng văn bản 

đã được trình bày theo đúng ý bạn. Nói một đơn giản: Hệ thống menu mới của 

Office 2010 rõ ràng và chi tiết hơn rất nhiều. 

3. Chức năng Backstage View 

Trong Office 2010, nút bấm này được thay đổi bởi một tab mới trên Ribbon, 

nằm ở trong cùng bên trái. Khi bạn click vào tab này, một màn hình mới được 

gọi là Backstage View sẽ được hiện lên. Trên màn hình này, danh sách bên trái 

sẽ chứa các tác vụ, màn hình bên phải sẽ là tùy chọn các chức năng tương ứng 

với tác vụ đó. 
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4. Chức năng Paster Preview 

Microsoft đã thu thập phản hồi của khách hàng về các phiên bản Office trước 

và phát hiện ra rằng số đông người dùng thường xuyên mất nhiều thời gian để 

dán một đoạn văn bản hoặc hình ảnh vào nội dung soạn thảo của mình.  

Nguyên do của tình trạng này là vì người dùng không biết trước nội dung được 

dán vào văn bản sẽ trông như thế nào, và họ phải làm lại nhiều lần mới khiến 

cho chúng trông hợp lý và phù hợp với định dạng của nội dung soạn thảo. Và 

đó là lý do tính năng Paste Preview được ra đời. 
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Paste Preview cho phép bạn xem trước nội dung soạn thảo sẽ trông như thế nào 

nếu một nội dung khác được dán vào trong đó, giúp bạn tiết kiệm được thời 

gian. Ngoài ra tính năng này còn cho phép lưu giữ định dạng của nội dung cần 

dán, kết hợp các định dạng hoặc loại bỏ định dạng của nội dung trước khi dán. 

5. Chức năng Text Effect 

Thay vì phải tạo một đối tượng WordArt để chèn chữ nghệ thuật vào trang văn 

bản, giờ đây với Office 2010 công việc đó đã đơn giản hơn rất nhiều và người 

dùng cũng có thêm nhiều lựa chọn với việc trang trí văn bản của mình. Khác 

với phiên bản Office 2007. Tính năng WordArt chỉ được tích hợp vào Excel và 

Powerpoint còn với Word 2007 thì mọi sự vẫn y như trước nhưng tới Office 

2010 thì đã khác. 

Với tính năng Text Effect bạn có thể sử dụng hoàn toàn các hiệu ứng đẹp mắt 

của WordArt trong Excel hay Powerpoint 2007 trong Word 2010. Thật đơn 

giản bạn chỉ cần lựa chọn đoạn văn bản cần áp dụng hiệu ứng sau đó nhấp 

chuột vào biểu tượng của Text Effect trên thanh công cụ tại thẻ Menu Home, 

một menu đổ xuống cho phép bạn lựa chọn các hiệu ứng cần áp dụng 

Và bạn hoàn toàn có thể áp dụng các hiệu ứng có trong Text Effect với văn bản 

của mình. 

Nếu như phải lựa chọn Edit để hiệu chỉnh nội dung cho WordArt thì giờ đây 
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người dung có thể chỉnh sửa trực tiếp nội dung văn bản có hiệu ứng của 

WordArt 

 

Người dùng có thể chèn, xóa hay thay đổi Font, kích thước Font, màu sắc, đánh 

dấu… với văn bản mang hiệu ứng của WordArt 

Chú ý: Chức năng này chỉ sử dụng cho những file Word được tạo ra từ Word 

2010 và có định dạng *.docx nếu người dùng lưu file dưới dạng *.doc thì các 

hiệu ứng này sẽ tự động bị gỡ bỏ khỏi văn bản 

6. Lƣu fi e dƣới d ng PDF và XPS đƣợc tích hợp sẵn 

Ngoài các định dạng được hỗ trợ bởi MS Office các phiên bản trước đó như 

Doc, Docx… thì Office 2010 cũng hỗ trợ lưu file dưới định dạng PDF và XPS 

mà không phải cài đặt thêm Add-in nào như Office 2007 
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7. Hiển thị thông tin chi tiết của fi e văn bản trong Office 

Button 

Để biết thông tin về file văn bản bạn đang làm việc bạn chỉ việc nhấp chuột vào 

nút Office Button. Mọi thông tin sẽ được hiển thị như dung lượng (tính đến lần 

lưu cuối cùng), số trang, số từ, thời gian chỉnh sửa, thời gian tạo, thời gian lưu 

lần cuối, người tạo… 

 

8. Khả năng mở rộng màn hình 

Office 2010 cho phép người dùng mở rộng cửa sổ soạn thảo bằng cách ẩn hoặc 

hiện bảng Menu Ribbon bằng nút lệnh Minimize the Ribbon nằm phía trên góc 

phải cửa sổ làm việc của các ứng dụng Office 2010 hoặc nhấn tổ hợp phím Ctrl 

+ F1 
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9. Chức năng chỉnh s a fi e Media chuy n d ng 

Chức năng chỉnh s a fi e Media chuy n d ng  

  

 

  

Không chỉ biết đến với những công cụ soạn thảo văn bản và tính toán, Office 

2010 còn biết đến với công cụ chỉnh sửa ảnh và video mạnh mẽ. Cụ thể, bạn có 

thể dễ dàng chỉnh sửa và biên tập nội dung hình ảnh cũng như video ngay trong 

trong Microsoft PowerPoint. Bạn thậm chí có thể loại bỏ nền của hình ảnh với 

bộ Office mới.  
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Nói cách khác, Office 2010 có rất nhiều tính năng mà bạn có thể làm được với 

các file media. Mặc dù nó sẽ không phải là phần mềm chỉnh sửa ảnh chuyên 

dụng như Photoshop, nhưng Office 2010 thực sự làm cho việc tạo và chỉnh sửa 

nội dung các hình ảnh dễ dàng hơn. 

10. Ch p ảnh c a sổ, ứng d ng đƣa vào văn bản 

Đây là một điểm mới có trong Office 2010, trong Menu Insert bạn dễ dàng 

nhận thấy nút lệnh Screenshot. 

 

Khi nhấp chuột vào nút lệnh này một menu hiện ra cho phép bạn chụp ảnh một 

ứng dụng đang chạy hay một cửa sổ đang được mở để chèn vào ngay tại vị trí 

con trỏ. 

 

Khi nhấp chuột vào nút lệnh Screenshot một menu hiện ra hiển thị các cửa sổ 

đang mở và chương trình đang chạy người dùng chỉ việc nhấp chuột vào đối 

tượng để có được bức ảnh chèn vào văn bản. Người dùng cũng có thêm lựa 

chọn chụp tuỳ chọn bằng cách lựa chọn Screen Clipping để chụp ảnh những 

vùng mình muốn. Khi chọn lệnh này màn hình máy tính sẽ mờ đi và con trỏ 
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chuyển thành dấu cộng màu đen người dùng nhấp chuột và khoanh một vùng 

cần chụp vùng đó sẽ sáng lên và ngay khi thả chuột người dùng sẽ có được một 

bức ảnh chèn vào văn bản là vùng vừa chọn. 

11. X   ý ảnh nhƣ một chƣơng trình chuy n nghiệp 

Với Office 2010 người dùng có thêm nhiều lựa chọn thiết lập các chế độ và 

hiệu ứng cho đối tượng picture được chèn vào văn bản. Chỉ cần chọn đối tượng 

này sau đó vào Menu Picture Tools\Format người dùng có thể dễ dàng nhận 

thất các lựa chọn để thay đổi hiệu ứng cho bức ảnh như: Correction, Color, 

Artistic Effect. 

 

12. Phát triển chức năng tìm kiếm 

Nếu như với Office 2007 và các phiên bản trước đó hộp thoại tìm kiếm không 

có gì khác biệt thì với Office Word 2010 MS đã phát triển chức năng này thành 

một chức năng khá linh hoạt và tốc độ tìm kiếm cũng được cải thiện đáng kể. 

Khi chọn lệnh tìm kiếm hay nhấn tổ hợp phím Ctrl+F, cửa sổ soạn thảo sẽ thu 

hẹp lại về bên trái nhường chỗ cho hộp thoại tìm kiếm. Khi người dùng nhập 

nội dung tìm kiếm vào ô Search Document thì các từ giống sẽ được đánh dấu 

ngay trong văn bản đồng thời hộp thoại cũng hiện ra một phần đoạn văn gần 

với từ đang tìm kiếm để người dùng có thể dễ dàng di chuyển đến vùng có từ 

đang tìm kiếm 
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13. T y chọn bảo m t m nh m  
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Bạn luôn lo lắng nội dung tài liệu của mình sẽ bị thay đổi và truy cập trái phép? 

Điều này sẽ được hạn chế tối đa ở trong Office 2010. Phiên bản Office mới 

cung cấp những tính năng cho phép hạn chế việc thay đổi mà không có sự cho 

phép của tác giả, ngoài ra còn cung cấp thêm vào một “chế độ bảo vệ” 

(protection mode) để tránh việc bạn vô tình sửa nội dung của file ngoài ý 

muốn. Office 2010 cho phép bạn chọn lựa ai trong số những người nhận được 

tài liệu của bạn được phép chỉnh sửa, hoặc chỉ được xem mà không có quyền 

chỉnh sửa.  

II. Nội dung chính 

Chương 1: Thao tác căn bản trên Word 2010 

1. T o mới văn bản 

Tương tự như Word 2007, phím tắt để tạo một tài liệu mới trong Word 2010 là 

Ctrl+N. Cách khác: Nhấn chuột vào Microsoft Office Button (hoặc Tab File), 

chọn New, nhấn đúp chuột vô mục Blank document. 

Tạo một tài liệu mới từ mẫu có sẵn: Nhấn Microsoft Office Button (hoặc Tab 

File), chọn New. Nhấn nút Create để tạo một tài liệu mới từ mẫu đã chọn. 



 

 

GIÁO TRÌNH WORD 2003-2007-2010 Page 211 

 

BÙI QUYẾT TIẾN 2011 

 

2. Mở một văn bản t o sẵn 

Tương tự như Word 2007, phím tắt mở tài liệu có sẵn là Ctrl+O. Bạn cũng có 

thể vào Microsoft Office Button (hoặc Tab File), chọn Open. 
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3. Lƣu một văn bản đã so n thảo 

Lƣu tài  iệu 

Phím tắt để lưu tài liệu là Ctrl+S (giống Word 2007). Cách khác: Nhấn 

Microsoft Office Button (hoặc Tab File), chọn Save. 

Nếu file tài liệu này trước đó chưa được lưu lần nào, bạn sẽ được yêu cầu đặt 

tên file và chọn nơi lưu. 

Để lưu tài liệu với tên khác (hay định dạng khác), bạn nhấn Microsoft Office 

Button (hoặc Tab File), chọn Save As (phím tắt F12, tương tự như Word 2007). 

Mặc định  ƣu tài  iệu d ng Word 2003 trở về trƣớc 

Mặc định, tài liệu của Word 2010 được lưu với định dạng là *.DOCX, khác với 

*.DOC mà bạn đã quen thuộc. Với định dạng này, bạn sẽ không thể nào mở 

được trên Word 2003 trở về trước nếu không cài thêm bộ chuyển đổi. Để tương 

thích khi mở trên Word 2003 mà không cài thêm chương trình, Word 2007 cho 

phép bạn lưu lại với định dạng Word 2003 (trong danh sách Save as type của 

hộp thoại Save As, bạn chọn Word 97-2003 Document). 

Muốn Word 2010 mặc định lưu với định dạng của Word 2003, bạn nhấn 

Microsoft Office Button (hoặc Tab File), chọn Word Options để mở hộp thoại 

Word Options. Trong khung bên trái, chọn Save. Tại mục Save files in this 

format, bạn chọn Word 97-2003 Document (*.doc). Nhấn OK. 
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Giảm thiểu khả năng mất dữ  iệu khi chƣơng trình bị đóng bất ngờ 

Để đề phòng trường hợp treo máy, cúp điện làm mất dữ liệu, bạn nên bật tính 

năng sao lưu tự động theo chu kỳ. Nhấn Microsoft Office Button (hoặc Tab 

File), Word Options, chọn Save 
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4. Thao tác với chuột và bàn phím 

4.1 Thao tác với chuột: 

a. Sao chép d ng văn bản   

Một trong những công cụ định dạng hữu ích nhất trong Word là Format Painter 

(nút hình cây cọ trên thanh công cụ Standard). Bạn có thể dùng nó để sao chép 

dạng từ một đoạn văn bản này đến một hoặc nhiều đoạn khác và để thực hiện 

chức năng này, dùng chuột là tiện lợi nhất.  

Đầu tiên đánh khối văn bản có dạng cần chép, bấm một lần vào nút Format 

Painter (nếu muốn dán dạng vào một đoạn văn bản khác) hoặc bấm kép nút 

(nếu muốn dán dạng vào nhiều đoạn văn bản khác). Tiếp theo, để dán dạng vào 

những đoạn văn bản nào thì chỉ cần đánh khối chúng là xong (nhấn thêm phím 

Esc để tắt chức năng này đi nếu trước đó bạn bấm kép nút Format Painter). 

b. Sao chép hoặc di chuyển dòng hoặc cột trong tab e   

Trong một table, nếu bạn muốn chép thêm hay di chuyển một hay nhiều dòng 

hoặc cột thì có thể dùng cách kéo và thả bằng chuột như sau: chọn dòng hoặc 

cột cần chép hoặc di chuyển, kéo khối đã chọn (nếu sao chép thì trước đó nhấn 

giữ phím Ctrl) đặt tại vị trí mà bạn muốn. 

c. D ng cây thƣớc để xem khoảng cách văn bản tr n trang   

Thông thường bạn dùng cây thước để định vị các dòng văn bản, đặt khoảng 

cách lề trang hay đặt các tab dừng. Nhưng nó còn một công dụng khác không 

kém phần thú vị và tiện lợi, đó là xem chính xác (thể hiện trực quan bằng số) 

khoảng cách của văn bản so với lề, cạnh trang hoặc giữa mỗi tab. Để biết 

khoảng cách mỗi phần như thế nào, bạn bấm và giữ chuột tại một vị trí nào đó 

trên thanh thước ngang, đồng thời bấm giữ tiếp nút chuột phải là sẽ thấy ngay 

khoảng cách giữa mỗi phần là bao nhiêu. 

d. Sao chép hoặc di chuyển văn bản   
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Cũng tương tự như table hay bất cứ đối tượng nào khác trong tài liệu, bạn có 

thể dùng cách kéo và thả trong việc sao chép hoặc di chuyển văn bản. Ở đây 

không cần phải nói gì thêm về phương pháp này (vì chắc hầu hết chúng ta đều 

đã biết cách làm này), nhưng chỉ lưu ý một điều là để có thể dùng được cách 

này thì tuỳ chọn Drag-and-drop text editing (menu Tools-Options-thẻ Edit) 

phải được đánh dấu. 

e.  Phóng to hoặc thu nhỏ tài  iệu   

Khi cần phóng to hoặc thu nhỏ tài liệu, thông thường bạn sẽ chọn từ nút Zoom 

trên thanh Standard, nhưng như thế cũng hơi bất tiện vì phải qua hai ba thao 

tác. Nếu chuột của bạn có 3 nút thì có thể nhanh chóng phóng to hay thu nhỏ 

tài liệu từ nút chuột giữa, bằng cách nhấn giữ phím Ctrl trong khi đẩy nút chuột 

lên (phóng to) hoặc xuống (thu nhỏ). 

f. Mở nhanh hộp tho i Tabs và Page Setup   

Khi cần chỉnh sửa chi tiết các dấu tab dừng trong đoạn văn bản, bạn sẽ phải 

nhờ đến hộp thoại Tabs, hay khi thay đổi các thiết lập trang giấy thì bạn lại 

phải dùng đến hộp thoại Page Setup. Thay vì mở các hộp thoại đó từ menu 

Format-Tabs hay menu File-Page Setup, bạn có thể nhanh chóng mở chúng 

bằng cách bấm kép bất kỳ chỗ nào trong thanh thước ngang (trong khoảng cách 

nhập văn bản, ở dưới các hàng số để mở hộp thoại Tabs hoặc trên hàng số để 

mở hộp Page Setup). 

g.  Đánh khối toàn bộ tài  iệu   

Trước khi cung cấp một dạng nào đó cho toàn bộ văn bản, điều đầu tiên mà bạn 

sẽ làm là đánh khối toàn bộ chúng và bạn có thể dùng những cách như bấm 

menu Edit-Select All hoặc nhấn Ctrl+A. Nhưng bạn hãy thử cách này xem, chỉ 

cần đưa chuột về lề trái văn bản (mũi tên trỏ chuột sẽ nghiêng về phải) và bấm 

nhanh 3 lần cũng có thể chọn toàn bộ tài liệu được đấy. 

4.2 Thao tác với bàn phím 
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Các phím thường dùng trong Winword gồm các phím:  

  

Các phím di chuyển con trỏ:  

Phím ↑: Di chuyển con trỏ lên một dòng.  

Phím ↓: Di chuyển con trỏ xuống một dòng.  

Phím →: Di chuyển con trỏ sang phải một ký tự.  

Phím ←: Di chuyển con trỏ sang trái một ký tự.  

  

Các phím xoá ký tự:  

Phím Delete: Xoá ký tự tại ví trí con trỏ (bên phải con trỏ).  

Phím Backspace: Xoá ký tự liền trái vị trí con trỏ.  

Phím Insert: Để chuyển đổi giữa chế độ chèn (Insert) và thay thế (Overwrite) 

ký tự.  

  

Các phím điều khiển:  

Phím Home: Chuyển vị trí con trỏ về đầu dòng văn bản chứa con trỏ.  

Phím End: Chuyển vị trí con trỏ về cuối dòng văn bản chứa con trỏ.  

Phím Page Up: Chuyển vị trí con trỏ lên trên một trang màn hình.  

Phím Page Down: Chuyển vị trí con trỏ xuống dưới một trang màn hình.  

Muốn về đầu văn bản: ấn đồng thời Ctrl+Home.  
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Muốn về cuối văn bản: ấn đồng thời Ctrl+End. 

Thao tác nhanh trong văn bản với các phím tắt thông d ng 

 

TT  Phím tắt  Tác d ng  

1  Ctrl+1  Giãn dòng đơn (1)  

2  Ctrl+2  Giãn dòng đôi (2)  

3  Ctrl+5  Giãn dòng 1,5  

4  Ctrl+0 (zero)  Tạo thêm độ giãn dòng đơn trước đoạn  

5  Ctrl+L  Căn dòng trái  

6  Ctrl+R  Căn dòng phải  

7  Ctrl+E  Căn dòng giữa  

8  Ctrl+J  Căn dòng chữ dàn đều 2 bên, thẳng lề  

9  Ctrl+N  Tạo file mới  

10  Ctrl+O  Mở file đã có  

11  Ctrl+S  Lưu nội dung file  
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12  Ctrl+P  In ấn file  

13  F12  Lưu tài liệu với tên khác  

14  F7  Kiểm tra lỗi chính tả tiếng Anh  

15  Ctrl+X  Cắt đoạn nội dung đã chọn (bôi đen)  

16  Ctrl+C  Sao chép đoạn nội dung đã chọn  

17  Ctrl+V  Dán tài liệu  

18  Ctrl+Z  Bỏ qua lệnh vừa làm  

19  Ctrl+Y  
Khôi phục lệnh vừa bỏ (ngược lại với 

Ctrl+Z)  

20  Ctrl+Shift+S  
Tạo Style (heading) -> Dùng mục lục 

tự động  

21  Ctrl+Shift+F  Thay đổi phông chữ  

22  Ctrl+Shift+P  Thay đổi cỡ chữ  

23  Ctrl+D  Mở hộp thoại định dạng font chữ  

24  Ctrl+B  Bật/tắt chữ đậm  
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25  Ctrl+I  Bật/tắt chữ nghiêng  

26  Ctrl+U  Bật/tắt chữ gạch chân đơn  

27  Ctrl+M  
Lùi đoạn văn bản vào 1 tab (mặc định 

1,27cm)  

28  Ctrl+Shift+M  Lùi đoạn văn bản ra lề 1 tab  

29  Ctrl+T  
Lùi những dòng không phải là dòng 

đầu của đoạn văn bản vào 1 tab  

30  Ctrl+Shift+T  
Lùi những dòng không phải là dòng 

đầu của đoạn văn bản ra lề 1 tab  

31  Ctrl+A  
Lựa chọn (bôi đen) toàn bộ nội dung 

file  

32  Ctrl+F  Tìm kiếm ký tự  

33  
Ctrl+G (hoặc 

F5)  
Nhảy đến trang số  

34  Ctrl+H  Tìm kiếm và thay thế ký tự  

35  Ctrl+K  Tạo liên kết (link)  

36  Ctrl+]  Tăng 1 cỡ chữ  
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37  Ctrl+[  Giảm 1 cỡ chữ  

38  Ctrl+W  Đóng file  

39  Ctrl+Q  
Lùi đoạn văn bản ra sát lề (khi dùng 

tab)  

40  Ctrl+Shift+>  Tăng 2 cỡ chữ  

41  Ctrl+Shift+<  Giảm 2 cỡ chữ  

42  Ctrl+F2  
Xem hình ảnh nội dung file trước khi 

in  

43  Alt+Shift+S  Bật/Tắt phân chia cửa sổ Window  

44  Ctrl+enter  Ngắt trang  

45  Ctrl+Home  Về đầu file  

46  Ctrl+End  Về cuối file  

47  Alt+Tab  Chuyển đổi cửa sổ làm việc  

48  Start+D  Chuyển ra màn hình Desktop  

49  Start+E  
Mở cửa sổInternet Explore, My 

computer  
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50  Ctrl+Alt+O  Cửa sổ MS word ở dạng Outline  

51  Ctrl+Alt+N  Cửa sổ MS word ở dạng Normal  

52  Ctrl+Alt+P  Cửa sổ MS word ở dạng Print Layout  

53  Ctrl+Alt+L  Đánh số và ký tự tự động  

54  Ctrl+Alt+F  Đánh ghi chú (Footnotes) ở chân trang  

55  Ctrl+Alt+D  
Đánh ghi chú ở ngay dưới dòng con trỏ 

ở đó  

56  Ctrl+Alt+M  

Đánh chú thích (nền là màu vàng) khi 

di chuyển chuột đến mới xuất hiện chú 

thích  

57  F4  Lặp lại lệnh vừa làm  

58  Ctrl+Alt+1  Tạo heading 1  

59  Ctrl+Alt+2  Tạo heading 2  

60  Ctrl+Alt+3  Tạo heading 3  

61  Alt+F8  Mở hộp thoại Macro  

62  Ctrl+Shift++  Bật/Tắt đánh chỉ số trên (x2)  
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63  Ctrl++  Bật/Tắt đánh chỉ số dưới (o2)  

64  
Ctrl+Space 

(dấu cách)  
Trở về định dạng font chữ mặc định  

65  Esc  Bỏ qua các hộp thoại  

66  Ctrl+Shift+A  

Chuyển đổi chữ thường thành chữ hoa 

(với chữ tiếng Việt có dấu thì không 

nên chuyển)  

67  Alt+F10  Phóng to màn hình (Zoom)  

68  Alt+F5  Thu nhỏ màn hình  

69  
Alt+Print 

Screen  

Chụp hình hộp thoại hiển thị trên màn 

hình  

70  Print Screen  Chụp toàn bộ màn hình đang hiển thị  

 

5. Chọn khối và thao tác tr n khối 

 Chọn khối 

- Cách 1  nhắp mouse từ điểm đầu đến điểm cuối của văn bản cần chọn 

- Cách 2  Nhắp mouse để đặt con trỏ text ở điểm đầu, giữ  Shift và nhắp 

mouse ở điểm cuối của đoạn văn bản cần chọn 

- Cách 3  Dùng phím Home, End và phím mũi tên trên bàn phím để di 

chuyển con trỏ text đến điểm đầu 
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Giữ phím Shift và gõ các phím mũi tên thích hợp để di chuyển con trỏ text đến 

điểm cuối của đoạn văn bản cần chọn 

 Sao chép, di chuyển  

 

Lệnh Biểu tƣợng Phím tƣơng đƣơng Ý nghĩa 

Cut  
Ctrl + X 

Chuuyển đoạn văn bản đã chọn 

vào bộ nhớ Clipboard 

Copy  Ctrl + C 
Chép đoạn văn bản đã chọn vào bộ 

nhớ Clipboard 

Paste 

 

Ctrl + V 

Dán đoạn văn bản có trong 

Clipboard vào vị trí con trỏ text 

 

- Đánh dấu chọn đoạn văn bản 

- Vào menu Edit chọn Copy hoặc Cut 

- Đặr con trỏ ở vị trí kết quả chọn Paste 

 Xóa khối 

- Chọn đoạn văn bản cần xóa. Nhấn phím Delete trên bàn phím 

Chương 2: Thực hiện định dạng văn bản  

1. Định d ng văn bản 

In đ m  

1. Chọn đoạn text mà bạn muốn in đậm, đưa con trỏ chuột vào vùng chọn cho 

đến khi xuất hiện thanh công cụ Mini.  
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2. Nhấn nút Bold (B).  

Bạn cũng có thể sử dụng phím tắt Ctrl+B.  

Lưu ý, nhấn Bold (hoặc Ctrl+B) lần nữa nếu bạn muốn bỏ in đậm.  

In nghi ng  

Thực hiện tương tự như in đậm, nhưng thay vì nhấn nút Bold thì bạn nhấn nút 

Italic (phím tắt Ctrl+I).  

G ch dƣới đo n text  

Nhấn Ctrl+U để gạch dưới đoạn text đang chọn. Nhấn Ctrl+U lần nữa để bỏ 

gạch dưới.  

Ngoài ra còn có nhiều kiểu gạch dưới khác:  

* Gạch dưới các từ, trừ khoảng trắng:  

- Chọn đoạn text bạn muốn gạch dưới.  

- Tại thẻ Home, nhóm Font, bạn nhấn nút mũi tên ở góc dưới bên phải.  

 

- Trong hộp Underline style, bạn chọn Word only. Nhấn OK.  

* Gạch đôi ở dưới từ:  

Thực hiện bước 1, 2 tương tự trên.  

Trong hộp Underline style, bạn chọn biểu tượng dòng đôi. Nhấn OK.  
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* Đường gạch dưới trang trí:  

Thực hiện bước 1, 2 tương tự trên.  

- Trong hộp Underline style, bạn chọn kiểu mình thích.  

- Để đổi màu của đường gạch dưới, nhấn chuột vào hộp Underline color và 

chọn màu mình thích. Nhấn OK.  

Đổi màu chữ  

1. Chọn đoạn text bạn muốn đổi màu, di chuyển con trỏ chuột vào vùng chọn 

để xuất hiện thanh công cụ Mini.  

2. Nhấn nút Font Color và chọn màu mình thích.  

Đổi kích cỡ chữ  

1. Chọn đoạn text, di chuyển con trỏ chuột vào để xuất hiện thanh công cụ 

Mini.  

2. Để tăng kích cỡ chữ, bạn nhấn nút Grow Font (phím tắt Ctrl+Shift+>). Để 

giảm kích cỡ chữ, nhấn nút Shrink Font (phím tắt Ctrl+Shift+<).  

Đánh dấu (High ight) đo n text  

Đánh dấu đoạn text để làm nó trông nổi bật hơn. Cách thực hiện:  

1. Tại thẻ Home, nhóm Font, bạn nhấn vào mũi tên bên cạnh nút Text 

Highlight Color .  

2. Chọn một màu dùng để tô sáng mà bạn thích (thường là màu vàng).  

3. Dùng chuột tô chọn đoạn text muốn đánh dấu.  

4. Muốn ngừng chế độ đánh dấu, bạn nhấn chuột vào mũi tên cạnh nút Text 

Highlight Color, chọn Stop Highlighting, hoặc nhấn ESC.  

Gỡ bỏ chế độ đánh dấu text  

1. Chọn đoạn text muốn gỡ bỏ chế độ đánh dấu.  
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2. Trong thẻ Home, nhóm Font, bạn nhấn chuột vào mũi tên cạnh nút Text 

Highlight Color.  

3. Chọn No Color.  

Định d ng chỉ số tr n (Superscript), chỉ số dƣới (Subscript)  

1. Chỉ số trên (Superscript); 2. Chỉ số dưới (Subscript).  

 

Chọn đoạn text cần định dạng. Trong thẻ Home, nhóm Font, bạn nhấn nút 

Superscript (phím tắt Ctrl+Shift+=) để định dạng chỉ số trên, hoặc nhấn nút 

Subscript (phím tắt Ctrl+=) để định dạng chỉ số dưới.  

CANH CHỈNH VĂN BẢN  

Canh trái, phải, giữa, hoặc canh đều hai bên  

1. Chọn đoạn văn bản bạn muốn canh chỉnh.  

2. Trong thẻ Home, nhóm Paragraph, nhấn nút Align Left để canh lề trái, nhấn 

Align Right để canh phải, nhấn nút Center để canh giữa (giữa 2 lề trái và phải), 

hay nhấn nút Justify để canh đều hai bên.  

Canh chỉnh nhiều chế độ tr n c ng 1 dòng  

1. Chuyển chế độ xem văn bản là Print Layout hoặc Web Layout (Trong thẻ 

View, nhóm Document Views, chọn nút Print Layout hoặc Web Layout).  

2. Nhấn chuột vào dòng mới và thực hiện như sau:  

- Chèn đoạn text canh trái: Di chuyển con trỏ chuột chữ I sang trái cho đến vị 

trí cần gõ text, nhấn đúp chuột và gõ vào đoạn text.  
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- Chèn đoạn text canh giữa: Di chuyển con trỏ chuột chữ I vào khoảng giữa 

dòng cho đến vị trí cần gõ text. Nhấn đúp chuột và gõ vào đoạn text.  

- Chèn đoạn text canh phải: Di chuyển con trỏ chuột chữ I sang phải cho đến vị 

trí cần gõ text, nhấn đúp chuột và gõ vào đoạn text.  

Thay đổi các canh chỉnh theo chiều dọc đo n text  

1. Trong thẻ Page Layout, nhóm Page Setup, nhấn chuột vào nút mũi tên ở góc 

dưới bên phải.  

2. Trong hộp thoại Page Setup, nhấn vào thẻ Layout. Tại mục Vertical 

alignment, bạn chọn một loại canh chỉnh mình thích (Top, Center, Justified, 

Bottom).  
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3. Tại mục Apply to, bạn chọn phạm vi áp dụng là Whole document (toàn văn 

bản), This section (vùng hiện tại), hay This point forward (kể từ đây trở về 

sau). Nhấn OK.  

Canh giữa  ề tr n và  ề dƣới  

1. Chọn đoạn văn bản bạn muốn canh giữa so với lề trên và lề dưới.  

2. Trong thẻ Page Layout, nhóm Page Setup, nhấn chuột vào nút mũi tên ở góc 

dưới bên phải.  

3. Trong hộp thoại Page Setup, nhấn vào thẻ Layout. Tại mục Vertical 

alignment, bạn chọn Center.  
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4. Tại mục Apply to, chọn Selected text. Nhấn OK.  

Th t  ề dòng đầu ti n của đo n  

1. Nhấn chuột vào đoạn mà bạn muốn thụt lề dòng đầu tiên.  

2. Trong thẻ Page Layout, nhấn vào nút mũi tên góc dưới bên phải của nhóm 

Paragraph.  

3. Ở hộp thoại Paragraph, chọn thẻ Indents and Spacing. Tại mục Special, bạn 

chọn First line. Tại mục By, chọn khoảng cách thụt vào. Nhấn OK.  

Điều chỉnh khoảng cách th t  ề của toàn bộ đo n  

1. Chọn đoạn văn bản muốn điều chỉnh.  

2. Tại thẻ Page Layout, nhóm Paragraph, nhấn chuột vào mũi tên lên, xuống 

bên cạnh mục Left để tăng, giảm khoảng cách thụt lề trái, hay tại mục Right để 

điều chỉnh thụt lề phải.  

Th t dòng tất cả, trừ dòng đầu ti n của đo n  

1. Chọn đoạn văn bản mà bạn muốn điều chỉnh.  

2. Trên thanh thước ngang, hãy nhấn chuột vào dấu Hanging Indent và rê đến 

vị trí bạn muốn bắt đầu thụt dòng.  

Nếu bạn không thấy thanh thước ngang đâu cả, hãy nhấn nút View Ruler ở 

phía trên của thanh cuộn dọc để hiển thị nó.  

T o một th t âm  

Thay vì thụt dòng vào trong, bạn có thể điều chỉnh thụt ra ngoài so với lề trái 

bằng cách: 

1. Chọn đoạn văn bản mà bạn muốn mở rộng sang trái.  

2. Tại thẻ Page Layout, nhóm Paragraph, nhấn nút mũi tên hướng xuống trong 

mục Left cho đến khi đoạn văn bản nằm ở vị trí bạn vừa ý.  

THAY ĐỔI KHOẢNG CÁCH TRONG VĂN BẢN 
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T o khoảng cách đôi giữa các dòng cho toàn bộ tài  iệu  

Khoảng cách mặc định giữa các dòng cho bất kỳ tài liệu trống nào là 1.15. Bạn 

có thể tạo khoảng cách đôi (2) nếu muốn bằng cách sau:  

1. Trong thẻ Home, nhóm Styles, nhấn chuột phải vào nút Normal, chọn 

Modify.  

 

2. Bên dưới nhóm Formatting, nhấn nút Double Space. Nhấn OK.  

Thay đổi khoảng cách dòng cho đo n văn bản đang chọn  

1. Chọn đoạn văn bản muốn thay đổi.  

2. Trong thẻ Home, nhóm Paragraph, nhấn nút Line Spacing.  

3. Chọn khoảng cách bạn muốn, chẳng hạn 2.0  

Ghi chú: Nếu muốn đặt nhiều khoảng cách giữa các dòng nhưng khoảng cách 

này không có trong menu xuất hiện khi nhấn nút Line Spacing, bạn hãy chọn 

Line Spacing Options, và nhập vào khoảng cách mà bạn thích.  

Các kiểu khoảng cách dòng mà Word hỗ trợ:  

- Single (dòng đơn). Tùy chọn này hỗ trợ font lớn nhất trong dòng đó, thêm vào 

một lượng khoảng trống nhỏ bổ sung. Lượng khoảng trống bổ sung tùy thuộc 

vào font chữ mà bạn đang sử dụng.  

- 1.5 lines: Gấp 1,5 lần khoảng cách dòng đơn.  

- Double: Gấp 2 lần khoảng cách dòng đơn.  
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- At least: Lựa chọn này xác lập khoảng cách dòng tối thiểu cần thiết để phù 

hợp với font hoặc đồ họa lớn nhất trên dòng.  

- Exactly: Cố định khoảng cách dòng và Word sẽ không điều chỉnh nếu sau đó 

bạn tăng hoặc giảm cỡ chữ.  

- Multiple: Xác lập khoảng cách dòng tăng hoặc giảm theo tỉ lệ % so với dòng 

đơn mà bạn chỉ định. Ví dụ, nhập vào 1.2 có nghĩa là khoảng cách dòng sẽ tăng 

lên 20% so với dòng đơn.  

Thay đổi khoảng cách trƣớc hoặc sau các đo n  

1. Chọn đoạn văn bản bạn muốn thay đổi khoảng cách trước hoặc sau nó.  

2. Trong thẻ Page Layout, nhóm Paragraph, bạn nhấn chuột vào mũi tên cạnh 

mục Before (trước) hoặc After (sau) để thay đổi bằng giá trị bạn muốn.  

Thay đổi khoảng cách giữa các ký tự  

1. Chọn đoạn văn bản mà bạn muốn thay đổi.  

2. Trong thẻ Home, nhấn chuột vào nút mũi tên ở góc dưới phải của nhóm Font 

để mở hộp thoại Font.  

3. Nhấn chọn thẻ Character Spacing ở hộp thoại này. Trong mục Spacing, nhấn 

Expanded để mở rộng hay Condensed để thu hẹp khoảng cách và chỉ định số 

khoảng cách trong mục By.  

 

Co dãn văn bản theo chiều ngang  
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1. Chọn đoạn văn bản bạn muốn căng ra hoặc thu lại.  

2. Trong thẻ Home, nhấn chuột vào nút mũi tên ở góc dưới phải của nhóm Font 

để mở hộp thoại Font.  

3. Nhấn chọn thẻ Character Spacing ở hộp thoại này. Tại mục Scale, nhập vào 

tỉ lệ % mà bạn muốn. Nếu tỉ lệ này lớn hơn 100% thì đoạn văn bản sẽ được kéo 

ra, ngược lại, nó sẽ được thu lại.  

Đánh dấu sự thay đổi và ghi chú trong tài  iệu  

Theo dõi sự thay đổi trong khi chỉnh sửa  

1. Mở tài liệu mà bạn muốn theo dõi.  

2. Trong thẻ Review, nhóm Tracking, nhấn nút Track Changes.  

3. Thay đổi tài liệu theo ý bạn (chèn, xóa, di chuyển hay định dạng văn bản...). 

Lập tức ở bên hông trang tài liệu sẽ xuất hiện những bong bóng hiển thị sự thay 

đổi này.  

Tắt chế độ theo dõi sự thay đổi  

Trong thẻ Review, nhóm Tracking, nhấn vào nút Track Changes một lần nữa 

để tắt chế độ theo dõi trong khi chỉnh sửa.  

Thay đổi cách Word đánh dấu  

- Bạn có thể đổi màu và những định dạng mà Word dùng để đánh dấu sự đổi 

trong tài liệu bằng cách nhấn vào mũi tên bên cạnh nút Track Changes, và nhấn 

chọn mục Change Tracking Options.  
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- Nếu bạn muốn xem tất cả những thay đổi ngay trong tài liệu thay vì hiển thị 

những bong bóng bên hông tài liệu, ở nhóm Tracking, nhấn vào nút Ballons, 

sau đó chọn Show all revisions inline.  

- Để làm nổi bật vùng hiển thị những bong bóng (bên lề tài liệu), hãy nhấn nút 

Show Markup và chọn Markup Area Highlight.  

2. Định d ng cột, tab, Numbering 

a. Định d ng cột  

Cách thứ nhất  gõ văn bản trước, chia cột sau: 

- Bước 1: bạn nhập văn bản một cách bình thường, hết đoạn nào thì nhấn 

Enter để xuống hàng. Sau khi đã gõ hết nội dung văn bản, bạn hãy nhấn 

Enter để con trỏ xuống hàng tạo một khoảng trắng. 

- Bước 2: tô khối nội dung cần chọn (không tô khối dòng trắng ở trên), tại 

thẻ Page Layput, nhóm Page Setup bạn chọn các mẫu cột do Word mặc 

nhiên ấn định. 
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Nhấn vào More Columns hiển thị hộp thoại; 

 

- Presets  : các mẫu chia cột 

- One – Two – Three : Các cột có độ rộng bằng nhau 

- Left – Right : Các cột có độ rộng khác nhau 

- Number of Columns : Số cột (nếu muốn số cột chữ >3) 

- Line Between : Đường kẻ giữa các cột 

- Width and Spacing : Điều chỉnh độ rộng và khoảng cách  

- Equal column width :Các cột có độ rộng cột bằng nhau nếu nhắp 

chọn vào ô vuông phía trước 

Cách thứ hai  chia cột trước, gõ văn bản sau (dùng trong trường hợp toàn 

bộ văn bản được chia theo dạng cột báo). 

- Tại thẻ Page Layput, nhóm Page Setup bạn chọn các mẫu cột do Word 

mặc nhiên ấn định - Nhập văn bản vào. 
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- Tại thẻ Page Layput, nhóm Page Setup bạn chọnBreaks, Column Break: 

để ngắt cột khi bạn muốn sang các cột còn lại. 

 

b. Cài đặt điểm dừng tab (Tab stops)  

Để cho việc cài đặt tab được thuận tiện, bạn nên cho hiển thị thước ngang trên 

đỉnh tài liệu bằng cách nhấn nút View Ruler ở đầu trên thanh cuộn dọc.  
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Bạn có thể nhanh chóng chọn tab bằng cách lần lượt nhấn vào ô tab selector – 

là ô giao nhau giữa thước dọc và thước ngang (ở góc trên bên trái trang tài liệu) 

cho đến khi chọn được kiểu tab mong muốn, sau đó nhấn chuột vào thanh 

thước ngang nơi bạn muốn đặt tab.  

Tùy từng trường hợp cụ thể mà bạn có thể sử dụng một trong các loại tab sau:  

 Tab trái:  Đặt vị trí bắt đầu của đoạn text mà từ đó sẽ chạy sang phải 

khi bạn nhập liệu.  

 Tab giữa:  Đặt vị trí chính giữa đoạn text. Đoạn text sẽ nằm giữa vị 

trí đặt tab khi bạn nhập liệu.  

 Tab phải:  Nằ m ở bên phải cuối đoạn text. Khi bạn nhập liệu, đoạn 

text sẽ di chuyển sang trái kể từ vị trí đặt tab.  

 Tab thập phân:  Khi đặt tab này, những dấu chấm phân cách phần 

thập phân sẽ nằm trên cùng một vị trí.  

 Bar Tab:  Loại tab này không định vị trí cho text. Nó sẽ chèn một 

thanh thẳng đứng tại vị trí đặt tab.  
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- Default tab stops: Khoảng cách dừng của default tab, thông thường là 

0.5” 

- Tab stop position: gõ tọa độ điểm dừng Tab 

- Alignment chọn một loại tab là Left – Center – Right – Decimal – Bar 

(loại tab chỉ có tác dụng tạo một đuờng kẻ dọc ở một tọa độ đã định) 

- Leader chọn cách thể hiện tab 

o 1 None Tab tạo ra khoảng trắng 

o 2-3-4 Tab tạo ra là các dấu chấm, dấu gạch hoặc gạch liền nét 

- Các nút lệnh: 

o Set : Đặt điểm dừng tab, tọa độ đã gõ được đưa vào danh sách 

o Clear : xóa tọa độ đã chọn 

o Clear all : xóa tất cả tọa độ điểm dừng tab đã đặt 

Nếu bạn muốn đặt điểm dừng tab tại vị trí phù hợp mà không thể xác định 

chính xác khi nhấn chuột lên thanh thước ngang, hoặc bạn muốn chèn ký tự 
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đặc biệt trước tab, bạn có thể dùng hộp thoại Tabs bằng cách nhấn đúp chuột 

vào bất kỳ điểm dừng tab nào trên thanh thước.  

Sau khi cài đặt điểm dừng tab xong, bạn có thể nhấn phím Tab để nhảy đến 

từng điểm dừng trong tài liệu.  

c. Numbering 

Số thứ tự tự động cho phép b n định d ng và tổ chức văn bản với các số, 

các bu  et (dấu chấm tròn). 

 

Bulleted and Numbered 

Các danh sách Bullet có các dấu chấn tròn, danh sách các Number có các số 

và danh sách các Ountline là sự phối hợp giữa các số và các chữ cái phụ thuộc 
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vào sự tổ chức của danh sách. 

Để thêm một thứ tự tự động vào văn bản có sẵn: 

• Lựa chọn văn bản bạn muốn để tạo một thứ tự tự động 

• Trong nhóm Paragraph trên tab Home, kích vào nút danh sách Bulleted 

hoặc Numbered 

 

Để tạo một thứ tự tự động mới: 

• Đặt con trỏ vào nơi bạn muốn chèn thứ tự tự động trong tài liệu 

• Chọn nút danh sách Bulleted hoặc Numbered 

• Rồi nhập nội dung bình thường 

Số thứ tự tự động  ồng 

Số thứ tự tự động lồng là danh sách có một vài cấp độ. Để tạo một thứ tự tự 

động lồng: 

• Tạo thứ tự tự động của bạn theo sự hướng dẫn phía trên 

• Chọn nút Increase Indent hay Decrease Indent 

 

Định d ng danh sách thứ tự tự động 
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Hình ảnh chấm tròn và số có thể được thay đổi bằng cách sử dụng hộp thoại 

Bullets or Numbering. 

• Lựa chọn toàn bộ thứ tự tự động để thay đổi tất cả các dấu chấm tròn hay số, 

hoặc đặt con trỏ lên một dòng trong danh sách thứ tự tự động để thay đổi một 

Bullet 

• Chọn phải chuột 

• Chọn vào mũi tên bên cạnh danh sách Bulleter hay Numbered và chọn một 

Bullet hay Numbering khác. 

 

 

3. Drop Cap 

T o một chữ hoa th t cấp (Dropped Cap)  

Microsoft Word có tính năng tạo chữ nhấn mạnh gọi là Drop Cap. Đó là chữ 

cái đầu câu được phóng to và thả xuống. Kiểu trình bày văn bản này có tính mỹ 

thuật cao. 

Nhấp chuột lên tab Insert trên thanh Ribbon và chọn lệnh Drop Cap trong 
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nhóm Text. Khi bạn nhấn lên nút lệnh Drop Cap, một menu xổ xuống xuất 

hiện. Bạn nhấn lên dòng Dropped lập tức mẫu tự đầu tiên của dòng đầu tiên 

trên văn bản sẽ được nhấn mạnh. 

 

Có 2 chế độ:  

1. Dropped cap.  

2. In-margin dropped cap.  

Để có thể tùy biến chữ cái nhấn mạnh này, bạn nhấn chuột lên lệnh Drop Cap 

Options… trên menu của Drop Cap. Trên hộp thoại Drop Cap, bạn có thể 

chọn vị trí của chữ nhấn mạnh, font chữ, số dòng thả xuống và khoảng cách từ 

chữ nhấn mạnh tới cụm text. Nhấn OK để hoàn tất. 
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. 

Sau này, nếu không muốn nhấn mạnh kiểu Drop Cap nữa, bạn chỉ việc vào lại 

màn hình Drop Cap và chọn lệnh None là xong. 

4. Watermark (nền bảo vệ văn bản) 

Hình mờ  

Một hình mờ là một ảnh trong suốt mà xuất hiện ngay sau văn bản trong tài 

liệu. Để chèn một hình mờ: 

• Chọn tab Page Layout trên vùng Ribbon 

• Chọn nút Watermark trong nhóm Page Background 

• Kích chọn Watermark bạn muốn hoặc Chọn Custom Watermark và tạo một 

hình mờ riêng. 

• Để bỏ một hình mờ, thực hiện các bước như trên nhưng chọn Remove 

Watermark.  
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5. T o ti u đề tr n và dƣới (Header and Footer) cho văn bản  

Tại thẻ Insert, nhóm Header & Footer, bạn nhấn chuột vào nút Header hay 

Footer. 
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Một menu xổ xuống với các Header, Footer mẫu cho bạn chọn. Kế đến bạn 

nhập nội dung cho Header hay Footer đó. Nhập xong nhấn đúp chuột vào vùng 

nội dung của trang, lập tức Header/ Footer sẽ được áp dụng cho toàn bộ trang 

của tài liệu. 

Thay đổi Header / Footer cũ bằng Header / Footer mới  

Tại thẻ Insert, nhóm Header & Footer, bạn nhấn chuột vào nút Header hay 

Footer. Sau đó chọn lại một Header / Footer mới để thay cho Header / Footer 

hiện tại.  

Không s  d ng Header / Footer cho trang đầu ti n  
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Tại thẻ Page Layout, bạn nhấn chuột vào nút góc dưới phải của nhóm Page 

Setup để mở hộp thoại Page Setup. Kế đến mở thẻ Layout ra. Đánh dấu kiểm 

mục Different first page bên dưới mục Headers and footers. Nhấn OK.  

 

Vậy là Header / Footer đã được loại bỏ khỏi trang đầu tiên của tài liệu.  

Trong Word 2003, bạn cũng có thể loại bỏ Header / Footer cho trang đầu tiên 

bằng cách vào menu File – Page Setup > chọn thẻ Layout > đánh dấu check 

Different first page > OK.  

Áp d ng Header / Footer khác nhau cho trang chẵn và trang  ẻ  
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Tại thẻ Page Layout, bạn nhấn chuột vào nút góc dưới phải của nhóm Page 

Setup để mở hộp thoại Page Setup. Kế đến mở thẻ Layout ra. Đánh dấu kiểm 

mục Different odd and even bên dưới mục Headers and footers. Nhấn OK.  

Bây giờ bạn có thể chèn Header / Footer cho các trang chẵn trên một trang 

chẵn bất kỳ, chèn Header / Footer cho các trang lẻ trên một trang lẻ bất kỳ.  

Trong Word 2003, bạn cũng có thể thực hiện tương tự bằng cách vào menu 

File – Page Setup > chọn thẻ Layout > đánh dấu check Different odd and even 

> OK.  

 

Thay đổi nội dung của Header / Footer  
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Tại thẻ Insert, nhóm Header & Footer, bạn nhấn chuột vào nút Header hay 

Footer. Kế đến chọn Edit Header / Edit Footer trong menu xổ xuống để chỉnh 

sửa nội dung của Header / Footer. Trong khi chỉnh sửa bạn có thể định dạng lại 

font chữ, kiểu chữ, màu sắc... cho tiêu đề Header / Footer bằng cách chọn chữ 

và sử dụng thanh công cụ Mini xuất hiện bên cạnh.  

Chỉnh sửa xong bạn nhấn đúp chuột ra ngoài vùng nội dung của trang tài liệu.  

Xóa Header / Footer  

Tại thẻ Insert, nhóm Header & Footer, bạn nhấn chuột vào nút Header hay 

Footer. Kế đến chọn Remove Header / Remove Footer trong danh sách xổ 

xuống.  

 

T o Header / Footer khác nhau cho các v ng khác nhau của tài  iệu  

- Trước tiên, bạn cần tạo các ngắt vùng để phân chia các vùng trong tài liệu. 

Nhấn chuột vào vị trí muốn đặt một vùng mới. Trong thẻ Page Layout, nhóm 

Page Setup, nhấn nút Breaks và chọn một kiểu ngắt vùng phù hợp trong 

Section Breaks, ví dụ Continuous (chúng ta sẽ tìm hiểu kỹ hơn về ngắt trang / 

ngắt vùng ở những bài viết sau).  
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- Tại thẻ Insert, nhóm Header & Footer, bạn nhấn chuột vào nút Header hay 

Footer. Kế đến chọn Edit Header / Edit Footer để chỉnh sửa nội dung cho 

Header / Footer.  

- Trên thẻ Header & Footer, nhóm Navigation, nếu thấy nút Link to Previous 

đang sáng thì nhấn vào nút này một lần nữa để ngắt kết nối giữa Header / 

Footer trong vùng mới này với vùng trước đó. Bạn sẽ thấy mục Same as 

Previous ở góc trên bên phải của Header / Footer biến mất.  

- Sau đó bạn chỉnh sửa Header / Footer cho vùng mới này và yên tâm rằng 

những Header / Footer của các vùng trước đó không bị thay đổi theo.  

6. Đánh số thứ tự cho trang văn bản 

Chèn số trang vào văn bản  
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Số trang này sẽ được đưa vào Header hay Footer tùy ý bạn. Để thực hiện, bạn 

chọn thẻ Insert, tại nhóm Header & Footer, bạn nhấn nút Page Number. Trong 

menu xuất hiện, bạn trỏ tới Top of Page (chèn số trang vào phần Header) hoặc 

Bottom of Page (chèn vào Footer). Word 2010cung cấp sẵn khá nhiều mẫu 

đánh số trang và bạn chỉ việc chọn một trong các mẫu này là xong.  

  

Thay đổi d ng số trang   

Bạn có thể thay đổi dạng số trang theo ý thích của mình mà định dạng chuẩn 

không có sẵn. Để thực hiện, bạn nhấn đúp vào Header hay Footer, nơi bạn đã 

đặt số trang. Tại thẻ Design, nhóm Header & Footer, bạn nhấn nút Page 

Number, chọn tiếp Format Page Numbers.  
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Number format: Chọn dạng số thứ tự 

Include Chapter Number: Số trang sẽ được kèm với số chương 

Continue From Previous Section: Số trang nối tiếp với section trước đó 

Start at : Số trang được bắt đầu từ số 

Trong hộp thoại Page Number, tại mục Number format, bạn hãy chọn một kiểu 

đánh số mình thích, sau đó nhấn OK. 

Thay đổi kiểu chữ, cỡ chữ, màu sắc của số trang  

Nhấn đúp chuột vào Header hay Footer, nơi bạn đã đặt số trang tại đó.  

Dùng chuột chọn số trang. Tại thanh công cụ mini vừa xuất hiện ở bên trên, 

bạn có thể chọn lại font chữ, cỡ chữ, định dạng lại chữ đậm, nghiêng, hay chọn 

màu tùy thích. Khi hiệu chỉnh xong bạn nhấn đúp chuột vào vùng nội dung 

chính của tài liệu.  

Bắt đầu đánh số trang bằng một số khác  

Bạn có thể bắt đầu đánh số trang bằng một con số khác, thay vì 1 như mặc 

định. Cách thực hiện: Tại thẻ Insert, nhóm Header & Footer, bạn nhấn nút Page 

Number, chọn Format Page Numbers. Trong hộp thoại xuất hiện, bạn chọn 

Start at và nhập vào con số bắt đầu khi đánh số trang. Nhấn OK.  
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Ghi chú: Nếu tài liệu của bạn có trang bìa và bạn muốn trang đầu tiên sau đó 

được bắt đầu bằng 1, tại ô Start at, bạn hãy gõ vào 0.  

Xóa số trang đã đánh  

Tại thẻ Insert, nhóm Header & Footer, bạn nhấn nút Page Number, sau đó chọn 

Remove Page Numbers ở cuối menu.  

Xóa số trang ở trang đầu ti n của tài  iệu  

Trong tài liệu, thường trang đầu tiên không được đánh số vì nó là trang bìa. Áp 

dụng phần ghi chú ở thủ thuật “Bắt đầu đánh số trang bằng một số khác” bên 

trên, trang bìa vẫn được đánh số là 0. Vì vậy bạn hãy thực hiện thêm bước sau 

để xóa hẳn số trang ở trang đầu tiên của tài liệu.  

- Nhấn chuột vào bất kỳ vùng nào của tài liệu 

- Tại thẻ Page Layout, bạn nhấn chuột vào ô vuông góc dưới bên phải của 

nhóm Page Setup để mở hộp thoại Page Setup ra.  

- Nhấn chuột vào thẻ Layout trong hộp thoại, bên dưới Headers and footers, 

bạn đánh dấu chọn vào hộp kiểm Different first page. Nhấn OK.  

Bây giờ bạn hãy kiểm tra lại xem, có đúng là trang đầu tiên không có số trang, 

sau đó trang kế được đánh số 1 không nhé.  

7. Định d ng trang văn bản 

Chỉnh s a  ề trang và định hƣớng trang 

Lề trang có thể được chỉnh sửa qua các bước sau: 

• Chọn tab Page Layout trên nhóm Ribbon 

• Trên nhóm Page Setup, kích chọn Margins 

• Chọn Default Margin, hoặc 

• Chọn vào Custom Margins và hoàn thành hộp thoại. 
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Để thay đổi hướng, kích thước hay cột của trang:  

• Chọn tab Page Layout trên nhóm Ribbon 

• Trong nhóm Page Setup, Chọn Orientation, Size hay Columns 

• Chọn kiểu thích hợp. 
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Áp d ng đƣờng viền trang và màu sắc  

Đế áp dụng đường viền trang hay màu sắc: 

• Chọn tab Page Layout trên nhóm Ribbon. 

• Trong nhóm Page Background, Chọn Page Colors và lựa chọn màu muốn 

áp dụng cho trang hoặc Page Borders và chọn đường viền thích hợp cho trang. 

 

T o một ngắt trang 

Để chèn một ngắt trang: 

• Chọn tab Page Layout trên nhóm Ribbon 

• Trong nhóm Page Setup, Chọn menu Breaks. 

• Chọn Page Break. 
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Chèn một Trang bìa  

Để chèn một trang bìa: 

• Chọn tab Insert trên nhóm Ribbon 

• Chọn nút Cover Page trên nhóm Pages. 

• Chọn một kiểu trang bìa. 
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Chèn một trang trống  

Để chèn một trang trống: 

• Chọn tab Insert trên nhóm Ribbon. 

• Chọn nút Blank Page trên nhóm Page. 
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Chương 3: Thực hiện chèn các đối tượng 

1. Chèn các kí tự đặc biệt 

Các ký hiệu và ký tự đặc biệt 

Các ký tự đặc biệt như hệ thống chấm câu, cách khoảng, hoặc các ký tự đồ họa 

mà không có sẵn trên bàn phím. Để chèn các ký hiệu và các ký tự đặc biệt: 

• Đặt con trỏ vào nơi bạn muốn chèn ký hiệu 

• Chọn tab Insert trên vùng Ribbon 

• Chọn nút Symbol trên nhóm Symbols 

• Chọn ký hiệu phù hợp. 

 

 

2. Chèn C ipArt và hình ảnh 

Word 2010cũng cho phép bạn chèn các minh họa và hình ảnh vào tài liệu. Để 

chèn các minh họa: 

• Đặt con trỏ vào nơi bạn muốn chèn hình minh họa hay hình ảnh 

• Chọn tab Insert trên vùng Ribbon 
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• Chọn nút Clip Art 

• Hộp thoại xuất hiện và bạn có thể tìm hình mẫu 

• Chọn hình minh họa bạn muốn chèn 

 

 

3. Chèn và hiệu chỉnh hình v  

Để chèn một hình ảnh:  

• Đặt con trỏ vào nơi bạn muốn chèn 

• Chọn tab Insert trên vùng Ribbon 

• Chọn nút Picture 

• Duyệt qua hình ảnh bạn muốn chèn và chọn ảnh. 

• Chọn Insert 

 

Kích thƣớc đồ họa (hình ảnh) 

Tất cả hình vẽ có thể tăng hay giảm kích thước bằng cách kích vào ảnh và kích 

vào một góc của ảnh rồi kéo để tăng hay giảm kích thước ảnh cho phù hợp. 
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4. Chèn và hiệu chỉnh  ƣu đồ 

Smart Art là tập hợp các loại đồ họa bạn có thể sử dụng để tổ chức thông tin 

trong tài liệu. Để chèn SmartArt:  

• Đặt con trỏ vào nơi bạn muốn chèn minh họa hay hình ảnh 

• Chọn tab Insert trên vùng Ribbon 

• Chọn nút SmartArt 

• Chọn vào SmartArt bạn muốn  

• Chọn mũi tên phía bên trái để chèn văn bản hoặc gõ văn bản trong đồ họa.  
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Để hiệu chỉnh SmartArt, chọn Tab Design và các nhóm liên quan: 

 

 

 

5. V  và hiệu chỉnh biểu đồ  

Biểu đồ là một dạng thể hiện bằng hình ảnh các số liệu của một bảng tính. Biểu 

đồ được hình thành bởi trục tung và trục hoành. Trục hoành thể hiện loại dữ 
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liệu dùng để so sánh. Trục tung thể hiện số lượng hay đơn vị đo lường dữ liêu 

dùng để so sánh 

Tại thẻ Insert, nhóm Illustrator, bạn nhấn vào Chart  

 

Xuất hiện cửa sổ chọn kiểu biêu đồ 

 

Chọn một kiểu biểu đồ và nhập hoặc sửa nội dung bảng dữ liệu trực tiếp trên 

bảng dữ liệu Data Sheet của màn hình Excel.  
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Đóng chương trình Excel, biểu đồ lưu lại trên màn hình Word 

 

a.  Thay đổi   i kiểu biểu đồ  

Chọn biểu đồ, trên Tab Design chọn nhóm Type, Change Chart Type. 
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- Hãy lựa chọn loại biểu đồ theo danh sách Chart type và chọn hình biểu đồ 

bên ô Chart sub-type.  

- Chọn nút Set as default chart nếu muốn để kiểu biểu đồ đã chọn sẽ được dùng 

cho những lần vẽ biểu đồ sau. 

Nhấn nút OK để hoàn thành việc thay đổi kiểu biểu đồ  

Chỉnh s a nội dung hiển thị tr n biểu đồ  

-  Chọn biểu đồ chỉnh sửa biểu đồ, Tab Layout  

 

Có thể chỉnh s a nội dung trong nhóm Labe s và nhóm Axes. 

Labels: 

- Chart title: Tên biểu đồ  

- Axis title: Tiêu đề trục 

- Legend: Chú giải 

- Data Labels: Hiển thị dữ liệu và các nhãn giá trị 

- Data Labels: Hiển thị dữ liệu và các nhãn giá trị 

Axes: 

- Axes: chỉnh sửa, hiển thị dữ liệu trên trục tọa độ 

- Gridlines: Thay đổi đường kẻ mặt đáy biểu đồ 

-  Quay & hiển thị biểu đồ theo hình ảnh 3-D  
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Chọn biểu đồ chỉnh sửa biểu đồ, Tab Layout, nhóm Background chọn 3-D 

Rotation  

 

Xuất hiện hộp thoại Fỏmat Chart Area:  

 

- Rotation: Quay biểu đồ theo chiều dọc, chiều ngang….  

- Perspective: Phối cảnh xa.  

Bạn có thể sử dụng các nút chức năng quay biểu đồ phù hợp.  
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6. L p và hiệu chỉnh biểu thức toán học 

Công c  toán học  

Word 2010 cho phép bạn chèn các công thức toán học. Để xem công cụ toán 

học: 

• Đặt con trỏ vào nơi bạn muốn chèn công thức toán học 

• Chọn tab Insert trên vùng Ribbon 

• Chọn nút Equation trên nhóm Symbols 

• Chọn công thức toán học phù hợp hoặc Chọn Insert New Equation 
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• Để chỉnh sửa công thức toán học: Kích chọn công thức và tab Design sẽ xuất 

hiện trên vùng Ribbon 

 

 

Chương 4: Thao tác với bảng biểu 
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1. Thao tác t o bản và hiệu chỉnh bảng 

T o bảng 

Để tạo một bảng: 

• Đặt con trỏ vào trang nơi bạn muốn tạo bảng 

• Chọn tab Insert trên vùng Ribbon. 

• Chọn vào nút Tables trên nhóm Tables. Bạn có thể tạo một bảng theo một 

trong 4 cách sau:  

 

 

- Đánh dấu số dòng và cột  

- Chọn Insert Table và nhập số dòng và cột 

- Chọn vào Draw Table, tạo bảng bằng cách kích và nhập số dòng và cột 

- Chọn Quick Tables và chọn bảng. 
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Nh p dữ  iệu trong một bảng  

Đặt con trỏ vào ô bạn muốn nhập thông tin. Và bắt đầu nhập 

Chỉnh s a cấu trúc bảng và định d ng bảng 

Để chỉnh sửa cấu trúc của bảng: 

• Chọn vào bảng và bạn sẽ thấy có hai tab mới trên vùng Ribbon là: Design và 

Layout. Hai tab này dùng để thiết kế và bố trí bảng. 
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Trên tab Design, bạn có thể chọn:  

• Table Style Options  

 

• Draw Borders  

 

 

Để định dạng bảng, Chọn vào bảng và chọn tab Layout. Tab Layout này cho 

phép bạn thực hiện:  

 

 

• Xem Gridlines và Các thuộc tính (có trên nhóm Table).  

• Chèn dòng và cột (có trên nhóm Row & Columns). 

• Xóa bảng, Dòng và cột (nhóm Rows & Columns). 

• Trộn hoặc tách các ô (có trên nhóm Merge). 
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• Tăng và giảm kích thước ô (có trong nhóm Cell Size). 

• Canh lề văn bản trong các ô và thay đổi hướng văn bản (nhóm Alignment). 

2. Định d ng đƣờng viền và nền cho bảng 

a. Định d ng đƣờng viền cho bảng 

Tạo đường viền cho Tables ta làm các bước sau:  

- Tô khối cả bảng và chọn Tables Tools.  

- Chọn tiếp Design, nhấn vào nút Border chọn All Borders  

 

- Chọn các kiểu đường viền và nhấp OK 

b. Tô nền cho bảng 

Phối hợp màu sắc để tạo nền cho Tables. Bạn có thể thực hiện theo các bước 
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sau:  

-  Chọn các ô cần tô màu, sau đó nhấn vào Tables Tools chọn Design.  

-  Chọn tiếp mục Shading và chọn màu nền cho ô đó.  

 

Bạn có thể phối hợp các màu để cho Tables của bạn ấn tượng hơn 

3. Chèn công thức toán học vào bảng 

Ngƣời d ng vẫn nghĩ công c  Tab e của Word đơn giản chỉ  à trình bày dữ 

 iệu d ng bảng với dòng và cột nhƣng thực tế, tuy không thể so sánh đƣợc 

với Exce  về mặt tính toán, song Word cũng cho phép ngƣời d ng có thể 

thực hiện đƣợc một số phép tính cộng, trừ, nhân, chia để hỗ trợ hơn cho 

ngƣời d ng. 

Cũng có thể người dùng cho rằng tính toán trong Word còn chậm hơn là tính 

bằng tay rồi điền kết quả vào. Tuy nhiên, điểm lợi thế hơn hẳn khi tính toán 

luôn trong Table của Word là việc khi chỉnh sửa dữ liệu thì máy có khả năng 

cập nhật kết quả, còn nếu tính bằng tay thì lại phải tính lại và điền lại. Lúc đó 

thì tính toán bằng tay lại chậm hơn. 
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Bảng 1. Bảng dữ liệu cần tính toán  

Lấy ví dụ cụ thể như ở bảng 1. Để thực hiện bảng dữ liệu trên, người dùng thực 

hiện qua ba bước: nhập dữ liệu, tính toán và định dạng. 

Bƣớc 1. Nhập dữ liệu tất cả các cột, trừ cột Thành tiền 

Bƣớc 2. Tính Thành tiền = Số lượng + Đơn giá: 

 

Hộp thoại Formula  

- Kích chuột vào ô đầu tiên của cột Thành tiền, chọn lệnh Layout, nhóm 

Data, chọn Formu a (fx) 

 

- Nhập công thức tính theo hai cách tại ô Formula: 



 

 

GIÁO TRÌNH WORD 2003-2007-2010 Page 272 

 

BÙI QUYẾT TIẾN 2011 

e  

+ Tính trực tiếp theo cách dùng địa chỉ theo dòng và cột của Excel. Trong 

trường hợp cụ thể này, Số  ƣợng  à cột D, Đơn giá  à cột C, dòng cần tính  à 

dòng 2, nên công thức tính sẽ là =c2+d2 

+ Hoặc có thể sử dụng các hàm có trong ô Paste Function ở bên dưới hoặc gõ 

tên hàm vào. Trong Word có thể sử dụng các hàm cơ bản như: Sum (tính 

tổng), Count (đếm), Average (tính trung bình cộng), Max (giá trị  ớn 

nhất), Min (giá trị nhỏ nhất), Product (nhân) … và có thể sử dụng địa chỉ ô 

và vùng như Excel. Để tính Thành tiền có thể viết như sau: = Product(left) 

hoặc = Product(c2 d2) 

- Chọn chế độ định dạng tại ô Number Format (ví dụ: #,##0) 

Bƣớc 3. Sao chép xuống các ô bên dưới: Bôi đen kết quả vừa tính, chọn copy 

và paste xuống các ô bên dưới của cột thành tiền rồi bấm F9 để cập nhật theo 

dòng. 

Bƣớc 4. Tính tổng: kích chuột vào ô cuối cùng của dòng Thành tiền và chọn 

Layout/Formula, nhập công thức =sum(above) và chọn chế độ định dạng tại ô 

Number Format rồi OK. 

Trong quá trình làm việc, nếu dữ liệu tại các cột Số lượng và Đơn giá có điều 

chỉnh thì chỉ cần bôi đen cột Thành tiền và bấm F9 thì máy sẽ tự động cập nhập 

kết quả theo số liệu mới. 
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Chú ý: nếu người dùng nhập sai kiểu số liệu hoặc trong bảng có các ô dạng 

Merge Cells thì có thể kết quả tính toán sẽ không chính xác. 

Hộp tho i Formu a 

- Formula: Hiển thị hàm, công thức tính toán. Bắt đầu mỗi hàm hay công thức 

đều phải bắt đầu từ dấu “=” (SUM(ABOVE): Tỉnh tổng các giá trị ở trên). Bạn 

phải điền đúng công thức của mỗi hàm.  

- Number format: Các định dạng kiểu số  

- Paste Function: Các hàm cơ bản:  

ABS: Trị tuyệt đối  

AND: Hàm và  

AVERAGE: Tính trung bình  

COUNT: Đếm  

IF: Hàm điều kiện  

INT: Hàm chia lấy phần nguyên  

MAX: Hàm lớn nhất  

MIN: Hàm nhỏ nhất  

MOD: Hàm chia lấy phần dư  

NOT: Hàm phủ định  

OR: Hàm hoặc  

ROUND: Hàm làm tròn  

SUM: Tính tổng  

4. Chuyển bảng thành văn bản và ngƣợc l i 

 Chuyển đổi từ  Table sang Text: 

- Đặt con trỏ vào một ô bất kỳ trong Table 
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- Trong thẻ Layout, nhóm Data, nhấn nút Convert to Text 

 

- Hiển thị hộp thoại sau: 

 

- Dùng các ký hiệu để phân cách nội dung trong ô thuộc Table 

o Paragrahp marks dấu phân đoạn (tương đương nhấn phím 

Enter) 

o Tabs có khoảng cách phím Tab 

o Commas dấu phẩy 

o Other dấu khác các dấu đã nêu bên trên, bạn 

gõ vào dấu bạn muốn bên cạnh 

- Nhấn OK 

 Chuyển đổi từ  Text sang Tab e  

- Chọn dữ liệu muốn chuyển đổi thành Table 

- Trong thẻ Insert, nhóm Tables, nhấn Convert Text to Table 
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- Hiển thị hộp thoại sau: 

 

- Chọn tùy chọn thích hợp sau đó nhắp nút OK 

- Dùng các ký hiệu để phân cách nội dung trong ô thuộc Table 
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o Paragrahp marks : dấu phân đoạn (tương đương nhấn phím 

Enter) 

o Tabs : có khoảng cách phím Tab 

o Commas : dấu phẩy 

o Other : dấu khác các dấu đã nêu bên trên, bạn gõ 

vào dấu bạn muốn bên cạnh 

Chương 5: Hỗ trợ xử lý trong Word 2010 

1. Auto Correct và Macro 

a. Auto Correct  

Để tiết kiệm thời gian và công sức khi nhập nội dung cho một văn bản lớn 

trong đó có sự lặp lại nhiều lần một hay nhiều nhóm từ, bạn có thể thiết lập 

chức năng AutoCorrect nhằm thay thế một vài ký tự viết tắt cho các từ đó 

bởi các từ đủ nghĩa mà thông thường các từ này dài hơn. 

Chọn biểu tượng Office 2010trên góc trái của của sổ Word, chọn Options, 

chọn Proofing, chọn Auto Correct Options 

 

Hiển thị hộp thoại sau: 
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-  

- Correct TWo INitian CApitals : nếu hai ký tự đầu tiên trong một từ 

được gõ bằng chữ in thì nó sẽ thay chữ in thứ hai bằng chữ thường.  

VD: gõ TWo INitian CApitals sẽ được thay bằng Two Initian Capitals  

- Capitalize first letter of sentences : Word nhận biết sau dấu chấm sẽ 

bắt đầu một câu mới và ký tự đầu câu sẽ được đổi thành chữ in nếu 

chúng ta gõ bằng chữ thường 

- Capitalize name of days : Ký tự đấu tiên của thứ (ngày trong tuần được 

gõ bằng tiếng Anh) sẽ đổi thành chữ in. 

- Correct accidental usage of cAPS LOCK key : khi gõ phím Caps 

Lock, đèn Caps Lock trên bàn phím  sáng, lúc này chúng ta có thể gõ 
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nhầm trạng thái của bàn phím bằng cách giữ phím Shift gõ ký tự đầu 

tiên của một từ, sau đó nhả phím Shift gõ các ký tự còn lại của từ, sau 

khi gõ xong từ này Word sẽ đổi từ đã gõ về đúng dạng đồng thời làm tắt 

luôn đèn caps lock. 

- Replace text as you type : tự động gõ từ sai thành từ đúng 

Trong hộp hoại trên, từ sai được liệt kê ở bên cột trái tương ứng với từ đúng ở 

bên cột phải. Như vậy chỉ khi nào gõ đúng từ sai ở bên trái thì Word sẽ tự động 

thay thế từ đúng ở bên phải. 

Nhập nội dung viết tắt vào hộp Replace. Nhập nội dung thay thế cho nội 

dung viết tắt vào hộp With, sau đó click nút Add để đưa vào danh sách 

AutoCorrect. 

Thực hiện tuần tự các bước để nhập thêm các từ viết tắt khác. 

Khi thực hiện xong, nhấn OK để thoát khỏi hộp thoại. 

Muốn xoá từ viết tắt nào, bạn click chọn từ trong danh sách và nhấn Delete. 

Muốn sửa đổi, chọn từ trong danh sách và nhập lại vào nội dung trong 

khung Replace hoặc With. 

Trong khi gõ văn bản, muốn sử dụng AutoCorrect bạn nhập vào từ viết tắt, 

sau đó nhập thêm dấu phân cách từ (ký tự trắng, dấu phẩy, dấu chấm, dấu 

chấm hỏi, . . .) để đưa nội dung thay thế tương ứng vào văn bản. 

b. Macro 

Macros  à các tính năng ti n tiến, có thể  àm tăng tốc độ hiệu chỉnh hay 

định d ng mà b n có thể thực thi thƣờng xuy n trong một tài  iệu Word. 

Chúng ghi lại chuỗi các lựa chọn mà bạn chọn để cho một loạt các hành động 

có thể được hoàn thành trong một bước. 
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Ghi một Macro 

Để ghi một Macro: 

• Chọn tab View trên vùng Ribbon 

• Chọn vào mũi tên phía dưới Macros  

 

• Chọn Record Macro, hộp thoại xuất hiện như sau: 

 

• Nhập tên (không chứa dấu cách) 

• Chọn vào nơi bạn muốn gán cho một nút (trên Quick Access Toolbar) hay 

bàn phím (chuỗi các phím) 

• Để gán Macro cho một nút trên Quick Access Toolbar: 
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- Chọn Button 

- Dưới Customize Quick Access Toolbar, lựa chọn tài liệu mà bạn muốn 

Macro có sẵn. 

 

- Dưới lệnh chọn: Chọn Macro mà bạn đang ghi 

- Chọn Add 

- Chọn OK để bắt đầu ghi Macro 

- Thực thi các hành động bạn muốn được ghi trong Macro 

- Chọn Macros 

- Chọn vào Stop Recording Macros 
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• Để gán một nút Macro cho một phím tắt: 

- Ở hôp thoại Record Macro, Chọn Keyboard 

- Trong hộp Press New Shortcut Key, nhập phím tắt mà bạn muốn gán cho 

nút Macro và Chọn Assign 

 

- Chọn Close để bắt đầu ghi Macro 

- Thực thi các hành động bạn muốn được ghi trong Macro 

- Chọn Macros 

- Chọn Stop Recording Macros 

Ch y Macro 
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Chạy một Macro phụ thuộc vào nơi nó được thêm vào Quick Access Toolbar 

hay nếu nó được gán là một phím tắt. 

• Để chạy một Macro từ Quick Access Toolbar, Chọn vào biểu tượng Macro 

 

• Để chạy một Macro từ phím tắt, chỉ cần ấn các phím mà bạn đã lập trình để 

chạy Macro. 

2. T o ghi chú và bảo vệ tài  iệu Word. 

a. Chèn một ghi chú  

1. Chọn đoạn text hoặc đối tượng bất kỳ trong tài liệu bạn muốn ghi chú.  

2. Trong thẻ Review, nhóm Comments, nhấn nút New Comment.  

 

3. Nhập vào ghi chú của bạn trong bong bóng hiển thị ở khung bên cạnh tài 

liệu.  

Xóa ghi chú  

- Để xóa một ghi chú, nhấn chuột phải vào ghi chú đó, chọn Delete Comment.  

- Để xóa nhanh tất cả ghi chú trong tài liệu, nhấn chuột vào một ghi chú bất kỳ. 

Trong thẻ Review, nhóm Comments, nhấn vào mũi tên bên dưới nút Delete và 

chọn Delete All Comments in Document.  

Thay đổi ghi chú  

1. Nếu các ghi chú không hiển thị trong tài liệu, bạn nhấn nút Show Markup 

trong nhóm Tracking của thẻ Review, sau đó đánh dấu chọn Comments.  
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2. Nhấn chuột vào bên trong một bong bóng có ghi chú cần sửa. Sau đó sửa lại 

nội dung theo ý bạn.  

Thay đổi t n ngƣời ghi chú  

Bên cạnh mỗi ghi chú luôn có tên của người sử dụng. Nếu bạn muốn thay đổi 

tên này, hãy thực hiện như sau:  

1. Trong thẻ Review, nhóm Tracking, nhấn chuột vào mũi tên bên dưới nút 

Track Changes, sau đó chọn mục Change User Name.  

 

2. Trong hộp thoại xuất hiện, bên dưới mục Personalize..., bạn nhập vào tên 

của mình, sau đó nhấn OK.  

 

Lưu ý là những ghi chú kể từ bây giờ trở đi mới có tác dụng với tên mới.  
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In tài  iệu kèm theo ghi chú và những đánh dấu thay đổi  

1. Nhấn nút Microsoft Office Button (hoặc Tab File) , sau đó chọn Print.  

2. Trong hộp thoại Print, tại mục Print what, chọn Settings, Print và nhấn OK.  

 

b.Bảo vệ tài liệu Word 

Word 2010 hỗ trợ sẵn tính năng đặt password bảo vệ văn bản với tính bảo mật 
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cao.  

Bạn nhấp vào biểu tượng tab File phía trên góc trái > chọn Info > Click 

Protect Document and  

Click Encrypt with Password > nhấp OK. Xác nhận lại password > nhấn OK. 

Click the File tab, then Click Info.  On the menu to the right Click Protect 

Document and  

Click Encrypt with Password. 

 

 Hộp thoại Encrypt Document, bạn nhập password vào. Click OK 
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Từ bây giờ, mỗi khi mở file văn bản này, Word sẽ hiển thị cửa sổ yêu cầu nhập 

password. Chỉ người nào biết password mới có thể xem được nội dung của file. 

 

Muốn hủy bỏ, bạn chỉ việc vào hộp thoại Encrypt Document để xóa password 

bảo vệ. 

3. Tìm kiếm, thay thế 

Tìm văn bản  

Bạn có thể nhanh chóng tìm kiếm một từ hoặc cụm từ theo cách sau:  

- Trong thẻ Home, nhóm Editing, nhấn nút Find (hoặc nhấn phím tắt Ctrl+F).  

 

- Trong mục Find what của hộp thoại Find and Replace vừa xuất hiện, 

bạn hãy nhập vào đoạn văn bản cần tìm.  
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- Để tìm mỗi một từ hoặc cụm từ, bạn nhấn Find Next. Để tìm tất cả từ hoặc 

cụm từ cùng một lúc trong văn bản, bạn nhấn Find in, sau đó nhấn Main 

Document.  

- Muốn kết thúc quá trình tìm kiếm, bạn nhấn ESC.  

Tìm và thay thế văn bản  

- Trong thẻ Home, nhóm Editing, nhấn nút Replace (hoặc nhấn phím tắt 

Ctrl+H).  
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- Ở mục Find what, bạn nhập vào đoạn văn bản muốn tìm.  

- Ở mục Replace with, bạn nhập vào đoạn văn bản muốn thay thế.  

- Để tìm đoạn văn bản tiếp theo, bạn nhấn Find Next.  

- Để thay thế đoạn văn bản, bạn nhấn Replace. Sau khi nhấn xong, Word sẽ 

chuyển sang đoạn văn bản tiếp theo.  

- Để thay thế tất cả các đoạn văn bản tìm được, bạn nhấn Replace All.  

Tìm và tô sáng đo n văn bản tìm đƣợc  

Để dễ dàng nhận biết các cụm từ tìm được, bạn có thể tô sáng nó trên màn 

hình (không tô sáng khi in ra).  

- Trong thẻ Home, nhóm Editing, nhấn nút Find (Ctrl+F).  

- Trong hộp Find what, nhập văn bản mà bạn muốn tìm.  

- Nhấn Reading Highlight, sau đó chọn Highlight All.  

- Tất cả từ tìm được sẽ được tô sáng. Để tắt tính năng này đi, bạn nhấn 

Reading Highlight lần nữa, chọn Clear Highlighting.  
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Tìm và thay thế những định d ng đặc biệt  

- Trong thẻ Home, nhóm Editing, bạn nhấn nút Replace (Ctrl+H).  

- Nhấn nút More nếu bạn không nhìn thấy nút Format.  

 

- Để tìm kiếm đoạn văn bản với định dạng đặc biệt, bạn hãy nhập đoạn văn đó 

trong ô Find what. Nếu chỉ để tìm kiếm định dạng, hãy để trống ô này.  

- Nhấn nút Format, sau đó chọn định dạng mà bạn muốn tìm.  

- Nhấn vào ô Replace with, sau đó nhấn Format, chọn định dạng thay thế. Nếu 

bạn cũng muốn thay thế bằng đoạn văn bản, hãy nhập đoạn text đó vào ô 

Replace with.  

- Nhấn Find Next, nhấn tiếp Replace để tìm và thay thế các định dạng đặc biệt. 
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Để thay thế toàn bộ, nhấn Replace All.  

Tìm và thay thế các dấu đo n, ngắt trang và các m c khác  

- Trong hộp thoại Find and Replace xuất hiện sau khi nhấn Ctrl+H, bạn nhấn 

nút More nếu không thấy nút Special.  

- Nhấn vào ô Find what, sau đó nhấn nút Special và chọn một mục cần tìm.  

- Nhập những gì bạn muốn thay thế trong ô Replace with.  

- Nhấn Find Next, Replace hoặc Replace All.  

S  d ng ký tự đ i diện khi tìm kiếm  

- Bật hộp thoại Find and Replace lên.  

- Nhấn nút More để mở rộng hộp thoại.  

- Đánh dấu kiểm vào ô Use wildcards.  

- Nhập từ cùng những ký tự đại diện vào ô Find what.  

- Nhập những gì bạn muốn thay thế trong ô Replace with.  

- Nhấn Find Next, Replace hoặc Replace All.  

Bảng các ký tự đại diện  

Đ i diện  Nh p Ví d  

Một ký tự bất kỳ  ? “s?t” tìm “sat” và “set”. 

Một dãy ký tự * “s*d” tìm “sad” và “started”. 
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Bắt đầu một từ  < 

“<(inter)” tìm “interesting”, 

“intercept”. Không tìm 

“splintered”. 

Cuối một từ  > 
“(in)>” tìm “in”, “within”. 

Không tìm “interesting”. 

Một trong những ký tự 

chỉ định  
[] “w[io]n” tìm “win” và “won”. 

Một ký tự bất kỳ trong 

dãy 
[-] 

“[r-t]ight” tìm “right” và 

“sight”. Dãy phải theo thứ tự 

tăng dần. 

Một ký tự bất kỳ, trừ 

những ký tự cho sẵn 

trong ngoặc 

[!x-z]  
“t[!a-m]ck” tìm “tock”, “tuck”. 

Không tìm “tack” hay “tick”. 

Để tìm một ký tự định nghĩa như một ký tự đại diện, bạn gõ dấu \ trước ký tự 

đó. Chẳng hạn gõ \? để tìm dấu hỏi. Bạn có thể sử dụng dấu ngặc đơn để nhóm 

các ký tự đại diện và đoạn text để chỉ ra thứ tự phép tính. Ví dụ gõ 

<(pre)*(ed)> để tìm “presorted” và “prevented”.  

Bạn có thể sử dụng ký tự đại diện \n để tìm kiếm một biểu thức và thay thế 

bằng một biểu thức được sắp xếp. Ví dụ gõ (Office) (Word) vào ô Find what và 

gõ \2 \1 vào ô Replace with. Kết quả là chương trình sẽ tìm cụm từ Office 

Word và thay bằng Word Office.  
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4. Kiểm tra chính tả, ngữ pháp, từ đồng nghĩa, tự động chỉnh s a, từ 

điển mặc định và công c  đếm từ 

Có nhiều tính năng trợ giúp b n đọc và kiểm tra bản in th  cho tài  iệu. 

Chúng bao gồm các công c   Spelling and Grammar (công cụ kiểm tra chính 

tả và ngữ pháp), Thesaurus (từ đồng nghĩa), AutoCorrect (tự động chỉnh sửa), 

Default Dictionary (từ điển mặc định) và Word Count (công cụ đếm từ). 

Spelling and Grammar 

Để kiểm tra chính tả và ngữ pháp của một tài liệu: 

• Đặt con trỏ vào đầu của tài liệu hoặc đầu của bất kỳ đoạn văn bản mà bạn 

muốn kiểm tra 

• Chọn tab Review trên vùng Ribbon 

• Chọn biểu tượng Spelling & Grammar trên nhóm Proofing hoặc ấn phím tắt 

(F7). 

 

 

• Bất kỳ một lỗi nào sẽ hiển thị một hộp thoại cho phép bạn chọn một cách viết 

hay ngữ pháp thích hợp hơn. 
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Nếu bạn muốn kiểm tra chính tả của một từ cụ thể, bạn có thể kích chuột phải 

vào bất kỳ từ nào được gạch dưới bởi Word và chọn một sự thay thế. 

 

Từ điển đồng nghĩa  
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Từ điển đồng nghĩa cho phép bạn xem các từ đồng nghĩa. Để sử dụng từ điển 

đồng nghĩa: 

• Chọn tab Review trên vùng Ribbon 

• Chọn nút Thesaurus trên nhóm Proofing. 

• Công cụ từ điển đồng nghĩa sẽ xuất hiện ở phía bên phải màn hình và bạn có 

thể xem các tùy chọn. 

 

Bạn cũng có thể truy cập vào từ điển đồng nghĩa bằng cách kích phải vào bất 

kỳ từ nào và chọn Synonyms trên menu. 
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T o một từ điển mặc định mới  

Thường thì bạn có các từ ngữ kỹ thuật chuyên môn mà có thể không được công 

nhận bởi công cụ kiểm tra chính tả và ngữ pháp trong Word. Do vậy mà bạn có 

thể tùy chỉnh từ điển để có những từ bạn muốn cho vào. 

• Chọn nút Microsoft Office 

• Chọn nút Word Options 
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• Chọn tab Proofing 

• Chọn tab When Correcting Spelling 

• Chọn Custom Dictionaries, và hộp thoại Custom Dictionaries xuất hiện. 

 

 

• Chọn Edit Word List  

• Nhập các từ có thể sử dụng của bạn mà không có trong từ điển hiện thời trong 

Word. 
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ĐẾM SỐ TỪ TRONG TÀI LIỆU  

Word 2010 có thể đếm số từ của tài liệu trong khi bạn gõ văn bản. Ngoài ra 

chương trình còn có thể đếm số trang, số đoạn, số dòng, số ký tự có hoặc 

không có khoảng trắng.  

 

Đếm số từ trong khi gõ văn bản  

Trong khi bạn gõ văn bản, Word 2010 sẽ tự động đếm số trang và số từ có 

trong tài liệu. Thông tin này được hiển thị trên thanh trạng thái ở góc dưới bên 

trái màn hình: mục Page (số trang) và Wor ds (số từ).  
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Đếm số từ trong v ng chọn  

Bạn có thể đếm số từ trong các vùng chọn, và các vùng chọn này không nhất 

thiết phải liền mạch nhau.  

- Trước tiên bạn dùng chuột chọn vùng cần đếm. Nếu các vùng không liền 

mạch nhau, sau khi chọn vùng đầu tiên, bạn giữ phím Ctrl và chọn thêm các 

vùng khác.  

- Trên thanh trạng thái ở cuối màn hình sẽ hiển thị số từ có trong vùng chọn. Ví 

dụ 110/1025 có nghĩa là trong vùng chọn có 110 từ trên tổng số 1025 từ của tài 

liệu.  

Bao gồm cả textbox, footnote và endnote trong khi đếm từ  

- Trong thẻ Review, nhóm Proofing, nhấn nút Word Count.  

- Trong hộp thoại Word Count, đánh dấu check vào mục Include textboxes, 

footnotes and endnotes.  

Đếm số từ trong textbox  

- Chọn textbox mà bạn muốn đếm từ.  

- Trên thanh trạng thái ở cuối màn hình sẽ hiển thị số từ có trong textbox. Ví dụ 

110/1025 có nghĩa là trong textbox có 110 từ trên tổng số 1025 từ của tài liệu.  

Xem số trang, số ký tự, số đo n và số dòng  

Để có đầy đủ thông tin về số trang, số ký tự, số đoạn và số dòng, bạn thực hiện 

một trong hai cách sau:  

- Trong thẻ Review, nhóm Proofing, nhấn nút Word Count.  

- Trên thanh trạng thái ở góc dưới bên trái màn hình, bạn nhấn chuột vào mục 

Words.  

Hộp thoại Word Count xuất hiện cho bạn đầy đủ thông tin mà bạn muốn.  
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5. In tài liệu Word  

Định d ng trang in 

Mỗi khi tạo file mới, trong cửa sổ văn bản đã có sẵn một trang giấy trắng để 

bắt đầu soạn văn bản (thường là giấy letter hoặc giấy A4). Chỉ khi nào cần đến 

chi tiết chính xác hơn chúng ta mới chọn lại khổ giấy khác 

Tab Page Layout, nhóm Page Setup, chọn mũi tên dưới góc phải để mở hợp 

thoại Page Setup 

 

 Chọn  o i giấy – Tab Paper 

 

- Paper Size : chọn loại giấy, kích thước tương ứng sẽ hiện ra trong width và 

height, nếu chọn Custom phải cho số đo kích thước giấy trong width và height 

 Đặt  ề cho trang in – Tab Margins 
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- Top  : Lề đỉnh của trang in 

- Bottom  : Lề đáy của trang in 

- Left  : Lề trái của trang in 

- Right  : Lề phải của trang in 

Nếu có dùng lệnh Mirror Margins để làm sách (tạo tính đối xứng giữa các 

trang) thì lệnh left và right sẽ trở thành Inside và Outside 

- Gutter : Khoảng cách dùng để đóng gáy sách 

- From edge: Khoảng cách từ mép của tờ giấy đến header hoặc footer 
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- Orientation : chọn hướng in 

o Portrait : Giấy dọc 

o Landscape : Giấy ngang 

- Mirror margins : Đặt lề đối xứng nhau. Nếu lệnh này có dùng, giấy sẽ 

được phân biệt là có trang lẻ và trang chẵn (Odd and Even), thường áp 

dụng để in sách. 

In tài  iệu 

-Tab File, chọn Print 
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- Copies: chọn số bản in 

- Printer : chọn tên máy in tương ứng đã được cài đặt trong Windows. Nếu máy 

in đang sử dụng không có tên trong danh sách này (nghĩa là nó chưa được khai 

báo) thì phải thực hiện các bước sau: 

o Nhắp Start, chọn Settings và nhắp Printers. 
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o Nhắp đúp vào biểu tượng Add Printer. 

o Thực hiện các bước cài đặt máy in của chức năng Add Printer Wizard 

- Pages : in số trang chọn lựa bằng cách gõ các số trang vào, dùng dấu “,” 

để phân cách các trang rời rạt, dấu gạch nối “-“ để in các trang liên tiếp 

6. Trộn tài  iệu (Mail Merge)  

6.1 Các Khái niệm 

Trộn thư 

Trong thực tế, đôi khi chúng ta cần phải in văn bản gởi cho nhiều người chẳng 

hạn như thư mời, phiếu báo điểm, giấy chứng nhận, bằng tốt nghiệp… 

Thay vì phải gõ những thông tin của từng người vào nội dung của từng giấy 

chứng nhận (rất dễ nhằm lẫn), ta có có thể dùng công cụ Mail Merge để giải 

quyết vấn đề trên một cách nhanh chóng. 

Tập tin data source 

Một file chứa dữ liệu nguồn thường được trình bày dưới dạng bảng biểu đơn 

giản như table, sheet (của Excel, Access) bảo đảm đủ số cột, hàng và nội dung 

trong các ô. 

Tập tin main document 

Một file văn bản mẫu đã được trình bày hoàn chỉnh 

a. Form letter 

Bƣớc 1. Tạo tập tin Main chính trong WORD như sau 

Công Ty TNHH XYZ  

 999 Pasteur, Q.1, TP.HCM 

  8223344 Ngày 30 tháng 10 năm 2009 
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THƢ MỜI 

 

Kính gởi:  

Sinh năm:  

Địa chỉ:  

Mời  sắp xếp thời gian đến dự cuộc phỏng vấn tuyển nhân sự cho 

Công ty. 

Thời gian: giờ,  ngày  

Địa điểm:  

 Giám Đốc 

 Trần Văn A 

Bƣớc 2. Tạo tập tin nguồn dữ liệu trên Excel với các cột có tên 

tương ứng (chú ý là tên cột không nên viết dấu tiếng việt, và phải bắt 

đầu dữ liệu ngay tại Cell A1).  

* Chú ý: tập tin dữ liệu này bạn có thể tạo bằng WORD, tuy nhiên 

nếu thể hiện trong Excel bạn sẽ có lợi hơn nếu bảng dữ liệu đó có hổ 

trợ nhiều phép tính và hàm phức tạp. 

OBC HOTEN PHAI NS DIACHI THPHO BANG 

Ông Đinh như Quí Nam 1965 11 Lê Lợi TP.HCM ĐH 

Bà Hồ Lệ Ngọc Nữ 1966 22 Thùy Vân Vũng Tàu ĐH 

Ông Hoàng văn Bình Nam 1975 33 Lê Lai TP.HCM   
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Ông Phan thành Tâm Nam 1970 

44 Lý Thường 

Kiệt TP.HCM   

Bà 

Nguyễn Thúy 

Hồng Nữ 1968 55 Lê Thánh Tôn TP.HCM ĐH 

Ông Trần Hòa Bình Nam 1969 66 Lý Thái Tổ Biên Hòa ĐH 

Bà Lê Thị Mộng Vân Nữ 1973 

77 Trần Hưng 

Đạo 

Thủ Dầu 

Một   

Ông Lê Văn Lợi Nam 1967 88 Ngô Đức Kế TP.HCM   

Bà Hàng thị Ngọc Hà Nữ 1968 99 Hùng Vương Vũng Tàu   

Bà 

Hoàng thị Lệ 

Tường Nữ 1969 96 Pasteur TP.HCM ĐH 

Bƣớc 3. Trên tập tin Main chính trong Word 

Chọn Start Mail Merge trên tab Mailings và sau đó chọn Step by Step Mail 

Merge Wizard.  
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Trình Wizard sẽ mở ra một cửa sổ bên phải tài liệu. Cửa sổ này có thể di 

chuyển bằng chuột đến một vị trí mới trên màn hình và bạn cũng có thể thay 

đổi kích cỡ của nó. 
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Để thực hiện merge mail cần phải qua 6 bước, bạn làm theo hướng dẫn bằng 

cách chọn những tùy chọn phù hợp rồi nhấn Next ở dưới cùng của hộp thoại, 

nếu muốn quay lại thì nhấn vào Previous. 

Trong mục Select document type đã chọn sẵn Letters. Chọn Next qua bước 2 
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Trong mục Select sartting document đã chọn sẵn Use the current document. 

Chọn Next qua bước 3 

 

Trong mục Select recipients nhấn nút Browse. Chọn va mở file danh sách 

excel đã lưu. 

 

Chọn Sheet1, OK 
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Ở hộp thoại Mail Merge Recipents, ta có thể loại bỏ hoặc trích lọc những hàng 

không muốn tạo thư mời. 

Nhấn OK. 

Nhấn Next qua bước 4. 
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Trong mục Write your letter, nhấn chọn More items… 

 

Đặt con trỏ text ở vị trí xác định trong văn bản mẫu, nơi cần chèn dữ liệu vào, 

lần lượt chèn các field vào trong main document như sau: 
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Nhấn Next sang bước 5, ở bước này nhấn vào nút >> đề xem trước các thư mời 

tiếp theo 

 

Nhấn nút Next sang bước thứ 6. 
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Chọn Print… nếu muốn in các thư mời trực tiếp ra máy in, chọn Edit indidual 

letters nếu muốn xem trước các thư mời trong văn bản. 

 

Trong hộp thoại Merge to New Document có thể chọn tạo ra toàn bộ các thư 

mời có trong danh sách hoặc chỉ chọn tạo thư mời cho một số người. 

b. Envelopes 

Tạo những bì thư bằng cách Mail Merge. Thực hiện tương tự phần From letter 
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nhưng chọn Envelops thay vì chọn From letter ở bước1. 

c. Labels 

Tạo nhãn bằng cách Mail Merge. Thực hiện tương tự phần From letter nhưng 

chọn Labe s thay vì chọn From  etter ở bƣớc1. 

d. Catologes 

Tạo văn bản kiểu danh sách bằng cách Mail Merge. Thực hiện tương tự phần 

From  etter nhƣng chọn Cato oges thay vì chọn From  etter ở bƣớc1. 

Ribbon cũng là một cách hữu ích để tạo một Mail Merge và quá trình xử lý rất 

giống với các bước trong trình Wizard. Bằng cách sử dụng thanh Ribbon, bạn 

sẽ có thể truy cập vào nhiều tính năng hơn, chẳng hạn như tự động kiểm tra tìm 

lỗi trước khi bạn hoàn tất việc hòa trộn. Ngoài ra còn có những yếu tố nâng 

cao, chẳng hạn như sử dụng các trường để thể hiện các thao tác hoặc tính toán 

trong tài liệu.  

 

Những lệnh bạn dùng trên Tab Mailings trong bốn nhóm sau:    

- Start Mail Merge: Đây là điểm bắt đầu từ nơi bạn chọn một loại tài liệu và 

sau đó chọn, tạo, hoặc chỉnh sửa danh sách người nhận.    

- Write & Insert Fields: Đây là nơi bạn có thể chèn các Merge Field và sử 

dụng Rules để thể hiện các thao tác tính toán cho tài liệu.   

- Preview Results: Bên cạnh việc xem lại tài liệu đã hòa trộn, bạn có thể sử 

dụng tính năng kiểm tra lỗi một cách tự động.   

- Finish: Hoàn thành merge và kết hợp các tài liệu cá nhân của bạn vào một tài 

liệu toàn diện, hay in chúng ra hoặc gửi thư điện tử. 
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Chương 6: Các phím tắt trong Word 

1. Các  o i phím tắt: 

Có 2 cách để sử dụng phím tắt. Giả sử để in đậm một chữ bạn có thể sử dụng: 

 

a. Phím truy cập các Tab và lệnh trên màn hình.  

b. Tổ hợp phím không nằm trên thanh Ribbon.  

Nhiều người cho rằng bất kỳ sự kết hợp của một tồ hợp phím nào dẫn đến việc 

thực thi một lệnh đều có thể gọi là phím tắt, về cơ bản thì đó là một cách nghĩ 

đúng. Nhưng trong bài này chúng ta sẽ có một định nghĩa chính xác hơn về 

phím tắt. Xác định sự khác biệt rất quan trọng vì từng loạt phím tắt khác nhau 

sẽ có phương thức hoạt động khác nhau. Access Keys (phím truy c p) Access 

Key cho phép bạn truy cập thanh Ribbon, nó liên hệ mật thiết với các Tab, lệnh 

và những thứ mà bạn nhìn thấy trên màn hình. Bạn sử dụng Acces Key bằng 

cách nhấn Alt rồi sau đó nhấn tiếp một phím hoặc một chuỗi tuần tự các phím.  

Mỗi lệnh trên thanh Ribbon, trong trình đơn của nút Microsoft Office và trên 

Quick Access Toolbar đều có một phím truy cập riêng, mỗi phím truy cập 

được gán một Key Tip. Key Tip là một phiên bản mới của hệ thống ký tự g ch 

chân mà bạn quen thuộc ở các phiên bản trước khi muốn truy cập các trình đơn 

bằng cách sử dụng phím Alt. Key combinations (tổ hợp phím) Các tổ hợp 
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phím dùng để thực hiện một lệnh nào đó và nó không liên quan tới những gì 

bạn nhìn thấy trên màn hình. Các phím phải được nhấn cùng một lúc để kích 

hoạt các lệnh, trong đa số trường hợp, dù không phải tất cả, đều có liên quan 

tới phím Ctrl (ví dụ nhấn Ctrl + C để copy). Tổ hợp phím không thay đổi trong 

phiên bản Office 2007, nó hoạt động giống hệt các phiên bản trước. 

2. Duyệt thanh Ribbon bằng Access Key (phím truy c p) 

Khi bạn muốn dùng bàn phím thay vì các thiết bị trỏ như con chuột để điều 

khiển thanh Ribbon và những thứ khác trên màn hình, trước tiên bạn phải bật 

chức nâm điều khiển bằng bàn phím. Nói cách khác bạn phải chuyển từ chế độ 

nhập liệu sang chế độ thực thi lệnh bằng cách nhấn phím Alt. Sau đó, bạn sẽ có 

rất nhiều tùy chọn để duyệt khắp thanh Ribbon.  

a. Key Tip và các biểu tƣợng hình khi n (Badges) 

 

Ngay khi bạn nhấn phím Alt, bạn sẽ thấy các nhãn nhỏ, hoặc khiên nhỏ 

hiện lên để chỉ ra Key Tip của từng Tab. Khi bạn nhấn phím để kích hoạt 

một Tab, các khiên nhỏ sẽ hiển thị Key Tip cho từng lệnh trong Tab đó. Nói 

cách khác, bạn chỉ thấy mỗi lần một nhóm Key Tip, và bạn phải nhấn một 

lựa chọn nào đó trước khi thấy nhiều hơn. Key Tip là cách rất tuyệt để sử 

dụng phím tắt bởi bạn không cần phải ghi nhớ, mọi thứ đều hiển thị trên 

màn hình. 

b. Tìm hiểu th m về Key Tip 
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Hình b n trái: Trên Tab Insert Key Tip M được gán cho nút lệnh SmartArt. 

Hình b n phải: Trên Tab Page Layout Key Tip M được gán cho nút lệnh 

Margins. Các Key Tip có thể trùng lặp trên các Tab khác nhau, trong ví dụ trên 

M là phím tắt cho SmartArt trong Tab Insert nhưng lại là phím tắt cho Margins 

trong Tab Page Layout. Bạn chỉ có thể thấy và làm việc với Key Tip của Tab 

đang được kích hoạt. Nếu bạn lỡ chọn sai Tab thì chỉ cần nhấn Esc để hiển thị 

lại Key Tip cho Tab và chọn lại Tab mà bạn cần. Lƣu ý: Nếu có một hộp thoại 

đang mở dùng cùng một ký tự Key Tip với một Tab hoặc một lệnh trên thanh 

Ribbon, thì Key Tip của hộp thoại này sẽ được ưu tiên. 

c. Di chuyển bằng phím mũi t n 

Ngoài Key Tip bạn cũng có thể dùng phím mũi tên để duyệt thanh Ribbon. 

Đầu tiên bạn cũng nhấn phím Alt để chọn thanh Ribbon làm tiêu điểm, sau 

đó dùng các phím mũi tên để di chuyển: Phím MŨI TÊN TRÁI và MŨI 

TÊN PHẢI để chuyển qua lại giữa các Tab. Phím MŨI TÊN LÊN để 

chuyển tiêu điểm lên Quick Access Toolbar (từ đây bạn có thể dùng phím 

MŨI TÊN TRÁI để di chuyển sang nút Microsoft Office). Phím MŨI 

TÊN XUỐNG chuyển bạn vào Tab đang kích hoạt và bạn có thể di chuyển 

tiệp trong đó bằng cách sử dùng phím mũi tên.. Một điểm tiến bộ so với 

phiên bản trước của Microsoft Office là bạn có thể di chuyển lên / xuống 

thay vì chỉ là trái / phải.  

d. Phím TAB và thanh Ribbon  

Bạn cũng có thể dùng phím TAB để di chuyển quanh thanh Ribbon. Sau khi 

nhấn Alt để chọn thanh Ribbon, bạn hãy nhấn phím TAB liên tục để di 
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chuyển qua các nút lệnh theo từng nhóm tại Tab đang kích hoạt. 

Sau khi đi một vòng hết các lện trong Tab hiện tại, tiêu điểm sẽ được 

chuyển theo thứ tự nút Help, nút Microsoft Office, Quick Access Toolbar, 

các Tab và quay trở lại nhóm đầu tiên trong Tab hiện tại. Nhấn Shift + TAB 

để di chuyển theo hướng ngược lại. Khi đến được lệnh mà bạn muốn, hãy 

nhấn ENTER. 

Nếu bạn từng làm việc với Mocrosoft Office trong nhiều năm và là một 

chuyên gia về phím tắt, bạn thuộc lòng tất cả các phím tắt. Có thể bạn sẽ bối 

rối khi tất cả trình đơn và phím tắt cũ đã biến mất. Thực ra, thanh Ribbon và 

phím tắt mới cần có một ít thời gian để bạn làm quen nhưng một khi đã nắm 

bắt được bạn sẽ đánh giá cao nó. 

Nếu bạn vẫn không hài lòng và muốn trở lại với các phím tắt cũ thì đây là 

câu trả lời: hầu hết phím tắt cũ đều vẫn hoạt động. Tuy nhiên bạn phải nhớ 

chính xác vì giờ đây không còn nơi nào trên màn hình nhắc bạn cần phải 

nhấn phím nào. Đây là cách hoạt động: Trong các phiên bản trước khi bạn 

nhấn Alt + E thì trình đơn Edit được mở lên và bạn nhấn tiếp các ký tự 

được gạch chân để truy cập các lệnh. Trong Office 2010khi nhấn tổ hợp Alt 

+ E (hoặc các ký tự tắt khác) sẽ không có trình đơn nào mở ra. Thay vào đó, 

một thông điệp sẽ hiển thị cho bạn biết bạn đang dùng hệ thống phím tắt cũ. 

Nếu bạn nhớ tổ hợp phím tắt thì chỉ cần nhấn tiếp để thực hiện lệnh. Nếu 

bạn không nhớ, hãy nhấn Esc để hiển thị các Key Tip. 

3. Các phím tắt thông d ng: 

Phím Chức năng 

Ctrl+1 Giãn dòng đơn 
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Ctrl+2 Giãn dòng đôi 

Ctrl+5 Giãn dòng 1,5 

Ctrl+0 Tạo thêm độ giãn dòng đơn trước đoạn 

F12 Lưu tài liệu với tên khác 

F7 Kiểm tra lỗi chính tả tiếng Anh 

F4 Lặp lại lệnh vừa làm 

Ctrl+Shift+S Tạo Style (heading) -> Dùng mục lục tự động 

Ctrl+Shift+F Thay đổi phông chữ 

Ctrl+Shift+P Thay đổi cỡ chữ 

Ctrl+D Mở hộp thoại định dạng font chữ 

Ctrl+M  Lùi đoạn văn bản vào 1 tab (mặc định 1,27cm) 

Ctrl+Shift+M Lùi đoạn văn bản ra lề 1 tab 

Ctrl+T Lùi những dòng không phải là dòng đầu của đoạn văn bản 

vào 1 tab 

Ctrl+Shift+T Lùi những dòng không phải là dòng đầu của đoạn văn bản ra 

lề 1 tab 
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Ctrl+F Tìm kiếm ký tự 

Ctr +G (hoặc 

F5) 

Nhảy đến trang số 

Ctrl+H Tìm kiếm và thay thế ký tự 

Ctrl+K Tạo liên kết (link)  

Ctrl+] Tăng 1 cỡ chữ 

Ctrl+[ Giảm 1 cỡ chữ 

Ctrl+Shift+> Tăng 2 cỡ chữ 

Ctrl+Shift+< Giảm 2 cỡ chữ 

Alt+Shift+S Bật/Tắt phân chia cửa sổ Window 

Ctrl+Enter Ngắt trang 

Start+D Chuyển ra màn hình Desktop 

Start+E Mở cửa sổ Internet Explorer, My computer 

Ctrl+Alt+N Cửa sổ MS word ở dạng Normal 

Ctrl+Alt+P Cửa sổ MS word ở dạng Print Layout 

Ctrl+Alt+L Đánh số và ký tự tự động 
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Ctrl+Alt+F Đánh ghi chú (Footnotes) ở chân trang 

Ctrl+Alt+D Đánh ghi chú ở ngay dưới dòng con trỏ ở đó 

Ctrl+Shift+A Chuyển đổi chữ thường thành chữ hoa (với chữ tiếng Việt có 

dấu thì không nên chuyển) 

Alt+F10 Phóng to màn hình (Zoom) 

Alt+F5 Thu nhỏ màn hình 

Alt+Print 

Screen 

Chụp hình hộp thoại hiển thị trên màn hình 

Print Screen Chụp toàn bộ màn hình đang hiển thị. 

Chương 7: Một số mẹo hay trên Word 2010 

1. Các công c  đồ họa của Word 2010 

Từ những công cụ vẽ hình và định dạng đơn giản ở các phiên bản trước, Office 

2010đã nâng cấp đáng kể tính năng đồ họa trong Word, giúp cho người dùng 

thỏa sức sáng tạo mà không cần đến sự trợ giúp của những chương trình đồ họa 

chuyên nghiệp như Photoshop, Illustrator, CorelDraw … 

Trong Word, các đối tượng đồ họa (Illustrations) được chia làm 05 loại: Picture 

(ảnh chụp), ClipArt (ảnh vẽ có sẵn khi cài đặt), Shapes (các hình vẽ cơ bản), 

SmartArt ( các hình vẽ, sơ đồ đặc biệt), Chart (đồ thị) và WordArt (chữ nghệ 

thuật – nằm trong nhóm Text).  
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Quá trình thao tác được thực hiện qua hai phần: tạo đối tượng và định dạng đối 

tượng. 

Để khởi tạo đối tượng, ta chọn menu Insert rồi chọn nhóm đối tượng trong 

phần Illustrations. 

- Với Picture, người sử dụng phải chọn tranh ở nơi chứa (ví dụ trong My 

Pitures) 

- Với ClipArt, người sử dụng phải chọn tranh trong kho có sẵn của chương 

trình 

- Với Shapes, người sử dụng phải chọn hình vẽ rồi kích chuột vào văn bản 

- Với SmartArt, người sử dụng phải chọn loại sơ đồ rồi OK 

- Với Chart, người sử dụng phải nhập số liệu 

- Với Word Art, người sử dụng phải chọn mẫu và nhập nội dung 

Sau khi tạo đối tượng xong, người sử dụng phải kích chuột vào đối tượng đó và 

chuyển sang menu Format để định dạng. Đây là nơi tập trung các công cụ để 

định dạng đối tượng vừa tạo, bao gồm 
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+ Nhóm Adjust: điều chỉnh độ sáng tối, độ tương phản, gồm: 

- Brightness: điều chỉnh độ sáng 

- Contrast: điều chỉnh độ tương phản 

- Recolor: điều chỉnh tông màu. Với tính năng này, người sử dụng có thể 

chuyển toàn bộ ảnh thành dạng đơn sắc theo một tông màu nào đó. Đặc biệt, 

trong đó có tính năng Set Transparent Color dùng để chuyển một mảng màu trở 

nên trong suốt (thường dùng để loại bỏ nền ảnh) 

- Compress Pictures: dùng để nén ảnh. Các ảnh nguyên gốc có thể có dung 

lượng rất lớn (vài MB một ảnh), khi chèn vào trong văn bản thì dung lượng của 

file Word sẽ bằng dung lượng ký tự cộng với dung lượng của toàn bộ ảnh. Như 

thế có thể một văn bản có kích cỡ lên tới 100MB. Để giảm dung lượng ảnh, ta 

dùng chế độ nén với 03 mức: Print 220 ppi - tốt cho khi in ra máy và hiển thị, 

Screen 150 ppi – hiển thị tốt trên màn hình, Email 96 ppi – dung lượng nhỏ - 

chất lượng hiển thị không tốt 

- Change Picture: thay đổi ảnh 

- Reset Picture: khôi phục ảnh trở về trạng thái gốc 

- Nhóm Picture Styles: các chế độ định dạng cho ảnh, gồm: 

- Picture Shape: chọn kiểu khung ảnh (chỉ có với đối tượng dạng ảnh) 

- Picture Border: chọn kiểu viền khung ảnh 

- Picture Effects: chọn kiểu hiệu ứng cho ảnh 
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+ Nhóm Shape Styles: các chế độ định dạng cho các đối tượng dạng hình vẽ và 

đồ thị, gồm: 

Shape Fill: chọn kiểu nền 

- Shape Outline: chọn kiểu viềt 

- Shape Effects: chọn kiểu hiệu ứng cho hình vẽ 

+ Nhóm Arrange: căn chỉnh vị trí, khoảng cách giữa các đối tượng đồ họa, 

gồm: 

- Position: Chọn vị trí đối tượng so với dòng văn bản 

- Bring to front: đưa lên trên cùng 

- Send to back: đưa xuống dưới cùng 

- Text Wrapping: chọn chế độ dòng văn bản bao quanh đối tượng (bao theo 

hình vuông, bao chặt hay phủ lên trên …) 

- Align: dóng hàng các đối tượng được chọn 

- Group: nhóm và bỏ nhóm các đối tượng được chọn 

- Rotate: quay, lật các đối tượng 

+ Nhóm Size: điều chỉnh kích cỡ chính xác các đối tượng 
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- Height: điều chỉnh chiều cao 

- Width: điều chỉnh độ rộng 

- Crop: cắt tranh 

+ Nhóm Shadow Effects: lựa chọn các hiệu ứng bóng hai chiều 

+ Nhóm 3-D Effects: lựa chọn các hiệu ứng bóng ba chiều 

+ Nhóm WordArt Styles: chọn mẫu định dạng chữ nghệ thuật 

+ Bên cạnh menu Format để định dạng chung các đối tượng đồ họa, thì với 

những loại như biểu đồ, đồ thị còn có thêm hai menu là Design và Layout 

- Design: chỉnh sửa thiết kế, dữ liệu (đối với đồ thị) 

- Layout: chỉnh sửa giao diện 

Có một điểm cần lưu ý, tất cả các tính năng nói trên của Word 2010 chỉ hiển thị 

khi văn bản được tạo và lưu theo định dạng Word 2010 (có đuôi là .docx). Nếu 

lưu ở định dạng Word 2003 thì những tính năng riêng có của Word 2010 như 

các dạng biểu đồ đặc biệt, các kiểu định dạng đổ bóng, tạo hiệu ứng nổi … sẽ 

bị ẩn đi. 

1. S  d ng Word 2010 để viết Blog 

  

 

http://www.helloict.com/su-dung-word2007-viet-blog-253
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Mỗi khi bạn viết bài mới cho Blog của mình, bạn thường soạn thảo bằng công 

cụ của hệ thống Blog đó. Tuy nhiên, công cụ soạn thảo thường không đáp ứng 

được các chức năng 

mà bạn cần và cũng hay bị mất bài khi kết nối internet bị rớt! Nếu bạn đang sử 

dụng bộ Office 2010, bạn có thể dùng Word 2010 để làm công cụ soạn thảo 

mỗi khi 

viết Blog. 

Các s  d ng nhƣ sau   

Bƣớc 1  Nhấp vào nút Office bên góc trái trên 

cùng >> New >> nhấp kép lên nút New Blog Post 

 

Bƣớc 2  Chương trình sẽ nhắc bạn đăng ký tài khoản của blog với ứng dụng. 

Nhấp nút Register now. Nếu bạn không gặp hộp thoại yêu cầu tạo tài khoản 

bạn có thể nhấp vào 

nút quản lý tài khoản Manage account trên thanh công cụ Blog Post. 

 

http://www.helloict.com/tag/blog
http://www.helloict.com/tag/blog
http://www.helloict.com/tag/office-2007
http://www.helloict.com/tag/word
http://www.helloict.com/tag/blog
http://www.helloict.com/tag/blog
http://www.helloict.com/tag/blog
http://www.helloict.com/tag/blog
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Bƣớc 3  Trong bảng quản lý tài khoản, bạn nhấp 

New để tạo tài khoản tới tài khoản của Blog. Tiếp đến, bạn chọn hệ thống blog 

nào bạn đang dung, Cung cấp username và password. 

 

Bƣớc 4  Giờ thì bạn có thể soạn bài viết của mình trên Word 2007.  

Sau khi hoàn thành, để xuất bản lên Blog, bạn click nút Publish >> chọn 

Publish để đăng bài ngay hay nút publish as draff để lưu lại bản nháp.  

 

Ngoài ra bạn có thể dùng các nút trên thanh công cụ Blog post khác như xem 

trang chủ (nút Homepage), chỉnh sửa (nút Open Existing).  

2. T o m c l c trong Word 2010 

Cách dễ nhất để t o m c   c tự động  à t n d ng các Heading Sty es mà 

b n muốn gộp chúng trong m c   c. Ví dụ: Có Heading 1, Heading 2, …tùy 

http://www.helloict.com/tag/blog
http://www.helloict.com/tag/blog
http://www.helloict.com/tag/password
http://www.helloict.com/tag/word
http://www.helloict.com/tag/blog
http://www.helloict.com/tag/blog
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theo nội dung của tài liệu. Khi bạn thêm hoặc xóa bất kỳ Heading nào từ tài 

liệu, Word sẽ cập nhật vào mục lục tự động. Word cũng cập nhật số trang trong 

mục lục khi thông tin trong tài liệu được thêm hoặc xóa. Khi bạn tạo một mục 

lục tự động, điều đầu tiên bạn nghĩ là đánh dấu các mục trong tài liệu. Mục lục 

được định dạng lựa vào các cấp độ của các Heading. Cấp độ 1 sẽ bao gồm bất 

kỳ nội dung nào được định dạng với kiểu Heading 1. 

Đánh dấu m c   c 

Bạn có thể đánh dấu các mục trong mục lục tự động theo một trong hai cách 

sau: sử dụng các Heading được xây dựng sẵn, hoặc đánh dấu các mục văn bản 

riêng. 

Sử dụng các Heading Styles được cài sẵn: 

• Lựa chọn nội dung bạn muốn định dạng thành Heading 

• Chọn tab Home 

• Trong nhóm Styles, Chọn Heading 1 (hoặc chọn heading tùy ý) 

 

• Nếu bạn không thấy Style bạn muốn, Chọn vào mũi tên để mở rộng Quick 

Styles Gallery 

• Nếu style bạn muốn không xuất hiện, Chọn Save Selection as New Quick 

Style 
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Để đánh dấu các mục: 

• Lựa chọn nội dung bạn muốn tạo Heading 

• Chọn tab References 

• Chọn Add Text trong nhóm Table of Contents 

• Chọn Level bạn muốn áp dụng cho nội dung đã chọn 

 

T o m c   c tự động 

Để tạo mục lục tự động 
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• Đặt con trỏ vào tài liệu nơi bạn muốn đặt mục lục tự động 

• Chọn Tab References 

• Chọn nút Table of Contents, Chọn vào Insert Table of Contents và định 

dạng mục lục theo cách riêng của mình. 

 

 

 

C p nh t Tab e of contents 
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Sau khi đã tạo ra bảng mục lục cho tài liệu, có thể bạn phải duy trì nó. Bảng 

mục lục sẽ tự động cập nhật khi tài liệu được mở; và còn hay hơn nữa khi nó 

cũng tự cập nhật bất cứ khi nào bạn thêm tên chương hoặc tiêu đề mới vào và 

làm thay đổi số trang của tài liệu. Chỉ cần thực hiện 2 bước sau: Bạn cập nhật 

mục lục bằng cách Click vào tab References và sau đó chọn Update Table 

trong nhóm Table of Contents.  

 

Khi cập nhật bảng mục lục bạn sẽ được hỏi rằng bạn muốn cập nhật toàn bộ 

mục lục hay chỉ muốn điều chỉnh số trang.  

 

Chọn điều chỉnh số trang nếu bạn thêm nội dung làm tăng số trang trong tài 

liệu mà không thêm tiêu đề nào mới, còn nếu bạn thêm hoặc thay đổi nội dung 

tiêu đề thì nên chọn Update entire table. Bạn nên tránh việc sửa chữa trực tiếp 

vào bảng mục lục, vì nếu bạn đã từng cập nhật bảng mục lục thì bạn sẽ mất dữ 

liệu đã thay đổi. Để thay đổi nội dung trong bảng mục lục, thì hãy chỉnh sửa 

trên tài liệu, chứ không sửa trực tiếp trên bảng mục lục, sau đó click Update 

Table. 

Xóa m c   c tự động 

Để xóa mục lục tự động: 
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• Chọn tab Referencs trên nhóm Ribbon 

• Chọn Table of Contents 

• Chọn Remove Table of contents. 

 

Điều chỉnh m c   c 

Bạn đã có một bảng mục lục rồi, nhưng bạn lại muốn thay đổi chúng. Ví dụ 

tiêu đề trong tài liệu của bạn có màu xanh nhưng trong bảng mục lục thì không. 

Bạn thích màu xanh và muốn trong bảng mục lục cũng có màu trùng với các 

tiêu đề trong tài liệu. Có thể bảng mục lục quá dài và bạn muốn làm nó ngắn 

bớt. 

Hoặc cũng có thể bạn đã hài lòng về bảng mục lục nhưng vẫn muốn có một 

thay đổi nhỏ. Chẳng hạn bạn muốn thay đỗi các đường chấm đứt quãng giữa 

các đề mục và số trang. Hoặc bạn muốn số trang nằm gần các đề mục hơn. 

Thiết kế   i bảng m c   c 

Bạn đã có bảng mục lục, nó trông có vẻ ổn, nhưng bạn muốn màu sắc tương tự 

như tiêu đề. Đây là cách thực hiện: Trên Tab References, chọn Table of 

Contents trong nhóm Table of Contents và sau đó chọn Insert Table of 

Contents. 

Trong hộp thoại Table of Contents, chắc chắn rằng mục From template đã 

được đánh dấu trong hộp Formats, sau đó chọn Modify. Chọn TOC 1 trong 
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hộp thoại Style để chọn cấp độ cao nhất hoặc Level 1, trong bảng mục lục TOC 

và sau đó chọn Modify. Hộp thoại Modify Style được mở ra, sử dụng hộp màu 

Font trong phần Formatting để chọn màu xanh. Sau khi click OK hai lần, hãy 

xem trong mục Print Preview của hộp thoại Table of Contents và bạn sẽ thấy 

rằng Table of Contents, hay còn được viết tắt là TOC 1 (hay Level 1), bây giờ 

là màu xanh. Nếu bạn muốn thay đổi TOC 2 (Level 2) hay TOC 3 (Level 3) 

cũng thành màu xanh, thì bạn cũng làm theo quy trình trên bằng việc chọn 

TOC 2 hoặc TOC 3 trong hộp thoại Style trước khi đi đến hộp thoại Modify 

Style. Sau khi click OK, một hộp thoại xuất hiện với nội dung hỏi bạn có muốn 

thay đổi bảng mục lục hay không, click OK và kết quả sẽ hiện thành màu xanh 

như ý muốn của bạn. 

Bạn muốn thay đổi nhiều hơn nữa? Word 2010cho người dùng nhiều tùy chọn 

để chọn lựa trong hộp thoại Modify Style, nhưng hãy luôn nhớ chọn Style mà 

bạn muốn thay đổi trong hộp thoại Style trước khi thực hiện chức năng Modify 

Style. Chú ý rằng khi click Format, bạn sẽ có lựa chọn thay đổi như Font, 

Paragraph, Tabs, … bạn cũng có thể thay đổi các cài đặt của từng phần và xem 

lại chúng trong mục Preview trước khi áp dụng cho bảng m c   c. 

Cách  àm ngắn hoặc kéo dài bảng m c   c 
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Bảng lục lục quá dài, có lẽ chỉ cần hai cấp độ đầu tiên TOC 1 và TOC 2 là phù 

hợp với tài liệu của bạn. Mục Show levels ở hộp thoại Table of Contents là 

nơi bạn có thể chọn các phân cấp bạn muốn thể hiện trong bảng mục lục. Word 

2010có đến 9 cấp độ khác nhau. Làm ngắn bảng mục lục bằng cách giảm cấp 

độ, còn muốn kéo dài bảng mục lục thì bạn hãy tăng cấp độ lên. Bạn có thể 

xem trong Print Preview hoặc Web Preview để xem sự điều chỉnh của mình, 

khi nhận thấy hợp lý, thì click OK hai lần. 

Cách thay đổi đơn giản bảng m c   c 

Bạn có thể thực hiện các thay đổi nhỏ mà không cần rời khỏi hộp thoại Table 

of Contents. Chẳng hạn thay đổi các gạch đứt quãng giữ các đề mục và số 

trang (gọi là Tab Leader), hoặc thay đổi canh dòng (align) của số trang. 
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Để thay đổi Tab Leader, chọn mục Tab leader để xem lại kiểu gạch ngang và 

dòng. Nếu bạn xóa hộp Right align page numbers, thì số trang sẽ di chuyển 

lại gần hơn đến bảng mục lục và tab leaders sẽ không còn hiệu lực. Nếu bạn 

muốn xóa bỏ toàn bộ số trang thì hãy bỏ dấu chọn ở hộp Show page numbers. 

3. T o trang bìa trong Word 2010 

a. Thêm một trang bìa 

Word 2010 cung cấp sẵn cho bạn một bộ sưu tập các trang bìa khá đẹp mắt. 

Các trang bìa luôn được chèn vào đầu tài liệu, không phụ thuộc vào vị trí hiện 

tại của con trỏ trong tài liệu.  

- Trong thẻ Insert, nhóm Pages, bạn nhấn nút Cover Page.  

- Trong menu xuất hiện, bạn hãy nhấn chọn một kiểu trang bìa mình thích. 
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Trang bìa đó sẽ được áp dụng vào tài liệu và bạn có thể sửa đổi nội dung các 

dòng chữ mặc định bằng dòng chữ mình thích. 

 

b. Xóa trang bìa  

Để xóa trang bìa, bạn nhấn chuột vào thẻ Insert, nhấn nút Cover Page trong 

nhóm Pages, sau đó nhấn Remove Current Cover Page. 

4. Tìm nhanh từ đồng nghĩa trong Word 

Tra từ đồng nghĩa, phản nghĩa  

Sử dụng tính năng Research, bạn còn có thể tra từ đồng nghĩa và từ phản nghĩa.  

- Trong thẻ Review, nhóm Proofing, bạn nhấn nút Thesaurus.  

 

- Giữ phím Alt và nhấn chuột vào từ cần tra. Kết quả sẽ hiển thị trong khung 

Research ở bên phải.  
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- Để chèn từ đồng nghĩa hoặc phản nghĩa đó vào tài liệu hiện hành, nơi con trỏ 

đang đứng, bạn đưa chuột vào từ trong danh sách kết quả, nhấn chuột vào mũi 

tên bên cạnh từ, chọn Insert.  

- Để tìm tiếp từ đồng nghĩa / phản nghĩa của từ trong danh sách tìm được, bạn 

nhấn chuột vào từ đó trong danh sách kết quả.  

Ghi chú: Bạn có thể tìm từ đồng nghĩa, phản nghĩa trong ngôn ngữ khác (ngoài 

tiếng Anh) bằng cách nhấn chuột vào hộp danh sách bên dưới khung nhập liệu 

Search for và chọn một ngôn ngữ, ví dụ như tiếng Pháp (French) chẳng hạn. 



 

 

GIÁO TRÌNH WORD 2003-2007-2010 Page 337 

 

BÙI QUYẾT TIẾN 2011 

5. Gởi file qua Email từ môi trƣờng Word 

Dù vẫn hay mở hòm thư, chọn chức năng tạo mới rồi đính kèm file văn bản để 

gửi cho đối tác, bạn có thể thay đổi thói quen này bằng cách gửi ngay trên môi 

trường Word. Điều kiện là máy tính của bạn đã cài Outlook Express hoặc 

Microsoft Express. 

 

Khi có hòm thư e-mail do một máy chủ hỗ trợ (theo giao thức IMAP hoặc 

POP3), bạn có thể dùng Outlook Express, Microsoft Express. Hòm thƣ 

webmai  của Goog e (Gmai ) hay Yahoo cũng hỗ trợ giao thức POP3 

(nhƣng Yahoo chỉ d ng đƣợc tính năng này ở bản đóng phí). 

Các bước thực hiện như sau: 

- Mở một tập tin muốn gửi 

- Vào menu File > Share > Send Using E-mail. Chọn tiếp một kiểu để gởi 

email 

Như đã nói ở trên, lệnh này chỉ thành công khi Word phát hiện một hệ thống e-

mail tương thích và hoạt động khi các chương trình đó đã được cài đặt. 
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- Lúc này giao diện gửi thư hiện ra với các dòng như To..., CC...., Subject... 

Nếu không nhớ e-mail của người gửi, bạn nhấn vào biểu tượng hình quyển vở 

để đọc sổ địa chỉ và chọn > OK. 

- Biểu tượng có dấu mũi tên màu xanh và dấu chấm than sẽ giúp bạn đặt e-mail 

gửi đi của mình ở cấp độ ưu tiên nào (thấp, bình thường, cao). Bạn cũng có thể 

đính kèm các file khác ngay trên môi trường Word bằng cách nhấn vào biểu 

tượng chiếc kẹp ghim. 

- Sau đó, nhấn vào mục Send a copy. 

Chú ý rằng vào lần đầu tiên gửi thư theo cách này, có thể bạn sẽ được yêu cầu 

nhập ID, password và domain. Lúc này, bạn chỉ cần gõ lại đúng như khai báo 

đối với hòm thư Outlook hoặc Microsoft Express đã tạo trước đó. 

6. Thủ thu t d ng máy tính trong Word  

Mặc dù công năng chính của Microsoft Word là soạn thảo văn bản, song nó 

cũng cho phép người dùng thực hiện các phép tính cơ bản thông qua chiếc máy 

tính làm được tích hợp với tên gọi Tools Calculate (khá giống với tiện ích 

Calculator trong thư mục Accessories của hệ điều hành Windows).  

Để khai thác công cụ bí mật này của Microsoft Word, trước tiên, bạn cần đặt 

biểu tượng Tools Caculate của nó trên tab mới của cửa sổ soạn thảo văn bản 

bằng cách: 

Tạo Tab mới trên Ribbon: click phải lên Ribbon, chọn Customize the Ribbon: 

 

Hộp thoại Word Options hiển thị 
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Chọn New Tab, lần lượt đổi tên thành Tab Caculator, và group Tinh Toan 

Ở cột Choose commands from, chọn All commands, di chuyển thanh cuốn 

chọn Tools Calculate. Nhấn nút Add để thêm vào biểu tượng vào Tab 

Caculator 

Kế tiếp, bạn hãy nhập vào một phép tính, chẳng hạn ((90+10)*2)/50. Hãy đánh 

dấu khối phép tính này rồi nhấp chuột lên nút Tools Calculate. Kết quả của 

phép tính sẽ được trình bày ở góc dưới trái của cửa sổ soạn thảo văn bản (nằm 

ngay sau dòng chữ The sesult of the calculation is).  
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7. Thủ thu t tránh in văn bản ngoài ý muốn 

Có thể hàng ngày bạn vẫn soạn thảo tài liệu bằng chương trình Word, nhưng vì 

yêu cầu an toàn thông tin mà bạn tuyệt đối không được in ra một khi chưa cần 

thiết. Tuy nhiên, chức năng Print trên thanh công cụ của Word luôn thường 

trực sẵn sàng để thực hiện lệnh in cho dù bạn nhỡ tay bấm nhầm.  

Để khống chế chức năng in tức thời không cần xác nhận của Word, bạn có thể 

thiết lập tùy chọn thông báo trước khi thi hành lệnh in. Tùy chỉnh này rất cần 

thiết trong trường hợp bạn thường xuyên xử lý hay xem lại những trang tài liệu 

bí mật nhất là trong văn phòng sử dụng máy in nối mạng.  

Trước hết bạn cần nhấn vào nút Office có biểu tượng đặt tại góc đỉnh phía trái 

màn hình. Chọn nút Word Options, kế tiếp chọn Trust Center trong danh 

sách, rồi chọn nút Trust Center Settings 
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Và nhấn vào Privacy Options.  Sau đó nhấn chuột đánh dấu mục Warn before 

printing... và bấm nút OK. 

 

             

Ngoài ra còn có một cách định dạng khác đối với những tài liệu mang nội dung 

riêng tư, đơn giản đó là giải pháp không cho in văn bản ra giấy. Bạn cần lựa 

chọn toàn bộ trang văn bản (Ctrl+A), sau đó bấm nút chuột phải và chọn mục 
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Font trong trình đơn thả, đánh dấu vào mục Hidden rồi ấn nút OK.  

 

Kết thúc bước này, nội dung văn bản của bạn đã được ẩn đi. Để hiện lại trên 

màn hình, bạn vào Tab File/Options, nhấn đánh dấu mục Hidden text sau đó 

đừng quên nhấn nút OK.  

 



 

 

GIÁO TRÌNH WORD 2003-2007-2010 Page 343 

 

BÙI QUYẾT TIẾN 2011 

Hoàn thành bước này, toàn bộ nội dung văn bản hiển thị trở lại trên màn hình 

tuy nhiên nếu in bạn sẽ chỉ được kết quả là trang giấy trắng.  

8. Mẹo in hình khổ giấy lớn bằng máy in nhỏ 

Bạn có một máy in màu chỉ in được cỡ giấy A4 nhưng lại muốn in ra những 

tấm ảnh có kích thước “khổng lồ” để trang trí trong gia đình? Công cụ mang 

tên “The Rasterbator” sẽ giúp bạn thực hiện điều tưởng như bất khả thi này. 

  

Chương trình sẽ khéo léo “cắt” tấm ảnh số của bạn ra thành rất nhiều phần nhỏ 

bằng nhau với kích thước của mỗi phần bằng đúng khổ giấy A4. Bạn chỉ việc 

in ra toàn bộ những phần này, sau đó ghép lại với nhau cho chính xác như trò 

chơi ghép hình của trẻ em và dán lên một nơi nào đó đã chuẩn bị sẵn, bạn sẽ có 

một tấm ảnh “to đùng” không thua kém gì lắm so với các poster quảng cáo.  

Sau khi chọn ngôn ngữ cho mình, thường là tiếng Anh, bạn nhấn vào 

“Continue” để vào các bước:  

Nhấn vào “Browse” để tìm đến bức ảnh cần in rồi nhấn “Open” để hiện ra 

đường dẫn đến tấm ảnh rồi nhấn “Continue”.  
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Chọn khổ giấy của máy in -> nếu tấm ảnh là khổ đứng thì chọn “Portrait”, nếu 

là khổ ngang thì chọn “Landscape”.  

Ở ô “sheets”, bạn thoải mái lựa chọn số tờ mà bạn cần “The Rasterbator” cắt 

ra cho mình. Lưu ý số tờ càng nhiều thì tấm ảnh của bạn càng lớn và có thể đến 

mức khổng lồ. Nên tính toán kỹ mặt bằng dán ảnh trước khi ra lệnh cho “The 

Rasterbator” cắt hình. Số tờ tối đa mà “The Rasterbator” có thể cắt cho bạn là 

đến 1.000 tấm, đủ sức tạo nên một bảng quảng cáo kinh khủng!  

Bản mới nhất của chương trình là “Rasterbator Standalone 1.2” có thể tải miễn 

phí tại http://arje.net/files/Rasterbator_Standalone_1.21.zip dưới dạng file nén 

ZIP có dung lượng 866 KB. Khi tải về máy xong, bạn chỉ việc bung thư mục 

chứa chương trình vào ổ cứng và nhấp đúp vào file Rasterbator.exe để chương 

trình tự động chạy, không 

11. Tạo nhanh một hoặc nhiều dòng ngẫu nhiên  

Nhằm phục vụ cho việc tạo ra một dòng, một trang hay nhiều trang trong word 

để có thể kiểm tra việc in ấn dễ dàng. Chúng ta có thể nhập vào dòng công thức 

sau: =lorem() thì mặc định với 3 đoạn, 6 dòng hoặc =lorem(số đoạn cần in ra, 

số dòng trên mỗi đoạn). Bên cạnh đó bạn có thể dùng lệnh rank với cú pháp 

tương tự như lệnh lorem.  

12. Tạo bảng bằng phím  

Bằng sự kết hợp giữa phím “+” và “–”, phím Enter và phím Tab trên bàn phím, 

chúng ta có thể dễ dàng và nhanh chóng tạo ra các bảng tính. Giả sử, bạn cần 

tạo một bảng tính 4 cột và có 4 dòng, bạn thực hiện như sau: Đầu tiên bạn nhấn 

+----+----+-------------+---------+ sau đó nhấn Enter ở cuối dòng. Một bảng tính 

được xuất hiện, tiếp theo, bạn đặt con trỏ chuột ở cột cuối cùng và nhấn Tab, 

một dòng mới sẽ xuất hiện. Độ rộng của bảng tính chính bằng số dấu “-” mà 

bạn đã nhấn lúc tạo bảng. Tuy nhiên bạn có thể thay đổi độ rộng này khi nhập 

liệu.  

http://arje.net/files/Rasterbator_Standalone_1.21.zip
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13. Tạo đường kẻ  

Để tạo nhanh các đường kẽ ngang của một trang tài liệu, bạn chỉ cần sử dụng 

các đặc biệt có trên bàn phím. Các phím -, =, *, #,~ khi được nhấn tương ứng 

từ 3 phím mỗi loại trở lên sẽ tạo ra đường kẻ đơn, đôi, ba, đường chấm đứt nét 

và đường dzíc dzắc. Khi đó bạn không cần phải vào danh mục trên Ribbon để 

thực hiện. Ví dụ để tạo đường kẽ đôi, bạn chỉ cần nhấn === và nhấn enter là 

xong.  

14. Bỏ tính năng tự động SuperScript  

Thông thường, khi bạn gõ vào ngày theo kiểu anh hoặc những ký tự tương tự 

như 1st, 2nd,...,7th,…thì Word sẽ tự động SuperScript ký tự đó thành 1st, 2nd, 

…,7th,….Nếu bạn không muốn vậy, sau khi gõ xong mỗi cụm ký tự, bạn nhấn 

Ctrl +Z để Word bỏ áp dụng thiết đặt đối với cụm ký tự đó. Nếu bạn muốn áp 

dụng đối với toàn bộ các cụm ký tự cho văn bản thì bạn hãy vào biểu tượng 

Office ở góc trên – bên trái, sau đó chọn Word Options. Tiếp theo bạn chọn 

mục Proofing và chọn AutoCorrect Options. Trong cửa sổ AutoCorrect bạn 

chọn tab AutoFormat As You Type và check bỏ mục chọn Ordials(1st) with 

superscript như hình. 

15. Copy định dạng bảng tính  

Bạn vừa định dạng một ô trong bảng tính và có nhiều ô cần bạn định dạng 

giống như vậy. Bạn có thể di chuyển chuột để sử dụng chức năng Format 

Painter, nhưng điều đó sẽ tốn nhiều thời gian. Hãy định dạng một ô trong số 

những ô bạn cần định dạng và di chuyển chuột đến một vị trí cần sao chép định 

dạng, quét khối ô này và nhấn F4. Thế là định dạng mới sẽ được thiết đặt.  
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BÀI 1. KHỞI ĐỘNG WORD VÀ CỬA SỔ LÀM VIỆC 

Khởi động Word 

Bạn có thể khởi động 
Word bằng cách nháy 
vào 
nó 

biểu  tượng của 
trong  danh mục 

nhóm   chương   trình 
Microsoft  Office từ 
danh   sách Tất   cả 
chương     trình All 
Programs,  hoặc  có 
thể chạy  Word một 
cách tự  động mỗi lần 
khởi động máy tính. 
 
Sau khi chạy chương trình cài đặt, bạn sẽ thấy một nhóm các chương trình gọi
là "Microsoft   Office".   Nhóm chương trình bao  gồm biểu   tượng

nháy chuột vào biểu tượng này.
. Để khởi động Word, một cách đơn giản là

Màn hình soạn thảo văn bản
Khi lần  đầu khởi động  một  ứng dụng trong hệ Microsoft Office 2007, bạn sẽ
ngạc nhiên với những gì bạn thấy nếu bạn là người đã từng làm việc với các
phiên bản trước của Microsoft Office. Bảng chọn và thanh công cụ của phiên
bản cũ  đã  được thay  thế bởi Ruy-băng, phần giao diện người dùng uyển
chuyển của Microsoft Office. Vị trí tên tệp cũng đã thay đổi. Ngoài ra, bạn có
thể  nhìn thấy thanh trạng thái ở  dưới cùng màn hình, các thanh cuộn- thanh 
cuộn ngang ở ngay trên thanh trạng thái và thanh cuộn dọc nằm bên phải màn 
hình, và một con trỏ nằm trong vùng soạn thảo chỉ ra vị trí bạn sẽ gõ văn bản 
vào. Chúng ta sẽ lần lượt làm quen với các đối tượng này.

Tài liệu hướng dẫn 1



 Microsoft Office Word 2007 – Phần cơ sở

Ruy-băng (Ribbon) 

Ruy-băng xuất hiện trong Microsoft Office Word 2007.
 
Ruy-băng được thiết kế để giúp bạn tìm nhanh lệnh bạn cần để thực hiện công 
việc. Các lệnh được tổ chức thành các nhóm hợp lý dưới các tab. Mỗi tab liên 
quan tới một loại hành động chẳng hạn như viết hay bố trí trang. Để giảm sự 
lộn xộn, một số tab chỉ hiện khi cần đến. Ví dụ, tab Picture Tools chỉ hiện khi 
một hình được chọn. Sự thay đổi này làm công việc của bạn dễ dàng và nhanh 
hơn. 
 
Có ba cấu thành cơ bản của Ruy-băng. Bạn cần biết mỗi cấu thành được gọi là 
gì và sử dụng ra sao. 

Tabs.  Có  bảy  tab cơ  sở: Home, Insert, Page Layout,  References,
Mailings, Review và View. Mỗi tab tương ứng với một phạm vi hoạt động. 
 

Groups. Mỗi tab có một vài nhóm chỉ ra các mục liên quan với nhau. 
 

Commands. Một lệnh là một nút, một hộp để nhập thông tin hoặc một bảng 
chọn. 
 
Mọi thứ trên tab đã được chọn cẩn thận theo hoạt động của người dùng. Ví dụ,
tab  Home chứa tất cả  các thứ bạn thường dùng nhất, chẳng hạn lệnh trong
nhóm Font để thay đổi phông văn bản: Font, Font Size, Bold, Italic, v.v... 
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Một vài nhóm có mũi tên chéo nhỏ ở góc phải bên dưới. Mũi tên được gọi là
Hiện Hộp thoại (Dialog Box Launcher). Nếu bạn nháy vào nó, bạn sẽ thấy 
nhiều tùy chọn hơn liên quan đến nhóm. Bạn không  thấy lệnh này trong các 
phiên bản trước của Word. Các tùy chọn sẽ xuất hiện trong biểu mẫu của hộp 
thoại trông như các phiên bản trước của Word. 
 
Nếu bạn muốn có diện mạo của phiên bản trước khi làm việc với phiên bản này 
thì câu trả lời là không thể. Nhưng sau khi bạn làm quen với Ruy –băng và hãy 
thử xem cái gì ở đâu rồi bạn sẽ nhận ra nó sẽ giúp bạn thực hiện công việc dễ 
dàng hơn như thế nào. 
 
Ví dụ một số tab chỉ hiện khi cần đến, chẳng hạn tab Picture Tools chỉ hiện khi 
một hình được chọn. Sự thay đổi này làm công việc của bạn dể dàng và nhanh 
hơn. 
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Khi bạn chọn một hình, tab bổ trợ Picture Tools sẽ xuất hiện, chỉ ra nhóm các
lệnh để làm việc với hình. 
 

Chọn hình. 
 

 Tab Picture Tools xuất hiện. Nháy chọn tab.

Các nhóm và các lệnh bổ trợ xuất hiện để làm việc với hình; như  nhóm
Border hay Arrange. 
 
Khi bạn nháy  chuột ra ngoài hình, tab Picture Tools biến mất, và các nhóm 
khác trở lại. 

Nút Microsoft Office 
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Đã  xảy ra chuyện gì với bảng chọn File của phiên
Microsoft Office bạn sẽ tìm thấy nó.

bản trước?  Ấn nút 

Vị trí để bắt đầu một tài liệu Word là nút Microsoft Office.
 
Khi bạn nháy nút, một bảng chọn xuất hiện. Bạn nhận thấy rằng các lệnh cơ 
bản trong bảng chọn này như Mở, Lưu, và In các tệp của bạn giống với bảng 
chọn File trong các phiên bản trước của Word. Bên trái của bảng chọn, bạn 
thấy tất cả các lệnh để làm việc với tệp. 
 
Bên phải bảng chọn liệt kê các tài liệu đã mở gần nhất. Điều này rất thuận tiện 
để  bạn nhìn thấy ngay các tài liệu bạn làm việc với thường xuyên mà không 
cần phải tìm trong máy. 

Cực tiểu hóa Ruy-băng 

Không có cách nào  để xóa hay thay thế Ruy-băng bằng thanh công cụ hay
bảng chọn từ phiên bản trước của Microsoft Office. Tuy nhiên bạn có thể cực
tiểu hóa Ruy-băng để có thêm khoảng trống trên màn hình của bạn. 

Để luôn giữ Ruy-băng cực tiểu

1.  Nháy Customize Quick Access Toolbar   .

2.  Trong danh sách, nháy Minimize the Ribbon.
3.  Để dùng Ruy-băng khi nó đang cực tiểu, nháy tab bạn cần dùng, rồi nháy 

tùy chọn hay lệnh bạn cần dùng. 
 
Ví dụ, bạn cần thay đổi cỡ phông của văn bản, bạn chọn văn bản của bạn trong 
Microsoft Office Word, nháy tab Home, rồi chọn nhóm Font, nháy cỡ văn bản 
bạn cần. Sau khi bạn nháy cỡ văn bản bạn cần, Ruy-băng sẽ trở lại là cực tiểu.
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Để giữ Ruy-băng cực tiểu trong thời gian ngắn
 
Để nhanh chóng cực tiểu hóa Ruy-băng, nháy đúp vào tên của tab hiện hoạt. 
Nháy đúp để khôi phục lại Ruy-băng. Bạn cũng có thể dùng bàn phím để cực 
tiểu hóa hay khôi phục lại Ruy-băng bằng cách ấn phím CTRL+F1. 

Khôi phục lại Ruy-băng 

1.  Nháy Customize Quick Access Toolbar   .
2.  Trong danh sách, nháy Minimize the Ribbon.

Ẩn tạm thời Ruy-băng 
 
Nháy đúp vào tab hiện hoạt để ẩn các nhóm cho rộng chỗ. 
 
Khi bạn muốn thấy lại các lệnh, nháy đúp vào tab hiện hoạt để đưa các nhóm 
trở lại. 
 
Nếu bạn muốn các loại lệnh khác sẵn dùng thì sao? Hãy dùng Quick Access 
Toolbar (Thanh công cụ truy nhập nhanh).

Tùy chỉnh Quick Access Toolbar
 
Quick Access Toolbar là một thanh công cụ tùy chỉnh chứa tập hợp các lệnh
không phụ thuộc tab  được hiển thị hiện thời. Bạn có thể di chuyển  Quick
Access Toolbar từ một trong hai vị trí có thể, và có thể thêm các nút tương ứng
các lệnh vào Quick Access Toolbar.

Di chuyển Quick Access Toolbar
 
Quick Access Toolbar được định vị ở một trong hai vị trí:

Góc trên trái cạnh Microsoft Office (Nút Microsoft Office – vị trí mặc định)

Bên dưới Ruy-băng, phần giao diện người dùng uyển chuyển của Microsoft 
Office (Microsoft Office Fluent) 

1.  Nháy Customize Quick Access Toolbar   .
2.  Trong danh sách, nháy  Show

Ribbon. 
Below the Ribbon hoặc Show Above the

Thêm một lệnh vào Quick Access Toolbar
 
1.  Trên Ruy-băng, nháy tab hoặc nhóm thich hợp có hiển thị lệnh bạn muốn 

thêm vào Quick Access Toolbar.
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2.  Nháy phải vào lệnh, rồi nháy Add to Quick Access Toolbar trên bảng chọn
nối tắt. 

Loại bỏ một lệnh khỏi Quick Access Toolbar
 
Nháy phải vào nút muốn loại bỏ khỏi Quick Access Toolbar, rồi nháy Remove 
from Quick Access Toolbar trên bảng chọn nối tắt.

Tên tệp 
 
Góc trái trên của cửa sổ cho bạn thấy biểu tượng của chương trình soạn thảo 
văn bản Microsoft Office Word 2007, căn giữa dòng trên cùng của cửa sổ là tên 
tệp văn bản ví dụ như Document1 - Microsoft Word:

Ở đây, tên tệp văn bản bạn đang làm việc là Document1.docx. Tất cả các tên
tệp văn bản được soạn thảo bằng Word 2007 đều có phần mở rộng là .docx 
trừ khi bạn cho nó một phần mở rộng khác; vì vậy đôi khi ta chỉ cần tên tệp là 
đủ. 

Thanh công cụ Mini 
 
Làm bất cứ việc gì mà không có những công cụ thích hợp đều tốn phí thời gian 
và vất vả, thậm chí trong nhiều trường hợp không thể thực hiện được. Không gì
dễ  chịu và thân thiện  bằng việc bạn soạn thảo văn bản trên máy tính cũng
giống như bạn cầm bút viết trên bàn giấy, một công việc đã quen thuộc với bạn.
Chính vì vậy, những người phát triển hệ soạn thảo văn bản Word cố gắng cung 
cấp cho bạn một môi trường làm việc quen thuộc để thời gian làm quen của 
bạn với môi trường làm việc mới được rút ngắn một cách tối thiểu. Với Word,
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bạn còn có thể làm được nhiều việc một cách nhanh chóng và có hiệu quả mà
bạn không thể ngờ tới. 
 
Word cung cấp cho người dùng nhiều công cụ khác nhau để hỗ trợ cho nhiều 
công việc, từ  soạn thảo, định dạng chuẩn tới việc thiết lập các bảng biểu tùy 
thích, thiết kế các hình vẽ cũng như chèn các hình vẽ đã có sẵn và bạn còn có 
thể tạo ra các hiệu ứng đặc biệt. Chúng ta sẽ học cách sử dụng thanh công cụ 
Mini để định dạng tài liệu của bạn. 
 
Khi bạn chọn văn bản và trỏ vào nó, thanh công cụ Mini nửa trong suốt sẽ xuất 
hiện. Thanh công cụ Mini sẽ giúp bạn làm việc với các phông, kiểu phông, cỡ 
phông, căn chỉnh, màu văn bản, mức thụt lề và các dạng dấu đầu dòng. 

Bạn muốn  định dạng nhanh đoạn văn bản khi đang làm việc trong tab Page
Layout. Bạn có thể nháy tab Home để dùng các lựa chọn định dạng, có cách
làm nhanh hơn như sau: 
 

Chọn văn bản của bạn bằng cách kéo chuột, rồi trỏ vào đoạn đã chọn. 

 Thanh công cụ Mini sẽ xuất hiện rõ dần. Nếu bạn trỏ vào thanh công cụ Mini,
nó sẽ hiện nguyên hình, và bạn có thể nháy vào tùy chọn định dạng ở đó. 

Lưu ý Bạn không thể tùy chỉnh thanh công cụ Mini.
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Tắt Thanh công cụ Mini 

1.  Nháy nút Microsoft Office, rồi nháy Word Options
2.  Nháy  Popular, dưới Top options for working with Word, xóa hộp kiểm

Show Mini Toolbar on selection.

Thước đo 
 
Màn hình hay đánh lừa con mắt của chúng ta, nhất là khi con mắt của chúng ta 
bị mỏi mệt. Đôi khi những hình vẽ hay câu chữ được in ra rất chuẩn, nhưng khi 
được hiển thị trên màn hình, chúng bị méo mó hay kích thước của chúng không 
còn giữ được tỷ lệ thực tế. Để hỗ trợ cho công việc của người sử dụng, màn 
hình của Word cung cấp cho ta hai thước đo, thước đo ngang và thước đo dọc, 
để ta có thể kiểm tra một cách tương đối kích thước "trang viết" của mình để
căn chỉnh văn bản,  đồ họa, bảng biểu và các yếu tố khác trong tài liệu. Tất
nhiên là không phải lúc nào chúng ta cũng cần tới thước. Vì vậy ta có thể hiển
thị chúng một cách tùy chọn. 
 
Để hiển thị thước ngang phía trên của tài liệu Word và thước đứng dọc theo lề 
trái tài liệu của bạn chỉ có thể làm được khi hiển thị văn bản dưới chế độ Print 
Layout. 

Hiện và ẩn thước đo 
 
Để hiện hay ẩn thước đo ngang và thước đo dọc, nháy View Ruler ở trên cùng 
thanh cuộn dọc. 

Lưu ý: Thước đo ngang sẽ không xuất hiện nếu nó bị tắt. Để bật thước đo
ngang, làm như sau: 

1.  Nháy nút Microsoft Office, rồi nháy Word Options.
2.  Nháy Advanced. 
3.  Dưới Display, chọn hộp kiểm Show vertical ruler in Print Layout view. 
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Đổi đơn vị đo trên thước 
 
Để phù hợp với nhiều dạng công việc khác nhau cũng như tập quán sử dụng 
đơn vị đo trên nhiều vùng địa lý, chúng ta có thể lựa chọn đơn vị đo chiều dài
trên thước.  Word cho ta năm phương thức lựa chọn: đo lường theo  đơn vị
chuẩn quốc tế hiện tại là Centimeters, Milimeters, Inches, và Points sử dụng ở
phương Tây, nhất là các nước thuộc Liên hiệp Anh và Mỹ, và Picas, một đơn vị 
đo truyền thống trong ấn loát (typography). Với năm loại đơn vị này, nhu cầu về 
sở thích của mọi tầng lớp người sử dụng đều được thỏa mãn. Thực hiện theo 
các bước sau: 

1.  Nháy nút Microsoft Office, rồi nháy Word Options.
2.  Nháy Advanced. 
3.  Dưới Display, chọn đơn vị tùy ý bằng cách nháy mũi tên trong hộp Show 

measurements in units of:

Ngoài các số đo trên thước còn có các con trỏ dùng để định dạng (căn lề) từng
đoạn văn bản như được minh họa trong hình dưới đây:
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Thanh trạng thái 
 
Ở dưới cùng của cửa sổ là thanh trạng thái (Status bar). Những thông tin xuất
hiện trên thanh trạng thái tùy thuộc vào công việc mà bạn đang thực hiện.
Thanh trạng thái hiển thị những mô tả ngắn gọn về lệnh đang được tiến hành,
ví dụ như lưu văn bản vào đĩa cứng (Save) thì trên thanh trạng thái sẽ  xuất 
hiện thông báo cho biết như hình dưới:

Dấu chèn và thanh cuộn 
 
Điểm chèn (đôi khi ta gọi là con trỏ hay điểm nháy do nó nhấp nháy liên tục) 
trên màn hình chỉ ra nơi xuất hiện của ký tự bạn gõ vào. Khi bạn gõ liên tục các 
ký tự vào văn bản, màn hình sẽ được cuộn từ trái sang phải và từ trên xuống 
dưới sao cho có thể nhìn thấy được dấu chèn trên màn hình. Nếu muốn chèn 
ký tự mới (hay bất kỳ một đối tượng nào, chẳng hạn hình vẽ) vào một vị trí nào 
đó, bạn phải di chuyển dấu chèn tới vị trí đó. 
 
Chúng ta cũng có thể dùng chuột để điều chỉnh các thanh cuộn ở bên phải và 
phía dưới của màn hình để có thể làm thay đổi các phần khác của văn bản. 
Luôn luôn lưu ý rằng việc dịch chuyển các thanh cuộn không làm thay đổi vị trí 
dấu chèn trên văn bản. Do vậy, sau khi cuộn màn hình, nếu bạn muốn gõ các 
ký tự mới vào vùng văn bản đang được hiển thị, bạn phải dùng chuột và nháy 
vào vị trí mới đó. Bằng không, một khi bạn gõ ký tự mới vào, màn hình sẽ hiển 
thị đoạn văn bản có chứa dấu chèn và ký tự mới được gõ vào sẽ xuất hiện tại 
chỗ dấu chèn. 
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Di chuyển dấu chèn 
 

Cách đơn giản nhất để di chuyển dấu chèn là dùng chuột: bạn hãy di chuột sao 
cho con trỏ của chuột có dạng chữ I, di con trỏ tới nơi bạn muốn và nháy chuột. 
Ngoài ra chúng ta còn có thể sử dụng các phím mũi tên trên bàn phím. 
 

Để hỗ trợ việc di chuyển nhanh dấu chèn bằng bàn phím, Word cung cấp cho 
ta các tính năng sau: 
 
Dịch chuyển sang trái hay sang phải một từ CTRL + ← hay CTRL + →

Dịch chuyển tới đầu dòng hay cuối dòng home hay end 

Dịch chuyển tới đầu đoạn văn có chứa dấu chèn CRTL + ↑ 

Dịch chuyển tới đầu đoạn văn tiếp theo ctrl + ↓ 
 
Dịch chuyển tới đầu đoạn văn trước đó CTRL + hai lần ↑ 

Dịch chuyển lên hay xuống một trang màn hình page up hay page down 

Chuyển tới đầu hay cuối văn bản ctrl + home hay ctrl + end 

Chuyển tới vị trí vừa soạn thảo trước đó                    shift + f5 

Sử dụng các thanh cuộn 
 

Hai thanh cuộn nằm  ở bên phải và cuối màn hình soạn thảo  được sử dụng
trong việc "Giở lướt" văn bản (theo chiều dọc và chiều ngang) đang được hiển
thị để xem những phần bị che khuất. Tại hai đầu thanh cuộn có hai nút tam giác
và giữa chúng là một hình chữ nhật. Muốn cuộn văn bản theo chiều nào, bạn
chỉ cần nháy chuột ở những nút hình tam giác có mũi nhọn hướng về chiều đó.
Nếu cuộn theo chiều đứng, mỗi một lần nháy chuột ở các nút có hình tam giác
văn bản trên màn hình sẽ được cuộn một dòng còn nếu nháy chuột ở khoảng
trống trên hay dưới nút hình vuông nó sẽ cuộn một "màn hình". Tác động cũng
tương tự như khi bạn cuộn văn bản theo chiều ngang, chỉ có khác là thay vì
một dòng, bạn sẽ thấy văn bản được cuộn với một khoảng cách nào đó. 
 

Nếu bạn cần phải cuộn nhanh tới vị trí muốn xem thì hãy kéo và thả chuột ở
các nút hình chữ nhật. Nhắc lại rằng, khi cuộn bằng chuột, bạn không làm dịch
chuyển dấu chèn; nếu muốn cố  định phần đang nhìn thấy trên màn hình bạn
phải nháy chuột tại một vị trí nào đó trong trang văn bản. Ngoài ta, trên thanh
cuộn đứng còn có các nút phụ, khi nháy ở đó bạn có thể lật giở theo từng mục
văn bản (chứ không phải "trang màn hình"), và một nút tròn  để hiển thị các
phương thức cuộn đặc biệt, chẳng hạn như theo đề mục, theo hình vẽ hay theo
biểu bảng v.v…(xem hình dưới đây) 
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Các nút ở bên phải thanh cuộn ngang, cạnh phần Thu phóng là các nút "nóng"
dùng để chuyển đổi các chế độ xem tài liệu trên màn hình (xem mục dưới) 

Các chế độ xem tài liệu trên màn hình.
 
Với hệ soạn thảo văn bản Word, bạn có thể xem tài liệu trên màn hình bằng 
năm chế độ khác nhau, mỗi một cách được gắn với một biểu tượng riêng biệt. 
Với mỗi cách, bạn sẽ xem chi tiết văn bản dưới nhiều khía cạnh khác nhau, phù 
hợp với tính chất của các công việc của bạn. Vị trí của dấu chèn không thay đổi 
khi bạn chuyển từ cách xem này sang cách xem khác. 
 
Hơn thế nữa, bạn có thể "phóng to" hay "thu nhỏ" phần tài liệu mà bạn muốn 
xem tùy theo ý bạn muốn xem ở mức độ chi tiết hay là xem "toàn cảnh". Thậm 
chí, khi cần thiết màn hình có thể hiển thị  tài liệu trên toàn bộ  màn hình hay 
xem các phần khác nhau cùng một văn bản trên hai cửa sổ khác nhau. 
 
Muốn chuyển đổi cách xem, ta chọn tab View trong nhóm Document Views.
Bạn sẽ thấy  năm nút có các biểu tượng như trình bày dưới đây.  Để chuyển
sang một chế độ hiển thị nào đó, ta chỉ cần nháy chuột ở nút đó. 

Print Layout (bố trí in): Dùng để xem văn bản trên toàn trang, chẳng hạn
vị trí của các hình vẽ trên trang in hay là vị trí tương đối của các văn bản trên 
trang. Chế độ hiển thị này thích hợp để xem văn bản lần cuối cùng trước khi in 
ra giấy. 
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 Full Screen Reading để phóng to văn bản trên toàn bộ màn hình. Trong
chế độ xem này bạn có thể lựa chọn để xem tài liệu trong các cách khác nhau. 
Nháy View Options, và thực hiện một trong các cách sau:

� 
� 
� 

Để hiển thị văn bản cỡ lớn hơn, nháy Increase Text Size. 
Để đọc nhiều chữ hơn trên màn hình, nháy Decrease Text Size. 
Để hiển thị trang như nó sẽ được in ra, nháy Show Printed Page. 

� Để hiển thị cùng lúc hai trang, nháy Show Two Pages . 

 Web Layout (bố trí Web): Chế độ xem này cho ta hình dung trang tài liệu
hiển thị như trang Web. 
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Draft (bản thảo):  Đây là cách xem thích hợp cho việc soạn thảo văn bản
từ bàn phím, định dạng và bố trí trang được đơn giản hóa cũng như di chuyển 
các phần của một văn bản trong phạm vi chính nó.

Outline (dàn bài): Như tên gọi của nó, chế độ xem này chủ yếu dùng để
phác thảo cấu trúc của một văn bản, sau đó soạn thảo chi tiết từng mục một. 

Tắt chế độ xem Full Screen Reading
 
Nháy Close ở góc trên phải của màn hình, hoặc ấn ESC.

Nhảy tới một phần của tài liệu
 
Bạn có thể dùng Document Map hoặc Thumbnails (hình thu nhỏ) để tìm các 
phần của tài liệu mà bạn muốn nhảy tới. 
 
Nếu Document Map hoặc Thumbnails chưa được hiển thị, nháy Jump to a 
page or section in a document ở trên giữa của màn hình,

 sau đó nháy Document Map hoặc Thumbnails.

Thực hiện một trong các cách sau:
 
� Để nhảy tới  đầu mục bất kỳ 

Document Map. 
trong tài liệu, nháy vào đầu mục  đó  trong
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� Để nhảy tới một trang đặc biệt, nháy vào hình thu nhỏ của trang đó. 

Đánh dấu một tài liệu 
 
Trong chế độ Full Screen Reading, bạn có thể tô sáng nội dung, theo dõi các 
thay đổi của bạn, thêm nhận xét, và duyệt lại các thay đổi.

Tô sáng nội dung bạn muốn nhớ
 
1.  Nháy Reading Tools, rồi nháy Text Highlight Color.
2.  Chọn văn bản hay đồ họa bạn muốn tô sáng.

LƯU Ý 
 
� Để tắt tô sáng, nháy Reading Tools, nháy Text Highlight Color, rồi nháy 

Stop Highlighting, hay ấn ESC. 
� Để đổi màu tô sáng, nháy Reading Tools, nháy vào mũi tên bên cạnh Text 

Highlight Color, rồi nháy vào màu bạn muốn.

Hiển thị văn bản với tỷ lệ thích hợp
 
Để phóng to hơn nữa các chi tiết trên màn hình, Word còn cung cấp cho ta một

thanh trượt Zoom ở góc dưới bên  phải của thanh
trạng thái. Nháy chuột vào con trượt sang phải hoặc sang trái để phóng to lên
hay thu nhỏ lại theo ý muốn của bạn.
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Chọn một thiết đặt thu phóng đặc biệt
 
Bạn có thể chọn cách xem tài liệu trên màn hình theo một trong các cách sau: 
 
1.  Trên tab View, trong nhóm Zoom, nháy Zoom 100%.

2.  Trên tab View, trong nhóm Zoom, nháy One Page, Two Pages, hay Page
Width. 

3.  Trên tab  View tab, trong nhóm Zoom,  nháy Zoom, rồi nhập số phần trăm 
hay lựa chọn thiết đặt nào nào khác mà bạn muốn.

Soạn thảo đồng thời các phần khác nhau của một văn bản 
 
Chúng ta có thể xử lý đồng thời hai đoạn văn bản khác nhau của cùng một văn 
bản. Các đoạn văn bản này được hiển thị trên hai ô cửa sổ khác nhau và bạn 
có thể thực hiện mọi thao tác soạn thảo văn bản trong từng cửa sổ như trong 
cửa sổ lớn. Bất cứ một sửa đổi nào trong một ô cửa sổ cũng đều được phản 
ánh trong ô cửa sổ kia. Thậm chí, bạn có thể hiển thị từng ô cửa sổ theo từng 
chế độ khác nhau. 
 
Để tách cửa sổ soạn thảo thành hai cửa sổ, chúng ta có thể thực hiện theo hai 
cách: 

� Chọn tab View, trong nhóm Window nháy . Khi đó sẽ xuất hiện một
vạch ngang màn hình và nếu bạn nháy chuột khi vạch ngang ở đâu thì cửa 
sổ được phân chia thành hai tại đó. Nếu không muốn làm việc trong chế độ 
hai cửa sổ nữa, ta di chuột đến đường phân cách khi con trỏ của chuột trở 
thành hai đoạn thẳng song song có hai mũi tên chĩa xuống và chĩa lên rồi 
nháy đúp chuột, ta sẽ trở lại cửa sổ chính.
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� Nháy  đúp chuột lên phần trên cùng của thanh cuốn đứng chỗ có vạch

ngang như mũi tên chỉ trong hình , cửa sổ được phân chia thành hai,
bạn hãy nháy đúp chuột và màn hình sẽ được tách thành hai cửa sổ bằng 
nhau. Muốn trở lại cửa sổ soạn thảo chính, nháy đúp chuột vào vạch phân 
cách. 
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BÀI 2. SOẠN MỘT TÀI LIỆU ĐƠN GIẢN

Làm việc với các tệp văn bản
 
Sau khi làm quen với màn hình của Word, chúng ta đã có thể bắt tay vào việc 
soạn thảo văn bản. Khi khởi động, Word cung cấp cho bạn ngay một tệp văn 
bản trống với tên ngầm định là Document1.docx. Nếu không có nhu cầu gì đặc 
biệt, bạn có thể tạm thời làm việc trên tệp ngầm định này.

Tạo tệp văn bản mới 
 
Để tạo một tệp văn bản mới, bạn có thể thực hiện theo cách sau đây: 

1.  Nháy nút Microsoft Office, rồi nháy New.

2.  Dưới Templates, bạn sẽ thấy các lựa chọn bạn có thể dùng để tạo: 
�   Một tài liệu trống. 

�   Một tài liệu từ khuôn mẫu đã cài đặt.
�   Một tài liệu mới từ tệp đã có. 

 
Nếu bạn đã kết nối Internet, bạn cũng sẽ thấy các khuôn mẫu sẵn dùng khác từ 
Microsoft Office Online. 
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Lần đầu tiên làm việc  với Word, bạn hãy chọn Blank document  (Văn bản
trống) và nháy Create. Màn hình sẽ cho ta một văn bản trống với một tên ngầm
định nào đó (thường là Document với một số thứ tự ở đuôi).

Nhập văn bản vào từ bàn phím
Khi Word hiển thị cho  bạn một tệp văn bản, dấu chèn ở ngay vị trí  đầu tiên
(phía trên, bên trái cửa sổ) dưới dạng một vạch đứng nhấp nháy báo hiệu sẵn
sàng để bạn đưa các ký tự từ bàn phím. Bạn không cần phải lo lắng một cách 
thái quá về việc lần đầu tiên có những lỗi do gõ nhầm bàn phím, chúng ta có 
thể  sửa những lỗi đó một cách dễ dàng và vào bất cứ lúc nào. Để chèn một 
đoạn văn bản vào chỗ nào, chúng ta chỉ việc đặt dấu chèn tại đó. 

Hai chế độ soạn thảo 
 
Word tạo điều kiện cho bạn làm việc trong hai chế độ soạn thảo khác nhau: chế 
độ chèn ký tự và chế độ thay thế. Với chế độ chèn ký tự, những ký tự sau dấu 
chèn được dịch chuyển dần về bên phải khi bạn gõ những ký tự mới vào, còn 
với chế độ thay thế, các ký tự mới sẽ thay thế các ký tự đứng sau. Chúng ta có 
thể chuyển đổi giữa hai chế độ này một cách tùy ý. 
 
Để chuyển đổi giữa hai chế dộ soạn thảo, đơn giản nhất là dùng phím Insert 
trên bàn phím để điều khiển bật và tắt chế độ thay thế. Để dùng được tính năng 
điều khiển này của phím Insert hãy làm như sau:

1.  Nháy nút Microsoft Office       , rồi nháy Word Options.
2.  Nháy Advanced. 
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3.  Dưới Editing options, chọn/xóa hộp kiểm Use Insert key to control overtype
mode. 

Để bật/tắt chế độ thay thế: 

1.  Nháy nút Microsoft Office       , rồi nháy Word Options.
2.  Nháy Advanced. 
3.  Dưới Editing options, chọn/xóa hộp kiểm Use overtype mode. 

Sử dụng các phím Enter và Space
 
Thông thường một văn bản bao gồm nhiều đoạn văn, các đoạn văn có thể gồm 
một  hai dòng hay rất nhiều dòng. Khi đánh trên máy chữ thông thường, bạn
phải gõ phím xuống hàng (thường được gọi là phím ENTER); với Word bạn
không phải lo lắng chuyện đó: Word sẽ tự động xuống hàng cho bạn khi đã tới
cuối hàng mà không thể cho thêm từ mới vào được nữa. Phím ENTER lúc này 
có vai trò đặc biệt là dùng để  đánh dấu cho Word biết điểm kết thúc của một 
đoạn văn. Dấu đó thường được gọi là dấu ngắt đoạn. 
 
Chúng ta hãy gõ một vài câu dưới đây vào văn bản, chú ý nhấn phím ENTER 
sau mỗi dấu chấm câu: 

Sóng chiều đưa chiếc thuyền nan
 
Chị ơi con sáo gọi đàn bên sông.

Sóng·chiều·đưa·chiếc·thuyền·nan¶
Chị·ơi·con·sáo·gọi·đàn·bên·sông¶ 
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Ô kìa! Bên cõi trời đông 
 
Ngựa ai còn ruổi dặm hồng xa xa.

Ô·kìa!·Bên·cõi·trời·đông¶ 
Ngựa·ai·còn·ruổi·dặm·hồng·xa·xa. ¶

Nếu bạn nháy chuột ở  nút (hiển thị hoặc dấu các ký tự điều khiển) trên
nhóm Paragraph của tab Home, bạn sẽ thấy những câu trên được hiển thị như 
trong khung ở bên phải. Qua đây bạn thấy rằng Word xử lý văn bản bạn đưa 
vào như là một dòng liên tục các ký tự, bao gồm cả các ký tự được hiển thị và 
các ký tự điều khiển việc định dạng. Dấu ¶ cho biết điểm kết thúc của một đoạn 
văn, còn dấu · đánh dấu điểm cuối của một từ mà khi soạn thảo bạn phải gõ 
vào phím trống (SPACE). Vì vậy, khi soạn thảo với Word, bạn không nên lạm 
dụng việc sử dụng phím ENTER và phím SPACE, chỉ nên gõ các phím đó khi 
bạn thực sự thấy cần thiết. 

Hiện hay ẩn dấu định dạng

Trong tab Home, trong nhóm Paragraph, nháy Show/Hide ( ). 

Đánh dấu đoạn văn bản 

Khi làm việc  với Word, bạn hãy luôn luôn ghi nhớ rằng: trước khi có thể di
chuyển, xóa hay định dạng một đoạn văn (hay hình) nào đó, bạn cần phải đánh
dấu nó. Ví dụ như cỡ chữ của đoạn văn đó quá nhỏ cần phải chọn cỡ chữ to 
hơn hoặc cần in nghiêng, v.v. Khi bạn đánh dấu, đoạn văn được đánh dấu sẽ bị 
"bôi đen". Nếu ta đánh dấu sai chỗ hay bỏ  qua không thực hiện những phép 
sửa đổi với những phần đã được đánh dấu đó, chúng ta chỉ cần nháy chuột tại 
bất kỳ nơi nào trong văn bản, hoặc ấn vào một phím mũi tên bất kỳ, vệt đen sẽ 
biến mất. Mục này sẽ hướng dẫn bạn những cách thức đánh dấu bằng chuột. 
 
Muốn đánh dấu một đoạn văn bản, chúng ta đưa con trỏ của chuột vào nơi bắt 
đầu, nhấn và giữ chuột, kéo trên đoạn văn bản cần đánh dấu và thả chuột tại 
nơi kết thúc. Khi bạn kéo chuột từ trên xuống dưới, đoạn văn bản mà chuột đi 
qua sẽ được đánh dấu suốt theo chiều ngang. Trở lại văn bản vừa mới có mấy 
câu ở trên, bạn hãy thử đánh dấu như hình dưới đây:
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Word còn cung cấp cho chúng ta một số khả năng để thao tác nhanh và chính
xác. Để đánh dấu 
 
� Một từ: Nháy đúp chuột trên từ đó; 
� Một dòng: Nháy chuột ở bên trái dòng; 
� Một đoạn: Nháy đúp chuột ở bên trái đoạn văn; 
� Một khối theo chiều đứng: Giữ phím ALT và kéo thả chuột. Như hình dưới 

đây: 

� Toàn bộ văn bản: Nháy chuột ba lần ở bên trái đoạn văn bất kỳ. 

Sửa và xóa trong văn bản
Khi soạn thảo một văn bản, nhất là những văn bản dài, chúng ta không thể
tránh được lỗi do gõ nhầm ký tự. Thậm chí, khi văn bản được soạn thảo lần
đầu chưa được vừa ý bạn, bạn có thể thay đổi nội dung, bố cục cũng như cách 
trình bày. Trong những trường hợp này, khi soạn thảo văn bản bằng máy tính, 
bạn không cần phải lãng phí "giấy tờ" một cách vô ích như là với công cụ giấy
bút  truyền thống. Bạn  có thể lưu văn bản và sửa đổi có bất  kỳ lúc nào bạn
muốn. Tất nhiên, tiêu phí thời gian cho việc sửa đổi văn bản là điều mà máy
tính không thể giúp bạn được hoàn toàn. 
 
Để sửa những lỗi nhỏ, bạn chỉ cần dùng tới hai phím BACKSPACE và DELETE 
là đủ. Hai phím này dùng để xóa những ký tự đã gõ sai và sau đó bạn có thể 
chèn các ký tự đúng vào chỗ đó. 
 
� BACKSPACE hay phím có dấu ← dùng để xóa một ký tự trước dấu chèn; 
� DELETE dùng để xóa một ký tự sau dấu chèn; 
� CTRL + BACKSPACE : xóa một từ trước dấu chèn và 
� CRTL + DELETE để xóa một từ sau dấu chèn. 
 
Muốn xóa những đoạn lớn hơn thì nhanh gọn nhất là đánh dấu đoạn đó và ấn 
phím DELETE hoặc phím BACKSPACE. Thay cho việc sử dụng hai phím đó, 
chúng ta có thể dùng lệnh Cut, chọn ở nhóm Clipboard trong tab Home như 
sau: 

Đánh dấu đoạn cần xóa, nháy chuột vào nút ở nhóm Clipboard trong tab
Home. 
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Mặc dù hiệu quả của lệnh Cut và dùng phím Delete là như nhau, song trong
cách sử dụng chúng có một điều khác biệt cơ bản mà bạn cần luôn luôn ghi 
nhớ: Delete dùng để xóa đơn thuần một đoạn văn bản hay hình trong khi Cut 
cũng có tác dụng xóa, song nội dung của đoạn văn bản vừa bị xóa được Word 
lưu trữ tạm thời trong một bộ nhớ đệm (Clipboard) để có thể sử dụng về sau, 
chẳng hạn như dán (Paste) vào một vị trí khác trong văn bản. Bộ nhớ đệm của 
Office 12 lưu trữ nội dung của 24 lần Cut sau cùng

Khôi phục những sai sót khi xóa
 
Bạn rất có thể thực hiện các thao tác xóa nói trên khi mà bạn thực sự không
muốn. Chẳng hạn như khi một đoạn văn đã được đánh dấu,  bạn vô tình  ấn
phím DELETE; hoặc khi bạn đã xóa rồi, song suy nghĩ lại, bạn thấy rằng đáng
lẽ không nên xóa. Không chỉ hạn chế với các thao tác xóa mà nói chung khi 
thực hiện bất kỳ một thao tác gì với Word, ngay sau đó nếu bạn thấy rằng đáng 
lẽ không nên thực hiện thao tác đó, bạn vẫn có khả  năng khôi phục lại trạng 
thái trước đó một cách nhanh chóng và hoàn hảo.

Chúng ta được cung cấp hai nút Undo và Redo trên thanh công cụ truy nhập
nhanh ngay cạnh nút Microsoft Office. Mỗi khi chúng ta cần khôi phục lại trạng 
thái trước đó của văn bản, ta chỉ cần nháy chuột ở nút Undo. Nút Redo dùng 
để  khôi phục lại trạng thái trước khi sử dụng nút Undo. Như vậy, giả sử như 
bạn thấy cần xóa phần bị "bôi đen", bạn chỉ cần ấn phím DELETE; nhưng sau 
đó bạn thấy rằng mình đã xóa nhầm, bạn nháy chuột ở nút Undo, phần bị xóa 
sẽ trở lại như cũ. Sau một vài giây suy nghĩ, bạn lại thấy rằng tốt nhất vẫn là 
xóa nó đi, bạn có thể nháy chuột ở nút Redo. 
 
Thậm chí, ta có thể khôi phục lại trạng thái trước khi thực hiện nhiều thao tác 
bằng cách nháy chuột tại các nút mũi tên bên phải các nút như hình bên dưới. 
Di chuột từ trên xuống để chọn số thao tác cần khôi phục lại và nháy chuột sẽ 
tương đương với việc nháy chuột ngần ấy lần ở nút Undo hay Redo. 
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Cẩn thận khi xóa ký tự ¶ 
 
Như đã giới thiệu ở phần trên, ký tự ¶ đánh dấu điểm cuối của một đoạn, ký tự 
này xuất hiện khi bạn ấn ENTER. Ký tự ¶ lưu trữ các thông tin định dạng của 
đoạn văn bản trước nó, ví dụ như phông chữ, dáng vẻ của đoạn văn bản. Vì 
vậy bạn hãy rất cẩn thận khi xóa ký tự  ¶ vì khi xóa nó, nói chung bạn sẽ làm 
thay đổi định dạng của nó thành định dạng của đoạn văn bản tiếp theo. Nếu đã 
vô tình xóa đi, ngay lập tức bạn nên khôi phục lại bằng cách nháy chuột ở nút 
Undo. Nói chung, khi soạn thảo bạn không nhìn thấy ký tự ¶, trừ phi bạn nháy 
chuột ở nút ¶ trên thanh công cụ.
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Di chuyển và sao văn bản
 

Khi soạn thảo với Word, chúng ta có thể di chuyển hoặc sao một phần bất kỳ,
cho dù đó là phần văn bản, hình vẽ hay là một mục nào đó lấy từ các ứng dụng
khác. Di chuyển có nghĩa là làm thay đổi vị trí của một phần văn bản được chọn
trong bố cục của toàn bộ tệp văn bản, sao có nghĩa là sao chép lại một phần
văn bản được chọn vào một vị trí khác mà không làm thay đổi phần văn bản
ban  đầu. Phương pháp  đơn giản nhất  để di chuyển và sao phần văn bản là
dùng chuột, tuy nhiên muốn di chuyển hay sao tới một vị trí tương đối xa vị trí
ban đầu thì dùng các lệnh Cut, Copy và Paste sẽ thích hợp hơn. 

Di chuyển phần văn bản sang vị trí khác
 
Cách 1 
 
1.  Chọn phần văn bản hay hình vẽ cần di chuyển theo cách thức đã trình bày

ở trên 
2.  Đặt con trỏ của chuột vào phần đã được "bôi đen" và ấn nút chuột trái. Khi

con trỏ của chuột trở thành mũi tên có khung chấm bên dưới, vẫn giữ chuột
ở trạng thái nhấn nút trái và di con trỏ của chuột đến vị trí mới. 

3.  Thả chuột. 

Cách 2 
 
1.       Chọn khối văn bản cần di chuyển sang vị trí mới 
 
2. Ấn kết hợp phím Ctrl + X 
 
3. Đặt điểm chèn vào vị trí cần đặt khối văn bản 
 
4. Ấn kết hợp phím Ctrl +V 
 
Kết quả cho các cách thực hiện khác nhau là giống nhau.

Sao một phần văn bản 
 

Muốn sao chép một phần văn bản vào một vị trí nào đó, chúng ta chỉ cần thực
hiện ba thao tác  đã mô tả  ở phần di chuyển với sự khác biệt quan trọng là:
trước khi ấn nút chuột trái, hãy ấn phím CTRL và chỉ thả phím CTRL sau khi
thả nút chuột. Hoặc sử dụng các bước như sau 
 
1.       Chọn khối văn bản cần sao chép sang vị trí mới 
 
2. Ấn kết hợp phím Ctrl + C 
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3. 
 
4. 

Đặt điểm chèn vào vị trí cần đặt khối văn bản
 
Ấn kết hợp phím Ctrl +V

Kết quả thực hiện là giống nhau.

Sử dụng nút chuột phải để di chuyển và sao
 
Để tăng tốc độ thao tác, Word hỗ trợ việc sử dụng nút chuột bên phải cho nhiều 
mục tiêu khác nhau. Khi di chuyển và sao đoạn văn bản, bạn cũng có thể dùng 
nút chuột phải. 
 
Chọn phần văn bản hay hình vẽ cần di chuyển theo cách thức đã trình bày ở 
trên. 
 
Đặt con trỏ của chuột vào phần đã được "bôi đen" và ấn nút chuột phải. Giữ 
chuột ở trạng thái nhấn nút phải và di con trỏ của chuột đến vị trí mới. Con trỏ 
của chuột bây giờ là một vạch chấm đứng.

Thả chuột, bạn sẽ thấy hiện lên một cửa sổ nhỏ như hình dưới  đây. Nếu di
chuyển thì nháy chuột ở dòng Move Here (chuyển tới đây); nếu sao, bạn hãy
nháy chuột ở dòng Copy Here (sao ở đây). Còn nếu không, bạn nháy chuột ở 
dòng cuối Cancel (bỏ qua) hay ở bất kỳ nơi nào ngoài cửa sổ đó. 

Sử dụng các lệnh Cut, Copy và Paste
 
1.  Chọn phần văn bản hay hình vẽ cần di chuyển theo cách thức đã trình bày 

ở trên 
2.  Thực hiện một trong hai thao tác sau:

� Để di chuyển, ta nháy nút (Cut) trên tab Home nhóm Clipboard. 

� Để sao, ta nháy nút (Copy) trên tab Home nhóm Clipboard. 

Word sẽ lưu nội dung của phần văn bản đó vào trong bộ nhớ tạm thời
(Clipboard). 

 
3.  Di con trỏ của chuột đến vị trí mới.

4.  Nháy  (Paste) trên tab Home nhóm Clipboard.

*Có thể bạn chưa lưu ý 
 
Khi soạn thảo một văn bản, bạn phải tuân theo những quy tắc nhất định trong 
ấn loát. Những quy tắc này giúp cho bạn trình bày một văn bản đẹp, hợp thức
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và điều quan trọng hơn là sáng sủa, mạch lạc, rõ nghĩa cũng như nhấn mạnh
được những điều cần nhấn mạnh.

Trong một văn bản, tất cả các dấu câu như dấu chấm (.), dấu phẩy (,), dấu
chấm phẩy (;), dấu hai chấm (:), dấu chấm hỏi (?), dấu chấm than (!) cũng như
các dấu ngoặc và nhiều loại dấu khác đều luôn luôn đi cùng với từ đứng trước 
nó và Word định dạng các dòng theo quy tắc này. Vì vậy, trước các dấu câu 
bạn không được để khoảng trống (Space). 
 
Khi xóa hay dán (paste) các đoạn văn bản, Word tự động điều chỉnh các phần 
trống còn sót lại trong phần câu còn lại. Ví dụ như nếu bạn xóa một từ  đứng 
trước dấu phẩy, Word sẽ tự động loại bỏ phần trống giữa dấu phẩy và từ đứng 
trước từ bị xóa. (Tác động này chỉ có được khi bạn xóa bằng cách "bôi đen".) 

Nếu bạn không muốn Word thực hiện điều chỉnh tự động này, bạn có thể 

1.  Nháy nút Microsoft Office      , rồi nháy Word Options. 
2.  Nháy Advanced. 
3.  Dưới Cut, Copy and Paste, nháy chuột để tắt hộp Use Smart Cut And 

Paste. 
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Nhập ký tự ©, TM, ®, và các biểu tượng khác
 
Để thêm các chữ cái, số và các dấu chấm câu trrên bàn phím, nhiều phông chữ 
bao gồm cả các biểu tượng danh mục, như §, TM, © và ®. Nhiều phông chữ 
cũng chứa các ký tự có chứa các dấu phụ (các từ biến âm sắc, dấu ngã và các 
từ có trọng âm). Để chèn các biểu tượng với lệnh Symbol, thực hiện các bước 
dưới đây: 
 
1.  Đặt con trỏ tại nơi bạn muốn chèn biểu tượng. 
2.  Trên tab Insert trong nhóm Symbols nháy Symbol.

Khi nháy nút Symbol sẽ xuất hiện bảng một số ký tự thường gặp như hình dưới
bên trái. Nếu ký tự bạn cần không có trong bảng, nháy More Symbols... hộp
thoại Symbol (hình dưới bên phải) sẽ xuất hiện cho bạn nhiều lựa chọn hơn. 

Nếu bạn cần chèn các biểu thức toán học hoặc tạo các công thức, sử  dụng
công cụ Equation trên tab Insert trong nhóm Symbols.
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Khi  nháy  vào Equation, 
danh  sách  thả các  dạng 
biểu  thức  xuất hiện 
bạn  chọn.  Nếu  bạn 

cho 
cần 

soạn biểu thức mới không 
có trong  danh sách  mẫu 
này  thì  nháy  vào  Insert 
New   Equation ở dòng 
dưới  cùng. Tab  công  cụ 
mới sẽ xuất hiện như hình 
dưới sẽ trợ giúp bạn soạn 
biểu thức mới. 

Lưu tệp văn bản 
 
Chúng  ta  vừa  mới mở  một tệp văn bản mới với tên ngầm định là
Document1.docx. Trong tệp văn bản đó, chúng ta mới "soạn thảo" được bốn
câu thơ ngắn ngủi, nhưng với nội dung ít ỏi như vậy, nó vẫn đủ "tư cách" là một 
tệp văn bản. Có thể bạn chỉ có đủ thời gian tới đây để làm quen với Word hoặc 
cũng có thể để đề phòng các trục trặc khác (chẳng hạn, mất điện), bạn muốn 
lưu giữ kết quả làm việc của mình trên đĩa cứng của máy tính. Khi đã được lưu, 
sau này bạn có thể mở nó ra để sửa đổi hay làm việc tiếp với nó. Để lưu, bạn 
hãy 

1.  Nháy nút  trên Quick Access Toolbar (Thanh công cụ truy nhập nhanh).
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2.  Hoặc  nháy  nút 
Office rồi nháy Save. 

Microsoft

Vì  đây là lần đầu tiên chúng ta lưu một tệp với một tên ngầm  định (Word
thường lấy một số ký tự đầu tiên trong văn bản đang được soạn thảo làm tên
ngầm định), chúng ta sẽ được hiển thị một cửa sổ để cho những thông số tùy 
chọn của mình. Từ lần sau trở đi, khi lặp lại động tác lưu văn bản như trên, cửa 
sổ này sẽ không được hiển thị nữa, tệp văn bản sẽ được tự động lưu với tên 
của nó. 
 
Bạn hãy gõ Tai lieu 1 vào mục File name. Chú ý chọn vị trí của thư mục bạn

muốn lưu tài liệu vào  trong hộp
để dễ tìm và mở văn bản ở những lần sau.
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Mở tệp văn bản hiện có 
 
Bây giờ chúng ta hãy mở tệp văn bản Tai lieu 1.docx (vừa được ta soạn thảo 
và lưu). 

Nháy nút 
nháy Open 

Microsoft Office, rồi

Bạn sẽ được cung cấp một cửa sổ thoại Open để định vị tệp văn bản cần mở.
 
Nháy chuột ở tên tệp văn bản để chọn (ở đây là Tai lieu 1.docx) và nháy Open 
hoặc nháy đúp chuột ở tên tệp văn bản để mở tệp văn bản.

Sau khi mở tệp văn bản, bạn có thể sửa đổi, thêm nội dung hoặc thực hiện các
thao tác khác với văn bản. 

Đóng tệp văn bản và Word 
 
Sau khi đã chắc chắn rằng tệp văn bản đã được lưu, bạn có thể đóng tệp văn 
bản đó lại để tiết kiệm bộ nhớ làm việc với các tệp văn bản hay các ứng dụng 
khác. 

� Nháy chuột tại nút  tại góc trên bên phải cửa sổ hoặc
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� Nháy nút Microsoft Office, rồi nháy Close

Nếu bạn chưa lưu những sửa đổi mới trong văn bản, Word sẽ hỏi lại bạn để
tránh trường hợp mất thông tin. Nếu không, cửa sổ sẽ được đóng lại. 

Nếu không làm việc với Word nữa, bạn có thể đóng lại bằng cách nháy chuột

tiếp ở nút 
 
Office, rồi nháy 

 tại góc trên bên phải màn hình hoặc Nháy nút Microsoft

Lựa chọn các kiểu phông chuẩn
 
Hiện nay có rất nhiều loại phông chữ khác nhau và rất đa dạng, giúp cho người 
sử dụng dễ dàng lựa chọn phông chữ cho mình để soạn thảo văn bản hoặc chế 
bản các dạng ấn phẩm khác nhau đặc biệt là trên các trình soạn thảo văn bản 
Microsoft Word. Đi kèm với nó là các phần mềm hỗ trợ cho các kiểu phông chữ
đó, Ví  dụ  như  chương  trình soạn thảo tiếng Việt: ABC, Vietkey,  Unikey,
VietFlex... 
 
Để soạn thảo chế độ tiếng Việt người sử dụng có thể sử dụng các trình soạn 
thảo trên để hoàn thành công việc của mình.
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Đặc biệt hiện nay các hệ  điều hành Windows 2000, Windows XP  đều hỗ trợ
chế độ soạn thảo tiếng Việt theo chế độ Unicode. Đây là một công cụ tiện lợi
cho người sử dụng mà không cần đến các trình soạn thảo khác mà vẫn có thể
gõ được tiếng Việt, hơn nữa nó cung cấp cho người sử dụng có thể gõ được
các loại phông chữ khác nhau của các nước trên thế giới theo một chuẩn
chung. Nếu bạn gõ văn bản ở dạng Unicode thì bạn có thể đọc được tiếng Việt
trên các máy khác nhau mà không bị biến dạng phông chữ của bạn. 
 

Để tiện cho người sử dụng, chúng tôi hướng dẫn các bạn các thức sử dụng
Unicode trong các hệ điều hành Windows 2000, Windows XP, đồng thời cũng
giới thiệu cho các bạn sử dụng công cụ Unikey hỗ trợ các chế độ gõ tiếng việt
theo các phông khác nhau và đặc biệt nó hỗ trợ gõ ở chế độ Unicode với phông
chữ rất đẹp. 

Để có tiếng Việt Unicode
 

Thiết lập môi trường tiếng Việt cho Windows: (Chỉ thực hiện 1 lần, nếu máy của 
bạn chưa có thiết lập tiếng Việt của Windows) 
 

Để gõ được tiếng Việt theo kiểu của Windows Vietnamese (gọi nôm na là tiếng
Việt Unicode), ta cần thêm Vietnamese vào  trong Input locale (để Windows
nhận biết và xử lý đúng những đặc trưng của tiếng Việt). 
 

Vì trên các Hệ  điều hành khác nhau, cách thiết lập cũng hơi khác nhau một
chút. Để người sử dụng dễ thực hiện, chúng tôi xin miêu tả chi tiết từng bước
cho từng nhóm Hệ điều hành khác nhau. 

TRÊN WINDOWS 9x, NT, Me 
 
Bạn có thể sử dụng phần mềm Unikey

TRÊN WINDOWS 2000 
 

1.  Vào Start → Control Panel → Regional Options: General: Chọn Vietnamese.
Cũng trong phần  Regional Options, chọn tab:  I  nput Locales: (ta có thể
vào thẳng phần Input locales này từ phần Keyboard của Control Panel)
nhấn nút Add, bảng thông báo Add Input Locale hiện ra, trong phần: Input
locale: hãy chọn Vietnamese. 

 

2.  Đánh dấu vào ô Enable indicator on taskbar (chỉ thị ngôn ngữ trên thanh
tác vụ ở cuối màn hình. Khi bật tiếng Việt, sẽ có hình chữ VI như bên phải

 

. 

TRÊN WINDOWS XP 
 

1.  Vào  Start  → Control Panel  → Regional and Language Options: Chọn tab
Language:  Đánh dấu hộp Install files for complex script and right-to-left
languages (include Thai) 
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2.  Nhấn OK. Lúc này bạn cần có đĩa nguồn WindowsXP để hệ thống cài đặt 
thêm dịch vụ mà bạn vừa chọn. Sau đó khởi động lại máy. 

 

Sau khi khởi  động lại máy, vào lại Control Panel  → Regional Language and
Options, chọn thẻ Languages. Nhấn Detail..., khi hộp thoại Text Services and
Input Languages hiện ra, nhấn nút Add, chọn Vietnamese trong hộp thoại Add
Input Language. Nhấn OK ba lần để hoàn tất thiết lập. 
 

(Trong nút  Language Bar, Windows XP  đã tự  đánh dấu vào ô  Show the
Language Bar on the desktop - chỉ thị ngôn ngữ trên thanh tác vụ ở cuối màn
hình, nên khi bật tiếng Việt, chỉ thị này sẽ có hình chữ VI như bên phải      .) 
 

Sau khi thiết lập xong tiếng Việt cho Windows, ta  đã có thể gõ tiếng Việt
Unicode,  nhưng  theo  kiểu   Windows  Vietnamese  (tức  là  theo  kiểu  của
Microsoft, xem thêm bảng mô tả chế độ gõ tiếng Việt-phần cuối bài này). Để có
thể gõ tiếng Việt theo cách trước nay vẫn làm (tức là theo kiểu VNI, ABC hoặc
Telex), ta hãy làm theo phần cuối bài này. 
 

Chú ý: Từ Hệ  điều hành Windows2000 trở  đi, nếu muốn thiết lập môi trường
để gõ các ngoại ngữ khác (như tiếng Pháp, Nhật, Hoa, Thái...), bạn có thể làm
tương tự như đã làm cho tiếng Việt. 

Thiết lập kiểu gõ: 

Để có thể hiểu được các chương trình gõ tiếng Việt, người sử dụng nên phân 
biệt được 3 khái niệm sau: 

Mã tiếng Việt (còn gọi là bộ mã, bảng mã, trang mã, tiếng Anh: code page,
code table): Có nhiều bảng mã tiếng Việt như: Unicode tổ hợp, Unicode dựng
sẵn (hai mã này hợp thành bảng mã TCVN 6909. Tuy nhiên bảng mã này chỉ
mới chú ý đến mã mà không có phần bản sắc tiếng Việt, đó chính là locales ),
VietWare, VNI, ABC, VietFlex, VietStar, DHBK, TCVN1, TCVN2, BKED, 3C30...
Unicode tổ hợp tiếng Việt là bảng mã đầu tiên (và duy nhất cho đến nay) được
hỗ trợ tính bản địa để tiếng Việt chính là tiếng Việt. 

Phông tiếng Việt (hay còn gọi là kiểu chữ tiếng Việt): Mỗi bảng mã có kèm
theo bộ phông tương  ứng. Vì có quá nhiều bộ mã tiếng Việt, nên cũng có
tương ứng bằng ấy bộ phông/kiểu chữ tiếng Việt với đủ thứ tên gọi. Chẳng hạn
như, bộ mã ABC có các phông ABC với tiếp đầu ngữ.vn ở đầu (ví dụ .vnArial,
.vnTimes...), bộ mã VNI có các phông VNI với tiếp đầu ngữ VNI- ở đầu (ví dụ,
phông VNI-Arial, VNI-Times...), bộ mã VS có các phông VS1, VS2 với tiếp đầu
ngữ  VS1, VS2 -  ở  đầu như (VS1-Arial, VS1-Times...). Bộ mã Unicode cũng
tương  ứng có bộ phông Unicode của mình, (ví dụ như Times New Roman,
Arial... hoặc SimSun, SimHei: tiếng Hoa...). Office XP hiện có các phông tiếng
Việt sau: Arial, Times New Roman, Courier News, Tahoma, Verdana. 
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Kiểu gõ tiếng Việt: Mặc dù có nhiều bảng mã và nhiều loại phông, chỉ có 3
 

kiểu gõ tiếng Việt phổ biến hiện nay: VNI, Telex và theo Windows Vietnamese
(gọi nôm na là kiểu gõ tiếng Việt của Microsoft Windows). Phần hướng dẫn 
các kiểu gõ này sẽ được viết bên dưới. 

Bảng mã tiếng Việt cũ sử dụng Unikey

Bạn không nên dùng.các phông VNI, ABC... tiếng Việt như trước đây. 

Chọn  Character set (bảng mã tiếng Việt 
khác). 
 Input  Method  cho  ta  chọn  kiểu  gõ  ưa 
thích: VNI, Telex. 

Trong bảng Code Table (bảng mã), ta chọn
các  bảng  mã  tiếng  Việt  mà  mình  muốn
dùng. Ví dụ, muốn dùng phông VNI, ta chọn
VNI-Windows  ANSI,  muốn  dùng  phông
ABC, ta chọn bảng mã  ABC, muốn dùng
phông VietFlex, ta chọn bảng mã VS1 hoặc
VS2, tương tự như thế cho các bảng mã
của DHBK, 3C25, v.v... 

- Trong mục Switch Key, chọn cách thức
chuyển  đổi chế  độ gõ tiếng Anh và tiếng
Việt, ví dụ Alt+Z 

Chú ý: Để gõ được tiếng Việt với bộ mã, sử dụng công cụ Unikey, bạn cần phải 
có các phông tương ứng. Ví dụ như .vnTime, vnArial, hoặc các phông VNI 

Sử dụng Unikey để gõ Unicode

Để sử dụng Unikey  để gõ tiếng
Việt  trong  chế  độ  Unicode,  bạn
thiết  đặt  chế   độ  Unicode  trong
mục Character set 

Gõ dấu tiếng Việt theo kiểu VNI:
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Để có chữ, hoặc dấu       Gõ
 

Dấu sắc 1 
 

Dấu huyền 2 
 

Dấu hỏi 3 
 

Dấu ngã 4 
 

Dấu nặng                          5 
 

Dấu â 6 
 

Dấu ư, ơ 7 
 

Dấu ă                                8 
 

Chữ đ                                d, 9 
 
Ví dụ: để gõ chữ Chiến: 
 

Bạn có thể gõ: c h i e (dấu â) (dấu sắc) n ; hoặc gõ : c h i e (dấu â) n (dấu sắc)
Bạn có thể gõ dấu ở cuối từ, nếu gõ sai, bạn có thể gõ lại ngay mà không cần
xoá dấu cũ. 
 
Gõ dấu tiếng Việt theo kiểu Telex: 
 

Để có chữ, hoặc dấu          Gõ 
 

Dấu sắc s 
 

Dấu huyền f 
 

Dấu hỏi r 
 

Dấu ngã x 
 

Dấu nặng                            j 
 

ă                                          aw 
 

â                                          aa 
 

ê                                          ee 
 

ô                                          oo 
 

đ dd 
 

ư                                         w 
 

ơ                                         ow 
 

w                                         ww 
 

Bỏ dấu                                z 
 
Ví dụ: Muốn gõ chữ trường, bạn có thể gõ: t r w o w f n g hoặc t r w o w n g f. 

Tài liệu hướng dẫn 37



 Microsoft Office Word 2007 – Phần cơ sở

Bạn có thể sửa dấu ngay sau từ. Trong ví dụ trên, nếu bạn gõ thêm chữ s thì từ
trường sẽ thành trướng. 

Gõ tiếng Việt bằng bộ gõ có sẵn của WindowsTM 

 
Chuyển sang bàn phím tiếng Việt bằng cách trỏ chuột trái vào chỉ thị ngôn ngữ
trên thanh tác vụ ở góc phải dưới cùng của màn hình, rồi chọn VI. 

Để có chữ, hoặc dấu           Gõ
 

ă                                       1 
 

â                                       2 
 

ê                                       3 
 

ô                                       4 
 

đ 0 
 

ư                                      [ 
 

ơ                                      ] 
 

Dấu huyền                       5 
 

Dấu hỏi                            6 
 

Dấu ngã 7 
 

Dấu sắc                           8 
 

Dấu nặng                         9 
 
Ví dụ: Để gõ chữ Việt, bạn sẽ gõ: V i 3 9 t.
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BÀI 3. ĐỊNH DẠNG VĂN BẢN
 
Định dạng (formatting) một văn bản tức là dùng các kiểu (styles) để làm cho 
văn bản của bạn rõ ràng mạch lạc và thống nhất định dạng trong toàn bộ tài 
liệu. Kiểu bao gồm: kiểu phông, kích cỡ phông, khoảng cách giữa các dòng, 
khoảng cách giữa các đoạn, căn lề trái, phải hay căn đều trái phải, lùi vào đầu 
dòng... tạo các đường biên hay khung, đánh số các khoản mục và bố trí các chi 
tiết khác (trong đó bao gồm cả bảng biểu, hình ảnh), v.v. Kiểu thường được áp 
dụng cho đơn vị  đoạn một cách tự  động, nếu muốn định dạng kiểu khác cho 
một phần văn bản trong đoạn bạn phải chọn riêng đoạn đó và định dạng lại kiểu 
phông và kích cỡ phông. 
 
Khi tạo tài liệu mới, bản thân nó đã chứa sẵn một số tối thiểu các kiểu ngầm
định. Bạn có  thể dùng  ngay các kiểu này nếu chúng phù hợp, hoặc sửa đổi
chúng thành kiểu bạn thích. Bạn cũng có thể tạo thêm các kiểu mới. Để sao
chép định dạng của đoạn này sang đoạn khác bạn có thể dùng Format Painter 
hoặc áp dụng các kiểu trong danh sách kiểu trong nhóm Style trên tab Home. 
Ngoài ra, bạn có thể sao chép các kiểu bạn đã lựa chọn từ tệp này sang tệp 
khác mà không cần lặp lại việc tạo mới hay sửa đổi kiểu. Trong bài này, bạn sẽ 
thực hành theo từng bước cụ thể trên cơ sở các tệp văn bản chúng ta mới và 
sẽ đưa vào. 

Chọn phông chữ, cỡ chữ và kiểu chữ
 
Word cung cấp cho ta hai khả năng để chọn phông chữ, cỡ chữ và kiểu chữ. 
Kiểu chữ bao gồm kiểu chữ đậm, kiểu chữ nghiêng và kiểu chữ có gạch dưới; 
ngoài ra nếu với một phông chữ còn có các kiểu khác, Word cũng hiển thị cho 
ta biết. 
 
1. Trên thanh công cụ định dạng ta có thể thấy những nút sau:

Muốn thay đổi phông và cỡ chữ của các ký tự, ta thực hiện các bước sau: 
 
1.  Trước hết ta chọn các ký tự đó ("bôi đen");
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2.  Trong    nhóm Font,    nháy chuột ở   mũi   tên   chọn phông chữ

. Chúng ta sẽ nhận được danh sách các phông chữ,
nháy chuột để chọn phông chữ thích hợp;

 
3.  Nháy chuột ở mũi tên chọn cỡ chữ để chọn cỡ chữ.

Tương tự, để chọn kiểu chữ cho từ Word chẳng hạn, trước hết ta "bôi đen" từ

đó,  nếu cần chuyển sang chữ đậm Word ta nháy chuột ở nút , nháy nút

 ta được chữ nghiêng Word và nháy nút ta được chữ có gạch dưới
Word, nháy vài mũi tên ta có thể chọn kiểu của đường gạch dưới. Có thể nháy

chuột nhiều nút để đạt được kết quả kết hợp, ví dụ như nháy cả hai nút và

, ta được chữ đậm và nghiêng Word hay nháy chuột ở cả ba nút ta được
 
Word. Ngược lại, nếu bôi đen một chữ đậm và nháy chuột ở nút       , ta sẽ trở 
lại chữ bình thường. Kết quả cũng tương tự với các nút khác.

2. Khả năng thứ hai cho những chọn lựa đầy đủ hơn là nháy Hộp phóng  của
nhóm Font trên tab  Home. Chúng ta được cung cấp một cửa sổ như Hình
dưới. Khi chọn phông, cỡ và kiểu chữ, cửa sổ bên dưới hiển thị cho ta một mẫu
lựa chọn để hỗ trợ cho việc quyết định nhanh về tính thích hợp của phông chữ 
được chọn. Ngoài những khả năng lựa chọn phông chữ, cỡ chữ và kiểu chữ, 
Word còn hỗ  trợ nhiều khả năng khác. Chẳng hạn như chỉ với thao tác gạch 
dưới ta đã có thể:

Gạch dưới liên tục (Single underline) Gạch dưới liên tục 

Gạch dưới từng từ (Word only underline)   Gạch dưới từng từ 

Gạch dưới đúp (Double underline)
 
Gạch ngắt (Dash) 

Gạch dưới đúp 
 
Gạch ngắt

40 Tài liệu hướng dẫn



 Microsoft Office Word 2007 – Phần cơ sở

Dưới đây minh họa thêm một vài khả năng của Word (với các phép chọn trong
Effect): 

Chữ có bóng (Shadow) Word
Chữ khung (Outline) 

 

 

Chữ khung và có bóng Word, Word, Word 
 
Chỉ số trên và chỉ số dưới (ABC) 
 
Đôi khi trong văn bản ta phải đưa vào những ký tự có kèm theo các chỉ số, kể 
cả chỉ số trên và chỉ số dưới, bên phải cũng như bên trái, ví dụ như H2O, x2 + 
y2. Khi đánh chỉ số, Word sẽ tự động chọn phông có cỡ nhỏ hơn và đẩy vị trí 
cho thích hợp. 
 
Chỉ số dưới: Khi đang ở chế độ soạn thảo bình thường, nếu muốn đánh chỉ số 
dưới, bạn hãy ấn đồng thời các phím CTRL và =, ấn như thế một lần nữa, bạn 
sẽ trở lại chế  độ bình thường. Ví dụ cần gõ công thức H2O ta thực hiện như 
sau: Gõ H, ấn đồng thời các phím CTRL và =, gõ số 2, một lần nữa ấn đồng 
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thời các phím CTRL và = để trở lại chế độ bình thường và gõ O. Bạn cũng có

thể sử dụng nút trong nhóm Font thay cho cụm phím CTRL và =. 
 
Chỉ số trên: Nguyên tắc thực hiện cũng hoàn toàn tương tự, chỉ có khác là thay 
vì ấn đồng thời hai phím CTRL và =, để đấnh chỉ số trên bạn cần ấn đồng thời

ba  phím CTRL, SHIFT  và =. Bạn cũng có thể sử dụng nút
Font thay cho cụm ba phím CTRL, SHIFT và =.

 trong  nhóm

Khi muốn thay đổi phông chữ, cỡ và kiểu của các chỉ số, chúng ta cũng có thể
lặp lại các thao tác đã trình bày ở trên; chú ý rằng bạn chỉ được đánh dấu các 
chỉ số. 

Khoảng cách giữa các ký tự
 
Khi phát triển hệ phần mềm soạn thảo văn bản Word, các nhà thiết kế đã tham 
khảo ý kiến của các nhà chuyên môn trong lĩnh vực ấn loát và đưa vào những 
tính năng tự động hoàn toàn đáp ứng các yêu cầu về ấn loát, trong đó có vấn 
đề về khoảng cách phân bố giữa các ký tự. Do vậy bạn có thể hoàn toàn yên 
tâm. Tuy nhiên trong các trường hợp hãn hữu, Word vẫn hỗ trợ bạn khả năng 
khả năng làm co giãn khoảng cách này. Ví dụ như:

TODAY Office
 

TODAY Office 
 

TODA Y  O f f i ce  
 

T O D A Y  O f f i c e 
 
Muốn thực hiện điều này, bạn đừng
chèn các khoảng trống bằng cách
gõ  Space mà hãy nháy Hiện Hộp

Co (condensed) 1pt
 
Bình thường (normal) 
 
Giãn (expanded) 1,5pt
 
Giãn (expanded) 2pt

thoại (Dialog Box  Launcher) ở
góc dưới bên phải của nhóm Font
trong     tab Home, chọn    tab
Charactar  Spacing  bạn  sẽ  được
cung  cấp  một  bảng  để  chọn.  Tuy
nhiên, các thao tác này chỉ dành cho
những   người 
nghiệm  làm 

đã   có 
việc  với 

nhiều  kinh
Word, với

những bạn mới bắt đầu làm quen thì
hãy tin tưởng và hài lòng với các
tính năng tự động của nó. 
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BÀI 4. ĐỊNH DẠNG ĐOẠN VĂN BẢN
Như đã đề cập tới ở bài trước, một đoạn văn bản (Paragraph) là một phần được kết thúc bằng
¶. Khi soạn thảo chúng ta kết thúc một đoạn văn bản bằng cách ấn phím Enter. Bạn chỉ nhìn 
thấy ¶ trên màn hình nếu bạn nháy nút ¶ trên thanh công cụ chuẩn (chuyển sang chế độ hiển thị 
tất cả những ký tự ẩn). Trước khi định dạng một đoạn văn bản, bản phải đánh dấu nó, tức là 
"thông báo" cho Word biết bạn định làm việc với đoạn nào. 
 
1. Định dạng đoạn văn bản liên quan tới dáng vẻ của toàn bộ  đoạn văn bản, cho dù bạn chỉ 
đánh dấu một hai ký tự trong đoạn văn đó hay đánh dấu cả đoạn.

Căn chỉnh lề văn bản 
 
a. Chế độ ngầm định của Word là mọi đoạn văn bản được tự động căn chỉnh 
thẳng lề bên trái, đồng thời giữ nguyên khoảng cách hợp lý giữa các ký tự mà
không quan tâm đến lề bên phải. Chúng ta có thể dùng các nút , , và

để căn giữa, căn lề phải và điều chỉnh thẳng cả hai lề trái và phải cho từng
đoạn văn. 
 

Đánh dấu đoạn văn bản, 
Nháy chuột một trong các nút sau:

a. Nháy nút 
 
HỆ ĐIỀU HÀNH 

để căn lề trái b. Nháy nút
 

     HỆ ĐIỀU HÀNH

để căn giữa trang 

Hệ điều hành là phần mềm quan trọng Hệ điều hành là phần mềm quan trọng
bậc nhất cho các máy PC. Khởi đầu,
các hệ điều hành đã được dự kiến xây

bậc nhất cho các máy PC. Khởi đầu, các
hệ điều hành đã được dự kiến xây dựng

dựng để điều hành một trong các hoạt để điều hành một trong các hoạt  động
động phức tạp nhất của cơ chế vào/ra. phức tạp nhất của cơ chế vào/ra. 

c. Nháy nút để căn lề trái 
 
 
 

HỆ ĐIỀU HÀNH

d. Nháy nút để  điều chỉnh 
hai lề 

 
     HỆ ĐIỀU HÀNH

thẳng

Hệ điều hành là phần mềm quan trọng Hệ điều hành là phần mềm quan trọng
bậc nhất cho các máy PC. Khởi đầu,

các hệ điều hành đã được dự kiến xây
bậc nhất cho các máy PC. Khởi đầu, các
hệ điều hành đã được dự kiến xây dựng

dựng để điều hành một trong các hoạt để điều hành một trong các hoạt  động
động phức tạp nhất của cơ chế vào/ra phức tạp nhất của cơ chế vào/ra. 

Thay cho bước 2, ta có thể nháy Hộp thoại phóng (Dialog Box Launcher) ở
góc dưới bên phải của nhóm Paragraph trong tab Home, chọn tab Indent and
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Spacing. Trong ô  Alignment, nếu nháy chuột trái ở nút mũi tên, ta sẽ  nhận
được một danh sách lựa chọn bao gồm các dòng Left (lề trái), Centered (căn
giữa),  Right  (lề phải)  và  Justified (chỉnh thẳng cả hai lề) (xem hình dưới).
Muốn định dạng kiểu nào, ta chỉ cần nháy chuột ở dòng đó và nháy nút OK
(hay ấn phím Enter) và ta sẽ nhận được kết quả tương tự trên.

b. Thông thường, với các đoạn văn bản có hai cách bố trí dòng đầu tiên: hoặc
là căn thẳng lề trái hoặc thụt vào một khoảng nào đó so với các dòng tiếp theo 
như  minh họa ở  đoạn này. Kiểu định dạng ngầm định của Word là không để 
thụt vào, song bạn có thể kéo (nhấn, giữ nút chuột trái và di chuyển, sau đó thả 
nút chuột) con trỏ trên thước đo để tạo ra khoảng thụt vào cần thiết cho dòng
đầu tiên. Bạn có thể kéo con trỏ cả về bên trái, bằng cách đó bạn đã "kéo" dòng
đầu tiên nhô  ra ngoài lề. Nên nhớ, dấu chèn đang ở
dụng cho đoạn đó.

đoạn nào thì sẽ có tác
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Nếu muốn chính xác hơn, nháy Hiện Hộp thoại (Dialog Box Launcher) ở góc
dưới bên phải của nhóm  Paragraph trong tab Home, chọn tab  Indent and
Spacing. Chọn tiếp First line (dòng đầu tiên) trong mục Special. Cho một số
đo hoặc chấp nhận số đo ngầm định vào ô By ở bên phải và nháy OK. 

Các dáng vẻ đặc biệt khác của đoạn văn bản
 
Khi muốn nêu bật ý quan trọng của một đoạn văn nào đó, người ta thường định 
dạng đoạn văn bản đó theo một kiểu dáng riêng biệt khác với kiểu nói chung 
trong văn bản. Một trong những cách tạo kiểu dáng riêng đó là căn lề của cả 
đoạn văn bản thụt vào bên trong, có thể một lề trái, có thể cả hai lề. Hoặc khi 
muốn liệt kê, chẳng hạn các tài liệu tham khảo, người ta thường định dạng theo 
kiểu các đoạn "treo", nghĩa là từ dòng thứ hai trở đi đều thụt vào so với dòng
đầu tiên. Với Word, tất cả các định dạng đó đều có thể thực hiện  được một
cách nhanh chóng và dễ dàng.
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Cho thụt vào một phía hay cả hai phía: Đánh dấu đoạn văn bản, nếu muốn cho
thụt cả đoạn văn bản so với lề trái, bạn hãy đưa chuột vào phần hộp chữ nhật
của con trỏ trên thước đo và kéo tới vị trí bạn muốn (Chú ý đừng kéo riêng
phần tam giác ở trên vì nó sẽ cho ta kết quả khác!). Ta có thể kéo con trỏ về cả
hai phía; kéo về bên phải, đoạn văn sẽ thụt vào so với lề trái, kéo về bên trái sẽ 
đưa đoạn văn ra quá lề. Còn nếu muốn điều chỉnh lề phải của đoạn văn, bạn
kéo con trỏ ở bên phải của thước đo (xem hình trên).

Nếu muốn định dạng đoạn văn "treo" như trên hình cuối ở trên, ta cũng đánh
dấu đoạn văn bản và kéo phần tam giác ở trên con trỏ
thích hợp. 

trên thước đo về vị trí

Để  có thể  định dạng một cách chính xác hơn và được thống nhất trong suốt
văn bản dài,  nháy Hiện Hộp thoại (Dialog Box Launcher) ở góc dưới bên
phải của nhóm Paragraph  trong tab Home, chọn tab Indent and Spacing.
Trong Indentation, bạn có thể cho các số đo cho Left (bên trái) và Right (bên
phải) để đặt khoảng thụt vào chính xác cho bên trái hay bên phải đoạn văn (có 
thể cho số đo âm). Còn để tạo ra đoạn treo, bạn hãy chọn Hanging và cho số 
đo và ô By. Sau khi cho hết các thông số, nháy nút OK.
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Trên thanh công cụ chuẩn bạn thường được cung cấp hai nút  và . Có
thể sử dụng hai nút này để tăng giảm khoảng cách thụt vào ở bên trái của đoạn
văn bản một cách nhanh chóng; cụ thể hơn: nháy chuột ở nút
 
tăng khoảng cách đó, còn nháy ở nút sẽ cho kết quả ngược lại. 

 bạn sẽ làm

Khoảng cách giữa các hàng và các đoạn văn
 
Khoảng cách ngầm định giữa các hàng trong một đoạn văn là khoảng cách đơn 
(single) và ta có thể dễ  dàng thay đổi khoảng cách này. Khi thay đổi khoảng 
cách giữa các hàng trong một đoạn văn, bạn tác động tới tất cả các hàng trong 
đoạn văn bản được chọn hay chứa dấu chèn. 
 
Đặt khoảng cách giữa các đoạn văn xác định nên độ cao (và chiều sâu) của 
mọi hàng trong đoạn văn bản. Độ cao này thay đổi tùy thuộc vào phông chữ và 
cỡ chữ lớn nhất sử dụng trong đoạn văn. Chẳng hạn, với phông chữ cỡ 10 pt 
thì độ cao của mỗi hàng xấp xỉ 12 pt, đó là độ cao thực sự của phông chữ cộng 
với khoảng cách giữa các dòng.
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Khoảng cách giữa các hàng trong một đoạn văn
 

Để thay đổi khoảng cách giữa các dòng trong một đoạn văn bản, ta tiến hành 
các bước sau: 

1. Chọn đoạn văn bản ta muốn thay đổi.

2. Nháy nút trong nhóm Paragraph.
 

3. Chọn kiểu thích hợp trong danh sách
các  khoảng  cách  liệt  kê  như  hình  bên.
Nếu bạn cần một số đo khác các số đã liệt
kê hãy nháy Line Spacing Options. 

Dưới đây là minh họa một đoạn văn với khoảng cách đơn và khoảng cách 1,5
dòng. 

Sóng chiều đưa chiếc thuyền nan 
Chị ơi con sáo gọi đàn bên sông. 
Ô kìa! Bên cõi trời đông 
 
Ngựa ai còn ruổi dặm hồng xa xa.

        Sóng chiều đưa chiếc thuyền nan 
Chị ơi con sáo gọi đàn bên sông. 
Ô kìa! Bên cõi trời đông 

 
Ngựa ai còn ruổi dặm hồng xa xa.
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Khoảng cách giữa các đoạn văn

Thay vì nhấn một hay  nhiều phím Enter để làm tăng khoảng cách giữa các
đoạn văn, bạn nháy Hiện Hộp thoại (Dialog Box Launcher) ở góc dưới bên
phải của nhóm Paragraph trong tab Home để mở hộp thoại Paragraph điều 
chỉnh khoảng cách trước hay sau một đoạn văn. Việc sử dụng này có nhiều ưu 
điểm. Trước hết là bạn có thể  điều chỉnh được một cách chính xác. Ngoài ra 
khi bạn di chuyển hay xóa một đoạn văn bản là bạn xóa cả các khoảng cách 
đó, sau khi xóa sẽ không còn xót lại các khoảng trống và chúng ta không phải 
xử lý lại. 

Khi một  đoạn văn bản có khoảng cách cho trước nó nằm ở  đầu một trang,
thông thường Word sẽ bỏ qua khoảng cách đó, nhưng trong một số trường hợp
như đoạn đầu tiên của một tài liệu (đề mục) thì khoảng cách đó vẫn được giữ 
nguyên. Bạn hãy điều chỉnh khoảng cách giữa các đoạn theo các bước sau: 
 
1. Chọn đoạn văn bản ta muốn thay đổi.

2.  Nháy Hiện Hộp thoại (Dialog Box Launcher) ở góc dưới bên phải của
nhóm Paragraph trong tab Home để mở hộp thoại Paragraph.

Tài liệu hướng dẫn 49



 Microsoft Office Word 2007 – Phần cơ sở

3. Chọn tab Indents and Spacing.
 

4. Cho số đo khoảng cách vào Before (trước đó) và/hoặc After (sau đó) trong 
ô Spacing (xem hình ở trên). 
 
5. Nháy OK. 

*Nên tránh 
 

Gõ tab hay space nhiều lần để làm tăng khoảng thụt vào cũng như nhấn phím
Enter ở cuối mỗi dòng. Văn bản sẽ không được căn chỉnh đúng và mỗi khi bạn
chèn thêm hay xóa ký tự, bạn sẽ rất mất thì giờ để định dạng lại. 

Thiết lập và sắp thẳng các điểm dừng (Tab)
 

Tận cùng phía bên trái của thước đo bạn sẽ thấy một nút được gọi là nút chọn 
điểm dừng. Khởi đầu (theo ngầm định), nút đó có dạng  (dùng để căn thẳng 
trái), nháy chuột ở  đó, nó biến thành dạng     (dùng để căn thẳng giữa), nháy 
chuột lần thứ hai ở đó nó sẽ có dạng (dùng để căn thẳng phải)và cuối cùng, 
nếu nháy chuột thêm một lần nữa, nó sẽ trở về dạng ban đầu. Nháy chuột ở 
nút này ta có thể thiết đặt nhanh các điểm dừng để căn trái, căn giữa hay căn 
phải văn bản. Công việc này tương tự như bạn làm việc với máy chữ, tạo các 
điểm dừng để căn thẳng chữ theo các cột. Thực hiện từng bước sau đây giúp 
bạn biết cách thiết đặt các điểm dừng tại các vị trí mong muốn. 
 
1.  Nháy nút chọn điểm dừng đến khi nó phản ánh điểm dừng căn thẳng trái . 
2.  Trên thước, nháy điểm 1 cm. Điểm dừng căn thẳng trái xuất hiện. 
3.  Nháy lại     . Điểm dừng thay đổi thành điểm dừng căn giữa . Trên thước, 

nháy điểm 5 cm. 
4.  Nháy lại     . Điểm dừng thay đổi thành điểm dừng căn thẳng phải     . Trên 

thước, nháy điểm 9 cm. 
5.  Nhấn phím Tab. Gõ Căn thẳng Trái. 
6.  Nhấn phím Tab. Gõ Căn giữa. 
7.  Nhấn phím Tab. Gõ Căn thẳng Phải. 
8.  Nhấn phím Enter và lặp lại các bước 6.-8. với ba từ Trái, Giữa và Phải. 
 
Tài liệu bây giờ hiển thị ba điểm dừng có thể có trong Word như minh họa dưới 
đây: 
 

Căn thẳng trái Căn thẳng giữa                            Căn thẳng phải 
Trái                                                      Giữa                                                     Phải
Một khi ta nháy một điểm dừng nào đó không đúng vị trí trên thước, muốn di 
chuyển nó sang vị trí khác hay xóa điểm dừng đó ta chỉ việc kéo biểu tượng 
điểm dừng tới vị trí thích hợp hay ra khỏi khu vực hiển thị của thước. 
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Thêm đường viền, màu sắc nền cho đoạn văn
Với Word bạn có thể tạo ra nhiều hiệu ứng bất ngờ một cách dễ dàng. Một
trong số đó là việc tạo đường viền, khung cho một đoạn văn bản (kể cả đoạn
văn bản trong các ô của bảng biểu) cũng như thiết lập màu sắc nền cho nó. 
Hình dưới đây minh họa một vài khả năng.

Bạn hãy thực hiện các bước sau đây để thêm đường viền (Border), tạo ra vệt
bóng (Shading), mẫu nền (Patterns) và màu sắc (Color) vào đoạn văn trong 
các tài liệu của bạn. 

Trong nhóm  Paragraph của tab Home, chúng ta thấy có nút , nút này
dùng để giúp bạn thực hiện nhanh một số thao tác có liên quan tới việc tạo
đường viền cho các đoạn văn bản.

Để tạo hình ảnh như hình trên bên trái. Hãy tiến hành các bược sau: 

1.  Nháy nút trong nhóm Paragraph của tab Home. Chọn Borders and
Shading... (Đường viền và Vệt bóng) – dòng cuối cùng trong hình trên. 

2.  Nháy tab Borders và nháy ở hai nút và ở bên phải để chọn viền
trên và viền dưới. Xem hình minh họa dưới đây:
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3.  Cuốn hộp Width: (Độ rộng:) xuống, và chọn độ rộng 3 pt.
4.  Trong hộp danh sách Color: (Màu sắc:), nháy Blue (Xanh) và nháy OK. 
 
Muốn tạo hiệu quả như trong hình thứ hai, ta lặp lại Bước 1 và 2 ở trên, sau đó

1.  Chọn  Borders  and Shading (Đường viền và Vệt bóng)  và  nháy  tab
Shading (Tạo ra vệt bóng).

2.  Trong mục 
nháy 30%. 

Patterns (Mẫu), nháy hộp danh sách Style: (Kiểu dáng), và

3.  Trong hộp danh sách Color (Màu), nháy Auto (Tự động) và nháy OK. (Thay
cho Auto, bạn có thể chọn một màu bất kỳ theo ý thích của bạn. Mẫu được 
hiển thị ở ô bên phải để bạn xem trước (Hình ). 

 
Hình cuối cùng minh họa cả ba hiệu quả: tạo khung, độ bóng và màu nền, trong 
đó có khả năng nới rộng khoảng cách từ khung tới các dòng văn bản. Để thực 
hiện điều đó, bạn hãy lặp lại Bước 1 và 2 ở trên, sau đó

1.  Chọn  Borders  and 
Borders. 

Shading (Đường viền và Vệt bóng)  và  nháy  tab

2.  Nháy hộp Box, cuốn Style để chọn kiểu đường viền, và chọn độ rộng 3 pt.
3.  Trong hộp danh sách Color: (màu sắc:), nháy chọn màu Blue (Xanh). 
4.  Nháy nút Shadow (Đổ bóng). 
5.  Nháy OK. 
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Tạo chữ cái lớn đầu đoạn văn
 
Tạo chữ cái lớn đầu một đoạn văn bản minh họa thêm một khả năng định dạng 
nhanh chóng và dễ dàng của Word. Kiểu dáng này thường được sử dụng nhiều 
hơn trong việc trình bày các bài báo mang tính chất phổ thông. 
 
Có hai kiểu tạo chữ cái lớn đầu một đoạn văn bản: trong lề và ngoài lề. Khi ta
định dạng chữ cái lớn đầu tiên cho một đoạn văn, Word tạo ra một khung
(frame) và đặt chữ cái vào trong khung đó. Bạn cũng có thể chèn một hình vẽ
làm ký tự đầu tiên của một đoạn, với hình vẽ đó, Word sẽ tự động chỉnh lại kích 
thước của hình vẽ để vừa với số dòng bạn muốn.
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1. Đặt dấu chèn vào đoạn văn bản bạn
muốn cho chữ đầu lớn. Nếu bạn đánh
dấu một phần hay cả từ  đầu thì cả từ
đầu 
lớn.

sẽ  được định dạng theo cỡ chữ

2. Chọn tab Insert,  trong  nhóm   Text,
nháy Drop Cap (Chữ cái lớn). 

3. Nháy chuột ở một trong ba khả năng
lựa chọn dưới Position (vị trí):  None
(không), Dropped (đẩy  xuống)  và In
Margin (ở lề). 

4.  Trong  hộp  Font  (phông)  bạn  có  thể
chọn phông chữ. 

5.  Chọn số hàng chữ  đầu thò xuống ở ô
Lines to drop.

6. Chọn khoảng cách từ bên  phải chữ
đầu tới phần còn lại ở ô Distance from
text (khoảng cách tới đoạn văn). 

7. Nháy nút OK.

Dùng Format Paint 
 
Word cung cấp cho ta một công cụ khá hiệu lực và thuận tiện để thực hiện tất 
cả các công việc về định dạng phông chữ, đoạn văn đã được trình bày ở trên 
một cách nhanh chóng và thống nhất trong suốt tài liệu của bạn mà không phải 
lặp lại các thao tác tác đó trong từng đoạn văn. Đó là nút Format Painter (chổi 
 
định dạng) trên tab Home trong nhóm Clipboard có biểu tượng 
(hình một cái chổi quét sơn). Nguyên tắc sử dụng nó thật đơn giản: giả sử bạn
có  một  đoạn  văn bản  đã  định dạng một cách hoàn hảo và bạn muốn tất cả
phần  còn  lại trong  văn  bản của bạn cũng được định dạng như  thế.  Nút

 dùng để sao chép định dạng phông (Font) và đoạn (Paragraph)
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từ  đoạn này  sang  đoạn khác. Để sao chép
đoạn thứ hai, chúng ta tiến hành như sau:

định dạng từ đoạn nào  đó sang

1.  Chọn (bôi đen)  đoạn văn  đã được định dạng (có thể bằng cách kéo thả
chuột, nháy lề trái hai lần hay nháy ba lần trên đoạn văn).

2.  Nháy trên tab Home trong nhóm Clipboard. Nếu di chuyển
chuột, con trỏ của nó bây giờ có hình dạng cái chổi sơn.

3.  Kéo con trỏ chuột tới đoạn văn cần định dạng và nháy chuột. 
 
Lưu ý: Nếu muốn định dạng nhiều đoạn văn bản, bạn có thể tiết kiệm được rất

nhiều thời gian bằng cách nháy hai lần ở bước 2. Khi đã định
dạng  xong  tất  cả  các đoạn  cần thiết bạn phải nháy chuột một  lần  ở  nút

để con trỏ của chuột trở về hình dạng cũ.
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BÀI 5. ĐỊNH DẠNG VÀ SẮP XẾP CÁC DANH SÁCH 

Tạo danh sách các mục 

Đối với những phần văn bản có tính chất liệt kê dưới dạng  danh sách các

khoản  mục,  chúng  ta  sử  dụng lệnh Bullets (Dấu đầu  dòng), 

Numbering  (Đánh số thứ tự) hoặc
mức): 

Multilevel List (Danh sách  nhiều

Các hành tinh trong Hệ Mặt trời        Thứ ba, 4/6/93

• 
 

• 
 

• 
 

• 

Sao Hỏa 
Sao Thủy 
Trái đất 
Sao Kim 

1.
2.
3.
4.

Gặp Phó giám đốc Công ty RNA
Xem xét kế hoạch phát triển 
Trình bày tại Hội thảo 
Khởi hành đi Paris 

Để tạo danh sách các khoản mục, bạn hãy
 
1.  Chọn các dòng cần đưa vào danh sách.

2.  Nháy  trên tab Home trong nhóm Paragraph nếu bạn muốn đặt dấu
chấm đen trước các khoản mục; nếu muốn đánh số thứ tự, bạn hãy nháy

chuột  ở nút          ;  nếu muốn
 
chuột ở nút         . 

đánh số thứ tự nhiều mức, bạn hãy nháy

3.  Muốn loại bỏ một khoản mục nào đó trong danh sách, bạn chỉ cần nháy lại
nút tương ứng. 

 
Như ví dụ trên hình trên chẳng hạn, ta chọn các dòng: "Sao Hỏa", "Sao Thủy", 
 
"Trái đất" và dòng "Sao Kim" (bôi đen) và sau đó nháy chuột ở nút         . Nếu 
 
cần thiết, ta có thể dùng nút để tăng hiệu quả phân biệt. Bạn hãy luôn nhớ
rằng mỗi đoạn sẽ là một khoản mục. Vì vậy để tạo khoản mục mới ta cần gõ 
phím Enter để thêm vào một đoạn mới. Nếu muốn loại trừ một dòng nào đó ra

khỏi danh sách, ta chỉ cần chọn dòng đó và nháy lại nút (hoặc nút ).

Sửa đổi kiểu của các khoản mục
 
Để sửa đổi kiểu của các các khoản mục, ví dụ như bạn không thích dùng dấu • 
 

mà thích dùng dấu ♣ hay dấu � cũng như thay vì 1., 2. bạn thích dạng 1), 2) 
hơn chẳng hạn, bạn vẫn có khả năng để đặt các tùy chọn của mình. Word cung 
cấp cho chúng ta các lựa chọn  định dạng khi nháy  vào mũi tên trên các nút 
Bullets, Numbering và Multilevel List như các hình minh họa dưới đây. 
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 Các dạng dấu đầu dòng 

Các dạng đánh số thứ tự 

Các dạng danh sách nhiều mức

Thêm số vào các đầu mục được tạo bởi kiểu có sẵn 
 
Nếu bạn sử dụng các kiểu đầu mục có sẵn cho việc định dạng các đầu mục 
trong một tài liệu, bạn có thể đánh số các đầu mục một cách tự động bởi định 
dạng số bạn chọn.
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1.  Trên tab Home trong nhóm Paragraph, nháy Multilevel List. 
2.  Nhập văn bản bạn muốn đánh số đầu mục, ấn ENTER.

3.  Để thêm số đầu mục tiếp theo, nháy
kiểu bạn muốn.

Multilevel List lần nữa và chọn

Để  chuyển một  đầu mục tới một
nhóm Paragraph.

mức phù hợp, thực hiện các lệnh sau trên

1.  Để giảm  cấp đầu  mục xuống mức số thấp hơn, chọn đầu mục và nháy

Increase Indent hoặc ấn phím TAB.
2.  Để thăng  cấp đầu  mục lên một mức số cao hơn, chọn đầu mục và nháy

Decrease Indent  hoặc ấn SHIFT+TAB.

Sắp xếp một danh sách 

1.  Chọn  danh  sách 
bạn    muốn    sắp 
xếp. 

2.  Trên   tab 
trong 

Home,
nhóm

Paragraph,   nháy 

Sort. 
3.  Lựa các tùy chọn 

bạn muốn. 
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BÀI 6. LÀM VIỆC VỚI BẢNG

Tạo bảng 
 
Tạo bảng trong một văn bản bao giờ cũng là một công việc phức tạp và tốn phí 
công sức. Nhiều chương trình soạn thảo văn bản chuyên nghiệp cũng đã bộc lộ 
những điểm yếu của mình khi xử lý bảng biểu. Các tính năng của Word 2007 
đã được cải tiến rất nhiều để giúp ta tạo bảng một cách đơn giản và trực quan. 
 
Tạo bảng tức là bố trí các thông tin, dữ liệu có liên quan với nhau dưới một 
dạng nêu bật được các mối liên quan đó. Bảng gồm các hàng và các cột, mỗi 
hàng và cột gồm một số ô. Bạn có thể  đưa văn bản và hình vẽ vào mỗi ô và 
việc soạn thảo cũng như sửa đổi chúng trong mỗi ô được thực hiện theo cách 
thức y hệt như bạn thực hiện trên một trang bình thường. 
 
1.  Để thêm một bảng vào tài liệu, ta đặt con trỏ ở vị trí muốn chèn và 

nháy tab Insert, 

2. Trong nhóm Tables nháy chuột vào nút Table
 

Một cửa sổ có nửa trên như hình
bên sẽ xuất hiện. Ta  nháy  chuột,
giữa và kéo chuột  xuống và sang
phải để chọn số hàng và cột cho
bảng rồi thả chuột.  Hàng trên  cùng
sẽ cho bạn biết số  cột và số 
bạn chọn cho bảng.

hàng
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Bạn có thể nháy   Insert  Table...
(Chèn Bảng). Gõ hay chọn số cột và
hàng trong các hộp Number of
Columns (Số Cột)  và  Number of
Rows (Số Hàng) trong hộp hội thoại
Insert Table.

Khởi  đầu Word sẽ tạo cho bạn một theo  nội  dung)  hoặc AutoFit   to

bảng trống có số cột và số hàng bạn
muốn  với  chiều rộng  các  cột được

window (Tự động khớp theo cửa sổ).

chia đều theo chiều rộng của trang.
Khi cần thiết chỉnh sửa, chúng ta có
thể  dùng chuột di chuyển các con trỏ
trên thước đo để thay đổi độ rộng của
các cột.  Còn khi  dùng  lệnh Insert
Table...  bạn  có thể chọn chiều rộng
của các cột (Column width) theo các
lựa chọn  khác nhau dưới  AutoFit
behavior: cho số vào ô ở cửa sổ mô
tả ở bên nếu bạn muốn chiều rộng cột
cố  định, có thể  để  Auto, hoặc  chọn
AutoFit to contents (Tự  động  khớp
 
Chọn ô, hàng và cột trong bảng

Để chọn một ô nào đó trong bảng ta nháy chuột tại cạnh
trái của nó.

Nháy bên trái một hàng để chọn hàng đó. Ta có thể nháy đúp
chuột tại một vị trí trên hàng đó.

Để chọn một cột, ta nháy chuột ở đường viền trên của ô trên
cùng trong cột đó.
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Thay đổi độ rộng các cột 
 
Để thay đổi độ rộng của cột hay hàng trong bảng, trỏ chuột vào đường viền cần 
mở rộng hoặc thu hẹp cho đến khi con trỏ trở thành hai vạch đứng song song 
với hai mũi tên hai chiều, kéo đường viền về phía cần mở rộng hoặc thu hẹp.
Trên thước có các nút đứng ở vị trí các đường viền và dùng chuột kéo các
nút này cũng cho kết quả tương tự như kéo các đường biên.
 
Muốn biết độ rộng của các cột trong bảng, chúng ta có thể đọc trên thước đo. 
Nếu ta ấn và giữ phím ALT và nháy chuột ở nút nào đó, Word sẽ hiển thị các
khoảng cách giữa các đường biên dọc với những số đo chính xác. 
 
Khác với các phiên bản trước đó, khi bạn di chuột đơn thuần để kéo một đường 
biên đứng thì chỉ một vị trí đường biên đó thay đổi, các đường biên khác vẫn ở 
nguyên vị trí cũ. Với các phím SHIFT và CTRL ta có thể tạo thêm các hiệu quả 
khác: 
 
� Giữ phím CTRL ở trạng thái ấn và kéo một đường biên đứng nào đó, các 

đường biên bên phải nó sẽ thay đổi một cách giữ nguyên tỷ lệ độ rộng giữa
các cột  ở  bên phải  đường biên bị kéo, đồng thời
bảng được giữ nguyên. 

chiều rộng toàn bộ của

� Giữ phím SHIFT ở trạng thái ấn và kéo một đường biên đứng nào đó, các
đường biên bên phải nó sẽ thay đổi và giữ nguyên độ rộng giữa các cột ở 
bên phải đường biên bị kéo, đồng thời chiều rộng toàn bộ của bảng bị thay 
đổi. 

� Giữ đồng thời các phím CTRL và SHIFT ở trạng thái ấn và kéo một đường 
biên đứng nào đó, các đường biên bên phải nó sẽ thay đổi chia đều độ rộng 
giữa các cột ở bên phải đường biên bị  kéo, đồng thời chiều rộng toàn bộ 
của bảng được giữ nguyên. 

 
Việc điều chỉnh độ rộng của các cột một cách chính xác được thực hiện thông 
qua lệnh Table Properties như sau: 
 
1. Chọn cột cần điều chỉnh độ rộng. 
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2.  Trong  tab 
chọn  tab 

Table  Tools, 
Layout,  nháy 

Table Properties 
rồi nháy tab Column. 

3.  Cho các số đo chính xác 
về  độ rộng của từng cột 
ở mục Preferred with và 
các  tùy  chọn khác cho 
bảng     (Table), hàng 
(Row), hoặc ô (Cell). 

4.  Nháy OK. 

Tách bảng 
 
Giả sử bạn có một bảng tổng kết về doanh thu và chi phí của một công ty nào
đó  được sắp xếp dưới dạng bảng bên trái hình dưới đây và  bạn muốn tách
bảng này thành hai bảng, một bảng về doanh thu và một bảng về chi phí. Muốn
thế bạn chỉ cần 
 
1.  Đặt dấu chèn tại hàng mà bảng mới sẽ bắt dầu. 
2.  Trong tab Table Tools, chọn tab Layout, nháy Split Table (tách bảng). 

Bạn sẽ nhận được kết quả như phần bên phải của hình dưới.

Doanh thu 
 
Số đơn vị bán ra

1992 1993 Doanh thu
 
199 168           số đơn vị bán ra

1992   1993 
 
199     168 

Giá đơn vị 3 3 Giá đơn vị 3         3 

Tổng doanh thu 597 504 Tổng doanh thu 597     504 

Chi phí 1992 1993

Chi phí nguyên liệu\đơn   75 75 Chi phí
vị 

1992   1993 

Chi phí lao động đơn vị 
 
 
Chi phí bán hàng

25 25 Chi phí nguyên liệu\đơn 
vị 

 
129 168 Chi phí lao động \đơn vị 

75       75 
 
 
25       25 

Chi phí bán hàng 129     168 
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Thêm và xóa ô, hàng và cột
Để  thêm ô, hàng hoặc cột trong một bảng, trước hết chúng ta phải chọn ô,
hàng hay cột. Word sẽ thêm hàng mới lên trên hàng ta đánh dấu, thêm cột mới
vào bên trái cột được đánh dấu và ô mới vào vị trí đánh dấu, đẩy xuống và đẩy 
sang bên phải các ô ở dưới và bên phải ô đánh dấu kể cả ô được đánh dấu. 
 
Thêm ô: Ta nhớ là cần thêm bao nhiêu ô thì phải chọn ngần ấy ô. Ví dụ như 
hình dưới ta cần thêm hai ô vào trước ô thứ hai ở cột 2 và hàng 2. 
 
1.  Chọn hai ô 2 và 3 ở cột 2 
2.  Trong tab Table Tools, chọn tab Layout, nháy Bật Hộp thoại của nhóm

Rows & Columns (hàng và cột). Một cửa sổ sẽ được hiển thị. 

Nếu ta nháy ở hàng Shift Cells Down (đẩy ô xuống dưới), hai ô mới sẽ được
chèn vào và đẩy hai ô cũ xuống dưới. Nếu ta nháy ở hàng Shift Cells Right 
(đẩy ô sang phải), hai ô mới sẽ được chèn vào và đẩy hai ô cũ sang phải (xem 
hình dưới). 

Doanh thu 1992 Doanh thu      1992 Doanh thu 1992 

Số   đơn   vị 199 Số đơn  vị Số đơn vị 199 
bán ra 
 
Giá đơn vị 
 

Tổng 
doanh thu 

3
 
597 

bán ra
 
Giá đơn vị 
 
Tổng doanh   199
thu

bán ra
 
Giá đơn vị
 
Tổng 
doanh thu

597 

3 

3

597

Thêm hàng và thêm cột: 
 
1.  Chọn hàng hay cột ở vị trí cần thêm các hàng mới hay cột mới vào. 
2.  Chọn Insert entire row hoặc Insert entire column để thêm hàng hay cột.

Để ý rằng bạn chọn bao nhiêu hàng hay cột thì Word sẽ  chèn thêm bấy
nhiêu hàng và cột  vào vị trí trên các hàng hay bên trái các cột  đã  được
chọn. 
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Doanh thu 1992 Doanh thu 1992

Số đơn  vị 199
bán ra 
 
Giá đơn vị 3

Tổng 597              Số đơn  vị 199
doanh thu bán ra

 
       Giá đơn vị 
 
       Tổng doanh

thu

3
 
597

Doanh thu 1992
 
Số   đơn  vị 199 
bán ra 
 
Giá đơn vị 3

     Doanh thu
 

Số đơn   vị
bán ra 

 
Giá đơn vị

1992
 
199 
 
 
3

Tổng 
doanh thu 

597 Tổng doanh
thu

597

Xóa ô, hàng và cột: Việc xóa các ô, hàng và cột trong bảng bắt đầu bằng việc
đánh dấu những ô, hàng hay cột cần xóa và sau đó chọn lệnh thích hợp trong 
Table Tools, nháy tab Layout tiếp đó trong nhóm Rows & Columns, nháy rồi 
nháy Cells - xóa ô, Rows - xóa hàng hay Delete Columns - xóa cột, tương 
ứng. 

Tách ô 
 
Bạn có thể phân chia một ô bất kỳ trong bảng thành nhiều hàng và/hay cột tùy 
theo ý thích của bạn. 
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1.  Chọn ô cần phân chia. 
2.  Dưới Table Tools, trong tab Layout, trong nhóm Merge, nháy Split Cells. 
3.  Một cửa sổ như hình bên sẽ được hiển thị.
4.  Hãy nhập số hàng vào ô Number of rows (số hàng) và số cột  vào ô

Number of colums (số cột).
5.  Nháy OK. 

Hợp nhất nhiều ô thành một ô
 
Với Word 2007, việc hợp nhất các ô được thực hiện đơn giản vì Word 2007 cho 
phép hợp nhất theo cả  hai chiều. Bạn chỉ việc chọn các ô cần kết hợp thành

một ô và chọn lệnh Merge Cells (kết hợp các ô) trong nhóm Merge trên
tab Layout của Table Tools, bạn sẽ được kết quả mong muốn.

Định dạng bảng 
 
Tạo các đường viền và các đường lưới đa dạng sẽ làm nổi bật những nét quan 
trọng trong một bảng là mục đích của việc định dạng bảng. Có thể sử dụng một 
trong ba cách sau: 
 
Word 2007 cung cấp cho ta các kiểu sẵn dùng – tương tự như các kiểu để định 
dạng văn bản, để có thể  định dạng các đường này một cách đơn giản bằng
việc sử dụng các lệnh hiển thị trực quan trên tab Design trong nhóm  Table
Styles của Table Tools (Hình dưới)

Để tự định dạng một bảng ta thực hiện theo các bước sau:
 
1.  Chọn một vùng hoặc toàn bộ bảng cần định dạng (dưới Table Tools, nháy 

tab Layout trong nhóm Table – nháy nút Select và chọn miền bạn muốn). 
2.  Dưới Table Tools, nháy tab Design.

3.  Trong nhóm Table Styles, nháy nút Borders, sau đó dùng các
thiết đặt sẵn có của đường viền để định dạng miền bạn đã chọn. Tuy nhiên
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với cách này bạn phải lặp lại thao tác này nhiều lần nếu muốn định dạng đủ
các đường viền theo ý mình. Bạn có dùng cách sau:

4.  Nháy Borders and Shading để mở hộp thoại
Border and shading thay cho chọn dạng đường viền sẵn có, nháy tab
Borders, rồi chọn kiểu thiết đặt dưới Setting, kiểu đường dưới Style, màu
sắc dưới  Color,  độ đậm nhạt của đường viền dưới Width tùy theo bạn
muốn, chọn vị trí các đường viền hay lưới trong bảng để áp dụng kiểu bạn
thiết đặt dưới Preview. 

Đối với dữ liệu trong bảng, bạn có thể sử dụng các phương  thức  định dạng
thông thường như với định dạng đoạn và định dạng ký tự.

Điều chỉnh vị trí của bảng
 
Với việc kéo các đường viền, chúng ta hoàn toàn có khả năng di chuyển một 
bảng tới một vị trí bất kỳ. Song việc làm đó làm tiêu phí quá nhiều thời gian và 
kém phần chính xác. Trong thực tế đôi khi chúng ta chỉ cần đặt cân giữa hai lề, 
sát lề trái hay sát lề phải. Trong những trường hợp như thế này, việc căn chỉnh 
tương đối dễ dàng. 
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1. Chọn một 
bộ bảng

dòng hay toàn

2. Chọn Center (giữa), Left
(trái)  hay Right   (phải)
dưới Alignment 
xếp)   trong    hộp 

(sắp 
thoại

Table Properties  để đặt
bảng căn giữa, sát lề trái
hay sát lề phải. 

3. Nháy OK. 

Tạo bảng tự do 
 
Ngoài cách tạo bảng nêu trên, bạn có thể  tự vẽ bảng như bạn dùng bút bình 
thường bằng cách: 

Nháy tab  Insert, trong nhóm Tables nháy chuột vào nút  Table

và nháy nút Draw Table (Vẽ Bảng). Khi đó con trỏ chuột chuyển
thành hình cây bút. Bạn có thể chọn màu để vẽ bảng (từ hình bên) bằng cách

nháy nút trên tab Design của Table Tools trong nhóm  Draw
Borders. Đầu tiên bạn vẽ đường khung ngoài của bảng sau đó vẽ các đường
kẻ ngang phân chia hàng, đường kẻ dọc phân chia cột. Kết thúc việc vẽ bằng

cách nháy nhả nút
Borders 

 trên tab Design của Table Tools trong nhóm Draw
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Bạn có thể sửa các  đường vẽ nhầm bằng cách nháy nút  trên tab
Design của Table Tools trong nhóm Draw Borders. Con trỏ trở thành hình cái
tẩy, kéo chuột đến đoạn đường kẻ vẽ sai, nháy và kéo chuột để đoạn vẽ sai nổi

lên, nhả chuột để xoá đoạn đó. Nháy nút một lần để dừng chế độ xoá.

Tạo phương trình 
 
Các phương trình được tạo trong văn bản đòi hỏi một cách định dạng khác biệt, 
kể cả phông chữ hay khoảng cách và vị trí của các ký tự và dấu hiệu và hiện đã 
có một vài chương trình chuyên dụng cho việc soạn thảo các phương trình theo 
đúng các yêu cầu về chuyên môn cũng như về  ấn loát. Word là một hệ phần 
mềm xử lý văn bản, tuy không phải là chuyên dụng song với phiên bản 2007 đã 
có thể đáp ứng được các yêu cầu nghiêm khắc của các nhà chuyên môn với 
cách soạn thảo dễ dàng hơn trước nhiều. 
 
Với Word 2007 ta có thể tạo các phân số, các hàm số mũ, tích phân và hàng 
loạt các phần tử toán học khác trong một văn bản. Khi bạn soạn phương trình, 
Word tự động định dạng và làm hầu hết các công việc khi soạn thảo biểu thức
toán học, chẳng hạn như tự  động chọn cỡ chữ cho các chỉ số trên và dưới
cũng như vị trí của chúng và điều chỉnh khoảng cách giữa các ký tự. 

sin 2  α  + cos 2  α = 1 − b ± b 2 − 4ac
 

2a

n 

a = ∑ xk

Khi soạn phương trình, Word tự động chuyển đổi phương trình sang định dạng
phương trình chuyên nghiệp. 
 
1.  Trên tab Insert, trong nhóm Symbols, nháy vào mũi tên cạnh Equations, 
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rồi nháy 
 
2.  Soạn phương trình. 
 
Chèn   một phương 

.

trình được  sử  dụng 
thường    xuyên    hay 
định dạng trước: 

1.  Trên   tab 
trong 
Symbols, 

Insert, 
nhóm 
nháy 

vào mũi tên cạnh 
Equations,       rồi 
nháy phương trình 
mà    bạn 
soạn. 

muốn 

Thêm một phương trình vào danh sách phương trình
xuyên 
 
1.  Chọn phương trình bạn muốn thêm.

được sử dụng thường

2.  Dưới Equation Tools, trên tab Design, trong nhóm Tools, nháy Equation,

rồi nháy .
3.  Trong hộp thoại Create New Building Block, gõ tên cho phương trình. 
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4.  Trong danh sách Gallery, nháy Equations.
5.  Chọn bất kỳ lựa chọn nào khác mà bạn muốn. 
 
Chèn biểu thức toán học thường dùng: 
 
1.  Trên tab Insert, trong nhóm Symbols, nháy mũi tên bên cạnh Equations, 

rồi nháy .

2.  Dưới Equation Tools, trên tab Design, trong nhóm Structures, nháy loại
biểu thức bạn muốn dùng, chẳng hạn như phân số hay khai căn, rồi nháy 
biểu thức mà bạn muốn dùng.

Nếu biểu thức chứa những chỗ giữ sẵn, hãy nháy vào đó rồi gõ số hay ký hiệu
bạn muốn. Chỗ giữ sẵn của phương trình là những hộp chấm chấm nhỏ trong

phương trình .

Biểu thức toán học bạn soạn thảo sẽ được Word chèn vào trong một khung, khi
nháy chuột ở ngoài khung biểu thức, khung sẽ mất đi và tất cả sẽ được hiển thị 
đúng như bạn mong muốn. 
 
Những ký tự  bạn gõ vào trong biểu thức cũng sẽ được đặt trong các khung,

khởi đầu các khung này có dạng rất hẹp, như khung chấm trong hình (vì
chưa chứa gì); khi thêm ký tự, các khung này sẽ được tự động nới rộng ra. Nếu
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trong một biểu thức bạn thấy có nhiều khung như vậy thì có thể dùng các phím
mũi tên để di chuyển dấu chèn giữa các khung đó. 
 
Khi soạn thảo xong biểu thức, ta nháy chuột tại một nơi bất kỳ trên màn hình và 
màn hình Word sẽ trở lại. 
 
Thay đổi một phương trình được viết trong Office Word 2007: 
 
1.  Nháy phương trình bạn muốn soạn thảo. 
2.  Thực hiện các thay đổi bạn muốn. 
 
Thay đổi một phương trình được viết trong phiên bản trước: 
 
Để thay đổi một phương trình được viết trong phiên bản trước dùng Equation 
3.0 bổ trợ, bạn cần sử dụng phần bổ trợ đã được dùng để viết phương trình. 
 
Khi bạn mở một tài liệu có chứa phương trình được viết trong phiên bản trước 
của Word, bạn không thể sử dụng hỗ trợ gắn liền để viết hay thay đổi phương 
trình nếu không chuyển đổi tài liệu của bạn sang Office Word 2007. 
 
Thay đổi một phương trình được viết bằng Equation 3.0: 
 
1.  Nháy đúp vào phương trình bạn muốn thay đổi. 
2.  Thực hiện các thay đổi bạn cần. 

Để  nhận trợ  giúp trong 
trên bảng chọn Help. 

Equation Editor, nháy Equation Editor Help Topics

Chuyển đổi một phương trình định dạng chuyên nghiệp sang một phương trình
trên một dòng: 
 
Khi bạn gõ một phương trình và ký tự phân ranh chẳng hạn như khoảng cách 
trong miền toán học, Microsoft Office Word 2007 tự động chuyển đổi nó thành
phương trình định dạng chuyên nghiệp. Thủ tục sau giải thích chuyển đổi
phương trình định dạng chuyên nghiệp sang phương trình trên một dòng như
thế nào. 
 
Chuyển đổi phương trình: 
 
1.  Chọn phương trình. 
2.  Dưới Equation Tools, trên tab Design, trong nhóm Tools, nháy Linear. 
 
Chuyển đổi tài liệu của bạn sang Office Word 2007: 
 
Nếu bạn chuyển đổi tài liệu của bạn và lưu nó sang tệp Office Word 2007, bạn 
sẽ  không thể  sử dụng phiên bản trước của Word để  thay đổi bất kỳ phương 
trình nào trong tài liệu. 

� Nháy nút 
 
� Nháy nút 

Microsoft Office, rồi nháy Convert.
 
Microsoft Office, rồi nháy Save.

Lưu ý Sau khi bạn chuyển đổi tài liệu của bạn, bạn cần lưu tài liệu như một tài
liệu Office Word 2007, hoặc tài liệu sẽ trở lại phiên bản trước.
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BÀI 7. THIẾT KẾ TRANG
 
Thông thường việc đặt kích thước trang, lề, hướng giấy (ngang hay dọc), đầu 
trang hay chân trang được thực hiện trước khi soạn thảo văn bản. Tuy nhiên 
bạn có thể thay đổi các những đặc trưng này bất cứ lúc nào bạn muốn. Thậm 
chí có thể duy trì các đặc trưng này một cách nhất  quán trong suốt văn bản 
hoặc bạn có thể chia một văn bản dài thành nhiều phần (section) để đặt các tùy 
chọn khác nhau cho từng phần.

Kích thước trang in 

Kích thước trang 
 
Khi mở đầu một văn bản mới với Word, bạn có thể bắt tay vào việc soạn thảo
ngay. Word sẽ áp dụng các thông số ngầm định về kích thước trang, kích
thước lề cũng như cách đánh số trang cho văn bản của bạn. Nếu bạn thấy các
thông số ngầm định đó không phù hợp với mục tiêu của mình, bạn có thể đặt 
lại theo các bước sau: 
 
1.  Trước hết chọn kích thước giấy. Trên tab Page Layout, trong nhóm Page 

Setup, nháy Size 
2.  Các loại kích thước giấy được được hiển thị trong hộp thoại có số đo tương 

ứng. Hai loại kích thước thường dùng là A4 và A5. Cuối hộp thoại có More 
Paper Sizes… (kích thước trang khác nữa) để bạn có thể chọn kích thước 
tùy ý. 

Thay đổi hướng trang toàn bộ tài liệu của bạn
 
1.  Trên tab Page Layout, trong nhóm Page Setup, nháy Orientation. 

2.  Nháy Portrait hay Landscape.
 
Sừ dụng hướng dọc và ngang trang giấy trong cùng một tài liệu: 
 
1.  Chọn các trang hay đoạn văn mà bạn muốn chuyển thành hướng dọc hay 

ngang trang giấy. 
 

LƯU Ý  Nếu bạn chọn một số nhưng không phải toàn bộ văn bản trên trang 
để chuyển thành hướng dọc hay ngang, Word đặt văn bản đã chọn trong 
trang của nó, và văn bản lân cận sang trang riêng. 

 
2.  Trên tab Page Layout, trong nhóm Page Setup, nháy Margins. 
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3.  Nháy Custom Margins. 
4.  Trên tab Margins, nháy Portrait hay Landscape. 
5.  Trong danh sách Apply to, nháy Selected text. 
 
LƯU Ý  Microsoft Word tự động chèn ngắt phần trước và sau văn bản ở nơi có 
hướng trang mới. Nếu văn bản của bạn đã chia thành nhiều phần, bạn có thể 
nháy vào một phần (hay chọn nhiều phần), rồi đổi hướng chỉ cho các phần bạn 
chọn. 
 
Thay đổi và thiết đặt lề 
 
Lề là khoảng cách từ mép trang giấy tới cạnh của phần văn bản (khoảng cách 
giữa các cạnh tương  ứng của hai hình chữ nhật trên hình  vẽ bên). Thông 
thường Word in văn bản và hình vẽ trong diện tích được giới hạn bởi các lề, 
còn các thông tin chứa trong  đầu trang hay cân trang (kể cả  số trang)  được 
đưa ra ngoài lề. Một khi lề đã được điều chỉnh thì các thông số đó tác động đến 
toàn bộ văn bản. 
 
Các lựa chọn lề: 
 
Microsoft Word đưa ra một vài lựa chọn lề. Bạn có thể dùng các lề mặc định 
hoặc có thể định rõ lề của riêng mình.

Thêm lề cho bìa sách  Sử dụng lề đóng gáy để thêm khoảng cách vào bên
cạnh hoặc phía lề trên của tài liệu mà bạn định đóng gáy. Lề đóng gáy sẽ giúp
cho văn bản không bị che khuất do đóng gáy.

 Lề đóng gáy 
 
 Lề đối xứng gương cho các trang đối diện
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Đặt lề cho các trang Sử dụng lề đối xứng gương để thiết đặt trang cho các
tài liệu in hai mặt, như sách hay tạp chí. Trong trường hợp này, lề của trang trái
sẽ đối xứng gương với lề trang phải (nghĩa là, lề bên trong có cùng độ rộng, và
lề bên ngoài có cùng độ rộng). 
 

LƯU Ý    Bạn có thể thiết đặt lề đóng gáy cho một tài liệu đối xứng gương nếu 
tài liệu cần khoảng cách thêm để đóng gáy. 
 

Add a book fold Sử dụng lựa chọn Book fold trong hộp thoại Page Setup,
bạn có thể tạo cuốn sách nhỏ. Bạn có thể sử dụng lựa chọn tương tự để tạo
bảng chọn, giấy mời, chương trình sự kiện, hay bất kỳ loại tài liệu nào khác sử
dụng gấp giữa đơn. 

 Word chèn gấp giữa đơn 

Sau khi bạn thiết đặt tài liệu như một cuốn sách nhỏ, bạn cũng làm việc với nó
như bạn làm việc với bất kỳ tài liệu nào, chèn văn bản, đồ họa, và các yếu tố
trực quan khác. 
 
LƯU Ý 
 

Hầu hết máy in đòi hỏi một độ rộng tối thiểu cho thiết đặt lề, vì không thể in ra
sát mép trang giấy. Nếu bạn cố thiết đặt lề quá hẹp, Microsoft Word hiển thị
thông báo One or more margins are set outside the printable area of the
page. 
 

Để tránh tình trạng văn bản bị mất, nháy Fix để tự động tăng độ rộng lề. Nếu
bạn không để ý đến thông báo và cố in tài liệu như vậy, Word sẽ hiển thị thông
báo khác hỏi bạn có muốn tiếp tục không. 
 

Thiết đặt lề tối thiểu phụ thuộc máy in của bạn, trình điều khiển máy in, và kích
thước trang. Để biết thiết đặt lề tối thiểu kiểm tra tài liệu hướng dẫn máy in của
bạn. 

Thay đổi và thiết đặt lề 
 
1.  Trên tab Page Layout, trong nhóm Page Setup, nháy Margins. 
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2.  Nháy loại lề bạn cần. Với độ rộng lề thông thường nhất, nháy Normal. 
 
Khi bạn nháy loại lề bạn cần, toàn bộ tài liệu của bạn tự động thay đổi sang loại 
lề bạn đã chọn. 

Bạn cũng  có thể  chỉ  rõ  thiết đặt lề của riêng mình. Nháy  Margins, nháy
Custom Margins, rồi trong hộp Top, Bottom, Left, và Right, nhập giá trị mới
cho các lề. 
 
LƯU Ý 
 
Để thay đổi các lề mặc định, nháy Margins sau khi bạn chọn lề mới, rồi nháy
Custom Margins. Trong hộp thoại Page Setup, nháy nút Default, rồi nháy
Yes. Thiết đặt mặc định mới được lưu vào mẫu mà các tài iệu sẽ lấy làm cơ sở.
Mỗi tài liệu mới được tạo trên cơ sở mẫu sẽ tự động dùng thiết đặt lề mới. 
 
Để  thay đổi các lề của một phần văn bản, chọn văn bản, rồi thiết đặt lề bạn
muốn bằng cách nhập  giá trị lề mới trong hộp thoại Page Setup. Trong hộp
Apply to, nháy Selected text. Microsoft Word tự động chèn ngắt phần trước và
sau đoạn văn bản mới được thiết đặt lề mới. Nếu văn bản của bạn đã chia sẵn 
thành các phần, bạn có thể nháy vào một phần hay chọn nhiều phần rồi thay 
đổi lề cho những phần muốn thiết đặt lề giống nhau.

Xem lề trang 

1.  Nháy nút Microsoft Office, rồi nháy Word Options.
2.  Nháy  Advanced, rồi nháy hộp kiểm Show text

document content. 
boundaries dưới  Show

Lề trang xuất hiện trong tài liệu của bạn là các đường nhiều chấm. 
 
LƯU Ý  Bạn có thể xem lề trang trong chế độ Print Layout hoặc Web Layout, 
đường ranh giới văn bản không xuất hiện trong trang được in ra. 

Thiết đặt lề các trang đối diện
 
Khi bạn chọn lề đối xứng gương, lề của trang trái sẽ là ảnh đối xứng gương với lề trang phải. 
Nghĩa là, các lề trong có độ rộng như nhau, và các lề ngoài có độ rộng như nhau. 
 
1. Trên tab Page Layout, trong nhóm Page Setup, nháy Margins.
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2.  Nháy Mirrored.
3.  Để thay đổi độ rộng lề, nháy Margins, nháy Custom Margins, rồi nháy các 

hộp Inside và Outside, nhập độ rộng bạn muốn.

Chèn đầu trang và chân trang
 
Đầu trang và chân trang là vùng ở lề trên và lề dưới trong một tài liệu. Bạn có 
thể đưa vào tài liệu của bạn đầu trang và chân trang để hiển thị thông tin tiêu 
đề, ngày tháng, biểu tượng công ty, số trang hay tên tệp hoặc tên tác giả. Bạn 
có thể định dạng những gì đưa vào đầu trang và chân trang như trong trang văn 
bản bình thường.

Chèn đầu trang hay chân trang trên mỗi trang
 
Microsoft Office Word  2007 có nhiều đầu trang hay chân trang  đã xác định
trước để bạn có thể dùng chèn vào tài liệu của bạn. Hoặc bạn có thể tạo đầu
trang hay chân trang từ đầu. 
 
1.  Trên tab Insert, trong nhóm Header & Footer, nháy Header hay Footer. 

 hay 
 
2.  Nháy thiết kế đầu trang hay chân trang bạn muốn dùng. 
 
LƯU Ý  Nếu bạn không thấy bộ sưu tập thiết kế đầu trang hay chân trang, có
thể có vấn đề với khối cấu trúc mẫu trên máy tính của bạn.

Đầu trang hay chân trang được chèn vào từng trang của tài liệu 
 
Nếu cần bạn có thể  định dạng văn bản trong đầu trang hay chân trang bằng 
cách chọn văn bản và dùng lựa chọn đính dạng trên thanh công cụ Mini. 
 
Nếu bạn muốn chuyển sang một đầu trang hay chân trang xác định trước khác, 
hãy lặp lại các bước này và chọn một đầu trang hay chân trang khác từ bộ sưu 
tập. 

Chèn đầu trang hay chân trang tùy chỉnh
 
1.  Trên tab Insert, trong nhóm Header & Footer, nháy Header hay Footer. 
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 hay 
 
2.  Nháy Edit Header hay Edit Footer. 
3.  Gõ văn bản hay chèn đồ họa và các nội dung khác bằng cách dùng các lựa 

chọn  trong  nhóm  Insert  trong  tab  Design,  dưới  tab  Header  &  Footer 
Tools. 

 MẸO Để lưu đầu trang hay chân trang bạn đã tạo vào bộ sưu tập các lựa chọn
đầu trang hay chân trang, chọn văn bản hay đồ họa trong đầu trang hay chân, 
rồi nháy Save Selection as New Header hay Save Selection as New Footer.

Tạo đầu trang hay chân trang của trang đầu khác với các trang còn lại 

1.  Trên trang 
trang. 

đầu tiên của tài liệu, nháy đúp vào vùng đầu trang hay chân

2.  Dưới Header & Footer Tools, trên tab Design, trong nhóm Options, chọn
hộp kiểm Different First Page. 

 
LƯU Ý  Nếu  tài liệu của bạn có  chứa trang bìa từ  bộ sưu tập các trang bìa 
trong Office Word 2007, lựa chọn Different First Page đã được bật. Chèn hay 
soạn đầu trang hay chân trang trên trang này không ảnh hưởng đến các trang 
khác trong tài liệu.

Tạo một đầu trang hay chân trang, hay thay đổi đầu trang hay chân trang
đã có sẵn trên trang đầu tiên. 
 
Không dùng đầu trang hay chân trang trên trang đầu tiên

1.  Trên trang 
trang. 

đầu tiên của tài liệu, nháy đúp vào vùng đầu trang hay chân

2.  Dưới Header & Footer Tools, trên tab Design, trong nhóm Options, chọn
hộp kiểm Different First Page. 

 
LƯU Ý  Nếu hộp kiểm Different First Page đã được chọn, đừng xóa nó đi. 
Thực hiện bước tiếp. 

 
3.  Trên vùng First Page Header hay First Page Footer, xóa nội dung của đầu 

trang hay chân trang. 
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Tạo đầu trang hay chân trang khác nhau giữa trang lẻ và trang chẵn 
 
Ví dụ, bạn có thể dùng tiêu đề của tài liệu trên các trang lẻ và tiêu đề chương 
trên các trang chẵn. Hoặc, đối với một cuốn sách nhỏ, bạn có thể đặt số trang 
trên các trang lẻ ở bên phải trang giấy và số trang trên các trang chẵn ở bên 
trái  trang giấy. Bằng cách này số trang luôn nằm  ở  mép ngoài khi các  trang 
được in hai mặt của giấy. 
 
Tạo đầu trang hay chân trang lẻ và chẵn trong một tài liệu mà chưa dùng đầu 
trang hay chân trang: 
 
1.  Nháy vào một trang lẻ, chẳng hạn trang đầu tiên của tài liệu. 
2.  Trên tab Insert, trong nhóm Header & Footer, nháy Header hay Footer. 

 hay 
 
3.  Trong bộ sưu tập đầu trang hay chân trang, nháy nhãn thiết kế (Odd Page), 

chẳng hạn Austere (Odd Page).
4.  Dưới Header & Footer Tools, trên tab Design, trong nhóm Options, chọn

hộp kiểm Different Odd & Even Pages.
5.  Dưới  Header & Footer Tools, trên tab Design, trong nhóm  Navigation,

nháy Next Section 
trang chẵn. 

để chuyển con trỏ đến đầu trang hay chân trang của

6.  Dưới Header & Footer Tools, trên tab Design, trong nhóm Header & Footer,
nháy Header hay Footer. 

7.  Trong bộ sưu tập đầu trang hay chân trang, nháy một nhãn thiết kế (Even 
Page), chẳng hạn Austere (Even Page).

Tạo đầu trang hay chân trang lẻ và chẵn trong tài liệu đã có đầu trang hay
chân trang 
 
1.  Nháy đúp vào vùng đầu trang hay chân trang. 
2.  Dưới Header & Footer Tools, trên tab Design, trong nhóm Options, chọn 

hộp kiểm Different Odd & Even Pages. Đầu trang hay chân trang đã có
bây giờ sẽ chỉ được gán cho các trang lẻ.

3.  Dưới  Header & Footer Tools, trên tab Design, trong nhóm  Navigation,

nháy Next Section để chuyển con trỏ đến đầu trang hay chân trang các
trang chẵn, rồi tạo đầu trang hay chân trang cho các trang chẵn. 

Tạo đầu trang hay chân trang khác nhau trong mỗi phần hay chương 
 
Nếu tài liệu của bạn được chia ra các phần, bạn có thể thay đổi đầu trang và 
chân trang sao cho chúng hiển thị nội dung khác nhau cho mỗi phần. Ví dụ, nếu
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tài liệu của bạn chia thành các chương bằng cách dùng ngắt phần, tiêu  đề
chương có thể được hiển thị trong đầu trang của mỗi chương. 
 
MẸO   Nếu bạn không chắc chắn tài liệu của bạn có các phần hay, bạn có thể 
tìm kiếm chúng. 

 Nháy vào Drafts trên thanh trạng thái.
 
 Trên tab Home, trong nhóm Find, nháy Go To. 
 
 Nháy Section. 
 
 Nháy Next để tìm ngắt phần trong tài liệu. 
 
 Chế độ xem bản thảo dễ xem ngắt phần trong tài liệu.

Thêm ngắt phần vào tài liệu 
 
Nếu tài liệu của bạn chưa chia ra các phần, bạn có thể chèn ngắt phần vào chỗ 
nào bạn muốn có đầu trang hay chân trang thay đổi. 
 
1.  Bắt đầu ở đầu trang, đặt con trỏ tại chỗ bắt đầu trang mà bạn muốn bắt đầu 

thay đổi đầu trang hay chân trang.
2.  Trên tab  Page Layout, trong nhóm Page Setup, nháy Breaks, rồi dưới

Section Breaks, nháy Next Page.
3.  Đặt con trỏ tại bắt đầu trang tiếp theo nơi bạn muốn thay đổi đầu trang hay 

chân trang, chẳng hạn trang đầu của chương mới.
4.  Trên tab  Page Layout, trong nhóm Page Setup, nháy Breaks, rồi dưới

Section Breaks, nháy Next Page.
5.  Lặp lại bước 3 và 4 cho mỗi ngắt phần bạn muốn trong tài liệu. 
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Dùng ngắt phần của tài liệu để thay đổi đầu trang hay chân trang 
 
Nếu tài liệu của bạn đã chia thành nhiều phần, bạn có thể dùng ngắt phần để 
định hình đầu trang hay chân trang. 
 
1.  Bắt đầu tại phần đầu của tài liệu, nháy phần đầu tiên mà bạn muốn thay đổi 

đầu trang hay chân trang. 
2.  Trên tab Insert, trong nhóm Header & Footer, nháy Header hay Footer. 

 hay

3.  Nháy Edit Header hay Edit Footer.
4.  Trên  tab  Headers &  Footers, trong nhóm Navigation, nháy  Link to

Previous để ngắt kết nối giữa đầu trang hay chân trang trong phần này
và phần trước.

 
Thay đổi đầu trang hay chân trang đã có, hoặc tạo đầu trang hay chân trang 
mới cho phần này.

1.  Trong  nhóm  Navigation  của
 

Footer), nháy Next Section 
trang của phần tiếp theo. 

tab  Design (tab  theo bối cảnh  Header &
 
để chuyển con trỏ đến đầu trang hay chân

2.  Lặp lại các bước trên cho tất cả các phần trong tài liệu.
 
Dùng đầu trang hay chân trang giống nhau qua ranh giới các phần 
 
Trong một tài liệu có đầu trang hay chân trang thay đổi giữa các phần, bạn có 
thể làm cho đầu trang hay chân trang giống nhau qua ranh giới các phần. 
 
1.  Nháy đúp vào đầu trang hay chân trang mà bạn muốn duy trì qua ranh giới 

các phần. 
2.  Trên tab Headers & Footers, trong nhóm Navigation, nháy Next Section 
 

. 
 
3.  Nháy Link to Previous      . Office Word 2007 sẽ hỏi xem bạn có muốn xóa

đầu trang hay chân trang và kết nối với đầu trang hay chân trang trong phần 
trước không. Nháy Yes. 

Thay đổi nội dung của đầu trang hay chân trang
 
1.  Trên tab Insert, trong nhóm Header & Footer, nháy Header hay Footer. 
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 hay 
 
2.  Nháy Edit Header hay Edit Footer. 
3.  Tiến hành thay đổi của bạn cho đầu trang hay chân trang bằng cách chọn 

văn bản và sửa nó hoặc dùng các lựa chọn trên thanh công cụ Mini để định 
dạng văn bản. Ví dụ, bạn có thể thay đổi phông, áp dụng chữ in đậm, hay 
áp dụng phông màu khác nhau.

MẸO  Trong  chế độ xem Print Layout, bạn có thể chuyển nhanh giữa đầu
trang hay chân trang và văn bản tài liệu. Nháy đúp ngay vào đầu trang hay
chân trang mờ, hay văn bản tài iệu mờ.

Chèn số trang 
 
Nếu tài liệu của bạn đã có nội dung ở  đầu trang hay chân trang, bạn có thể 
thêm số trang vào đầu trang hay chân trang. 
 
Nếu bạn muốn dùng một trong các thiết kế số trang định dạng trước, nhưng 
bạn muốn  thêm thông tin nhiều hơn là số trang vào đầu trang hay chân trang, 
đơn giản nhất là bắt đầu với số trang sau đó thêm văn bản hay đồ họa khác 
vào đầu trang hay chân trang. 
 
LƯU Ý  Nhiều thiết kế  chân trang trong bộ  sưu tập đã có chứa số trang như 
một phần của nội dung. 
 
Để thêm thông tin về chèn số trang, xem Chèn số trang. 
 
Thêm số trang vào đầu trang hay chân trang đã có 
 
1.  Nháy đúp vào vùng đầu trang hay chân trang. 
2.  Đặt con trỏ tại nơi bạn muốn chèn số trang. 
 
LƯU Ý 
 
Bạn có thể cần ấn phím TAB, điều chỉnh căn đoạn, hay thực hiện các thay đổi 
khác đối với nội dung đầu trang hay chân trang ở vị trí con trỏ nơi bạn muốn. 

Nhiều thiết kế đầu trang hay chân trang bị nằm ra ngoài bảng, và  ấn TAB
chuyển con trỏ không phải chèn điểm dừng tab. Để chèn điểm dừng tab trong ô
bảng, ấn CTRL+TAB. Để xác định đầu trang hay chân trang mà bạn đang làm 
việc nằm đâu ngoài bảng, tìm trong tab theo bối cảnh Table Tools ở trên Ruy- 
băng khi con trỏ trong vùng đầu trang hay chân trang. 
 
Nhiều thiết kế đầu trang hay chân trang chứa điều khiển nội dung cho các nội 
dung lưu trữ  chẳng hạn như tiêu đề tài liệu và ngày tháng. Khi bạn nháy để 
soạn đầu trang hay chân trang, con trỏ tự động chọn điều khiển nội dung. Để di 
chuyển con trỏ ra khỏi điều khển nội dung (để bạn có thể chèn số trang vào đầu
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trang hay chân trang mà không cần xóa nội dung của điều khiền nội dung), ấn
phím mũi tên sang trái hay mũi tên sang phải. 
 
1.  Trên tab Insert, trong nhóm Header & Footer, nháy Page Number. 

2.  Nháy Current Position. 
3.  Chọn thiết kế số trang từ bộ sưu tập các thiết kế. 
 
Thêm nội dung đầu trang hay chân trang vào thiết kế số trang định dạng trước 
 
1.  Trên tab Insert, trong nhóm Header & Footer, nháy Page Number. 

2.  Nháy  Top of Page, Bottom of Page, hay Page Margins, phụ thuộc vào
bạn muốn số trang xuất hiện ở đâu trong tài liệu của bạn.

3.  Chọn thiết kế số trang từ bộ sưu tập các thiết kế. 
 
Ví dụ, nếu bạn muốn nội dung đầu trang nào đó được căn lề  trái và số  trang 
căn lề phải, chọn thiết kế số trang được căn phải. 
 
Thực hiện một trong các cách sau: 
 
� Để chèn nội dung đầu trang hay chân trang trước số trang, ấn phím HOME, 

nhập nội dung, rồi ấn TAB đến vị trí nội dung. 
� Để chèn nội dung đầu trang hay chân trang sau số trang, ấn phím END, ấn 

TAB, rồi nhập nội dung. 
 
Nếu bạn chọn một thiết kế từ thiết kế Page Margins, nháy đầu trang hay chân 
trang, và thêm nội dung bạn muốn vào.

Chèn tên tệp của tài liệu 
 
1.  Đặt con trỏ tại nơi bạn muốn chèn tên tệp vào đầu trang hay chân trang. 
2.  Dưới  Header & Footer Tools, trên tab

Quick Parts, rồi nháy Field.
Design, trong nhóm Insert, nháy

3.  Trong  danh  sách  Field  names, nháy FileName. Nếu bạn  muốn  có cả
đường dẫn cùng với tên tệp, chọn hộp kiểm Add path to filename. 

Bảo mật  Vì  bất cứ ai đọc tài liệu của bạn đều có thể nhìn thấy  được mã
trường, hãy chắc chắn rằng thông tin bạn đặt trong mã trường không phải là
thông tin riêng tư.
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Chèn tiêu đề tài liệu, tên tác giả, hay các thuộc tính khác của tài liệu 
 
1.  Đặt con trỏ tại nơi bạn muốn chèn thuộc tính của tài liệu vào đầu trang hay 

chân trang. 
2.  Dưới  Header & Footer Tools, trên tab

Quick Parts. 
Design, trong nhóm Insert, nháy

3.  Trỏ vào Document Property, rồi nháy thuộc tính tài liệu mà bạn muốn. 

Chèn ngày hiện tại 
 
1.  Đặt con trỏ tại nơi bạn muốn chèn ngày vào đầu trang hay chân trang. 
2.  Dưới  Header & Footer Tools, trên tab

Date & Time. 
Design, trong nhóm Insert, nháy

3.  Trong danh sách  Available formats, nháy định dạng ngày 
chọn (cả giờ nếu cần). 

mà bạn  muốn

Loại bỏ đầu trang hay chân trang
 
1.  Nháy bất kỳ đầu trong tài liệu. 
2.  Trên tab Insert, trong nhóm Header & Footer, nháy Header hay Footer. 

hay
 
3.  Nháy Remove Header hay Remove Footer. 
 
Đầu trang hay chân trang bị xóa trong toàn bộ tài liệu. 
 
 LƯU Ý  Nếu bạn đã tạo đầu trang hay chân trang khác trang đầu tiên và trang 
chẵn trang lẻ khác nhau, hoặc nếu có các phần không được liên kết, hãy chắc 
chắn loại bỏ tất cả đầu trang hay chân trang ở mỗi trang hay phần khác nhau. 

Ngắt trang 
 
Trong  ấn loát nói chung người ta rất tránh những trang in có những  khiếm
khuyết sau đây: 

Các dòng cụt ở đầu trang hay cuối trang (nghĩa là dòng cuối cùng của một
đoạn văn ở đầu trang và một hay hai dòng đầu tiên của một đoạn ở cuối trang).
 
Các tiêu đề đứng ở cuối trang mà không có nội dung đi kèm. 
 
Ngoài ra trong văn bản nên tránh bố trí các bảng biểu bị chia ra hai trang khác
nhau cũng như nhiều  điều khác nữa. Mục đích là trình bày một văn bản rõ
nghĩa và nêu bật được những điều cốt yếu, tránh làm mất đi sự tập trung của
người đọc vào những điều cốt yếu. 
 
Word có một cơ chế tự động ngắt trang để phù hợp với nhiều yêu cầu về nội
dung và thẩm mỹ khác nhau. Tuy nhiên trong những trường hợp hãn hữu,
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chúng ta vẫn phải sử dụng tới cơ chế ngắt trang tùy chọn bằng lệnh Insert →
Page Break (ngắt): 
 
1.  Đặt dấu chèn ở vị trí bạn muốn ngắt trang.

2. Trên tab Insert, trong nhóm Pages, nháy Page Break. 
 
Chặn ngắt trang ở giữa một đoạn 
 
1.  Chọn đoạn bạn muốn chặn việc ngắt thành hai trang. 
2.  Trên tab  Page Layout, nháy  mở hộp thoại  Paragraph, rồi 

and Page Breaks. 
3.  Nháy hộp kiểm Keep lines together. 
 
Chọn các đoạn bạn muốn giữ chúng trong cùng một trang. 
 
1.  Trên tab  Page Layout, nháy  mở hộp thoại  Paragraph, rồi 

and Page Breaks. 
2.  Chọn hộp kiểm Keep with next. 
 
Chỉ rõ ngắt trang trước một đoạn 
 
1.  Nháy đoạn bạn muốn ngắt trang.

nháy tab 
 
 
 
 
 
 
 
nháy tab 

Line
 
 
 
 
 
 
 
Line

2.  Trên tab Page Layout, nháy Bật Hộp thoại Paragraph, rồi nháy tab Line
and Page Breaks. 

3.  Chọn hộp kiểm Page break before. 
 
Đặt ít nhất hai dòng của một đoạn ở trên cùng hay dưới cùng của trang 
 
Một tài liệu trông chuyên nghiệp không bao giờ kết thúc trang với chỉ một dòng 
của của đoạn mới hay bắt đầu một trang với chỉ có dòng cuối cùng của một 
đoạn của trang trước. Dòng cuối cùng của một đoạn nằm riêng lẻ  ở  đầu một 
trang hay dòng đầu tiên của một đoạn nằm riêng lẻ ở cuối một trang gọi là dòng 
mồ côi. 
 
1.  Chọn các đoạn bạn muốn chặn chúng không có dòng mồ côi. 
2.  Trên tab Page Layout, nháy Bật Hộp thoại Paragraph, rồi nháy tab Line 

and Page Breaks. 
3.  Chọn hộp kiểm Widow/Orphan control. 
 
 LƯU Ý   Lựa chọn này được bật mặc định. 
 
Chặn ngắt trang trong dòng của một bảng 
 
1.  Nháy dòng trong bảng bạn không muốn bị ngắt. Chọn toàn bộ bảng nếu bạn 

không muốn bị ngắt sang trang. 
 

LƯU Ý   Một bảng dài hơn một trang thì phải ngắt trang. 
 
2.  Trên tab Table Tools, nháy Layout
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3.  Trong nhóm Table, nháy Properties

4.  Nháy tab Row, và xóa hộp kiểm Allow row to break across pages. 

Chèn ngắt phần 
 
Bạn có thể dùng ngắt phần để thay đổi bố trí hay định dạng của trang hay các 
trang của trong tài liệu của bạn. Ví dụ, bạn có thể bố trí phần của một trang cột 
đơn thành hai cột. Bạn có thể tách các chương trong tài liệu của bạn do đó số 
trang cho mỗi chương bắt đầu từ  1. Bạn cũng có thể tạo đầu trang hay chân 
trang khác nhau cho một phần của tài liệu của bạn. 
 
 LƯU Ý   Trong Microsoft Office Word 2007, bạn có thể chọn nhiều bố trí trang 
từ bộ sưu tập thiết kế trang mới. Ví dụ, bạn có thể thêm một trang cột đơn có 
một phần cột đôi bằng cách nháy lựa chọn bố trí trang đó trong bộ sưu tập các 
thiết kế New Page. 

 Phần định dạng cột đơn 
 

 Phần định dạng cột đôi 
 
Các dạng ngắt phần bạn có thể chèn 
 
Các ngắt phần được dùng để tạo bố trí hay thay đổi định dạng trong phần chia 
của một tài liệu. Bạn có thể thay đổi các định dạng sau cho các phần riêng: 
 

�   Lề 
�   Kích cỡ hay hướng trang giấy 
�   Nguồn giấy cho máy in 
�   Viền trang 
�   Căn dọc của văn bản trên một trang 
� Đầu trang và chân trang
�   Cột 
�   Số trang 
�   Số dòng 
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�   Chú thích cuối trang và cuối văn bản
 
 LƯU Ý 
 
Ngắt phần điều khiển định dạng văn bản phần trước nó. Khi bạn xóa một ngắt 
phần, bạn cũng xóa định dạng văn bản phần trước dấu ngắt. Văn bản đó một 
phần của phần tiếp theo. Ví dụ, nếu bạn chia các chương của một tài liệu bằng
ngắt phần sau đó bạn xóa ngắt phần ở bắt đầu Chương 2,  Chương 1 and
Chương 2 sẽ cùng phần và cùng định dạng trước đó đã dùng chỉ cho Chương
2. 
 
Ngắt phần điều khiển định dạng của phần cuối cùng của tài liệu nó không được 
hiện ra như phần của tài liệu. Để thay đổi địng dạng tài liệu, nháy vào trong 
đoạn cuối cùng của tài liệu. 

Ví  dụ sau chỉ ra các  loại ngắt phần bạn có thể chèn. (Trong mỗi minh họa,
đường đôi chấm chấm biểu diễn ngắt phần.)
 
Lệnh Next Page chèn một ngắt phần và bắt đầu phần mới trên trang tiếp theo. 
Loại ngắt phần này đặc biệt hữu dụng để bắt đầu một chương mới trong một tài 
liệu. 

Lệnh Continuous chèn một ngắt phần và bắt đầu phần mới trên cùng trang.
Loại ngắt phần này hữu dụng để tạo thay đổi định dạng, chẳng hạn số cột khác 
trên một trang. 

Lệnh Even Page hay Odd Page chèn một ngắt phần và bắt đầu phần mới trên
trang chẵn hay lẻ tiếp theo. Nếu bạn muốn các chương của tài liệu luôn bắt đầu 
trên một trang lẻ hay trên một trang chẵn, hãy dùng ngắt phần Odd page hay 
Even page. 
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Thay đổi bố trí hay định dạng tài liệu
 
1.  Nháy vào chỗ bạn muốn tạo thay đổi định dạng. Có thể bạn muốn chọn một 

phần của tài liệu mà bạn muốn chèn một cặp ngắt phần. 
2.  Trên tab Page Layout, trong nhóm Page Setup, nháy Breaks. 

3.  Trong nhóm Section Breaks, nháy loại ngắt phần phù hợp với loại định
dạng thay đổi mà bạn muốn tạo.

 
Ví dụ, nếu bạn chia một tài liệu thành nhiều chương, bạn muốn mỗi chương bắt 
đầu trên trang lẻ. Nháy Odd Page trong nhóm Section Breaks.

Loại bỏ thay đổi của bố trí trang
 
Một ngắt phần chỉ rõ nơi thay đổi định dạng xảy ra trong tài liệu. Khi bạn xóa 
một ngắt phần bạn cũng xóa định dạng phần đối với văn bản trước dấu ngắt. 
Văn bản đó sẽ trở thành một phần của phần tiếp sau và mang định dạng của 
phần đó. 
 
1.  Hãy chắc chắn rằng bạn đang trong chế độ xem Draft do đó bạn có thể thấy 

đường ngắt phần chấm chấm. 
2.  Chọn ngắt phần bạn muốn xóa. 
3.  Nhấn DELETE.

Chú thích cuối trang và cuối văn bản
 
Chú thích cuối trang và cuối văn bản là những chú giải và/hoặc thông tin tham 
khảo cho những phần được trình bày trong văn bản. Trong một văn bản ta có 
thể gặp cả các chú thích cuối trang cũng như chú thích cuối văn bản. Khi bạn 
chèn những  chú thích loại này vào văn bản, Word  sẽ tự  động xử lý chúng, 
chẳng hạn như nếu bạn xóa một chú thích nào đó, chương trình sẽ tự  động 
đánh số lại những chú thích còn lại một cách tương thích. 
 
Mỗi chú thích gồm hai phần: phần dấu tham khảo   (chẳng hạn như 1 hay È) có 
mặt trong văn bản và bản thân phần chú giải. (Chú thích ở trang này là một ví 
dụ). Khi ta chèn chú thích, Word sẽ áp dụng một cách ngầm định các chữ số Ai 
cập (1,2,3) cho phần dấu tham khảo của chú thích cuối trang và các số La mã 
thường (i, ii, iii) cho các chú thích cuối văn bản. Một đoạn thẳng sẽ tách phần 
chú thích với phần văn bản. Bạn hoàn toàn có khả năng sử dụng các ký hiệu và
định dạng tùy chọn cho các chú thích, ví dụ như sử dụng dấu
khảo. 
 
Chèn chú thích 

 làm dấu tham
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1.  Đặt đấu chèn vào vị trí cần chèn dấu tham khảo.
2.  Chọn References → Insert Footnote (chèn chú thích) hay Endnote (chú 

thích cuối văn bản). 
3.  Gõ phần văn bản chú giải. 
4.  Nháy chuột ở một vị trí bất kỳ trong văn bản chính và bạn có thể tiếp tục

việc soạn thảo. Nếu muốn sửa đổi phần chú giải, bạn có thể đưa dấu chèn
vào phần chú giải và thực hiện việc sửa đổi, kể cả sửa đổi định dạng. 

 
Xem và xóa chú thích 
 

Khi bạn đặt con trỏ của chuột vào dấu tham khảo, bạn sẽ thấy nội dung của
phần chú giải được hiển thị. Tuy nhiên đối với tiếng Việt thì thay vì các chữ có
dấu bạn sẽ  đọc được các ký tự tương ứng trong phông Times New Roman.
Nháy đúp chuột ở dấu tham khảo, dấu chèn được chuyển về phần văn bản chú
giải. 
 

Muốn xóa một chú thích nào đó, chúng ta chọn dấu tham khảo tương ứng và
nhấn phím DELETE. Word sẽ xóa cả dấu tham khảo trong văn bản và phần chú
giải, đồng thời sắp xếp lại các chú thích còn lại. 

Chèn hay xóa chú thích cuối trang hay chú thích cuối văn bản 
 

Chú thích cuối trang và chú thích cuối văn bản được sử dụng trong các tài liệu
đã in để giải thích, bình luận hay đưa ra sự liên hệ đối với văn bản trong tài liệu.
Bạn có thể sử dụng chú thích cuối trang cho các bình luận chi tiết và chú thích
cuối văn bản cho đoạn trích dẫn của nguồn tài liệu. 
 

 LƯU Ý  Nếu bạn tạo một thư mục, bạn có thể tìm các lệnh để tạo và quản lý
nguồn tài liệu và  đoạn trích trong tab  References trong nhóm  Citations &
Bibliography. 
 
Về chú thích cuối trang và chú thích cuối văn bản 
 

Một chú thích cuối trang hay chú thích cuối văn bản bao gồm hai phần liên kết 
với nhau — dấu tham chiếu chú thích và văn bản chú thích tương ứng. 

Dấu tham chiếu chú thích cuối trang và chú 
thích cuối văn bản 

 
Đường ngăn cách 

 
  Văn bản chú thích cuối trang 
 
  Văn bản chú thích cuối văn bản 

88 Tài liệu hướng dẫn



 Microsoft Office Word 2007 – Phần cơ sở

Chèn chú thích cuối trang hay chú thích cuối văn bản
 
Microsoft Office Word tự  động đánh số chú thích cuối trang và chú thích cuối 
văn bản cho bạn, sau khi bạn chỉ rõ sơ  đồ  đánh số. Bạn có thể dùng sơ  đồ 
đánh số đơn từ đầu đến cuối một tài liệu, hoặc bạn có thể dùng các sơ đồ đánh 
số khác nhau trong mỗi phần trong một tài liệu. 
 
Khi bạn thêm, xóa, hay di chuyển chú thích được tự động đánh số, Word đánh 
số lại các dấu tham chiếu chú thích cuối trang và chú thích cuối văn bản. 
 
 LƯU Ý  Nếu chú thích cuối trang trong tài liệu của bạn được đánh số không 
đúng, tài liệu của bạn có chứa các thay đổi được theo dõi. Hãy chấp nhận các 
thay đổi trong đó Word đánh số đúng chú thích cuối trang và chú thích cuối văn 
bản. 

1.  Trong chế độ Print Layout - bố trí in, nháy vào chỗ bạn muốn chèn dấu
tham chiếu chú thích. 

2.  Trên tab  References, trong nhóm  Footnotes, nháy  Insert 
Insert Endnote. 

Footnote hay

Phím tắt Để  chèn một chú thích cuối trang tiếp theo, ấn CTRL+ALT+F.  Để
chèn một chú thích cuối văn bản tiếp theo, ấn CTRL+ALT+D.
 
Mặc định, Word đặt các chú thích cuối trang ở cuối mỗi trang và chú thích cuối 
văn bản ở cuối của tài  liệu. 
 
Để thực hiện thay đổi định dạng của chú thích cuối trang hay chú thích cuối văn 
bản, nháy Bật Hội thoại Footnotes, rồi thực hiện một trong các việc sau: 
 
1.  Trong hộp Number format, nháy định dạng bạn muốn dùng. 
2.  Để dùng ký hiệu tùy chỉnh thay cho các định dạng số truyền thống,  nháy 

Symbol ở cạnh Custom mark, rồi chọn một dấu ký hiệu sẵn dùng. 
3.  Nháy Insert. 
 
 LƯU Ý  Việc làm này không thay đổi các ký hiệu đã có. Mà chỉ thêm các ký 
hiệu mới. 
 
Word chèn số ghi chú và đặt điểm chèn cạnh số ghi chú.
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Gõ văn bản ghi chú. 
 
Nháy đúp vào số chú thích cuối trang hay chú thích cuối văn bản để trở lại dấu 
tham chiếu trong tài liệu. 
 
Thay đổi định dạng số của chú thích cuối trang hay chú thích cuối văn bản 
 
1.  Đặt điểm chèn trong phần bạn muốn thay đổi định dạng chú thích cuối trang

hay chú thích cuối  văn bản. Nếu tài liệu không chia thành 
điểm chèn bất kỳ đâu trong tài liệu.

các phần,  đặt

2.  Trên tab References, nháy Bật hộp thoại Footnote & Endnote. 
3.  Nháy Footnotes hay Endnotes. 
4.  Trong hộp Number format, nháy lựa chọn bạn muốn. 
5.  Nháy Apply. 

Tạo một thông báo chú thích cuối trang hay chú thích cuối văn bản phần
tiếp thêm 
 
Nếu một chú thích cuối trang hay chú thích cuối văn bản quá dài để vừa trong 
một trang, bạn có thể tạo một thông báo phần tiếp thêm để báo cho người đọc 
biết rằng chú thích cuối trang hay chú thích cuối văn bản còn tiếp tục ở trang 
tiếp theo. 
 
Hãy chắc chắn rằng bạn đang trong chế  độ xem Draft bằng cách nháy Draft 
trên thanh trạng thái. 
 
1.  Trên tab References, trong nhóm Footnotes, nháy Show Notes. 

2.  Nếu tài liệu của bạn có chứa cả chú thích cuối trang và chú thích cuối văn
bản, một thông báo xuất hiện. Nháy View footnote area hay View endnote 
area, rồi nháy OK. 

3.  Trong danh sách ô ghi chú, nháy Footnote Continuation Notice hay Endnote 
Continuation Notice. 

4.  Trong ô ghi chú, gõ văn bản bạn muốn dùng cho thông báo phần tiếp thêm. 
Ví dụ, gõ Chú thích cuối văn bản còn tiếp trong trang tiếp theo. 

Xóa một chú thích cuối trang hay chú thích cuối văn bản
 
Khi bạn muốn xóa một chú thích, bạn làm việc với dấu tham chiếu chú thích 
trong cửa sổ tài liệu, không làm việc với văn bản trong chú thích. 
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 Dấu tham chiếu chú thích 

Nếu bạn xóa một dấu tham chiếu chú thích được đánh số tự  động, Word sẽ
đánh số lại các chú thích theo thứ tự mới.

Xóa một chú thích 
 
Trong tài liệu, chọn dấu tham chiếu chú thích của chú thích cuối trang hay chú 
thích cuối văn bản mà bạn cần xóa rồi ấn DELETE.

Tạo bản mục lục 
 
Dùng đặc tính Bảng mục lục tự động trong Microsoft Word có thể xây dựng và 
đưa ra nhanh một Bảng mục lục. Tuy nhiên đặc tính này chỉ có hiệu lực khi bạn
định dạng tài liệu của  mình theo các kiểu (Styles). Bảng mục lục  được xây
dựng tự động theo các tên tiêu đề tùy bạn chọn và với số mức tiêu đề tuỳ ý. 
 
Để tạo ra một chỗ trong báo cáo của bạn cho Bảng Mục lục, cuốn lên đầu trang 
1, đặt dấu chèn ở cuối đầu đề, và nhấn ENTER hai lần. Gõ Mục lục, và nhấn 
ENTER. Chọn phông và định dạng cho chữ Bảng mục lục tuỳ ý bạn. 
 
Bạn tạo bảng mục lục bằng cách chọn các kiểu đề mục — ví dụ, Heading 1,
Heading 2, và Heading 3 —  mà bạn muốn có trong bảng mục lục. Microsoft
Office Word tìm các đề mục khớp với kiểu bạn đã chọn, định dạng và làm bản
sao mục văn bản theo kiểu đề mục, rồi chèn bảng mục lục vào tài liệu. 
 
Microsoft Office Word 2007 cung cấp một bộ sưu tập nhiều kiểu bảng mục lục 
để  chọn từ  đó. Đánh dấu các mục bảng mục lục, rồi nháy kiểu bảng mục lục 
bạn cần từ các lựa chọn của bộ sưu tập. Office Word 2007 tự động tạo bảng 
mục lục từ các đề mục mà bn đánh dấu. 
 
Đánh dấu các mục cho bảng mục lục 
 
Cách dễ nhất để tạo bảng mục lục là dùng các kiểu đề mục đã xây dựng. Bạn 
cũng có thể tạo bảng mục lục dựa trên các kiểu tùy chỉnh mà bạn đã áp dụng. 
Hoặc bạn có thể chỉ  định các mức bảng mục lục cho các mục văn bản riêng 
biệt. 
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Đánh dấu các mục bằng cách dùng các kiểu đề mục đã dựng sẵn: 
 
1.  Chọn đề mục bạn muốn áp dụng kiểu đề mục. 
2.  Trên tab Home, trong nhóm Styles, nháy kiểu bạn muốn.

Ví dụ, nếu bạn đã chọn văn bản mà bạn muốn kiểu của nó như đề mục chính,
nháy kiểu có tên Heading 1 trong bộ sưu tập kiểu nhanh Quick Style. 
 
 LƯU Ý 
 
� Nếu bạn không thấy kiểu bạn cần, nháy vào mũi tên để mở rộng click the 

arrow to expand the Quick Style gallery. 
� Nếu kiểu bạn cần không xuất hiện trong bộ sưu tập kiểu nhanh Quick Style, 

ấn CTRL+SHIFT+S  để mở ngăn tác vụ  Apply Styles. Dưới  Style Name, 
nháy kiểu bạn cần. 

Đánh dấu các mục văn bản đặc biệt
 
Nếu bạn muốn mục lục chứa cả văn bản không định dạng như đề mục, bạn có 
thể dùng qui trình sau để đánh dấu mục văn bản đặc biệt. 
 

1.  Chọn văn bản bạn muốn có trong bảng mục lục. 
2.  Trên tab References, trong nhóm Table of Contents, nháy Add Text. 

3.  Nháy mức bạn muốn gán cho lựa chọn của bạn, chẳng hạn như Level 1

cho mức chính hiển thị trong bảng mục lục.

4.  Lặp lại các bước 1 đến 3 đến khi bạn gán hết tất cả các văn bản bạn
muốn xuất hiện trong bảng mục lục. 

 
Tạo bảng mục lục 
 
Sau khi bạn đánh dấu các mục cho bảng mục lục, bạn đã sẵn sàng tạo bảng 
mục lục. 
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Tạo bảng mục lục từ các kiểu đề mục đã xây dựng:
 
Dùng thủ tục này nếu bạn đã tạo một tài liệu bằng cách dùng kiểu đề mục. 
 
1.  Nháy vào nơi bạn muốn chèn bảng mục lục, thường là ở đầu một tài liệu. 
2.  Trên  tab  References,  trong nhóm Table of Contents, nháy  Table of

Contents, rồi nháy kiểu bảng mục lục bạn cần.

 LƯU Ý   Để thêm các lựa chọn,
thoại Table of Contents. 

nháy Insert Table of Contents  để mở hộp

Tạo bảng mục lục từ các kiểu tùy chỉnh bạn đã áp dụng
 
Dùng thủ tục này nếu bạn đã áp dụng các kiểu tùy chỉnh cho các đề mục của 
bạn. Bạn có thể chọn các thiết đặt kiểu mà bạn cần dùng khi tạo bảng mục lục. 
 
1.  Nháy vào nơi bạn muốn chèn bảng mục lục, thường là ở đầu một tài liệu. 
2.  Trên  tab  References,  trong nhóm Table of Contents, nháy  Table of

Contents, rồi nháy Insert Table of Contents.
3.  Nháy Options. 
4.  Dưới Available styles, tìm kiểu bạn đã áp dụng cho các đề mục trong tài 

liệu của bạn. 
5.  Dưới TOC level, cạnh tên kiểu, gõ số từ 1 đến 9 để chỉ ra mức bạn muốn 

kiểu đề mục hiển thị. 

 LƯU Ý  Nếu bạn chỉ dùng các kiểu tùy chỉnh, xóa số TOC của các kiểu  đã
dựng sẵn như Heading 1. 
 
6.  Lặp lại bước 4 và bước 5 cho mỗi kiểu đề mục bạn muốn có trong bảng 

mục lục. 
7.  Nháy OK. 
 
Chọn bảng mục lục khớp với loại tài liệu: 
 
Printed document  Nếu bạn tạo tài liệu mà người đọc sẽ đọc ở trang đã in thì 
tạo bảng mục lục trong đó mỗi mục liệt kê cả đề mục và số trang khi đề mục 
xuất hiện. Người đọc có thể lật đến trang họ cần. 
 
Online document  Đối với tài liệu người đọc sẽ đọc trực tuyến trên Word, bạn 
có thể định dạng các mục trong bảng mục lục với siêu liên kết, do đó người đọc 
có thể chuyển tới một đề mục bằng cách nháy vào mục đó trong bảng mục lục. 
 
Để dùng một trong các thiết kế sẵn có: 
 
1.  Nháy vào một thiết kế trong hộp Formats. 
2.  Chọn bất kỳ lựa chọn nào khác bạn muốn.
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Cập nhật bảng mục lục 
 
Nếu bạn thêm vào hay loại bớt đi các đề mục hoặc các mục của bảng mục lục 
trong tài liệu của bạn, bạn có thể cập nhật mục lục nhanh chóng. 
 

1.  Trên  tab  References, trong nhóm  Table of  Contents, nháy  Update
Table. 

2.  Nháy Update page numbers only hay Update entire table. 

Xóa bảng mục lục 
 

1.  Trên  tab  References, trong nhóm  Table of  Contents,
Contents.

nháy  Table of

2.  Nháy Remove Table of Contents.

94 Tài liệu hướng dẫn



 Microsoft Office Word 2007 – Phần cơ sở

BÀI 8- IN ẤN

Xem trước khi in 
 
Cho đến bài này, chúng ta đã trình bày những phần cơ bản của việc sử dụng 
Microsoft Word 2007 để soạn thảo một văn bản đầy đủ. Tất nhiên chúng ta mới 
chỉ đề cập được những nét chính, để làm chủ được Word bạn cần có thêm thời 
gian và kinh nghiệm thực tế. Bước tiếp theo sau khi soạn thảo xong một văn 
bản là in ra giấy. Nhưng trước khi bạn in, hãy xem tài liệu được in ra của bạn 
có đáp ứng được yêu cầu của bạn hay không.

Trước khi in, kiểm tra bố trí trang và thiết đặt trang ở đây. Mọi thứ bạn cần ở
trong tab Page Layout. Nhóm Page Setup bao gồm Size (8.5 x 11, A4, v.v...), 
Orientation (ngang và dọc), và Margins. 
 
Xem trước một trang trước khi in

1.  Nháy nút Microsoft Office, trỏ vào mũi tên cạnh Print, rồi nháy Print
Preview.Con trỏ trở thành một kính lúp.

2.  Trên ruy-băng PrintPreview, nháy để mở hộp thoại Zoom (Chỉnh cỡ).

Nháy để phóng to văn bản lên thành 100%. Nháy để  xem

trước  một  trang. Nháy để xem trước hai  trang. Nháy

để phóng to hiển thị toàn bộ trang.

Bạn có thể chèn thêm  đoạn văn trong chế độ Xem trước khi in.  Nháy
để không chọn chế độ kính lúp. Kính lúp thay 

chèn văn bản. Lúc này bạn có thể chèn thêm vào văn bản.
đổi thành dấu
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3.  Nháy  trong nhóm Preview trên ruy-băng PrintPreview  (Xem
trước khi in) để hiển thị thước. Để sửa đổi lề phải, trỏ chuột vào ranh giới lề
phải trên thước ngang. Nó xuất hiện như một đường bóng giữa miền sáng 
và tối của thước. 

Khi con trỏ trở thành mũi tên hai chiều, bạn có thể sửa đổi lề. 

4.  Nháy để trở lại chế độ xem trước đó.

Bạn có thể vào chế độ xem trước khi in và thiết đặt trang bằng cách khác. 
 
Bạn có thể đặt lại lề của tài liệu một cách chính xác hơn bằng cách chọn Page
Setup...  (Thiết  đặt  Trang).  Trong hộp hội thoại Page Setup,  chọn nhãn
Margins (Lề) nhập 2 cm vào tất cả các hộp Top (Trên), Bottom (Dưới), Left
(Trái), Right (Phải) để  cho phần văn bản của bạn cách đều mép trang giấy 2
cm. Dưới  Orientation  (Hướng) nháy Portrait để in văn bản  theo chiều dọc
trang giấy hoặc nháy chọn Landscape để in văn bản theo chiều ngang trang
giấy. 
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Cũng trong hộp thoại Page Setup, nháy tab Paper (Kích thước trang giấy) để
chọn kích thước trang giấy bạn muốn in ra. Nháy mũi tên quay xuống trong hộp
danh sách Paper size để chọn kích thước trang A4 thông thường. Nháy OK để
chấp nhận các thay đổi hoặc nháy Close để trở lại chế độ xem trước đó. 
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In 
 
Bạn có thể in tài liệu của mình bằng các máy in khác nhau đã được cài đặt
trong thư mục máy in của bạn. Bạn có thể in hai bản sao (hay nhiều hơn) một
tài liệu. Bạn có thể in toàn bộ tài liệu hay chỉ một số trang trong tài liệu. Để thiết 
lập các lựa chọn tuỳ ý khi in: 

1.  Nháy nút 
hiện. 

Microsoft Office, nháy lệnh Print hộp thoại Print sẽ xuất

Nhưng nếu bạn trỏ vào mũi tên bên phải lệnh Print bạn sẽ thấy các lệnh: 
 

Print, để mở hộp thoại Print. 
 

Quick Print, gửi ngay tài liệu của bạn tới máy in. 
 
4 Print Preview, sẽ cho bạn xem trước tài liệu của bạn sẽ được in ra trông như 
thế nào. Nếu bạn cần dùng lệnh này nhiều thì thêm nó vào Thanh công cụ truy 
nhập nhanh. 

2.  Trong hộp hội thoại Print (In), nháy mũi tên quay xuống trong hộp danh
sách Name: (Tên) của hộp Printer (Máy in) để chọn máy in bạn muốn in tài
liệu 
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3.  Trong hộp thoại Print, nháy mũi tên trong hộp Number of copies: (Số bản
sao:) để chọn 2. 
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4.  Trong hộp Page range (Miền các trang), chọn All (Tất cả) để in toàn bộ tài
liệu, chọn Current page (Trang hiện tại) để in trang hiện đang chọn, hoặc
chọn Pages (Các trang) để tự gõ số các trang bạn muốn in vào, ví dụ nếu
muốn in các trang 1, 3, 5 đến 12 thì bạn gõ 1, 3, 5-12 

 

Nháy OK để in tài liệu theo đúng lựa chọn của bạn, hay Cancel để trở lại tài liệu 
của bạn mà không in. 
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PhÇn 1: Microsoft word 

 
 

T¸c gi¶: 

NguyÔn S¬n H¶i 
nshai@moet.edu.vn 

Trung t©m tin häc – Bé Gi¸o dôc vµ ®µo t¹o 



Bµi më ®Çu 
 

1. Giíi thiÖu phÇn mÒm Microsoft Winword 

So¹n th¶o v¨n b¶n lµ c«ng viÖc ®−îc sö dông rÊt nhiÒu trong c¸c c¬ quan, xÝ 
nghiÖp còng nh− nhu cÇu cña bÊt kú c¸ nh©n nµo hiÖn nay. 

Tõ thña xa x−a con ng−êi ®· biÕt sö dông m¸y mãc vµo viÖc so¹n th¶o v¨n b¶n 
(m¸y gâ ch÷). Gâ ®Õn ®©u, v¨n b¶n ®−îc in ra ngay ®Õn ®ã trªn giÊy. C¸c c«ng viÖc 
dÞch chuyÓn trªn v¨n b¶n, còng nh− c¸c kü n¨ng so¹n th¶o v¨n b¶n cßn rÊt th« s¬, ®¬n 
gi¶n. §Ó t¹o ra ®−îc mét v¨n b¶n, ®ßi hái ng−êi so¹n th¶o ph¶i cã nh÷ng kü n¨ng sö 
dông m¸y gâ rÊt tèt (kh«ng nh− m¸y tÝnh b©y giê, hÇu nh− ai còng cã thÓ häc vµ so¹n 
th¶o ®−îc mét c¸ch râ rµng). So¹n th¶o lµ nh− vËy, cßn vÒ in Ên còng cã v« cïng khã 
kh¨n. §ã lµ ngµy x−a, khi mµ c«ng nghÖ th«ng tin cßn ch−a ph¸t triÓn. 

Ngµy nay, khi mµ c«ng nghÖ th«ng tin ®ang ph¸t triÓn rÇm ré, c«ng nghÖ thay ®æi 
tõng ngµy, nh÷ng bµi to¸n, nh÷ng khã kh¨n cña con ng−êi ®ang dÇn dÇn ®−îc m¸y 
tÝnh ho¸, th× viÖc so¹n th¶o nh÷ng v¨n b¶n b»ng m¸y tÝnh ®· trë thµnh nh÷ng c«ng 
viÖc rÊt b×nh th−êng cho bÊt kú ai biÕt sö dông m¸y tÝnh. Mét trong nh÷ng phÇn mÒm 
m¸y tÝnh ®−îc sö dông réng r·i nhÊt hiÖn nay lµ Microsoft Word cña h·ng Microsoft 
hay cßn gäi phÇn mÒm Winword. 

Ra ®êi tõ cuèi nh÷ng n¨m 1980, ®Õn nay phÇn mÒm Winword ®· ®¹t ®−îc tíi sù 
hoµn h¶o trong lÜnh vùc so¹n th¶o v¨n b¶n còng nh− trong lÜnh vùc v¨n phßng cña bé 
phÇn mÒm Microsoft Office nãi chung. Cã thÓ liÖt kª c¸c ®Æc ®iÓm næi bËt cña phÇn 
mÒm nµy nh− sau: 

- Cung cÊp ®Çy ®ñ nhÊt c¸c kü n¨ng so¹n th¶o vµ ®Þnh d¹ng v¨n b¶n ®a d¹ng, dÔ 
sö dông; 

- Kh¶ n¨ng ®å ho¹ ®· m¹nh dÇn lªn, kÕt hîp víi c«ng nghÖ OLE (Objects 
Linking and Embeding) b¹n cã thÓ chÌn ®−îc nhiÒu h¬n nh÷ng g× ngoµi h×nh 
¶nh vµ ©m thanh lªn tµi liÖu word nh−: biÓu ®å, b¶ng tÝnh,.v.v. 

- Cã thÓ kÕt xuÊt, nhËp d÷ liÖu d−íi nhiÒu lo¹i ®Þnh d¹ng kh¸c nhau. §Æc biÖt 
kh¶ n¨ng chuyÓn ®æi d÷ liÖu gi÷a Word víi c¸c phÇn mÒm kh¸c trong bé 
Microsoft Office ®· lµm cho viÖc xö lý c¸c øng dông v¨n phßng trë nªn ®¬n 
gi¶n vµ hiÖu qu¶ h¬n. 

- DÔ dµng kÕt chuyÓn tµi liÖu thµnh d¹ng HTML ®Ó chia sÎ d÷ liÖu trªn m¹ng 
néi bé, còng nh− m¹ng Internet. 

2. C¸ch khëi ®éng 

Cã rÊt nhiÒu c¸ch cã thÓ khëi ®éng ®−îc phÇn mÒm Word. Tuú vµo môc ®Ých lµm 
viÖc, së thÝch hoÆc sù tiÖn dông mµ ta cã thÓ chän mét trong c¸c c¸ch sau ®©y ®Ó khëi 
®éng: 

C¸ch 1: Chän lÖnh Start cña Windows: Start | Programs | Microsoft Word 

C¸ch 2: Nh¸y kÐp chuét lªn biÓu t−îng cña phÇn mÒm Word  nÕu 
nh− nh×n thÊy nã bÊt kú ë chç nµo: trªn thanh t¸c vô (task bar), trªn mµn h×nh nÒn cña 
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Windows, vv.. 

C¸ch 3: NÕu muèn më nhanh mét tÖp v¨n b¶n võa so¹n th¶o gÇn ®©y nhÊt trªn 
m¸y tÝnh ®ang lµm viÖc, cã thÓ chän Start | Documents, chän tªn tÖp v¨n b¶n (Word) 
cÇn më. Khi ®ã Word sÏ khëi ®éng vµ më ngay tÖp v¨n b¶n võa chØ ®Þnh. 

3. M«i tr−êng lµm viÖc 

Sau khi khëi ®éng xong, mµn h×nh lµm viÖc cña Word th−êng cã d¹ng nh− sau: 

 

Cöa sæ so¹n th¶o tµi liÖu

HÖ thèng b¶ng 
chän 

HÖ thèng thanh 
c«ng cô 

Th−íc kÎ

Thanh tr¹ng 
th¸i

Th−êng th× m«i tr−êng lµm viÖc trªn Word gåm 4 thµnh phÇn chÝnh: 

- Cöa sæ so¹n th¶o tµi liÖu: Lµ n¬i ®Ó chÕ b¶n tµi liÖu. B¹n cã thÓ gâ v¨n b¶n, 
®Þnh d¹ng, chÌn c¸c h×nh ¶nh lªn ®©y. Néi dung trªn cöa sæ nµy sÏ ®−îc in ra 
m¸y in khi sö dông lÖnh in. 

- HÖ thèng b¶ng chän (menu): chøa c¸c lÖnh ®Ó gäi tíi c¸c chøc n¨ng cña 
Word trong khi lµm viÖc. B¹n ph¶i dïng chuét ®Ó më c¸c môc chän nµy, ®«i 
khi còng cã thÓ sö dông tæ hîp phÝm t¾t ®Ó gäi nhanh tíi c¸c môc chän. 

- HÖ thèng thanh c«ng cô: bao gåm rÊt nhiÒu thanh c«ng cô, mçi thanh c«ng 
cô bao gåm c¸c nót lÖnh ®Ó phôc vô mét nhãm c«ng viÖc nµo ®ã. VÝ dô: khi 
so¹n th¶o v¨n b¶n, b¹n ph¶i sö dông ®Õn thanh c«ng cô chuÈn Standard vµ 
thanh c«ng cô ®Þnh d¹ng Formating; hoÆc khi vÏ h×nh cÇn ®Õn thanh c«ng cô 
Drawing ®Ó lµm viÖc. 

- Th−íc kÎ: gåm 2 th−íc (ruler) bao viÒn trang v¨n b¶n. Sö dông th−íc nµy b¹n 
cã thÓ ®iÒu chØnh ®−îc lÒ trang v¨n b¶n, còng nh− thiÕt lËp c¸c ®iÓm dÞch (tab) 
mét c¸ch ®¬n gi¶n vµ trùc quan.    

- Thanh tr¹ng th¸i: gióp b¹n biÕt ®−îc mét vµi tr¹ng th¸i cÇn thiÕt khi lµm 
viÖc. VÝ dô: b¹n ®ang lµm viÖc ë trang mÊy, dßng bao nhiªu, .v.v. 

4. T¹o mét tµi liÖu míi 

Lµm viÖc víi word lµ lµm viÖc trªn c¸c tµi liÖu (Documents). Mçi tµi liÖu ph¶i 
®−îc cÊt lªn ®Üa víi mét tÖp tin cã phÇn më réng .DOC. Th−êng th× c¸c tÖp tµi liÖu 
cña b¹n sÏ ®−îc cÊt vµo th− môc C:\My Documents trªn ®Üa cøng. Tuy nhiªn, b¹n cã 
thÓ thay ®æi l¹i th«ng sè nµy khi lµm viÖc víi Word. 

Th«ng th−êng sau khi khëi ®éng Word, mét mµn h×nh tr¾ng xuÊt hiÖn. §ã còng lµ 
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tµi liÖu míi mµ Word tù ®éng t¹o ra. Tuy nhiªn ®Ó t¹o mét tµi liÖu míi, b¹n cã thÓ sö 
dông mét trong c¸c c¸ch sau: 

- Më môc chän File | New..; 

hoÆc 

- NhÊn nót New  trªn thanh c«ng cô Standard; 

hoÆc 

- NhÊn tæ hîp phÝm t¾t Ctrl + N. 

5. Ghi tµi liÖu lªn ®Üa 

 §Ó ghi tµi liÖu ®ang lµm viÖc lªn ®Üa, b¹n cã thÓ chän mét trong c¸c c¸ch sau: 

- Më môc chän File | Save..; 

hoÆc 

- NhÊn nót Save  trªn thanh c«ng cô Standard; 

hoÆc 

- NhÊn tæ hîp phÝm t¾t Ctrl + S. 

SÏ cã hai kh¶ n¨ng x¶y ra: 

NÕu ®©y lµ tµi liÖu míi, hép tho¹i Save As xuÊt hiÖn, cho phÐp ghi tµi liÖu nµy bëi 
mét tÖp tin míi: 

 

Gâ tªn tÖp 
tin vµo ®©y! 

H·y x¸c ®Þnh th− môc (Folder)- n¬i sÏ chøa tÖp tin míi nµy råi gâ tªn tÖp tin vµo 
môc File name: (vÝ dô Vanban1 råi nhÊn nót Save ®Ó kÕt thóc viÖc ghi néi dung tµi 
liÖu. 

NÕu tµi liÖu cña b¹n ®· ®−îc ghi vµo mét tÖp, khi ra lÖnh cÊt tÊt c¶ nh÷ng sù thay 
®æi trªn tµi liÖu sÏ ®−îc ghi l¹i lªn ®Üa. 

 

Tác
 

 B¹n nªn thùc hiÖn thao t¸c ghi tµi liÖu võa råi th−êng xuyªn trong khi so¹n tµi liÖu, ®Ó tr¸nh mÊt d÷ liÖu 
khi gÆp c¸c sù cè mÊt ®iÖn, hay nh÷ng trôc trÆc cña m¸y tÝnh. 
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6. Më tµi liÖu ®∙ tån t¹i trªn ®Üa 

Tµi liÖu sau khi ®· so¹n th¶o trªn Word ®−îc l−u trªn ®Üa d−íi d¹ng tÖp tin cã 
phÇn më réng lµ .DOC. §Ó më mét tµi liÖu Word ®· cã trªn ®Üa, b¹n cã thÓ chän mét 
trong c¸c c¸ch sau ®©u: 

- Më môc chän File | Open; 

hoÆc 

- NhÊn tæ hîp phÝm t¾t Ctrl+O. 

Hép tho¹i Open xuÊt hiÖn: 

 
H·y t×m ®Õn th− môc n¬i chøa tÖp tµi liÖu cÇn më trªn ®Üa, chän tÖp tµi liÖu, cuèi 

cïng nhÊn nót lÖnh  ®Ó tiÕp tôc. TÖp tµi liÖu sÏ ®−îc më ra trªn mµn h×nh 
Word. 

MÆt kh¸c, b¹n còng cã thÓ thùc hiÖn më rÊt nhanh nh÷ng tÖp tµi liÖu ®· lµm viÖc 
gÇn ®©y nhÊt b»ng c¸ch më môc chän File nh− sau: 

 

NhÊn chuét lªn tÖp 
tµi liÖu cÇn më ! 

 TiÕp theo nhÊn chuét lªn tªn tÖp tµi liÖu cÇn më. 

7. Tho¸t khái m«i tr−êng lµm viÖc 

Khi kh«ng lµm viÖc víi Word, b¹n cã thÓ thùc hiÖn theo mét trong c¸c c¸ch sau: 

- Më môc chän File | Exit   

hoÆc 

- NhÊn tæ hîp phÝm t¾t Alt + F4. 
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Ch−¬ng 1:  

so¹n th¶o c¬ b¶n 
 

1.1 Mét sè thao t¸c so¹n th¶o c¬ b¶n 

1.1.1 NhËp v¨n b¶n 

NhËp v¨n b¶n lµ kh©u ®Çu tiªn trong qui tr×nh so¹n th¶o tµi liÖu. Th«ng th−êng 
l−îng v¨n b¶n (Text) trªn mét tµi liÖu lµ rÊt nhiÒu, b¹n tiÕp cËn ®−îc cµng nhiÒu 
nh÷ng tÝnh n¨ng nhËp v¨n b¶n th× cµng tèt, bëi lÏ nã sÏ lµm t¨ng tèc ®é chÕ b¶n tµi 
liÖu. 

a. Sö dông bé gâ tiÕng ViÖt 

Ban ®Çu, m¸y tÝnh ch−a cã b¶ng m· tiÕng ViÖt mµ chØ cã duy nhÊt b¶ng m· 
chuÈn ASCCI. B¶ng m· nµy bao gåm 128 kü tù La tinh (c¸c phÝm ch÷, c¸c phÝm sè 
vµ mét sè c¸c ký hiÖu ®Æc biÖt).  

§Ó cã thÓ ®−a ®−îc tiÕng ViÖt sö dông trªn m¸y tÝnh, c¸c nhµ lËp tr×nh ph¶i x©y 
dùng phÇn mÒm gâ tiÕng ViÖt vµ c¸c bé ph«ng ch÷ tiÕng ViÖt ®i kÌm. 

HiÖn nay cã kh¸ nhiÒu c¸c bé gâ tiÕng ViÖt ®ang ®−îc sö dông nh−: VNI- ®−îc 
sö dông réng r·i ë phÝa Nam, VietWare- ®−îc sö dông nhiÒu ë miÒn Trung vµ 
ABC, Vietkey th× ®−îc sö dông réng r·i ngoµi B¾c. 

Do mçi n¬i sö dông nh÷ng bé gâ riªng (b¶ng m· tiÕng ViÖt còng kh¸c nhau) nªn 
viÖc trao ®æi th«ng tin gÆp rÊt nhiÒu khã kh¨n. Míi ®©y ChÝnh phñ ®· khuyÕn c¸o 
sö dông bé gâ vµ bé ph«ng ch÷ Unicode. Víi hÖ thèng míi nµy viÖc trao ®æi th«ng 
tin ®· trë nªn ®¬n gi¶n h¬n rÊt nhiÒu. Tuy nhiªn nã vÉn gÆp ph¶i mét sè khã kh¨n 
v× tÝnh t−¬ng thÝch víi c¸c hÖ thèng phÇn mÒm cò trªn m¸y tÝnh kh«ng cao. TÊt 
nhiªn, Unicode sÏ lµ gi¶i ph¸p tiÕng ViÖt trong t−¬ng lai. 

PhÇn mÒm tiÕng ViÖt chóng t«i giíi thiÖu trong cuèn gi¸o tr×nh nµy lµ ABC hoÆc 
Vietkey víi kiÓu gâ Telex. M¸y tÝnh cña b¹n ph¶i ®−îc gµi ®Æt phÇn mÒm nµy ®Ó 
cã ®−îc bé gâ vµ bé ph«ng ch÷ ®i kÌm. 

Khi nµo trªn mµn h×nh cña b¹n xuÊt hiÖn biÓu t−îng:  hoÆc  lµ khi b¹n 
cã thÓ gâ ®−îc tiÕng ViÖt. NÕu biÓu t−îng xuÊt hiÖn ch÷ E  (kiÓu gâ tiÕng Anh), 
b¹n ph¶i nhÊn chuét lªn biÓu t−îng lÇn n÷a hoÆc nhÊn tæ hîp phÝm nãng Alt + Z  
®Ó chuyÓn vÒ chÕ ®é gâ tiÕng ViÖt. Qui t¾c gâ tiÕng ViÖt nh− sau: 

Gâ §−îc ch÷  Gâ §−îc dÊu 

aa ©  f huyÒn 

aw ¨  s s¾c 

oo «  r hái 

ow ¬  x ng· 

w −  j nÆng 
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VÝ dô: 

 Muèn gâ tõ: “ Céng hoµ x∙ héi chñ nghÜa ViÖt Nam” 

B¹n ph¶i bËt tiÕng ViÖt vµ gâ lªn tµi liÖu nh− sau: 

      “Coongj hoaf xax hooij chur nghiax Vieetj Nam” 

* NÕu gâ z, tõ tiÕng ViÖt sÏ bÞ bá dÊu. 

b. Sö dông bµn phÝm  

BËt tiÕng ViÖt (nÕu b¹n muèn gâ tiÕng ViÖt) vµ sö dông nh÷ng thao t¸c so¹n th¶o 
th«ng th−êng ®Ó so¹n th¶o tµi liÖu nh− lµ: 

- C¸c phÝm ch÷ a, b, c, .. z; 

- C¸c phÝm sè tõ 0 ®Õn 9; 

- C¸c phÝm dÊu: ‘,><?[]{}… 

- Sö dông phÝm Shift ®Ó gâ ch÷ in hoa vµ mét sè dÊu; 

- Sö dông phÝm Caps Lock ®Ó thay ®æi kiÓu gâ ch÷ in hoa vµ ch÷ th−êng; 

- Sö dông phÝm ↵ Enter ®Ó ng¾t ®o¹n v¨n b¶n; 

- Sö dông phÝm Tab ®Ó dÞch ®iÓm Tab; 

- Sö dông phÝm Space Bar ®Ó chÌn dÊu c¸ch; 

- Sö dông c¸c phÝm mòi tªn: ←↑↓→ ®Ó dÞch chuyÓn con trá trªn tµi liÖu; 

- Sö dông phÝm Page Up vµ Page Down ®Ó dÞch chuyÓn con trá vÒ ®Çu hoÆc cuèi 
tõng trang mµn h×nh; 

- PhÝm Home, End ®Ó ®−a con trá vÒ ®Çu hoÆc cuèi dßng v¨n b¶n; 

- PhÝm Delete ®Ó xo¸ ký tù v¨n b¶n ®øng kÒ sau ®iÓm trá; 

- PhÝm Backspace ®Ó xo¸ ký tù ®øng kÒ tr−íc ®iÓm trá 

1.1.2 Thao t¸c trªn khèi v¨n b¶n 

Môc nµy cung cÊp nh÷ng kü n¨ng thao t¸c trªn mét khèi v¨n b¶n bao gåm : sao 
chÐp, c¾t d¸n, di chuyÓn khèi v¨n b¶n. Gióp lµm t¨ng tèc ®é so¹n th¶o v¨n b¶n. 

a. Sao chÐp  

Sao chÐp khèi v¨n b¶n lµ qu¸ tr×nh t¹o mét khèi v¨n b¶n míi tõ mét khèi v¨n 
b¶n ®· cã s½n. Ph−¬ng ph¸p nµy ®−îc ¸p dông khi b¹n cÇn ph¶i gâ l¹i mét ®o¹n v¨n 
b¶n gièng hÖt hoÆc gÇn gièng víi mét ®o¹n v¨n b¶n ®· cã s½n trªn tµi liÖu vÒ mÆt 
néi dung còng nh− ®Þnh d¹ng (chóng ta sÏ t×m hiÓu kh¸i niÖm ®Þnh d¹ng ë phÇn 
tiÕp theo). C¸ch lµm nh− sau: 

B−íc 1: Lùa chän (b«i ®en) khèi v¨n b¶n cÇn sao chÐp. §Ó lùa chän khèi v¨n 
b¶n b¹n lµm nh− sau: 

- Di chuét vµ khoanh vïng v¨n b¶n cÇn chän; 

hoÆc 

- Dïng c¸c phÝm mòi tªn ←↑↓→ kÕt hîp viÖc gi÷ phÝm Shift ®Ó chän vïng v¨n 
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b¶n. Chän ®Õn ®©u b¹n sÏ thÊy v¨n b¶n ®−îc b«i ®en ®Õn ®ã. 

B−íc 2: Ra lÖnh sao chÐp d÷ liÖu b»ng mét trong c¸c c¸ch: 

- Më môc chän Edit | Copy ; 

hoÆc 

- NhÊn nót Copy  trªn thanh c«ng cô Standard; 

hoÆc 

- NhÊn tæ hîp phÝm nãng Ctrl + C; 

B−íc 3: D¸n v¨n b¶n ®· chän lªn vÞ trÝ cÇn thiÕt. B¹n lµm nh− sau: 

§Æt con trá vµo vÞ trÝ cÇn d¸n v¨n b¶n, ra lÖnh d¸n b»ng mét trong c¸c c¸ch sau: 

- Më môc chän Edit | Paste ; 

hoÆc 

- NhÊn nót Paste  trªn thanh c«ng cô Standard; 

 hoÆc 

- NhÊn tæ hîp phÝm nãng Ctrl + V. 

B¹n sÏ thÊy mét ®o¹n v¨n b¶n míi ®−îc d¸n vµo vÞ trÝ cÇn thiÕt. B¹n cã thÓ thùc 
hiÖn nhiÒu lÖnh d¸n liªn tiÕp, d÷ liÖu ®−îc d¸n ra sÏ lµ d÷ liÖu cña lÇn ra lÖnh Copy 
gÇn nhÊt. 

b. Di chuyÓn khèi v¨n b¶n  

Víi ph−¬ng ph¸p sao chÐp v¨n b¶n, sau khi sao chÐp ®−îc ®o¹n v¨n b¶n míi th× 
®o¹n v¨n b¶n cò vÉn tån t¹i ®óng vÞ trÝ cña nã. NÕu muèn khi sao chÐp ®o¹n v¨n 
b¶n ra mét n¬i kh¸c vµ ®o¹n v¨n b¶n cò sÏ ®−îc xo¸ ®i (tøc lµ di chuyÓn khèi v¨n 
b¶n ®Õn mét vÞ trÝ kh¸c), ph−¬ng ph¸p nµy sÏ gióp lµm ®iÒu ®ã. Cã thÓ thùc hiÖn 
theo hai c¸ch nh− sau: 

 C¸ch 1:  

  B−íc 1: Lùa chän khèi v¨n b¶n cÇn di chuyÓn; 

B−íc 2: Ra lÖnh c¾t v¨n b¶n cã thÓ b»ng mét trong c¸c c¸ch sau: 

- Më môc chän Edit | Cut ; 

  hoÆc 

- NhÊn nót Cut  trªn thanh c«ng cô Standard; 

 hoÆc 

- NhÊn tæ hîp phÝm nãng Ctrl + X. 

V¨n b¶n ®· chän sÏ bÞ c¾t ®i, chóng sÏ ®−îc l−u trong bé nhí ®Öm (Clipboard) 
cña m¸y tÝnh. 

B−íc 3: Thùc hiÖn lÖnh d¸n v¨n b¶n (Paste) nh− ®· giíi thiÖu ë trªn vµo vÞ trÝ 
®Þnh tr−íc. 

 C¸ch 1:  
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  B−íc 1: Lùa chän khèi v¨n b¶n cÇn di chuyÓn; 

B−íc 2: Dïng chuét kÐo rª vïng v¨n b¶n ®ang chän vµ th¶ lªn vÞ trÝ cÇn di 
chuyÓn ®Õn. 

Ph−¬ng ph¸p nµy gäi lµ kÐo – th¶ (drag and drop). 

1.1.3 ThiÕt lËp Tab 

Tab lµ c«ng cô ®−îc sö dông rÊt nhiÒu trong viÖc nhËp v¨n b¶n. Ngoµi kh¶ n¨ng 
dÞch chuyÓn ®iÓm trá theo tõng b−íc nhÈy, môc nµy sÏ giíi thiÖu c¸ch sö dông Tab 
cho viÖc t¹o mét v¨n b¶n hiÓn thÞ d−íi d¹ng c¸c cét. 

Bµi to¸n ®Æt ra: h·y t¹o b¶ng d÷ liÖu nh− sau: 

 STT Hä vµ tªn §Þa chØ 

 1 NguyÔn V¨n Quang 123, T©y S¬n 

 2 Hå H¶i Hµ 68, NguyÔn Du 

 3 D−¬ng Quèc To¶n 23/10 NguyÔn Tr·i 

 4 NguyÔn Anh §øc 32/7 NguyÔn Tr·i 

  C¸c b−íc lµm nh− sau: 

  B−íc 1: §Þnh nghÜa kho¶ng c¸ch cho c¸c cét cña b¶ng bëi hép tho¹i Tab nh− 
sau: 

 Më b¶ng chän Format | Tab.., hép tho¹i Tab xuÊt hiÖn: 

 
- Hép Default tab stops: ®Ó thiÕt lËp b−íc nhÈy ngÇm ®Þnh cña Tab. H×nh trªn 

b−íc nhÈy ngÇm ®Þnh lµ 0.5 cm (tøc lµ mçi khi nhÇn phÝm Tab, con trá sÏ dÞch 
mét ®o¹n 0.5 cm trªn mµn h×nh so¹n th¶o). B¹n cã thÓ thay ®æi gi¸ trÞ b−íc 
nh¶y ngÇm ®Þnh Tab trªn mµn h×nh so¹n th¶o Word b»ng c¸ch gâ mét gi¸ trÞ 
sè ( ®¬n vÞ lµ cm) vµo hép nµy; 

- B¶ng trªn cã 3 cét, mçi cét sÏ ®−îc b¾t ®Çu t¹i mét vÞ trÝ cã kho¶ng c¸ch cè 
®Þnh ®Õn lÒ tr¸i trang v¨n b¶n mµ ta ph¶i thiÕt lËp ngay sau ®©y. Gi¶ sö cét 
STT c¸ch lÒ tr¸i 1cm, cét Hä vµ tªn c¸ch lÒ tr¸i 3 cm, cét §Þa chØ c¸ch lÒ tr¸i 8 
cm. Khi ®ã ph¶i thiÕt lËp c¸c th«ng sè nµy trªn hép tho¹i Tab nh− sau: 

Hép Tab stop position: gâ 1 (gâ kho¶ng c¸ch tõ cét STT ®Õn mÐp lÒ tr¸i 
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trang v¨n b¶n; ë môc Alignment- chän lÒ cho d÷ liÖu trong cét nµy (cét STT): 
Left – canh lÒ d÷ liÖu bªn tr¸i cét, Right- canh lÒ bªn ph¶i cét, Center – c¨n lÒ 
gi÷a cét, h·y chän Center. Chän xong nhÊn nót Set. T−¬ng tù lÇn l−ît khai 
b¸o vÞ trÝ Tab cho c¸c cét cßn l¹i: Hä vµ tªn (3) vµ cét §Þa chØ (8). §Ðn khi 
hép tho¹i Tab cã d¹ng: 

 
Cuèi cïng nhÊn nót Ok ®Ó hoµn tÊt viÖc thiÕt lËp tab cho c¸c cét vµ cã thÓ sö 
dông chóng nót Clear- ®Ó xo¸ bá ®iÓm Tab ®ang chän; nót Clear All - ®Ó xo¸ 
bá toµn bé c¸c ®iÓm tab ®ang thiÕt lËp trªn hép tho¹i). 

B−íc 2: C¸ch sö dông nh÷ng ®iÓm Tab võa thiÕt lËp ë trªn ®Ó t¹o b¶ng d÷ 
liÖu: 

 

 

 
Khi con trá ®ang n»m ë ®Çu dßng v¨n b¶n, nhÊn Tab ®Ó nhËp d÷ liÖu cét STT. 

NhËp xong nhÊn Tab, con trá sÏ chuyÓn ®Õn vÞ trÝ tab tiÕp theo (vÞ trÝ cét hä vµ 
tªn) vµ nhËp tiÕp d÷ liÖu Hä vµ tªn. NhËp xong nhÊn Tab ®Ó nhËp d÷ liÖu cét §Þa 
chØ. Lµm t−¬ng tù víi c¸c dßng tiÕp theo, b¹n ®· cã thÓ t¹o ®−îc b¶ng d÷ liÖu 
nh− yªu cÇu ë trªn. 

§Æc biÖt, chØ cÇn dïng chuét xö lý trªn th−íc kÎ n»m ngang (Vertical Ruler) 
b¹n còng cã thÓ thiÕt lËp vµ ®iÒu chØnh c¸c ®iÓm tab nh− võa råi. C¸ch lµm nh− 
sau: 

§Ó t¹o ®iÓm tab cho cét STT (cã kho¶ng c¸ch lµ 1cm, lÒ gi÷a), h·y nhÊn chuét 
tr¸i lªn vÞ trÝ 1 cm trªn th−íc kÎ n»m ngang. Mét ®iÓm Tab cã kho¶ng c¸ch 1cm, 
lÒ tr¸i (Left) ®· ®−îc thiÕt lËp nh− sau: .  

Muèn thay ®æi lÒ cho ®iÓm tab nµy lµ gi÷a (Center), lµm nh− sau: 

NhÊn kÐp chuét lªn ®iÓm tab võa thiÕt lËp, hép tho¹i Tab xuÊt hiÖn. TiÕp theo 
chän lÒ cho ®iÓm tab ®ang chän trªn hép tho¹i nµy ë môc Alignment lµ Center 

C¸c vÞ trÝ ®iÓm tab võa thiÕt lËp! 
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 TiÕp theo nhÊt nót Set ®Ó thiÕt lËp. 

NhÊn Set ®Ó thiÕt lËp 

Chän Center 

T−¬ng tù, h·y t¹o tiÕp c¸c ®iÓm tab cho cét Hä tªn vµ cét §Þa chØ. 

Muèn xo¸ bá mét ®iÓm tab nµo ®ã, chØ viÖc dïng chuét kÐo chóng (®iÓm tab ®ã) 
ra khái th−íc kÎ. 

1.2 C¸c kü n¨ng ®Þnh d¹ng v¨n b¶n 

NhËp v¨n b¶n bao gåm c¸c thao t¸c ®Ó gâ ®−îc v¨n b¶n lªn tµi liÖu. Cßn ®Þnh d¹ng 
v¨n b¶n bao gåm c¸c thao t¸c gióp b¹n lµm ®Ñp v¨n b¶n theo ý muèn. 

1.2.1 §Þnh d¹ng ®¬n gi¶n 

Gióp b¹n cã ®−îc nh÷ng kü n¨ng ®Þnh d¹ng v¨n b¶n ®Çu tiªn, ®¬n gi¶n nhÊt nh− 
lµ: ph«ng ch÷, mµu s¾c, cì ch÷, lÒ v.v. 

  H·y gâ ®o¹n v¨n b¶n sau: 

MÉu v¨n b¶n ®Þnh d¹ng 

a. Chän ph«ng ch÷ 

§Ó chän ph«ng ch÷ cho ®o¹n v¨n b¶n trªn, h·y lµm nh− sau: 

  B−íc 1: Chän (b«i ®en) ®o¹n v¨n b¶n; 

B−íc 2: Dïng chuét bÊm lªn hép Font  trªn thanh c«ng cô 
Standard. Mét danh s¸ch c¸c kiÓu ph«ng ch÷ xuÊt hiÖn: 

 
B¹n cã thÓ chän mét kiÓu phï hîp. VÝ dô, sau khi chän kiÓu ph«ng .VnTimeH, 

®o¹n v¨n b¶n ®· chän sÏ cã d¹ng: 

MÉu v¨n b¶n ®Þnh d¹ng 

Tác giả: Nguyễn Sơn Hải, Trung tâm Tin học - Bộ Giáo dục và Đào tạo. Email: nshai@moet.edu.vn  



MÉu v¨n b¶n ®Þnh d¹ng 

MÉu v¨n b¶n ®Þnh d¹ng 

MÉu v¨n b¶n ®Þnh d¹ng 
d. Chän mµu ch÷ 

§Ó chän mµu s¾c ch÷ cho ®o¹n v¨n b¶n trªn, h·y lµm nh− sau: 

  B−íc 1: Chän (b«i ®en) ®o¹n v¨n b¶n trªn; 

B−íc 2: Dïng chuét bÊm lªn hép Font Color   trªn thanh c«ng cô 
Standard. Mét b¶ng mµu xuÊt hiÖn cho phÐp chän lùa: 

 
B¹n cã thÓ chän lo¹i mµu phï hîp b»ng c¸ch nhÊn chuét lªn « mµu cÇn chän. 

Ngoµi ra, b¹n cã thÓ chän nh÷ng mÉu mµu ®éc ®¸o h¬n khi nhÊn nót  : 

 
ThÎ Standard cho phÐp chän mµu cã s½n cã thÓ chän; 

H¬n n÷a, thÎ Custom cho phÐp ®Þnh nghÜa mµu cho riªng m×nh: 
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Xem mµu ®ang 
chän ë ®©y.

B¹n cã thÓ chän mµu ë b¶ng c¸c ®iÓm mµu, ®ång thêi còng cã thÓ ®iÒu chØnh 
®−îc tû lÖ c¸c mµu ®¬n trong tõng gam mµu (Red- tû lÖ mµu ®á; Green- tû lÖ mµu 
xanh lµ c©y; Blue- tû lÖ mµu xanh da trêi). 

e. Chän mµu nÒn v¨n b¶n 

  §Ó chän mµu nÒn cho ®o¹n v¨n b¶n trªn, vÝ dô nh−: 

MÉu v¨n b¶n ®Þnh d¹ng 

h·y lµm nh− sau: 

  B−íc 1: Chän (b«i ®en) ®o¹n v¨n b¶n trªn; 

 B−íc 2: Dïng chuét bÊm lªn hép Hight light   trªn thanh c«ng cô 
Standard. Mét b¶ng mµu xuÊt hiÖn cho phÐp chän lùa: 

 
Cã thÓ chän lo¹i mµu nÒn phï hîp b»ng c¸ch nhÊn chuét lªn « mµu cÇn chän. 

NÕu chän None- t−¬ng ®−¬ng viÖc chän mµu tr¾ng. 

f. Hép tho¹i Font 

Ngoµi nh÷ng tÝnh n¨ng ®Þnh d¹ng c¨n b¶n ë trªn, hép tho¹i Font cung cÊp nh÷ng 
tÝnh n¨ng ®Þnh d¹ng ®Æc biÖt h¬n. §Ó më hép tho¹i Font, kÝch ho¹t môc chän 
Format | Font.. 
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ThÎ Font: Cho phÐp thiÕt lËp c¸c ®Þnh d¹ng c¨n b¶n vÒ ph«ng ch÷ nh− ®· tr×nh 

bµy ë trªn, vÝ dô: 

- Hép Font- cho phÐp chän ph«ng ch÷; 

- Hép Font style- chän kiÓu ch÷: Regular- kiÓu ch÷ b×nh th−êng; Italic- kiÓu 
ch÷ nghiªng; Bold – kiÓu ch÷ bÐo; Bold Italic – kiÓu võa bÐo, võa nghiªng; 

- Hép Size- chän cì ch÷; 

- Font color- chän mµu cho ch÷; 

- Hép Underline style: ®Ó chän kiÓu ®−êng g¹ch ch©n (nÕu kiÓu ch÷ ®ang chän 
lµ underline). 

- Ngoµi ra, môc Effect cho phÐp thiÕt lËp mét sè hiÖu øng ch÷ ®¬n gi¶n, b¹n cã 
thÓ chän chóng vµ xem thÓ hiÖn ë môc Preview. 

- NÕu nhÊn nót Default – kiÓu ®Þnh d¹ng nµy sÏ ®−îc thiÕt lËp lµ ngÇm ®Þnh cho 
c¸c ®o¹n v¨n b¶n míi sau nµy; 

Tác giả: Nguyễn Sơn Hải, Trung tâm Tin học - Bộ Giáo dục và Đào tạo. Email: nshai@moet.edu.vn  



 

Chän kiÓu 
hiÖu øng !

KÕt qu¶ sÏ 
thu ®−îc !

ThÎ Text Effect: cho phÐp thiÕt lËp mét sè hiÖu øng tr×nh diÔn s«i ®éng cho 
®o¹n v¨n b¶n. H·y chän kiÓu tr×nh diÔn ë danh s¸ch Animations: vµ xem tr−íc kÕt 
qu¶ sÏ thu ®−îc ë hép Preview.  

1.2.2 §Þnh d¹ng ®o¹n v¨n b¶n 

ë môc 1.2.1 chóng ta ®· lµm quen víi c¸c thao t¸c ®Þnh d¹ng v¨n b¶n cho vïng 
v¨n b¶n ®· ®−îc chän (®−îc b«i ®en). Trong phÇn nµy, chóng ta t×m hiÓu c¸ch ®Þnh 
d¹ng v¨n b¶n trªn cïng ®o¹n v¨n b¶n.  

Mçi dÊu xuèng dßng (Enter) sÏ t¹o thµnh mét ®o¹n v¨n b¶n. Khi ®Þnh d¹ng ®o¹n 
v¨n b¶n, kh«ng cÇn ph¶i lùa chän toµn bé v¨n b¶n trong ®o¹n ®ã, mµ chØ cÇn ®Æt 
®iÓm trá trong ®o¹n cÇn ®Þnh d¹ng.  

§Ó më tÝnh n¨ng ®Þnh d¹ng ®o¹n v¨n b¶n, më môc chän Format | Paragraph, 
hép tho¹i Paragraph xuÊt hiÖn: 

Tác giả: Nguyễn Sơn Hải, Trung tâm Tin học - Bộ Giáo dục và Đào tạo. Email: nshai@moet.edu.vn  



 
  Môc Aligment: chän kiÓu c¨n lÒ cho ®o¹n: 

- Justified – c¨n ®Òu lÒ tr¸i vµ lÒ ph¶i; 

- Left – c¨n ®Òu lÒ tr¸i 

- Right – c¨n ®Òu lÒ bªn ph¶i 

- Center – c¨n gi÷a 2 lÒ tr¸i vµ ph¶i. 

Môc Indentation: thiÕt lËp kho¶ng c¸ch tõ mÐp lÒ ®o¹n so víi lÒ trang: 

- Left – kho¶ng c¸ch tõ lÒ tr¸i ®o¹n ®Õn lÒ tr¸i cña trang v¨n b¶n; 

- Right- kho¶ng c¸ch tõ lÒ ph¶i cña ®o¹n ®Õn lÒ ph¶i cña trang v¨n b¶n 

NgÇm ®Þnh, hai kho¶ng c¸ch nµy ®Òu lµ 0. 

- Trong môc Special nÕu chän: 

• First line: khi ®ã cã thÓ thiÕt lËp ®é thôt dßng cña dßng ®Çu tiªn trong ®o¹n 
vµo môc By: 

§©y lµ vÝ dô vÒ mét ®o¹n v¨n b¶n thiÕt lËp ®é thôt ®Çu dßng (First line) 
so víi c¸c dßng tiÕp theo trong ®o¹n mét kho¶ng c¸ch 0.5 cm. 

• Hanging: ®Ó thiÕt lËp ®é thôt dßng cña dßng thø 2 trë ®i trong ®o¹n so víi 
dßng ®Çu tiªn mét kho¶ng c¸ch ®−îc gâ vµo môc By:. 

-   §©y lµ vÝ dô vÒ mét ®o¹n v¨n b¶n thiÕt lËp ®é thôt cña c¸c dßng thø 2 
trë ®i (Hanging) so víi dßng ®Çu tiªn trong ®o¹n mét kho¶ng c¸ch 0.5 
cm. 

• None: ®Ó hñy bá chÕ ®é thôt ®Çu dßng trªn ®o¹n. 

§©y lµ vÝ dô vÒ mét ®o¹n v¨n b¶n khi kh«ng thiÕt lËp chÕ ®é thôt ®Çu dßng 
trªn ®o¹n (None). 
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- NÕu môc Special lµ First line, khi ®ã cã thÓ thiÕt lËp ®é thôt dßng cña dßng 
®Çu tiªn trong ®o¹n vµo môc By: 

- Môc Spacing: cho phÐp thiÕt lËp c¸c kho¶ng c¸ch dßng: 

- Before – kho¶ng c¸ch dßng gi÷a dßng ®Çu tiªn cña ®o¹n tíi dßng cuèi cïng 
cña ®o¹n v¨n b¶n trªn nã; 

- After- ®Ó thiÕt lËp kho¶ng c¸ch dßng gi÷ dßng cuèi cïng cña ®o¹n víi dßng 
®Çu tiªn cña ®o¹n sau nã; 

- Line Spacing - ®Ó chän ®é d·n dßng. NgÇm ®Þnh ®é d·n dßng lµ 1 (Single); 

Mµn h×nh Preview cho phÐp xem tr−íc nh÷ng kÕt qu¶ ®Þnh d¹ng ®o¹n võa thiÕt 
lËp. 

NhÊn Ok ®Ó chÊp nhËn nh÷ng thuéc tÝnh võa thiÕt lËp cho ®o¹n v¨n b¶n ®ang 
chän; tr¸i l¹i nhÊn Cancel ®Ó huû bá c«ng viÖc võa lµm. 

 

1.3 ThiÕt lËp Bullets vµ numbering 

 PhÇn nµy sÏ h−íng dÉn c¸ch thiÕt lËp c¸c lo¹i ®¸nh dÊu ®Çu ®o¹n (Bullets) vµ c¸ch 
®¸nh sè chØ môc (Numbering) cho c¸c tiªu ®Ò trªn tµi liÖu word. 

1.3.1 ThiÕt lËp Bullets 

§Ó ®¸nh dÊu ®Çu dßng mét ®o¹n v¨n b¶n, h·y lµm theo c¸c b−íc sau ®©y: 

B−íc 1: §Æt con trá lªn ®o¹n cÇn ®¸nh dÊu ®Çu dßng vµ kÝch ho¹t tÝnh n¨ng 
®¸nh dÊu ®Çu dßng b»ng c¸ch më môc chän: Format | Bullets and Numbering .., 
hép tho¹i sau ®©y xuÊt hiÖn: 

 
B−íc 2: ThiÕt lËp th«ng tin vÒ dÊu ®Çu dßng ë thÎ Bulleted nh− sau: 

 Dïng chuét nhÊn lªn kiÓu Bullet muèn thiÕt lËp (®o¹n v¨n b¶n nµy ®ang sö 
dông kiÓu bullet chän ë h×nh trªn); 
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 NhÊn nót Picture.., ®Ó chän mét kiÓu bullet lµ c¸c h×nh ¶nh kh¸c, khi ®ã hép 
tho¹i sau ®©y xuÊt hiÖn: 

 
Chän mét lo¹i bullet råi nhÊn OK ®Ó hoµn tÊt. 

 Cã thÓ nhÊn nót Customize.. ®Ó thùc hiÖn mét vµi thao t¸c ®Þnh d¹ng cÇn thiÕt 
cho bullet ®ang chän: 

 
- Cã thÓ chän l¹i kiÓu bullet ë danh s¸ch Bullet character; 

- NhÊn nót Font.. ®Ó chän lo¹i ph«ng ch÷ cho bullet; 

- NhÊn nót Bullet.. ®Ó cã thÓ chän bullet lµ mét ký tù ®Æc biÖt (Symbol); 

- Môc Bullet position ®Ó thiÕt lËp kho¶ng c¸ch dÊu bullet so víi mÐp trong lÒ 
bªn tr¸i tµi liÖu; 

- Môc Text position ®Ó thiÕt lËp kho¶ng c¸ch tõ v¨n b¶n (text) tíi mÐp trong lÒ 
tr¸i cña tµi liÖu. 

 

 

 

 

 Nót lÖnh Bullet  trªn thanh c«ng cô chuÈn sÏ gióp b¹n thiÕt lËp nhanh hoÆc bá thiÕt lËp ®Þnh 
d¹ng ®¸nh dÊu ®Çu ®o¹n v¨n b¶n.  

Tác giả: Nguyễn Sơn Hải, Trung tâm Tin học - Bộ Giáo dục và Đào tạo. Email: nshai@moet.edu.vn  



1.3.2 ThiÕt lËp Numbering 

§Ó ®¸nh sè chØ môc cho c¸c tiªu ®Ò tµi liÖu, h·y lµm theo c¸c b−íc sau ®©y: 

B−íc 1: §Æt con trá lªn ®o¹n cÇn ®¸nh sè chØ môc vµ kÝch ho¹t tÝnh n¨ng ®¸nh 
sè chØ môc b»ng c¸ch më môc chän: Format | Bullets and Nubering .., hép tho¹i 
sau ®©y xuÊt hiÖn: 

 
B−íc 2: ThiÕt lËp th«ng tin vÒ ®¸nh sè chØ môc ë thÎ Numbered nh− sau: 

 H·y dïng chuét nhÊn lªn kiÓu ®¸nh sè chØ môc muèn thiÕt lËp ; 

 Nót Customize..., ®Ó ®Þnh d¹ng cho sè chØ môc nµy bëi hép tho¹i sau: 

 

ý nghÜa c¸c môc tin trªn hép tho¹i nµy nh− sau: 

- Nót Font…, cho phÐp chän kiÓu ph«ng ch÷ cho sè chØ môc; 

- Môc Start at: ®Ó chän chØ môc ®Çu tiªn cÇn ®¸nh sè: nÕu chän 1, sÏ thùc hiÖn 
®¸nh chØ môc lµ 1, 2, ..; nh−ng nÕu chän lµ 5 th× sÏ ®¸nh sè tõ 5 trë ®i lµ 5, 6, 
7..; 

- Môc Number position ®Ó thiÕt lËp vÞ trÝ cña chØ môc trªn ®o¹n v¨n b¶n; 

- Text position ®Ó thiÕt lËp kho¶ng c¸ch v¨n b¶n so víi mÐp lÒ cña trang tµi 
liÖu. 
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 Nót lÖnh Numbering  trªn thanh c«ng cô chuÈn sÏ gióp b¹n thiÕt lËp nhanh hoÆc bá thiÕt lËp 
®Þnh d¹ng ®¸nh chØ môc ®Çu ®o¹n v¨n b¶n.  

1.4 So¹n th¶o c«ng thøc to¸n häc 

§Ó cã thÓ so¹n th¶o ®−îc c«ng thøc to¸n häc, m¸y tÝnh cña b¹n ph¶i ®−îc cµi ®Æt 
bé Microsoft Equation 3.0 cïng víi bé Microsoft Office. C¸ch so¹n th¶o mét c«ng 
thøc to¸n häc ®−îc tiÕn hµnh nh− sau: 

B−íc 1: Chän mét vÞ trÝ trªn tµi liÖu, n¬i sÏ chÌn c«ng thøc to¸n häc vµo; 

B−íc 2: KÝch ho¹t tr×nh so¹n th¶o c«ng thøc to¸n häc b»ng c¸ch: më môc chän 
Insert | Object… Hép tho¹i Object xuÊt hiÖn: 

 
Dïng chuét chän môc Microsoft Equation 3.0 (nh− h×nh trªn), råi nhÊn OK. 

Thanh c«ng cô Equation cïng hép so¹n th¶o c«ng thøc xuÊt hiÖn: 
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Thanh c«ng cô ®Ó so¹n 
th¶o c«ng thøc Hép so¹n th¶o c«ng 

thøc to¸n häc 

- Hép so¹n th¶o c«ng thøc, lµ n¬i ®Ó so¹n th¶o c«ng thøc to¸n häc. 

- Thanh c«ng cô Equation chøa c¸c nót lÖnh cho phÐp chän c¸c mÉu c«ng thøc 
vµ c¸c ký tù, ký hiÖu, phÇn tö trong mét c«ng thøc to¸n häc. 

B−íc 3: So¹n th¶o c«ng thøc: §¬n gi¶n b»ng c¸ch chÌn c¸c mÉu c«ng thøc råi 
x©y dùng c¸c thµnh phÇn c«ng thøc. 

1.5 Chia v¨n b¶n thµnh nhiÒu cét 

 Microsoft Word cung cÊp tÝnh n¨ng Columns gióp ng−êi dïng dÔ dµng chia v¨n 
b¶n cña m×nh thµnh nhiÒu cét (gièng nh− ®Þnh d¹ng trªn c¸c trang b¸o vµ t¹p chÝ). 
Mçi ®o¹n v¨n b¶n cã thÓ ®−îc chia thµnh c¸c cét cã ®é réng kh¸c nhau. Trªn mçi cét, 
cã thÓ thùc hiÖn chÌn c¸c th«ng tin nh−: b¶ng biÓu, h×nh vÏ,.. nh− thao t¸c trªn c¸c 



trang tµi liÖu b×nh th−êng.  

1.5.1 Chia cét v¨n b¶n 

B−íc 1: Lùa chän (b«i ®en) vïng v¨n b¶n cÇn chia lµm nhiÒu cét; 

B−íc 2: KÝch ho¹t môc chän Format | Columns.. Hép tho¹i Columns xuÊt 
hiÖn: 

 
ThiÕt lËp c¸c th«ng sè cho hép tho¹i Columns víi c¸c ý nghÜa nh− sau: 

- ý nghÜa c¸c hép chän ë môc Presets nh− sau : 
One  - 1 cét; 

Two  - 2 cét; 

Three - 3 cét; 

Left  - chia v¨n b¶n thµnh 2 cét, cét bªn tr¸i cã chiÒu réng b»ng mét nöa cét 
bªn ph¶i; 

Right - chia v¨n b¶n thµnh 2 cét, cét bªn ph¶i cã chiÒu réng b»ng mét nöa 
cét bªn tr¸i; 

- B¹n cã thÓ thiÕt lËp sè cét cÇn t¹o ra nhiÒu h¬n b»ng c¸ch gâ sè cét vµo môc 
Number of Columns; 

- Môc Width and Spacing: cho phÐp thiÕt lËp c¸c th«ng sè vÒ chiÒu réng vµ 
kho¶ng c¸ch gi÷a c¸c cét. B¹n cã thÓ dïng chuét (hoÆc gâ) thay ®æi gi¸ trÞ 
môc Width, ®é réng cña cét t−¬ng øng sÏ ®−îc thay ®æi (h·y nh×n h×nh ë môc 
Preview ®Ó xem tr−íc kÕt qu¶). HoÆc thay ®æi gi¸ trÞ môc Spacing.  

- Kho¶ng c¸ch gi÷a hai cét kÒ nhau còng ®−îc thay ®æi khi môc Equal 
columns width ®−îc chän (checked)- th× ®é réng cña c¸c cét vµ kho¶ng c¸ch 
gi÷a c¸c cét ®Òu b»ng nhau. Muèn thay ®æi ®é réng mçi cét hoÆc kho¶ng c¸ch 
gi÷a c¸c cét kh¸c nhau, h·y bá chän môc nµy. Khi ®ã, cã thÓ ®iÒu chØnh ®é 
réng hoÆc kho¶ng c¸ch gi÷a hai cét nµo ®ã mét c¸ch trùc tiÕp. 

- H·y quan s¸t môc Col #: ®Ó biÕt ®−îc cét sÏ cÇn ®iÒu chØnh vµ kh«ng quªn 
xem hép Preview ®Ó nh×n thÊy tr−íc ®−îc kÕt qu¶ sÏ ®¹t ®−îc. 
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- Môc Apply to: cho biÕt ph¹m vi v¨n b¶n sÏ chia thµnh c¸c cét. 

+ NÕu chän Seleted Text th× chØ chia cét cho v¨n b¶n ®· ®−îc chän (b«i 
®en) 

+ NÕu chän Whole Document, toµn bé c¸c trang v¨n b¶n sÏ ®−îc chia cét 
theo thiÕt lËp nh− trªn. 

1.5.2 Söa l¹i ®Þnh d¹ng 

§Ó söa l¹i ®Þnh d¹ng cét ®· chia, h·y lµm theo 2 b−íc 

B−íc 1: §Æt ®iÓm trá vµo mét vÞ trÝ bÊt kú trªn vïng v¨n b¶n ®· chia cét. 

B−íc 2: KÝch ho¹t menu Format | Columns.. , Hép tho¹i Columns xuÊt hiÖn 
cho phÐp chØnh söa c¸c th«ng sè vÒ c¸c cét ®· chia. 

1.6 T¹o ch÷ c¸i lín ®Çu ®o¹n v¨n b¶n 

 TÝnh n¨ng DropCap cña word gióp t¹o c¸c kiÓu ch÷ c¸i lín ®Çu tiªn cho mét ®o¹n 
v¨n b¶n.  

1.6.1 C¸ch t¹o 

 §Ó t¹o ch÷ c¸i lín ®Çu ®o¹n v¨n b¶n, h·y lµm theo c¸c b−íc sau: 

 B−íc 1: §Æt con trá lªn ®o¹n cÇn t¹o ch÷ c¸i lín ®Çu ®o¹n; khëi ®éng tÝnh n¨ng 
Drop Cap b»ng c¸ch: më môc chän Format | Drop Cap.. Hép tho¹i Drop cap 
xuÊt hiÖn: 

 
B−íc 2: thiÕt lËp c¸c th«ng sè cho ch÷ lín nµy: 

- Môc Position- ®Ó chän kiÓu ch÷ cÇn ®Æt. Cã 3 kiÓu ch÷ lµ: None – kh«ng thiÕt 
lËp; Dropped vµ In Margin. H·y xem mÉu trªn h×nh; 

- Hép Font:- chän ph«ng ch÷ cho ch÷ c¸i nµy; 

- Môc Line to drop:- thiÕt lËp sè dßng v¨n b¶n lµm chiÒu cao cho ch÷; 

- Môc Distance from text:- gâ vµo kho¶ng c¸ch tõ ch÷ c¸i lín nµy ®Õn ký tù 
tiÕp theo nã. 

- Cuèi cïng, nhÊn OK ®Ó hoµn tÊt 
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D−íi ®©y lµ 2 vÝ dô minh häa khi sö dông 2 lo¹i ch÷ c¸i lín ®Çu ®o¹n lµ 
Dropped vµ In Margin 

 

o¹n v¨n b¶n nµy ®Ó m« t¶ c¸c lo¹i ch÷ c¸i lín ®Çu ®o¹n v¨n b¶n. Khi 
chän Position lµ kiÓu Dropped, víi chiÒu cao cña ch÷ lµ 2 dßng (Lines 

to drop=2) 

o¹n v¨n b¶n nµy ®Ó m« t¶ c¸c lo¹i ch÷ c¸i lín ®Çu ®o¹n v¨n b¶n. Khi chän 
Position lµ kiÓu In margin, víi chiÒu cao cña ch÷ lµ 2 dßng (Lines to 
drop=2). 

. 

 §
 §

1.6.2 §iÒu chØnh ch÷ c¸i lín ë ®Çu ®o¹n 

 §Ó thay ®æi l¹i ch÷ c¸i lín ®Çu ®o¹n ®· t¹o ®−îc, h·y lµm nh− sau: 

B−íc 1: §Æt con trá lªn ®o¹n cÇn söa ch÷ c¸i lín ®Çu ®o¹n; khëi ®éng tÝnh n¨ng 
Drop Cap ; 

 
B−íc 2: Thùc hiÖn thiÕp lËp l¹i c¸c th«ng sè trªn hép tho¹i nµy. Cuèi cïng nhÊn 

OK ®Ó chÊp nhËn sù thay ®æi. 

1.7 T¹o vµ qu¶n lý c¸c Style 

 Trong qu¸ tr×nh so¹n th¶o v¨n b¶n, nhiÒu khi cÇn ®Þnh d¹ng nhiÒu ®o¹n v¨n b¶n 
theo cïng mét kiÓu ®Þnh d¹ng. NÕu ph¶i ®Þnh d¹ng lÇn l−ît tõng ®o¹n nh− vËy sÏ mÊt 
rÊt nhiÒu thêi gian, v¶ l¹i khã chÝnh x¸c v× ph¶i thao t¸c qu¸ nhiÒu. Mét trong nh÷ng 
c¸ch ®¬n gi¶n nhÊt trong Word gióp ®¬n gi¶n t×nh huèng trªn lµ Style. 

 Style lµ mét tËp hîp c¸c ®Þnh d¹ng v¨n b¶n cña mét ®o¹n, cã tªn gäi vµ cã thÓ ®−îc 
g¸n bëi mét tæ hîp phÝm nãng. 

 Style ®Æc biÖt cÇn thiÕt khi ph¶i so¹n th¶o mét gi¸o tr×nh, mét tµi liÖu cã chøa nhiÒu 
môc, nhiÒu lo¹i ®o¹n v¨n b¶n kh¸c nhau. 

1.7.1 T¹o mét Style 

§Ó t¹o mét Style h·y lµm nh− sau: 
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B−íc 1: Më môc chän Format | Style.. Hép tho¹i Style xuÊt hiÖn: 

 
B−íc 2: §Ó t¹o Style míi, nhÊn nót New, hép tho¹i: New Style xuÊt hiÖn cho 

phÐp thiÕt lËp th«ng tin cho Style míi: 

 
- Gâ tªn cho Style míi vµo môc Name: vÝ dô Muc1; 

- NhÊn nót Format ®Ó chän c¸c chøc n¨ng ®Þnh d¹ng cho Style nµy: 

 Bao gåm c¸c th«ng tin: 

- Font… ®Ó ®Þnh d¹ng ph«ng ch÷ cho Style; 

- Paragraph… ®Þnh d¹ng ®o¹n; 
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- Tabs.. ®Ó ®Æt ®iÓm Tab cho Style (nÕu cÇn); 

- Border.. ®Ó chän kiÓu ®−êng viÒn cho Style (nÕu cÇn); 

- Frame.. ®Ó chän kiÓu khung cho Style (nÕu cÇn); 

- Numbering.. ®Ó chän kiÓu g¹ch ®Çu dßng (nÕu cÇn); 

- NhÊn nót Shortcut key.. ®Ó g¸n phÝm nãng cho Style nµy, hép tho¹i 
Customize Keyboard xuÊt hiÖn cho phÐp thiÕt lËp phÝm nãng: 

 
- Khi con trá ®ang ë môc Press new shortcut key: h·y bÊm tæ hîp phÝm nãng 

cÇn g¸n trªn bµn phÝm. VÝ dô: Ctrl + 1; 

- TiÕp theo nhÊn nót Assign ®Ó ®ång ý phÝm nãng nµy; 

- Cã thÓ g¸n nhiÒu tæ hîp phÝm nãng cho mét Style, chóng ®−îc chøa ë danh 
s¸ch Current keys:  

- Nót Remove, nót Reset All.. gióp qu¶n lý c¸c phÝm nãng võa t¹o; 

- Sau khi g¸n xong tæ hîp phÝm nãng, hép tho¹i Customize keyboard sÏ cã 
d¹ng: 

 
- NhÊn nót Close ®Ó tiÕp tôc. 

- NÕu chän  , khi ®ã ®Þnh d¹ng cña Style sÏ ®−îc tù ®éng thay 

Tác giả: Nguyễn Sơn Hải, Trung tâm Tin học - Bộ Giáo dục và Đào tạo. Email: nshai@moet.edu.vn  



- Cuèi cïng nhÊn OK ®Ó hoµn tÊt viÖc g¸n style míi nµy cho ®o¹n v¨n b¶n ®ang 
chän trªn tµi liÖu. 

1.7.3 §iÒu chØnh Style 

§Ó tu söa l¹i ®Þnh d¹ng cho Style, h·y lµm nh− sau: 

B−íc 1: Më hép tho¹i Style vµ chän tªn Style cÇn tu söa ë danh s¸ch Styles: 
(vÝ dô muèn tu söa l¹i ®Þnh d¹ng style Muc1) 

 

Chän style cÇn 
®iÒu chØnh ! 

B−íc 2: NhÊn nót Modify.. hép tho¹i Modify Style xuÊt hiÖn cho phÐp thay ®æi 
l¹i ®Þnh d¹ng cña style nµy: 

 
- Cã thÓ thay ®æi l¹i c¸c ®Þnh d¹ng khi nhÊn lªn nót Format, chän kiÓu ®Þnh 

d¹ng vµ thùc hiÖn thay ®æi chóng; 

- Cã thÓ thiÕt lËp l¹i phÝm nãng khi nhÊn nót Shortcut key..; 
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- Vµ cã thÓ lµm ®−îc tÊt c¶ nh÷ng viÖc ®èi víi Style nµy nh− ®· lµm khi t¹o 
Style míi. 

- Cuèi cïng, nhÊn OK ®Ó ®ång ý mäi sù thay ®æi. 

 

 Trªn tÖp tin Normal.dot cña word lu«n chøa s½n style cã tªn Normal. §©y lµ ®Þnh d¹ng ngÇm ®Þnh cho 
v¨n b¶n khi so¹n th¶o trªn word. B¹n nªn söa ®Þnh d¹ng style nµy phï hîp víi ®Þnh d¹ng v¨n b¶n th−êng 
xuyªn lµm viÖc. VÝ dô: 

- Font ch÷ (Font name): .vnTime 
- Cì ch÷ (Font size): 13 
- LÒ (Alignment) : Justify 
- §é gi·n dßng (Line spacing): Single 
- Kho¶ng c¸ch dßng tr−íc cña ®o¹n (Spacing before): 6 
- Kho¶ng c¸ch dßng sau cña ®o¹n (Spacing after): 4 

1.7.4 Qu¶n lý c¸c Styles 

§Ó qu¶n lý c¸c Style trªn Word còng nh− c¸c styles ®ang sö dông trªn tÖp tµi 
liÖu ®ang më, h·y lµm nh− sau: 

B−íc 1: Më hép tho¹i Style vµ nhÊn nót Organizer..: 

 

NhÊn lªn ®©y 
®Ó tiÕp tôc.. 

Hép tho¹i Oganizer xuÊt hiÖn cho phÐp qu¶n lý c¸c style cã trªn word còng 
nh− trªn tÖp tµi liÖu ®ang më: 
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Danh s¸ch c¸c style 
cã thÓ qu¶n lý

- Danh s¸ch In Document1: liÖt kª c¸c style ®ang sö dông trªn tÖp 
Document1.doc (tÖp ®ang më); 

- Danh s¸ch To Normal.dot: liÖt kª danh s¸ch c¸c style cã trªn tÖp Normal.dot 
cña word (c¸c style trªn tÖp normal.dot cã thÓ chia sÎ cho tÊt c¶ c¸c tÖp word 
kh¸c sö dông ®−îc); 

- MÆt kh¸c ta còng cã thÓ thay ®æi c¸c styles trªn danh s¸ch nµy b»ng c¸ch chän 
tÖp tµi liÖu ë hép Styles available in: 

- Qu¶n lý style lµ thªm vµo, xo¸ ®i hoÆc ®æi tªn c¸c style cho tµi liÖu ®ang më 
hoÆc cho tÖp normal.dot cña word. 

- Sö dông nót Copy ®Ó sao chÐp mét style gi÷a hai danh s¸ch trªn; 

- Sö dông nót Delete ®Ó xo¸ style ®ang chän; 

- Sö dông nót Rename ®Ó ®æi tªn style ®ang chän; 

- Cuèi cïng nhÊn Close ®Ó kÕt thóc. 

 1.8 T×m kiÕm vµ thay thÕ v¨n b¶n 

TÝnh n¨ng Find & Replace trong Word gióp t×m kiÕm v¨n b¶n, ®ång thêi gióp thay 
thÕ mét côm tõ bëi mét côm tõ míi. §iÒu nµy gióp Ých rÊt nhiÒu khi b¹n ph¶i lµm viÖc 
trªn mét sè l−îng trang v¨n b¶n rÊt lín (mét gi¸o tr×nh, mét b¸o c¸o dµi ch¼ng h¹n). 

1.8.1 T×m kiÕm v¨n b¶n  

§Ó t×m kiÕm mét côm tõ trong tµi liÖu cña m×nh, lµm nh− sau: 

  B−íc 1: Chän vïng v¨n b¶n muèn t×m kiÕm; 

NÕu kh«ng lùa chän mét vïng v¨n b¶n, Word sÏ thùc hiÖn t×m kiÕm trªn toµn bé 
tµi liÖu. 

B−íc 2: Khëi ®éng tÝnh n¨ng t×m kiÕm v¨n b¶n b»ng c¸ch: kÝch ho¹t môc chän 
Edit | Find.. hoÆc nhÊn tæ hîp phÝm t¾t Ctrl + F, hép tho¹i Find and Replace 
xuÊt hiÖn: 
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B−íc 3: ThiÕt lËp c¸c th«ng tin vÒ t×m kiÕm trªn thÎ Find. ý nghÜa c¸c môc tin 
nh− sau: 

- Gâ tõ cÇn t×m kiÕm vµo môc Find what: vÝ dô: Viet nam; 

- ThiÕt lËp c¸c tuú chän t×m kiÕm ë môc Search Options nh− sau: 

- Match case- t×m kiÕm mµ kh«ng ph©n biÖt ch÷ hoa, ch÷ th−êng; 

- Find whole words only- chØ t×m trªn nh÷ng tõ ®éc lËp 

B−íc 4: NhÊn nót Find next, m¸y sÏ chØ ®Õn vÞ trÝ v¨n b¶n chøa côm tõ cÇn t×m. 

1.8.2 T×m vµ thay thÕ v¨n b¶n  

TÝnh n¨ng nµy gióp t×m ra nh÷ng côm tõ trªn v¨n b¶n, ®ång thêi cã thÓ thay thÕ 
côm tõ t×m ®−îc bëi mét côm tõ míi. §Ó thùc hiÖn tÝnh n¨ng nµy, lµm nh− sau:  

B−íc 1: Chän vïng v¨n b¶n muèn t×m kiÕm; khëi ®éng tÝnh n¨ng t×m kiÕm v¨n 
b¶n; 

B−íc 2: ThiÕt lËp th«ng tin vÒ côm tõ cÇn t×m vµ côm tõ sÏ thay thÕ ë thÎ 
Replace cña hép tho¹i: 

 

Gâ côm tõ sÏ thay thÕ !

Gâ côm tõ cÇn t×m !

Gâ côm tõ cÇn 
t×m vµo ®©y !

NhÊn lªn ®©y 
®Ó tiÕp tôc

- Gâ côm tõ cÇn t×m kiÕm vµo môc Find what: 



- Gâ côm tõ sÏ thay thÕ ë môc Replace with: 

Hép tho¹i trªn thiÕt lËp th«ng tin t×m kiÕm côm tõ Viet nam, nÕu t×m thÊy cã thÓ 
thay thÕ côm tõ ®ã bëi ViÖt Nam. 

B−íc 3: NhÊn nót Find next ®Ó t×m ®Õn vÞ trÝ v¨n b¶n chøa côm tõ cÇn t×m. Khi 
t×m thÊy, cã thÓ bÊm nót Replace ®Ó thay thÕ côm tõ t×m ®−îc bëi côm tõ ®· chØ 
®Þnh ë môc Replace with: hoÆc nhÊn nót Replace All, Word sÏ tù ®éng thay thÕ 
toµn bé c¸c côm tõ sÏ t×m ®−îc nh− chØ ®Þnh. 

1.9 TÝnh n¨ng AutoCorrect 

§©y lµ tÝnh n¨ng tù ®éng söa lçi chÝnh t¶ rÊt m¹nh trªn Word. Nã gióp tèc ®é so¹n 
th¶o v¨n b¶n cña b¹n nhanh h¬n nhê nh÷ng tõ viÕt t¾t vµ tr¸nh ®−îc c¸c lçi chÝnh t¶ 
kh«ng cÇn thiÕt bëi kh¶ n¨ng tù ®éng söa lçi chÝnh t¶ cña nã. 

1.9.1 Thªm mét tõ viÕt t¾t 

  §Ó thªm mét tõ viÕt t¾t, thùc hiÖn theo c¸c b−íc sau: 

B−íc 1: Khëi ®éng tÝnh n¨ng AutoCorrect b»ng c¸ch më môc chän lÖnh: Tools | 
AutoCorrect.., Hép tho¹i AutoCorrect xuÊt hiÖn: 

 

Côm tõ sÏ thay thÕCôm tõ viÕt t¾t

- Gâ côm tõ viÕt t¾t vµo môc Replace: 

- Gâ côm tõ sÏ thay thÕ vµo môc With: 

VÝ dô: muèn viÕt t¾t tõ v¨n b¶n bëi vb th×: 

Replace  gâ  vb 

With      gâ    v¨n b¶n 

B−íc 2: NhÊn nót Add ®Ó ghi thªm tõ nµy vµo danh s¸ch viÕt t¾t cña Word. 

1.9.2 Xo¸ ®i mét tõ viÕt t¾t 
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§Ó xo¸ ®i mét tõ viÕt t¾t, thùc hiÖn theo c¸c b−íc sau: 

B−íc 1: Khëi ®éng tÝnh n¨ng AutoCorrect; 

B−íc 2: T×m ®Õn tõ viÕt t¾t cÇn xo¸ b»ng c¸ch gâ tõ viÕt t¾t vµo môc Replace. 
VÝ dô muèn xo¸ tõ vb – v¨n b¶n võa thiÕt lËp ë trªn, h·y gâ vb vµo môc Replace; 

B−íc 3: NhÊn nót Delete ®Ó xo¸ côm tõ viÕt t¾t nµy. 

 

 

 

 

 

 

 Khi chóng ta so¹n th¶o trªn Word, th−êng hay gÆp ph¶i lçi sau: 
NÕu gâ ch÷ thi, m¸y sÏ tù ®éng söa thµnh thI 
Gâ ch÷ thiÖn, m¸y tù ®éng söa thµnh thIÖn 

Tøc lµ ch÷ i (i th−êng) sÏ tù ®éng chuyÓn thµnh I (I hoa). Lçi nµy do AutoCorect ®Æt söa lçi chÝnh t¶ i
thµnh I (v× trong tiÕng Anh I cã nghÜa lµ t«i, vµ chóng lu«n ®−îc viÕt in hoa trong c©u). §Ó söa lçi nµy, h·y 
thùc hiÖn xo¸ ®i kiÓu viÕt t¾t ch÷ i bëi tÝnh n¨ng Delete cña AutoCorrect. 

 

1.9.3 C¸c tuú chän vÒ söa lçi chÝnh t¶ 

AutoCorrect cho phÐp thiÕt lËp mét sè tÝnh chÊt tù ®éng söa c¸c lçi chÝnh t¶ 
trong qu¸ tr×nh so¹n th¶o. §Ó thiÕt lËp c¸c tÝnh chÊt tù ®éng söa lçi chÝnh t¶, h·y 
lµm nh− sau: 

B−íc 1: Khëi ®éng tÝnh n¨ng AutoCorrect; 

B−íc 2: ThiÕt lËp c¸c th«ng sè vÒ tù ®éng söa lçi chÝnh t¶ b»ng c¸ch chän 
(checked) c¸c môc sau: 

  - tù ®éng söa nh÷ng tõ nÕu cã 2 ký tù hoa ®Çu dßng sÏ 
chØ ®Ó l¹i ký tù hoa ®Çu tiªn. VÝ dô TWo sÏ tù ®éng söa thµnh Two; 

  - tù ®éng söa ký tù ®Çu tiªn cña mét c©u thµnh ký tù in 
hoa; 

  - viÕt in hoa cho ký tù ®Çu tiªn  cña ngµy. VÝ dô: sÏ 
lu«n söa lµ Monday; 

 - tù ®éng söa lçi kiÓu nh− cAPS LOCK khi bËt 
nhÇm phÝm Caps lock. Khi ®ã m¸y sÏ söa thµnh Caps lock. 

1.10 ChÌn ký tù ®Æc biÖt 

Trong qu¸ tr×nh so¹n th¶o v¨n b¶n, nhiÒu lóc chóng ta cÇn chÌn mét sè ký tù ®Æc 
biÖt vµo tµi liÖu (kh«ng cã trªn bµn phÝm) vÝ dô nh−: ∀, ∑, ↑, ↓, ±, ≥, ... TÝnh n¨ng 
Insert Symbol cña Word gióp ®¬n gi¶n lµm viÖc nµy.  

1.10.1 ChÌn ký tù ®Æc biÖt 

Chän vÞ trÝ cÇn ®¨t ký tù ®Æc biÖt, tiÕp theo më môc chän Insert | Symbol… Hép 
tho¹i Symbol xuÊt hiÖn: 
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ë thÎ Symbol,  cã thÓ t×m ký tù ®Æc biÖt cÇn chÌn lªn v¨n b¶n. Trong tr−êng hîp 
kh«ng t×m thÊy, cã thÓ t×m ký tù ë danh môc kh¸c b»ng c¸ch chän mét danh môc 
tËp hîp c¸c ký tù ë môc Font:  

Mµn h×nh trªn hiÓn thÞ tËp hîp c¸c ký tù ®Æc biÖt cña danh s¸ch Symbol. Gi¶ sö 
khi chän hép Font lµ  danh s¸ch c¸c ký tù ®Æc biÖt sÏ nh− sau: 

 
Khi thÊy ký tù cÇn t×m, cã thÓ chÌn chóng lªn tµi liÖu bëi mét trong hai c¸ch sau: 

C¸ch 1: NhÊn kÐp chuét lªn ký tù cÇn chÌn; 

hoÆc 

C¸ch 2: Chän ký tù cÇn chÌn b»ng c¸ch nhÊn chuét tr¸i lªn nã, råi nhÊn nót 
Insert ®Ó chÌn ký tù lªn tµi liÖu. 

Víi tÝnh n¨ng nµy, b¹n cã thÓ chÌn mét lóc nhiÒu c¸c ký tù ®Æc biÖt lªn tµi liÖu. 

§Æc biÖt: cã hai chøc n¨ng rÊt thuËn tiÖn nÕu ta ph¶i dïng nhiÒu ký tù ®Æc biÖt nµo 
®ã trong so¹n th¶o, ®ã lµ g¸n tæ hîp phÝm nãng vµ thiÕt lËp côm tõ viÕt t¾t cho ký tù 
®Æc biÖt. 

1.10.2 G¸n tæ hîp phÝm nãng cho ký tù ®Æc biÖt 

Mçi ký tù ®Æc biÖt, b¹n cã thÓ g¸n mét tæ hîp phÝm nãng ®Ó sau nµy khi so¹n 
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th¶o chØ cÇn bÊm tæ hîp phÝm  ®ã, ký tù ®Æc biÖt t−¬ng øng sÏ ®−îc chÌn lªn tµi 
liÖu. H·y lµm nh− sau: 

B−íc 1: Më hép tho¹i Symbol; 

B−íc 2: T×m ®Õn ký tù ®Æc biÖt cÇn g¸n phÝm t¾t, nhÊn chuét tr¸i lªn ký tù ®ã ®Ó 
chän: 

 
B−íc 3: NhÊn nót Shortcut Key.. , hép tho¹i Customize Keyboard xuÊt hiÖn: 

 
Khi con trá ®ang ë môc Press new shortcut key: h·y nhÊn tæ hîp phÝm nãng 

cÇn g¸n. ë vÝ dô trªn, gi¶ sö muèn g¸n tæ hîp phÝm Alt + O cho ký tù φ, h·y bÊm 
tæ hîp phÝm Alt + O, tiÕp theo bÊm nót Assign ®Ó ®¨ng ký phÝm t¾t nµy. Khi hép 
tho¹i sau ®©y xuÊt hiÖn, tøc lµ b¹n ®· g¸n phÝm t¾t Alt + O cho ký tù φ  
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PhÝm nãng ®· 
®−îc g¸n !

C¸ch sö dông: 

Sau khi ®· thiÕt lËp tæ hîp phÝm t¾t cho ký tù φ, ®Ó chÌn ký tù nµy lªn tµi liÖu b¹n 
kh«ng cÇn quay l¹i tÝnh n¨ng Insert Symbol n÷a, mµ chØ cÇn nhÊn tæ hîp phÝm Alt 
+ O. Ký tù φ sÏ ®−îc chÌn vµo vÞ trÝ mµ con trá ®ang chän. 

1.10.3 G¸n tõ viÕt t¾t cho ký tù ®Æc biÖt 

Ngoµi viÖc g¸n tæ hîp phÝm nãng cho mét ký tù ®Æc biÖt, ta cßn cã thÓ g¸n tæ 
hîp ký tù thay cho ký tù ®Æc biÖt th«ng qua tÝnh n¨ng AutoCorrect. 

VÝ dô, ®Ó chÌn ký tù ®Æc biÖt φ b¹n cã thÓ g¸n nã bëi tæ hîp ký tù fi, c¸ch lµm 
nh− sau: 

B−íc 1: Khëi ®éng tÝnh n¨ng Insert Symbol; 

B−íc 2: T×m ®Õn ký tù ®Æc biÖt cÇn g¸n phÝm t¾t, nhÊn chuét tr¸i lªn ký tù ®ã ®Ó 
chän: 

 
B−íc 3: NhÊn chuét lªn nót AutoCorrect, hép tho¹i AutoCorrect xuÊt hiÖn: 
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Gâ tõ cÇn g¸n 
vµo ®©y ! 

H·y gâ vµo tæ hîp ký tù th−êng cÇn g¸n cho ký tù ®Æc biÖt nµy vµo môc 
Replace. ë vÝ dô nµy, muèn g¸n tæ hîp ký tù fi cho ký tù ®Æc biÖt φ, h·y gâ fi vµo 
môc Replace; 

B−íc 4: nhÊn nót Add ®Ó ®ång ý cho viÖc g¸n võa råi. Cuèi cïng nhÊn Ok ®Ó 
®ãng hép tho¹i. 

C¸ch sö dông: 

Gi¶ sö b¹n ®· thiÕt lËp fi cho ký tù φ nh− trªn, nÕu ph¶i gâ biÓu thøc:  

φ = 2n+1 chØ cÇn gâ fi = 2n+1 

C©u hái vµ bµi tËp Ch−¬ng 1 

C¸c c©u hái kiÓm tra lý thuyÕt: 

1. H·y nªu nh÷ng kh¶ n¨ng mµ phÇn mÒm Microsoft Word cã thÓ lµm ®−îc 
cho c«ng viÖc v¨n phßng mµ b¹n ®−îc biÕt? 

2. Ph©n biÖt sù kh¸c nhau gi÷a hai kh¸i niÖm: nhËp v¨n b¶n vµ so¹n th¶o v¨n 
b¶n? 

3. Ph©n biÖt sù kh¸c nhau gi÷a hai kh¸i niÖm v¨n b¶n vµ tµi liÖu? 

4. Th«ng th−êng tÖp v¨n b¶n Word cã phÇn më réng lµ g×? 

5. ThÕ nµo lµ mét khèi v¨n b¶n? Nªu c¸c thao t¸c cÇn thiÕt ®Ó cã thÓ di 
chuyÓn mét khèi ®Õn vÞ trÝ kh¸c, ®Ó sao chÐp mét khèi t−¬ng tù ®Õn vÞ trÝ 
kh¸c? 

6. Cã thÓ sö dông phÝm t¾t ®Ó më hép tho¹i chän ph«ng ch÷ ®−îc kh«ng? 
NÕu ®−îc, ®ã lµ tæ hîp nh÷ng phÝm g×? 

7. Nªu c¸c tæ hîp phÝm t¾t cÇn thiÕt ®Ó: thiÕt lËp ch÷ bÐo, thiÕt lËp ch÷ 
nghiªng, ch÷ cã g¹ch ch©n? 

8. ThÕ nµo lµ mét ®o¹n v¨n b¶n? Mét ®o¹n v¨n b¶n cã thÓ n»m trªn nhiÒu 
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trang v¨n b¶n ®−îc kh«ng? NÕu ®−îc th× trong tr−êng hîp nµo? 

Bµi tËp thùc hµnh 

Gâ c¸c ®o¹n v¨n b¶n sau: 

Bµi tËp 1: 

HÖ thèng m¹ng m¸y tÝnh d¹y häc AVNET ®−îc c«ng ty SCC triÓn khai tõ 
gi÷a n¨m 1996 trong c¸c tr−êng ®¹i häc vµ trung häc còng nh− c¸c trung t©m tin 
häc - ngo¹i ng÷ ®· mang l¹i nhiÒu hiÖu qu¶ thiÕt thùc cho viÖc d¹y vµ häc. 
AVNET ®· ®−îc ®«ng ®¶o ng−êi sö dông hoan nghªnh v× tÝnh th©n thiÖn vµ hiÖn 
®¹i. AVNET xøng ®¸ng lµ mét hÖ ®iÒu hµnh líp häc v× trªn nÒn cña AVNET 
thÇy gi¸o cã thÓ qu¶n lý toµn diÖn líp häc ®ång thêi d¹y vµ kiÓm tra nhiÒu m«n 
häc kh¸c nhau. 

Bµi tËp 2: 

Trong sè c¸c ch−¬ng tr×nh ph¸t triÓn kinh tÕ, x· héi Thñ ®« ®Õn n¨m 2010 cã dù 
¸n tu bæ vµ t«n t¹o khu di tÝch V¨n MiÕu - Quèc Tö Gi¸m, n¬i ®−îc coi lµ biÓu 
t−îng cña v¨n ho¸ ViÖt Nam. ViÖc trïng tu, t«n t¹o V¨n MiÕu - Quèc Tö Gi¸m 
lµ mét trong nh÷ng viÖc ®−îc quan t©m cña Hµ Néi chuÈn bÞ tiÕn tíi kû niÖm 
1000 Th¨ng Long. 

N¨m 1991, sau khi ®−îc Bé V¨n ho¸ - Th«ng tin phª duyÖt, Dù ¸n b¶o tån, tu 
bæ, t«n t¹o vµ khai th¸c du lÞch V¨n MiÕu - Quèc Tö Gi¸m ®· tiÕn hµnh. Nhµ b¶o 
qu¶n 82 bia tiÕn sÜ ®−îc x©y dùng b»ng sè tiÒn 70.000USD, t¹i B¸i §−êng trang 
nghiªm, cæ kÝnh, th−êng xuyªn cã c¸c ho¹t ®éng truyÒn thèng; kû niÖm ngµy 
sinh cña c¸c danh nh©n, lÔ d©ng h−¬ng, r−íc kiÖu vµo dÞp TÕt Nguyªn ®¸n, V¨n 
MiÕu - Quèc Tö Gi¸m ®· ®ãn 920 ngh×n l−ît kh¸c du lÞch trong ®ã cã 550 ngh×n 
l−ît kh¸ch quèc tÕ ... 

Víi diÖn tÝch h¬n 54.000m2 ë trung t©m thµnh phè v× thÕ c¸c ho¹t ®éng v¨n ho¸, 
nghÖ thuËt d©n téc lín th−êng ®−îc tæ chøc t¹i ®©y. Cã ®−îc kh«ng gian vµ trang 
thiÕt bÞ thÝch hîp, ®Çy ®ñ, khu di tÝch V¨n MiÕu - Quèc Tö Gi¸m sÏ lµ n¬i l−u 
danh danh nh©n v¨n ho¸ cËn, hiÖn ®¹i víi néi dung vµ h×nh thøc thÝch hîp, tr−ng 
bµy cã tÝnh chÊt b¶o tµng vÒ lÞch sö häc hµnh, thi cö cña ViÖt nam, tæ chøc c¸c 
cuéc héi th¶o khoa häc, kû niÖm danh nh©n v¨n ho¸, trao tÆng häc hµm, häc vÞ 
vµ nh÷ng danh hiÖu cao quý cña Nhµ n−íc cho c¸c nhµ khoa häc ®Ó tiÕp nèi 
truyÒn thèng hiÕu häc, träng dông nh©n tµi cña d©n téc 

 

 Bµi tËp 3: Thùc hiÖn so¹n th¶o vµ ®Þnh d¹ng theo mÉu sau: 

§Þnh  d¹ng 
Font ch÷:  

- §¸nh dÊu khèi v¨n b¶n 

- Chän Format > Font > x¸c ®Þnh  chi tiÕt c¸c thuéc tÝnh (font ch÷,cì, mµu...) 

   HoÆc cã thÓ chän tõng thuéc tÝnh trªn thanh c«ng cô 

T¹o ch÷ c¸i  ®Çu dßng:  
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- §¸nh dÊu ch÷ c¸i cÇn trang trÝ 

- Chän Format > Drop Cap.. > x¸c ®Þnh kiÓu trang trÝ, sè dßng, font ch÷... 

 

Bµi tËp 4 :Thùc hiÖn t¹o c¸c Bullet vµ Nubering sau ®©y lªn tµi liÖu: 

1. §Ó cã thÓ häc tËp tèt Tin häc b¹n ph¶i: 

- Giái tiÕng Anh, ®Æc biÕt lµ kh¶ n¨ng ®äc hiÓu tµi liÖu tiÕng Anh; 

- Ham häc häc hái, ®Æc biÕt lµ së thÝch t×m tßi vµ kh¸m ph¸ bÝ Èn; 

- Cã kÕ ho¹ch vµ  kû luËt häc tËp tèt; 

- ChÞu khã giao l−u víi c¸c b¹n cïng líp, cïng së thÝch tin häc, ®Æc biÖt giao 
l−u víi c¸c diÔn ®µn tin häc trªn m¹ng Internet; 

- Cuèi cïng, b¹n h·y lu«n cëi më tÊm lßng ®Ó tù söa m×nh, ®Ó cïng häc hái. 
NiÒm vui sÏ ®−a b¹n ®Õn nh÷ng th¾ng lîi ! 

2. Quan ®iÓm cña b¹n nh− thÕ nµo ®Ó häc tèt m«n Tin häc? 

- ………………………………………………….. 

- ………………………………………………….. 

Bµi tËp 5: So¹n th¶o c¸c c«ng thøc sau: 
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Bµi tËp 6:  Gâ vµo ®o¹n v¨n b¶n vµ chia thµnh 2 cét nh− sau: 

 

 Trong sè c¸c ch−¬ng tr×nh ph¸t triÓn 
kinh tÕ, x· héi Thñ ®« ®Õn n¨m 2010 cã 

dù ¸n tu bæ vµ t«n t¹o khu di tÝch V¨n MiÕu 
- Quèc Tö Gi¸m, n¬i ®−îc coi lµ biÓu t−îng 

cña v¨n ho¸ ViÖt Nam. ViÖc trïng tu, t«n 
t¹o V¨n MiÕu - Quèc Tö Gi¸m lµ mét 
trong nh÷ng viÖc ®−îc quan t©m cña Hµ 
Néi chuÈn bÞ tiÕn tíi kû niÖm 1000 Th¨ng 
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Long. 

¨m 1991, sau khi ®−îc Bé V¨n ho¸ - 
Th«ng tin phª duyÖt, dù ¸n b¶o tån, tu 

bæ, t«n t¹o vµ khai th¸c du lÞch V¨n MiÕu - 
Quèc Tö Gi¸m ®· tiÕn hµnh. Nhµ b¶o qu¶n 
82 bia tiÕn sÜ ®−îc x©y dùng b»ng sè tiÒn 
70.000USD, t¹i B¸i §−êng trang nghiªm, 
cæ kÝnh,  th−êng xuyªn cã c¸c ho¹t ®éng 
truyÒn thèng; kû niÖm ngµy sinh cña c¸c 
danh nh©n, lÔ d©ng h−¬ng, r−íc kiÖu vµo 
dÞp TÕt Nguyªn ®¸n, V¨n MiÕu - Quèc Tö 
Gi¸m ®· ®ãn 920 ngh×n l−ît kh¸c du lÞch 
trong ®ã cã 550 ngh×n l−ît kh¸ch quèc tÕ ... 

íi diÖn tÝch h¬n 54.000m2 ë trung t©m 
thµnh phè v× thÕ c¸c ho¹t ®éng v¨n 

ho¸, nghÖ thuËt d©n téc lín th−êng ®−îc 
tæ chøc t¹i ®©y. Cã ®−îc kh«ng gian vµ 
trang thiÕt bÞ thÝch hîp, ®Çy ®ñ, khu di 
tÝch V¨n MiÕu - Quèc Tö Gi¸m sÏ lµ n¬i 
l−u danh danh nh©n v¨n ho¸ cËn, hiÖn ®¹i 
víi néi dung vµ h×nh thøc thÝch hîp, tr−ng 
bµy cã tÝnh chÊt b¶o tµng vÒ lÞch sö häc 
hµnh, thi cö cña ViÖt nam, tæ chøc c¸c 
cuéc héi th¶o khoa häc, kû niÖm danh 
nh©n v¨n ho¸, trao tÆng häc hµm, häc vÞ 
vµ nh÷ng danh hiÖu cao quý cña Nhµ 
n−íc cho c¸c nhµ khoa häc ®Ó tiÕp nèi 
truyÒn thèng hiÕu häc, träng dông nh©n 
tµi cña d©n téc. 

N 

 
V 

Bµi tËp 7:  So¹n th¶o c¸c mÉu sau: 

∆ = b2 - 4ac 

S = 2πr2 

B¶n quyÒn cña C«ng ty T&M 2002-2003©
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Ch−¬ng 2:  

b¶ng biÓu 
 

2.1 T¹o cÊu tróc b¶ng 

2.1.1 ChÌn b¶ng míi 

C¸ch 1: Sö dông môc chän Insert Table 

§Ó chÌn mét b¶ng míi lªn tµi liÖu, më môc chän: Table | Insert | Table… Hép 
tho¹i Insert Table xuÊt hiÖn: 

 
H·y ®iÒn th«ng tin vÒ cÊu tróc b¶ng míi lªn hép tho¹i nµy: 

- Môc Table size: cho phÐp thiÕt lËp sè cét (Columns) vµ sè dßng (Rows) cho 
b¶ng: 

- Gâ sè cét cña b¶ng vµo môc: Number of columns: 

- Gâ sè dßng cña b¶ng vµo môc Number of rows: 

- Môc AutoFit behavior: thiÕt lËp mét sè c¸c thuéc tÝnh tù ®éng c¨n chØnh: 

- Fixed column with: sÏ cè ®Þnh chiÒu réng cña mçi cét lµ: Auto – tù ®éng c¨n 
chØnh chiÓu réng cho cét; hoÆc b¹n gâ vµo ®é réng cña mçi cét vµo môc nµy (tèt 
nhÊt chän Auto, v× b¹n cã thÓ c¨n chØnh ®é réng cña c¸c cét sau nµy); 

- AutoFit contents: tù ®éng ®iÒu chØnh ®é réng c¸c cét khÝt víi d÷ liÖu trong cét 
Êy; 

- AutoFit window: tù ®éng ®iÒu chØnh ®é réng c¸c cét trong b¶ng sao cho b¶ng 
cã chiÒu réng võa khÝt chiÒu réng trang v¨n b¶n. 

Nªn chän kiÓu Auto cña môc Fixed column with: 

- Nót Auto format cho phÐp b¹n chän lùa ®Þnh d¹ng cña b¶ng sÏ t¹o theo mét sè 
mÉu b¶ng ®· cã s½n nh− lµ: 

 
41



 
H·y chän mét kiÓu ®Þnh d¹ng ë danh s¸ch Formats: (nÕu b¹n c¶m thÊy −ng ý). 

Ng−îc l¹i cã thÓ bÊm Cancel ®Ó bá qua b−íc nµy. 

- NÕu chän môc , th× th«ng tin vÒ cÊu tróc b¶ng hiÖn t¹i sÏ lµ 
ngÇm ®Þnh cho c¸c b¶ng t¹o míi sau nµy. 

- Cuèi cïng nhÊn OK ®Ó chÌn b¶ng lªn tµi liÖu: 

C¸ch 2: Sö dông thanh c«ng cô: B¹n cã thÓ nhÊn nót Insert Table trªn thanh c«ng 
cô Standard ®Ó chÌn mét b¶ng lªn tµi liÖu. B¶ng chän sau ®©y xuÊt hiÖn, cho phÐp 
chän sè dßng vµ sè cét cña b¶ng: 

 
H×nh trªn chän mét b¶ng míi víi 3 dßng vµ 3 cét. Sau khi thùc hiÖn lÖnh trªn, sÏ 

thu ®−îc kÕt qu¶ nh− sau: 

   

   

2.1.2 Söa cÊu tróc b¶ng 

Sau khi ®· chÌn mét b¶ng lªn tµi liÖu, b¹n vÉn cã thÓ thay ®æi cÊu tróc b¼ng b»ng 
c¸ch: chÌn thªm hoÆc xo¸ ®i c¸c cét, c¸c dßng cña b¶ng. 

Gi¶ sö b¹n ®· chÌn vµ nhËp d÷ liÖu cho b¶ng nh− sau: 

STT Hä tªn Ngµy sinh 

1 NguyÔn V¨n Nam 12/3/1983 

2 TrÇn ThÞ B×nh 22/1/1981 

Chän kiÓu ®Þnh 
d¹ng ë ®©y! 
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B©y giê muèn chÌn thªm mét cét Giíi tÝnh vµo sau cét Hä tªn. B¹n cã thÓ lµm nh− 
sau: 

B−íc 1: §Æt ®iÓm trá lªn cét Hä tªn; 

B−íc 2: Më môc chän Table | Insert | Columns to the right (tøc lµ chÌn thªm mét 
cét vµo bªn ph¶i cét ®ang chän). Mét cét míi ®−îc chÌn vµo bªn ph¶i cét Hä tªn: 

STT Hä tªn  Ngµy sinh 

1 NguyÔn V¨n Nam  12/3/1983 

2 TrÇn ThÞ B×nh  22/1/1981 

 H·y thùc hiÖn nhËp d÷ liÖu cho cét Giíi tÝnh nµy: 

STT Hä tªn Giíi tÝnh Ngµy sinh 

1 NguyÔn V¨n Nam Nam 12/3/1983 

2 TrÇn ThÞ B×nh N÷ 22/1/1981 

Muèn chÌn thªm dßng vµo cuèi b¶ng ®Ó nhËp thªm d÷ liÖu, lµm nh− sau: 

B−íc 1: §Æt ®iÓm trá vµo dßng cuèi cïng (TrÇn ThÞ B×nh); 

B−íc 2: Më môc chän: Table | Insert | Row below (tøc lµ chÌn thªm dßng míi 
vµo phÝa d−êi dßng ®ang chän). Mét dßng míi ®−îc chÌn vµo b¶ng. 

STT Hä tªn Giíi tÝnh Ngµy sinh 

1 NguyÔn V¨n Nam Nam 12/3/1983 

2 TrÇn ThÞ B×nh N÷ 22/1/1981 

    

Ngoµi ra, khi sö dông c¸c thao t¸c vÒ con trá trùc tiÕp lªn b¶ng b¹n cã thÓ ®¬n gi¶n 
khi thùc hiÖn viÖc chØnh söa cÊu tróc b¶ng. 

§Ó chÌn thªm (c¸c) cét míi vµo b¶ng, b¹n lµm nh− sau: 

B−íc 1: Chän (b«i ®en) toµn bé cét muèn chÌn: gi¶ sö muèn chÌn thªm 1 cét vµo 
tr−íc cét Ngµy sinh, b¹n b«i ®en toµn bé cét Ngµy sinh; 

B−íc 2: NhÊn ph¶i chuét lªn vïng b«i ®en cña b¶ng, råi më môc chän 
. Mét cét míi sÏ ®−îc chÌn vµo tr−íc cét Ngµy sinh. 

T−¬ng tù, ®Ó chÌn thªm (c¸c) dßng míi vµo b¶ng, b¹n lµm nh− sau: 

B−íc 1: Chän (b«i ®en) toµn bé dßng muèn chÌn: gi¶ sö muèn chÌn thªm 2 dßng 
lªn ®Çu b¶ng, b¹n b«i ®en toµn bé 2 dßng cã STT lµ 1 vµ 2; 

B−íc 2: NhÊn ph¶i chuét lªn vïng b«i ®en cña b¶ng, råi më môc chän 
. Hai dßng míi sÏ ®−îc chÌn lªn tr−íc hai dßng cò. 

§Ó xo¸ (c¸c) cét ra khái b¶ng, lµm nh− sau: 
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B−íc 1: Chän (b«i ®en) toµn bé c¸c cét muèn xo¸; 

B−íc 2: NhÊn ph¶i chuét lªn vïng b«i ®en cña b¶ng, råi më môc chän 
. C¸c cét ®−îc chän sÏ bÞ xo¸ ra khái b¶ng. 

§Ó xo¸ (c¸c) dßng ra khái b¶ng, lµm nh− sau: 

B−íc 1: Chän (b«i ®en) toµn bé c¸c dßng muèn xo¸; 

B−íc 2: NhÊn ph¶i chuét lªn vïng b«i ®en cña b¶ng, råi më môc chän 
. Toµn bé c¸c dßng ®· chän sÏ ®−îc xo¸ ra khái b¶ng. 

2.1.3 Trén « 

Trén « lµ thao t¸c trén nhiÒu « kÒ nhau trªn mét b¶ng l¹i thµnh mét «. XÐt vÝ dô sau: 

 

 

 

Häc kú 1 Häc kú 2 

C¸c « ®· ®−îc trén

STT Hä tªn 
HL HK HL HK 

1 NguyÒn V¨n Nam Tèt Tèt Kh¸ Kh¸ 

2 TrÇn Thanh B×nh Tèt Tèt Kh¸ Tèt 

C¸ch lµm: 

§Çu tiªn b¹n t¹o b¶ng nh− sau: 

STT Hä tªn Häc kú 
1 

 Häc 
kú 2 

 

  HL HK HL HK 

1 NguyÒn V¨n Nam Tèt Tèt Kh¸ Kh¸ 

2 TrÇn Thanh B×nh Tèt Tèt Kh¸ Tèt 

Sau ®ã lÇn l−ît trén c¸c «. vÝ dô, ®Ó trén « Hä vµ tªn: 

B−íc 1: B«i ®en 2 « cÇn trén cña « Hä tªn; 

 
B−íc 2: Më môc chän Table | Merge Cell. Khi ®ã 2 « ®· chän sÏ ®−îc trén thµnh 

mét «.  

T−¬ng tù, b¹n h·y lÇn l−ît trén c¸c « cßn l¹i. 

2.1.4 VÏ b¶ng 

Trong tr−êng hîp muèn vÏ thªm c¸c ®−êng cho b¶ng, b¹n cã thÓ sö dông chøc 
n¨ng nµy. 

H·y më thanh c«ng cô Tables and Borders, nhÊn nót Draw Table . Con chuét 
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lóc nµy chuyÓn sang h×nh chiÕc bót vÏ vµ b¹n cã thÓ dïng nã ®Ó kÎ thªm c¸c ®−êng kÎ 
cho b¶ng. 

2.2 §Þnh d¹ng b¶ng biÓu 

2.2.1 §Þnh d¹ng d÷ liÖu trong « 

ViÖc ®Þnh d¹ng ph«ng ch÷, mµu ch÷ trªn b¶ng biÓu thùc hiÖn theo nh− phÇn ®Þnh 
d¹ng ch÷ ®· tr×nh bµy ë (môc 1.2).  

§Þnh d¹ng lÒ 

B−íc 1: Chän (b«i ®en) c¸c « cÇn ®Þnh d¹ng; 

B−íc 2: Nh¸y ph¶i chuét lªn vïng b«i ®en, më môc chän   råi 
chän kiÓu lÒ muèn ®Þnh d¹ng theo b¶ng: 

 
§Þnh d¹ng h−íng v¨n b¶n 

B¹n cã thÓ ®Þnh d¹ng h−íng v¨n b¶n trong « (hiÓn thÞ theo chiÒu däc, hay chiÒu 
ngang). §Ó ®Þnh d¹ng h−íng, b¹n lµm nh− sau: 

B−íc 1: Chän « cÇn ®Þnh d¹ng h−íng; 

B−íc 2: Nh¸y ph¶i chuét lªn vïng ®· chän, më môc chän , 
hép tho¹i Text Direction xuÊt hiÖn: 

 
H·y dïng chuét nhÊn vµo h−íng muèn thiÕt lËp ë môc Orientation.  

B−íc 3: NhÊn OK ®Ó hoµn tÊt. 

2.2.2 T« nÒn, kÎ viÒn  

§Ó t« mµu nÒn hay kÎ viÒn cho mét vïng cña b¶ng, c¸ch lµm nh− sau: 

B−íc 1: Chän c¸c « (b«i ®en) cÇn t« nÒn hay ®Æt viÒn; 

B−íc 2: NhÊn ph¶i chuét lªn vïng ®· chän, më môc chän . 
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Hép tho¹i Border and Shading xuÊt hiÖn: 

 
ThÎ Border cho phÐp thiÕt lËp c¸c ®Þnh d¹ng vÒ ®−êng kÎ cña vïng lùa chän: 

- Môc Style: chän kiÓu ®−êng ®Þnh thiÕt lËp; 

- Môc Color: chän mµu cho ®−êng th¼ng; 

- Môc Width: chän ®é dµy, máng cho ®−êng; 

- Môc Setting: chän ph¹m vi ®−êng cÇn thiÕt lËp. Ngoµi ra b¹n cã thÓ chän ph¹m 
vi c¸c ®−êng cÇn thiÕt lËp ®Þnh d¹ng ë môc Preview; 

- Môc Apply to: ®Ó chän ph¹m vi c¸c « thiÕt lËp cho phï hîp: Table – sÏ thiÕt lËp 
®Þnh d¹ng nµy cho toµn bé b¶ng; Cell- chØ thiÕt lËp cho c¸c « ®· chän; 

- NhÊn Ok ®Ó kÕt thóc c«ng viÖc. 

ThÎ Shading cho phÐp thiÕt lËp c¸c ®Þnh d¹ng vÒ t« nÒn b¶ng: 

 
- Môc Fill: chän chän mµu cÇn t«. §· cã s½n mét hép víi rÊt nhiÒu mµu. B¹n cã 

thÓ nhÊn nót More Colors.. ®Ó tù chän cho m×nh nh÷ng mµu kh¸c: 

 
46



 
- Môc Apply to: ®Ó chän ph¹m vi c¸c « cÊn t« mÇu nÒn: Table – t« toµn bé b¶ng; 

Cell- chØ t« cho c¸c « ®· chän; 

- NhÊn Ok ®Ó kÕt thóc c«ng viÖc. 

2.3 TÝnh to¸n trªn b¶ng 

B¹n cã thÓ thùc hiÖn mét sè phÐp tÝnh ®¬n gi¶n trªn b¶ng cña Word. Mét khÝa c¹nh 
nµo ®Êy th× Word còng cã kh¶ n¨ng nh− mét b¶ng tÝnh ®iÖn tö (Excel), tuy nhiªn nã chØ 
xö lý ®−îc nh÷ng phÐp to¸n ®¬n gi¶n, rÊt lµ ®¬n gi¶n.  

2.3.1 TÝnh tæng 

Gi¶ sö cã mét b¶ng sè liÖu nh− sau: 

TT Hä tªn L−¬ng Phô cÊp Thùc lÜnh

1 NguyÔn Nam 507000 150000 ? 

2 TrÇn Kh¸nh 600000 150000 ? 

3 Minh Hoa 630000 200000 ? 

Tæng céng: ? ? ? 

Hµm tÝnh tæng SUM cña Word ®Ó ®iÒn gi¸ trÞ tæng vµo c¸c « cã dÊu ? 

B−íc 1: §Æt ®iÓm trá lªn « cÇn chøa gi¸ trÞ tæng. VÝ dô mét « trªn dßng Tæng céng: 

B−íc 2: Më môc chän Table | Formula.., hép tho¹i Formula xuÊt hiÖn: 
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ë môc Formula, gâ vµo c«ng thøc cÇn tÝnh. Cã 3 lo¹i c«ng thøc tÝnh tæng: 

=SUM(ABOVE) – tÝnh tæng c¸c dßng tõ trªn dßng ®Æt ®iÓm trá. C«ng thøc nµy 
®−îc ¸p dông ®Ó tÝnh tæng cho dßng Tæng céng; 

=SUM(LEFT) – tÝnh tæng cho c¸c dßng bªn tr¸i dßng ®Æt ®iÓm trá. C«ng thøc nµy 
®−îc ¸p dông tÝnh tæng cho cét Thùc lÜnh ( = L−¬ng + Phô cÊp); 

T−¬ng tù, =SUM(RIGHT) – tÝnh tæng cho c¸c dßng bªn ph¶i dßng ®Æt ®iÓm trá. 

Cuèi cïng nhÊn OK ®Ó hoµn tÊt viÖc tÝnh tæng. 

Sau khi thùc hiÖn d¸n c¸c c«ng thøc tÝnh tæng cho dßng Tæng céng, vµ cét Thùc lÜnh 
ta ®−îc b¶ng kÕt qu¶ nh− sau: 

 

TT Hä tªn L−¬ng Phô cÊp Thùc lÜnh 

1 NguyÔn Nam 507000 150000 657000 

2 TrÇn Kh¸nh 600000 150000 750000 

3 Minh Hoa 630000 200000 830000 

Tæng céng: 1737000 500000 2237000 

=SUM(LEFT)

=SUM(ABOVE)
 

2.3.2 TÝnh trung b×nh céng 

Gi¶ sö cã mét b¶ng sè liÖu nh− sau: 

TT Hä tªn §TB HK1 §TB HK2 §TB c¶ n¨m 

1 NguyÔn Nam 5.7 6.5 ? 

2 TrÇn Kh¸nh 7.6 7.4 ? 

3 Minh Hoa 7.5 8.3 ? 

§TB chung c¶ líp: ? ? ? 

Hµm tÝnh trung b×nh céng AVERAGE cña Word ®Ó ®iÒn gi¸ trÞ vµo c¸c « cã dÊu ? 

B−íc 1: §Æt ®iÓm trá lªn « cÇn tÝnh. VÝ dô mét « trªn dßng §TB c¶ n¨m: 

B−íc 2: Më môc chän Table | Formula.., hép tho¹i Formula xuÊt hiÖn: 
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ë môc Formula, gâ vµo c«ng thøc cÇn tÝnh. Cã 3 lo¹i c«ng thøc tÝnh trung b×nh céng: 

=AVERAGE(ABOVE) – tÝnh trung b×nh céng c¸c dßng tõ trªn dßng ®Æt ®iÓm 
trá. C«ng thøc nµy ®−îc ¸p dông ®Ó tÝnh gi¸ trÞ cho dßng §TB chung c¶ líp:; 

=AVERAGE(LEFT) – tÝnh trung b×nh céng cho c¸c dßng bªn tr¸i dßng ®Æt ®iÓm 
trá. C«ng thøc nµy ®−îc ¸p dông tÝnh gi¸ trÞ cho cét §TB c¶ n¨m  = (§TB HK1 + 
§TB HK2)/2; 

T−¬ng tù, =AVERAGE(RIGHT) – tÝnh trung b×nh céng cho c¸c dßng bªn ph¶i 
dßng ®Æt ®iÓm trá. 

Cuèi cïng nhÊn OK ®Ó hoµn tÊt viÖc tÝnh tæng. 

Sau khi thùc hiÖn d¸n c¸c c«ng thøc tÝnh trung b×nh céng cho dßng §TB chung c¶ 
líp:, vµ cét §TB c¶ n¨m: ta ®−îc b¶ng kÕt qu¶ nh− sau: 

TT Hä tªn §TB HK1 §TB HK2 §TB c¶ n¨m 

1 NguyÔn Nam 5.7 6.5 6.1 

2 TrÇn Kh¸nh 7.6 7.4 7.5 

3 Minh Hoa 7.5 8.3 7.9 

§TB chung c¶ líp: 6.93 7.4 7.17 

2.4 S¾p xÕp d÷ liÖu trªn b¶ng 

D÷ liÖu trªn b¶ng cã thÓ ®−îc s¾p xÕp theo mét thø tù nµo ®ã.  

Gi¶ sö cã b¶ng d÷ liÖu sau: 

TT Hä ®Öm Tªn §iÓm TB 

1 NguyÔn Quang Anh 7.5 

2 TrÇn M¹nh Hµ 8.0 

3 NguyÔn §øc B×nh 7.2 

4 NguyÔn Xu©n Th¾ng 6.5 

5 NguyÔn ThÞ Oanh 8.0 

S¾p xÕp b¶ng theo Tªn vµ Hä ®Öm 
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S¾p xÕp b¶ng theo §iÓm TB råi ®Õn Tªn 

§Æt ®iÓm trá lªn b¶ng cÇn s¾p xÕp råi më môc chän Table | Sort.., hép tho¹i Sort 
xuÊt hiÖn vµ thiÕt lËp c¸c th«ng sè cho hép tho¹i nµy nh− sau: 

 

KÕt qu¶ s¾p xÕp thu ®−îc lµ: 

TT Hä ®Öm Tªn §iÓm TB

2 TrÇn M¹nh Hµ 8.0 

5 NguyÔn ThÞ Oanh 8.0 

1 NguyÔn Quang Anh 7.5 

3 NguyÔn §øc B×nh 7.2 

4 NguyÔn Xu©n Th¾ng 6.5 

2.5 Thanh c«ng cô Tables and Borders 

Thanh c«ng cô nµy chøa c¸c tÝnh n¨ng gióp b¹n dÔ dµng thùc hiÖn nh÷ng thao t¸c xö 
lý trªn b¶ng biÓu. 

§Ó hiÓn thÞ thanh c«ng cô, kÝch ho¹t môc chän View | Toolbars | Tables and 
Borders: 

 

ý nghÜa c¸c nót trªn thanh c«ng cô nµy nh− sau: 

 : Dïng  ®Ó kÎ hoÆc ®Þnh d¹ng c¸c ®−êng; 

 : Dïng ®Ó tÈy bá ®−êng th¼ng; 

 : §Ó chän kiÓu ®−êng th¼ng; 
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 : Chän ®é ®Ëm cña ®−êng; 

 : §Þnh d¹ng mµu cho ®−êng; 

 : KÎ khung cho c¸c «; 

 : T« mÇu nÒn c¸c «; 

 : §Ó chÌn thªm b¶ng míi lªn tµi liÖu; 

 : §Ó trén c¸c « ®· chän thµnh 1 «; 

 : §Ó chia mét « thµnh nhiÒu « nhá; 

 : §Ó ®Þnh d¹ng lÒ v¨n b¶n trong «; 

 : §Ó kÝch ho¹t tÝnh n¨ng tù ®éng ®Þnh d¹ng 

 : §Þnh d¹ng h−íng v¨n b¶n trong «; 

 : S¾p xÕp gi¶m dÇn theo cét ®ang chän; 

 : S¾p xÕp t¨ng dÇn theo cét ®ang chän; 

 : TÝnh tæng ®¬n gi¶n. 

C©u hái vµ bµi tËp Ch−¬ng 2 

Tr¶ lêi c¸c c©u hái kiÓm tra lý thuyÕt sau: 

1. Cã mÊy ph−¬ng ph¸p ®Ó chÌn mét b¶ng míi lªn tµi liÖu Word? H·y liÖt kª 
tªn tõng ph−¬ng ph¸p vµ cho biÕt nh÷ng −u ®iÓm cña tõng ph−¬ng ph¸p nµy? 

2. Trén nhiÒu « thµnh mét « ng−êi ta sö dông tÝnh n¨ng Merge trªn thanh c«ng 
cô Table. NÕu bá trén mét « ®Ó vÒ tr¹ng th¸i c¸c « nhá ban ®Çu ph¶i lµm thÕ 
nµo? 

 

 Thùc hiÖn chÕ b¶n c¸c b¶ng biÓu theo yªu cÇu sau ®©y:  

 

1. 

 ADVERTISEMENT 
 

TRADING  FOR LEASE FOR SALE 
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BUSINESS FORMS 
MFT.CO. 

112 Ng Thi Minh Khai St. 

Dist.3, Ho Chi Minh City 

Fax: (848) 8225133 

Tel: 8225851 

 

 Computer  forms with 
1 to 5 ply NCR 
carbonless 

 Business forms 
printing 

 ROOM FOR RENT 

Add: 327 Le Van Sy St.  

Ward 2, Tan Binh Dist. 

(2km from the Airport) 

• Well-equipped room. 
Include air-con., water 
heater, IDD, phone, fax

1985 BMW 3181 

2doors, dark green, in 
good condition 

Price: 9,400 USD 

 

 

 

Pls. Contact: 

Mr.F.Nonnenmacher 

 

2. 

Sè ®iÓm kiÓm  
tra M«n häc 

Sè 
tiÕt 

HÖ sè 1 HÖ sè 2

HÖ sè 
m«n häc

Ghi chó 

Häc kú I:     

1. Tin häc §¹i c−¬ng 30 1 1 1 
2. §¸nh m¸y vi tÝnh 45 1 2 2 
3. ThuËt to¸n LT 75 1 2 3 
4. Winword 45 1 2 2 
5. Excel 45 1 2 2 

Céng : ? ? ? ? 

Häc Kú II:     
6. Access 45 1 2 2 
7. Visual Basic 45 1 2 2 
8. M¹ng MT 60 1 2 3 
9. Internet-Web 60 1 2 3 

Céng : ? ? ? ? 

1. Cuèi häc kú I 
häc viªn ph¶i 
lµm Bµi tËp lín 
tÝnh 45 tiÕt (cã 
gi¸o viªn h−íng 
dÉn). 
 
2. Cuèi  häc kú 
II häc viªn ph¶i 
lµm Bµi tËp tèt 
nghiÖp víi thêi 
gian 2 th¸ng.  

 

3. 

M· 
thuèc 

Tªn thuèc §¬n 
gi¸ 

Qui c¸ch M· thuèc Sè l−îng 
b¸n 

A1 Vitamin B1 15000 Lo¹i100 viªn A2 20

A2 Vitamin C 20000 VØ 20 viªn C2 11

C2 Clorpheniramin 30000 Lo¹i100 viªn C3 30

C3 Ampicilin 6000 VØ 10 viªn A1 100

 

4. 

Tr−êng PTTH Hoµng DiÖu 

KÕt qu¶ thi häc kú I 
N¨m häc 2001 – 2002 

§iÓm thi S 
T
T 

Hä vµ tªn Ngµy sinh
To¸n Lý Ho¸ 

Tæng 
®iÓm 

1 Tr−¬ng ThÞ Chi 02/10/80 8 7 9  
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2 NguyÔn Ph−íc C−êng 04/09/80 5 7 6  

3 NguyÔn §øc Duy 16/01/79 8 9 5  

4 NguyÔn Vò Dòng 15/05/80 7 6 8  

5 Ph¹m Cao §¨ng 25/02/78 9 9 8  

6 Ph¹m BÝch Loan 04/08/80 7 5 6  

Yªu cÇu:  1. So¹n th¶o vµ ®Þnh d¹ng b¶ng ®iÓm theo mÉu trªn; 

2. TÝnh cét tæng ®iÓm = To¸n + Lý + Ho¸   (Dïng Formula). 

3. Thùc hiÖn s¾p xÕp d÷ liÖu trong b¶ng theo chiÒu t¨ng dÇn (Theo cét tæng ®iÓm). 
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Ch−¬ng 3:  

§å ho¹ 
 

 

Ngoµi nh÷ng kh¶ n¨ng vÒ so¹n th¶o vµ ®Þnh d¹ng v¨n b¶n, kh¶ n¨ng ®å ho¹ cña Word 
còng rÊt m¹nh. Trong ch−¬ng nµy, chóng ta sÏ ®−îc t×m hiÓu vµ tiÕp cËn nh÷ng kü thuËt 
vÏ h×nh còng nh− xö lý mét sè khèi h×nh ho¹ trùc tiÕp trªn Word. 

§Ó lµm viÖc víi m«i tr−êng ®å ho¹ trªn Word, b¹n ph¶i sö dông ®Õn thanh c«ng cô 
Drawing.  

 
NÕu ch−a nh×n thÊy thanh c«ng cô nµy trªn mµn h×nh cã thÓ më nã b»ng c¸ch kÝch 

ho¹t môc chän View | Toolbar | Drawing 

3.1 VÏ khèi h×nh ®¬n gi¶n 

3.1.1 Sö dông c¸c mÉu h×nh ®¬n gi¶n 

B¹n cã thÓ vÏ mét sè khèi h×nh rÊt ®¬n gi¶n lªn tµi liÖu cña m×nh b»ng c¸ch sö dông 
mét sè nót vÏ h×nh trªn thanh c«ng cô Drawing nh−: 

 : VÏ h×nh ch÷ nhËt; 

 : VÏ h×nh « val, h×nh trßn; 

 : T¹o « h×nh ch÷ nhËt chøa v¨n b¶n; 

 : VÏ ®−êng th¼ng; 

 : VÏ mòi tªn. 

 

C¸ch vÏ h×nh nh− sau: 

B−íc 1: Dïng chuét nh¾p lªn nót chøa h×nh cÇn vÏ;  

B−íc 2: Dïng chuét vÏ h×nh ®ã lªn tµi liÖu. 

 

D−íi ®©y lµ mét h×nh ch÷ nhËt võa ®−îc vÏ: 

 

§iÓm ®¸nh dÊu

Khi con trá chuyÓn h×nh mòi tªn, b¹n 
cã thÓ thay ®æi kÝch cì h×nh vÏ. 
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Chóng ta ®Ó ý, trªn khèi h×nh th−êng cã c¸c ®iÓm ®¸nh dÊu , nÕu ®Æt con trá 
chuét vµo nh÷ng ®iÓm ®¸nh dÊu nµy b¹n cã thÓ co d·n ®−îc kÝch cì cña h×nh vÏ 
b»ng c¸ch kÐo rª chuét. 

3.1.2 Sö dông c¸c khèi h×nh AutoShape 

Ngoµi c¸c khèi h×nh ®¬n gi¶n mµ b¹n thÊy trªn thanh c«ng cô Drawing, nót 
AutoShapes cßn cung cÊp rÊt nhiÒu c¸c mÉu h×nh vÏ ®a d¹ng. 

§Ó sö dông mét mÉu h×nh trong AutoShapes, B¹n lµm nh− sau: 

NhÊp nót AutoShapes trªn thanh c«ng cô Drawing: 

 
Danh s¸ch c¸c mÉu h×nh ®−îc liÖt kª ra, b¹n cã thÓ chän vµ vÏ chóng lªn tµi liÖu 

nh− ®· h−íng dÉn ë trªn. 

3.1.3 §Þnh d¹ng h×nh vÏ 

Thanh c«ng cô Drawing cung cÊp nhiÒu nót tÝnh n¨ng gióp b¹n ®Þnh d¹ng trªn 
khèi h×nh vÏ: 

 : Nót nµy dïng ®Ó chän ®èi t−îng cÇn ®Þnh d¹ng; 

 : Chän ®é dÇy máng cña ®−êng; 

 : Chän kiÓu nÐt cña ®−êng; 

 : Chän chiÒu mòi tªn (khi vÏ mòi tªn trªn h×nh); 

 : Chän mµu s¾c cho ®−êng; 

 : T« mÇu nÒn cho mét h×nh kÝn; 

 : Chän mµu s¾c cho ch÷; 

 : T¹o bãng cho h×nh vÏ; 

 : Chän khèi h×nh trong kh«ng gian 3 chiÒu (3D); 

 : §Ó quay h×nh vÏ. 
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3.1.4 Lµm viÖc tËp hîp c¸c h×nh vÏ 

Mét khèi h×nh vÏ th−êng bao gåm tæ hîp nhiÒu h×nh vÏ ghÐp l¹i. TÝnh n¨ng nhãm 
(Group) gióp gom nhãm  c¸c h×nh nhá cÇn thiÕt thµnh mét khèi h×nh lín. §iÒu nµy rÊt 
thu©n lîi cho viÖc sö dông còng nh− qu¶n lý khèi h×nh vÏ trªn tµi liÖu. 

a. Gom nhãm (Group) 

§Ó gom nhãm mét tËp hîp c¸c h×nh, b¹n lµm nh− sau: 

B−íc 1: Sö dông nót  trªn thanh c«ng cô Drawing, kÕt hîp viÖc gi÷ phÝm Shift. 
Råi lÇn l−ît chän c¸c h×nh nhá cÇn nhãm l¹i (b»ng c¸ch nhÊn chuét lªn tõng h×nh) 
hoÆc dïng chuét khoanh vïng bao quanh khèi h×nh cÇn nhãm; 

B−íc 2: KÝch ho¹t tÝnh n¨ng nhãm b»ng c¸ch: nhÊn nót Draw trªn thanh c«ng cô 
Drawing, chän Group  . TÊt c¶ c¸c h×nh nhá ®· chän sÏ ®−îc 
nhãm l¹i thµnh mét h×nh lín. 

b. Gì nhãm (Ungroup) 

Trong tr−êng hîp muèn söa l¹i tõng cÊu tróc h×nh nhá trªn khèi ®· nhãm, b¹n ph¶i 
thùc hiÖn gì nhãm. C¸ch lµm nh− sau: 

B−íc 1: Sö dông nót  ®Ó chän h×nh (lín) cÇn gì nhãm; 

B−íc 2: KÝch ho¹t tÝnh n¨ng gì nhãm b»ng c¸ch: nhÊn nót Draw trªn thanh c«ng 
cô Drawing, chän Ungroup  . TÊt c¶ c¸c h×nh nhá trong h×nh 
lín sÏ ®−îc trë l¹i tr¹ng th¸i nh− tr−íc lóc bÞ nhãm.  

§Õn ®©y, b¹n cã thÓ hiÖu chØnh tõng h×nh nhá theo ý muèn. 

c. Nhãm l¹i (Regroup) 

Sau khi gì nhãm vµ chØnh söa xong, muèn nhãm l¹i thµnh khèi h×nh nh− ban ®Çu 
b¹n kh«ng cÇn ph¶i thùc hiÖn l¹i tÝnh n¨ng nhãm, mµ chØ cÇn gäi tÝnh n¨ng nhãm l¹i 
(Regroup). C¸ch lµm nh− sau; 

B−íc 1: Sö dông nót  ®Ó chän bÊt kú mét h×nh nhá nµo trong sè c¸c h×nh nhá 
cÇn nhãm l¹i; 

B−íc 2: KÝch ho¹t tÝnh n¨ng nhãm l¹i b»ng c¸ch: nhÊn nót Draw trªn thanh c«ng 
cô Drawing, chän Regroup . C¸c h×nh nhá sÏ ®−îc tù ®éng 
nhãm l¹i nh− viÖc nhãm ®· lµm ban ®Çu. 

3.2 T¹o ch÷ nghÖ thuËt 

3.2.1 ChÌn ch÷ nghÖ thuËt 

§Ó chÌn mét dßng ch÷ nghÖ thuËt (Word Art) lªn tµi liÖu, b¹n lµm nh− sau: 

B−íc 1: NhÊp nót Insert WordArt  trªn thanh céng cô Drawing, hép tho¹i 
WordArt Gallery xuÊt hiÖn: 
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NhÊn chuét lªn « cã 
mÉu ch÷ cÇn t¹o! 

B−íc 2: Dïng chuét chän kiÓu ch÷ nghÖ thuËt cÇn t¹o, b»ng c¸ch nhÊn vµo « chøa 
kiÓu ch÷ mµ b¹n muèn; 

B−íc 3: Gâ vµo dßng ch÷ b¹n muèn t¹o ë môc Text trªn hép tho¹i Edit WordArt 
Text: 

 
B¹n cã thÓ chän ph«ng ch÷, kiÓu ch÷, cì ch÷ cho ®o¹n v¨n b¶n nµy.  

B−íc 4: NhÊn Ok ®Ó kÕt thóc. Dßng ch÷ nghÖ thuËt sÏ ®−îc hiÖn lªn tµi liÖu: 

 

3.2.2 HiÖu chØnh 

B¹n cã thÓ thùc hiÖn c¸c phÐp hiÖu chØnh cho dßng ch÷ nghÖ thuËt ®· t¹o ®−îc bëi 
thanh c«ng cô WordArt: 

 

ý nghÜa c¸c nót lÖnh trªn thanh c«ng cô nµy nh− sau: 
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 : §Ó chÌn thªm dßng ch÷ nghÖ thuËt kh¸c; 

 : §Ó söa néi dung v¨n b¶n cña dßng ch÷; 

 : §Ó chän l¹i kiÓu ch÷ nghÖ thuËt; 

 : §Ó ®Þnh d¹ng mµu cho khèi ch÷; 

 : §Ó chän mét sè kiÓu ch÷ nghÖ thuËt kh¸c; 

 : §Ó quay khèi ch÷; 

 : §Ó xoay h−íng v¨n b¶n; 

 : §Ó ®Þnh d¹ng lÒ v¨n b¶n trong khèi h×nh; 

 : §Ó ®iÒu chØnh kho¶ng c¸ch gi÷a c¸c ký tù. 

3.3 ChÌn ¶nh lªn tµi liÖu 

 B¹n cã thÓ chÌn ®−îc h×nh ¶nh tõ nhiÒu nguån kh¸c nhau trªn m¸y tÝnh lªn tµi liÖu 
Word nh−: ¶nh tõ mét tÖp tin; ¶nh tõ th− viÖn ¶nh Clip Gallery hoÆc ¶nh tõ mµn h×nh 
m¸y tÝnh. 

3.5.1 ChÌn ¶nh tõ mét tÖp tin 

§Ó chÌn ¶nh tõ mét tÖp tin lªn tµi liÖu, b¹n lµm nh− sau: 

Më môc chän Insert | Picture | From file, hép tho¹i Insert Picture xuÊt hiÖn cho 
phÐp b¹n t×m tÖp ¶nh  cÇn chÌn lªn tµi liÖu: 

 
H·y chän tÖp ¶nh, råi nhÊn nót Insert ®Ó hoµn tÊt. 
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¶nh tõ tÖp ®· chän ®−îc chÌn lªn tµi liÖu cïng thanh c«ng cô Picture gióp b¹n 
thùc hiÖn c¸c phÐp ®Þnh d¹ng, hiÖu chØnh ¶nh. ý nghÜa c¸c nót lÖnh trªn thanh c«ng 
cô Picture nh− sau: 

 : §Ó chÌn thªm ¶nh tõ tÖp tin kh¸c; 

 : §Þnh d¹ng mµu cho ¶nh; 

   : §iÒu chØnh ®é t−¬ng ph¶n cho ¶nh; 

   : §iÒu chØnh ®é s¸ng, tèi cña ¶nh; 

 : Dïng ®Ó c¾t ¶nh; 

 : Chän kiÓu ®−êng viÒn cho ¶nh; 

 : BËt c¸c tÝnh n¨ng ®Þnh d¹ng ®èi t−îng ¶nh; 

 : 
ThiÕt lËp thuéc tÝnh xuyªn thÊu (Transparent) 
¶nh; 

 : Huû bá c¸c ®Þnh d¹ng ¶nh. 

Trong tr−êng hîp kh«ng xuÊt hiÖn thanh c«ng cô Picture, b¹n cã thÓ gäi môc chän 
View | Toolbar | Picture ®Ó hiÓn thÞ nã. 

3.5.2 ChÌn ¶nh tõ th− viÖn ¶nh Clip Gallery 

§Ó chÌn ¶nh tõ th− viÖn ¶nh Clip Gallery lªn tµi liÖu, b¹n lµm nh− sau: 

Më môc chän Insert | Picture | Clip Art, hép tho¹i Insert ClipArt xuÊt hiÖn 
cho phÐp t×m h×nh ¶nh  cÇn chÌn lªn tµi liÖu: 
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¶nh ®−îc l−u trong c¸c môc (Categories), b¹n ph¶i më c¸c môc nµy ra ®Ó t×m 
¶nh.  

Nót Back  vµ Forward  gióp b¹n quay vÒ thao t¸c tr−íc hoÆc thao t¸c 
sau trong khi dÞch chuyÓn gi÷a c¸c Categories.  

Sau khi t×m ®−îc ¶nh, nhÊn chuét lªn ¶nh t×m ®−îc, mét thùc ®¬n xuÊt hiÖn cho 
phÐp b¹n chän c¸c t×nh huèng xö lý ®èi víi ¶nh ®ang chän: 

 

NhÊn lªn ®©y ®Ó chÌn 
¶nh lªn tµi liÖu! 

H·y nhÊn nót Insert  ®Ó chÌn ¶nh lªn tµi liÖu. 

Sau khi ¶nh ®−îc chÌn lªn tµi liÖu, b¹n cã thÓ sö dông thanh c«ng cô Picture ®Ó 
®Þnh d¹ng ¶nh nh− ®· h−íng dÉn ë trªn. 

3.5.3 Chôp ¶nh tõ mµn h×nh vµo tµi liÖu 

Trong qu¸ tr×nh chÕ b¶n tµi liÖu, nhiÒu khi chóng ta cÇn chÌn nh÷ng h×nh ¶nh ®ang 
xuÊt hiÖn trªn mµn h×nh m¸y tÝnh vµo tµi liÖu. Sau ®©y lµ c¸c b−íc cÇn thiÕt gióp b¹n 
lµm viÖc ®ã: 

B¹n muèn chôp toµn bé mµn h×nh m¸y tÝnh vµo tµi liÖu? 

B−íc 1: Më mµn h×nh cÇn chôp, nhÊn phÝm Print Screen. Toµn bé h×nh ¶nh cña 
mµn h×nh sÏ ®−îc l−u vµo bé nhí ®Öm (Clipboard) d−íi d¹ng h×nh ¶nh; 

B−íc 2: Chän vÞ trÝ cÇn chÌn lªn tµi liÖu, nhÊn tæ hîp phÝm Ctrl + V hoÆc nót 
Paste ®Ó d¸n h×nh tõ bé nhí ®Öm lªn v¨n b¶n. 

B¹n muèn chôp hép tho¹i hoÆc cöa sæ ®ang ®−îc kÝch ho¹t trªn mµn h×nh vµo tµi 
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liÖu? 

B−íc 1: Më mµn h×nh cÇn chôp, nhÊp tæ hîp phÝm Alt + Print Screen. H×nh ¶nh 
cña hép tho¹i hoÆc cöa sæ ®ang kÝch ho¹t sÏ ®−îc l−u vµo bé nhí ®Öm; 

B−íc 2: Chän vÞ trÝ cÇn chÌn ¶nh trªn tµi liÖu, nhÊn tæ hîp phÝm Ctrl + V hoÆc nót 
Paste ®Ó d¸n h×nh tõ bé nhí ®Öm lªn v¨n b¶n. 

B¹n chØ muèn chôp mét vïng nµo ®ã cña mµn h×nh vµo tµi liÖu? 

B−íc 1: Më mµn h×nh cÇn chôp, nhÊp phÝp Print Screen. 

B−íc 2: H·y më ch−¬ng tr×nh Paint brush cña Window hay bÊt kú mét phÇn mÒm 
xö lý ¶nh nµo cã trªn m¸y tÝnh; t¹o mét tÖp míi vµ d¸n mµn h×nh võa chôp ®−îc vµo. 
TiÕp theo, sö dông tÝnh n¨ng c¾t h×nh cña phÇn mÒm nµy ®Ó c¾t phÇn h×nh ¶nh cÇn lÊy. 
NhÊn Ctrl+C hoÆc nót Copy ®Ó sao chÐp chóng. 

B−íc 3: Cuèi cïng, b¹n chän vÞ trÝ cÇn chÌn lªn tµi liÖu, nhÊn tæ hîp phÝm Ctrl + V 
hoÆc nót Paste ®Ó d¸n h×nh ®· c¾t ®−îc lªn tµi liÖu. 

 

C©u hái vµ bµi tËp Ch−¬ng 3 

 Bµi tËp vÏ khèi h×nh 

 1. 

Ban gi¸m hiÖu
(Board of headmaster)

c©u l¹c bé
club

x−ëng ®iªu kh¾c
sculpture  factory

trung t©m organ
keyboard center

Khoa
©m nh¹c

Music
Department

Khoa
mü thuËt

art
Department

Khoa
v¨n ho¸

Culture
Department

Khoa
th− viÖn
b¶o tµng
library

Department

Khoa
s©n khÊu

Music
Department

Phßng
®µo t¹o

Trainning office

Phßng
tæ chøc - hµnh chÝnh

Personel - administration
office

Phßng
tæ chøc - hµnh chÝnh

Personel - administration
office
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 2. 

   
 3. 

TiÕn 
tr×nh 2 

TiÕn 
tr×nh 1 

TiÕn 
tr×nh3 

TiÕn 
tr×nh
4

 
T¹o c¸c mÉu ch÷ nghÖ thuËt sau : 

1.    

 

f2

f1

Λ

 F2

F1

TCP/IP IPX TAPI NetX 

Service 

Direct Play Object 

Win32 Application 
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 2. 

 

 

 

 3. 

  
 

4. 

          
  

Bµi tËp chÌn h×nh ¶nh: 

1. ChÌn c¸c biÓu t−îng sau tõ Clip Art lªn word: 

 
 

2 Chôp ¶nh mµn h×nh chÝnh cña Word vµ vÏ thªm c¸c chó thÝch nh− h×nh sau: 
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4. H·y chôp thùc ®¬n sau (khi nhÊn chuét ph¶i lªn mµn h×nh word): 
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Ch−¬ng 4:   

In Ên 
 

4.1 Qui tr×nh ®Ó in Ên 

In Ên lµ c«ng ®o¹n rÊt quan träng vµ lµ kh©u cuèi cïng trong qui tr×nh so¹n th¶o tµi 
liÖu.  

§Ó lµm tèt viÖc in Ên cho tµi liÖu cña m×nh, b¹n nªn thùc hiÖn theo qui tr×nh sau: 

1. §Þnh d¹ng trang in (Page Setup)

2. So¹n th¶o tµi liÖu 
 

3. ThiÕt lËp tiªu ®Ò ®Çu, tiªu ®Ò cuèi 
trang, ®¸nh sè trang (nÕu cÇn) 

4. Xem tµi liÖu tr−íc khi in    

 

 
- §Þnh d¹ng trang in: ®©y lµ b−íc b¹n ph¶i lµm ®Çu tiªn khi so¹n th¶o mét tµi liÖu 

trªn Word; 

- So¹n th¶o tµi liÖu: bao gåm tÊt c¶ c¸c kü n¨ng mµ b¹n ®· ®−îc t×m hiÓu tõ 
ch−¬ng 1 ®Õn ch−¬ng 5; 

- ThiÕt lËp tiªu ®Ò ®Çu, tiªu ®Ò cuèi trang; 

- Print Preview- lµ kh©u rÊt quan träng. Cho phÐp b¹n cã thÓ xem néi dung c¸c 
trang in tr−íc khi in; 

- Thùc hiÖn in tµi liÖu ra giÊy. 

4.2 TÝnh n¨ng Page Setup 

 TÝnh n¨ng nµy gióp thiÕt lËp cÊu tróc trang in, khæ giÊy in. H·y më môc chän File | 
Page Setup.. ®Ó kÝch ho¹t. Hép tho¹i Page Setup xuÊt hiÖn: 

 (Print preview) 

5.  In Ên tµi liÖu
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- ThÎ Paper Size: cho phÐp b¹n lùa chän khæ giÊy in: 

- Môc Paper size: ®Ó chän khæ giÊy in. Bao gåm c¸c khæ: Letter, A0, A1, A2, A3, 
A4, A5,.. tuú thuéc vµo tõng lo¹i m¸y in cña b¹n. B×nh th−êng, v¨n b¶n ®−îc 
so¹n th¶o trªn khæ A4; 

- Ngoµi ra b¹n cã thÓ thiÕt lËp chiÒu réng (môc Width), chiÒu cao (môc Height) 
cho khæ giÊy; 

- Môc Orientation: ®Ó chän chiÒu in trªn khæ giÊy. NÕu lµ Portrait – in theo 
chiÒu däc; Lanscape – in theo chiÒu ngang khæ giÊy; 

- Môc Apply to: ®Ó chØ ®Þnh ph¹m vi c¸c trang in ®−îc ¸p dông thiÕt lËp nµy. NÕu 
lµ Whole Document - ¸p dông cho toµn bé tµi liÖu; This point forward - ¸p dông 
b¾t ®Çu tõ trang ®ang chän trë vÒ cuèi tµi liÖu; 

- Môc Preview – cho phÐp b¹n nh×n thÊy cÊu tróc trang in ®· thiÕt lËp; 

- NhÊn nót Default.. – nÕu b¹n muèn ¸p dông thiÕt lËp nµy lµ ngÇm ®Þnh cho c¸c 
tÖp tµi liÖu sau cña Word; 

- NhÊn OK ®Ó ®ång ý vµ ®ãng hép tho¹i l¹i. 

ThÎ Margin: cho phÐp thiÕt lËp lÒ trang in: 
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- Môc Top: ®Ó thiÕt lËp chiÒu cao cña lÒ trªn cña trang in; 

- Môc Bottom: ®Ó thiÕt lËp chiÒu cao cña lÒ d−íi cña trang in; 

- Môc Left: ®Ó thiÕt lËp chiÒu réng cña lÒ bªn tr¸i cña trang in; 

- Môc Right: ®Ó thiÕt lËp chiÒu réng cña lÒ bªn ph¶i cña trang in; 

- Môc Gutter: ®Ó thiÕt lËp bÒ réng phÇn g¸y tµi liÖu; 

  
- Môc Header – thiÕt lËp chiÒu cao cña phÇn tiªu ®Ò ®Çu trang (Header); 

- Môc Footer – thiÕt lËp chiÒu cao cña phÇn tiªu ®Ò cuèi trang (Footer); 

- Môc Apply to: ®Ó chØ ®Þnh ph¹m vi c¸c trang in ®−îc ¸p dông thiÕt lËp nµy. NÕu 
lµ Whole Document - ¸p dông cho toµn bé tµi liÖu; This point forward - ¸p dông 
b¾t ®Çu tõ trang ®ang ®Æt ®iÓm trá trë vÒ cuèi tµi liÖu; 

- Môc Preview cho phÐp b¹n nh×n thÊy cÊu tróc trang in ®· thiÕt lËp; 

- NhÊn nót Default.. – nÕu b¹n muèn ¸p dông thiÕt lËp nµy lµ ngÇm ®Þnh cho c¸c 
tÖp tµi liÖu sau cña Word; 

- NhÊn OK ®Ó ®ång ý vµ ®ãng hép tho¹i l¹i. 

4.3 Tiªu ®Ò ®Çu, tiªu ®Ò cuèi trang 

 Cã thÓ miªu t¶ vÞ trÝ cña phÇn tiªu ®Ò ®Çu, tiªu ®Ò cuèi trang qua h×nh sau:  

 

Top

Left 

Gutter 

Right

Bottom

Header

Footer 

C¸ch x©y dùng tiªu ®Ò ®Çu vµ tiªu ®Ò cuèi: 

Më môc chän View | Header and Footer, con trá lËp tøc chuyÓn ngay vµo phÇn 
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tiªu ®Ò ®Çu (Header): 

 
Thanh c«ng cô Header and Footer còng xuÊt hiÖn: 

 
B¹n cã thÓ so¹n th¶o tiªu ®Ò b»ng c¸ch gâ trùc tiÕp v¨n b¶n, råi ®Þnh d¹ng chóng. B¹n 

còng cã thÓ chÌn c¸c h×nh ¶nh, ®å häa, b¶ng biÓu,.. lªn tiªu ®Ò nh− lµ chÌn lªn tµi liÖu. 
Ngoµi ra, b¹n cã thÓ chÌn thªm c¸c th«ng tin kh¸c n÷a tõ thanh c«ng cô Header and 
Footer nh− sau: 

 : 
Nót nµy cho phÐp chÌn vµo mét sè c¸c th«ng tin tiªu ®Ò cña tÖp 
tµi liÖu nh− lµ: 

 : ChÌn T¸c gi¶, trang, ngµy; 

 : ChÌn tªn t¸c gi¶; 

 : ChÌn tªn m¸y tÝnh t¹o tÖp tin; 

 : ChÌn tªn tÖp tin cïng ®−êng dÉn; 

 : ChÌn tªn tÖp tin; 

 : ChÌn ngµy in v¨n b¶n gÇn nhÊt; 

 : ChÌn thêi ®iÓm cuèi sö v¨n b¶n; 

 : ChÌn trang thø X cña tæng sè trang Y 

 : ChÌn sè thø tù trang hiÖn t¹i; 

 : ChÌn tæng sè trang cña tµi liÖu; 

 : ChÌn ngµy hiÖn t¹i; 

 : ChÌn giê hiÖn t¹i; 

 : §Þnh d¹ng sè trang; 

 : ChuyÓn ®æi lµm viÖc gi÷a Header vµ Footer; 

 : §ãng thanh tiªu ®Ò l¹i. 
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4.4 ChÌn sè trang tù ®éng 

 Ngoµi viÖc chÌn sè trang tù ®éng bëi tÝnh n¨ng Header and Footer, b¹n cã thÓ chÌn 
sè trang tù ®éng lªn tiªu ®Ò trang b»ng c¸ch: 

 Më môc chän: Insert Page numbers… Hép tho¹i Page numbers xuÊt hiÖn: 

 
- Môc Position – chän vÞ trÝ sÏ chÌn sè trang: Bottom of page  chÌn vµo tiªu ®Ò 

cuèi; hoÆc Top of page  chÌn vµo tiªu ®Ò ®Çu trang; 

- Môc Aligment – dãng hµng cho sè trang: Right- bªn ph¶i trang; Left – bªn tr¸i 
trang hoÆc Center- ë gi÷a trang; 

- NÕu chän môc  sÏ thùc hiÖn ®¸nh sè trang ®Çu tiªn, tr¸i l¹i 
trang ®Çu tiªn sÏ kh«ng ®−îc ®¸nh sè, chØ ®¸nh sè tõ trang thø 2 trë ®i; 

- Môc Preview-  ®Ó xem kÕt qu¶ thiÕt lËp trªn trang tµi liÖu; 

- NhÊn OK ®Ó hoµn tÊt c«ng viÖc. 

4.5 Xem tµi liÖu tr−íc khi in 

 Xem tr−íc khi in (hay cßn gäi Print preview) lµ viÖc rÊt quan träng, ®Æc biÖt ®èi víi 
nh÷ng ng−êi míi häc word, ch−a cã nhiÒu c¸c kü n¨ng vÒ in Ên. Qua mµn h×nh Print 
Preview, b¹n cã thÓ quan s¸t tr−íc ®−îc cÊu tróc trang in còng nh− néi dung chi tiÕt trªn 
trang in. Qua ®ã sÏ cã nh÷ng ®iÒu chØnh hîp lý, kÞp thêi ®èi víi tµi liÖu cña m×nh ®Ó khi 
in ra sÏ thu ®−îc kÕt qu¶ cao nh− ý muèn. 

§Ó bËt mµn h×nh Print preview, b¹n cã thÓ lµm theo mét trong hai c¸ch: 

C¸ch 1: Më môc chän File | Print Preview 

C¸ch 2: NhÊn nót Print preview  trªn thanh c«ng cô Standard. 

Mµn h×nh Preview cïng thanh c«ng cô Print preview xuÊt hiÖn: 
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Mµn h×nh Preview lµ n¬i hiÓn thÞ cÊu tróc, còng nh− néi dung c¸c trang tµi liÖu 

tr−íc khi in; 

Thanh c«ng cô Print Preview cung cÊp c¸c nót chøc n¨ng ®Ó lµm viÖc trªn mµn 
h×nh Preview, ®ã lµ: 

 : 
§Ó phãng to, thu nhá (Zoom) th«ng tin trªn mµn 
h×nh Preview; 

 : 
Cho phÐp hiÓn thÞ hay kh«ng hiÓn thÞ th−íc kÎ 
(Rule) trªn mµn h×nh nµy; 

 : ChØ hiÓn thÞ mét trang tµi liÖu trªn mµn h×nh nµy; 

 : 
Cã thÓ chän n trang tµi liÖu cïng hiÓn thÞ trªn cïng 
mét mµn h×nh nµy (n=1..6); 

 : 
§Ó chuyÓn ®æi chÕ ®é chØ xem vµ xem + cã thÓ 
söa néi dung trùc tiÕp trªn tµi liÖu; 

 : In tµi liÖu ra m¸y in; 

 : 
§ãng mµn h×nh nµy l¹i, trë vÒ mµn h×nh so¹n th¶o 
tµi liÖu ban ®Çu. B¹n còng cã thÓ lµm viÖc nµy khi 
nhÊn phÝm ESC. 
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4.6 In Ên tµi liÖu 

 Sau khi ®· chÕ b¶n xong tµi liÖu, ®· kiÓm tra l¹i c¸c lçi chÕ b¶n. B−íc nµy b¹n sÏ thùc 
hiÖn in Ên tµi liÖu ra m¸y in. 

 Cã nhiÒu c¸ch cho b¹n chän lùa ra lÖnh in Ên: 

 C¸ch 1: Më môc chän File | Print.. 

C¸ch 2: NhÊn tæ hîp phÝm Ctrl + P 

Hép tho¹i Print xuÊt hiÖn: 

 
- Hép Printer cho phÐp b¹n chän m¸y in cÇn in (trong tr−êng hîp m¸y tÝnh b¹n cã 

nèi tíi nhiÒu m¸y in). Nót Properties cho phÐp b¹n thiÕt lËp c¸c thuéc tÝnh cho 
m¸y in nÕu cÇn; 

- Hép Page range- cho phÐp thiÕt lËp ph¹m vi c¸c trang in: 

- Chän All – in toµn bé c¸c trang trªn tÖp tµi liÖu; 

- Current page – chØ in trang tµi liÖu ®ang chän; 

- Pages – chØ ra c¸c trang cÇn in. Qui t¾c chän ra c¸c trang cÇn in nh− sau: 

<tõ trang>-<®Õn trang> 

VÝ dô:  

ChØ in trang sè 5: 5 

In tõ trang 2 ®Õn trang 10: 2-10 

In tõ trang 2 ®Õn trang 10; tõ trang 12 ®Õn 15: 2-10, 12-15 

- Hép Copies – chØ ra sè b¶n in, ngÇm ®Þnh lµ 1. NÕu b¹n in nhiÒu h¬n 1 b¶n, h·y 
gâ sè b¶n in vµo ®©y; 

- Hép Page per sheet ®Ó chØ ra sè trang tµi liÖu sÏ ®−îc in ra mét trang giÊy. NgÇm 
®Þnh lµ 1, tuy nhiªn b¹n cã thÓ thiÕt lËp nhiÒu h¬n sè trang in trªn mét trang giÊy, 
khi ®ã cì sÏ rÊt bÐ; 

- Cuèi cïng nhÊn nót OK ®Ó thùc hiÖn viÖc in Ên. 
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C©u hái vµ bµi tËp ch−¬ng 4 

1. Muèn in c¸c trang: 3,4,5, 9, 10 vµ 15 cña tµi liÖu ®ang më trªn cïng mét lÖnh in, 
ph¶i thiÕt lËp nh− thÕ nµo? 

2. C¸ch thiÕt lËp ®Ó cã thÓ in ®−îc 3 b¶n in trªn mét lÖnh in? 

3. Muèn in 2 trang tµi liÖu lªn mét trang giÊy, lµm thÕ nµo? 

4. Cã thÓ võa thiÕt lËp mét sè trang tµi liÖu in theo h−íng giÊy däc (Portrait), võa in 
theo h−íng giÊy n»m ngang (Landscape) ®−îc kh«ng? NÕu ®−îc, h·y nªu c¸ch 
lµm? (tham kh¶o h×nh d−íi) 

 

Trang hiÓn thÞ theo 
chiÒu ngang C¸c trang 

hiÓn thÞ 
theo chiÒu 
däc 

5. Cã thÓ söa ®−îc néi dung tµi liÖu trªn cöa sæ Print preview ®−îc kh«ng? NÕu 
®−îc, nªu c¸ch lµm? 
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Ch−¬ng 5:  

trén tµi liÖu 
 

5.1 Kh¸i niÖm vÒ trén tµi liÖu 

Mét tÝnh n¨ng rÊt m¹nh cña phÇn mÒm so¹n th¶o v¨n b¶n Microsoft Word lµ trén tµi 
liÖu (Mail Merge). §iÒu nµy ®· gióp Ých cho c¸c nh©n viªn v¨n phßng rÊt nhiÒu trong 
viÖc in c¸c danh s¸ch cña m×nh ra c¸c phiÕu nhá. Chóng ta h·y t×m hiÓu t×nh huèng sau: 

Lan lµ BÝ th− chi ®oµn líp Q9A1, c« ®ang ph¶i so¹n th¶o c¸c giÊy mêi ®Ó göi tíi c¸c 
b¹n sinh viªn tham dù buæi liªn hoan v¨n nghÖ do Chi ®oµn tæ chøc. Danh s¸ch kh¸ch 
mêi ®· ®−îc liÖt kª trªn mét b¶ng Word (hoÆc trªn Excel) nh− sau: 

TT Hä tªn Líp 

1 NguyÔn V¨n Quang Q9A2 

2 Th¹ch H¶i V©n Q9A2 

3 Bïi ThÞ Ninh Q9A3 

4 Lª Quang T¸m Q9A3 

5 NguyÔn ThÞ Hµ Q9A4 

Lan ph¶i lµm nh− thÕ nµo? 

TÝnh n¨ng Mail Merge cña Word sÏ gióp Lan ®¬n gi¶n vµ rÊt nhanh chãng t¹o ra ®−îc 
c¸c giÊy mêi ghi ®Çy ®ñ th«ng tin cÇn thiÕt. 

5.2 ChuÈn bÞ d÷ liÖu 

Ph¶i ch¾c ch¾n b¹n ®· t¹o ®−îc danh s¸ch kh¸ch mêi nh− sau: 

TT Hä tªn Líp 

1 NguyÔn V¨n Quang Q9A2 

2 Th¹ch H¶i V©n Q9A2 

3 Bïi ThÞ Ninh Q9A3 

4 Lª Quang T¸m Q9A3 

5 NguyÔn ThÞ Hµ Q9A4 

B¶ng nµy cã thÓ ®−îc so¹n trªn Word, trªn Excel hoÆc mét b¶ng trªn Access, Foxpro. 

5.3 So¹n mÉu tµi liÖu trén 

So¹n th¶o mét mÉu giÊy mêi nh− sau: 
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5.4 KÝch ho¹t tÝnh n¨ng Mail merge 

KÝch ho¹t tÝnh n¨ng trén tµi liÖu cña Word b»ng c¸ch më môc chän Tools | Mail 
Merge.. , Hép tho¹i Mail Merge Helper xuÊt hiÖn: 

 

ë môc  bÊm chuét nót Creat vµ chän môc Mailing Label, hép tho¹i 
sau ®©y xuÊt hiÖn: 

 
H·y chän Active Window ®Ó tiÕp tôc: 

ë môc , nhÊn chuét nót Get Data vµ chän môc Open Data Source.., 
hép tho¹i Open Data Source xuÊt hiÖn, b¹n h·y chän tÖp chøa danh s¸ch kh¸c mêi ®· 
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t¹o råi nhÊn Open. 

Sau khi më ®−îc tÖp chøa danh s¸ch kh¸ch mêi, cã thÓ nhÊn Close ®Ó ®ãng hép tho¹i 
Mail Merge Helper vµ sö dông thanh c«ng cô Mail merger ®Ó chÌn c¸c tr−êng tin cÇn 
thiÕt lªn tµi liÖu: 

 
NÕu kh«ng thÊy thanh c«ng cô Mail Merge xuÊt hiÖn trªn mµn h×nh, cã thÓ hiÓn thÞ 

nã b»ng c¸ch chän thùc ®¬n View | Toolbars | Mail Merge. 

5.5 ChÌn c¸c tr−êng tin lªn tµi liÖu 

§Ó chÌn mét tr−êng tin lªn giÊy mêi, lµm nh− sau: 

B−íc 1: §Æt ®iÓm trá vµo vÞ trÝ cÇn chÌn th«ng tin trªn tµi liÖu: ®Æt lªn phÇn ®Þnh chÌn 
tªn (nÕu muèn chÌn tr−êng Hä tªn) hoÆc ®Æt ®iÓm trá lªn môc líp (nÕu muèn chÌn 
tr−êng Líp); 

B−íc 2: Trªn thanh c«ng cô Mail merge nhÊn nót Insert Merge Field, råi chän 
tr−êng tin cÇn chÌn lªn tµi liÖu. 

Sau khi chÌn ®Çy ®ñ c¸c tr−êng tin vµo nh÷ng vÞ trÝ hîp lý cña chóng trªn tµi liÖu, b¹n 
cã thÓ chuyÓn sang b−íc tiÕp theo ®Ó tiÕn hµnh trén ra c¸c GiÊy mêi. 

5.6 Thùc hiÖn trén tµi liÖu 

NhÊn nót  trªn thanh c«ng cô Mail merge, hép tho¹i tuú chän trén th− Merge 
xuÊt hiÖn: 

 
Cã thÓ thiÕt lËp th«ng sè cho hép tho¹i nµy nh− sau: 

- Môc Merge to: cho biÕt nh÷ng giÊy mêi ®−îc t¹o ra sÏ ®Æt ë ®©u: New 
document- ë mét tÖp word míi; hoÆc Printer – sÏ ®−îc in ngay ra m¸y in; 

- Môc Records to be merged: cho biÕt ph¹m vi c¸c b¶n ghi sÏ ®−îc trén ra: All- 
sÏ thùc hiÖn trén tÊt c¶ c¸c b¶n ghi hoÆc From: – h·y chØ ra trén tõ b¶n ghi nµo 
®Õn To: b¶n ghi nµo? 

- Cuèi cïng nhÊn nót Merge ®Ó thùc hiÖn trén ra c¸c GiÊy mêi nh− ®· thiÕt lËp. 
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5.7 Thanh c«ng cô Mail merge 

Thanh c«ng cô Mail Merge cung cÊp c¸c nót chøc n¨ng gióp b¹n lµm viÑc nhanh 
chãng vµ thuËn tiªn trong qu¸ tr×nh trén tµi liÖu trªn word. 

 

 : §Ó chÌn mét tr−êng tin (cét) tõ danh s¸ch lªn tµi liÖu trén; 

 : §Ó chuyÓn ®Õn vÞ trÝ c¸c tµi liÖu sau khi ®· trén ®−îc; 

 : 
§Ó hiÓn thÞ hép tho¹i Mail Merge Helper tiÕp tôc nh÷ng thiÕt 
lËp ë môc 5.4; 

 : 
§Ó kiÓm tra xem cã mét lçi nµo trong qu¸ tr×nh thiÕt lËp c¸c 
th«ng tin trén tµi liÖu hay kh«ng? 

 : 
Thùc hiÖn trén tµi liÖu vµ ®−a c¸c kÕt qu¶ ra mét tÖp Word 
míi; 

 : Thùc hiÖn trén tµi liÖu vµ in lu«n kÕt qu¶ ra m¸y in; 

 : Më hép tho¹i thiÕt lËp c¸c th«ng tin tr−íc khi trén th− Merge.

Bµi tËp ch−¬ng 5 

1. Nªu c¸c b−íc cÇn thiÕt ®Ó trén tµi liÖu word tõ mét b¶ng d÷ liÖu cã s½n trªn mét 
tÖp word kh¸c? 

2. T¹o mét danh s¸ch ®iÓm häc sinh cña mét líp (15 häc sinh) bao gåm c¸c cét: 
Hä tªn, Líp, Tin häc ®¹i c−¬ng, ThuËt to¸n lËp tr×nh, TriÕt häc, §TB, XÕp lo¹i. 
TiÕp theo sö dông tÝnh n¨ng Mail merge trén ra c¸c phiÕu ®iÓm nh− sau ®Ó göi 
tíi phô huynh häc sinh: 

 
78



 
3. T¹o danh s¸ch kÕt qu¶ thi tuyÓn (10 thÝ sinh) bao gåm 8 cét th«ng tin: SBD, Hä 

tªn, Ngµy sinh, §Þa chØ, §iÓm m«n1, §iÓm m«n 2, §iÓm m«n 3, KÕt qu¶ xÐt 
tuyÓn. TiÕp theo sö dông tÝnh n¨ng Mail merge ®Ó t¹o vµ in ra c¸c GiÊy b¸o kÕt 
qu¶ thi tuyÓn göi tíi tõng thÝ sinh. 
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Ch−¬ng 6:  

Mét sè øng dông kh¸c cña word 
 

6.1 TÝnh n¨ng ®Õm tõ 

 TÝnh n¨ng ®Õm tõ cho phÐp b¹n thèng kª ®−îc c¸c th«ng tin vÒ ký tù, tõ, ®o¹n, trang 
trªn mét tÖp tµi liÖu. Nã rÊt cÇn thiÕt khi b¹n lµ nhµ b¸o, viÕt s¸ch hoÆc lµm nh÷ng viÖc 
cã liªn quan. 

 Më môc chän Tools | Word Count ®Ó gäi tÝnh n¨ng nµy. Hép tho¹i Word Count 
xuÊt hiÖn: 

 

Tæng sè trang

Tæng sè tõ

Tæng sè ký tù (kh«ng tÝnh dÊu c¸ch)

Tæng sè ký tù (kÓ c¶ dÊu c¸ch)

Tæng sè ®o¹n

Tæng sè dßng

NÕu chän môc  , sÏ thùc hiÖn ®Õm c¶ c¸c tõ vµ ®o¹n trªn 
nh÷ng phÇn ghi chó cña tµi liÖu. 

6.2 B¶o vÖ tµi liÖu 

 ViÖc b¶o vÖ d÷ liÖu trªn Word ®−îc ph©n thµnh c¸c møc ®é. Møc ®é cao nhÊt lµ b¶o 
vÖ khi më tÖp tµi liÖu, vµ møc ®é thø hai lµ b¶o vÖ sù thay ®æi d÷ liÖu trªn tÖp tµi liÖu. Sö 
dông møc ®é nµo lµ do b¹n quyÕt ®Þnh, tuú thuéc vµo môc ®Ých cña b¹n. 

 Nguyªn t¾c b¶o vÖ cho mçi møc lµ: b¹n g¸n mét mËt khÈu (Password). Khi ®ã, chØ 
khi nµo ng−êi dïng nhËp ®óng mËt khÈu ®· g¸n míi cã thÓ lµm ®−îc viÖc mµ b¹n ®· b¶o 
vÖ. 

6.2.1 B¶o vÖ khi më tÖp tµi liÖu 

  B−íc 1: Më tµi liÖu cÇn b¶o vÖ trªn word; 

 B−íc 2: Më môc chän: Tools | Options.., hép tho¹i Options xuÊt hiÖn: 
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Trªn thÎ Save, b¹n h·y gâ vµo mËt khÈu b¶o vÖ tÖp khi më ë môc Password to 

Open:, gâ xong nhÊn OK. Hép tho¹i Confirm Password xuÊt hiÖn, yªu cÇu b¹n 
nhËp l¹i mËt khÈu võa gâ: 

 
H·y gâ l¹i mËt khÈu võa gâ tr−íc ®ã vµo môc Reenter password to open: Gâ 

xong nhÊn OK ®Ó hoµn tÊt. 

NÕu b¹n gâ ®óng, hép tho¹i sÏ ®ãng l¹i, viÖc thiÕt lËp mËt khÈu khi më v¨n b¶n ®· 
thµnh c«ng. NÕu b¹n gâ sai, th«ng b¸o sau ®©y xuÊt hiÖn: 

 
TiÕp theo b¹n ph¶i nhËp l¹i mËt khÈu ®· gâ tr−íc ®ã. 

 Sau khi ®· thiÕt lËp mËt khÈu b¶o vÖ tµi liÖu khi më tÖp nµy thµnh c«ng, nÕu ng−êi 
dïng më tÖp tµi liÖu nµy ra ®Ó lµm viÖc, hép tho¹i sau ®©y xuÊt hiÖn yªu cÇu nhËp vµo 
mËt khÈu b¶o vÖ: 

 
Ng−êi dïng ph¶i nhËp ®óng mËt khÈu mµ b¹n ®· thiÕt lËp lªn hép tho¹i nµy míi cã 
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thÓ më ®−îc tÖp tµi liÖu. 

6.2.2 B¶o vÖ khi söa néi dung tµi liÖu 

  B−íc 1: Më tµi liÖu cÇn b¶o vÒ trªn word; 

 B−íc 2: Më hép tho¹i Options; 

 
Trªn thÎ Save, b¹n h·y gâ vµo mËt khÈu b¶o vÖ khi söa ®æi néi dung v¨n b¶n ë môc 

Password to modify:, gâ xong nhÊn OK. Hép tho¹i Confirm Password xuÊt hiÖn, 
yªu cÇu b¹n nhËp l¹i mËt khÈu võa gâ: 

 
H·y gâ l¹i mËt khÈu võa gâ tr−íc ®ã vµo môc Reenter password to modify: Gâ 

xong nhÊn OK ®Ó hoµn tÊt. 

NÕu b¹n gâ ®óng, hép tho¹i sÏ ®ãng l¹i, viÖc thiÕt lËp mËt khÈu thµnh c«ng. NÕu 
b¹n gâ sai, th«ng b¸o sau ®©y xuÊt hiÖn: 

 
 Sau khi ®· thiÕt lËp ®−îc mËt khÈu, nÕu ng−êi dïng më tÖp nµy ra ®Ó sö dông, mét 
hép tho¹i yªu cÇu hä nhËp mËt khÈu ®Ó cã thÓ söa ®−îc néi dung tµi liÖu: 
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Cã rÊt nhiÒu c¸c thuéc tÝnh mµ b¹n cã thÓ thiÕt lËp ®−îc ë ®©y, nh−ng d−íi ®©y lµ 
mét sè thuéc tÝnh hay ®−îc sö dông nhÊt: 

- Status bar: ®Ó hiÓn thÞ thanh tr¹ng th¸i Status bar; 

- ScreenTips: cho phÐp hiÓn thÞ nh÷ng mÉu giíi thiÖu (Tips) trªn mµn h×nh cña 
word; 

- Animated text: cho phÐp hiÓn thÞ nh÷ng hiÖu øng tr×nh diÔn cña v¨n b¶n (®Ó 
thiÕt lËp nh÷ng hiÖu øng nµy, b¹n tham kh¶o môc 1.2.1.f Hép tho¹i Font); 

- Hozirontal scrollbar: ®Ó hiÓn thÞ thanh cuén ngang cña cöa sæ tµi liÖu; 

- Vertical scrollbar: ®Ó hiÓn thÞ thanh cuén däc cña cöa sæ tµi liÖu; 

- Drawing: cho phÐp hiÓn thÞ h×nh vÏ lªn tµi liÖu vµ in ®−îc chóng ra m¸y in. NÕu 
kh«ng chän môc nµy, b¹n kh«ng thÓ nh×n thÊy c¸c h×nh vÏ b»ng thanh c«ng cô 
Drawing còng nh− kh«ng thÓ in ®−îc c¸c h×nh nµy ra m¸y in; 

- Text Boundary: hiÓn thÞ ®−êng viÒn bao cho trang v¨n b¶n còng nh− nh÷ng ®èi 
t−îng kh¸c trªn tµi liÖu. §iÒu nµy gióp b¹n ph©n ®Þnh ®−îc râ rµng biªn giíi c¸c 
®èi t−îng cã trªn tµi liÖu ®ang lµm viÖc; 

6.3.2 ThÎ General 

 §Ó thiÕt lËp mét sè th«ng tin mang tÝnh chung trªn m«i tr−êng lµm viÖc: 

 
Chóng t«i chØ giíi thiÖu 2 thuéc tÝnh b¹n cã thÓ quan t©m nhÊt: 

- Recently used file list: h·y nhËp vµo sè tÖp word ®−îc sö dông dông gÇn ®©y 
nhÊt lªn môc chän File cña word. §iÒu nµy rÊt thuËn tiÖn cho viÖc më mét tÖp 
v¨n b¶n mµ b¹n chóng míi ®−îc sö dông gÇn ®©y chØ b»ng c¸ch nhÊp chuét. 
NgÇm ®Þnh sè tÖp lµ 4, b¹n nªn thiÕt lËp con sè nµy nhiÒu h¬n; 

- Measurement units: ®Ó thay ®æi ®¬n vÞ ®o chiÒu dµi trªn word cho phï hîp víi 
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b¹n. Cã 2 kiÓu ®¬n vÞ ®o chiÒu dµi ®−îc sö dông ë ®©y lµ Inch vµ Centimeter. 

6.3.3 ThÎ Spelling & Grammar 

 §Ó thiÕt lËp nh÷ng th«ng tin vÒ kiÓm tra lçi chÝnh t¶ v¨n b¶n: 

 
- Check spelling as you type: ®Ó kÝch ho¹t tÝnh n¨ng kiÓm tra lçi chÝnh t¶. B¹n 

nªn chän môc nµy, bëi lÏ nÕu nã ®−îc chän th× nh÷ng tõ viÕt t¾t vµ nh÷ng thiÕt 
lËp kiÓm tra lçi chÝnh t¶ trªn hép tho¹i AutoCorrect míi cã t¸c dông; 

- Check grammar as you type: ®Ó kÝch ho¹t tÝnh n¨ng kiÓm tra lçi ng÷ ph¸p (ng÷ 
ph¸p tiÕng Anh). B¹n chØ bËt nã khi tµi liÖu lµ v¨n b¶n tiÕng Anh, tr¸i l¹i b¹n nªn 
bá môc nµy. 
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6.3.4 ThÎ File Locations 

 ThiÕt lËp nh÷ng th«ng tin vÒ th− môc trªn ®Üa cã liªn quan ®Õn m«i tr−êng lµm viÖc 
word: 

 
H·y chän môc cÇn thiÕt lËp l¹i th− môc ë danh s¸ch File types: råi nhÊn nót 

Modify ®Ó chän l¹i th− môc lµm viÖc. VÝ dô, muèn thay ®æi th− môc ngÇm ®Þnh khi 
më vµ cÊt v¨n b¶n míi, lµm nh− sau: 

B−íc 1: Chän môc Documents trªn danh s¸ch File types; 

B−íc 2: NhÊn nót Modify, hép tho¹i sau xuÊt hiÖn cho phÐp b¹n chän l¹i th− môc 
míi. 

 
B−íc 3: Sau khi chän xong th− môc ngÇm ®Þnh ®Ó më vµ cÊt tµi liÖu, nhÊn nót OK 

®Ó ®ång ý sù thay ®æi nµy. 
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6.4 Lµm viÖc víi Macro 

 Khi lµm viÖc víi word nhiÒu khi b¹n ph¶i lÆp l¹i mét sè c¸c thao t¸c xö lý trªn tµi 
liÖu. §iÒu nµy sÏ ®−îc ®¬n gi¶n h¬n khi b¹n ¸p dông kü thuËt Macro. 

 Macro cã thÓ hiÓu lµ mét lÖnh ®Ó gäi mét thñ tôc (thñ tôc lµ mét ch−¬ng tr×nh ®−îc 
lËp tr×nh trªn m¸y tÝnh cã thÓ bao gåm nhiÒu lÖnh yªu cÇu m¸y tÝnh lµm viÖc) nµo ®ã. 
LÖnh Macro cã thÓ ®−îc g¾n bëi tæ hîp phÝm t¾t hoÆc ®−îc g¾n vµo mét nót lÖnh trªn 
thanh c«ng cô mµ khi bÊm tæ hîp phÝm t¾t nµy hoÆc nhÊn chuét lªn nót ®· g¸n trªn 
thanh c«ng cô, Macro ®ã sÏ ®−îc thùc hiÖn. 

6.4.1 T¹o Macro 

§Ó dÔ hiÓu h¬n, chóng t«i sÏ ®−a ra bµi to¸n vµ c¸ch gi¶i quyÕt nã sau ®©y: 

B¹n lµ mét nh©n viªn v¨n phßng, rÊt hay ph¶i so¹n th¶o c¸c b¸o c¸o, hîp ®ång,.. 
mµ cã dßng tiªu ®Ò ®Çu tiªn lµ: 

Céng hoµ x∙ héi chñ nghÜa ViÖt Nam 
§éc lËp – Tù do – H¹nh phóc 

--o0o-- 

H·y t¹o mét Macro cã tªn CHXHCNVN vµ g¾n nã bëi mét tæ hîp phÝm nãng Ctrl 
+ T ch¼ng h¹n, b¹n lµm nh− sau: 

B−íc 1: KÝch ho¹t tÝnh n¨ng t¹o míi Macro b»ng c¸ch: më môc chän Tools | 
Macro | Record new Macro.. Hép tho¹i Record Macro xuÊt hiÖn: 

 
B−íc 2: Khai b¸o tªn vµ thiÕt lËp phÝm t¾t cho Macro nµy: 

- ¤ Macro name: b¹n h·y gâ vµo tªn cña Macro cÇn t¹o lµ: CHXHCNVN; 

- §Ó thiÕt lËp phÝm t¾t cho Macro, h·y nhÊn lªn nót Keyboard , hép tho¹i 
Customize Keyboard xuÊt hiÖn: 
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Khi con trá ®ang nhÊp nh¸y ë hép Press new shortcut key: b¹n h·y bÊm tæ hîp 

phÝm nãng cÇn thiÕt lËp (ë ®©y lµ Ctrl + T), tiÕp theo nhÊn Asign ®Ó ®ång ý. Cuèi 
cïng nhÊn Close ®Ó ®ãng hép tho¹i nµy l¹i. Mét thanh c«ng cô míi xuÊt hiÖn nh− 
sau: 

 

Vµ con trá trªn mµn h×nh sÏ trë thµnh: . Khi ®ã b¹n cã thÓ ra c¸c lÖnh cho 
Macro nµy. 

B−íc 3: Ra c¸c lÖnh cho Macro: Thùc chÊt lÖnh cho Macro ®ang t¹o lµ: So¹n th¶o 
dßng ch÷ 

Céng hoµ x· héi chñ nghÜa ViÖt Nam 

§éc lËp – Tù do – H¹nh phóc 

--o0o-- 

vµ ®Þnh d¹ng dßng ch÷ ®ã ®Ó trë thµnh: 

Céng hoµ x∙ héi chñ nghÜa ViÖt Nam 
§éc lËp – Tù do – H¹nh phóc 

--o0o-- 

B¹n h·y lµm c¸c c«ng viÖc so¹n th¶o ®Ó ®−îc kÕt qu¶ nh− vËy. 

B−íc 4: KÕt thóc viÖc t¹o Macro: Sau khi so¹n th¶o ®−îc mÉu tiªu ®Ò nh− ý muèn, 

h·y kÕt thóc viÖc t¹o Macro nµy b»ng c¸ch nhÊn lªn nót Stop recording  trªn 
thanh c«ng cô Stop. B¹n ®· t¹o ®−îc Macro cã tªn CHXHCNVN víi phÝm nãng lµ 
Ctrl + T. 

6.4.2 Sö dông Macro ®· t¹o ®−îc 

  Gi¶ sö ®· t¹o ®−îc Macro CHXHCNVN. Khi muèn hiÓn thÞ tiªu ®Ò nh− vËy b¹n 
chØ cÇn gäi Macro nµy bëi phÝm nãng cña nã lµ Ctrl + T. B¹n sÏ thu ®−îc kÕt qu¶ nh− 
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mong muèn. 

C©u hái vµ bµi tËp ch−¬ng 6 

1. Nªu c¸c ph−¬ng ph¸p b¶o vÖ d÷ liÖu trong c¸c tÖp v¨n b¶n word? NÕu kh«ng 
muèn cho bÊt kú ai ®äc ®−îc néi dung trong mét tÖp tµi liÖu, b¹n ph¶i dïng 
ph−¬ng ph¸p nµo ®Ó b¶o vÖ, cho biÕt c¸c b−íc ®Ó thiÕt lËp? 

2. Do mµn h×nh hiÓn thÞ d÷ liÖu m¸y tÝnh nhá, nÕu muèn Èn ®i thanh tr¹ng th¸i cña 
word ph¶i lµm nh− thÕ nµo? 

3. Trong khi so¹n th¶o trong word nÕu c¸c dßng v¨n b¶n tiÕng ViÖt  xuÊt hiÖn nh÷ng 
dßng g¹ch ch©n mµu ®á nh− sau: . H·y cho biÕt t¹i sao nh− 
vËy, vµ c¸ch kh¾c phôc sù cè nµy? 

4. Gi¶ sö ®· cã th− môc C:\TaiLieu. Muèn mçi lÇn thùc hiÖn lÖnh më tµi liÖu hoÆc 
lÖnh ghi tµi liÖu míi trong Word, th− môc nµy sÏ ®−îc më ra ®Çu tiªn, ph¶i lµm 
nh− thÕ nµo? 

5. B¹n hiÓu kh¸i niÖm Macro nh− thÕ nµo? Nªu c¸c b−íc cÇn thiÕt ®Ó cã thÓ t¹o ®−îc 
mét Macro? 

6. H·y t¹o c¸c Macro ®Ó lµm c¸c c«ng viÖc sau:   

- Macro cã tªn ChupManHinh ®Ó chôp toµn bé mµn h×nh hiÖn t¹i cña m¸y tÝnh 
vµ ®−a vµo vÞ trÝ ®ang chän trªn tµi liÖu; 

- Macro cã tªn DanhSoTrang ®Ó tù ®éng ®¸nh sè trang cho v¨n b¶n ®ang so¹n 
th¶o lªn tiªu ®Ò cuèi theo ®Þnh d¹ng nh− sau: Trang 9/83 

- Macro cã tªn CatVaThoat ®Ó ghi l¹i néi dung v¨n b¶n ®ang so¹n th¶o lªn ®Üa 
®ång thêi tho¸t khái Word. 
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PHẦN I: LÀM QUEN VỚI MS WORD 2007 

1. Tạo văn bản đầu tiên 

a. Làm quen với cửa sổ soạn thảo 

 Khi bạn mở Word sẽ có một tài liệu trống xuất hiện, nó trông như một tờ giấy và 

chiếm một khoảng lớn màn hình. 

 

Bạn muốn bắt đầu làm việc nhưng không biết bằng cách nào: 

- Bạn sẽ gõ văn bản ở đâu? Nếu muốn thụt đầu dòng thì phải làm sao? Thay đổi canh 

lề như thế nào? Làm sao để lưu tài liệu? 

- Hãy khởi đầu bằng cách làm quen với một số điểm căn bản của Word. 

b. Bắt đầu nhập liệu  

 Trong chương trình soạn thảo văn bản Microsoft Word 2007 thanh Ribbon được 

đặt ở phía trên vùng làm việc chính. Người dùng sẽ sử dụng các Nút Lệnh của thanh 

Ribbon để thực hiện các hiệu chỉnh. 
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1. Thanh Ribbon nằm phía trên cùng. 

2. Điểm chèn nội dung. 

 Word chờ bạn nhập nội dung. Tại điểm chèn nội dung có một gạch dọc nhấp 

nháy phía trên cùng bên trái cho bạn biết vị trí nơi những gì bạn gõ vào hiển thị. 

 Khoảng trống từ điểm chèn nội dung tới đầu trang và phía bên trái được gọi là 

các Margin (canh lề), bạn sẽ tìm hiểu về các Margin trong phần sau của bài. Bây giờ 

nếu bạn bắt đầu gõ văn bản, trang tài liệu của chúng ta sẽ dần được phủ đầy từ góc 

trên bên trái đi xuống.  

 Nếu bạn muốn gõ văn bản từ phía thấp hơn thay vì ở đầu trang hãy gõ phím 

ENTER trên bàn phím đến khi điểm chèn nội dung nằm ở đúng vị trí mà bạn mong 

muốn.  

 Nếu bạn muốn thụt đầu dòng hãy nhấn phím TAB trước khi gõ, mỗi lần gõ phím 

TAB điểm chèn nội dung sẽ dịch chuyển sang bên phải một khoảng là 1,5 inch.  

 Khi bạn gõ văn bản điểm chèn nội dung sẽ di chuyển dần từ trái sang phải. Khi 

điểm chèn này đi đến phần ngoài cùng bên phải bạn hãy tiếp tục gõ bình thường Word 

sẽ tự động chuyển xuống dòng mới.   

 Để bắt đầu một đoạn mới, hãy nhấn phím ENTER .  

c. Những kí hiệu hỗ trợ 

 

1. Ký hiệu phân đoạn, mỗi ký hiệu tương ứng với một lần nhấn phím ENTER.  

2. Ký hiệu TAB, mỗi ký hiệu tương ứng với một lần nhấn phím TAB.  

3. Ký hiệu SPACEBAR, mỗi ký hiệu tương ứng với một lần nhấn phím SPACEBAR. 

 Hãy tưởng tượng bạn đã gõ một văn bản như hình bên trên. Hai đoạn văn bản có 

vẻ cách nhau hơi xa. Đoạn thứ hai lại dường như thụt đầu dòng hơi nhiều so với đoạn 

đầu. 
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 Bạn có thể dễ dàng kiểm tra bằng cách nhìn vào những ký hiệu định dạng 

(formatting marks) mà Word tự động chèn vào khi bạn gõ văn bản. Các ký hiệu này 

luôn có mặt trong văn bản, tuy nhiên nó được ẩn đi cho đến khi bạn cần thì chúng mới 

hiển thị. 

 Để hiển thị những ký hiệu định dạng hãy sử dụng thanh Ribbon phía trên màn 

hình Word. Chọn thẻ Home, và tìm kiếm nút lệnh trong phần Paragraph, nhấn 

vào đó để hiển thị hoặc ẩn các ký hiệu định dạng.  

 Khi bạn nhìn thấy những ký hiệu định dạng này lần đầu tiên bạn có thể sẽ tự hỏi 

nó là gì và lo ngại nó có được in ra khi bạn in văn bản của mình hay không. Câu trả 

lời là không, các dấu hiệu này không được in dù bạn có nhìn thấy chúng trên màn hình 

soạn thảo.  

 Vậy ký hiệu định dạng là gì? Tác dụng của chúng? Hãy xem xét một ví dụ như 

sau:  

 Word tự động chèn ký hiệu đánh dấu đoạn văn bản (paragraph mark) mỗi 

khi bạn nhấn phím ENTER để bắt đầu môt đoạn mới. Trong hình minh họa trên, giữa 

hai đoạn văn bản xuất  hiện một ký hiệu đánh dấu đoạn văn bản thừa, có nghĩa là bạn 

đã nhấn phím ENTER hai lần thay vì chỉ cần nhấn một. Việc này làm xuất hiện các 

khoảng trống không cần thiết. Hãy xóa ký hiệu thừa này nếu bạn muốn tiết kiệm 

không gian trong văn bản. 

 Mỗi lần nhấn phím TAB sẽ làm xuất hiện một ký hiệu mũi tên . Trong hình, 

có một mũi tên ở đoạn đầu và hai mũi tên ở đạn thứ hai, như vậy phím TAB đã được 

nhấn hai lần ở đầu đoạn thứ hai. 

 Ký hiệu dấu chấm cho biết bạn đã nhấn phím SPACEBAR bao nhiêu lần giữa 

mỗi từ, hoặc khi bạn vô ý nhấn nhầm phím SPACEBAR giữa các ký từ trong một từ. 

Một chấm đại diện một khoảng trống, hai chấm là hai khoảng trống. Thông thường, 

chỉ cần có một khoảng trống ở giữa các từ. Cần lưu ý ký hiệu dấu chấm này khác với 

dấu chấm câu trong văn bản, dấu chấm câu nằm phía dưới chân các ký tự còn ký hiệu 

dấu chấm nằm ở giữa các ký tự.  

d. Những dấu gạch chân trong văn bản 

 Khi bạn gõ văn bản, thỉnh thoảng có thể Word sẽ tự động chèn các dấu gạch 

chân gấp khúc màu đỏ, xanh lá hoặc xanh dương phía dưới một số từ.  
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 Dấu gạch đỏ: có thể do lỗi chính tả hoặc Word không thể nhận dạng được từ 

bạn gõ vào, ví dụ như tên riêng hoặc tên một địa danh nào đó. Nếu từ của bạn gõ là 

đúng chính tả nhưng Word vẫn không nhận ra thì bạn có thể thêm từ đó vào mục từ 

điển Word (Word's Dictionary) để sau này từ đó không còn bị gạch dưới.  

 Dấu gạch xanh lá: Word cho rằng bạn nên kiểm tra lại ngữ pháp (tất nhiên là 

tiếng Anh)   

 Dấu gạch xanh dương: từ bạn gõ vào là đúng chính tả nhưng có thể không hợp 

với ngữ cảnh hoặc ngữ nghĩa của câu.Ví dụ thay vì dùng từ "too" (quá) bạn có thể gõ 

nhầm thành "to".  

 Vậy bạn sẽ phải xử lý những dấu gạch đó như thế nào? Hãy Click-Chuột-Phải 

trên từ bị gạch dưới, Word sẽ tự động đưa ra các đề nghị chỉnh sửa (thỉnh thoảng 

Word cũng có thể sẽ không đưa ra được bất kỳ gợi ý nào). Hãy chọn gợi ý nào bạn 

cảm thấy hợp lý để thay thế từ bị gạch dưới, phần gạch dưới này sẽ biến mất. Các dấu 

gạch dưới này không xuất hiện khi bạn in văn bản.  

 Một lưu ý đối với dấu gạch dưới màu xanh lá và xanh dương: trong đa số trường 

hợp, Word thường chính xác trong việc chỉ ra các lỗi ngữ pháp thông dụng. Tuy 

nhiên, bạn nên cân nhắc khi sử dụng chức năng này. Nếu bạn chắc chắn rằng mình 

đúng và Word đã sai, hãy bỏ qua những gợi ý chỉnh sửa này.  

e. Thay đổi canh lề trang văn bản  

 Canh lề (Margins) là các khoảng trống xung quanh viền của trang văn bản. Phía 

Trên, Dưới, Phải và Trái của trang có một khoảng canh lề bằng 1 inch (tương đương 

2.54cm), đây là khoảng canh lề thông dụng nhất mà bạn có thể sử dụng trong đa số 

trường hợp. 
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 Nếu bạn muốn thay đổi canh lề thì bạn có thể thực hiện dễ dàng vào bất cứ lúc 

nào. Chẳng hạn như khi bạn muốn viết một lá thư, trình bày một công thức hoặc làm 

một bài thơ thì bạn có thể sẽ cần những khoảng canh lề khác.  

 Hãy sử dụng thanh Ribbon để thay đổi các khoảng canh lề. Chọn thẻ Page 

Layout, Trong phần Page Setup click chọn nút Margins bạn sẽ nhìn thấy danh sách 

nhiều khoảng canh lề khác nhau bên cạnh đó là thông số chi tiết cho mỗi phần.  

 Khoảng canh lề đầu tiên trong danh sách là Normal, khoảng canh lề hiện tại. Để 

chọn canh lề nhỏ hơn hãy chọn Narrow. Nếu bạn muốn khoảng trống bên trái và bên 

phải rộng hơn thì hãy chọn Wide. Khi bạn đã chọn xong khoảng canh lề mà mình 

mong muốn, toàn bộ tài liệu sẽ tự động thay đổi theo canh lề mà bạn vừa chọn. 

 Khi bạn chọn một khoảng canh lề nào thì phần nền của nó sẽ thay đổi màu, click 

vào nút Margins một lần nữa màu nền sẽ cho biết khoảng canh lề nào hiện đang được 

áp dụng cho tài liệu của bạn.  

f. Lưu tài liệu 

 

1. Để lưu tài liệu hãy nhấn nút Microsoft Office   



Tìm hiểu Microsoft Office 2007- Tập 1: Tìm hiểu Microsoft Word 2007 

 

Biªn So¹n: Niemtin071@yahoo.com 12 

 

2. Sau đó nhấn Save.   

 Bạn đã nhập liệu và hiệu chỉnh hoàn thiện câu từ và các đoạn văn bản, hoặc có 

những số liệu quan trọng mà bạn không muốn đánh mất nếu lỡ con mèo nhà bạn vô 

tình dẫm lên bàn phím hay một sự cố điện nào đó làm tắt máy tính đột ngột.  

 Để giữ thành quả công việc của mình được an toàn, bạn phải lưu tài liệu lại. 

Không bao giờ là quá sớm để làm điều đó.  

 Nhấn vào nút Microsoft Office ở phía trên cùng bên trái, sau đó nhấn Save. 

Một hộp thoại (Dialog Box) sẽ xuất hiện. Hộp thoại là một cửa sổ nhỏ để trợ giúp bạn 

thực hiện một việc nào đó. Bạn sẽ sử dụng hộp thoại này để cho Word biết bạn muốn 

lưu tài liệu này ở thư mục nào trên máy tính và đặt tên tài liệu là gì.  

 Sau khi đã lưu lần đầu và trở lại công việc, bạn có thể tiếp tục lưu tài liệu này 

suốt quá trình làm việc, bất cứ khi nào thấy cần thiết. Mỗi lần muốn lưu hãy nhấn nút 

 Save  trên thanh công cụ truy cập nhanh (Quick Access Toolbar) ở góc trên 

bên trái hoặc sử dụng tổ hợp phím tắt Ctrl+S (nhấn phím Ctrl và S cùng 

lúc).  

 Sau khi kết thúc công việc và lưu lại tài liệu, thoát khỏi Word bằng cách nhấn 

vào nút Microsft Office sau đó nhấn Close.  

2. Chỉnh sửa văn bản và tài liệu 

a. Hiệu chỉnh tài liệu 

 Để hiệu chỉnh tài liệu một cách nhanh chóng và hiệu quả bạn cần biết cách di 

chuyển điểm chèn nội dung (Insertion Point), vị trí mà những gì bạn gõ vào sẽ xuất 

hiện. Bạn có thể dùng bàn phím hoặc chuột để di chuyển đến vị trí tài liệu cần hiệu 

chỉnh. 
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 Khi đã đã di chuyển đến đúng vị trí mà bạn muốn chỉnh sữa, bạn có thể gõ thêm 

nội dung mới vào hay chọn đoạn văn bản mà bạn muốn sửa hoặc xóa. Bạn có thể chọn 

một ký tự, một từ, một câu, một đoạn văn bản hoặc toàn bộ tài liệu. Ngoài ra, bạn 

cũng có thể dời vị trí của chúng từ nơi này đến nơi khác trong tài liệu.  

b. Di chuyển vòng quanh tài liệu 

 

1.  Điểm chèn nội dung (Insertion Point), thể hiện bằng một gạch dọc nhấp nháy.  

2. Bạn có thể di chuyển điểm chèn nội dung từ vị trí số 1 sang vị trí số 2 bằng cách 

Click-Chuột-Trái vào vị trí số 2 hoặc dùng các phím Mũi Tên (Arrow Buttons). 

 Nhìn vào hình minh họa phí trên, hãy tưởng tượng bạn muốn gõ một câu mới 

giữa từ "civilization" và "During": "Symphonies and constellations have been named 

for clocks."  

 Điểm chèn nội dung hiện đang nằm ở cuối đoạn thứ hai sau từ "assistance." Để 

gõ văn bản vào nơi bạn muốn bạn phải di chuyển điểm chèn nội dung tới vị trí số 2. 

Bạn có thể thực hiện theo hai cách:  

  

 - Dùng chuột di chuyển con trỏ tới điểm bên phải từ "During", Click-Trái-Chuột 

để di chuyển điểm chèn nội dung vào vị trí đó. Sau đó hãy bắt đầu gõ câu mới vào, nội 

dung mới sẽ xuất hiện phía bên trái của từ "During".  

HOẶC  

 - Nhấn nút mũi tên hướng lên (UP ARROW) để di chuyển điểm chèn nội 

dung lên trên, mỗi lần nhấn điểm chèn sẽ di chuyển lên một dòng. Sau đó dùng phím 

mũi tên trái (LEFT ARROW) để di chuyển điểm chèn sang bên trái, mỗi lần một 

ký tự, đến vị trí mà bạn mong muốn.  

c. Chọn và xóa nội dung 
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 Trong hình bên trên, từ "really" hiện đang được chọn.  

 Sau khi đã thêm một câu mới ở phần b, bạn đọc lại toàn bộ và cảm thấy câu thứ 

hai sẽ hay hơn nếu bỏ từ "really".  

Để xóa trước hết bạn phải chọn từ cần xóa bằng một trong các cách sau: 

 - Dùng chuột: Di chuyển con trỏ tới trên từ "really", sau đó nhấp đúp (double-

click) chuột trái. Hoặc bạn có thể di chuyển con trỏ chuột đến phía trước (hoặc sau) từ 

"really" sau đó Click-Trái-Chuột và giữ nguyên rồi kéo chuột ngang qua từ "really".  

HOẶC  

 - Dùng bàn phím: sử dụng các phím mũi tên để di chuyển điểm chèn nôi dung 

đến bên phải (hoặc trái) từ "really",nhấn và giữ phím SHIFT sau đó dùng phím mũi 

tên trái (hoặc phải) để chọn.  

d. Di chuyển văn bản 

 

1. Chọn nội dung mà bạn muốn di chuyển   

2. Nhấn phím Cut trên thanh Ribbon.  

3. Di chuyển điểm chèn nội dung (Insertion Point) đến vị trí mới nơi bạn muốn chèn 

đoạn văn bản.   

4. Nhấn nút Paste trên thanh Ribbon.    
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 Tiếp tục xem xét đoạn văn bản đầu tiên. Bạn thấy rằng câu mà bạn thêm vào ở 

phần b nên đặt ở cuối đoạn. Bạn không cần phải xóa câu ở vị trí cũ rồi gõ lại ở vị trí 

mới. Thay vào đó, hãy di chuyển nó bằng cách thực hiện các lệnh Cut (cắt) và Paste 

(dán): Cắt để xóa câu ở vị trí cũ và dán để di chuyển nó đến ví trí mới mà bạn mong 

muốn.  

 Đầu tiên hãy chọn toàn bộ câu mà bạn muốn di chuyển như ở hình trên. Chọn 

thẻ Home trên thanh Ribbon, nhấn vào phím Cut trong phần Clipboard. Hoặc bạn có 

thể dùng phím tắt Ctrl + X (tưởng tượng chữ X giống như hình cây kéo).  

 Sau đó di chuyển điểm chèn nội dung tới cuối đoạn.   

 Cuối cùng, nhấn vào phím Paste trên thanh Ribbon. Hoặc bạn có thể dùng phím 

tắt Ctrl + V. Câu bạn muốn di chuyển đã được dời tới nơi bạn mong muốn.  

e. Hủy bỏ các hành động vừa thực hiện 

 

1. Nút Hủy Lệnh (Undo) trên thanh công cụ truy cập nhanh (Quick 

Access Toolbar).  

2. Các lệnh có để hủy: Cut và Paste.   

 Bạn đã di chuyển một câu đến vị trí mới trong phần d nhưng khi xem lại bạn 

cảm thấy không hài lòng. Thật may mắn là bạn không cần phải thực hiện lại chuỗi 

hành động Cut và Paste để chuyển câu trở về vị trí ban đầu. Thay vì vậy, hãy dùng 

chức năng Hủy Lệnh (Undo).  

 Trên thanh công cụ truy cập nhanh ở trên cùng, hãy Click vào mũi tên trên nút 

Undo , chọn 2 lệnh gần nhất mà bạn thực hiện (Cut và Paste) 2 lệnh này sẽ được 

hủy và câu mà bạn vừa di chuyển sẽ quay về vị trí ban đầu.  

 Bạn cũng có thể sử dụng phím tắt Ctrl + Z để thực hiện việc hủy lệnh, các lệnh 

sẽ được hủy theo thứ tự lệnh cuối cùng sẽ được hủy trước.  

f. Sử dụng thanh trượt (Scrollbar) để xem tài liệu 
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1. Thanh trượt (Scrollbar).  

2. Kéo con trượt (Scrollbox) lên xuống để xem tài liệu.   

3. Nhấn vào phím mũi tên để di chuyển lên hoặc xuống.  

 Có thể bạn có một tài liệu dài và muốn đọc hết mà không phải nhấn các phím 

mũi tên liên tục để di chuyển điểm chèn nôi dung lên hoặc xuống. Bạn có thể kéo tài 

liệu đến điểm cần xem một cách dễ dàng bằng cách dùng thanh trượt.  

 Thanh trượt nằm bên phải của cửa sổ Word như hình minh họa bên trên. Để sử 

dụng, bạn hãy Click lên con trượt và kéo nó lên hoặc xuống mà không làm di chuyển 

vị trí của điểm chèn nội dung. Hoặc bạn có thể Click vào các phím mũi tên để cuộn 

văn bản. 

 Để cuộn nhanh văn bản bằng bàn phím hãy nhấn vào phím PAGE UP để 

cuộn lên và PAGE DOWN để cuộn xuống dưới.  

3. Làm cho văn bản trông đẹp mắt 

a. Định dạng chữ và áp dụng các kiểu trang trí 

Trong hình là một phần của một bản thông cáo báo chí, nhưng tất cả mọi thứ đều 

trông giống nhau. Không tiêu đề, không hướng dẫn, không có điểm nhấn quan trọng 

để gây sự chú ý cho người đọc. 
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 Đừng quá lo lắng, bạn có thể nhanh chóng làm cho văn bản trên trở nên bắt mắt 

hơn bằng các công cụ như: In đậm (bold), In nghiêng (Italic), Gạch chân (underline); 

tạo các danh sách (list); sử dụng các kiểu trang trí v.v...Những công cụ đó sẽ giúp bạn 

định dạng văn bản.   

 Hãy xem chi tiết trong các phần tiếp theo.  

b. Tạo các điểm nhấn 

 

 Bảng thông cáo báo chí cho biết lợi nhuận ròng trên mỗi cổ phiếu của Contoso 

Pharmaceuticals. Bạn có thể gây sự chú ý của người đọc bằng cách sử dụng các đinh 

dạng như in đậm (bold), in nghiêng (Italic), gạch chân (underline). Bạn có thể thực 

hiện điều này bằng cách sử dụng các nút trên thanh Ribbon hoặc dùng phím tắt.  

 Chọn đoạn văn bản mà bạn muốn gây chú ý, sau đó chọn thẻ Home trên thanh 

Ribbon, bạn có thể định dạng văn bản bằng các nút trong phần Font. Ví dụ, nếu muốn 

in đậm văn bản hãy Click vào nút Bold (hoặc dùng phím tắt Ctrl + B).  

 Nếu bạn thấy chữ in đậm nhìn không vừa mắt, ngay sau khi thực hiện lệnh in 

đậm hãy nhấn phím Undo trên thanh công cụ truy cập nhanh ở phía trên cùng 
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của cửa sổ Word. Hoặc bạn có thể chọn văn bản vừa in đậm rồi nhấn nút Bold 

(hoặc phím tắt Ctrl + B) một lần nữa. 

 Bạn cũng có thể thay đổi màu sắc để đoạn văn bản trông nội bật hơn nữa. Vẫn tại 

thẻ Home và phần Font trên thanh Ribbon, bạn hãy tìm đến nút Font Color . 

Clcik vào mũi tên trên nút , di chuyển chuột lên trên từng màu trên bảng màu. 

Bạn có thể xem trước đoạn văn bản được chọn sẽ trông như thế nào với từng màu. Khi 

bạn đã chọn được màu mình thích, hãy Click lên màu đó.  

c. Thêm nhanh một kiểu trang trí (Style) 

 

 Bạn có thể thêm điểm nhấn bằng cách in đậm, in nghiêng, đổi font chữ, kích cỡ, 

màu sắc v.v...Nhưng thay vì làm từng bước riêng biệt rất tốn thời gian bạn có thể áp 

dụng các kiểu trang trí nhanh (Quick Styles). Quick Styles là một tập hợp các định 

dạng, bạn có thể thay đổi in đậm, in nghiêng, font chữ, kích cỡ, màu sắc chỉ bằng một 

cái Click-Chuột. 

 Để thêm một kiểu trang trí hãy chọn đoạn văn bản mà bạn muốn, sau đó trong 

phần Styles ở thẻ Home bạn có thể di chuyển con trỏ chuột ngang qua từng kiểu trang 

trí để xem đoạn văn bản thay đổi tương ứng như thế nào.   

 Nếu vẫn chưa chọn được một kiểu vừa ý, hãy nhấn nút  More để mở rộng bảng 

liệt kê các kiểu. Khi đã chọn được một kiểu phù hợp, Click chuột vào đó.  

 Đừng lo lắng nếu bạn chọn sai kiểu trang trí, bạn có thể chọn một kiểu khác bất 

cứ lúc nào bằng cách lập lại các thao tác trên. 

d. Tạo danh sách 

 Bảng thông cáo báo chí chỉ ra các điểm thành công trong Quý vừa qua, các điểm 

này sẽ nổi bật hơn nếu trình bày ở dạng danh sách. 
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 Bạn có thể sử dụng danh sách dạng chữ số (Numbering) hoặc dạng ký hiệu 

(Bullet) để gây sự chú ý.   

 Chọn đoạn văn bản mà bạn muốn tạo danh sách. Tại thẻ Home, phần Paragraph, 

click vào Bullets hoặc Numbering . Word sẽ tự động tạo danh sách cho 

bạn.  

e. Thêm hoặc bớt khoảng trống 

 

 Bạn có thể dễ dàng thay đổi khoảng cách giữa các dòng trong toàn bộ tài liệu 

hoặc trong một đoạn văn bản được chọn.  

 Để thay đổi khoảng cách dòng trong toàn bộ tài liệu đầu tiên bạn phải chọn tất cả 

tài liệu bằng cách nhấn phím tắt Ctrl + A. Để thay đổi khoảng cách dòng trong một 

đoạn văn bản, bạn chỉ cần di chuyển điểm chèn nội dung đến đoạn văn bản đó, không 

cần phải chọ cả đoạn.  

 Sau đó, tại thẻ Home, phần Paragraph, nhấn vào nút Line Spacing . Có 

một ký hiệu cho biết khoảng cách dòng hiện tại. Hãy chọn một khoảng cách mới mà 

bạn mong muốn.  
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f. Sử dụng kiểu định dạng cho toàn bộ tài liệu 

 Bảng thông cáo báo chí của chúng ta hiện trông khá ổn, nó có tiêu đề, các điểm 

nhấn được in đậm, có nhiều màu khác nhau, một danh sách bắt mắt.   

 

 Bước cuối cùng, hãy xem qua Tập hợp các kiểu trang trí nhanh (Quick Style 

sets), đó là tập hợp các kiểu trang trí bạn có thể dùng để thay đổi phong cách trang trí 

của toàn bộ tài liệu với chỉ một cú Click-Chuột. Mỗi Tập hợp (set) bao gồm các định 

dạng trang trí cho Tiêu đề, Tựa, Trích dẫn, font chính v.v...tất cả được thiết kế một 

cách thống nhất.  

 Mỗi khi thay đổi một Style Set, các Style tương ứng sẽ thay đổi mà không bị 

chồng chéo. Ví dụ Style cho Tiêu đề (Heading) mới sẽ thay thế cho Style tiêu đề cũ 

chứ không phải cho Style Tựa (Title) cũ.  

 Để xem tài liệu sẽ thay đổi như thế nào hãy chọn thẻ Home, Click vào Change 

Style trong phần Styles, sau đó chọn Style Set.  

 Di chuyển chuột trên từng Style trong danh sách, mỗi khi con trỏ chuột dừng 

trên một Style nào đó bạn sẽ thấy tài liệu được thay đổi theo Style tương ứng. Khi đã 

chọn được một Style vừa ý, hãy Click lên nó.  
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PHẦN II: LÀM QUEN VỚI PHIÊN BẢN MỚI 

1. Làm quen nhanh với giao diện mới 2007 

a. Làm quen với thanh Ribbon 

 Lần đầu tiên mở Word 2007 lên có thể bạn sẽ ngạc nhiên với giao diện hoàn toàn 

mới so với các phiên bản trước. Phần thay đổi lớn nhất là thanh Ribbon nằm trên 

cùng của cửa sổ chương trình. 

 

 Thanh Ribbon thể hiện sẵn những lệnh thông dụng nhờ đó bạn không phải lục 

tung hàng đống menu để tìm thứ bạn cần. 

 Tại sao lại có sự thay đổi này? Câu trả lời là để giúp cho bạn làm việc dễ dàng và 

hiệu quả hơn. Thanh Ribbon được nghiên cứu và thiết kế sao cho các lệnh được đặt ở 

những vị trí hợp lý nhất. 

b. Có những gì trên thanh Ribbon? 
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 Thanh Ribbon có 3 thành phần căn bản, sẽ rất có ích nếu bạn biết mỗi phần được 

gọi là gì và cách sử dụng chúng.  

1. Tab (thẻ) có 7 Tab cơ bản nằm ngang phía trên, mỗi Tab đại diện cho một vùng 

hoạt động. 

2. Group (nhóm) mỗi Tab bao gồm nhiều Group tập họp các đối tượng có liên quan 

mật thiết với nhau. 

3. Command (lệnh) mỗi Command có thể là một nút, một vùng để nhập nội dung 

hoặc một  Menu (trình đơn). 

 Mọi thứ trên một Tab đều được lựa chọn cẩn thận dựa trên các hoạt động của 

người dùng. Ví dụ Tab Home chứa những lệnh có tần suất sử dụng nhiều nhất chẳng 

hạn như các lệnh trong nhóm Font để định dạng văn bản như: Font, Font Size, Bold, 

Italic, v.v... 

c. Nút hiển thị hộp thoại của từng nhóm 

 

 Mới nhìn qua bạn có thể sẽ không tìm thấy một lệnh nào đó đã có trong các 

phiên bản Word trước. Đừng lo, một số nhóm có một nút hình mũi tên chéo nằm ở 

góc phải bên dưới của nhóm.   

 Nút mũi tên đó được gọi là Dialog Box Launcher (nút mở hộp thoại). Nếu bạn 

Click vào nút đó nó sẽ mở ra các tùy chọn liên quan đến nhóm tương ứng. Các tùy 

chọn này xuất hiện dưới dạng hộp thoại mà bạn vẫn thấy ở các phiên bản Word trước 

đây.  

 Nhân tiện nói về các phiên bản Word trước, bạn có thể tự hỏi liệu bạn có thể 

chọn một giao diện giống như các phiên bản trước trong Word 2007 không. Câu trả 

lời là KHÔNG. Tuy nhiên, sau khi đã quen thuộc với giao diện mới bạn sẽ cảm thấy 

thích thú với sự tiện lợi mà nó mang lại. 

d. Những Tab phụ 



Tìm hiểu Microsoft Office 2007- Tập 1: Tìm hiểu Microsoft Word 2007 

 

Biªn So¹n: Niemtin071@yahoo.com 23 

 

 Khi bạn chọn một một bức ảnh, tab phụ có tên Picture Tools sẽ xuất hiện, Tab 

này chứa các lệnh liên quan đến việc xử lý hình ảnh trong Word. 

 

 Trong phiên bản 2007, có một số Tab chỉ xuất hiện trên thanh Ribbon khi bạn 

cần đến chúng. Giả sử bạn vừa chèn một tấm ảnh vào tài liệu, bây giờ bạn muốn có 

những hiệu chỉnh liên quan tới tấm ảnh này chẳng hạn như chọn cách văn bản sẽ bao 

quanh tấm ảnh như thế nào hoặc có thể bạn muốn cắt xén những phần thừa trong 

ảnh...Vậy bạn có thể tìm các lệnh liên quan ở đâu?    

1. Chọn ảnh.  

2. Tab phụ Picture Tools xuất hiện, hãy click vào đó.  

3. Các nhóm và lệnh mới sẽ xuất hiện để bạn có thể xử lý hình ảnh, nhóm 

Picture Styles chẳng hạn.  

  Khi bạn click ra ngoài bức ảnh, Tab Picture Tools sẽ biến mất và các nhóm 

khác xuất hiện trở lại.  

e. Toolbar mini 

 Khi bạn chọn một đoạn văn bản hoặc một từ và chuyển con trỏ chuột đén đó, 

một Toolbar (thanh công cụ) nhỏ sẽ xuất hiện dưới dạng mờ. 
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Một số lệnh định dạng hữu dụng đến nỗi bạn muốn nó xuất hiện trong mọi hoàn cảnh. 

Giả sử bạn muốn định dạng nhanh một văn bản trong khi hiện tại bạn đang ở Tab 

Page Layout. Đương nhiên bạn có thể Click vào Tab Home để sử dụng những lệnh 

định dạng trong đó, tuy nhiên có một cách nhanh hơn:  

1. Chọn phần văn bản muốn định dạng sau đó chuyển con trỏ chuốt tới vị trí đó.  

2. Một thanh công cụ nhỏ xuất hiện dưới dạng mờ. Nếu bạn rê chuột đến đọ, thanh 

công cụ này sẽ hiện rõ và bạn có thể sử dụng các tùy chọn trên đó để định dạng văn 

bản.  

 Toobar Mini rất hữu ích cho định dạng nhanh văn bản, tuy nhiên bạn phải làm 

sao nếu muốn một vài lệnh khác cũng xuất hiện thường trực như vậy. Hãy xem phần 

tiếp theo về Quick Access Toolbar (thanh công cụ truy cập nhanh). 

f. Thanh công cụ truy cập nhanh 

 Thanh công cụ truy cập nhanh (Quick Access Toolbar) là một vùng nhỏ nằm 

trên góc trái của thanh Ribbon, nó chứa các lệnh mà bạn dùng ngày này qua ngày khác 

như: Save, Undo, Repeat . Bạn có thể thêm vào những lệnh mà mình thường dùng để 

nó sẽ luôn xuất hiện mà không cần biết Tab hiện tại là gì.  

 

 Click phải chuột vào nút lệnh mà bạn muốn thêm vào Quick Access Toolbar, 

chọn Add to Quick Access Toolbar. 

g. Ẩn tạm thời thanh Ribbon 

 Thanh Ribbon giúp cho mọi thứ trong Word 2007 trở nên tập trung và dễ dàng 

tìm kiếm những thứ cần thiết. Tuy nhiên, đôi khi bạn không cần phải tìm bất cứ thứ gì. 

Bạn chỉ muốn tập trung làm việc với tài liệu của mình và bạn muốn có nhiều không 

gian hơn. Thật đơn giản, hãy tạm ẩn thanh Ribbon.  
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 Cách ẩn thanh Ribbon: Nhấp đúp chuột vào Tab hiện tại, các nhóm của Tab sẽ 

biến mất. Như vậy bạn đã có nhiều khoảng trống hơn.  

 Khi nào bạn muốn thanh Ribbon xuất hiện trở lại, hãy nhấp đúp vào Tab hiện tại 

một lần nữa. 

h. Sử dụng bàn phím 

 

 Những người yêu bàn phím, đây là phần dành cho các bạn. Phìm tắt bắt đầu với 

Ctrl như các phiên bản trước. Ví dụ Ctrl + C là Copy, Ctrl+S là lưu tài liệu...   

 Thiết kế Ribbon dẫn đến hệ thống phím tắt mới với 2 lợi ích lớn so với phiên bản 

trước:   

 - Mọi lệnh đều có phím tắt   

 - Các phím tắt yêu cầu nhấn ít phím hơn 

 - Các phím tắt (Short Cut) có một tên mới: Key Tips. Nhấn phím Alt để các Key 

Tips xuất hiện cho tất cả các Tab, các nút lệnh trên Quick Access Toolbar, nút 

Microsoft Office. Lúc này, bạn có thể nhấn Key Tip cho những Tab mà bạn muốn 

hiển thị, ví dụ nhấn H để hiển thị Tab Home. Các Key Tip cho từng lệnh trong Tab 

Home sẽ xuất hiện và bạn chỉ việc nhấn Key Tip của lệnh mà bạn cần. 
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2. Làm quen nhanh với hệ thống Office 2007 

a. Phiên bản Office mới được thiết kế hướng người dùng 

 Có rất nhiều thay đổi tương tự nhau trong cả bộ Office 2007. Tin tốt lành đó là 

các lệnh và các công cụ đều đã được đưa ra trước mắt người dùng và luôn ở trạng thái 

sẵn sàng. 

 

 Thay vì có khoảng trên dưới 30 thanh công cụ hoặc các lệnh bị vùi dưới hàng tá 

menu hoặc trong các hộp thoại thì giờ đây bạn đã có một trung tâm điều khiển 

(Control Center) duy nhất kết hợp mọi thứ với nhau một cách trực quan. 

 Một khi đã quen thuộc với thanh Ribbon trong một chương trình (Word, Excel, 

Access...), bạn cũng sẽ cảm thấy dễ dàng trong một chương trình khác.  

b. Các lệnh được tổ chức như thế nào? 

 

 Các lệnh Paste, Cut và Copy thường được sử dụng nhất trong Word và Excel, do 

đó, theo logic các lệnh này được đặt ở Tab Home, Tab đầu tiên trên thanh Ribbon. 
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 Các lệnh tổ chức theo cách chúng được sử dụng. Microsoft nhận thấy người 

dùng có một số lệnh ưa thích mà họ dùng đi dùng lại hàng ngày. Những lệnh như thế 

hiện đã được đặt ở những nơi nổi bật và tiện dụng nhất. 

 Ví dụ lệnh Paste là lệnh có tần suất sử dụng cao nhất, như thế tại sao không cho 

nó một khoảng không gian lớn hơn so với các lệnh liên quan là Copy và Cut. 

 Các lệnh thông dụng không còn phải chia sẻ không gian trên thanh công cụ với 

những lệnh liên quan nhưng ít được dùng hơn. Những thứ hữu dụng sẽ được đặt trong 

tầm tay của bạn. 

 Những lệnh có tần suất sử dụng thấp sẽ chỉ có được một phần nhỏ trên thanh 

công cụ. Ví dụ người dùng ít sử dụng lệnh Paste Special hơn lệnh Paste, do đó muốn 

truy cập lệnh Paste Special bạn hãy nhấn phím mũi tên bên dưới lệnh Paste. 

c. Nhiều lệnh chỉ xuất hiện khi cần thiết 

 

 Tab phụ Picture Tools xuất hiện khi bạn chèn một bức ảnh vào Word. 

 Những lệnh bạn thường sử dụng nhất nằm trên thanh Ribbon và luôn ở trạng thái 

sẵn sàng. Trong khi đó, một số lệnh khác chỉ xuất hiện khi bạn thực sự cần. 

 Chẳng hạn nếu bạn không có bức ảnh nào trong tài liệu thì các công cụ để xử lý 

hình ảnh sẽ không cần thiết phải xuất hiện. 

 Nhưng chỉ cần bạn chèn vào một bức ảnh, Tab phụ Picture Tools sẽ lập tức xuất 

hiện cùng với Tab con Format chứa các lệnh để bạn làm việc với các bức ảnh. Khi 

bạn kết thúc công việc với bức ảnh Tab Picture Tools cũng biến mất. 

 Nếu bạn muốn làm việc lại với bức ảnh, chỉ cần Click lên nó, Tab Picture Tools 

sẽ lại xuất hiện. Word biết bạn đang làm gì và cung cấp cho bạn các công cụ cần thiết 

phù hợp. Thanh Ribbon phản ứng với các hành động của bạn. 

 Vậy bạn không cần phải lo lắng khi không luôn nhìn thấy tất cả các lệnh. Hãy 

thực hiện bước đầu tiên, sau đó mọi thứ bạn cần sẽ tự động xuất hiện. 
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d. Sẽ có nhiều tùy chọn hơn mỗi khi bạn cần 

 

 Click vào phím mũi tên ở phía dưới mỗi nhóm khi bạn cần nhiều tùy chọn 

liên quan tới nhóm đó: 

1. Click vào phím mũi tên của nhóm Font 

2. Hộp thoại Font xuất hiện với đầy đủ các tùy chọn. 

 Khi bạn thấy một phím mũi tên nhỏ phía dưới một nhóm có nghĩa là nhóm đó 

có thêm nhiều tùy chọn đang ẩn. Click vào phím mũi tên này (phím này được gọi là 

Dialog Box Launcher) một hộp thoại hoặc một bảng chứa lệnh (Task Pane). 

 Ví dụ trong PowerPoint, nhóm Font ở thẻ Home chứa các lệnh về font chữ như 

thay đổi kiểu chữ, kích thước, màu sắc, in đậm, in nghiêng, gạch dưới... 

 Nhưng nếu bạn muốn sử dụng các lệnh định dạng font ít thông dụng hơn như 

supperscript thì bạn phải click vào phím mũi tên bên dưới nhóm Font để mở hộp 

thoại Font có chứa lệnh supperscript và các lệnh khác liên quan đến font chữ.  

 Sau đó di chuyển điểm chèn nội dung tới cuối đoạn.  

 Cuối cùng, nhấn vào phím Paste trên thanh Ribbon. Hoặc bạn có thể dùng phím 

tắt Ctrl + V. Câu bạn muốn di chuyển đã được dời tới nơi bạn mong muốn.  

e. Xem trước thay đổi trước khi chọn 
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 Bạn đã bao giờ phải rơi vào cảnh lặp đi lập lại các thao tác Chọn Lựa - Hủy 

(Undo) - Chọn Lựa chưa? Bạn chọn một Font chữ, màu sắc, kiểu trang trí hoặc hiệu 

chỉnh một bức ảnh. Nhưng những thay đổi đó dẫn đến một kết quả không vừa ý, thế là 

bạn nhấn Undo, sau đó lại thực hiện những lựa chọn khác. Vòng lặp nhàm chán đó 

diễn ra cho đến khi có một kết quả làm bạn hài lòng.  

 Giờ đây, bạn có thể nhìn thấy ngay kết quả của từng tùy chọn. Mỗi khi bạn rê 

chuột ngang một tùy chọn nào đó phần văn bản hoặc hình ảnh mà bản muốn hiện 

chỉnh sẽ lập tức thay đổi tương ứng. Khi đã chọn được một giải pháp ưng ý, hãy click 

lên nó. Bạn sẽ không phải đụng đến lệnh Undo. 

f. Tạo thanh công cụ của riêng bạn 

 

 Bạn đã bao giờ phải rơi vào cảnh lặp đi lập lại các thao tác Chọn Lựa - Hủy 

(Undo) - Chọn Lựa chưa? Bạn chọn một Font chữ, màu sắc, kiểu trang trí hoặc hiệu 

chỉnh một bức ảnh. Nhưng những thay đổi đó dẫn đến một kết quả không vừa ý, thế là 

bạn nhấn Undo, sau đó lại thực hiện những lựa chọn khác. Vòng lặp nhàm chán đó 

diễn ra cho đến khi có một kết quả làm bạn hài lòng.  

 Giờ đây, bạn có thể nhìn thấy ngay kết quả của từng tùy chọn. Mỗi khi bạn rê 

chuột ngang một tùy chọn nào đó phần văn bản hoặc hình ảnh mà bản muốn hiện 

chỉnh sẽ lập tức thay đổi tương ứng. Khi đã chọn được một giải pháp ưng ý, hãy click 

lên nó. Bạn sẽ không phải đụng đến lệnh Undo. 

g. Sử dụng độ phân giả màn hình khác nhau làm thay đổi cách hiển thị của 

thanh Ribbon 

 Trong hình là một phần của một bản thông cáo báo chí, nhưng tất cả mọi thứ đều 

trông giống nhau. Không tiêu đề, không hướng dẫn, không có điểm nhấn quan trọng 

để gây sự chú ý cho người đọc.  
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 Nhóm Show/Hide trong Tab View hiển thị đầy đủ khi mà hình ở độ phân giải 

cao, khi màn hình có độ phân giải thấp, bạn phải nhấn vào nút mũi tên mới nhìn thấy 

được các lệnh. 

 Những gì bạn đã tìm hiểu về phiên bản Office mới cho đến giờ được áp dụng khi 

màn hình của bạn có độ phân giải cao. 

 Nếu màn hình của bạn có độ phân giải thấp, 800x600 pixel chẳng hạn, thì một số 

nhóm lệnh chỉ hiển thị tên nhóm chứ không hiển thị tất cả các lệnh. Bạn phải nhấn vào 

nút mũi tên bên dưới tên nhóm để truy cập tất cả các lệnh.  

 Nhìn vào hình minh họa trên, ở độ phân giải cao nhóm Show/Hide hiển thị đầy 

đủ các lệnh, trong khi đó với độ phân giải thấp hơn nó chỉ hiển thị tên nhóm mà không 

có lệnh nào. Trong trường hợp này bạn phải nhấn vào nút mũi tên để truy cập các 

lệnh.  

 Tổng quát, một nhóm chỉ hiện tên nhóm ở độ phân giải thấp là những nhóm lệnh 

thường ít được sử dụng.  

 Chế độ Minimize: dù ở bất kì độ phân giải nào, nếu bạn thu nhỏ cửa sổ chương 

trình lại thì một số nhóm sẽ chỉ còn hiển thị tên nhóm. Càng thu nhỏ cửa sổ chưa trình 

thì số nhóm chỉ hiển thì tên sẽ tăng lên.  

 Tablet PC: Nếu bạn dùng Tablet PC (Máy tính dạng bảng) với màn hình nhỏ 

bạn sẽ thấy Office 2007 sẽ hiển thị một phiên bản thanh Ribbon với các Tab và nhóm 

nhỏ hơn. Ngược lại với màn hình lớn.  
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PHẦN III: SỬ DỤNG CÁC BIỂU MẪU CÓ SẴN TRONG 

1. Sức mạnh của các biểu mẫu (Template) 

 Mặc dù có thể bạn đã làm việc với Word và quen thuộc với các tài liệu của 

Word, có thể bạn vẫn không tường tận lắm về các biểu mẫu. Biểu mẫu là gì? Nó có 

thể giúp ích cho bạn ra sao? 

 Một biểu mẫu là một loại tài liệu đã có sẵn nội dung trong đó.như văn bản, kiểu 

trang trí, định dạng; định dạng trang như canh lề, cách dòng; các yếu tố trang trí như 

màu sắc, đường viền...  

 

 Hãy xem biểu mẫu như một trợ giúp hữu ích khi bạn bắt đầu soạn thảo tài liệu. 

Giả sử như hàng tuần bạn đều có một cuộc họp và bạn phải soạn đi soạn lại lịch họp 

với một vài thay đổi nhỏ mỗi lần. Hãy bắt đầu với một số thông tin phù hợp đã được 

chuẩn bị sẵn sẽ giúp bạn tiết kiệm rất nhiều thời gian. 

 Hãy theo dõi một vài ví dụ tạo tài liệu mới từ các biểu mẫu sẵn có trong Word và 

bộ Office ở các phần sau. Bạn có thể sử dụng các biểu mẫu này để tào ra các tài liệu 

chuyên nghiệp và ấn tượng cho riêng mình 

2. Sử dụng các mẫu trang bìa Fax có sẵn 
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 Giả sử công việc của bạn phải thường xuyên gửi Fax cho khách hàng và đối tác, 

bạn luôn cần có một trang bìa ghi lại nội dung của các bảng Fax. Bạn có thể tự tạo 

trang bìa như vậy mỗi khi bạn gửi / nhận Fax. Hoặc bạn cũng có thể sử dụng biểu mẫu 

sẵn có trong Word. 

 Bản sẽ tìm thấy biểu mẫu như trên hình minh họa, giữa rất nhiều biểu mẫu khác 

trong Word. Bạn chỉ cần điền các thông tin phù hợp, in ra và gửi Fax. Thế là xong, rất 

đơn giản và nhanh chóng. Thậm chí bạn có thể thêm hoặc xóa một số phần tùy theo 

nhu cầu cụ thể, tuy nhiên, những gì thiết yếu nhất đã có sẵn và bạn không phải bắt đầu 

từ con số 0. 

3. Sử dụng các mẫu lịch làm việc sẵn có 

 Đây là một ví dụ khác cho thấy các biểu mẫu Word có thể giúp ích cho bạn như 

thế nào. Hãy tưởng tượng bạn được giao nhiệm vụ thiết kế lịch họp hàng tuần cho 

nhóm.   

 

 Trước khi bắt đầu từ một trang tài liệu rỗng, bạn hãy thử tham khảo một số biểu 

mẫu có trên trang Microsoft Office trực tuyến - bạn có thể liên kết trực tiếp tới các 

biểu mẫu này (bạn sẽ được hướng dẫn sau). Có rất nhiều biểu mẫu trong các danh mục 

khác nhau, thông dụng nhất là: Lịch làm việc. Lịch ngày tháng, Thư từ, Sơ Yếu Lý 

Lịch v.v... Có rất nhiều cho bạn lựa chọn. 

Hình minh họa cho thấy 3 biểu mẫu: 

1. Đây là mẫu đơn giản và trực quan với các văn bản và vùng đã được định 

dạng để bạn điền  

2. Một mẫu hoàn chỉnh, theo phong cách nghệ thuật. 

3. Mẫu này sử dụng định dạng Bảng (Table) và sử dụng các màu sắc khác 

nhau để phân biệt giữa các vùng. Đây là một mẫu tương đối phức tạp.  

4. Tìm những biểu mẫu đã được cài đặt kèm với Word 
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 Có khoảng 30 biểu mẫu được cài đặt kèm với Word như: Thư từ, Fax, Báo Cáo, 

Sơ Yếu Lý Lịch và Blog. Bạn sẽ tìm thấy các biểu mẫu này bằng cách: 

1. Click nút Microsoft Office, sau đó chọn New. 

2. Trong cửa sổ New Document chọn Installed Templates. 

3. Click vào các hình đại diện và xem thử biểu mẫu trông như thế nào phía 

bên phải.  

4. Khi chọn được mẫu phù hợp, Click vào nút Create. 

 Một tài liệu mới được tạo ra dựa trên biểu mẫu bạn chọn, và việc của bạn bây 

giờ là điền những nội dung phù hợp.  

5. Tìm các biểu mẫu trên trang Microsoft Office trực tuyến 

 Tạo một tải liệu mới như bước trên, tuy nhiên thay vì chọn Installed Templates 

bây giờ bạn sẽ chọn theo các danh mục phía dưới trong phần Microsoft Office 

Online. 

 

 Hãy Click vào từng danh mục để xem hình đại diện của các biểu mẫu trong danh 

mục đó. Tương tự như với các biểu mẫu được cài đặt sẵn, khi bạn Click vào hình đại 
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diện thì một mẫu xem trước của biểu mẫu đó sẽ hiện lên phía bên phải.Một số danh 

mục như Thư Từ (Letters) có các danh mục con để bạn lựa chọn.  

 Để tải các biểu mẫu về máy bạn hãy chọn hình đại diện của biểu mẫu rồi nhấn 

Download. Biểu mẫu tải về sẽ mở ra một tài liệu mới, sẵn sàng cho bạn làm việc.  

 Biểu mẫu gốc sẽ không bị thay đổi, nó vẫn nằm trên trang Microsoft Office trực 

tuyến. Tuy nhiên, một bản sao đã được lưu về máy tính của bạn, khi cần sử dụng bạn 

hãy mở thư mục My Templates trong Word mà không cần tải về một lần nữa.  

6. Khả năng đặc biệt của biểu mẫu 

 Như đã đề cập ở các phần trước, khi bạn mở một biểu mẫu một tài liệu mới được 

tạo ra dựa trên biểu mẫu mà bạn chọn. Thực chất bạn làm việc với một bản sao chứ 

không phải bản thân biểu mẫu. 

 

 Đó chính là khả năng đặc biệt của biểu mẫu: Tự tạo một bản sao khi được mở, 

bản sao này tạo ra tất cả các thành phần của biểu mẫu trong một tài liệu hoàn toàn 

mới. Bạn làm việc với tài liệu mới đó, thừa hưởng tất cả các thành phần có trong biểu 

mẩu và có thể thêm bớt nội dung tùy ý. 

 Vì bạn làm việc trên một tài liêu mới nên những hiệu chỉnh mà bạn thực hiện sẽ 

không ảnh hưởng tới biểu mẫu gốc, nó luôn được giữ ở trạng thái nguyên bản. Vì vậy, 

một biểu mẫu có thể là nền tảng cho vô số tài liệu. 

7. Biểu mẫu và tài liệu là hai định dạng khác nhau 
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 Biểu mẫu (Template) và Tài liệu (Document) có định dạng file khác nhau. 

 Nếu bạn đã từng lưu nhiều tài liệu Word có lẽ bạn đã quen thuộc với việc chọn 

định dạng sẵn có để lưu file. Đây là sự khác biệt giữa Biểu mẫu và Tài liệu: 

1. Biểu mẫu được lưu dưới dạng Word Template và nó có đuôi file là 

".dotx" (các phiên bản Word trước đây là ".dot"). 

2. Tài liệu được lưu dưới dạng Word Document và nó có đuôi file là 

".docx" (các phiên bản Word trước đây là ".doc"). 

 Biểu mẫu và Tài liệu có định dạng file khác nhau và cách hoạt động của chúng 

cũng khác nhau.  
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PHẦN IV: CÁCH TRÌNH BÀY THÔNG TIN HIỆU QUẢ TRONG 

WORD 2007 

1. Danh sách dạng số và ký hiệu 

a. Một danh sách đơn giản 

 Danh sách (List) là một thành phần rất hữu ích trong tài liệu, nó dùng để tóm 

tắt, liệt kê thông tin giúp người đọc dễ hiểu và hiểu vấn đề sâu hơn. Có 2 dạng danh 

sách là dạng đánh số (Numbering) và dạng ký hiệu (Bullet). Nếu bạn có một chuỗi 

thông tin có phân biệt mức độ hoặc thứ tự thì danh sách dạng số là lựa chọn thích hợp. 

Còn nếu chỉ cần liệt kê thì nên dùng dạng ký hiệu. 

 

 Ví dụ minh họa danh sách dạng chữ và số, đơn cấp và đa cấp.  

  Danh sách còn có sự phân cấp: đơn cấp và đa cấp. Một danh sách đơn cấp là 

danh sách mà trong đó các thành phần loại hoặc tính chất. Danh sách đa cấp có nghĩa 

là một hoặc nhiều thành phần trong danh sách có thể chứa một danh sách khác. Bạn có 

thể thấy sự khác biệt giữa danh sách đơn và đa cấp trong hình minh họa. 

Trong phần này chúng ta thảo luận về một danh sách đơn giản, chỉ có một cấp (đơn 

cấp). Các danh sách đa cấp sẽ được đè cập trong phần sau. 

b. Tạo một danh sách bằng cách gõ các ký tự thích hợp 

 Có nhiều cách để tạo một danh sách, nhưng cách đơn giản nhất là tạo tự động 

bằng cách gõ một số ký tự hoặc tổ hợp ký tự ở đầu câu. Nếu bạn muốn tạo danh sách 

dạng ký hiệu (Bullet) thì hãy đánh dấu sao (*) đầu câu, tiếp theo là một khoảng trắng. 

Dấu * sẽ tự động biến thành một ký hiệu hình chấm đen vậy là danh sách của bạn đã 
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được khởi tạo. Khi đã xong thành phần đầu tiên của danh sách, hãy gõ ENTER, lúc 

này một chấm đen khác sẽ tự động xuất hiện sẵn sàng cho thành phần tiếp theo. 

 

 Nếu muốn tạo danh sách dạng số tự động hãy gõ số 1 và dấu chấm (1.), tiếp theo 

là một khoảng trắng. Đây là một điểm mới trong Word 2007, ở các phiên bản trước 

bạn phải nhấn phím ENTER thì danh sách mới được khởi tạo. 

 Danh sách dạng chữ (a, b, c,...) chỉ là một cách thể hiện khác của danh sách dạng 

số nên cách khởi tạo cũng tương tự: bạn hãy gõ chữ a và dấu chấm (a.) sau đó là một 

khoảng trắng. 

 Ngoài dạng hình chấm đen như trên, danh sách ký hiệu còn có nhiều biểu tượng 

khác để bạn chọn lựa như hình vuông, hình kim cương, hình mũi tên v.v... 

c. Kết thúc một danh sách 

 Bạn đã gõ xong phần cuối cùng trong danh sách, làm sao để kết thúc và các ký 

hiệu hay chữ số không tự động xuất hiện nữa.  

 

 Cách dễ nhất để kết thúc việc tạo danh sách là nhấn phím ENTER hai lần liên 

tiếp. Bất cứ khi nào bạn nhấn ENTER thì một ký hiệu hoặc một con số mới sẽ xuất 
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hiện để chuẩn bị cho một thành phần mới trong danh sách, tuy nhiên nếu bạn nhấn 

ENTER một lần nữa thì ký hiệu / con số đó sẽ biến mất để bạn có thể bắt đầu một 

đoạn văn bản mới. 

 Nếu bạn muốn thực hiện khác một chút chảng hạn như lúc đang ở giữa danh 

sách bạn muốn tạo một dòng mới mà không có ký hiệu hay số phía trước và dòng mới 

này nằm ngang hàng với thành phần phía trên của danh sách. Lúc này, hãy sử dụng 

phím BACKSPACE (xóa lùi) để xóa ký hiệu (hoặc số) đầu dòng trong khi vẫn giữ 

nguyên canh lề so với dòng văn bản phía trên. Nếu bạn muốn dòng mới nằm ngang 

với ký hiệu (hoặc con số) thay vì nằm ngang văn bản phía trên, hãy nhấn 

BACKSPACE một lần nữa. 

d. Ký hiệu hay chữ số 

 Bạn lỡ chọn sai kiểu danh sách? Bạn chọn kiểu danh sách là ký hiệu nhưng bây 

giờ thấy kiểu chữ số sẽ hay hơn, hoặc ngược lại? Không có gì đáng lo, chuyển qua lại 

giữa hai kiểu rất dễ dàng. Hãy Click vào bất cứ vị trí nào trong danh sách, sau đó nhấn 

vào nút Bullet hoặc Numbering trên thanh Ribbon. 

 

 Bạn cũng có thể dùng các nút trên để bắt đầu một danh sách bằng cách Click vào 

nút phù hợp rồi bắt đầu gõ thành phần đầu tiên của danh sách. Hoặc bạn cũng có thể 

chọn những đoạn văn bản mà bạn muốn tạo danh sách rồi nhấn nút phù hợp. Mỗi đoạn 

sẽ tương ứng với một thành phần trong danh sách. 

e. Thay đổi ký hiệu cho danh sách 

 Nếu bạn có một danh sách dạng ký hiệu (Bullet) và cảm thấy nhàm chán với các 

chấm đen hình tròn thì bạn có thể thay thế chúng bằng các ký hiệu khác có sẵn trong 

Word. Hãy Click vào nút mũi tên bên cạnh nút Bullet để xem thư viện Bullet. 
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 Thậm chí nếu bạn không hài lòng với các ký hiệu sẵn có, bạn có thể tự tạo các 

ký hiệu của riêng mình. Hày chọn Define New Bullet để thực hiện điều đó. 

 

Có 2 dạng ký hiệu mà bạn có thể tạo: Biểu tượng (Symbol) và Hình ảnh (Picture).  

 Các ký hiệu biểu tượng sử dụng một ký tự trong các bộ Font đặc biệt như 

Weddings và Windding. Để sử dụng các biểu tượng này bạn phải cài đặt bộ Font phù 

hợp trong máy tính. Bạn cần chú ý điều này vì nếu bạn gửi tài liệu cho một người nào 

đó mà trong máy tính của họ không có bộ Font phù hợp sẽ dẫn đến lỗi hiển thị. 

  Ký hiệu dạng hình ảnh thực chất là những bức ảnh rất nhỏ. Bạn có thể tìm thấy 

rất nhiều dạng ký hiệu hình ảnh trên Microsoft Office Online. Hoặc bạn có thể tự tạo 

cho riêng mình, chỉ cần lưu ý các ảnh này phải rất nhỏ nên đừng sử dụng các hình ảnh 

quá phức tạp.  

  Cùng với Thư viện Bullet còn có Thư viện Numbering hoạt động tương tự. 

Bạn có thể chỉnh sửa Font, màu sắc, kích thước cho các ký hiệu dạng số của danh 

sách.  

f. Định dạng danh sách 
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1. Chọn các số trên danh sách. 

2. Định dạng lại.  

3. Danh sách với kiểu định dạng mới. 

 Bạn có thể định dạnh số hoặc ký hiệu của danh sách mà không làm ảnh hưởng 

đến phần còn lại. Ví dụ thay vì dùng kiểu màu đen in đậm mặc định bạn có thể thay 

bằng màu đỏ. Cách thự hiện như sau: Chọn các chữ số hoặc ký bằng cách Click vào 

một trong số chúng, chú ý không chọn phần văn bản. 

 Sau khí chọn xong hãy dùng các nút lệnh trên thanh Ribbon để định dạng theo ý 

của bạn. Clcik ra ngoài danh sách để xem sự thay đổi.  

g. Làm việc với đoạn văn bản trong danh sách và dán danh sách 

 Giả sử bạn có một danh sách với các dấu chấm màu đen hoặc các con số ở đầu 

dòng, bạn muốn một số thành phần trong danh sách có các đoạn văn bản không có ký 

hiệu nào ở đầu như trên hình minh họa. Có nhiều kịch bản và cách xử lý tùy theo yêu 

cầu và kinh nghiệm của người dùng. 

 

 Giả sử bạn muốn xóa ký hiệu hoặc số ở đầu một đoạn nào đó nhưng vẫn muốn 

giữ canh lề ngang với phần còn lại trong danh sách hãy click chuột ngay sau chấm đen 

rồi nhấn nút BACKSPACE. 

 Nếu bạn muốn xóa ký hiệu hoặc số ở đầu một đoạn và muốn đoạn đó được canh 

lề cao hơn với canh lề của tài liệu thay vì nằm ngang với các thành phần còn lại của 

danh sách hãy chọn vào ký hiệu hoặc con số đầu dòng rồi nhấn DELETE.  

 Để tạo một đoạn văn bản con trong một thành phần của danh sách hãy nhấn 

SHIFT + ENTER thay vì chỉ nhấn ENTER. Lúc này đoạn văn bản phụ sẽ có canh lề 

ngang với các phần trong danh sách nhưng không có ký hiệu hoặc con số ở đầu.  

 Để tiếp tục danh sách sau khi hoàn thành đoạn văn bản con hãy gõ vào số tiếp 

theo trong danh sách và một dấu chấm (.) danh sách sẽ tự động tiếp tục đánh số. Lưu ý 
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là nếu bạn nhấn vào nút Numbering thì Word sẽ khởi tạo một danh sách mới và đánh 

số lại từ đầu. Lúc này có một nút Auto Correct Options xuất hiện bên cạnh danh 

sách mới, hãy nhấn vào nút này sau đó nhấn Continue Numbering để danh sách mới 

sẽ được gắn lại vào danh sách cũ. 
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PHẦN V: THÊM NHỮNG GHI CHÚ VÀ THEO DÕI VIỆC CHỈNH 

SỬA TÀI LIỆU 

1. Kiểm tra tài liệu bằng chức năng Track Changes trong Word 2007 

a. Track Changes và Comments 

 Bạn đang xem lại tài liệu cho Sếp trước khi nó được công bố cho toàn công ty và 

bạn thấy có một số điểm cần chình sửa, bạn muốn Sếp của mình thấy những điểm cần 

chỉnh sữa đó. Hãy bật chức năng Track Changes, tất cả thay đổi từ việc thêm, xóa 

hoặc định dạng văn bản đều sẽ được Word đánh dấu. 

 

 Chọn thẻ Review, nhóm Tracking, chọn Track Changes. Khi bạn click lần đầu 

nền của nút Track Changes sẽ thay đổi màu sắc, bất cứ sự thay đổi nào trong tài liệu 

sẽ được đánh dấu cho đến khi bạn tắt Track Changes bằng cách nhấn nút Track 

Changes lần nữa. 

b. Xem các chỉnh sửa 
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1.  Văn bản bị xóa nằm trong một hình chữ nhật ở góc. 

2.  Văn bản được thêm vào sẽ được gạch dưới và có cùng màu với với viền hình chữ 

nhật chứa văn bản bị xóa.  

3. Những đường đứt quãng chỉ ra những phần có sự thay đổi, nơi nội dung text được 

xóa hay thêm vào. 

 Sau khi bạn mở tab Track Changes, bạn sẽ làm việc trong Word như bình 

thường. Khi chèn hoặc xóa văn bản, hay di chuyển văn bản hoặc đồ họa, thì các 

đường đứt quảng sẽ đánh dấu sự thay đổi này, màu sắc và nội dung thay đổi cũng 

được đánh dấu. 

 Bạn xóa dòng "with hard work and clear thinking.", dòng văn bản này được đặt 

trong một box hình chữ nhật nhỏ ở góc tài liệu, nó được đánh dấu là "Bị xóa 

(Deleted)" để giải thích vì sao nó phải nằm ở đó. Một được đứt quãng màu xanh chạy 

dài từ hình chữ nhật đến nơi mà dòng văn bản đã nằm trước khi bị xóa.  

 Bạn thay từ "twelve" bằng "nine" bạn chọn từ "twelve" và gõ "nine" để thay thế 

nó (hoặc cũng có thể xóa "twelve" rồi gõ "nine" tại vị trí đó). Từ "twelve" bị xóa sẽ 

được chuyển vào hộp một hình chữ nhật ở góc tài liệu. Từ "nine" mới thêm vào sẽ 

được gạch dưới và có cùng màu với viền của hình chữ nhật chứa "twelve".  

 Ngoài ra, có một gạch dọc phía trước mỗi câu mà trong đó có thực hiện chỉnh 

sửa. 

c. Thêm comment 

 Bạn đã thực hiện một số sửa đổi, nhưng bạn cũng muốn giải thích lý do tại sao 

bạn xóa từ "twelve" trong câu đầu tiên. Rất đơn giản: hãy thêm một bình luận (hoặc 

ghi chú) (Comment), đó là những chú thích mà bạn có thể thêm vào các tài liệu. Để 

thực hiện điều đó, chuyển con trỏ vào cuối của văn bản bạn muốn chèn Comment, trên 

thẻ Review, trong nhóm Comments, chọn New Comment. 
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 Một Comment đã xuất hiện ở góc tài liệu, từ mà bạn muốn ghi chú được tô sáng 

cùng màu với màu của hình chữ nhật chứa ghi chú (màu tím nhạt trong hình minh 

họa). Bạn có thể phân biệt Comment và những văn bản bị xóa dựa vào các điểm sau: 

 - Hình chữ nhật chứa Comment có tô màu trong khi hình chứa văn bản bị xóa chỉ 

có viền mới có màu.  

 - Nhãn "Comment" trên hình chữ nhật chứa ghi chú.  

 - Tên người ghi chú.  

Lưu ý: Bạn không cần phải mở Track Changes để chèn Comment, vì bạn có thể thêm 

comment bất cứ thời điểm nào. 

d. Phân biệt việc chỉnh sửa của từng người tham gia review tài liệu 

 Khi có nhiều người review một tài liệu, bạn có thể biết được thay đổi nào đã 

được ai thực hiện. Dưới đây là một số cách biết người nào đã thay đổi những gì. 

 

 Di chuyển con trỏ lên văn bản mới được chèn vào trong tài liệu, hoặc trên các 

văn bản đã bị xóa trong hình chữ nhật ở góc tài liệu. Đối với mỗi sửa đổi, bạn sẽ thấy 

một ScreenTip chỉ ra tên của người sửa và các loại của các sửa đổi, chẳng hạn như 

"đã xóa" (deleted) hoặc "chèn" (inserted). Các ScreenTip cũng hiển thị thông tin đã 

bị xóa hoặc chèn vào văn bản.  

 Một cách khác để phân biệt những người tham gia hiệu chỉnh tài liệu là dựa vào 

màu sắc. Word tự động đánh dấu một màu sắc của từng người tham gia hiệu chỉnh, 

mỗi người một màu khác nhau. Giả sử bạn được Word gán cho màu hồng khi hiệu 

chỉnh tài liệu, nếu bạn muốn xem chỉ những chỉnh sửa của mình thì hãy tìm những 

văn bản có tô sáng hoặc các hình chữ nhật màu hồng ở góc.   

e.Tắt Track Changes không ảnh hưởng đến các đánh dấu thay đổi hoặc ghi chú 

Mặc dù tắt Track Changes, nhưng những sự thay đổi vẫn còn thấy được trong tài liệu. 
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 Nếu bạn muốn biết tắt chức năng Track Changes có làm đánh những đánh dấu 

hoặc ghi chú trong tài liệu không thì câu trả lời là KHÔNG. 

 Như trong hình minh họa, mọi thứ bạn làm với tính năng Track Changes vẫn còn 

ngay khi bạn đã tắt Track Changes. Chỉ có một điểm lưu ý là sau khi tắt Track Change 

thì những thay đổi tiếp theo của bạn sẽ không còn được Word đánh dấu nữa. 

f. Chấp nhận hoặc từ chối comment (ghi chú) và thay đổi 

 

1. Sử dụng nút Accept để chấp nhận sự thay đổi cùng một lúc hoặc liên tục các thay 

đổi, hoặc để chấp nhận tất cả các thay đổi cùng một lúc.  

2. Sử dụng các nút Reject để từ chối sự thay đổi cùng một lúc hoặc liên tục các thay 

đổi, hoặc để từ chối tất cả các thay đổi cùng một lúc. 

3. Sử dụng các nút Previous để xem từng ghi chú hoặc hiệu chỉnh theo hướng lên trên 

của tài liệu. 

4. Sử dụng nút Next để xem theo hướng xuống cuối của tài liệu. 

 Khi tất cả những thay đổi đã được hoàn tất, một người nào đó phải có trách 

nhiệm xem lại tài liệu sau đó chấp nhận hoặc từ chối những thay đổi. 
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 Sử dụng nút Accept hoặc Reject trên Tab Review trong nhóm Changes hoặc 

Click-Chuột-Phải lên tài liệu để chấp nhận hay từ chối thay đổi và comment (bình 

luận, ghi chú). Khi những thay đổi và comment được chấp nhận bị xóa bỏ, tài liệu sẽ 

bị đánh dấu để chi ra rằng comment và những thay đổi đã được xóa ra khỏi tài liệu. 

Nhữn thay đổi được chấp nhận sẻ trở thành một phần của tài liệu khi nó được lưu lại. 

2. Track Changes và Comments - những tính năng nâng cao 

a. Ẩn tạm thời những thay đổi 

 Hãy tưởng tượng rằng bạn sẽ xem lại phần thay đổi tài liệu được thực hiện bởi 

Richard, Kai và Pilar. Bạn muốn xem phần thay đổi của Pilar trước và biết rằng bạn 

có thể tìm góp ý tài liệu của Pilar bằng cách di chuyển con trỏ chuột lên tất cả những 

sự thay đổi để thấy tên Pilar hoặc xem màu sắc được Word gán cho những hiệu chỉnh 

của cô ấy. Tuy nhiên, bạn nghĩ rằng nếu bạn chỉ có thể xem phần sửa chữa của Pilar 

mà không xem được phần của Richard và Kai thì không ổn, đặc biệt đối với những tài 

liệu dài. 

 

 Hãy tiếp tục khám khá bằng cách nào để học về sự thay đổi của track 

 Để chỉ xem những sửa chữa của Pilar, bạn có thể làm ẩn những cái sửa chữa của 

Richard và Kai. Cách thực hiện như sau: 

 Trên tab Review tab, trong nhóm Tracking, click dòng Show Markup, chỉ vào 

Reviewers và xóa dấu chọn trên mục All Reviewers, nó sẽ làm ẩn tất cả những hiệu 

chỉnh, của bất kỳ người nào. Sau đó click dòng Show Markup lần nữa, chỉ vào 

Reviewers và click vào hộp tên Pilar. Nó sẽ hiện ra phần comment và phần hiệu chỉnh 

của chỉ Pilar. Bạn có thể chấp nhận hoặc từ chối những gì đã được hiệu chỉnh bởi Pilar 

ngay tức thì hoặc có thể để sau.  

 Khi bạn đã thực hiện xong, thì hãy xem lại phần đã bị sửa chữa bởi những người 

khác bằng cách click Show Markup lần nữa, sau đó chọn All Reviewers.  
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b. Xem một tài liệu trước và sau khi thay đổi 

 Khi một tài liệu đã có rất nhiều comment và những phần bị sửa chữa, bạn có thể 

tự hỏi rằng tài liệu trước đây như thế nào hoặc bạn có nên chấp nhận hoặc từ chối các 

hiệu chỉnh.  

 

 Tính năng này được thực hiện như sau: Trên Tab Review, trong nhóm 

Tracking, Final Showing Markup là chức năng được chọn mặc định để hiệu chỉnh 

tài liệu. Để xem lại tài liệu trước đây, bạn Click vào Original. Để xem tài liệu sẽ trông 

như thế nào khi các hiệu chỉnh được chấp nhận và những comment đã được xóa, hãy 

Click vào hộp Display for Review và sau đó chọn Final. Nên nhớ rằng comment và 

những gì được hiệu chỉnh sẽ không bị xóa mất. Sau khi review tài liệu, click Final 

Showing Markup để xem lại comment và những hiệu chỉnh lần nữa. 

c. Ẩn những sự thay đổi không làm xóa comment và những cái bị điều chỉnh 

 Như đã đề cập trước đây ẩn comment và những hiệu chỉnh sẽ không xóa mất 

chúng, mà chỉ cho bạn thấy tài liệu sạch (không thấy những hiệu chỉnh hiện lên màn 

hình). 
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Cách để xem những gì ẩn trong tài liệu. 

 Trên tab Review, trong nhóm Tracking, Click Show Markup và chắc chắn rằng 

đã có những dấu check trên Comments, Ink, Insertions and Deletions và Formatting.  

Chọn vào Reviewers trên menu Show Markup và chắc chắn rằng đã có dấu check trên 

All Reviewers. 

d. Kiểm tra comment và những hiệu chỉnh 

 

1. Sử dụng những nút trong nhóm Changes để chấp nhận hay từ chối những hiệu 

chỉnh hoặc xóa những comment. 

2. Để thấy nội dung tài liệu ẩn những hiệu chỉnh hoặc comment, hãy Click bất cứ nút 

nào trong nhóm Comments hoặc Changes. Bạn sẽ thấy một hộp thoại mở lên như 

hình trên, Click Show All để xem tất cả comment và những hiệu chỉnh. 

 Cách duy nhất để làm mất các hiệu chỉnh là chấp nhận hoặc xóa chúng. Cách 

duy nhất làm mất bỏ comment là chấp nhận hoặc từ chối chúng. Khi chấp nhận thì các 

hiệu chỉnh và comment sẽ trở thành một phần của tài liệu và không bị đánh dấu nữa. 

 Khi bạn từ chối hoặc xóa các hiệu chỉnh và comment thì những gì được chỉnh 

sửa sẽ trở lại trạng thái trước khi thực hiện chỉnh sửa. Trước khi bạn phân phối tài liệu 

cho người khác, hãy chắc rằng bạn đã thực hiện các chấp nhận hoặc từ chối xóa với 

những hiệu chỉnh trên tài liệu. Sẽ không chuyên nghiệp nếu tài liệu bạn gửi cho người 

khác còn các nội dung đang chỉnh sửa. 

e. Chọn cách tạo track 
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 Bạn có thích những hình chữ nhật chứa văn bản bị xóa hay các ghi chú không? 

Hay bạn muốn thay đổi kích thước của chúng? Khi text được chèn vào trong tài liệu 

bạn thích đoạn text này xuất hiện với hai dòng gạch chân hay một dòng gạch chân? 

 Bạn có một vài chọn lựa cho việc thể hiện của comment và các hiệu chỉnh. Cách 

làm như sau: trên Tab Review, trong nhóm Tracking, Click vào dòng Track 

Changes, sau đó click Change Tracking Options. Bạn sẽ có nhiều chọn lựa để tùy 

biến những thể hiện của tính năng Track Changes. 
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PHẦN VI: NHỮNG TÁC ĐỘNG CUỐI CÙNG CHO TÀI LIỆU 

1. Căn bản về Header và Footer 

a. Thêm vào số trang, ngày giờ 

 Nếu bạn không chắc cái gì gọi là headers and footers, thì hãy nghĩ đến việc 

định dạng trang sách. Thông thường tên sách thường xuất hiện ở đầu mỗi trang và tên 

chương xuất hiện trang đối diện và ở dưới là số trang. 

 

 Đó là một dạng thể hiện của Header và Footer, nó được ứng dụng một cách 

tương tự trong Word. Thường thì có thể bạn muốn đánh dấu số trang trong suốt tài 

liệu. Các thông tin khác như tên tài liệu, tác giả, ngày in; tên công ty, địa chỉ email, 

địa chỉ web; tên file và vị trí file. 

 Không có qui luật cụ thể nào với Header và Footer, trong Word 2007, bạn có thể 

tạo ra Header và Footer theo ý của mình. 

b. Đánh dấu số trang 
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 Số trang (Page numbers) là sử dụng thông thường nhất của Header hoặc Footer, 

vì nó thật sự cần thiết cho tài liệu. Để đánh dấu số trang vào tài liệu ta làm như sau:  

1.  Trên Tab Insert, trong nhóm Header & Footer, chọn Page Number. 

2.  Chọn nơi mà số trang xuất hiện, ví dụ như trên, dưới, ở giữa... 

3. Sau đó chọn kiểu con số trong thư viện. 

 Số trang được áp dụng trong suốt tài liệu và chúng cũng được thay đổi nếu bạn 

xóa hay thêm vào số trang trong tài liệu. 

c.Thêm vào ngày tháng hiện tại 

 

Một vài Headers và Footers có sẵn trong thư viện bao gồm một Text Area (khu vực 

chèn văn bản) đặc biệt cho việc chèn ngày giờ. Nhưng bạn cũng có thể chèn ngày giờ 

hiện tại độc lập với Headers và Footers. Cách làm như sau:  

1. Click Header hoặc Footer nơi bạn muốn ngày giờ xuất hiện trên tài liệu.   

2. Trong nhóm Insert, chọn Date & Time.  

3. Chọn một loại định dạng ngày giờ. Bạn có thể chọn ngày hoặc giờ hoặc chọn cả 

hai.  

4. Chọn Update Automatically trong ô chọn.  

 Ngày giờ hiện tại sẽ cho bạn biết bất khi nào bạn mở tài liệu ra. Bạn cũng có thể 

cập nhật khi file được mở và điều chỉnh lại trước khi in ấn. 

d. Thêm tên file và đường dẫn đến file 

 Một kiểu Headers hoặc Footers thông thường khác là thêm tên cho tài liệu và 

đường dẫn đến nơi tài liệu được lưu trữ. Để chèn thông tin này một lần nữa bạn phải 

sử dụng Field (trường nội dung). 
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Hãy làm theo cách hướng dẫn sau: 

1. Trong nhóm Insert, click Quick Parts và chọn Field.  

2. Trong hộp Field, under Field names, chọn FileName.  

3. Click vào ô chọn Add path to filename.  

 Field FileName cho bạn cách cập nhật đường dẫn một cách tự động nếu bạn di 

chuyển tài liệu đi nơi khác. 

e. Xóa bỏ header hoặc footer 

 

 Bạn được chuyển một tài liệu và bạn cảm thấy cần xóa bỏ nội dung của Header 

hay Footer.  

1. Giả sử một thông tin ở Footer, chẳng hạn đường dẫn của tài liệu không còn cần 

thiết. 

2. Trong nhóm Header & Footer, chọn Footer.  

3. Chọn Remove Footer. 

 Số trang và Header cũng có chứa lệnh Remove với tác dụng tương tự.  

2. Header và Footer cho từng phần trong tài liệu 
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a. Tạo ra nhiều loại header và footer trong cùng một tài liệu 

 Bạn có một tài liệu nhiều phần và bạn muốn tạo ra nhiều loại Header và Footer 

tương ứng với từng phần. Hình minh họa bên trên cho biết từng phần tài liệu sẽ có 

Header và Footer khác nhau. 

 

 Với trang bìa bạn sẽ không cần số trang cũng như Header và Footer. 

 Đối với các phần đầu, chẳng hạn như Mục Lục, Header và Footer nên thể hiện 

sao cho người đọc biết đây chưa phải là nội dung chính. 

 Với các chương, Header và Footer lúc này rất cần thiết để định hướng cho người 

đọc, nhắc cho họ biết mình đang xem phần nào và ai là tác giả. 

 Bạn đã biết một điểm tiện dụng của Header và Footer là chỉ cần tạo một lần và 

có thể dùng xuyên suốt cả tài liệu. Nhưng với một tài liệu có nhiều phần bạn cần nhiều 

quyền kiểm soát Header và Footer hơn. 

Phải làm như thế nào?  

b.Tạo ra thành những phần khác nhau 

 Nếu tài liệu có nhiều phần bạn muốn tạo ra nhiều loại Header và Footer đi với 

từng phần, điều đầu tiên cần làm là tạo ra section breaks (ngắt đoạn) giữa từng phần 

của tài liệu. 
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 Một section break cho phép tạo ra một một cách trình bày duy nhất cho các 

trang trong phần đó. Với một cách trình bày (layout) được thiết lập, bạn có thể tạo 

Header và Footer theo cách bạn muốn cho từng phần (section). 

c. Cách phân chia từng section 

 

 Bạn chèn section break trong phần chính của tài liệu, chứ không phải bất cứ nơi 

nào trong không gian header và footer. Chính vì vậy, bạn phải đóng màn hình làm 

việc của Header và Footer trước khi thực hiện các bước sau đây: 

1. Chỉ con trỏ nơi bạn muốn bắt đầu một section mới.  

2. Trên Ribbon, chọn Tab Page Layout và chọn Breaks.  

3. Dưới Section Breaks, chọn Next Page. 

Word sẽ tạo ra một section break ở vị trí phía trên con trỏ chuột.  

d. Cách tạo mục lục header và footer khác nhau cho từng section 

 Một section break phân chia những gì bên trên nó thành một phần và những gì 

phía dưới là một phần khác. Vậy với một section break được chèn vào trước Chapter 

1, tất cả những gì trước đó (trang bìa, mục lục...) sẽ là phần 1 (section 1) và Chapter 1 

sẽ trở thành phần 2 (section 2).  

 Khi bạn mở không gian làm việc của Header và Footer, các thẻ đánh dấu sẽ xuất 

cho bạn biết bạn đang làm việc với Header và Footer của phần nào. Trong hình minh 

họa, các thẻ đánh dấu chỉ ra những phần khác nhau và gán cho mỗi phần một con số.  
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1. Footer này chỉ phần kết thúc của phần 1. 

2. Header bên dưới bắt đầu phần 2. 

3. Tab Same as Previous. Nó có ý nghĩa gì? 

 Nó có nghĩa là mặc dù bạn tạo ra những phần khác nhau nhưng Word vẫn có tùy 

chọn cho phép bạn chia sẻ những điểm chung giữa Header và Footer của mỗi phần. 

Trong hình minh họa, thẻ Same As Previous có nghĩa là nội dung của Header hiện tại 

được liên kết với nội dung Header của phần trước đó. Nếu bạn muốn Header hiện tại 

độc lập với Header trước bạn phải xóa liên kết giữa 2 Header. 

Với Footer cũng tương tự như Header.  

e. Cách tạo ra sự khác biệt cho trang đầu tiên 

 

 Khi bạn đã đưa các nội dung đầu (trang bìa, mục lục...) vào một phần riêng, bạn 

thậm chí còn có thể phân chia nó ra thành các phần nhỏ hơn nữa. Giả sử bạn không 

muốn bất cứ gì xuất hiện trên Header và Footer của trang bìa:  

1. Sử dụng chức năng Different First Page như hình trên để thực hiện. Nếu bạn chọn 

tùy chọn Different First Page thì có nghĩa bạn cho phép Header và Footer của trang 
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bìa này khác với phần còn lại của các trang trên cùng một phần (section). Bạn cũng có 

thể làm điều tương tự với các phần khác của tài liệu. 

2. Khu vực Header và Footer bây giờ sẽ có phần văn bản với nội dung "First Page 

Header" and "First Page Footer" (chỉ xuất hiện trong không gian làm việc Header và 

Footer).  

 Nếu bạn có áp dụng đánh số trang thì chứa năng Different First Page cũng ngăn 

không cho đánh số trang bìa.  

f. Header và Footer khác nhau cho các trang chẵn và lẻ 

 Khi bạn sử dụng thư viện Header và Footer được thiết kế sẵn, bạn sẽ thấy một số 

được tạo ra để dành riêng cho trang chẵn và lẻ. Nội dung của Header và Footer được 

đặt ở góc của trang, giống như trong thiết kế của các trang đối diện trong các quyển 

sách. Nếu bạn muốn in ra và đóng tài liệu của mình, có thể bạn sẽ cần định dạng 

tương tự.  

 

 Để tạo ra Header và Footer cho trang chẳng và lẻ, bạn thực hiện một tiến trình 

tương tự như trên: Tạo ra các phần khác nhau trong tài liệu bằng section break, xóa 

liên kết giữa các phần và thêm Header và Footer cho từng phần.  

Lưu ý khi thực hiện: Nếu bạn muốn Header hoặc Footer của các trang chẵn và Lẻ 

nằm ở góc trang bạn phải bật chứa năng Different Odd & Even Pages trong Tab 

Design trước khi thực hiện.  

3. Tìm hiểu về bảng mục lục (Table of contents - TOC) 

a. Cách làm việc với bảng mục lục tự động 

 Mục lục là một danh sách đơn giản liệt kê tên các chương. nó có thể phân thành 

nhiều cấp như trong hình trên.  
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 Mục lục cung cấp cái nhìn tổng quát của tài liệu giúp cho người đọc có thể tìm 

thấy từng phần một cách nhanh chóng. Word 2007 cung cấp cho bạn một cấp lập mục 

lục tự động. 

 

Có 2 bước để tạo mục lục tự động:  

  

1. Chuẩn bị tài liệu bằng cách gán các Heading Styles (kiểu trang trí tiêu đều) cho tên 

các chương và các tiêu đề mà bạn muốn xuất hiện trong mục lục.  

2. Thu thập các tiêu đề đó để tạo thành bảng mục lục.  

b. Bước 1: Chuẩn bị tài liệu cho bảng mục lục 

 Sau khi bạn đã quyết định các tên chương và tiêu đề sẽ xuất hiện trên mục lục 

bạn cần áp dụng một số Style đặc biệt để Word có thể thêm chúng vào mục lục tự 

động.  

 

Các Style này nằm trên tab Home, trong nhóm Styles. Với mỗi chương và tiêu đề làm 

như sau:  
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1. Chỉ con trỏ vào tên hoặc các tiêu đề của chương.  

2. Trong nhóm Styles, chọn Heading 1 cho cấp độ cao nhất là tên chương, Heading 2 

cấp độ tiếp theo, có thể là tên của của các phần trong chương và Heading 3 cho tiêu đề 

phụ.  

 Các Heading Styles và bảng mục lục tự động làm việc với nhau để tạo ra bảng 

mục lục cho tài liệu. Word chỉ định mục lục Heading 1 làm cấp độ cao nhất trong 

bảng mục lục, Heading 2 tương ứng với cấp độ cao thứ hai và Heading 3 cho cấp độ 

tiếp theo.  

c. Bước 2: Tạo bảng mục lục cho tài liệu 

 Sau khi chọn các Heading Style phù hợp cho từng phần, thì đã đến lúc thu thập 

tất cả chúng vào trong bảng mục lục, đây là lúc Word làm việc thay cho bạn.  

 

 Đầu tiên bạn chỉ con trỏ nơi bạn muốn bảng mục lục xuất hiện, thông thường thì 

người ta đặt mục lục ở đầu tài liệu. Trên tab References, chọn Table of Contents, sau 

đó click Automatic Table 1 hoặc Automatic Table 2 hoặc cái nào bạn cảm thấy phù 

hợp nhất. Rất nhanh và đơn giản.  

 Bảng mục lục sẽ xuất hiện với một hộp màu xanh nhạt. Đó là một hiệu ứng để 

thông báo cho bạn biết đây là một bản mục lục tự động.   

d. Cập nhật bảng mục lục 
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 Sau khi đã tạo ra bảng mục lục cho tài liệu, có thể bạn phải duy trì nó. Bảng mục 

lục sẽ tự động cập nhật khi tài liệu được mở; và còn hay hơn nữa khi nó cũng tự cập 

nhật bất cứ khi nào bạn thêm tên chương hoặc tiêu đề mới vào và làm thay đổi số 

trang của tài liệu. Chỉ cần thực hiện 2 bước sau:  

 Bạn cập nhật mục lục bằng cách Click vào tab References và sau đó chọn 

Update Table trong nhóm Table of Contents.  

 Khi cập nhật bảng mục lục bạn sẽ được hỏi rằng bạn muốn cập nhật toàn bộ mục 

lục hay chỉ muốn điều chỉnh số trang. Chọn điều chỉnh số trang nếu bạn thêm nội 

dung làm tăng số trang trong tài liệu mà không thêm tiêu đề nào mới, còn nếu bạn 

thêm hoặc thay đổi nội dung tiêu đề thì nên chọn Update entire table.  

 Bạn nên tránh việc sửa chữa trực tiếp vào bảng mục lục, vì nếu bạn đã từng cập 

nhật bảng mục lục thì bạn sẽ mất dữ liệu đã thay đổi. Để thay đổi nội dung trong bảng 

mục lục, thì hãy chỉnh sửa trên tài liệu, chứ không sửa trực tiếp trên bảng mục lục, sau 

đó click Update Table. 

e.Thay đổi bảng mục lục 

Có rất nhiều cách để bạn thay đổi bảng mục lục.  
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 Bên cạnh việc chon nhiều kiểu và định dạng đã có sẵn trong Word, bạn có thể tự 

thiết kế chi tiết bảng mục lục cho riêng mình, chẳng hạn như quyết định số cấp cho 

mục lục, có cho số trang xuất hiện hay không, tạo đường nối bằng dấu chấm giữa tiêu 

đề và số trang, v.v...  

 Bạn sẽ tìm hiểu các vấn đề này ở phần tiếp theo: Thay đổi hình thức bảng mục 

lục.  

4. Điều chỉnh mục lục 

a.Thay đổi hình thức bảng mục lục 

 Bạn đã có một bảng mục lục rồi, nhưng bạn lại muốn thay đổi chúng.  

 Ví dụ tiêu đề trong tài liệu của bạn có màu xanh nhưng trong bảng mục lục thì 

không. Bạn thích màu xanh và muốn trong bảng mục lục cũng có màu trùng với các 

tiêu đề trong tài liệu. 

 Có thể bảng mục lục quá dài và bạn muốn làm nó ngắn bớt. 

 

 Hoặc cũng có thể bạn đã hài lòng về bảng mục lục nhưng vẫn muốn có một thay 

đổi nhỏ. Chẳng hạn bạn muốn thay đỗi các đường chấm đứt quãng giữa các đề mục và 

số trang. Hoặc bạn muốn số trang nằm gần các đề mục hơn.  

 Tất cả những việc đó, và còn nhiều hơn, đề có thể thực hiện. 

b. Thiết kế lại bảng mục lục 

 Bạn đã có bảng mục lục, nó trông có vẻ ổn, nhưng bạn muốn màu sắc tương tự 

như tiêu đề. Đây là cách thực hiện: Trên Tab References, chọn Table of Contents 

trong nhóm Table of Contents và sau đó chọn Insert Table of Contents.  
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 Trong hộp thoại Table of Contents, chắc chắn rằng mục From template đã 

được đánh dấu trong hộp Formats, sau đó chọn Modify. Chọn TOC 1 trong hộp thoại 

Style để chọn cấp độ cao nhất hoặc Level 1, trong bảng mục lục TOC và sau đó chọn 

Modify. Hộp thoại Modify Style được mở ra, sử dụng hộp màu Font trong phần 

Formatting để chọn màu xanh.   

 Sau khi click OK hai lần, hãy xem trong mục Print Preview của hộp thoại Table 

of Contents và bạn sẽ thấy rằng Table of Contents, hay còn được viết tắt là TOC 1 

(hay Level 1), bây giờ là màu xanh.  

 Nếu bạn muốn thay đổi TOC 2 (Level 2) hay TOC 3 (Level 3) cũng thành màu 

xanh, thì bạn cũng làm theo quy trình trên bằng việc chọn TOC 2 hoặc TOC 3 trong 

hộp thoại Style trước khi đi đến hộp thoại Modify Style.  

 Sau khi click OK, một hộp thoại xuất hiện với nội dung hỏi bạn có muốn thay 

đổi bảng mục lục hay không, click OK và kết quả sẽ hiện thành màu xanh như ý 

muốn của bạn. 

c. Thiết kế lại bảng mục lục 
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 Bạn muốn thay đổi nhiều hơn nữa? Word 2007 cho người dùng nhiều tùy chọn 

để chọn lựa trong hộp thoại Modify Style, nhưng hãy luôn nhớ chọn Style mà bạn 

muốn thay đổi trong hộp thoại Style trước khi thực hiện chức năng Modify Style.  

 Chú ý rằng khi click Format, bạn sẽ có lựa chọn thay đổi như Font, Paragraph, 

Tabs, … bạn cũng có thể thay đổi các cài đặt của từng phần và xem lại chúng trong 

mục Preview trước khi áp dụng cho bảng mục lục.  

d. Cách làm ngắn hoặc kéo dài bảng mục lục 

 

 Bảng lục lục quá dài, có lẽ chỉ cần hai cấp độ đầu tiên TOC 1 và TOC 2 là phù 

hợp với tài liệu của bạn. Mục Show levels ở hộp thoại Table of Contents là nơi bạn 

có thể chọn các phân cấp bạn muốn thể hiện trong bảng mục lục. Word 2007 có đến 9 

cấp độ khác nhau.  

 Làm ngắn bảng mục lục bằng cách giảm cấp độ, còn muốn kéo dài bảng mục lục 

thì bạn hãy tăng cấp độ lên. Bạn có thể xem trong Print Preview hoặc Web Preview 

để xem sự điều chỉnh của mình, khi nhận thấy hợp lý, thì click OK hai lần. 

e. Cách thay đổi đơn giản bảng mục lục 

 Bạn có thể thực hiện các thay đổi nhỏ mà không cần rời khỏi hộp thoại Table of 

Contents.  

 Chẳng hạn thay đổi các gạch đứt quãng giữ các đề mục và số trang (gọi là Tab 

Leader), hoặc thay đổi canh dòng (align) của số trang.  
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 Để thay đổi Tab Leader, chọn mục Tab leader để xem lại kiểu gạch ngang và 

dòng. Nếu bạn xóa hộp Right align page numbers, thì số trang sẽ di chuyển lại gần 

hơn đến bảng mục lục và tab leaders sẽ không còn hiệu lực. Nếu bạn muốn xóa bỏ 

toàn bộ số trang thì hãy bỏ dấu chọn ở hộp Show page numbers. 

f. Cách xóa hay tạo lại từ đầu bảng mục lục 

 

 Nếu bạn muốn xóa bỏ bảng mục lục, thì hãy sử dụng lệnh Remove Table of 

Contents. Xóa bỏ bảng mục lục bằng hai cú Click-Chuột: Click lệnh Table of 

Contents và sau đó click Remove Table of Contents ở phần cuối của danh sách.   

 Hãy chắc rằng bạn sử dụng lệnh Remove Table of Contents, nếu bạn xóa thủ 

công trực tiếp bảng mục lục, có thể những mã ẩn sẽ lưu lại trong tài liệu của bạn. 

Những mã ẩn này có thể gây ra lỗi trong các bảng mục lục về sau.  

5. Tìm hiểu các trường và cách tạo nhiều mục lục 

a.Tạo Mục Lục bằng cách sử dụng các trường (field) 



Tìm hiểu Microsoft Office 2007- Tập 1: Tìm hiểu Microsoft Word 2007 

 

Biªn So¹n: Niemtin071@yahoo.com 64 

 

 Ngoài cách tạo Mục Lục cơ bản có có một cách nâng cao đó là sử dụng các 

trường mục lục (TOC fields).  

 

 Nếu bạn từng sử dụng trường trong Word có lẽ bạn đã thấy được sức mạnh của 

nó. Hãy học sử dụng các trường để tạo Mục Lục.  

 Nếu trường là khái niệm mới mẻ đối với bạn, hãy tìm hiểu chúng qua phần này 

và học cách dùng trường để tạo trực tiếp Mục Lục. Bạn sẽ biết tại sao chúng hữu ích 

nếu bạn muốn điều khiển hoàn toàn bảng mục lục.  

b. Trường (field) là gì? 

 Những ví dụ về trường mục lục. Mã của trường xuất hiện giữa các dấu ngoặc 

móc ({ }).  

 Trường (field) là một tập hợp lệnh chỉ dẫn Word tự động chèn nội dung hoặc 

thực hiện một công việc nào đó trong tài liệu. Trường được ứng dụng khá rộng trong 

Word và có một số việc bạn chỉ có thể thực hiện bằng trường, chẳng hạn như việc bỏ 

đánh dấu số trang cho một vài đề mục trong mục lục.  
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 Có lẽ bạn đã sử dụng các trường nhưng không nhận ra. Ví dụ số trang được điều 

khiển bởi trường, khi bạn tạo bảng mục lục tự động trong các phần trước, thụ ra bạn 

đã tạo ra các trường mục lục ra lệnh cho Word thu thập các đề mục để tạo thành bảng 

Mục Lục.  

 Trường mục lục là những thành phần cơ bản tạo nên bảng mục lục. Các bạn mục 

lục tự động dù được tạo bằng cách nào cũng đều dựa trên các trường mục lục để thu 

thập các đề mục. Khi kết quả thu thập của trường mục lục được hiển thị, bạn nhìn thấy 

bảng mục lục.  

 Bạn có thể xem các trường trong tài liệu bằng cách nhấn tổ hợp phím Alt + F9. 

Trường là những phần có dấu ngoặc móc xung quanh và phần đầu tiên cho biết loại 

của trường đó là gì. Hình minh họa trên là trường mục lục (Table of Content Fields).  

 Để lấy lại góc nhìn bình thường, ẩn đi các trường và xem kết quả hiển thị của 

chúng, hãy nhấn Alt + F9 một lần nữa.  

c. Các công tắc trường 

 Giả sử bạn muốn loại bỏ số trang với một số cấp trong bảng mục lục. Một cách 

làm đó là xóa số trang một cách thủ công và nhớ không cập nhật bảng mục lục. Nhưng 

đó là cách làm không đáng tin cậy, cách tốt hơn là dùng các field switches (công tắc 

trường).  

 

 Field switches là các lệnh bên trong trường để xác định các mã sẽ thực hiện 

những việc gì. Sức mạnh thực sự của các trường chính là các field switches này. Các 

field switches được thêm để kết thúc một trường và được đặt bên trong các dấu ngoặc 

móc, chúng bắt đầu với dấu sổ ngược ( \ ). Bảng mục lục tự động tạo ra các field 

switches thay cho bạn, nhưng bạn có thể thêm, bớt, hoặc hiệt chình các field switches 

này sau.  
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 Một bảng mục lục có thể có nhiều hơn một switch. Bảng mục lục trong hình 

minh họa chứa switch \o "1-3" , nó dùng để tạo mục lục dựa trên các đề mục được 

đánh dấu là Heading 1, Heading 2, và Heading 3. Switch \h làm cho các đề mục 

trong bảng mục lục biến thành các liên kết (hyperlink).  

 Để thêm một switch bạn gõ một dấu sổ ngược ( \ ) và ký tự lệnh vào giữa các 

dấu ngoặc móc, ví dụ để xóa hết các số trang trong mục lục hãy sử dụng switch \n như 

sau:  

{ TOC \o "1-3" \h \n }  

 Bạn có thể dùng hộp thoại Table of Contents để xóa số trang, tuy nhiên nếu bạn 

chỉ muốn xóa số trang ở cấp 2 và 3 thì bạn sẽ phải nhờ tới switch \n bằng cách gõ:  

{ TOC \o "1-3" \h \n "2-3"}  

d. Trường TC 

 Ngoài trường mục lục (TOC field) bạn có thể dùng trường TC (TC field) trong 

bảng mục lục tự động. Trường TC cũng là một cách để đánh dấu những đề mục mà 

bạn muốn xuất hiện trong bảng mục lục.  

Bạn sẽ dùng trường TC khi nào?  

 

 Giả sử có một tiêu đề mà bạn muốn xuất hiện trong mục lục nhưng nó lại quá dài 

và bạn chỉ muốn trích một phần trong đó. Bạn có thể dùng trường TC để lấy một phần 

của tiêu đề làm đề mục trong bảng mục lục.  

 Một ứng dụng khác của trường TC là nếu bạn nhận được một tài liệu có định 

dạng quá lộn xộn và bạn cần phải tạo một bảng mục lục cho nó. Sẽ nhanh chóng hơn 

nếu bạn sử dụng trường TC thay vì phải định dạng lại tài liệu.  
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e. Sử dùng trường TC để tạo đề mục cho bảng mục lục 

 

Đây là cách tạo ra trường TC:  

1. Chọn văn bản mà bạn muốn thêm vào bảng mục lục.  

2. Nhấn tổ hợp phím Alt + Shift + O để mở hộp thoại Mark Table of Contents 

Entry.  

3. Trong hộp thoại, hiệu chỉnh văn bản trong mục Entry nếu cần.  

4. Nếu có hơn một bảng mục lục trong tài liệu (mỗi bảng đại diện bởi một ký tự 

A,B,C...) hãy chọn bảng mục lục mà bạn muốn bằng trong phần Table identifier. Nếu 

chỉ có một bảng mục lục thì không cần lựa chọn phần này.  

5. Chọn cấp độ mà đề mục sẽ xuất hiện trên bảng mục lục trong phần Level.  

f. Thêm trường TC vào bảng mục lục 

 Để trường TC xuất hiện trong bảng mục lục, bạn phải thêm field switch \f vào 

bảng mục lục hiện tại. Field switch \f yêu cầu bảng mục lục thêm trường TC vào. 
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 Bạn có thể mở hộp thoại Table of Contents Options và chọn Table entry fields 

khi bạn tạo hoặc thay thế bảng mục lục. Nhưng có một các dễ hơn để tạo và hiệu 

chỉnh bảng mục lục tự động. Hãy nhấn Alt + F9 sau khi bạn tạo bảng mục lục và gõ 

"\f" vào phần cuối của trường nhu sau:  

{ TOC \o "1-3" \h \f }  

 Sau đó cập nhật trường bằng cách đặt con trỏ chuột vào trường mục lục và nhấn 

F9. Nhấn Alt + F9 lần nữa để xem kết quả.  

g. Tạo nhiều bảng mục lục trong một tài liệu 

 

 Nhiều tài liệu dài có thể có hơn một bảng mục lục, ngoài mục lục chung có thể là 

mục lục của riêng từng chương.  

 Cá loại sách hướng dẫn hoặc nghiên cứu có thể có nhiều bảng mục lục, ví dụ như 

một bảng mục lục cơ bản chỉ chứa tên chương và một bản mục lục chi tiết có chứa các 

phân trong một chương.  

 Bạn sẽ được hướng dẫn 3 cách để tạo nhiều bảng mục lục trong một tài liệu. 

Trong đó có một cách nhanh chóng sử dụng các Heading Styles có sẵn trong Word, 

hai cách còn lại sử dụng trong một số trường hợp đặc biệt.  

h. Cách cơ bản để tạo nhiều mục lục trong một tài liệu 

 Giả sử bạn muốn tạo 2 bảng mục lục cho cuốn sách dạy nấu ăn của mình. Một 

bảng mục lục rút gọn chỉ chứa tên chương và một bảng mục lục chi tiết. Bảng đầu tiên 

chứa tên chương như: Appetizers, Entrees, Sauces...Bảng thứ hai chi tiết hơn với tên 

các chương và các công thức chế biến trong từng chương.  
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 Nếu tài liệu của bạn sử dụng các Heading Styles có sẵn trong Word, cách thực 

hiện rất đơn giản. Tạo 2 bảng mục lục tự động, sau đó ở bảng đầu tiên đổi Swith \o từ 

"1-3" thành "1-1" :  

{TOC \o "1-1" \h}  

Đó là bảng mục lục cơ bản.  

 Vì bảng mực lục thứ hai chứa các đề mục đánh dấu với Heading 1, Heading 2 

và Heading 3 nên nó chính là bảng mục lục chi tiết của bạn.  

 Còn 2 cách khác để tạo nhiều mục lục trong một tài liệu đó là: trường TC và 

Bookmarks mà bạn sẽ được tìm hiểu tiếp theo.  

i. Hai lựa chọn khác để tạo nhiều mục lục trong một tài liệu 

 

 Bổ sung cho cách sử dụng Heading Styles và switch \o ở phần trước là 2 cách 

khác để tạo nhiều mục lục trong một tài liệu:  

 Dùng Table identifiers để đánh dấu mỗi bảng mục lục với một ký tự khác nhau.  

 Bookmark các phần, ví dụ như các công thức nấu bữa ăn sáng, hoặc công thức 

nấu bữa ăn trưa sau đó tạo mục lục cho từng phần. 
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j. Table Identifier 

 Để tạo nhiều hơn một bảng mục lục trong một tài liệu, với mỗi bảng chứa các đề 

mục khac nhau bạn có thể sử dụng Table Identifier.  

 Đầu tiên, bạn cần xác định ký tự đại diện cho mỗi mục lục, ví dụ "A" cho công 

thức nấu nước chấm và "B" cho công thức nấu bữa trưa.  

 

 Sau đó đánh dấu các đề mục mà bạn muốn xuất hiện bằng cách sử dụng trường 

TC như ở phần f , mục Table identifier trong hộp thoại Mark Table of Contents 

Entry dialog là nơi bạn chọn bảng mục lục phù hợp.  

 Khi tạo bảng mục lục bạn chỉ cần sử dụng duy nhất switch \f như sau:  

{ TOC \f B}  

  

Switch \f tạo ra bảng mục lục bằng cách thu thập các mục được đánh dấu bởi trường 

TC. Với ký tự B trong trường mục lục bảng mục lục chỉ hiển thị các trường TC tương 

ứng. Nếu thay B bằng A thì mục lục chỉ bao gồm các đề mục đánh dấu với Table 

identifier là A.  

k. Bookmark 

 Nếu tài liệu của bạn cần bảng mục lục cho một khối văn bản và bạn cũng đã sử 

áp dụng Heading Styles cho tài liệu thì bạn có thể dùng Bookmark để tạo bãng mục 

lục. Một chương trong sách là ví dụ hay về "khối văn bản" và bạn không cần phải 

đánh dấu riêng lẻ từng phần.  

 Bookmark trong Word không chỉ dùng cho bảng mục lục mà nó còn dùng để 

định danh một khối văn bản được chọn để dùng cho mục đích tham chiếu với một cái 

tên tùy ý do bạn đặt.  
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 Đầu tiên bạn cần đánh dấu đoạn văn bản bằng cách chọn toàn bộ khối văn bản. 

Sau đó trên Tab Insert, trong nhóm Links, chọn Bookmarks. Một hộp thoại xuất 

hiện để bạn đặt tên ("Breakfast" chẳng hạn) cho Bookmark vừa tạo. Khi đặt tên xong, 

nhấn Add.  

 Bây giờ hãy tạo mục lục bằng cách sử dụng switch \b cùng với tên Bookmark 

vừa tạo. Ví dụ mục lục cho công thức nấu bữa sáng như sau  

{ TOC \b "Breakfast" }  

 Khi đó, trường mục lục sẽ thu thập tất cả mục được đánh dấu bằng các Heading 

Style trong toàn bộ vùng được đánh dấu (bookmark) có tên Breakfast.  
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PHẦN VII: SỬ DỤNG MAIL MERGE ĐỂ TẠO MAIL HÀNG LOẠT 

1. Mail Merge căn bản 

a. Tìm hiểu và sử dụng mail merge (trộn thư) 

 

Trong bất kỳ Mail Merge nào, bạn làm việc với ba yếu tố khác nhau: 

1. Những tài liệu ban đầu. 

2. Người nhận thông tin, chẳng hạn như tên và địa chỉ của người mà bạn muốn kết 

hợp với các tài liệu chính.  

3. Các tài liệu đã hoàn thành, bao gồm các thông tin trong tài liệu chính cộng thêm 

mỗi thông tin riêng của từng người nhận. 

 Sự hiểu biết những yếu tố này sẽ giúp bạn đạt được những kết quả trộn thư như 

mong đợi.   

b. Tài liệu chính 

 Là những tài liệu có chứa nội dung thông tin giống nhau cho tất cả người. Tài 

liệu chính là điểm bắt đầu, nó có thể là một lá thư, phong bì, e-mail, hoặc thậm chí là 

một phiếu giảm giá.  
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1.  Nội dung là giống hệt nhau ở mỗi bản sao, ví dụ nội dung chính của một bức thư. 

Bạn chỉ cần đánh loại văn bản này một lần, không cần biết bạn sẽ in bao nhiêu lá như. 

2.  Danh sách người nhận bao gồm tên, địa chỉ hoặc có thể thêm nhiều thông tin khác 

như tên công ty, chức vụ. 

c. Thông tin người nhận 

 Trong Mail Merge, mỗi bản sao sẽ chứa thông tin của từng người nhận khác 

nhau, thông tin này được điền vào một khu vực định sẳn (place holder) trong tài liệu 

chính.  

 Thông tin người nhận có thể bao gồm: Địa chỉ trên bao thư, Tên trên câu chào 

trong thư, Tiền lương của từng nhân viên, v.v...  

 

 Thông tin người nhận phải được đặt trong một nguồn dữ liệu (data source), 

nguồn dữ liệu là khái niệm cơ bản bao trùm trong Mail Merge. Ví dụ một danh sách 

liên lạc (contacts) trong Microsoft Oulook là một nguồn dữ liệu. Các nguồn dữ liệu 

khác là một bảng (table) trong Word, một bảng tính Excel, một cơ sở dữ liệu Access, 

thậm chí là một tài liệu văn bản. 

 Thông tin người nhận thường được liệt kê theo dòng và cột như trong hình minh 

họa. Nguồn dữ liệu phải có cấu trúc rõ ràng để có thể xác định thông tin cho từng khu 

vực định sẳn (place holder) trong tài liệu chính. 

d. Bộ tài liệu khi hoàn tất 

 Tập hợp các tài liệu đã hoàn thành trong một thư có nội dung giống nhau mà bạn 

dự kiến đem in hoặc gửi bằng thư điện tử. 
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Khi đã hoàn tất việc trộn thư bạn sẽ có: 

Một tập hợp tài liệu hoàn chỉnh riêng biệt mà bạn có thể in (như thư, bì thư...) hoặc 

gửi qua mạng (như email).  

Nội dung chính được giữ nguyên trong tất cả các tài liệu, chỉ có thông tin người dùng 

sẽ thay đổi trong từng tài liệu. 

2. Chuẩn bị danh sách thông tin người nhận 

a.Thiết lập danh sách người nhận trong mail merge 

 Các cột và hàng trong một danh sách người nhận và khu vực định sẳn (place 

holder) trong tài liệu chính kết hợp cùng nhau để thực hiện việc trộn thư. 

 

 Bạn biết những gì là các yếu tố cơ bản của trộn thư. Bây giờ bạn sẽ tìm hiểu làm 

thế nào để thiết lập tài liệu chính của bạn và kết nối nó với danh sách người nhận.  

 Mail merge gồm hai phần chính là tài liệu và danh sách người nhận. Sau khi bạn 

hiểu những gì đang có hai thành phần chủ chốt và làm thế nào có liên quan, bạn sẽ có 

thể cài đặt và sử dụng thành công Mail Merges 
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b. Tìm hiểu thêm về danh sách người nhận 

 Các cột đại diện cho một loại thông tin người nhận; mỗi hàng là một bộ thông tin 

hoàn chỉnh cho từng người nhận. 

 

 Một danh sách người nhận có thể được thực hiện bằng bất kỳ chương trình nào, 

nhưng thông tin danh sách người nhận phải có cột và hàng. Bạn có thể tạo nó bằng 

cách sử dụng nhiều chương trình khác nhau, chẳng hạn như Excel, Access hoặc 

Outlook. 

1. Các cột trong một danh sách đại diện cho một nhóm hay loại thông tin. Mỗi cột 

được xác định bởi một cột tiêu đề. Ví dụ, một khách hàng trong danh sách bạn có thể 

có các cột cho họ tên, địa chỉ.  

2. Mỗi hàng trong một danh sách đại diện cho một thông tin đầy đủ của người nhận. 

Lưu ý rằng cần thiết phải ghi đúng tên và địa chỉ phải đầy đủ.  

 Từ các tài liệu chính, bạn kết nối vào danh sách thông tin người nhận và sau đó 

bạn có thể thêm bất kỳ cột nào vào một vị trí trong tài liệu chính đó.   

 Khi Mail Merge hoàn thành, sẽ có một tài liệu hoàn chỉnh cho mỗi người mà nó 

có chứa các thông tin từ các mục ở trong một hàng của danh sách người nhận. 

c. Danh sách thông tin người nhận đến từ đâu 
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Trong nhiều trường hợp, danh sách người nhận mà bạn muốn sử dụng đã tồn tại sẵn. 

Ví dụ:  

Thông tin Khách hàng với tên, địa chỉ, và nhiều hơn nữa.  

Các sản phẩm hay dịch vụ mà công ty bạn cung cấp.  

Thông tin về nhân viên của bạn.  

Nếu danh sách đã tồn tại, bạn có thể chỉ cần kết nối với nó với tài liệu chính trong 

Mail Merge.  

Nhưng đừng lo nếu bạn chưa có một danh sách. Mail merge có một bước cho bạn có 

thể tạo một danh sách người nhận từ đầu.   

Lưu ý: Bạn có thể thay đổi các dữ liệu trong danh sách người nhận vào bất kỳ lúc nào 

bằng cách mở hộp thoại Mail Merge Recipients trong khi hợp nhất hoặc bằng cách mở 

tập tin nguồn dữ liệu trực tiếp.  

d. Tìm hiểu Trường (Field) trong Mail Merge 

 Merge fields được bao quanh bởi dấu ngoặc kép (<< >>). 

Sau khi bạn kết nối với những danh sách người nhận, bạn có thể chỉ định các thông tin 

mà bạn muốn có trong thư hợp nhất bằng cách sử dụng các trường (fields). 

 

 Một trường là một tập hợp lệnh điều khiển Word tự động chèn thông tin vào tài 

liệu. Một không chính thức, có thể coi trường là một vị trí định sẵn (place holder). 

 Trong việc tạo và gửi thư hàng loạt, các trường mà bạn sử dụng được gọi là 

merge fields, và chúng là những vị trí định sẵn cho các thông tin đến trực tiếp từ một 

danh sách người nhận. Ví dụ, trong hình minh họa, merge fields đã được cập nhật các 

thông tin được lưu giữ trong các cột Địa chỉ và Tên của một danh sách người nhận. 

e. Tìm hiểu Merge field 
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Merge fields thực ra được tạo bởi các fields khác. Ví dụ, trong field Địa chỉ Block là 

một sự kết hợp của tên, tên họ , địa chỉ đường phố, thành phố, và mã bưu điện. 

«Tiêu Đề» «Họ Tên» 

«Địa Chỉ Tên Đường» 

«Thành Phố», «Bang» «Mã Quốc Gia» 

 Bạn cũng có thể kiểm soát cách nhìn thể hiện của thông tin người nhận trong các 

tài liệu đã hợp nhất (merged) bằng cách định dạng các trường (fields).   

 Ví dụ, bạn có thể muốn tên sẽ được in đậm hoặc màu đỏ. Trong tài liệu chính, 

chọn trường, bao quanh bởi các vạch hình chữ V ( «»). Trên Tab Home, bấm vào bất 

cứ lệnh trong nhóm Font hoặc các nhóm Paragraph, hoặc click vào nút Dialog Box 

Launcher  để thực hiện các tùy chọn định dạng mà bạn muốn. 

f. Thực hiện mail merge 

 

 Một phong bì đã được ghi địa chỉ người nhận bằng cách sử dụng Mail Merge 

Wizard.  

 Trong phần này bạn sẽ học những cách khác nhau để tạo Mail Merge. 
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Sau đó, bạn sẽ có một cơ hội để thực hành một thư hợp nhất (mail merge) của riêng 

bạn bằng cách sử dụng danh sách người nhận mà bạn đã xem trong các phần trước.  

g. Mail Merge Wizard 

 Để thực hiện một thư hợp nhất, chọn Start Mail Merge trên tab Mailings và sau 

đó chọn Step by Step Mail Merge Wizard.  

Trình Wizard sẽ mở ra một cửa sổ bên phải tài liệu. Cửa sổ này có thể di chuyển bằng 

chuột đến một vị trí mới trên màn hình và bạn cũng có thể thay đổi kích cỡ của nó. 

 

 Để thực hiện merge mail cần phải qua 6 bước, bạn làm theo hướng dẫn bằng 

cách chọn những tùy chọn phù hợp rồi nhấn Next ở dưới cùng của hộp thoại, nếu 

muốn quay lại thì nhấn vào Previous.  

 Trong Bước 1, trình Wizard sẽ mở ra với một câu hỏi bạn muốn loại tài liệu nào 

để thực hiện mail merge như Letters (thư), E-mail messages (email), Envelopes (bao 

thư), Lebels (nhãn mác) hay Directory (Thư mục). 

h. Cách tạo tài liệu chính cho mail merge 

 Hãy thử click vào tuỳ chọn Envelope (phong bì), trong Bước 2 của Wizard để 

chọn kích thước và các tuỳ chọn in ấn cho phong bì của bạn. 
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 Bước thứ hai bắt đầu thiết lập tài liệu khởi đầu. Bạn có thể sử dụng tài liệu đang 

mở, thay đổi cách trình bày của tài liệu hoặc chọn tài liệu khác.  

 Chọn Change document layout, sau đó click vào Envelope options nếu bạn 

muốn thay đổi kích thước phong bì.  

 Chọn Start from existing document nếu bạn có một phong bì lưu trước đó mà 

bạn muốn sử dụng mail merge, nhưng màn hình của bạn hiện đang mở một mở tài liệu 

trống, chọn tùy chọn này là nơi để thay thế các tài liệu trống đó cho phong bì của bạn. 

 Chọn Use the current document có nghĩa bạn bắt đầu với một tài liệu trống.   

i. Kết nối đến danh sách người nhận 

 Bước 3: Bạn chọn danh sách người nhận có sẵn hoặc bạn có thể tạo một danh 

sách mới. Trong bước này, bạn kết nối với những danh sách thông tin người nhận mà 

bạn muốn trộn vào vào các tài liệu của bạn. Bạn có ba lựa chọn: 

 

 Chọn Use an existing list nếu bạn đã có một danh sách người nhận có chứa 

những thông tin bạn muốn hợp nhất, hãy chọn đường dẫn cho file danh sách này. 

Chọn Select from Outlook contacts nếu bạn đã có danh sách liên lạc trong Outlook. 

Sau đó chọn Choose Contacts Folder để xác định vị trí file.  

 Chọn Type a new list nếu bạn chưa có danh sách người nhận. Danh sách mới 

được lưu như là một cơ sở dữ liệu Access với kiểu file là (.MDB) trong thư mục My 

Data Sources, nơi mà tài liệu của bạn cũng như thư mục được lưu vào đó. Và bạn 

cũng có thể tái sử dụng lại cho những lần trộn thư sau này.   

 Cách tốt nhất là bạn nên lưu các file danh sách là trong My Data Sources hoặc 

trong thư mục My Documents để thuận tiện cho mail merge. Tuy nhiên, bạn cũng có 

thể kết nối với bất kỳ danh sách thông tin người nhận nào từ vị trí trên máy tính của 

bạn hoặc từ máy chủ.   

j. Chọn danh sách người nhận trong email của bạn 
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 Bạn có thể chọn, phân loại, lọc danh sách và thông mà bạn muốn trong tài liệu. 

Sau khi kết nối với danh sách người nhận, chọn danh sách những người bạn muốn gửi 

thư. 

 Bạn hãy làm tất cả trong hộp thoại Mail Merge Recipients, hộp thoại này sẽ tự 

động mở ra sau khi bạn kết nối hoặc tạo ra danh sách mới.  

1. Tất cả những người nhận đều có một dấu chọn gần bên tên của họ, bạn có thể xóa 

dấu chọn này cho từng người. 

2. Lọc danh sách người nhận bằng cách click Sort... để chọn tên cột mà bạn muốn 

xem lại và sắp xếp. Click Filter... để nhập tên trường hoặc các giá trị trong danh sách 

người nhận mà bạn muốn. Click Find duplicates… để chạy một báo cáo xem có sự 

trùng lặp trong danh sách danh sách hay không . Click Find recipient… để xem thông 

tin một người nhận nào đó. Đối với Validate addresses… thì bạn phải có một chương 

trình dò lỗi địa chỉ thì mới thực hiện được chức năng này. 

k. Sắp xếp tài liệu chính 

Có rất nhiều cách để bạn thay đổi bảng mục lục.  
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 Trong bước 4 bạn sắp xếp lại tài liệu có nghĩa là đặt nội dung vào tài liệu, nó 

bao gồm: 

 Thông tin còn lại trong mỗi copy đã merge.  

 Vị trí định sẵn - Placeholders (fields) cho thông tin người nhận trong mỗi bản 

sao đã được trộn.  

 Cách nhanh nhất thêm một địa chỉ là click Address block trong Wizard. Ban 

đầu nó sẽ thêm «AddressBlock» trên lá thư (envelope), bao gồm họ tên, địa chỉ, 

thành phố, tỉnh thành, mã bưu điện.  

l. Xem lại mail merge 

 Bước thứ 5: Bạn có thể xem lại kết quả thực hiện trước khi hoàn tất việc trộn 

thư. Trong bước này bạn vẫn có quyền thay đổi bằng cách thêm hay bớt các trường 

(field), hạn chế người nhận hay điều chỉnh lại thông tin. 

 

 Sau khi bạn thêm tất cả nội dung và field trong tài liệu, bạn có thể xem lại tài 

liệu được trộn sẽ trông như thế nào. Trong bước 5 này bạn sẽ có một số chọn lựa:  

 Nếu mọi thứ trông có vẻ không ổn thì click Previous để trở lại bước thứ 4 để 

bạn có thể thêm, xóa,... hoặc sửa lại thông tin cho đúng.  

 Nếu mọi thứ đều ổn, click 2 lần vào nút ở trên đầu cửa sổ Wizard để duyệt 

những trang tiếp như hình bên trên.  

 Nếu bạn muốn xem tài liệu đã được trộn của một người nhận cụ thể nào đó thì 

click Find a recipient. Khi bạn xem qua tài liệu, bạn có thể bỏ bất cứ người nhận nào 

trong danh sách bằng cách click Exclude this recipient.  

 Nếu bạn nhận ra rằng trong danh sách có một số người nhận mà bạn không 

muốn có thì hãy click Edit recipient list, hộp thoại Mail Merge Recipients sẽ mở ra 

để bạn có thể bỏ chọn một hoặc nhiều người nhận trong danh sách. 
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m. Bước thứ 6: Hoàn tất việc merge 

 Khi đã hài lòng với những tài liệu merge sau khi xem lại và bạn sẵn sàng in, 

click Print để mở hộp thoại Merge to Printer, nhập thông tin về số trang cần in, sau 

đó nhấn OK. 

 

 Trong bước thứ 6 này bạn cũng còn cơ hội để thay đổi: Nếu bạn vẫn muốn xem 

lại kết quả hoặc điều chỉnh một bao thư (envelopes) cụ thể nào đó, hãy click Edit 

individual envelopes, thì nó sẽ tạo ra một bản trộn riêng bao gồm tất cả bao thư trong 

một tài liệu Word mới. Sauk hi xem lại hoặc sửa chữa các bao thư với tài liệu mới 

này, bạn có thể in ấn chúng. 

 Hoặc bạn có thể lưu trữ tài liệu và sẽ in ấn sau. Nếu bạn muốn giữa lại những 

thay đổi bạn đã thực hiện với bao thư cụ thể nào đó, hãy chắc chắn rằng mình đã lưu 

trữ tài liệu này. File này sẽ được lưu độc lập với tài liệu chính. 

n. Giới thiệu mail merges bằng cách sử dụng Ribbon 

 Các lệnh trong Tab Mailings luôn sẵn sàng khi bạn thực hiện các bước trong 

trình wizard  

 Ribbon cũng là một cách hữu ích để tạo một Mail Merge và quá trình xử lý rất 

giống với các bước trong trình Wizard. Bằng cách sử dụng thanh Ribbon, bạn sẽ có 

thể truy cập vào nhiều tính năng hơn, chẳng hạn như tự động kiểm tra tìm lỗi trước khi 

bạn hoàn tất việc hòa trộn. Ngoài ra còn có những yếu tố nâng cao, chẳng hạn như sử 

dụng các trường để thể hiện các thao tác hoặc tính toán trong tài liệu. 
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Những lệnh bạn dùng trên Tab Mailings trong bốn nhóm sau: 

1. Start Mail Merge: Đây là điểm bắt đầu từ nơi bạn chọn một loại tài liệu và sau đó 

chọn, tạo, hoặc chỉnh sửa danh sách người nhận. 

2. Write & Insert Fields: Đây là nơi bạn có thể chèn các Merge Field và sử dụng 

Rules để thể hiện các thao tác tính toán cho tài liệu. 

3. Preview Results: Bên cạnh việc xem lại tài liệu đã hòa trộn, bạn có thể sử dụng 

tính năng kiểm tra lỗi một cách tự động. 

4. Finish: Hoàn thành merge và kết hợp các tài liệu cá nhân của bạn vào một tài liệu 

toàn diện, hay in chúng ra hoặc gửi thư điện tử. 
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PHẦN VIII: NHỮNG KỸ NĂNG CƠ BẢN 

1. Giới thiệu thanh Ribbon 

a. Thanh Ribbon 

 Office 2007 được thiết kế để giúp bạn làm việc tiện lợi và hiệu quả hơn. Trong 

hệ thống Office 2007 gồm Word 2007, Excel 2007, PowerPoint 2007, Access 2007 

và một phần Outlook 2007 có một tính năng quan trọng mới được đưa vào đó là 

thanh Ribbon nằm ngang ở trên cùng thay thế hệ thống menu (trình đơn) và toolbar 

(thanh công cụ). Thanh Ribbon xuất hiện giúp bạn xử lý các tác vụ dễ dàng và nhanh 

chóng hơn, bao gồm những phím tắt mới.  

 

 Tại sao phải thay đổi? Nhiều nghiên cứu đã được thực hiện để tìm hiểu cách mà 

người dùng sử dụng Microsoft Office, và họ mong muốn chương trình hoạt động như 

thế nào. Giao diện mới là kết quả của tất cả các cuộc nghiên cứu đó. Lệnh và các chức 

năng được nhóm lại với nhau theo cách mà người dùng sử dụng chúng. Vì vậy giờ đây 

bạn không phải mất công tìm kiếm trong khi làm việc, mọi thứ đều nằm ngay trong 

tầm tay của bạn. 

b. Có những gì trên thanh Ribbon? 

 Thanh Ribbon có 3 thành phần căn bản, sẽ rất có ích nếu bạn biết mỗi phần được 

gọi là gì và cách sử dụng chúng. 
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1. Tab (thẻ) có 7 Tab cơ bản nằm ngang phía trên, mỗi Tab đại diện cho một vùng 

hoạt động. 

2.  Group (nhóm) mỗi Tab bao gồm nhiều Group tập họp các đối tượng có liên quan 

mật thiết với nhau. 

3. Command (lệnh) mỗi Command có thể là một nút, một vùng để nhập nội dung 

hoặc một Menu (trình đơn). 

Thanh Ribbon tự điều chỉnh dựa trên đối tượng mà bạn đang làm việc để đưa ra các 

lệnh và thao tác phù hợp. Ví dụ nếu bạn làm việc với biểu đồ trong Excel thì thanh 

Ribbon sẽ hiển thị các lệnh liên quan tới biểu đồ. Nếu không, các lệnh này sẽ được ẩn 

đi. 

c. Có nhiều tính năng mới trong các chương trình sử dụng thanh Ribbon 

 

Các chương trình sử dụng thanh Ribbon có 2 tính năng mới: 

1. Nút Microsoft Office the thế trình đơn File và đó cũng là nơi bạn có thể tìm thấy 

các lệnh cơ bản như trong trình đơn File trước đây, bao gồm: Open, Save và Print 

cũng như các cài đặt của chương trình, chỉnh sửa các thuộc tính tính, v.v... 
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2. The sits above the Ribbon and contains the commands that you want to keep near at 

hand. By default, the Quick Access Toolbar contains the Save, Undo, and Repeat (or 

Redo) commands, but you can customize it with whatever commands you want. 

Quick Access Toolbar (thanh công cụ truy cập nhanh) chứa các lệnh mà bạn muốn 

xuất hiện thường trực. Mặc định, Quick Access Toolbar chứa các lệnh Save, Undo và 

Repeat (hoặc Redo). Tuy nhiên bạn có thể tùy biến thanh công cụ này để nó chứa bất 

cứ lệnh nào mà bạn muốn. 

d. Các loại phím tắt 

Có 2 cách để sử dụng phím tắt. Giả sử để in đậm một chữ bạn có thể sử dụng: 

 

1. Phím truy cập các Tab và lệnh trên màn hình. 

2. Tổ hợp phím không nằm trên thanh Ribbon. 

 Nhiều người cho rằng bất kỳ sự kết hợp của một tồ hợp phím nào dẫn đến việc 

thực thi một lệnh đều có thể gọi là phím tắt, về cơ bản thì đó là một cách nghĩ đúng. 

Nhưng trong bài này chúng ta sẽ có một định nghĩa chính xác hơn về phím tắt. Xác 

định sự khác biệt rất quan trọng vì từng loạt phím tắt khác nhau sẽ có phương thức 

hoạt động khác nhau.  

Access Keys (phím truy cập)  

 Access Key cho phép bạn truy cập thanh Ribbon, nó liên hệ mật thiết với các 

Tab, lệnh và những thứ mà bạn nhìn thấy trên màn hình. Bạn sử dụng Acces Key bằng 

cách nhấn Alt rồi sau đó nhấn tiếp một phím hoặc một chuỗi tuần tự các phím.  

 Mỗi lệnh trên thanh Ribbon, trong trình đơn của nút Microsoft Office và trên 

Quick Access Toolbar đều có một phím truy cập riêng, mỗi phím truy cập được gán 

một Key Tip. Key Tip là một phiên bản mới của hệ thống ký tự gạch chân mà bạn 
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quen thuộc ở các phiên bản trước khi muốn truy cập các trình đơn bằng cách sử dụng 

phím Alt.  

Key combinations (tổ hợp phím)  

 Các tổ hợp phím dùng để thực hiện một lệnh nào đó và nó không liên quan tới 

những gì bạn nhìn thấy trên màn hình. Các phím phải được nhấn cùng một lúc để kích 

hoạt các lệnh, trong đa số trường hợp, dù không phải tất cả, đều có liên quan tới phím 

Ctrl (ví dụ nhấn Ctrl + C để copy).  

 Tổ hợp phím không thay đổi trong phiên bản Office 2007, nó hoạt động giống 

hêt 5cac1 phiên bản trước.  

2. Duyệt thanh Ribbon bằng Access Key (phím truy cập) 

 

 Khi bạn muốn dùng bàn phím thay vì các thiết bị trỏ như con chuột để điều 

khiển thanh Ribbon và những thứ khác trên màn hình, trước tiên bạn phải bật chức 

nâm điều khiển bằng bàn phím. Nói cách khác bạn phải chuyển từ chế độ nhập liệu 

sang chế độ thực thi lệnh bằng cách nhấn phím Alt. Sau đó, bạn sẽ có rất nhiều tùy 

chọn để duyệt khắp thanh Ribbon.  

a. Key Tip và các biểu tượng hình khiên (Badges) 
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 Ngay khi bạn nhấn phím Alt, bạn sẽ thấy các nhãn nhỏ, hoặc khiên nhỏ hiện lên 

để chỉ ra Key Tip của từng Tab. Khi bạn nhấn phím để kích hoạt một Tab, các khiên 

nhỏ sẽ hiển thị Key Tip cho từng lệnh trong Tab đó. Nói cách khác, bạn chỉ thấy mỗi 

lần một nhóm Key Tip, và bạn phải nhấn một lựa chọn nào đó trước khi thấy nhiều 

hơn. 

 Key Tip là cách rất tuyệt để sử dụng phím tắt bởi bạn không cần phải ghi nhớ, 

mọi thứ đều hiển thị trên màn hình. 

b. Tìm hiểu thêm về Key Tip 

 

Hình bên trái: Trên Tab Insert Key Tip M được gán cho nút lệnh SmartArt. 

Hình bên phải: Trên Tab Page Layout Key Tip M được gán cho nút lệnh Margins. 

 Các Key Tip có thể trùng lặp trên các Tab khác nhau, trong ví dụ trên M là phím 

tắt cho SmartArt trong Tab Insert nhưng lại là phím tắt cho Margins trong Tab Page 

Layout. 

 Bạn chỉ có thể thấy và làm việc với Key Tip của Tab đang được kích hoạt. Nếu 

bạn lỡ chọn sai Tab thì chỉ cần nhấn Esc để hiển thị lại Key Tip cho Tab và chọn lại 

Tab mà bạn cần. 

 Lưu ý: Nếu có một hộp thoại đang mở dùng cùng một ký tự Key Tip với một 

Tab hoặc một lệnh trên thanh Ribbon, thì Key Tip của hộp thoại này sẽ được ưu tiên. 

c. Di chuyển bằng phím mũi tên 
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 Ngoài Key Tip bạn cũng có thể dùng phím mũi tên để duyệt thanh Ribbon. Đầu 

tiên bạn cũng nhấn phím Alt để chọn thanh Ribbon làm tiêu điểm, sau đó dùng các 

phím mũi tên để di chuyển: 

 Phím MŨI TÊN TRÁI và MŨI TÊN PHẢI để chuyển qua lại giữa các Tab.  

 Phím MŨI TÊN LÊN để chuyển tiêu điểm lên Quick Access Toolbar (từ đây 

bạn có thể dùng phím MŨI TÊN TRÁI để di chuyển sang nút Microsoft Office).  

 Phím MŨI TÊN XUỐNG chuyển bạn vào Tab đang kích hoạt và bạn có thể di 

chuyển tiệp trong đó bằng cách sử dùng phím mũi tên..  

 Một điểm tiến bộ so với phiên bản trước của Microsoft Office là bạn có thể di 

chuyển lên / xuống thay vì chỉ là trái / phải. 

d. Phím TAB và thanh Ribbon 

 Bạn cũng có thể dùng phím TAB để di chuyển quanh thanh Ribbon. Sau khi 

nhấn Alt để chọn thanh Ribbon, bạn hãy nhấn phím TAB liên tục để di chuyển qua 

các nút lệnh theo từng nhóm tại Tab đang kích hoạt. 

 

 Sau khi đi một vòng hết các lện trong Tab hiện tại, tiêu điểm sẽ được chuyển 

theo thứ tự nút Help, nút Microsoft Office, Quick Access Toolbar, các Tab và quay 

trở lại nhóm đầu tiên trong Tab hiện tại. 

 Nhấn Shift + TAB để di chuyển theo hướng ngược lại. Khi đến được lệnh mà 

bạn muốn, hãy nhấn ENTER. 

e. Di chuyển bằng phím F6 
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Hình 1 Nhấn F6 trong Outlook chọn xoay vòng giữa các thư mục trong danh sách: 

các thư mục hoạt động, xem trước các bảng, và To Do Bar.  

Hình 2 Đang nhấn F6 trong Word chọn xoay vòng giữa các tài liệu, mở bất kỳ các 

bảng, thanh trạng thái ở dưới cùng của cửa sổ, và các giao diện.  

 Bạn có thể đến được các vùng khác nhau của các cửa sổ chương trình bằng cách 

nhấn F6. Ví dụ trong Outlook, xem ở mục Mail, tiêu điểm di chuyển giữa các danh 

sách thư mục, mở thư mục, xem trước các bảng, và To Do Bar. Hình ảnh minh họa ở 

trên là hướng di chuyển xung quanh cửa sổ Outlook. 

 Trong các giao diện của các chương trình sử dụng Ribbon, F6 xoay vòng giữa tất 

cả các vùng của cửa sổ, bao gồm các bảng đang mở, thanh trạng thái và thanh Ribbon. 

Ví dụ, nếu muốn để phóng to tài liệu của bạn bạn hãy làm như sau: 

 Nhấn F6 cho đến khi những tiêu điểm được hiển thị trên thanh trạng thái.  

 Nhấn phím TAB hoặc mũi tên qua phải để di chuyển sang nút lệnh hình dấu +.  

Bấm phím ENTER.  

f. Quá quen thuộc với hệ thống phím tắt cũ? 

 Nếu bạn từng làm việc với Mocrosoft Office trong nhiều năm và là một chuyên 

gia về phím tắt, bạn thuộc lòng tất cả các phím tắt. Có thể bạn sẽ bối rối khi tất cả 

trình đơn và phím tắt cũ đã biến mất. Thực ra, thanh Ribbon và phím tắt mới cần có 

một ít thời gian để bạn làm quen nhưng một khi đã nắm bắt được bạn sẽ đánh giá cao 

nó. 



Tìm hiểu Microsoft Office 2007- Tập 1: Tìm hiểu Microsoft Word 2007 

 

Biªn So¹n: Niemtin071@yahoo.com 91 

 

 

 Nếu bạn vẫn không hài lòng và muốn trở lại với các phím tắt cũ thì đây là câu trả 

lời: hầu hết phím tắt cũ đều vẫn hoạt động. Tuy nhiên bạn phải nhớ chính xác vì giờ 

đây không còn nơi nào trên màn hình nhắc bạn cần phải nhấn phím nào. 

Đây là cách hoạt động:  

 Trong các phiên bản trước khi bạn nhấn Alt + E thì trình đơn Edit được mở lên 

và bạn nhấn tiếp các ký tự được gạch chân để truy cập các lệnh. Trong Office 2007 

khi nhấn tổ hợp Alt + E (hoặc các ký tự tắt khác) sẽ không có trình đơn nào mở ra. 

Thay vào đó, một thông điệp sẽ hiển thị cho bạn biết bạn đang dùng hệ thống phím tắt 

cũ. Nếu bạn nhớ tổ hợp phím tắt thì chỉ cần nhấn tiếp để thực hiện lệnh. Nếu bạn 

không nhớ, hãy nhấn Esc để hiển thị các Key Tip. 

3. Hãy chú ý đến máy tính của bạn 

 

 Có thể bạn không nhận ra nhưng máy tính của bạn đang bị đặt trong tầm ngắm. 

Không phải chỉ bạn mà tất cả máy tính khác cũng vậy. Có những người đang cố thâm 

nhập vào các máy tính nhằm tư lợi hoặc một mục đích nào đó. Bạn cần phải nhận thức 

được các đe dọa để bảo vệ máy tính của mình tốt hơn.  
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a. Các đe dọa an ninh 

 Có thể một số khái niệm đã quen thuộc với bạn như: virus, trojan, spyware, 

malware, lừa đảo qua mạng. Để bảo vệ máy tính của bạn tốt hơn, bạn cần hiểu các 

mối đe dọa trên là gì. 

 Hầu hết các đe dọa an ninh được biết đến như một phần mềm hoặc một đoạn mã 

độc hại (malicious software / code), các phần mềm này âm thầm điều khiển máy tính 

của bạn mà bạn không hay biết gì. Đa số các phần mềm độ được thiết kế để tự nhân 

bản và lây nhiễm sang các file hoặc các máy tính khác. Một trong các cách lây nhiễm 

là gửi một e-mail có chứa mã độc dưới tên bạn tới các địa chỉ liên lạc trong máy tính 

của bạn.  

 

 Những gì mã độc thực hiện trên máy của bạn phụ thuộc vào nó là dạng gì và tính 

phá hoại ra sao. Có thể nó chỉ tạo ra các thông điệp gây phiền toái hoặc thực sự gây 

tổn hại bằng cách xóa các dữ liệu và chương trình của bạn. 

 Đây là một số định nghĩa về các phần mêm độc, dựa vào đó bạn sẽ biết mình 

đang phái đối mặt với cái gì: 

 Virus Phần mềm hoặc đoạn mã có khả năng tự nhân bản. Một virus lây lan bằng 

cách đính kem nó vào một file hoặc chương trình khác.  

 Worm Phần mềm nhân bản bằng cách tự gửi bản sao của nó qua mạng. 

Trojan horse Phần mềm không gây hại nhưng nó sẽ lợi dụng các lỗ hổng hệ thống để 

mở đường cho một phần mềm khác (virus, worm...) tấn công máy tính của bạn. 

 Trojan horse Phần mềm không gây hại nhưng nó sẽ lợi dụng các lỗ hổng hệ 

thống để mở đường cho một phần mềm khác (virus, worm...) tấn công máy tính của 

bạn. 
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 Spyware Phần mềm thu thập thông tin cá nhân của bạn, hoặc chúng cũng có thể 

thay đổi các thiết lập hệ thống mà không thông qua bạn. Thường máy tính bị nhiễm 

Spyware khi truy cập các trang web không đáng tin cậy. 

 Phishing Một phương thức lừa đảo thông tin tài khoản, thường là thông qua 

email. Một số kịch bản lừa đảo nhằm cài Spyware vào máy tính của bạn. Tin tốt là 

Outlook 2007 đã được tích hợp hệ thống chống Phishing. 

b. Nguồn lây nhiễm 

 Các mã độc lây nhiễm vào máy tính của bạn bằng cách ẩn mình trong một thứ gì 

đó có vẻ vô hại. Chảng hạn như một file đính kèm trong email, một phần mềm tải từ 

Internet, một website mà bạn ghé qua, một file chia sẻ hoặc mạng máy tính, một đĩa 

mềm và thậm chí là một tài liệu Office. Cơ bản thì mọi thứ đến từ một máy tính khác 

đều tiềm ẩn rủi ro. 

 

Lưu ý  Đôi khi các mã độc không ẩn mình và tấn công một cách công khai. 

 Ngoài việc cẩn trọng trước các thông tin đến từ máy tính khác, bạn cũng nên cẩn 

thận khi ghé thăm các website có yêu cầu thông tin cá nhân, hãy xác định đó có phải 

trang web giả mạo không trước khi điền thông tin. Ví dụ bạn phải chắc rằng mình 

đang ở trang web chính thức của ngân hàng bạn mở tài khoản chứ không phải ở một 

trang có giao diện giống nó. 

 Một lưu ý khác là khi bạn lướt qua một trang web thực tế bạn đang tải về các file 

từ Server. Hãy chắc rằng trang web đó đáng tin cậy. 

c. Microsoft Update một cách để hạn chế rủi ro 

 Cách cơ bản nhất để tăng cường an ninh hệ thống là bảo đảm phần mềm tren 

máy tính của bạn luôn cập nhật. Microsoft thường xuyên phát hành các bản cập nhật - 
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cái mà giới truyền thông hay gọi là bản vá (patch) - để chiến đấu với các đe dọa mới 

xuất hiện. Các bản cập nhật hỗ trợ Microsoft Windows và Microsoft Office. 

 

 Một cách hay là thường xuyên kiểm tra và cập nhật cả Windows và office bằng 

cách ghé qua trang cập nhật của Microsoft. 

 Ngoài ra bạn còn có thể thiết lập Microsoft Update tự động tải về các bản cập 

nhật khi chúng được phát hành. Một khi đã thiết lập xong, chương trình sẽ luôn được 

tự động cập nhật. 

d. Phần mềm chống Virus 

 Cách phòng vệ quan trọng nhất là sử dụng các chương trình chống Virus. Hãy 

cài đặt và cập nhật thường xuyên.  

 

 Nếu máy tính của bạn nằm trong hệ thống mạng có thể người quản trị mạng sẽ 

thực hiện thay bạn điều đó. 

 Các phần mềm chống Virus được thiết kế để phát hiện các Virus đã được nhận 

dạng. Vì virus mới không ngừng được phát tán nên bạn cần cập nhật chương trình 
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thường xuyên. Khi một virus mới xuất hiện trên thế giới, nhà sản xuất phần mềm diệt 

virus thường tung ra bản cập nhật trong vòng vài giờ sau khi nhận diện virus. 

e. Một số thiết lập an ninh khác 

 

Có thể tổng kết các ước bạn cần thự hiện để tăng cường an ninh hệ thống như sau: 

Cài chương trình diệt virus và spyware.  

Sử dụng các mật mã phức tạp (gồm chữ, số và các ký tự đặc biệt như "&" "%" "$"...). 

Cài đặt tường lửa (Firewall) kiểm soát các luồng thông tin  

Thường xuyên sao lưu dữ liệu quan trọng  

f. An toàn cho email 

 Một khu vực nguy hiểm dê bị nhiễm virus nhất là email và các file đính kèm. 

Đôi khi chỉ cần mở một email cũng có thể kích hoạt virus. 

 Ngay cả khi đã cài đặt chương trình chống virus, một virus mới có thể xuất và 

nhà sản xuất chưa kịp cập nhật thông tin về nó. Vì vậy, hãy thận trọng với các file 

đính kèm đặc biệt là khi người gửi là hoàn toàn xa lạ (hoặc có thể là tên một người 

quen như nội dung không phù hợp), hoặc nếu tiêu đề và tên file đính kèm có gì đó bất 

thường.  
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 Lưu ý Outlook 2007 có các tính năng ẩn phòng chống virus trong file đính kèm. 

Ví dụ các loại file thường được dùng để phát tán virus sẽ tự động bị chặn . 

 Ngoài ra nếu bạn vẫn lo lắng về là thông tin bạn nhận được có thể chứa virus thì 

vẫn có một số cách hiệu quả ngoài việc dùng phần mềm. Chẳng hạn bạn có thể gọi 

điện cho người gửi để xác nhận xem có đúng họ đã gửi email cho bạn không hay 

email được gửi từ một kẻ mạo danh nào đó.  

  Lưu ý Đừng bao giờ mở các email và  file đính kèm đáng nghi trước khi bạn có 

thể xác minh thông tin người gửi. 

_The end_ 
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MS WORD 2007  

1. Mở đầu 

1.1 Làm quen với giao diện mới  

Trong Word 2007, bạn sẽ không còn thấy các menu lệnh như phiên bản trước mà thay vào đó là 

hệ thống “ribbon” với 3 thành phần chính: thẻ (Tab), nhóm (Group) và các nút lệnh (Command 

button). Các nút lệnh có liên quan đến nhau được gom vào một nhóm, ví dụ như các nút chọn 

font, cỡ chữ, in đậm, nghiêng, gạch chân... được gom vào nhóm Font. Nhiều nhóm có chung một 

tác vụ lại được gom vào trong một thẻ.  

 

Bạn hãy để ý, ở góc trên bên tay trái có một nút hình tròn , nó có tên là Microsoft Office Button. 

Nhấn nút này sẽ xuất hiện một bảng lệnh tương tự như menu File của phiên bản Word trước, bao 

gồm các lệnh: New, Open, Save, Print...  

 

Quick Access Toolbar là thanh công cụ nằm cạnh nút Microsoft Office Button, giúp truy cập 

nhanh đến những nút lệnh thường dùng. Bạn có thể nhấn chuột vào nút mũi tên ở cuối thanh và 

bổ sung thêm những nút lệnh bạn hay dùng khác vào thanh công cụ này bằng cách đánh dấu 

chọn vào nó.  
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1.2 Sử dụng phím tắt để mở các thẻ, nút lệnh  

 

Ngoài phương pháp nhấn chuột, bạn có thể sử dụng phím tắt để truy cập đến các thẻ, nút lệnh 

một cách nhanh chóng. Rất đơn giản, hãy giữ phím Alt trong 2 giây, lập tức xuất hiện các chữ 

cái trên các thẻ, bạn nhấn tiếp chữ cái trên thẻ nào mình muốn mở, thẻ đó sẽ được kích hoạt. Bây 

giờ trên các nút lệnh lại xuất hiện một loạt chữ cái để bạn kích hoạt nó với cách tương tự.  

1.3 Tạo một tài liệu mới  

Tương tự như Word 2003, phím tắt để tạo một tài liệu mới trong Word 2007 là Ctrl+N. Cách 

khác: Nhấn chuột vào Microsoft Office Button , chọn New, nhấn đúp chuột vô mục Blank 

document.  

 

Tạo một tài liệu mới từ mẫu có sẵn: Nhấn Microsoft Office Button , chọn New. Nhấn Installed 

Templates, sau đó chọn một mẫu đã cài vào máy hay chọn một mẫu từ Microsoft Office Online 

(yêu cầu có kết nối Internet để tải về). Nhấn nút Create để tạo một tài liệu mới từ mẫu đã chọn.  
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1.4 Mở tài liệu có sẵn trên máy  

Tương tự như Word 2003, phím tắt mở tài liệu có sẵn là Ctrl+O. Bạn cũng có thể vào Microsoft 

Office Button , chọn Open.  

 

1.5 Lưu tài liệu  

Phím tắt để lưu tài liệu là Ctrl+S (giống Word 2003). Cách khác: Nhấn Microsoft Office Button , 

chọn Save.  

 

Nếu file tài liệu này trước đó chưa được lưu lần nào, bạn sẽ được yêu cầu đặt tên file và chọn nơi 

lưu.  

 

Để lưu tài liệu với tên khác (hay định dạng khác), bạn nhấn Microsoft Office Button , chọn Save 

As (phím tắt F12, tương tự như Word 2003).  

1.5.1  Mặc định lưu tài liệu dạng Word 2003 trở về trước  

Mặc định, tài liệu của Word 2007 được lưu với định dạng là *.DOCX, khác với *.DOC mà bạn 

đã quen thuộc. Với định dạng này, bạn sẽ không thể nào mở được trên Word 2003 trở về trước 

nếu không cài thêm bộ chuyển đổi. Để tương thích khi mở trên Word 2003 mà không cài thêm 

chương trình, Word 2007 cho phép bạn lưu lại với định dạng Word 2003 (trong danh sách Save 

as type của hộp thoại Save As, bạn chọn Word 97-2003 Document).  

Muốn Word 2007 mặc định lưu với định dạng của Word 2003, bạn nhấn Microsoft Office Button 

, chọn Word Options để mở hộp thoại Word Options. Trong khung bên trái, chọn Save. Tại mục 

Save files in this format, bạn chọn Word 97-2003 Document (*.doc). Nhấn OK.  
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Trong Word 2003 cũng có tính năng mặc định lưu theo một định dạng nào đó (dĩ nhiên không có 

định dạng của Word 2007). Để truy cập tính năng tương ứng trên Word 2003, bạn vào menu 

Tools > Options > thẻ Save > chọn định dạng trong mục Save Word files as > OK.  

1.5.2  Giảm thiểu khả năng mất dữ liệu khi chương trình bị đóng bất ngờ  

Để đề phòng trường hợp treo máy, cúp điện làm mất dữ liệu, bạn nên bật tính năng sao lưu tự 

động theo chu kỳ. Cũng trong hộp thoại Word Options, chọn mục Save ở bên trái, đánh dấu 

check vào Save AutoRecover information every, sau đó nhập số phút tự động lưu vào ô bên 

cạnh. Nhấn OK.  

1.5.3 Lưu tài liệu với định dạng PDF/XPS  

Một tính năng mới có trong Word 2007 là khả năng lưu tài liệu với dạng file *.PDF và *.XPS. 

Có lẽ bạn đã khá quen thuộc với định dạng PDF. Còn XPS? Tương tự PDF, XPS (XML Paper 

Specification) là loại file điện tử có bố cục cố định, đảm bảo khi file được xem trên mạng hay 

đem in nó vẫn giữ lại chính xác các phần định dạng bạn cần, dữ liệu trong file không dễ thay đổi.  

 

Để lưu hoặc xuất sang định dạng PDF/XPS, trước hết bạn cần cài đặt thêm phần hỗ trợ Microsoft 

Save as PDF or XPS cho hệ thống Office 2007: truy cập vào 

http://r.office.microsoft.com/r/rlidMSAddinPDFXPS hay http://tinyurl.com/y32j78 và làm theo 

hướng dẫn trong đó để cài đặt.  

http://r.office.microsoft.com/r/rlidMSAddinPDFXPS
http://tinyurl.com/y32j78
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Cài xong bạn có thể lưu tài liệu lại với dạng PDF/XPS bằng cách nhấn Microsoft Office Button , 

chọn Save As, chọn PDF or XPS.  

 

1. 6 Phóng lớn / thu nhỏ tài liệu  

Có lẽ bạn đã khá quen thuộc với hộp Zoom trên thanh công cụ Standard của Word 2003, nó giúp 

phóng to hay thu nhỏ tài liệu với nhiều tùy chọn. Còn trên Word 2007, công cụ này nằm ở đâu? 

Bạn hãy đưa mắt xuống góc dưới bên phải cửa sổ, trên thanh trạng thái sẽ thấy thanh trượt Zoom 

. Bạn chỉ việc kéo thanh trượt qua phải để phóng lớn hay qua trái để thu nhỏ tài liệu.  

 

1.6.1 Xác lập chế độ phóng lớn / thu nhỏ đặc biệt  

Trong thẻ View, nhóm Zoom, nhấn 100% để đưa tài liệu về đúng kích cỡ của nó. Cũng trong 

nhóm Zoom, nút One Page cho phép bạn hiển thị vừa đúng 1 trang trên màn hình, nút Two Pages 

hiển thị đúng 2 trang, còn Page Width là chế độ Zoom mà chiều rộng trang vừa với chiều rộng 

màn hình. Nhấn nút Zoom sẽ cho nhiều tùy chọn hơn nữa.  

1.6.2 Xem tài liệu ở chế độ Full Screen Reading  

Ở Word 2003, bạn có thể xem tài liệu giống như xem sách (2 trang đối diện nhau, và chiều rộng 

màn hình được tận dụng tối đa để có thể đọc và ghi chú vào tài liệu một cách dễ dàng). Cách 

thực hiện: vào menu View – Reading Layout.  

 

Đối với Word 2007, công cụ này nằm ở thẻ View, nhóm Document Views, mục Full Screen 

Reading. Khi ở chế độ Full Screen Reading, nhấn phím mũi tên ở góc dưới của trang để di 

chuyển qua lại giữa các trang. Nhấn ESC để trở về chế độ Print Layout. Cũng trong nhóm 

Document Views bạn có thể chọn nhiều chế độ hiển thị khác như Web Layout, Outline, Draft.  
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1.6.3 Thanh thước kẻ (Ruler)   

Thước kẻ dọc và ngang rất tiện lợi cho bạn canh chỉnh, thế nhưng trong phiên bản Word 2007 

này hình như Microsoft đã loại bỏ nó rồi? Không phải vậy, cũng như Word 2003 cho phép bạn 

tùy ý bật tắt thanh Ruler (menu View – Ruler), trong phiên bản 2007, chức năng này đã được 

đưa vào thẻ View, nhóm Show/Hide. Bạn chỉ việc đánh dấu check vào mục Ruler để cho nó hiện 

lên lại.  

 

Một cách khác để cho thước kẻ hiện ra là nhấn chuột vào nút View Ruler ở phía trên thanh cuộn 

dọc.  

 

Nếu thực hiện cách này mà bạn chỉ thấy có mỗi thước kẻ ngang xuất hiện, không thấy thước kẻ 

dọc đâu cả, hãy làm thêm bước sau để bật thước kẻ dọc lên: Nhấn Microsoft Office Button , nhấn 

tiếp Word Options. Trong hộp thoại xuất hiện, ở khung bên trái chọn Advanced. Kéo thanh trượt 

ở khung bên phải xuống dưới nhóm Display, đánh dấu chọn hộp kiểm Show vertical ruler in 

Print Layout view. Nhấn OK  

 

Lưu ý: Bạn phải xem tài liệu ở chế độ Print Layout thì mới hiện đủ được các thanh thước kẻ. 
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1.6.4 Duyệt tài liệu ở chế độ hình thu nhỏ (Thumbnails)  

Chế độ này rất hữu ích nếu trong tài liệu của bạn có quá nhiều trang vì nó cho bạn một cái nhìn 

tổng thể về các trang, và bạn có thể nhảy nhanh đến một trang bất kỳ.  

 

Trong thẻ View, nhóm Show/Hide, bạn đánh dấu check vào hộp kiểm Thumbnails. Lập tức bên 

trái cửa sổ xuất hiện một khung chứa hình thu nhỏ của các trang trong tài liệu, kèm theo số trang 

ở bên dưới. Bạn nhấn chuột vào một trang để nhảy đến trang đó.  

 

1.7 Thay đổi giao diện cho Office 

Theo những ảnh trên bạn có thấy là màu xanh truyền thống của Microsoft Word đã bị thay đổi? 

Office 2007 có tính năng thay đổi giao diện hiển thị (cho tất cả các chương trình nằm trong bộ 

Office 2007) và có 3 màu để bạn có thể lựa chọn: Màu xanh (Blue), màu đen (Black), màu bạc 

(Silver). Bạn có thể thay đổi bằng cách nhấn Microsoft Office Button, nhấn tiếp Word Options. 

Trong hộp thoại xuất hiện, ở khung bên trái nhấn Popular, tại phần Color Scherme chọn màu mà 

bạn muốn (Chú ý: thay đổi sẽ được áp dụng khi khởi động lại chương trình Office đang mở). 
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2. Định dạng văn bản 

 2.1 Định dạng trang 

2.1.1 Thay đổi xác lập lề trang  

Trong Word 2003, để thay đổi những xác lập trang, bạn vào menu File – Page Setup. Còn trong 

Word 2007 thì sao? Các xác lập trang giấy nằm trong thẻ Page Layout, nhóm Page Setup.  

- Để thay đổi lề trang, nhấn nút Margins, một menu xổ xuống cho bạn chọn những kiểu lề trang 

mình thích (mỗi kiểu lề đều có ghi chú thông số bên cạnh, ví dụ kiểu Normal thì lề trên, dưới, 

trái, phải đều cách mép giấy 1 inch...).  
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- Nếu như các thông số lề trang bạn muốn xác lập không có sẵn trong danh sách, hãy nhấn 

Custom Margins ở cuối menu, sau đó tự mình nhập vào thông số mới.  

2.1.2 Hiển thị các lề trang  

Nhấn Microsoft Office Button, nhấn tiếp Word Options. Trong hộp thoại xuất hiện, ở khung bên 

trái nhấn Advanced, khung bên phải kéo thanh trượt xuống nhóm Show document content và 

đánh dấu check vào hộp kiểm Show text boundaries. Nhấn OK.  

2.1.3 Các lề trang sẽ xuất hiện trong tài liệu dưới dạng đường đứt nét 

Trong Word 2003, bạn có thể thực hiện chức năng tương ứng bằng cách vào menu Tools – 

Options > thẻ View > đánh dấu check mục Text boundaries trong nhóm Print and Web Layout 

options > OK.  

2.1.4 Chọn hướng giấy cho toàn bộ tài liệu  

Trong thẻ Page Layout, nhóm Page Setup, nhấn nút Orientation và chọn một trong hai kiểu là 

Portrait (trang dọc) hoặc Landscape (trang ngang).  
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2.1.5 Xác lập trang dọc và trang ngang trong cùng một tài liệu  

- Dùng chuột quét chọn các đoạn văn bản mà bạn muốn thay đổi sang hướng dọc hoặc ngang.  

- Trong thẻ Page Layout, nhóm Page Setup, nhấn nút Margins.  

- Nhấn Custom Margins, chọn tiếp Portrait (trang dọc) hoặc Landscape (trang ngang) trong mục 

Orientation.  

- Trong mục Apply to, chọn Selected text. Nhấn OK.  

2.1.6 Thay đổi cỡ giấy  

Nếu muốn thay đổi kích cỡ trang giấy, trong thẻ Page Layout, nhóm Page Setup, bạn nhấn nút 

Size. Menu xổ xuống cho bạn chọn một trong các cỡ giấy có sẵn như: Letter, A4, A5, A6, 

Postcard...  

Muốn xác lập một cỡ giấy đặc biệt không có trong danh sách, bạn chọn More Paper Sizes ở cuối 

menu và nhập vào chiều rộng (Width), chiều cao (Height) mình thích.  

2.1.7 Khắc phục hiện tượng: Lề trên bị biến mất  

Khi bạn xem tài liệu ở chế độ Print Layout, điểm chèn nằm ở sát góc trên bên trái trang, giống 

như là không có lề trên vậy. Cách khắc phục:  

1. Khi lề trên hoặc lề dưới không hiển thị, bạn đưa con trỏ chuột đến lề trên hoặc lề dưới của 

trang cho đến khi con trỏ biến thành mũi tên hai đầu rồi nhấn đúp chuột vào.  

2. Lề trên và lề dưới giờ đây đã được hiển thị.  

Một cách khác để khắc phục hiện tượng bị mất lề trên:  

- Trong thẻ View, nhóm Document Views, đảm bảo rằng nút Print Layout đang được chọn.  

- Nhấn Microsoft Office Button , nhấn tiếp Word Options.  

- Trong khung bên trái, chọn Display.  

- Ở khung bên phải, dưới nhóm Page display options, đánh dấu chọn mục Show white space 

between pages in Print Layout view. Nhấn OK.  

Khác với Word 2007 phải nhấn đúp chuột, trong Word 2003 để hiển thị lại lề trên, bạn đưa con 

trỏ chuột đến lề trên hoặc lề dưới của trang cho đến khi con trỏ biến thành mũi tên hai đầu rồi 

nhấn một lần chuột trái vào.  

2.2 Thanh công cụ Header & Footer 

2.2.1 Chèn Header, Footer cho toàn bộ tài liệu  

Trong Word 2003, để chèn Header hay Footer vào tài liệu, chúng ta vào menu View – Header 

and Footer. Còn trong Word 2007, tại thẻ Insert, nhóm Header & Footer, bạn nhấn chuột vào nút 

Header hay Footer.  

Một menu xổ xuống với các Header, Footer mẫu cho bạn chọn. Kế đến bạn nhập nội dung cho 

Header hay Footer đó. Nhập xong nhấn đúp chuột vào vùng nội dung của trang, lập tức Header / 

Footer sẽ được áp dụng cho toàn bộ trang của tài liệu.  
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2.2.2 Thay đổi Header / Footer cũ bằng Header / Footer mới  

Tại thẻ Insert, nhóm Header & Footer, bạn nhấn chuột vào nút Header hay Footer. Sau đó chọn 

lại một Header / Footer mới để thay cho Header / Footer hiện tại.  

2.2.3 Không sử dụng Header / Footer cho trang đầu tiên  

Tại thẻ Page Layout, bạn nhấn chuột vào nút góc dưới phải của nhóm Page Setup để mở hộp 

thoại Page Setup. Kế đến mở thẻ Layout ra. Đánh dấu kiểm mục Different first page bên dưới 

mục Headers and footers. Nhấn OK.  

Vậy là Header / Footer đã được loại bỏ khỏi trang đầu tiên của tài liệu.  

Trong Word 2003, bạn cũng có thể loại bỏ Header / Footer cho trang đầu tiên bằng cách vào 

menu File – Page Setup > chọn thẻ Layout > đánh dấu check Different first page > OK.  

2.2.4 Áp dụng Header / Footer khác nhau cho trang chẵn và trang lẻ  

Tại thẻ Page Layout, bạn nhấn chuột vào nút góc dưới phải của nhóm Page Setup để mở hộp 

thoại Page Setup. Kế đến mở thẻ Layout ra. Đánh dấu kiểm mục Different odd and even bên 

dưới mục Headers and footers. Nhấn OK.  

Bây giờ bạn có thể chèn Header / Footer cho các trang chẵn trên một trang chẵn bất kỳ, chèn 

Header / Footer cho các trang lẻ trên một trang lẻ bất kỳ.  

Trong Word 2003, bạn cũng có thể thực hiện tương tự bằng cách vào menu File – Page Setup > 

chọn thẻ Layout > đánh dấu check Different odd and even > OK.  

2.2.5 Thay đổi nội dung của Header / Footer  

Tại thẻ Insert, nhóm Header & Footer, bạn nhấn chuột vào nút Header hay Footer. Kế đến chọn 

Edit Header / Edit Footer trong menu xổ xuống để chỉnh sửa nội dung của Header / Footer. 

Trong khi chỉnh sửa bạn có thể định dạng lại font chữ, kiểu chữ, màu sắc... cho tiêu đề Header / 

Footer bằng cách chọn chữ và sử dụng thanh công cụ Mini xuất hiện bên cạnh.  
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Chỉnh sửa xong bạn nhấn đúp chuột ra ngoài vùng nội dung của trang tài liệu.  

2.2.6 Xóa Header / Footer  

Tại thẻ Insert, nhóm Header & Footer, bạn nhấn chuột vào nút Header hay Footer. Kế đến chọn 

Remove Header / Remove Footer trong danh sách xổ xuống.  

2.2.7 Tạo Header / Footer khác nhau cho các vùng khác nhau của tài liệu  

- Trước tiên, bạn cần tạo các ngắt vùng để phân chia các vùng trong tài liệu. Nhấn chuột vào vị 

trí muốn đặt một vùng mới. Trong thẻ Page Layout, nhóm Page Setup, nhấn nút Breaks và chọn 

một kiểu ngắt vùng phù hợp trong Section Breaks, ví dụ Continuous (chúng ta sẽ tìm hiểu kỹ hơn 

về ngắt trang / ngắt vùng ở những bài viết sau).  

- Tại thẻ Insert, nhóm Header & Footer, bạn nhấn chuột vào nút Header hay Footer. Kế đến chọn 

Edit Header / Edit Footer để chỉnh sửa nội dung cho Header / Footer.  

- Trên thẻ Header & Footer, nhóm Navigation, nếu thấy nút Link to Previous đang sáng thì nhấn 

vào nút này một lần nữa để ngắt kết nối giữa Header / Footer trong vùng mới này với vùng trước 

đó. Bạn sẽ thấy mục Same as Previous ở góc trên bên phải của Header / Footer biến mất.  

- Sau đó bạn chỉnh sửa Header / Footer cho vùng mới này và yên tâm rằng những Header / 

Footer của các vùng trước đó không bị thay đổi theo.  

2.2.8 Tính năng khác  

a. Chèn số trang vào văn bản 

Số trang này sẽ được đưa vào Header hay Footer tùy ý bạn. Để thực hiện, bạn chọn thẻ Insert, tại 

nhóm Header & Footer, bạn nhấn nút Page Number. Trong menu xuất hiện, bạn trỏ tới Top of 

Page (chèn số trang vào phần Header) hoặc Bottom of Page (chèn vào Footer). Word 2007 cung 

cấp sẵn khá nhiều mẫu đánh số trang và bạn chỉ việc chọn một trong các mẫu này là xong.  
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b. Thay đổi dạng số trang   

Bạn có thể thay đổi dạng số trang theo ý thích của mình mà định dạng chuẩn không có sẵn. Để 

thực hiện, bạn nhấn đúp vào Header hay Footer, nơi bạn đã đặt số trang. Tại thẻ Design, nhóm 

Header & Footer, bạn nhấn nút Page Number, chọn tiếp Format Page Numbers.  

 

Trong hộp thoại Page Number, tại mục Number format, bạn hãy chọn một kiểu đánh số mình 

thích, sau đó nhấn OK. 

c. Thay đổi kiểu chữ, cỡ chữ, màu sắc của số trang  

Nhấn đúp chuột vào Header hay Footer, nơi bạn đã đặt số trang tại đó.  

 

Dùng chuột chọn số trang. Tại thanh công cụ mini vừa xuất hiện ở bên trên, bạn có thể chọn lại 
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font chữ, cỡ chữ, định dạng lại chữ đậm, nghiêng, hay chọn màu tùy thích. Khi hiệu chỉnh xong 

bạn nhấn đúp chuột vào vùng nội dung chính của tài liệu.  

d. Bắt đầu đánh số trang bằng một số khác  

Bạn có thể bắt đầu đánh số trang bằng một con số khác, thay vì 1 như mặc định. Cách thực hiện: 

Tại thẻ Insert, nhóm Header & Footer, bạn nhấn nút Page Number, chọn Format Page Numbers. 

Trong hộp thoại xuất hiện, bạn chọn Start at và nhập vào con số bắt đầu khi đánh số trang. Nhấn 

OK.  

 

Ghi chú: Nếu tài liệu của bạn có trang bìa và bạn muốn trang đầu tiên sau đó được bắt đầu bằng 

1, tại ô Start at, bạn hãy gõ vào 0.  

e. Xóa số trang đã đánh  

Tại thẻ Insert, nhóm Header & Footer, bạn nhấn nút Page Number, sau đó chọn Remove Page 

Numbers ở cuối menu.  

f. Xóa số trang ở trang đầu tiên của tài liệu  

Trong tài liệu, thường trang đầu tiên không được đánh số vì nó là trang bìa. Áp dụng phần ghi 

chú ở thủ thuật “Bắt đầu đánh số trang bằng một số khác” bên trên, trang bìa vẫn được đánh số là 

0. Vì vậy bạn hãy thực hiện thêm bước sau để xóa hẳn số trang ở trang đầu tiên của tài liệu.  

- Nhấn chuột vào bất kỳ vùng nào của tài liệu 

- Tại thẻ Page Layout, bạn nhấn chuột vào ô vuông góc dưới bên phải của nhóm Page Setup để 

mở hộp thoại Page Setup ra.  

- Nhấn chuột vào thẻ Layout trong hộp thoại, bên dưới Headers and footers, bạn đánh dấu chọn 

vào hộp kiểm Different first page. Nhấn OK.  

Bây giờ bạn hãy kiểm tra lại xem, có đúng là trang đầu tiên không có số trang, sau đó trang kế 

được đánh số 1 không nhé.  

2.3 Ngắt trang – ngắt vùng  

Trong Word 2003, người dùng thường vào menu Insert – Break để chèn vào tài liệu các ngắt 

trang, ngắt vùng. Còn trong Word 2007 bạn hãy thực hiện như sau.  

2.3.1 Ngắt trang  

a. Chèn một ngắt trang đơn thuần  

Trước tiên bạn để con trỏ vào vị trí muốn bắt đầu trang mới. Trong thẻ Insert, nhóm Pages, bạn 

nhấn vào nút Page Break.  

Lập tức, phần nội dung phía sau con trỏ sẽ được đưa vào một trang mới.  
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b. Tránh ngắt trang giữa một đoạn  

- Chọn một đoạn mà bạn muốn tránh ngắt thành 2 trang.  

- Trong thẻ Page Layout, nhấn vào nút ô vuông ở góc dưới phải của nhóm Paragraph để mở hộp 

thoại Paragraph.  

 

- Trong hộp thoại này, bạn chọn thẻ Line and Page Breaks, kế đến đánh dấu chọn vào hộp kiểm 

Keep lines together. Nhấn OK là xong.  

c. Tránh ngắt trang giữa các đoạn  

- Chọn các đoạn mà bạn muốn giữ trên 1 trang đơn.  

- Tại thẻ Page Layout, nhấn vào nút ô vuông ở góc dưới phải của nhóm Paragraph để mở hộp 

thoại Paragraph.  

- Trong hộp thoại này, bạn chọn thẻ Line and Page Breaks, kế đến đánh dấu chọn vào hộp kiểm 

Keep with next. Nhấn OK là xong.  

d. Tạo ngắt trang trước một đoạn  

- Nhấn chuột vào đoạn mà bạn muốn tạo ngắt trang trước nó.  

- Tại thẻ Page Layout, nhấn vào nút ô vuông ở góc dưới phải của nhóm Paragraph để mở hộp 

thoại Paragraph.  

- Trong hộp thoại này, bạn chọn thẻ Line and Page Breaks, kế đến đánh dấu chọn vào hộp kiểm 

Page break before. Nhấn OK.  
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e. Tránh ngắt trang trong một hàng của bảng  

- Nhấn chuột vào hàng của bảng mà bạn không muốn ngắt, hoặc chọn toàn bộ bảng nếu bạn 

không muốn bảng bị ngắt.  

- Trên thanh công cụ, nhấn vào thẻ Layout.  

- Tại nhóm Table, nhấn nút Properties.  

- Trong hộp thoại Table Properties, mở thẻ Row, bỏ dấu kiểm Allow row to break across pages. 

Nhấn OK.  

2.3.2 Ngắt vùng  

a. Các loại ngắt vùng có thể chèn  

- Lệnh Next Page chèn ngắt vùng vào và bắt đầu vùng mới trên trang mới kế tiếp. Loại này thích 

hợp để bắt đầu một chương trong tài liệu.  

- Lệnh Continuous chèn ngắt vùng và bắt đầu vùng mới trên cùng một trang. Loại này hữu dụng 

cho việc thay đổi định dạng, chẳng hạn trình bày số cột khác nhau trên cùng một trang.  

- Lệnh Even Page hoặc Odd Page chèn một ngắt vùng và bắt đầu vùng mới trên trang chẵn hoặc 

lẻ kế tiếp. Nếu bạn muốn các chương trong tài liệu luôn bắt đầu ở trang chẵn hoặc trang lẻ, hãy 

dùng tùy chọn Even Page hoặc Odd Page.  

b. Thay đổi bố cục hoặc định dạng tài liệu 

- Nhấn chuột vào nơi muốn thay đổi định dạng.  

- Trong thẻ Page Layout, nhóm Page Setup, bạn nhấn nút Breaks.  

- Trong phần Section Breaks, bạn hãy chọn một kiểu ngắt vùng phù hợp. Chẳng hạn, nếu bạn 

chia tài liệu thành các chương và mỗi chương bạn muốn bắt đầu ở trang lẻ, hãy chọn Odd Page.  
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d. Xóa các thay đổi của bố cục tài liệu  

Ngắt vùng dùng để chỉ ra nơi thay đổi định dạng trong tài liệu. Khi xóa ngắt vùng đi thì phần văn 

bản ở vùng trước và sau sẽ được áp dụng chung định dạng.  

- Trong thẻ View, nhóm Document Views, chọn nút Draft để có thể nhìn thấy các đường đứt đôi 

của vùng ngắt.  

- Dùng chuột chọn ngắt vùng mà bạn muốn xóa. Nhấn Delete.  

2.4 Thêm trang - xóa trang  

2.4.1 Thêm một trang mới  

- Nhấn chuột vào bất cứ nơi nào mà bạn muốn chèn vào thêm một trang mới.  

- Trong thẻ Insert, nhóm Pages, nhấn nút Blank Page.  

Trang mới sẽ được chèn vào vị trí sau con trỏ chuột đang đứng.  

2.4.2 Thêm một trang bìa  

Word 2007 cung cấp sẵn cho bạn một bộ sưu tập các trang bìa khá đẹp mắt. Các trang bìa luôn 

được chèn vào đầu tài liệu, không phụ thuộc vào vị trí hiện tại của con trỏ trong tài liệu.  

- Trong thẻ Insert, nhóm Pages, bạn nhấn nút Cover Page.  

- Trong menu xuất hiện, bạn hãy nhấn chọn một kiểu trang bìa mình thích. Trang bìa đó sẽ được 
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áp dụng vào tài liệu và bạn có thể sửa đổi nội dung các dòng chữ mặc định bằng dòng chữ mình 

thích.  

- Để thêm một trường thông tin, kích chuột vào nơi cần thêm, chọn lệnh Insert/Quick 

Parts/Document Property rồi chọn trường cần thêm. Mặc định, toàn bộ phần đồ họa trang trí trên 

trang bìa được nhóm lại với nhau nên người dùng không thể chỉnh sửa riêng từng đối tượng. Để 

định dạng riêng từng mảng màu hoặc thay ảnh nền … ta kích chuột vào một phần đối tượng nền 

rồi chọn Format/Group/Ungroup. Sau khi Ungroup, người dùng chọn riêng từng đối tượng và sử 

dụng menu Format để định dạng. Kết thúc việc chỉnh sửa, người dùng nên chọn một đối tượng 

và chọn lệnh Format/Group/Regroup để tái hợp nhóm các đối tượng này lại. 

Trang bìa của văn bản sẽ tự động có các ô thông tin để cho người dùng nhập như: 

Type the Company Name: nhập tên công ty  

- Type the Document Title: nhập tiêu đề chính  của văn bản  

- Type the Document Subtitle: nhập tiêu đề phụ của văn bản  

- Author: tên tác giả. Phần này sẽ hiển thị theo tên lúc người sử dụng cài đặt phần mềm Office 

khai báo.  

- Year: nhập hoặc chọn thời gian  

- Type the Company Address: nhập địa chỉ công ty 
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2.4.3 Xóa trang bìa  

Để xóa trang bìa, bạn nhấn chuột vào thẻ Insert, nhấn nút Cover Page trong nhóm Pages, sau đó 

nhấn Remove Current Cover Page.  

2.4.4 Xóa một trang trống  

Bạn có thể xóa một trang trống trong tài liệu bằng cách xóa đi các ngắt trang. Hãy đảm bảo rằng 

bạn đang xem tài liệu ở chế độ Draft (trong thẻ View, nhóm Document Views, nhấn nút Draft). 

Chọn 2 dấu ngắt ---Page Break--- liên tiếp nhau và xóa nó đi.  

Lưu ý: Nếu trang trống nằm ở cuối tài liệu thì bạn sẽ chỉ thấy một dấu ngắt ---Page Break--- mà 

thôi, và bạn cũng chỉ việc xóa nó đi là trang trống sẽ biến mất.  

2.4.5 Xóa một trang đơn có chứa nội dung  

- Đặt con trỏ vào trang bạn muốn xóa.  

- Trong thẻ Home, nhóm Editing, nhấn nút mũi tên bên cạnh nút Find, chọn Go To (hoặc nhấn 

phím tắt Ctrl+G).  

- Trong hộp thoại xuất hiện, bạn gõ \page vào ô nhập liệu và nhấn Enter. Toàn bộ nội dung của 

trang hiện hành sẽ được chọn.  

- Nhấn nút Close. Sau đó nhấn phím Delete để xóa đi nội dung của trang.  

2.5 Đếm số từ trong tài liệu  

Word 2007 có thể đếm số từ của tài liệu trong khi bạn gõ văn bản. Ngoài ra chương trình còn có 

thể đếm số trang, số đoạn, số dòng, số ký tự có hoặc không có khoảng trắng.  

 

2.5.1 Đếm số từ trong khi gõ văn bản  

Trong khi bạn gõ văn bản, Word 2007 sẽ tự động đếm số trang và số từ có trong tài liệu. Thông 

tin này được hiển thị trên thanh trạng thái ở góc dưới bên trái màn hình: mục Page (số trang) và 

Wor ds (số từ).  
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2.5.2 Đếm số từ trong vùng chọn  

Bạn có thể đếm số từ trong các vùng chọn, và các vùng chọn này không nhất thiết phải liền mạch 

nhau.  

- Trước tiên bạn dùng chuột chọn vùng cần đếm. Nếu các vùng không liền mạch nhau, sau khi 

chọn vùng đầu tiên, bạn giữ phím Ctrl và chọn thêm các vùng khác.  

- Trên thanh trạng thái ở cuối màn hình sẽ hiển thị số từ có trong vùng chọn. Ví dụ 110/1025 có 

nghĩa là trong vùng chọn có 110 từ trên tổng số 1025 từ của tài liệu.  

Bao gồm cả textbox, footnote và endnote trong khi đếm từ  

- Trong thẻ Review, nhóm Proofing, nhấn nút Word Count.  

- Trong hộp thoại Word Count, đánh dấu check vào mục Include textboxes, footnotes and 

endnotes.  

2.5.3 Đếm số từ trong textbox  

- Chọn textbox mà bạn muốn đếm từ.  

- Trên thanh trạng thái ở cuối màn hình sẽ hiển thị số từ có trong textbox. Ví dụ 110/1025 có 

nghĩa là trong textbox có 110 từ trên tổng số 1025 từ của tài liệu.  

2.5.4 Xem số trang, số ký tự, số đoạn và số dòng  

Để có đầy đủ thông tin về số trang, số ký tự, số đoạn và số dòng, bạn thực hiện một trong hai 

cách sau:  

- Trong thẻ Review, nhóm Proofing, nhấn nút Word Count.  

- Trên thanh trạng thái ở góc dưới bên trái màn hình, bạn nhấn chuột vào mục Words.  

Hộp thoại Word Count xuất hiện cho bạn đầy đủ thông tin mà bạn muốn.  

2.6 Tìm và thay thế  

2.6.1 Tìm văn bản  

Bạn có thể nhanh chóng tìm kiếm một từ hoặc cụm từ theo cách sau:  

- Trong thẻ Home, nhóm Editing, nhấn nút Find (hoặc nhấn phím tắt Ctrl+F).  
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- Trong mục Find what của hộp thoại Find and Replace vừa xuất hiện, bạn hãy nhập vào đoạn 

văn bản cần tìm.  

- Để tìm mỗi một từ hoặc cụm từ, bạn nhấn Find Next. Để tìm tất cả từ hoặc cụm từ cùng một lúc 

trong văn bản, bạn nhấn Find in, sau đó nhấn Main Document.  

- Muốn kết thúc quá trình tìm kiếm, bạn nhấn ESC.  

2.6.2 Tìm và thay thế văn bản  

- Trong thẻ Home, nhóm Editing, nhấn nút Replace (hoặc nhấn phím tắt Ctrl+H).  

- Ở mục Find what, bạn nhập vào đoạn văn bản muốn tìm.  

- Ở mục Replace with, bạn nhập vào đoạn văn bản muốn thay thế.  

- Để tìm đoạn văn bản tiếp theo, bạn nhấn Find Next.  

- Để thay thế đoạn văn bản, bạn nhấn Replace. Sau khi nhấn xong, Word sẽ chuyển sang đoạn 

văn bản tiếp theo.  

- Để thay thế tất cả các đoạn văn bản tìm được, bạn nhấn Replace All.  

2.6.3 Tìm và tô sáng đoạn văn bản tìm được  

Để dễ dàng nhận biết các cụm từ tìm được, bạn có thể tô sáng nó trên màn hình (không tô sáng 

khi in ra).  

- Trong thẻ Home, nhóm Editing, nhấn nút Find (Ctrl+F).  

- Trong hộp Find what, nhập văn bản mà bạn muốn tìm.  

- Nhấn Reading Highlight, sau đó chọn Highlight All.  

- Tất cả từ tìm được sẽ được tô sáng. Để tắt tính năng này đi, bạn nhấn Reading Highlight lần 

nữa, chọn Clear Highlighting.  
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2.6.4 Tìm và thay thế những định dạng đặc biệt  

- Trong thẻ Home, nhóm Editing, bạn nhấn nút Replace (Ctrl+H).  

- Nhấn nút More nếu bạn không nhìn thấy nút Format.  

 

- Để tìm kiếm đoạn văn bản với định dạng đặc biệt, bạn hãy nhập đoạn văn đó trong ô Find what. 

Nếu chỉ để tìm kiếm định dạng, hãy để trống ô này.  

- Nhấn nút Format, sau đó chọn định dạng mà bạn muốn tìm.  

- Nhấn vào ô Replace with, sau đó nhấn Format, chọn định dạng thay thế. Nếu bạn cũng muốn 

thay thế bằng đoạn văn bản, hãy nhập đoạn text đó vào ô Replace with.  
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- Nhấn Find Next, nhấn tiếp Replace để tìm và thay thế các định dạng đặc biệt. Để thay thế toàn 

bộ, nhấn Replace All.  

2.6.5 Tìm và thay thế các dấu đoạn, ngắt trang và các mục khác  

- Trong hộp thoại Find and Replace xuất hiện sau khi nhấn Ctrl+H, bạn nhấn nút More nếu 

không thấy nút Special.  

- Nhấn vào ô Find what, sau đó nhấn nút Special và chọn một mục cần tìm.  

- Nhập những gì bạn muốn thay thế trong ô Replace with.  

- Nhấn Find Next, Replace hoặc Replace All.  

2.6.6 Sử dụng ký tự đại diện khi tìm kiếm  

- Bật hộp thoại Find and Replace lên.  

- Nhấn nút More để mở rộng hộp thoại.  

- Đánh dấu kiểm vào ô Use wildcards.  

- Nhập từ cùng những ký tự đại diện vào ô Find what.  

- Nhập những gì bạn muốn thay thế trong ô Replace with.  

- Nhấn Find Next, Replace hoặc Replace All.  

Bảng các ký tự đại diện  

Đại diện  Nhập Ví dụ 

Một ký tự bất kỳ  ? “s?t” tìm “sat” và “set”. 

Một dãy ký tự * “s*d” tìm “sad” và “started”. 

Bắt đầu một từ  < 
“<(inter)” tìm “interesting”, 

“intercept”. Không tìm “splintered”. 

Cuối một từ  > 
“(in)>” tìm “in”, “within”. Không tìm 

“interesting”. 

Một trong những ký tự chỉ 

định  
[] “w[io]n” tìm “win” và “won”. 

Một ký tự bất kỳ trong dãy [-] 
“[r-t]ight” tìm “right” và “sight”. Dãy 

phải theo thứ tự tăng dần. 

Một ký tự bất kỳ, trừ những 

ký tự cho sẵn trong ngoặc 
[!x-z]  

“t[!a-m]ck” tìm “tock”, “tuck”. Không 

tìm “tack” hay “tick”. 

Để tìm một ký tự định nghĩa như một ký tự đại diện, bạn gõ dấu \ trước ký tự đó. Chẳng hạn gõ 

\? để tìm dấu hỏi. Bạn có thể sử dụng dấu ngặc đơn để nhóm các ký tự đại diện và đoạn text để 

chỉ ra thứ tự phép tính. Ví dụ gõ <(pre)*(ed)> để tìm “presorted” và “prevented”.  
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Bạn có thể sử dụng ký tự đại diện \n để tìm kiếm một biểu thức và thay thế bằng một biểu thức 

được sắp xếp. Ví dụ gõ (Office) (Word) vào ô Find what và gõ \2 \1 vào ô Replace with. Kết quả 

là chương trình sẽ tìm cụm từ Office Word và thay bằng Word Office.  

2.7  Định dạng chữ trong Word 2007 

2.7.1 Chỉnh sửa 

a. In đậm  

1. Chọn đoạn text mà bạn muốn in đậm, đưa con trỏ chuột vào vùng chọn cho đến khi xuất hiện 

thanh công cụ Mini.  

 

2. Nhấn nút Bold (B).  

Bạn cũng có thể sử dụng phím tắt Ctrl+B.  

Lưu ý, nhấn Bold (hoặc Ctrl+B) lần nữa nếu bạn muốn bỏ in đậm.  

b. In nghiêng  

Thực hiện tương tự như in đậm, nhưng thay vì nhấn nút Bold thì bạn nhấn nút Italic (phím tắt 

Ctrl+I).  

c. Gạch dưới đoạn text  

Nhấn Ctrl+U để gạch dưới đoạn text đang chọn. Nhấn Ctrl+U lần nữa để bỏ gạch dưới.  

Ngoài ra còn có nhiều kiểu gạch dưới khác:  

* Gạch dưới các từ, trừ khoảng trắng:  

- Chọn đoạn text bạn muốn gạch dưới.  

- Tại thẻ Home, nhóm Font, bạn nhấn nút mũi tên ở góc dưới bên phải.  

 

- Trong hộp Underline style, bạn chọn Word only. Nhấn OK.  

* Gạch đôi ở dưới từ:  

Thực hiện bước 1, 2 tương tự trên.  

 



Giáo trình MS Word 2007 

 

MS Word 2007 Page 25 
 

Trong hộp Underline style, bạn chọn biểu tượng dòng đôi. Nhấn OK.  

* Đường gạch dưới trang trí:  

Thực hiện bước 1, 2 tương tự trên.  

- Trong hộp Underline style, bạn chọn kiểu mình thích.  

- Để đổi màu của đường gạch dưới, nhấn chuột vào hộp Underline color và chọn màu mình 

thích. Nhấn OK.  

2.7.2 Đổi màu chữ  

1. Chọn đoạn text bạn muốn đổi màu, di chuyển con trỏ chuột vào vùng chọn để xuất hiện thanh 

công cụ Mini.  

2. Nhấn nút Font Color và chọn màu mình thích.  

2.7.3 Đổi kích cỡ chữ  

1. Chọn đoạn text, di chuyển con trỏ chuột vào để xuất hiện thanh công cụ Mini.  

2. Để tăng kích cỡ chữ, bạn nhấn nút Grow Font (phím tắt Ctrl+Shift+>). Để giảm kích cỡ chữ, 

nhấn nút Shrink Font (phím tắt Ctrl+Shift+<).  

2.7.4 Đánh dấu (Highlight) đoạn text  

Đánh dấu đoạn text để làm nó trông nổi bật hơn. Cách thực hiện:  

1. Tại thẻ Home, nhóm Font, bạn nhấn vào mũi tên bên cạnh nút Text Highlight Color .  

2. Chọn một màu dùng để tô sáng mà bạn thích (thường là màu vàng).  

3. Dùng chuột tô chọn đoạn text muốn đánh dấu.  

4. Muốn ngừng chế độ đánh dấu, bạn nhấn chuột vào mũi tên cạnh nút Text Highlight Color, 

chọn Stop Highlighting, hoặc nhấn ESC.  

2.7.5 Gỡ bỏ chế độ đánh dấu text  

1. Chọn đoạn text muốn gỡ bỏ chế độ đánh dấu.  

2. Trong thẻ Home, nhóm Font, bạn nhấn chuột vào mũi tên cạnh nút Text Highlight Color.  

3. Chọn No Color.  

2.7.6 Tìm kiếm nhanh những dòng chữ được đánh dấu 

1. Trong thẻ Home, nhóm Editing, nhấn nút Find.  

2. Nếu bạn không thấy nút Format, hãy nhấn nút More.  

3. Nhấn nút Format, sau đó chọn Highlight.  

4. Nhấn Find Next.  

2.7.7 Tạo một chữ hoa thụt cấp (Dropped Cap) Có 2 chế độ:  

1. Dropped cap.  

2. In-margin dropped cap.  
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Cách thực hiện:  

1. Nhấn chuột vào đoạn văn bản mà bạn muốn bắt đầu bằng một chữ hoa thụt cấp.  

2. Trong thẻ Insert, nhóm Text, bạn nhấn nút Drop Cap.  

3. Chọn tiếp chế độ Dropped hoặc In margin tùy ý.  

2.7.8 Định dạng chỉ số trên (Superscript), chỉ số dưới (Subscript)  

1. Chỉ số trên (Superscript); 2. Chỉ số dưới (Subscript).  

 

Chọn đoạn text cần định dạng. Trong thẻ Home, nhóm Font, bạn nhấn nút Superscript (phím tắt 

Ctrl+Shift+=) để định dạng chỉ số trên, hoặc nhấn nút Subscript (phím tắt Ctrl+=) để định dạng 

chỉ số dưới.  

2.8 Canh chỉnh văn bản  

Canh trái, phải, giữa, hoặc canh đều hai bên  

1. Chọn đoạn văn bản bạn muốn canh chỉnh.  

2. Trong thẻ Home, nhóm Paragraph, nhấn nút Align Left để canh lề trái, nhấn Align Right để 

canh phải, nhấn nút Center để canh giữa (giữa 2 lề trái và phải), hay nhấn nút Justify để canh đều 

hai bên.  

2.8.1 Canh chỉnh nhiều chế độ trên cùng 1 dòng  

1. Chuyển chế độ xem văn bản là Print Layout hoặc Web Layout (Trong thẻ View, nhóm 

Document Views, chọn nút Print Layout hoặc Web Layout).  

2. Nhấn chuột vào dòng mới và thực hiện như sau:  

- Chèn đoạn text canh trái: Di chuyển con trỏ chuột chữ I sang trái cho đến vị trí cần gõ text, 

nhấn đúp chuột và gõ vào đoạn text.  

- Chèn đoạn text canh giữa: Di chuyển con trỏ chuột chữ I vào khoảng giữa dòng cho đến vị trí 

cần gõ text. Nhấn đúp chuột và gõ vào đoạn text.  

- Chèn đoạn text canh phải: Di chuyển con trỏ chuột chữ I sang phải cho đến vị trí cần gõ text, 

nhấn đúp chuột và gõ vào đoạn text.  
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2.8.2  Thẻ Page Layout 

a. Thay đổi các canh chỉnh theo chiều dọc đoạn text  

1. Trong thẻ Page Layout, nhóm Page Setup, nhấn chuột vào nút mũi tên ở góc dưới bên phải.  

2. Trong hộp thoại Page Setup, nhấn vào thẻ Layout. Tại mục Vertical alignment, bạn chọn một 

loại canh chỉnh mình thích (Top, Center, Justified, Bottom).  

 

3. Tại mục Apply to, bạn chọn phạm vi áp dụng là Whole document (toàn văn bản), This section 

(vùng hiện tại), hay This point forward (kể từ đây trở về sau). Nhấn OK.  

b. Canh giữa lề trên và lề dưới  

1. Chọn đoạn văn bản bạn muốn canh giữa so với lề trên và lề dưới.  

2. Trong thẻ Page Layout, nhóm Page Setup, nhấn chuột vào nút mũi tên ở góc dưới bên phải.  

3. Trong hộp thoại Page Setup, nhấn vào thẻ Layout. Tại mục Vertical alignment, bạn chọn 

Center.  
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4. Tại mục Apply to, chọn Selected text. Nhấn OK.  

c. Thụt lề dòng đầu tiên của đoạn  

1. Nhấn chuột vào đoạn mà bạn muốn thụt lề dòng đầu tiên.  

2. Trong thẻ Page Layout, nhấn vào nút mũi tên góc dưới bên phải của nhóm Paragraph.  

3. Ở hộp thoại Paragraph, chọn thẻ Indents and Spacing. Tại mục Special, bạn chọn First line. 

Tại mục By, chọn khoảng cách thụt vào. Nhấn OK.  

d. Điều chỉnh khoảng cách thụt lề của toàn bộ đoạn  

1. Chọn đoạn văn bản muốn điều chỉnh.  

2. Tại thẻ Page Layout, nhóm Paragraph, nhấn chuột vào mũi tên lên, xuống bên cạnh mục Left 

để tăng, giảm khoảng cách thụt lề trái, hay tại mục Right để điều chỉnh thụt lề phải.  

2.8.3 Thụt dòng, thụt âm 

a. Thụt dòng tất cả, trừ dòng đầu tiên của đoạn  

+  Chọn đoạn văn bản mà bạn muốn điều chỉnh.  

+  Trên thanh thước ngang, hãy nhấn chuột vào dấu Hanging Indent và rê đến vị trí bạn muốn bắt 

đầu thụt dòng.  

Nếu bạn không thấy thanh thước ngang đâu cả, hãy nhấn nút View Ruler ở phía trên của thanh 

cuộn dọc để hiển thị nó.  

b.Tạo một thụt âm  

Thay vì thụt dòng vào trong, bạn có thể điều chỉnh thụt ra ngoài so với lề trái bằng cách: 

+  Chọn đoạn văn bản mà bạn muốn mở rộng sang trái.  

+  Tại thẻ Page Layout, nhóm Paragraph, nhấn nút mũi tên hướng xuống trong mục Left cho đến 

khi đoạn văn bản nằm ở vị trí bạn vừa ý.  

2.8.4 Thay đổi khoảng cách trong văn bản 

a. Tạo khoảng cách đôi giữa các dòng cho toàn bộ tài liệu  

Khoảng cách mặc định giữa các dòng cho bất kỳ tài liệu trống nào là 1.15. Bạn có thể tạo khoảng 

cách đôi (2) nếu muốn bằng cách sau:  

1. Trong thẻ Home, nhóm Styles, nhấn chuột phải vào nút Normal, chọn Modify.  
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2. Bên dưới nhóm Formatting, nhấn nút Double Space. Nhấn OK.  

b.Thay đổi khoảng cách dòng cho đoạn văn bản đang chọn  

1. Chọn đoạn văn bản muốn thay đổi.  

2. Trong thẻ Home, nhóm Paragraph, nhấn nút Line Spacing.  

3. Chọn khoảng cách bạn muốn, chẳng hạn 2.0  

Ghi chú: Nếu muốn đặt nhiều khoảng cách giữa các dòng nhưng khoảng cách này không có 

trong menu xuất hiện khi nhấn nút Line Spacing, bạn hãy chọn Line Spacing Options, và nhập 

vào khoảng cách mà bạn thích.  

Các kiểu khoảng cách dòng mà Word hỗ trợ:  

- Single (dòng đơn). Tùy chọn này hỗ trợ font lớn nhất trong dòng đó, thêm vào một lượng 

khoảng trống nhỏ bổ sung. Lượng khoảng trống bổ sung tùy thuộc vào font chữ mà bạn đang sử 

dụng.  

- 1.5 lines: Gấp 1,5 lần khoảng cách dòng đơn.  

- Double: Gấp 2 lần khoảng cách dòng đơn.  

- At least: Lựa chọn này xác lập khoảng cách dòng tối thiểu cần thiết để phù hợp với font hoặc 

đồ họa lớn nhất trên dòng.  

- Exactly: Cố định khoảng cách dòng và Word sẽ không điều chỉnh nếu sau đó bạn tăng hoặc 

giảm cỡ chữ.  

- Multiple: Xác lập khoảng cách dòng tăng hoặc giảm theo tỉ lệ % so với dòng đơn mà bạn chỉ 

định. Ví dụ, nhập vào 1.2 có nghĩa là khoảng cách dòng sẽ tăng lên 20% so với dòng đơn.  

c. Thay đổi khoảng cách trước hoặc sau các đoạn  

1. Chọn đoạn văn bản bạn muốn thay đổi khoảng cách trước hoặc sau nó.  

2. Trong thẻ Page Layout, nhóm Paragraph, bạn nhấn chuột vào mũi tên cạnh mục Before (trước) 

hoặc After (sau) để thay đổi bằng giá trị bạn muốn.  
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d. Thay đổi khoảng cách giữa các ký tự  

1. Chọn đoạn văn bản mà bạn muốn thay đổi.  

2. Trong thẻ Home, nhấn chuột vào nút mũi tên ở góc dưới phải của nhóm Font để mở hộp thoại 

Font.  

3. Nhấn chọn thẻ Character Spacing ở hộp thoại này. Trong mục Spacing, nhấn Expanded để mở 

rộng hay Condensed để thu hẹp khoảng cách và chỉ định số khoảng cách trong mục By.  

 

e. Co dãn văn bản theo chiều ngang  

1. Chọn đoạn văn bản bạn muốn căng ra hoặc thu lại.  

2. Trong thẻ Home, nhấn chuột vào nút mũi tên ở góc dưới phải của nhóm Font để mở hộp thoại 

Font.  

3. Nhấn chọn thẻ Character Spacing ở hộp thoại này. Tại mục Scale, nhập vào tỉ lệ % mà bạn 

muốn. Nếu tỉ lệ này lớn hơn 100% thì đoạn văn bản sẽ được kéo ra, ngược lại, nó sẽ được thu lại 

3. Chèn biểu tượng và ký tự đặc biệt  

3.1 Chèn biểu tượng  

- Nhấn chuột vào nơi bạn muốn chèn biểu tượng trong tài liệu.  

- Tại thẻ Insert, nhóm Symbols, bạn nhấn nút Symbol.  

- Thực hiện tiếp một trong hai thao tác sau:  

Nhấn chuột vào biểu tượng bạn muốn chèn trong danh sách xổ xuống.  

Nếu biểu tượng cần chèn không có trong danh sách, bạn nhấn More Symbols ở cuối danh sách. 

Hộp thoại Symbol xuất hiện. Tại mục Font, bạn chọn một font chữ mình thích, nhấn chọn biểu 

tượng cần chèn trong khung bên dưới, nhấn nút Insert để chèn. Xong nhấn Close để đóng hộp 

thoại Symbol lại.  

Ghi chú: Nếu bạn chọn một loại font chữ mở rộng, chẳng hạn Arial hoặc Times New Roman, 

danh sách Subset sẽ xuất hiện bên cạnh mục chọn Font. Sử dụng danh sách này để chọn các ký 

tự của ngôn ngữ mở rộng.  
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3.2 Chèn một ký tự đặc biệt  

- Nhấn chuột vào nơi bạn muốn chèn vào một ký tự đặc biệt.  

- Tại thẻ Insert, nhóm Symbols, bạn nhấn nút Symbol. Sau đó chọn More Symbols.  

 

- Trong hộp thoại Symbol, nhấn chọn thẻ Special Characters.  

- Bạn chọn trong danh sách một ký tự cần chèn và nhấn nút Insert.  

- Nhấn nút Close để đóng hộp thoại lại.  

3.3 Chèn một ký tự Unicode từ hộp thoại Symbol  

Khi bạn chọn một ký tự Unicode trong hộp thoại Symbol, mã của nó hiển thị trong hộp 

Character code.  

- Nhấn chuột vào vị trí bạn muốn chèn ký tự Unicode.  

- Trong thẻ Insert, nhóm Symbols, nhấn nút Symbol và chọn More Symbols.  

- Trong hộp thoại Symbol, thẻ Symbols, tại hộp Font bạn chọn font chữ mình thích.  

- Tại ô From, bạn chọn Unicode (hex).  
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- Nếu hộp Subset hiển thị, nhấn chọn một ký tự subset.  

- Nhấn vào ký tự bạn muốn chèn trong danh sách và nhấn nút Insert.  

- Nhấn Close.  

3.4 Dùng bàn phím để chèn ký tự Unicode vào tài liệu  

Nếu bạn biết mã của ký tự cần chèn, bạn có thể nhập vào mã đó trong tài liệu và nhấn phím 

Alt+X để chuyển đổi nó sang ký tự. Chẳng hạn bạn nhập vào 00A9 và nhấn Alt+X ngay sau đó 

sẽ được ký tự. Ngược lại, để hiển thị một mã ký tự Unicode của một ký tự nào đó trong tài liệu, 

bạn đặt con nháy phía sau ký tự đó và nhấn Alt+X.  

3.5 Chèn một biểu tượng được định nghĩa sẵn bằng cách sử dụng AutoCorrect  

Để sử dụng được tính năng này, trước hết bạn cần bật AutoCorrect lên:  

- Nhấn Microsoft Office Button, sau đó chọn Word Options.  

- Trong hộp thoại Word Options, chọn Proofing ở khung bên trái.  

- Nhấn nút AutoCorrect Options. Trong hộp thoại xuất hiện, chọn thẻ AutoCorrect.  

- Đánh dấu chọn mục Replace text as you type.  

- Nhấn OK hai lần để đóng các hộp thoại lại.  
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3.6 Tạo mục AutoCorrect của riêng bạn 

- Trong thẻ Insert, nhóm Symbols, nhấn nút Symbol, chọn More Symbols.  

- Ở hộp thoại Symbol xuất hiện, bạn nhấn vào thẻ Symbols hay Special Characters tùy ý.  

- Chọn một biểu tượng hay ký tự đặc biệt mà bạn muốn đưa vào mục AutoCorrect.  

- Nhấn nút AutoCorrect. Biểu tượng bạn chọn sẽ xuất hiện trong hộp With.  

- Trong mục Replace, bạn gõ các ký tự mà Word sẽ tự động chuyển sang biểu tượng hay ký tự 

đặc biệt mà bạn chọn ở trên.  

- Nhấn nút Add.  

- Nhấn OK.  

- Nhấn Close để đóng hộp thoại Symbol lại.  

4. Thủ thuật với dấu gạch nối (-)  

Khi một từ quá dài, không vừa khít với vị trí cuối dòng, Word sẽ chuyển từ này sang vị trí đầu 

dòng mới thay vì gạch nối nó. Tuy nhiên bạn có thể dùng tính năng Hyphenation để gạch nối tự 

động hoặc gạch nối bằng tay đoạn text, xác lập số khoảng cách lớn nhất cho phép giữa một từ và 

lề phải mà không gạch nối từ đó.  

 

Khi sử dụng tính năng gạch nối tự động, Word 2007 sẽ tự động chèn gạch nối vào vị trí cần thiết. 

Khi gạch nối bằng tay, Word sẽ tìm text để gạch nối và hỏi bạn có muốn chèn gạch nối vào hay 

không.  

4.1 Tự động chèn gạch nối trong toàn bộ tài liệu 

- Đảm bảo rằng không có đoạn text nào đang được chọn.  

- Trong thẻ Page Layout, nhóm Page Setup, bạn nhấn nút Hyphenation, sau đó chọn Automatic.  
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4.2 Chèn dấu gạch nối tùy ý 

Bạn có thể điều khiển vị trí ngắt của một từ hoặc một cụm từ nếu từ đó “rớt” ở cuối dòng. Ví dụ, 

bạn có thể chỉ định vị trí ngắt của từ “nonprinting” là “non-printing” thay vì “nonprint-ing”.  

- Trong thẻ Home, nhóm Paragraph, nhấn nút Show/Hide.  

- Nhấn chuột vào vị trí trong từ, nơi bạn muốn chèn dấu gạch nối.  

- Giữ Ctrl và nhấn phím gạch nối.  

4.3 Tự động chèn dấu gạch nối trong một phần tài liệu  

- Chọn đoạn text mà bạn muốn gạch nối.  

- Trong thẻ Page Layout, nhóm Page Setup, bạn nhấn nút Hyphenation, sau đó chọn Automatic. 

4.4 Gạch nối bằng tay trong một phần tài liệu  

Khi bạn gạch nối bằng tay, Word 2007 sẽ tìm đoạn text để gạch nối. Sau khi bạn chỉ định vị trí 

muốn gạch nối trong đoạn text, Word sẽ chèn một dấu gạch nối tùy ý. Nếu sau đó bạn soạn thảo 

tài liệu và thay đổi ngắt dòng, Word sẽ chỉ hiển thị và in ra những dấu gạch nối còn rớt ở cuối 

dòng mà không gạch nối lại trong tài liệu.  

- Chọn đoạn văn bản muốn gạch nối.  

- Trong thẻ Page Layout, nhóm Page Setup, bạn nhấn nút Hyphenation, sau đó chọn Manual.  

4.5 Chèn một dấu gạch nối không ngắt  

Các dấu gạch nối không ngắt giúp ngăn ngừa các từ, số hoặc cụm từ bị ngắt nếu nó rớt ở cuối 

dòng. Ví dụ, bạn có thể ngăn ngừa dãy số 999-1234 bị ngắt giữa chừng, thay vào đó toàn bộ cụm 

dãy số này sẽ được chuyển xuống đầu dòng kế tiếp.  

- Nhấn chuột vào nơi bạn muốn chèn dấu gạch nối không ngắt.  

- Nhấn giữ Ctrl, Shift và nhấn phím gạch nối.  

4.6 Xác lập vùng gạch nối  

Vùng gạch nối là số khoảng trống tối đa cho phép giữa 

một từ và lề phải mà không gạch nối từ này. Bạn có thể 

thay đổi vùng gạch nối: để giảm số lượng gạch nối, hãy 

làm cho vùng gạch nối rộng hơn; để giảm tính chất rời 

rạc của lề phải, bạn làm cho vùng gạch nối hẹp hơn.  

 

- Trong thẻ Page Layout, nhóm Page Setup, nhấn nút Hyphenation, sau đó chọn Hyphenation 

Options. 

- Trong Hyphenation zone, nhập vào khoảng cách mà bạn muốn.  
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4.7 Xóa bỏ dấu gạch nối tự động  

Trong thẻ Page Layout, nhóm Page Setup, nhấn nút Hyphenation, sau đó chọn None.  

4.8 Xóa bỏ dấu gạch nối bằng tay 

- Trong thẻ Home, nhóm Editing, nhấn nút Replace (hoặc nhấn phím Ctrl+H).  

- Nhấn nút More>> để mở rộng hộp thoại Find and Replace.  

- Nhấn nút Special, sau đó chọn:  

Optional Hyphen: nếu muốn xóa dấu gạch nối bằng tay.  

Nonbreaking Hyphen: để xóa dấu gạch nối không ngắt.  

- Để trống ô Replace with.  

- Nhấn Find Next, Replace, hoặc Replace All.  

5. Gỡ rối các vấn đề trong khi soạn thảo  

5.1 Chữ mới “đè” chữ cũ  

Triệu chứng: Mỗi khi gõ chữ mới, chữ cũ tại điểm chèn bị xóa đi.  

Nguyên nhân: Chế độ viết chồng đã được bật lên.  

Giải pháp: Tắt chế độ viết chồng bằng cách:  

- Nhấn chuột vào nút Microsoft Office Button, sau đó nhấn nút Word Options.  

- Nhấn Advanced trong khung bên trái.  

- Bên dưới nhóm Editing options, bạn xóa dấu kiểm trước mục Use overtype mode. Nhấn OK.  

 

5.2 Không thể tìm thấy lệnh Clear Contents 

Triệu chứng: Bạn muốn xóa chữ hoặc các đối tượng đồ họa nhưng không thể tìm thấy lệnh Clear 

Contents để thực hiện việc này.  

Nguyên nhân: Khác với các phiên bản trước, lệnh Clear Contents không có trong bản Word 

2007.  
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Giải pháp: Bạn có thể sử dụng phím Delete để xóa text hoặc các đối tượng đồ họa sau khi đã 

chọn nó.  

5.3 Word cuộn quá nhanh khi rê chuột chọn chữ 

Triệu chứng: Khi bạn chọn chữ bằng cách giữ và rê chuột theo hướng xuống dưới, Word cuộn tài 

liệu nhanh đến nỗi khó mà nhả chuột vào vị trí chính xác, nơi bạn muốn kết thúc vùng chọn.  

Nguyên nhân: Trong khi bạn rê chuột để chọn chữ, Word sẽ cuộn tài liệu theo hướng bạn chọn.  

Giải pháp: Để giải quyết vấn đề này, bạn nên kết hợp giữa chuột và bàn phím trong khi chọn 

chữ.  

- Nhấn chuột vào nơi bắt đầu vùng chọn.  

- Sử dụng thanh cuộn để trượt đến vị trí muốn kết thúc vùng chọn.  

- Giữ phím Shift trong khi nhấn chuột trái vào vị trí kết thúc vùng chọn.  

5.4 Lệnh Insert File biến đâu mất? 

Triệu chứng: Bạn muốn chèn chữ từ một tài liệu khác vào tài liệu hiện hành nhưng không thể tìm 

thấy lệnh Insert File để thực hiện việc này.  

Nguyên nhân: Trong Word 2007, lệnh Insert File đã được đổi tên thành Text from File và được 

chuyển vào menu Object trong thẻ Insert.  

Giải pháp:  

- Nhấn chuột tại vị trí muốn chèn tài liệu vào.  

- Trong thẻ Insert, nhóm Text, bạn nhấn chuột vào mũi tên bên cạnh nút Object, chọn Text from 

File.  

 

- Trong hộp thoại Insert File, bạn xác định file muốn chèn, sau đó nhấn đúp chuột vào nó để chèn 

vào tài liệu hiện hành.  

5.5 Không thể kéo – thả chuột đối với văn bản  

Triệu chứng: Không thể dùng chuột kéo – thả để thực hiện thao tác sao chép hay di chuyển văn 

bản.  

Nguyên nhân: Chức năng kéo – thả chuột trong Word đã bị vô hiệu hóa.  

Giải pháp:  
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- Nhấn chuột vào nút Microsoft Office Button, sau đó nhấn nút Word Options.  

- Nhấn Advanced trong khung bên trái hộp thoại.  

- Bên dưới nhóm Editing options, bạn đánh dấu kiểm mục Allow text to be dragged and dropped. 

Nhấn OK.  

 

- Bây giờ bạn có thể chọn văn bản và dùng chuột kéo – thả đoạn văn đó sang vị trí mới để di 

chuyển (hoặc giữ thêm phím Ctrl trong khi thực hiện để sao chép).  

5.6 Chữ Unicode bị “nhảy” khi copy  

Triệu chứng: Khi sử dụng font chữ Unicode, nếu copy một dòng văn bản thì hiện tượng nhảy chữ 

xuất hiện.  

Giải pháp:  

- Nhấn chuột vào nút Microsoft Office Button, sau đó nhấn nút Word Options.  

- Nhấn Advanced trong khung bên trái.  

 

- Bên dưới nhóm Cut, copy, and paste, bạn nhấn nút Settings.  
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- Bỏ dấu chọn ở hộp kiểm Adjust sentence and word spacing automatically. Nhấn OK hai lần để 

đóng các hộp thoại lại.  

6. Soạn thảo công thức toán học 

6.1 Viết một phương trình  

Với Word 2007, để viết một phương trình, bạn có thể chèn các biểu tượng trong hộp thoại 

Symbol; sử dụng tính năng Math AutoCorrect để chuyển chữ thành biểu tượng; hay sử dụng 

cách sau:  

- Trong thẻ Insert, nhóm Symbols, nhấn vào mũi tên bên dưới nút Equation, sau đó chọn Insert 

New Equation.  

 

- Trên thanh công cụ xuất hiện thêm thẻ Design, và bạn có thể nhấn chuột vào các nút trong 

nhóm Symbols để chèn các ký hiệu toán học, hay nhấn chuột vào các nút trong nhóm Structures 

để chèn vào tài liệu một cấu trúc toán học có sẵn, sau đó chỉnh sửa lại.  

Chú ý: Để hiển thị danh sách đầy đủ các ký hiệu toán học trong nhóm Symbols, bạn nhấn nút 

More ở góc dưới phải của nhóm.  
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6.2 Sử dụng các biểu tượng trong Math AutoCorrect  

- Nhấn Microsoft Office Button, sau đó nhấn Word Options.  

- Trong khung bên trái, nhấn Proofing, sau đó nhấn nút AutoCorrect Options.  

- Trong hộp thoại AutoCorrect, nhấn chọn thẻ Math AutoCorrect, sau đó đánh dấu kiểm trước 2 

mục Use Math AutoCorrect rules outside of math regions và mục Replace text as you type. Ghi 

nhớ các ký tự ở mục Replace (ký tự bạn nhập) và mục With (ký tự toán học sẽ thay thế).  

 

- Nhấn OK 2 lần để đóng các hộp thoại lại.  

- Bây giờ bạn hãy gõ thử các ký tự (mục Replace) và nhấn phím khoảng trắng, nó sẽ biến đổi 

thành ký tự toán học tương ứng. Ví dụ: \approx, nhấn khoảng trắng sẽ biến thành dấu .  

 6.3 Chèn một phương trình thông dụng  

Trong thẻ Insert, nhóm Symbols, bạn nhấn chuột vào mũi tên bên dưới nút Equation. Một menu 

xuất hiện với danh sách các phương trình thông dụng. Muốn sử dụng cái nào, bạn chỉ việc nhấn 
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chọn cái đó để chèn vào tài liệu và chỉnh sửa lại theo ý thích.  

Thêm một phương trình vào danh sách các phương trình thông dụng  

- Chọn một phương trình muốn thêm.  

- Bên dưới Equation Tools, trong thẻ Design, nhóm Tools, nhấn nút Equation, sau đó chọn Save 

Selection to Equation Gallery.  

- Trong hộp thoại Create New Building Block, bạn nhập vào tên của phương trình tại mục Name.  

- Tại danh sách Gallery, chọn Equations. Nhấn OK.  

 

6.4 Thay đổi phương trình được soạn thảo trong Word 2007  

Bạn chỉ việc nhấn chuột vào phương trình muốn chỉnh sửa và thay đổi theo ý thích.  

Thay đổi phương trình được soạn thảo trong Word phiên bản cũ hơn  

Để thay đổi một phương trình được soạn thảo ở phiên bản cũ, sử dụng Equation 3.0 add-in hay 

Math Type add-in, bạn cần sử dụng add-in mà đã viết phương trình này.  

Ngoài ra, khi bạn mở tài liệu có chứa phương trình được viết trong phiên bản cũ của Word, bạn 

không thể sử dụng các chương trình viết và thay đổi phương trình được cung cấp sẵn, trừ khi bạn 

chuyển tài liệu sang định dạng Word 2007.  

* Chuyển tài liệu sang định dạng Word 2007 

- Nhấn Microsoft Office Button, sau đó nhấn Convert.  

- Nhấn OK trong hộp thoại xác nhận.  

- Nhấn Microsoft Office Button, sau đó nhấn Save.  

* Thay đổi phương trình được soạn thảo bằng Equation 3.0 

- Nhấn đúp chuột vào phương trình muốn chỉnh sửa.  

- Thay đổi phương trình theo ý muốn.  

* Thay đổi phương trình được soạn thảo bằng Math Type 
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- Hãy đảm bảo rằng Math Type đã được cài đặt trên máy.  

- Nhấn đúp chuột vào phương trình muốn chỉnh sửa.  

- Trong Math Type, chỉnh sửa lại phương trình theo ý muốn.  

- Ở menu File, nhấn chọn Close and Return to... để trở về cửa sổ soạn thảo Word.  

7. Kiểm tra chính tả và lỗi ngữ pháp 

Tự động kiểm tra lỗi chính tả và ngữ pháp (các đường gợn sóng màu đỏ, xanh dương, xanh lá 

cây)  

Khi bạn bật chế độ kiểm tra chính tả tự động trong khi gõ, bạn có thể an tâm rằng không bị mắc 

nhiều lỗi chính tả trong tài liệu. Word 2007 sẽ đánh dấu những từ bị lỗi giúp ta phát hiện ra lỗi 

một cách nhanh chóng.  

Ví dụ: Bạn có thể nhấn chuột phải lên từ sai để xem những cách sửa lỗi được đề nghị.  

Tương tự, nếu bật chế độ kiểm tra ngữ pháp tự động, Word sẽ đánh dấu những lỗi ngữ pháp 

trong tài liệu trong khi bạn soạn thảo.  

Ví dụ: Bạn có thể nhấn chuột phải và chọn những kiểu sửa lỗi đề nghị. Bạn cũng có thể chọn 

Ignore Once để “lờ” đi lỗi này, hoặc chọn About This Sentence để xem tại sao Word xem câu đó 

là lỗi.  

7.1 Bật hoặc tắt chế độ kiểm tra chính tả, ngữ pháp tự động  

- Nhấn chuột vào Microsoft Office Button , chọn Word Options.  

- Trong hộp thoại hiện ra, chọn Proofing ở khung bên trái.  

- Để bật/tắt chế độ kiểm lỗi tự động trong tài liệu hiện 

hành (đang mở), bạn thực hiện như sau:  

Tại mục Exceptions for, chọn tên của tài liệu hiện 

hành.  

Chọn hoặc bỏ chọn mục Hide spelling errors in this document only và Hide grammar errors in 

this document only.  

- Để bật/tắt chế độ kiểm lỗi tự động trong tất cả tài liệu từ giờ trở đi, bạn thực hiện như sau:  

Tại mục Exceptions for, chọn All New Documents.  

Chọn hoặc bỏ chọn mục Hide spelling errors in this document only và Hide grammar errors in 

this document only. 

7.2 Kiểm tra tất cả lỗi chính tả và ngữ pháp sau khi soạn thảo văn bản  

- Chọn đoạn văn bản bạn muốn kiểm lỗi (hoặc không chọn nếu muốn kiểm toàn bộ văn bản).  

- Bấm phím F7 (hoặc chọn thẻ Review, nhấn nút Spelling & Grammar trong nhóm Proofing). 

- Nếu chương trình phát hiện ra lỗi chính tả, hộp thoại Spelling and Grammar xuất hiện, tô đỏ từ 

sai.  
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Tại khung Suggestions, bạn có thể chọn những gợi ý sửa lỗi mà chương trình đưa ra và nhấn nút 

Change để sửa theo gợi ý đó.  

  

Nếu bạn muốn tự mình sửa, hãy nhấn chuột vào tài liệu, nơi từ đang bị phát hiện là lỗi và sửa lại 

theo ý mình. Sửa xong nhấn nút Resume để kiểm tra tiếp những từ khác.  

 Trong trường hợp từ mà Word phát hiện là lỗi nhưng lại là từ mà bạn cho là chính xác và bạn 

muốn Word nhận ra từ này là đúng chính tả để lần sau khỏi “bắt lỗi” nữa, hãy thêm nó vào từ 

điển bằng cách nhấn nút Add to Dictionary.  

 Nếu muốn “lờ” đi từ sai và chuyển sang kiểm tra tiếp những từ khác, bạn nhấn nút Ignore Once 

(lờ 1 lần) hoặc Ignore All (lờ tất cả).  

 Trường hợp bạn thường xuyên bị mắc lỗi ở từ này và bạn muốn Word tự động sửa lại thành từ 

đúng trong khi bạn gõ văn bản, hãy chọn từ đúng trong khung Suggestions và nhấn nút 

AutoCorrect.  

- Ngoài ra, nếu bạn muốn kiểm tra luôn ngữ pháp, hãy đánh dấu chọn Check grammar trong hộp 

thoại Spelling and Grammar. Sau khi kiểm tra chính tả, chương trình sẽ chuyển sang kiểm tra 

ngữ pháp cho bạn. Cách sửa lỗi cũng tương tự như trên.  

7.3 Tìm từ trong từ điển  

Sử dụng tính năng Research, bạn có thể tìm các từ trong từ điển. Cách thực hiện:  

- Trong thẻ Review, nhóm Proofing, nhấn nút Research.  

- Để tìm một từ đơn trong tài liệu, giữ phím Alt và nhấn chuột vào từ cần tra cứu.  

- Để tra nghĩa một cụm từ, bạn dùng chuột chọn các từ đó, giữ phím Alt và nhấn chuột trái vào 

vùng chọn.  

- Tại khung Research bên phải màn hình, mục Search for, bạn sẽ thấy từ cần tra hiển thị trong 

đây. Bên dưới là phần giải nghĩa của nó.  

- Bạn cũng có thể gõ trực tiếp từ cần tra nghĩa vào ô Search for và nhấn OK.  

7.4 Tra từ đồng nghĩa, phản nghĩa  

Sử dụng tính năng Research, bạn còn có thể tra từ đồng nghĩa và từ 

phản nghĩa.  

- Trong thẻ Review, nhóm Proofing, bạn nhấn nút Thesaurus.  

- Giữ phím Alt và nhấn chuột vào từ cần tra. Kết quả sẽ hiển thị 

trong khung Research ở bên phải.  

- Để chèn từ đồng nghĩa hoặc phản nghĩa đó vào tài liệu hiện hành, 

nơi con trỏ đang đứng, bạn đưa chuột vào từ trong danh sách kết 

quả, nhấn chuột vào mũi tên bên cạnh từ, chọn Insert.  

- Để tìm tiếp từ đồng nghĩa / phản nghĩa của từ trong danh sách tìm 

được, bạn nhấn chuột vào từ đó trong danh sách kết quả.  
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Ghi chú: Bạn có thể tìm từ đồng nghĩa, phản nghĩa trong ngôn ngữ khác (ngoài tiếng Anh) bằng 

cách nhấn chuột vào hộp danh sách bên dưới khung nhập liệu Search for và chọn một ngôn ngữ, 

ví dụ như tiếng Pháp (French) chẳng hạn.  

7.5 Dịch văn bản  

Khác với cách tra nghĩa từng từ, trong phần này chúng ta sẽ cùng tìm hiểu cách dịch một đoạn 

văn bản dài.  

- Trong thẻ Review, nhóm Proofing, bạn nhấn nút Translate.  

- Hoặc bạn cũng có thể nhấn chuột phải vào vị trí bất kỳ trong tài liệu, chọn Translate - 

Translate.  

 

- Để chọn ngôn ngữ dịch, tại khung Translation ở bên phải, chọn ngôn ngữ nguồn tại mục From, 

ngôn ngữ đích tại mục To.  

- Để dịch một từ bất kỳ trong tài liệu, bạn giữ phím Alt và nhấn chuột trái vào từ. Nghĩa của nó 

sẽ được hiển thị trong khung Translation ở bên phải.  

- Để dịch một đoạn văn bản, bạn dùng chuột chọn đoạn văn bản đó, giữ Alt và nhấn chuột trái 

vào vùng chọn. Nghĩa của nó sẽ được hiển thị trong khung Translation ở bên phải.  
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- Để dịch toàn bộ tài liệu, tại khung Translation, bạn nhấn chuột vào nút Translate the whole 

document . Sau đó bấm Yes trong hộp thoại xác nhận. Bản dịch sẽ được hiển thị trong một cửa 

sổ duyệt Web mới mở ra.  

- Ngoài ra bạn cũng có thể dịch từ hoặc đoạn văn bằng cách tự mình nhập vào khung Search for, 

sau đó nhấn nút Start Searching .  

7.6 Bật tính năng “đưa chuột vào từ để hiển thị nghĩa trong một Screentip”  

Chỉ cần đưa chuột vào từ, nghĩa của nó (đã được dịch sang ngôn ngữ khác) sẽ hiển thị trong một 

Screentip bên cạnh, rất tiện lợi.  

 

Để bật tính năng này, bạn thực hiện như sau:  

 

- Tại thẻ Review, nhóm Proofing, nhấn chuột vào mũi tên bên cạnh nút Translation ScreenTip.  
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- Chọn một ngôn ngữ muốn dịch sang trong menu xuất hiện.  

 

- Muốn tắt tính năng này, bạn chọn Turn Off Translation ScreenTip.  

8. Chức năng Hyperlink 

8.1 Tự động tạo hyperlink cho địa chỉ Web  

Word tự động tạo một hyperlink khi bạn gõ vào một địa chỉ Web (chẳng hạn 

www.microsoft.com) và nhấn Enter hoặc phím khoảng trắng. Nếu muốn tắt/ bật tính năng này, 

bạn nhấn Microsoft Office Button , chọn Word Options. Nhấn Proofing. Nhấn nút AutoCorrect 

Options, nhấn chọn thẻ AutoFormat As You Type. Tại hộp Internet and network paths with 

hyperlinks, bạn bỏ chọn hoặc chọn để tắt/ bật tính năng này.  

8.2 Tạo một hyperlink tùy ý đến một tài liệu, tập tin hay trang Web  

1. Chọn đoạn text hoặc hình ảnh mà bạn muốn dùng để hiển thị như một hyperlink.  

2. Trong thẻ Insert, nhóm Links, bạn nhấn nút Hyperlink.  

3. Hộp thoại Insert Hyperlink xuất hiện.  

- Để liên kết đến một file hoặc trang Web có sẵn, bạn nhấn nút Existing File or Web Page bên 

dưới mục Link to, sau đó nhập vào địa chỉ mà bạn muốn liên kết đến trong hộp Address. Nếu 

không biết địa chỉ của một file, bạn có thể dùng khung duyệt file/ thư mục trong cửa sổ này để 

chọn file mình muốn liên kết.  

- Để liên kết đến một file mà bạn chưa hề tạo nó, hãy nhấn nút Create New Document bên dưới 

mục Link to, sau đó nhập tên của file mới sẽ tạo tại mục Name of new document. Tại mục When 

to edit bạn có thể chọn là Edit the new document later (soạn tài liệu này sau) hoặc Edit the new 

document now (soạn ngay bây giờ).  

Để tùy biến ScreenTip (hiển thị khi bạn rê chuột lên hyperlink), bạn nhấn nút ScreenTip và gõ 

vào dòng ghi chú. Nếu bạn không chỉ định dòng ghi chú này, Word sẽ sử dụng đường dẫn hay 
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địa chỉ của file liên kết đến làm ScreenTip.  

- Nhấn OK khi tạo xong hyperlink.  

8.3 Tạo một hyperlink đến trang e-mail trống  

Thực hiện bước 1 và bước 2 như trên để hiển thị hộp thoại Insert Hyperlink.  

3. Bên dưới mục Link to, bạn nhấn nút E-mail Address.  

4. Tại mục E-mail address, nhập vào địa chỉ e-mail mà bạn muốn khi nhấn vào hyperlink sẽ gửi 

thư cho địa chỉ này.  

5. Tại mục Subject, bạn nhập tiêu đề thư. Nhấn OK.  

 

8.4 Tạo một hyperlink đến vị trí bất kỳ trong tài liệu hay trang Web hiện hành  

Để sử dụng tính năng này, trước hết bạn cần đánh dấu vị trí đích muốn liên kết đến trong tài liệu 

hiện hành.  

* Chèn một bookmark:  

1. Trong tài liệu hiện hành, chọn đoạn text hay đối tượng mà bạn muốn gán một bookmark.  

2. Trong thẻ Insert, nhóm Links, bạn nhấn nút Bookmark.  

3. Cửa sổ Bookmark xuất hiện. Tại Bookmark name, bạn gõ vào một tên để nhận dạng bookmark 

này (lưu ý, tên không được chứa khoảng trắng). Nhấn Add để thêm vào.  
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* Thêm liên kết đến bookmark:  

1. Chọn text hoặc đối tượng mà bạn muốn hiển thị như một hyperlink.  

2. Nhấn chuột phải và chọn Hyperlink trong menu ngữ cảnh.  

3. Bên dưới mục Link to, bạn nhấn nút Place in This Document.  

4. Trong danh sách bạn chọn một bookmark muốn liên kết đến. Nhấn OK.  

 

8.5 Tạo một hyperlink đến vị trí bất kỳ trong tài liệu hay trang Web khác (không phải trang hiện 

hành)  

1. Trước tiên bạn tạo những bookmark trong file đích (file mà bạn sẽ liên kết đến) tương tự cách 

ở trên.  
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2. Mở tài liệu nguồn, chọn đoạn text hay đối tượng muốn hiển thị là hyperlink.  

3. Nhấn chuột phải, chọn Hyperlink trong menu ngữ cảnh.  

4. Bên dưới mục Link to, nhấn nút Existing File or Web Page.  

5. Tại khung Look in, bạn duyệt đến file đích muốn liên kết đến.  

6. Nhấn nút Bookmark, sau đó chọn những bookmark muốn liên kết đến trong tài liệu đích. Nhấn 

OK. 

8.6 Gỡ bỏ một hyperlink  

Bạn nhấn chuột phải vào hyperlink muốn gỡ bỏ, chọn Remove Hyperlink trong menu ngữ cảnh.  

9. Tính năng khác 

9.1 Áp dụng nhanh một kiểu mẫu (Quick Style) 

9.1.1 Áp dụng một kiểu mẫu  

1. Chọn đoạn text bạn muốn áp dụng kiểu mẫu.  

2. Trong thẻ Home, nhóm Styles, nhấn chuột vào một kiểu mà bạn thích. Nếu không thấy kiểu 

định dạng mà mình mong muốn, bạn nhấn nút More để mở rộng khung Quick Styles.  

 

Ví dụ, bạn muốn đoạn text đang chọn được áp dụng kiểu tiêu đề, nhấn nút Title trong khung 

danh sách.  

Bạn có thể xem trước kiểu định dạng được áp dụng như thế nào bằng cách rê chuột vào từng kiểu 

mình muốn xem, nó sẽ áp dụng “thử” với đoạn text bạn đang chọn.  
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9.1.2 Tạo một kiểu mẫu  

1. Chọn đoạn text mà bạn muốn tạo một kiểu mới. Ví dụ, bạn muốn tạo một định dạng in đậm, 

chữ màu đỏ.  

2. Trong thẻ Home, nhóm Font, bạn lần lượt in đậm (nhấn nút B) và tô đỏ chữ (chọn màu từ nút 

Font Color).  

3. Nhấn chuột phải vào vùng chọn, trỏ tới Styles, và nhấn Save Selection as a New Quick Style.  

4. Nhập vào tên của style mới (chẳng hạn Style 1) và nhấn OK.  

Lập tức kiểu chữ mới tạo sẽ nằm gọn trong nhóm Styles ở thẻ Home, sẵn sàng để bạn sử dụng.  

9.1.3 Thay đổi kiểu mẫu  

1. Định dạng đoạn text theo ý thích của bạn.  

2. Trong thẻ Home, nhóm Styles, nhấn chuột phải vào style mà bạn muốn thay đổi, chọn Update 

to Match Selection. 

Trong tài liệu, tất cả những đoạn text đã được áp dụng kiểu này trước đó sẽ được cập nhật lại với 

định dạng mới.  

9.1.4 Gỡ bỏ một kiểu mẫu  

1. Trong thẻ Home, nhóm Styles, bạn nhấn chuột phải vào kiểu mẫu muốn gỡ bỏ.  

2. Chọn Remove from Quick Styles gallery.  

9.2 Cài đặt điểm dừng tab (Tab stops)  

Để cho việc cài đặt tab được thuận tiện, bạn nên cho hiển thị thước ngang trên đỉnh tài liệu bằng 

cách nhấn nút View Ruler ở đầu trên thanh cuộn dọc.  

Bạn có thể nhanh chóng chọn tab bằng cách lần lượt nhấn vào ô tab selector – là ô giao nhau 

giữa thước dọc và thước ngang (ở góc trên bên trái trang tài liệu) cho đến khi chọn được kiểu tab 

mong muốn, sau đó nhấn chuột vào thanh thước ngang nơi bạn muốn đặt tab.  

Tùy từng trường hợp cụ thể mà bạn có thể sử dụng một trong các loại tab sau:  

Tab trái: Đặt vị trí bắt đầu của đoạn text mà từ đó sẽ chạy sang phải khi bạn nhập liệu.  

 Tab giữa: Đặt vị trí chính giữa đoạn text. Đoạn text sẽ nằm giữa vị trí đặt tab khi bạn nhập liệu.  

 Tab phải: Nằm ở bên phải cuối đoạn text. Khi bạn nhập liệu, đoạn text sẽ di chuyển sang trái kể 

từ vị trí đặt tab.  

 Tab thập phân: Khi đặt tab này, những dấu chấm phân cách phần thập phân sẽ nằm trên cùng 

một vị trí.  

 Bar Tab: Loại tab này không định vị trí cho text. Nó sẽ chèn một thanh thẳng đứng tại vị trí đặt 

tab.  
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Nếu bạn muốn đặt điểm dừng tab tại vị trí phù hợp mà không thể xác định chính xác khi nhấn 

chuột lên thanh thước ngang, hoặc bạn muốn chèn ký tự đặc biệt trước tab, bạn có thể dùng hộp 

thoại Tabs bằng cách nhấn đúp chuột vào bất kỳ điểm dừng tab nào trên thanh thước.  

 

Sau khi cài đặt điểm dừng tab xong, bạn có thể nhấn phím Tab để nhảy đến từng điểm dừng 

trong tài liệu.  

9.3 Ghi chú tài liệu  

9.3.1 Đánh dấu sự thay đổi và ghi chú trong tài liệu  

Theo dõi sự thay đổi trong khi chỉnh sửa  

1. Mở tài liệu mà bạn muốn theo dõi.  

2. Trong thẻ Review, nhóm Tracking, nhấn nút Track Changes.  

3. Thay đổi tài liệu theo ý bạn (chèn, xóa, di chuyển hay định dạng văn bản...). Lập tức ở bên 

hông trang tài liệu sẽ xuất hiện những bong bóng hiển thị sự thay đổi này.  

9.3.2 Tắt chế độ theo dõi sự thay đổi  

Trong thẻ Review, nhóm Tracking, nhấn vào nút Track Changes một lần nữa để tắt chế độ theo 

dõi trong khi chỉnh sửa.  

9.3.3 Thay đổi cách Word đánh dấu  

- Bạn có thể đổi màu và những định dạng mà Word dùng để đánh dấu sự đổi trong tài liệu bằng 

cách nhấn vào mũi tên bên cạnh nút Track Changes, và nhấn chọn mục Change Tracking 

Options.  
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- Nếu bạn muốn xem tất cả những thay đổi ngay trong tài liệu thay vì hiển thị những bong bóng 

bên hông tài liệu, ở nhóm Tracking, nhấn vào nút Ballons, sau đó chọn Show all revisions inline.  

- Để làm nổi bật vùng hiển thị những bong bóng (bên lề tài liệu), hãy nhấn nút Show Markup và 

chọn Markup Area Highlight.  

9.3.4 Chèn một ghi chú  

 

   1. Chọn đoạn text hoặc đối tượng bất kỳ trong tài liệu bạn muốn ghi chú.  

 

 2. Trong thẻ Review, nhóm Comments, nhấn nút New Comment.  

 

 3. Nhập vào ghi chú của bạn trong bong bóng hiển thị ở khung bên cạnh 

tài liệu.  

9.3.5 Xóa ghi chú  

- Để xóa một ghi chú, nhấn chuột phải vào ghi chú đó, chọn Delete Comment.  

- Để xóa nhanh tất cả ghi chú trong tài liệu, nhấn chuột vào một ghi chú bất kỳ. Trong thẻ 

Review, nhóm Comments, nhấn vào mũi tên bên dưới nút Delete và chọn Delete All Comments 

in Document.  

9.3.6 Thay đổi ghi chú  

1. Nếu các ghi chú không hiển thị trong tài liệu, bạn nhấn nút Show Markup trong nhóm 

Tracking của thẻ Review, sau đó đánh dấu chọn Comments.  

2. Nhấn chuột vào bên trong một bong bóng có ghi chú cần sửa. Sau đó sửa lại nội dung theo ý 

bạn.  

9.3.7 Thay đổi tên người ghi chú  

Bên cạnh mỗi ghi chú luôn có tên của người sử dụng. Nếu bạn muốn thay đổi tên này, hãy thực 

hiện như sau:  

1. Trong thẻ Review, nhóm Tracking, nhấn chuột vào mũi tên bên dưới nút Track Changes, sau 

đó chọn mục Change User Name.  
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2. Trong hộp thoại xuất hiện, bên dưới mục Personalize..., bạn nhập vào tên của mình, sau đó 

nhấn OK.  

 

Lưu ý là những ghi chú kể từ bây giờ trở đi mới có tác dụng với tên mới.  

9.4 In tài liệu 

9.4.1 In tài liệu kèm theo ghi chú và những đánh dấu thay đổi  

1. Nhấn nút Microsoft Office Button , sau đó chọn Print.  

2. Trong hộp thoại Print, tại mục Print what, chọn Document showing markup và nhấn OK.  

9.4.2 In danh sách những thay đổi trong tài liệu  

1. Nhấn nút Microsoft Office Button , sau đó chọn Print.  

2. Trong hộp thoại Print, tại mục Print what, chọn List of markup và nhấn OK.  

9.4.3 Không in những đánh dấu thay đổi và ghi chú  

1. Nhấn nút Microsoft Office Button , sau đó chọn Print.  

2. Trong hộp thoại Print, tại mục Print what, chọn Document và nhấn OK.  
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9.5 Dùng tính năng Bullets - Numbering để đánh dấu/đánh số tự động 

9.5.1 Tạo danh sách đánh dấu (bullet) hay đánh số (number) tự động 1 cấp  

1. Gõ vào dấu * để bắt đầu một danh sách các đánh dấu đầu dòng hoặc nhập 1. Để bắt đầu một 

danh sách đánh số tự động, sau đó nhấn phím cách (space bar) hoặc phím Tab.  

 

2. Nhập bất cứ chữ nào bạn muốn.  

3. Nhấn phím Enter. Word sẽ tự động chèn thêm một dấu bullet hoặc số thứ tự tiếp theo.  

4. Để kết thúc việc đánh dấu, đánh số tự động, nhấn Enter hai lần hoặc nhấn phím Backspace để 

xóa dấu bullet hoặc số cuối cùng.  

9.5.2 Nếu chức năng đánh dấu / đánh số tự động không có hiệu lực, bạn bật nó lên bằng cách 

sau:  

1. Nhấn nút Microsoft Office Button , sau đó chọn Word Options.  

2. Nhấn Proofing.  

3. Nhấn nút AutoCorrect Options, sau đó nhấn vào thẻ AutoFormat As You Type.  

4. Bên dưới nhóm Apply as you type, bạn đánh dấu chọn vào 2 mục Automatic bulleted lists và 

Automatic numbered lists. Nhấn OK để đóng các hộp thoại lại.  

 

9.5.3 Thêm dấu bullet hay numbering vào trong danh sách  

1. Chọn một mục bạn muốn thêm vào.  

2. Trong thẻ Home, nhóm Paragraph, nhấn nút Bullets hoặc nút Numbering .  
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Ghi chú: Bạn có thể tìm thấy nhiều kiểu bullet hoặc kiểu số khác bằng cách nhấn vào mũi tên 

bên cạnh nút Bullets / Numbering.  

9.5.4 Giãn khoảng cách giữa các mục trong danh sách Bullets / Numbering  

1. Trong thẻ Home, nhóm Styles, nhấn chuột vào mũi tên hướng xuống bên cạnh phải để mở 

rộng danh sách Styles. Sau đó nhấn chuột phải vào kiểu List Paragraph, chọn Modify.  

2. Trong hộp thoại Modify Style, nhấn nút Format, chọn Paragraph.  

3. Bỏ chọn mục Don’t add space between paragraphs of the same style. Nhấn OK để đóng các 

hộp thoại lại.  

 

9.5.5 Chuyển danh sách Bullets / Numbering từ một cấp sang đa cấp  

1. Nhấn chuột vào một mục trong danh sách mà bạn muốn chuyển nó thành một cấp khác.  

2. Trong thẻ Home, nhóm Paragraph, nhấn vào mũi tên bên cạnh nút Bullets hoặc Numbering, 

chọn Change List Level và chọn một cấp bạn muốn.  

9.5.6 Thêm các bullets hình ảnh hoặc biểu tượng vào danh sách  

1. Chọn mục mà bạn muốn bổ sung các bullets hình ảnh hay các biểu tượng.  

2. Trong thẻ Home, nhóm Paragraph, nhấn vào mũi tên bên cạnh nút Bullets.  
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3. Chọn Define New Bullet. Trong hộp thoại Define New Bullet, bạn nhấn nút Symbol (biểu 

tượng) hay Picture (hình ảnh) tùy mục đích.  

4. Chọn hình ảnh hoặc biểu tượng bạn muốn sử dụng, sau đó nhấn OK hai lần.  

 

9.5.7 Thêm một bullet hình ảnh hoặc biểu tượng vào trong thư viện Bullet  

1. Mở tài liệu có chứa biểu tượng bullet mà bạn muốn thêm vào thư viện.  

2. Trong thẻ Home, nhóm Paragraph, nhấn vào mũi tên cạnh nút Bullets.  

3. Bên dưới nhóm Document Bullets, nhấn chuột phải vào kiểu bullet mà bạn muốn thêm vào 

thư viện, sau đó chọn Add to Library.  

9.5.8 Xóa một kiểu ra khỏi thư viện Bullet  

1. Trong thẻ Home, nhóm Paragraph, nhấn vào mũi tên bên cạnh nút Bullets.  

2. Bên dưới nhóm Bullet Library, nhấn chuột phải vào một kiểu bạn muốn loại bỏ khỏi danh 

sách, sau đó chọn mục Remove.  

9.6 Tạo danh sách các ô đánh dấu chọn (checklist)  

Khi tạo một tài liệu dạng trắc nghiệm, chắc chắn bạn phải thiết kế những ô đánh dấu để người 

dùng đánh dấu vào . Có 2 dạng đánh dấu trong tài liệu: một dạng là dùng đem đi in (để người 

dùng đánh dấu vào giấy), dạng thứ hai là cho người dùng đánh dấu trực tiếp trong nội dung file. 
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9.6.1 Tạo một checklist để đem đi in  

Có 2 cách cơ bản để tạo một checklist đem đi in:  

- Nếu tài liệu của bạn không chứa nhiều kiểu bullets khác nhau, bạn có thể sử dụng cách tạo một 

danh sách bullets tùy biến định dạng.  

- Nếu tài liệu của bạn có sẵn nhiều định dạng bullets khác nhau, bạn có thể ngăn ngừa các bullets 

cũ thay đổi bằng cách tạo một danh sách checklist trong bảng.  

9.6.2 Tạo checklist bằng tính năng tùy biến định dạng bullets  

1. Nhập vào những mục trong danh sách của bạn.  

2. Chọn danh sách này.  

3. Trong thẻ Home, nhóm Paragraph, nhấn vào mũi tên cạnh nút Bullets.  

4. Chọn Define New Bullet.  

5. Nhấn nút Symbol.  

6. Trong hộp thoại Font, chọn một font biểu tượng đã cài sẵn trên máy, ví dụ như font 

Wingdings.  

7. Nhấn đúp chuột vào biểu tượng check box mà bạn muốn chèn vào tài liệu. Nhấn OK.  

9.6.3 Tạo bảng để ngăn ngừa các bullets cũ thay đổi khi tạo checklist  

Bước 1: Tạo bảng  

1. Trong thẻ Insert, nhóm Tables, nhấn nút Table.  

2. Chọn Insert Table.  

3. Tại mục Number of columns, bạn nhập 2.  

4. Tại mục Number of rows, nhập vào số dòng bạn muốn, lưu ý là mỗi dòng chứa một khoản 

mục chọn trong checklist.  

5. Nhấn OK.  

Bước 2: Chèn những ô check box và nhập liệu  

1. Nhấn vào ô đầu tiên ở trên bên trái trong bảng.  

2. Trong thẻ Insert, nhóm Symbols, nhấn nút Symbol và chọn More Symbols.  

3. Nhấn vào thẻ Symbols.  

4. Trong hộp Font, chọn một font biểu tượng đã cài trên máy, chẳng hạn font Wingdings.  

5. Nhấn đúp chuột vào biểu tượng check box mà bạn muốn.  

6. Nhấn Close.  

7. Nhấn chuột vào ô kế tiếp mà bạn muốn chèn một check box, nhấn tổ hợp phím Ctrl+Y, bạn sẽ 

thấy một check box mới xuất hiện.  

8. Sau khi chèn các ô check box mà bạn muốn, nhấn chuột vào ô đầu tiên ở trên bên phải và nhập 

vào các khoản mục tương ứng với các check box đã tạo.  

Bước 3: Trau chuốt lại bố cục  
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Các tab căn chỉnh Table 

1. Nhấn chuột phải vào bảng, trỏ đến mục AutoFit và chọn AutoFit to Contents.  

2. Nhấn chuột phải vào bảng, chọn Table Properties. Sau đó mở thẻ Table trong hộp thoại mới 

xuất hiện.  

3. Nhấn nút Options, ở hộp Left, Right, nhập vào khoảng cách giữa check box và đoạn text bên 

cạnh, ví dụ .02 inches. Nhấn OK.  

4. Trong thẻ Table, nhấn nút Borders and Shading, sau đó nhấn vào thẻ Borders.  

5. Bên dưới mục Setting, nhấn None, và nhấn OK hai lần để đóng các hộp thoại lại.  

Ghi chú: Sau khi bạn bỏ đường viền của bảng, bạn sẽ vẫn thấy một đường viền đứt khúc, tuy 

nhiên bạn có thể yên tâm là đường viền này sẽ không được hiển thị khi in. Nếu bạn muốn những 

đường viền đứt khúc này biến mất hoàn toàn, bạn có thể nhấn nút View Gridlines ở nhóm Table 

của thẻ Layout bên dưới Table Tools.  

9.6.4 Cách tạo ô đánh dấu để người dùng đánh dấu trực tiếp vào nội dung file 

Bước 1: Tạo bảng  

1. Trong thẻ Insert, nhóm Tables, nhấn nút Table, sau đó chọn Insert Table.  

2. Trong hộp Number of columns, gõ vào 2. 

3. Trong hộp Number of rows, nhập vào số dòng mà bạn muốn, mỗi dòng là một mục chọn trong 

danh sách sẽ tạo. Nhấn OK. 

Bước 2: Chèn vào những ô check box và nhập liệu  

Để thêm vào những ô cho phép người dùng đánh dấu check trực tiếp trong file, bạn cần sử dụng 

thẻ Developer.  

* Hiện thẻ Developer  

1. Nhấn nút Microsoft Office Button , chọn Word Options.  

2. Trong hộp thoại xuất hiện, chọn mục Popular ở khung bên trái.  

3. Đánh dấu chọn mục Show Developer tab in the Ribbon. Nhấn OK.  
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* Thêm vào các ô check box  

1. Nhấn vào ô đầu tiên bên trái của bảng.  

2. Trong thẻ Developer, nhóm Controls, nhấn nút Legacy Tools.  

3. Bên dưới Legacy Forms, chọn Check Box Form Field.  

Ghi chú: Nếu ô check box có nền màu xám, bạn nhấn nút Legacy Tools , chọn Form Field 

Shading để gỡ bỏ nền xám đó đi.  

4. Nhấn vào ô kế tiếp, nơi bạn muốn chèn tiếp một check box. Sau đó nhấn Ctrl+Y để chèn 

check box vào.  

5. Sau khi đã chèn xong hết các check box, bạn nhấn chuột vào ô đầu tiên bên phải của bảng và 

nhập vào các khoản mục tương ứng với từng check box bên trái.  

Bước 3: Hoàn thiện lại bố cục  

1. Nhấn chuột phải vào bảng, trỏ đến mục AutoFit và chọn AutoFit to Contents.  

 

2. Nhấn chuột phải vào bảng, chọn Table Properties. Sau đó mở thẻ Table trong hộp thoại mới 

xuất hiện.  

3. Nhấn nút Options, ở hộp Left, Right, nhập vào khoảng cách giữa check box và đoạn text bên 

cạnh, ví dụ 0.19cm. Nhấn OK.  
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4. Trong thẻ Table, nhấn nút Borders and Shading, sau đó nhấn vào thẻ Borders.  

5. Bên dưới mục Setting, nhấn None, và nhấn OK hai lần để đóng các hộp thoại lại.  

Bước 4: Khóa form  

Để người dùng có thể đánh dấu chọn trực tiếp vào file tài liệu, bạn cần khóa form lại. Lưu ý, khi 

khóa form lại bạn không thể chỉnh sửa chữ cũng như bố cục của tài liệu, do đó hãy đảm bảo thực 

hiện bước này sau cùng.  

1. Nhấn vào nút Design Mode trong nhóm Controls của thẻ Developer để tắt chế độ Design.  

2. Trong thẻ Developer, nhóm Protect, nhấn nút Protect Document, sau đó chọn Restrict 

Formatting and Editing.  
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3. Trong khung Protect Document, bên dưới Editing restrictions, đánh dấu chọn Allow only this 

type of editing in the document.  

4. Trong combo box bên dưới, chọn Filling in forms.  

 

5. Bên dưới Start enforcement, nhấn nút Yes, Start Enforcing Protection.  

6. Để đặt mật khẩu, không cho người dùng gỡ bỏ chế độ bảo vệ, hãy nhập vào mật khẩu trong ô 

Enter new password (optional) và xác nhận lại mật khẩu ở ô bên dưới.  

Bây giờ bạn có thể gửi file tài liệu này cho người dùng đánh dấu chọn vào, sau đó họ lưu lại và 

gửi lại cho bạn. Rất hữu ích nếu bạn muốn thực hiện một cuộc thăm dò khảo sát nào đó qua e-

mail...  

10.  
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10. Tạo mục lục tự động trong Office 2007  

 (Thứ Tư, 07/11/2007 - 9:32 AM) 

 Bài viết hướng dẫn tạo một mục lục tự động giúp bạn tiết kiệm 

thời gian và công sức bằng cách tận dụng những tiện ích có sẵn 

được nâng cấp thân thiện trong MS Word 2007. Để tạo ra mục 

lục, bạn đánh dấu cấp độ nội dung và tiến hành chèn mục mục 

bằng chức năng có sắn của trình soạn thảo. 

 

 Đánh dấu nội dung và trích xuất thành mục lục 

 

Bước 1: Mở văn bản bạn cần tạo mục lục tự động (hình minh họa là file "Quan he VietNam-

NhatBan.doc" 
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Bước 2: Bạn chọn References trên trình đơn thông minh của bộ MS Office 2007 

 

  

 

Bước 3: Lựa chọn vùng chức năng tạo mục lục tự động Table of Contents.. 

http://www.xahoithongtin.com.vn/images/diembao/2007_04/1.JPG
http://www.xahoithongtin.com.vn/images/diembao/2007_04/2.JPG
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Bước 4: Mục lục tự động được tạo trên nguyên tắc cấp độ nội dung, vì vậy, để tạo nó bạn phải 

lựa chọn cấp độ nội dung cho phù hợp. Ví dụ: 3 phần mở đầu, nội dung, kết luận.. bạn chọn level 

1, các nội dung nhỏ hơn sẽ chọn level lớn hơn như level 2. Level 3.... Phần trình bày dưới sẽ 

hướng dẫn chi tiết để các bạn dễ hình dung. 

Để đánh dấu đề mục trong bảng mục lục, các bạn chỉ cần đặt vị trí trỏ chuột vào dòng chứa đề 

mục và xác định mức (level): 

 

  

 

Các bạn thao tác tương tự với các đề mục khác, chú ý chọn level thích hợp. 

http://www.xahoithongtin.com.vn/images/diembao/2007_04/4.JPG
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Sau khi đã hoàn thành việc xác định mức độ các đề mục trong bảng mục lục các bạn di chuyển 

con trỏ chuột đến vị trí cần chèn mục lục và nhấn chọn biểu tượng Table of Contents... 

 

  

 

Bạn có thể chọn những kiểu trình bày sẵn có(Automatic...) hoặc tùy chọn chi tiết bằng cách nhấn 

chọn Insert Table of Contents... 

http://www.xahoithongtin.com.vn/images/diembao/2007_04/5.JPG
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Xuất hiện hộp thoại Index and Tables, chọn thẻ Table of Contents 

 

  

Print Preview: Kiểu mục lục sẽ hiển thị khi in 

Web Preview: Kiểu mục lục sẽ hiển thị ở dạng trang web 

Show page numbers: Hiển thị số trang. 

Right align page numbers: Hiển thị số trang bên lề phải. 

Use hyperlinks instead of page numbers: Có sử dụng liên kết từ mục lục tới trang đặt Heading. 

Tab leader: Chọn loại đường tab từ cuối các Heading đến số trang. 

Show levels: Số cấp độ Heading. 

ỹ Nút Show Outlining Toolbar: Cho hiển thị thanh công cụ Outlining trên cửa sổ MS Word 

http://www.xahoithongtin.com.vn/images/diembao/2007_04/7.JPG
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Nút Options...: Mở hộp thoại Table of Contents Options: Tùy chọn thêm một số tính năng khác.  

 

  

Nút Modify...: Mở hộp thoại Style, sửa đổi định dạng font chữ cho nội dung phần mục lục tự 

động. 
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Trường hợp trong file đã có mục lục tự động, và bạn đồng ý thay đổi định dạng font chữ bằng 

hộp thoại Style sẽ xuất hiện thông báo: "Bạn có muốn thay thế định dạng cho bảng nội dung mục 

lục không?" 

 

  

 

Chọn nút Yes: Đồng ý. Ngoài font chữ của nội dung bảng mục lục thay đổi, MS Word còn tự 

động cập nhật lại số trang cho các đề mục. 

Nhấn chọn OK trong hộp thoại Table of Contens để hoàn tất việc chèn mục lục tự động vào văn 

bản. 
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ở tại phần mục lục này, có liên kết cho phép bạn click chuột (hoặc dùng kết hợp phím Ctrl + 

click chuột) để nhảy đến đúng mục và số trang cần đến. 

3. Chỉnh sửa mục lục tự động 

 

- Tại mục lục tự động mới được tạo ra ta có thể chỉnh sửa như với mọi văn bản bình thường 

khác, tức là bạn có thể chọn font chữ , cỡ chữ, cách dòng, màu sắc... thích hợp theo ý của bạn.  

 

- Trong quá trình chỉnh sửa văn bản, số trang có thể thay đổi, do vậy nếu bạn muốn cập nhật lại 

chỉ cần click chuột vào Update Table 
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Hộp thoại Update Table hiện ra với 2 lựa chọn: 

 

  

Update pages numbers only: chỉ cập nhật số trang. 

Update entire table: cập nhật cả số trang và nội dung mục lục 

 

Tùy vào yêu cầu của bạn mà có lựa chọn thích hợp. 

 

 

Trong Word, các đối tượng đồ họa (Illustrations) được chia làm 05 loại: Picture (ảnh chụp), 

ClipArt (ảnh vẽ có sẵn khi cài đặt), Shapes (các hình vẽ cơ bản), SmartArt ( các hình vẽ, sơ đồ 

đặc biệt), Chart (đồ thị) và WordArt (chữ nghệ thuật – nằm trong nhóm Text). Quá trình thao tác 

được thực hiện qua hai phần: tạo đối tượng và định dạng đối tượng.  

Để khởi tạo đối tượng, ta chọn menu Insert rồi chọn nhóm đối tượng trong phần 

Illustrations.  

 

- Với Picture, người sử dụng phải chọn tranh ở nơi chứa (ví dụ trong My Pitures)  

- Với ClipArt, người sử dụng phải chọn tranh trong kho có sẵn của chương trình  

- Với Shapes, người sử dụng phải chọn hình vẽ rồi kích chuột vào văn bản  
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- Với SmartArt, người sử dụng phải chọn loại sơ đồ rồi OK  

- Với Chart, người sử dụng phải nhập số liệu  

- Với Word Art, người sử dụng phải chọn mẫu và nhập nội dung  

 

Sau khi tạo đối tượng xong, người sử dụng phải kích chuột vào đối tượng đó và chuyển 

sang menu Format để định dạng. Đây là nơi tập trung các công cụ để định dạng đối tượng 

vừa tạo, bao gồm: 

 

+ Nhóm Adjust: điều chỉnh độ sáng tối, độ tương phản, gồm:  

 

- Brightness: điều chỉnh độ sáng  

- Contrast: điều chỉnh độ tương phản  

- Recolor: điều chỉnh tông màu. Với tính năng này, người sử dụng có thể chuyển toàn bộ ảnh 

thành dạng đơn sắc theo một tông màu nào đó. Đặc biệt, trong đó có tính năng Set Transparent 

Color dùng để chuyển một mảng màu trở nên trong suốt (thường dùng để loại bỏ nền ảnh)  

- Compress Pictures: dùng để nén ảnh. Các ảnh nguyên gốc có thể có dung lượng rất lớn (vài MB 

một ảnh), khi chèn vào trong văn bản thì dung lượng của file Word sẽ bằng dung lượng ký tự 

cộng với dung lượng của toàn bộ ảnh. Như thế có thể một văn bản có kích cỡ lên tới 100MB. Để 

giảm dung lượng ảnh, ta dùng chế độ nén với 03 mức: Print 220 ppi - tốt cho khi in ra máy và 

hiển thị, Screen 150 ppi – hiển thị tốt trên màn hình, Email 96 ppi – dung lượng nhỏ - chất lượng 

hiển thị không tốt  

- Change Picture: thay đổi ảnh  

- Reset Picture: khôi phục ảnh trở về trạng thái gốc  

- Nhóm Picture Styles: các chế độ định dạng cho ảnh, gồm:  

- Picture Shape: chọn kiểu khung ảnh (chỉ có với đối tượng dạng ảnh)  

- Picture Border: chọn kiểu viền khung ảnh  

- Picture Effects: chọn kiểu hiệu ứng cho ảnh  

 

+ Nhóm Shape Styles: các chế độ định dạng cho các đối tượng dạng hình vẽ và đồ thị, gồm:  

 

- Shape Fill: chọn kiểu nền  

- Shape Outline: chọn kiểu viền  

- Shape Effects: chọn kiểu hiệu ứng cho hình vẽ  

 

+ Nhóm Arrange: căn chỉnh vị trí, khoảng cách giữa các đối tượng đồ họa, gồm:  

 

- Position: Chọn vị trí đối tượng so với dòng văn bản  
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- Bring to front: đưa lên trên cùng  

- Send to back: đưa xuống dưới cùng  

- Text Wrapping: chọn chế độ dòng văn bản bao quanh đối tượng (bao theo hình vuông, bao chặt 

hay phủ lên trên …)  

- Align: dóng hàng các đối tượng được chọn  

- Group: nhóm và bỏ nhóm các đối tượng được chọn  

- Rotate: quay, lật các đối tượng  

 

+ Nhóm Size: điều chỉnh kích cỡ chính xác các đối tượng  

 

- Height: điều chỉnh chiều cao  

- Width: điều chỉnh độ rộng  

- Crop: cắt tranh  

 

+ Nhóm Shadow Effects: lựa chọn các hiệu ứng bóng hai chiều  

+ Nhóm 3-D Effects: lựa chọn các hiệu ứng bóng ba chiều  

+ Nhóm WordArt Styles: chọn mẫu định dạng chữ nghệ thuật  

+ Bên cạnh menu Format để định dạng chung các đối tượng đồ họa, thì với những loại như 

biểu đồ, đồ thị còn có thêm hai menu là Design và Layout 

 

- Design: chỉnh sửa thiết kế, dữ liệu (đối với đồ thị)  

- Layout: chỉnh sửa giao diện  

 

Có một điểm cần lưu ý, tất cả các tính năng nói trên của Word 2007 chỉ hiển thị khi văn bản 

được tạo và lưu theo định dạng Word 2007 (có đuôi là .docx). Nếu lưu ở định dạng Word 97 - 

2003 thì những tính năng riêng có của Word 2007 như các dạng biểu đồ đặc biệt, các kiểu định 

dạng đổ bóng, tạo hiệu ứng nổi … sẽ bị ẩn đi.  
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MỤC LỤC 

1.Tôi muốn thiết lập một phông chữ làm phông chữ mặc định cho tất cả các tập tin. Hãy 

chỉ cho tôi cách thực hiện: 

2.Tôi nghe nói WORD có thể tự động lưu giữ dữ liệu khi đang làm việc,  có phải vậy 

không? 

3. Có cách nào chọn nhanh một từ, một câu và một đoạn trong văn bản bằng chuột 

không? 

4.Trong WORD, tôi có thể gán phím tắt cho các Symbol(ký tự đặc biệt) không? 

5.Làm thế nào chèn thêm những đường kẻ dọc vào giữa các cột văn bản? 

6.Tiêu đề đầu/cuối trang trong tài liệu của tôi xuất hiện từ {Page} chứ không hiện ra số 

trang.  Làm sao bây giờ? 

7.Có thể nào hủy bỏ việc đánh số trang chỉ trên trang đầu của tài liệu không ? 

8. Làm thế nào để chỉ canh lề phải một phần nội dung của tài liệu trong tiêu đề đầu 

trang/cuối trang ?  

9. Thông qua menu Insert,  tôi đưa vào tài liệu ký tự đặc biệt (Symbol). Trên màn hình,  

các biểu tượng xuất hiện,  nhưng khi in ra thì lại xuất hiện các khoảng trống. Sao lại thế? 

10.Cách nào chỉ in những trang lẻ của tài liệu? 

11. Tôi muốn in tài liệu của tôi trên cả hai mặt trang giấy.Tôi phải làm sao? 

12. Khi in,  các trang giấy của tôi lại xuất hiện theo thứ tự ngược lại. Phải làm gì để khắc 

phục việc này? 

 

 



 

THỦ THUẬT WORD 

 

1.Tôi muốn thiết lập một phông chữ làm phông chữ mặc định cho tất cả các tập tin. Hãy 

chỉ cho tôi cách thực hiện: 

     Để thiết lập lại phông chữ mặc định đã sử dụng, cần thực hiên như sau:  

1. Nhấp chọn menu Format -> Font. 

2. Trong hộp thoại Font,  chọn thẻ Font.Trong thẻ này, định dạng Font,  kích cỡ và kiểu 

chữ bằng cách sử dụng các khung Font, Font style và Size 

3. Nhấp vào nút Default…Một hộp thoại khác xuất hiện. 

4. Chọn Yes để sử dụng định dạng vừa thiết lập 

 

2.Tôi nghe nói WORD có thể tự động lưu giữ dữ liệu khi đang làm việc,  có phải vậy 

không? 

 Không sai! Có thể yêu cầu Word thực hiện chế độ lưu tự động.Trong quá trình làm việc 

bạn hay quên lưu giữ tài liệu thường xuyên. Điều này rất tai hại, mỗi khi có sự cố cúp điện, sẽ 

làm mất dữ liệu, tốn thời gian để làm lại.Word đã khắc phục nhược điểm này. Nó sẽ tự động 

lưu giữ dữ liệu theo một chu kỳ nhất định 

Muốn cài đặt chế độ lưu tự động, thực hiện các bước sau:   

1. Nhấp chọn menu Tool -> Options hiển thị hộp thoại Options 

2. Chọn thẻ Save. 



3. Đánh dấu chọn ô Save AutoRecover info every… minutes, rồi gõ vào khung 

Minutes khoang thời gian muốn lưu trữ tự động. 

4. Nhấp OK. 

Có thể ấn định khoảng thời gian cho mỗi lần lưu trữ tự động từ 1 đến 120 phút. Khoảng 

thời gian lưu trữ tự động là 10 phút. 

 

3. Có cách nào chọn nhanh một từ, một câu và một đoạn trong văn bản bằng chuột 

không? 

 Có chứ,  có nhiều cách chọn các từ, các câu, các đoạn (paragraph) trong văn bản.Ở đây 

xin hướng dẫn cách chọn bằng chuột: 

· Chọn một từ bằng cách nhấp đúp con trỏ chuột lên từ muốn chọn. 

· Chọn một câu bằng cách nhấn giữ Ctrl và nhấp con trỏ chuột tại một vị trí bất 

kỳ trong câu muốn chọn. 

· Chọn một đoạn bằng cách nhấp nhanh ba lần liên tiếp tại vị trí bất kỳ của đoạn 

muốn chọn. 

 

4.Trong WORD, tôi có thể gán phím tắt cho các Symbol(ký tự đặc biệt) không? 

             Gán cho Symbol(ký tự đặc biệt) một phím tắt bằng các bước sau đây : 

1. Nhấp chọn menu Insert -> Symbol để hiển thị hộp thoại Symbol. 

2. Chọn Simbol muốn gán phím tắt. 

3. Nhấp vào nút Shortcut Key.Hộp thoại Customize Keyboard xuất hiện. 



4. Trong hộp thoại Custumize,gõ phím hay tổ hợp phím muốn gán Symbol vào ô 

Press new shortcut key. 

5. Nhấp nút Assign, phím hoặc tổ hợp phím được gán sẽ tự động chuyển sang ô 

Current keys, Word sẽ ghi nhớ phím tắt này làm đại diện cho symbol. 

6. Nhấp Close đóng các hộp thoại. 

   

 ÿ Lưu ý quan trọng: 

  Hãy thận trọng trong việc gán phím tắt,  phải chắc chắn rằng tổ hợp phím này chưa 

dùng cho các chức năng khác của Word. Bằng không Word sẽ gán tổ hợp phím bị trùng cho 

symbol và “quên” đi tác vụ đã được gán cho nó trước nó. 

  Ví dụ: 

  Gán tổ hợp phím Ctrl + C cho symbol “(” 

  Từ đây,  khi nhấn phím Ctrl + C, Word sẽ tự động chèn vào symbol “(” chứ không 

thực hiện chức năng Save nữa. 

  Muốn tổ hợp phím Ctrl + C trở về chức năng ban đầu của nó (Save - lưu giữ liệu) phải 

xóa bỏ việc gán phím tắt cho symbol “(”.  Thực hiện như sau: 

1. Nhấp chọn menu Insert -> Symbol mở hộp thoại Symbol. 

2. Nhấp vào nút Short Key, mở tiếp hộp thoại Customize Keyboard. 

3. Trong hộp thoại này, chọn tổ hợp phím Ctrl + C ở ô Current keys. 

4. Nhấn nút Remove loại bỏ việc gán tổ hợp phím này cho symbol “(” 

5. Nhấp Close đóng các hộp thoại. 



  Vậy là Word lại “nhớ” lưu dữ liệu khi nhấn tổ hợp phím Ctrl + C. 

 

5.Làm thế nào chèn thêm những đường kẻ dọc vào giữa các cột văn bản? 

 Chèn thêm những đường kẻ dọc vào giữa các cột văn bản làm cho tài liệu sáng sủa và dễ 

đọc hơn.  Đường kẻ này càng có ích khi khoảng cách giữa các cột hơi bị hẹp. 

 Để chèn thêm đường kẻ dọc vào giữa các cột, làm theo các bước như sau: 

1. Di chuyển điểm chèn đến đoạn chứa các cột muốn thêm các đường kẻ dọc. 

2. Nhấp chọn menu Format -> Columns hiển thị hộp thoại Columns. 

3. Nhấp chọn ô Line between.  

4. Nhấp OK. 

 Đường kẻ dọc chỉ xuất hiện trên màn hình khi ở chế độ Page Layout View và trong màn 

hình Print Preview. Trong các chế độ hiển thị khác sẽ không thấy đường kẻ dọc này, nhưng 

vẫn thể hiện trên trang giấy khi in ra. 

 

6.Tiêu đề đầu/cuối trang trong tài liệu của tôi xuất hiện từ {Page} chứ không hiện ra số 

trang.  Làm sao bây giờ? 

 Word đã thực hiện chế độ hiển thị Field codes thay vì hiển thị kết quả của Field codes trong 

tài liệu này. Khi ấy, từ {Page} thay vì xuất hiện giá trị số trang thực sự. Ngoài ra,  hình ảnh,  

công thức toán học… chèn vào văn bản cũng biến mất, xuất hiện các dòng chữ lạ ở vị trí ấy.  

Việc hiển thị Field codes thật ra rất tiện lợi,  nhất là khi sửa đổi các code này. Tắt chức năng 

này vào thời điểm định dạng hoặc in tài liệu, Thực hiện các bước sau để tắt chức năng Field 

codes: 



1. Nhấp chọn menu Tool -> Options để hiển thị hộp thoại Options. 

2. Chọn tiếp thẻ View. 

3. Trong hộp thoại này, ở khung Show, xóa chọn ô Field codes. 

4. Nhấp OK. 

  Tiêu đề đầu trang/cuối trang lúc này sẽ hiển thị số trang như mong muốn. 

  Chuyển đổi qua lại giữa Field codes và kết quả của nó bằng cách di chuyển điểm chèn 

lên Field codes và nhấn tổ hợp phím Shift + F9. 

 

7.Có thể nào hủy bỏ việc đánh số trang chỉ trên trang đầu của tài liệu không ? 

  Word hiển thị số trang trên tất cả các trang của tài liệu khi dùng lệnh Insert ->Page 

Numbers.  Tuy vậy,  Word cũng cho phép hủy bỏ việc đánh số trang trên trang đầu tiên của tài 

liệu. Thực hiện như sau: 

1. Nhấp chọn menu Insert -> Page Numbers mở hộp thoại Page Numbers. 

2. Xoá chọn ô Show Number on First Page rồi nhấp OK. 

  Chức năng hủy bỏ đánh số trang trên trang đầu tiên của tài liệu vẫn có ảnh hưởng khi 

sử dụng nút Insert Page Numbers trong hộp thoại Header and Footer chèn số trang vào tài liệu. 

  

8. Làm thế nào để chỉ canh lề phải một phần nội dung của tài liệu trong tiêu đề đầu 

trang/cuối trang ?  

 Có thể canh lề có chọn lọc một phần hay toàn bộ nội dung trên tiêu đề đầu trang /cuối 

trang. 



 Để canh lề phải tất cả nội dung trong tiêu đề đầu trang/cuối trang, thực hiện như sau: 

 Nhấp chọn menu View -> Header and Footer hiển thị hộp thoại Header and Footer. 

 Khi ấy,  điểm chèn chuột nằm ở khung Header. 

 Nhấp nút biểu tượng Align Right trên thanh công cụ chuẩn.  

 Hoặc chọn menu Format -> Paragraph hiển thị hộp thoại Paragraph. Trong hộp thoại 

này,  ở hộp danh sách Alignment, chọn mục Right rồi nhấp OK. 

 Trong trường hợp chỉ muốn canh lề phải phần nhỏ nội dung đã gõ vào trong tiêu đề đầu 

trang /cuối trang: ví dụ : Canh lề trái tên của dự án,  Canh giữa số trang và canh lề phải tên 

người thực hiện,  hãy sử dụng các bước Tab tạo hình thức canh lề hỗn hợp này. 

 Muốn tạo ra Header hay Footer mang dáng vẻ như vậy, Thực hiện theo các bước sau: 

1. Nhấp chọn menu View -> Header and Footer hiển thị hộp thoại Header and 

Footer với khung Header. 

2. Chọn tiếp menu Format -> Tabs hiển thị hộp thoại Tabs. 

3. Muốn tạo Tab canh giữa (center tab),  gõ vào giá trị chỉ định vị trí chính xác 

giữa trang giấy trong khung Tab stop position, trong khung Alignment đánh 

dấu chọn nút Center, nhấn nút Set. 

4. Muốn tạo Tab canh phải (right tab), gõ vào giá trị chỉ định vị trí lề phải trong 

khung Tab stop position, trong khung Alignment đánh dấu chọn nút Right, 

nhấn nút Set. 

5. Nhấp OK chèn vào tiêu đề đầu trang/ cuối trang các điểm dừng Tab. 

6. Gõ vào đoạn văn bản muốn xuất hiện ở lề trái, chẳng hạn Dự án trồng rừng. 



7. Nhấn phím Tab đưa điểm chèn đến bước Tab canh giữa đã cài đặt,  nhấp vào 

biểu tượng có tên Insert Page number trên thanh Header and Footer để chèn số 

trang cho tài liệu. 

8. Nhấn phím Tab lần nữa đưa điểm chèn đến Tab phải đã cài đặt, gõ vào tên 

người thực hiện đề án : Nguyễn Anh Hùng chẳng hạn.  

9. Nhấp nút Close Đóng hộp thoại Header and Footer trở về màn hình văn bản. 

 

9. Thông qua menu Insert,  tôi đưa vào tài liệu ký tự đặc biệt (Symbol). Trên màn hình,  

các biểu tượng xuất hiện,  nhưng khi in ra thì lại xuất hiện các khoảng trống. Sao lại thế? 

 Đúng vậy, Word đang in tài liệu theo dạng “in nháp”(Draft), bỏ qua các “ký tự dạng đồ 

họa”,kể cả những biểu tượng mà Word tạo ra. Để Word in ra các ký hiệu đặc biệt này, thực 

hiện các bước sau: 

1. Chọn menu Tools -> Options. 

2. Trong hộp thoại Options, chọn thẻ Print, xóa chọn ô Draft Output rồi nhấp OK. 

 

10.Cách nào chỉ in những trang lẻ của tài liệu? 

 Có thể yêu cầu Word chỉ in các trang chẵn hay trang lẻ của tài liệu bằng cách theo các bước 

sau: 

1. Nhấp chọn menu File -> Print để hiển thị hộp thoại Print. 

2. Trong hộp danh sách Print ở cuối hộp thoại Print, chọn mục Odd pages (In trang 

lẻ) hay Even pages (in trang chẵn). 

3. Nhấp nút OK để in các trang đã chọn của tài liệu. 



 

11. Tôi muốn in tài liệu của tôi trên cả hai mặt trang giấy.Tôi phải làm sao? 

 Chỉ có thể in trên hai mặt của trang giấy nếu máy in được thiết để làm việc này.Đa số máy 

in không thực hiện được.  Muốn kiểm tra xem máy in có chức năng này hay không, hãy xem 

lại tài liệu máy in. 

 

12. Khi in,  các trang giấy của tôi lại xuất hiện theo thứ tự ngược lại. Phải làm gì để khắc 

phục việc này? 

 Nhiều kiểu máy in nạp giấy vào khác nhau. Theo mặc định, Word in trang đầu tiên trước, 

các trang còn lại tiếp theo sau. Tuy nhiên, một số máy in xếp các trang giấy theo kiểu trang đầu 

tiên lại nằm ở cuối, vì vậy cần phải sắp xếp lại các trang sau khi chúng in ra. Có thể cho in tài 

liệu theo thứ tự ngược lại để chúng được xếp chồng lên cho đúng. 

 Muốn in tài liệu theo thứ tự ngược lại : 

1. Nhấp chọn menu Tools -> Options, rồi nhấp chọn thẻ Print. 

2. Đánh dấu chọn ô Reverse Print Order và nhấp nút OK. 

 Lựa chọn in này sẽ là mặc định cho tới khi có thay đổi ngược lại. 

 

13.Tôi chèn ngày, giờ vào tài liệu như thế nào ? 

 Chèn Ngày,  Giờ hiện hành vào tài liệu theo các bước sau: 

1. Di chuyển con nháy tới vị trí muốn chèn Ngày hay Giờ, rồi nhấp chọn menu 

Insert -> Date and Time để hiển thị hộp thoại Date and Time. 



2. Chọn kiểu định dạng tùy ý trong hộp danh sách Available Formats. 

3. Nhấp chọn ô Update Automaticaly để Word tự động cập nhật thời gian.  

4. Nhấp nút OK chèn Ngày hay Giờ vào tài liệu theo định dạng đã chọn. 

& Phím tắt: 

 Nhấn tổ hợp phím Alt + Shift + D để chèn Ngày. 

 Nhấn tổ hợp phím Alt + Shift + T để chèn  Giờ. 

 Trong cả hai trường hợp,  Word sẽ chèn theo dạng Ngày/Giờ đã chèn vào lần trước. 

 

14.Tôi muốn thêm LOGO của công ty vào tài liệu, có cách nào thực hiện nhanh không? 

 Công cụ AutoCorrect dễ dàng thực hiện việc chèn Logo vào bất kỳ tài liệu nào. Để dùng 

công cụ này, đầu tiên phải cài đặt logo này vào AutoCorrect. Word sẽ chèn Logo vào trong tài 

liệu bất cứ khi nào bạn gõ các ký tự đại diện gán cho Logo. 

 Để cài đặt Logo vào AutoCorrect, theo các bước sau đây: 

1. Chèn Logo vào một tài liệu mới mở, rồi nhấp chọn Logo đó.  

2. Nhấp chọn menu Tools -> AutoCorrect. Một phân của Logo xuất hiện trong 

khung With. 

3. Gõ vào các ký tự đại diện trong khung Replace.Nên chọn nhóm ký tự nào sẽ 

không bao giờ sử dụng cho bất kỳ mục đích nào khi nhập văn bản. 

4. Nhấp nút Add, rồi nhấp OK. 

 Bây giờ, Logo đã được cài đặt thành một mục của AutoCorrect. Theo các bước sau đây để 

chèn nó vào trong tài liệu : 



1. Di chuyển điểm chèn đến vị trí muốn chèn Logo trong tài liệu.  

2. Gõ vào từ dành riêng gán cho Logo rồi nhấn phím Spacebar. 

 Logo sẽ xuất hiện tại vị trí điểm chèn hiện hành trong tài liệu.  

 Nếu Logo không xuất hiện, trong hộp thoại AutoCorrect,  hãy kiểm tra lại xem đã đánh dấu 

chọn ô Replace Text as you type chưa. 

 

15.Nút trên thanh công cụ quá nhỏ, có cách nào làm cho nó lớn hơn không? 

 Có thể làm lớn các nút này, nhất nếu dùng Card màn hình SVGA. Để thay đổi kích thước 

của các nút trên thanh công cụ: 

1. Nhấp chọn menu Tools -> Customize.Chọn thẻ Options. 

2. Đánh dấu chọn ô Large Buttons và nhấp OK. 

 Sau khi tăng kích thước các nút này, có thể phải sắp xếp lại các thanh công cụ để chúng 

xuất hiện đủ trên màn hình. 

 Thật ra, mặc định về kích thước của các nút biểu tượng trong Word là tối ưu. Kích thước 

của các nút chi chọn Large Buttons là quá lớn so với màn hình. 

 

16.Có thể giấu bớt các thanh công cụ cho màn hình văn bản lớn hơn một chút  được 

không? 

 Nhấp chọn menu View -> Toolbars. Thanh công cụ nào có đánh dấu chọn bên cạnh nghĩa 

là thanh công cụ ấy đang hiển thị trên màn hình.Muốn giấu chúng đi, nhấp vào ô chọn ấy.  

 Có phải thanh công cụ ấy đã mất đi trên màn hình Word của bạn rồi không? 



 

17. Khác biệt giữa PARAGRAPH STYLE và CHARACTER  STYLE là gì? 

 Style có chức năng định dạng cho văn bản. Khi sử dụng một Style cho đoạn văn bản, tất cả 

định dạng có trong Style cũng sẽ được áp dụng cho đoạn văn bản đó. 

 PARAGRAPH STYLE  ảnh hưởng đến toàn bộ đoạn văn bản, chứ không phải chỉ một 

phần văn bản trong đoạn ấy. 

 Sử dụng Paragraph Style để áp dụng cho những định dạng như: 

· Khoảng cách hàng. 

· Lề biên.  

· Khung, đường viền và bóng mờ. 

 Ngoài ra còn có thể áp dụng các định dạng ký tự với Paragraph Style như: 

· Kích cỡ phông chữ.  

· Kiểu chữ. 

 CHARACTER STYLE chỉ ảnh hưởng đến các ký tự riêng biệt hay nhóm văn bản xác định 

và áp dụng các loại định dạng như là kích cỡ phông chữ, kiểu chữ. 

 Thí dụ,  dùng CHARACTER STYLE có tên là Defined để in nghiêng các từ chỉ một loại 

mặt hàng nào đó. Nếu sau đó, muốn thay đổi hình dạng của các từ này, có thể thay đổi định 

dạng đã gán cho Character Style tên Defined 

 Khi thay đổi định dạng của một Style, tất cả đoạn văn bản đang áp dụng Style này cũng tự 

động thay đổi theo các định dạng mới của Style. 

 



18. Vì sao Word thông báo rằng không thể mở tập tin TEMPLATE có sẵn 

NORMAL.DOT? 

 Cho dù không chọn khuôn mẫu (template) cụ thể nào khi tạo văn bản mới, Word cũng tự 

động chọn khuôn mẫu Normal(được lưu trữ trên đĩa dưới dạng tập tin NORMAL.DOT). 

Khuôn mẫu Normal chứa những xác lập và chức năng sử dụng trong tất cả tài liệu. Tuy nhiên 

khi gặp khó khăn khi mở tập tin template, đương nhiên Word phải “la làng”. 

 Tập tin NORMAL.DOT chắc đã bị sứt mẻ ! Nếu trường hợp này xảy ra, cách giải quyết tốt 

nhất là xóa tập tin NORMAL.DOT này đi. Khi khởi động, nếu không tin thấy tập tin nào mang 

tên NORMAL.DOT, Word sẽ tự động tạo ra tập tin NORMAL.DOT chứa những xác lập mặc 

định nguyên thủy(do nhà sản xuất quy định). 

 Muốn xóa tập tin NORMAL.DOT, thực hiện như sau: 

  Nhấp nút phải chuột vào Start trên thanh Taskbar của màn hình Windows. Menu tắt 

hiển thị, chọn Explore mở hộp thoại Exploring 

  Thông thường tập tin NORMAL.DOT nằm ở thư mục C:\Program Files \ Microsoft 

Office\Template, chọn tập tin này rồi nhấn phím Delete. 

  Đóng hộp thoại này lại và khởi động lại Word. 

 

19. Có thể sao chép Style từ tập tin này sang tập tin khác được không ? 

 Sử dụng hộp thoại Style để thực hiện việc sao chép Style từ tập tin này sang tập tin khác. 

Các bước thực hiện như  sau: 

1. Chọn menu Format -> Style hiển thị hộp thoại Style. 

2. Nhấp tiếp nút Organizer.  



  Trong hộp thoại Organizer có các thẻ : Styles, Autotext, Toolbars và Macro Project 

Items. Muốn làm việc với nội dung nào chọn thẻ tương ứng. Hộp thoại Organizer cho phép sao 

chép(Copy), xóa(Delete) và đổi tên(Rename)  của Style. 

 Chẳng hạn, cần sao chép một Style từ tập tin này sang tập tin khác, thực hiện như sau: 

1. Trong hộp thoại Organizer, chọn thẻ Styles. 

2. Hộp thoại Organizer hiện ra hai hộp danh sách, thể hiện các Style có trong tập 

tin hiện hành (hộp danh sách bên trái). Nếu dấy đúng là hai tập tin cần sao chép 

Style thì hãy chuyển sang bước 4. 

3. Nếu hai (hoặc một trong hai)  tập tin được thể hiện không phải là tâp tin cần 

dùng, hãy nhấp vào nút Close File bên dưới mỗi hộp danh sách. Lúc này nút 

Open File hiển thị, nhấp vào nút Open File mở hộp thoại Open, chọn tập tin 

template cần dùng. Trên ô bên trái cũng như bên phải sẽ hiện lên các Style trong 

tập tin được chọn. 

4. Chọn các Style trên hộp danh sách bên trái rồi nhấp vào Copy. Word sẽ sao 

chép nó vào tập tin ở bên phải.  

5. Sau khi sao chép hết những Style cần thiết, nhấp vào Close để đóng hộp thoại 

Organizer. 

 Trong quá trình sao chép, nếu có Style nào trùng tên, Word sẽ đưa ra thông báo. 

 Nếu muốn chép chồng thì nhấp nút Yes, còn nhấp nút Cancel sẽ hủy bỏ việc sao chép này. 

 

20. Tập tin tài liệu của tôi có chứa nhiều hình ảnh nên lớn quá trời. Có cách nào để giảm 

bớt kích thước tập tin không ? 



 Để giảm kích thước tập tin, thay vì chèn hình vẽ “nằm chình ình” lên tài liệu, chỉ nên kết 

nối(link) nó thôi. “Kết nối” hình ảnh nghĩa là hình ảnh vẫn được ghi trong tập tin riêng biệt 

(không ở trong tập tin tài liệu của Word), được Word đọc, thể hiện trên màn hình khi mở tài 

liệu và cũng được in ra với văn bản một cách bình thường. Điều này còn có cái lợi là: khi tập 

tin hình ảnh thay đổi (do sử dụng chương trình đồ họa nào đó để sửa chữa hình ảnh), hình ảnh 

hiện lên trong tài liệu của Word dĩ nhiên sẽ được cập nhật phản ánh nhưng thay đổi đã thực 

hiện trên hình ảnh. 

 Để kết nối tài liệu với tập tin hình ảnh, theo các bước sau đây: 

1. Xóa những hình ảnh đã chèn vào tài liệu bằng cách chọn từng hình một rồi 

nhấn phím Delete. 

2. Di chuyển điểm chèn về nơi muốn chèn hình ảnh. 

3. Chọn menu Insert -> Picture -> Form File. Hộp thoại Insert Picture xuất hiện. 

4. Chọn tập tin hình ảnh trong hộp danh sách File name. 

5. Đánh dấu chọn ô Link to File, đồng thời xáo chọn ô Save Picture in Document. 

6. Nhấp OK trở về cửa sổ tài liệu. 

7. Lập lại các bước như trên cho từng hình ảnh trong tài liệu.  

 Việc dùng kết nối như vậy sẽ giảm đáng kể kích thước tập tin tài liệu vì mọi hình ảnh giờ 

đây đều là nhưng tập tin riêng biệt. Trong tập tin tài liệu chỉ có những thông tin về sự kết nối 

mà thôi (đây là những dòng lệnh đặc biệt chỉ về các tập tin hình ảnh). Dựa trên thông tin như 

vậy, khi mở tập tin tài liệu, word sẽ đọc những tập tin hình ảnh cần thiết và thể hiện hình ảnh 

trên màn hình. 

 



21. Tôi có thể tạo thư mục mới trên đĩa để ghi tập tin vào đó mà không cần thoát khỏi 

Word ? 

 Được chứ, Word cho phép tạo thư mục mới trên đĩa để lưu tập tin mà không cần thoát khỏi 

Word. 

 Thực hiện như sau: 

1. Nhấp chọn menu File -> Save As. Hộp thoại Save as xuất hiện. 

2. Trong hộp thoại này, nhấp vào nút Create New Folder. Hộp thoại New Folder 

xuất hiện,  cho phép đặt tên cho thư mục mới, và sẽ lưu tập tin hiện hành vào 

thư mục mới này. 

 

22. Tôi quên mất mã số rồi. Có cách nào hủy bỏ mật mã để có thể mở tập tin một cách 

bình thường không ? 

 Không được rồi ! Muốn hủy bỏ mật mã, cũng phải có mật mã chứ ! Word không có cách 

nào để “lách” mật mã đã khai báo và “ngang nhiên” sử dụng tập tin được bảo vệ. Ngay hãng 

Microsoft cũng chẳng giúp được gì trong chuyện này. Chỉ có mỗi cách là cố nhớ lại thôi ! Để 

tránh tình trạng này, nên ghi nhớ mật mã ở đâu đấy, vừa hợp lý, vừa an toàn. 

 Word phân biệt chữ hoa, chữ thường trong mật mã(Case-sensitive). Do đó, khi tạo mật mã, 

nếu dùng chế độ CAPSLOCK thì sau này, khi nhập mật mã, cũng phải sử dụng chế độ 

CAPSLOCK.  

 

23. Tôi muốn khai báo mật mã ! Được dùng bao nhiêu ký tự trong mật mã và đó là 

nhưng ký tự nào? 

 Một mật mã có thể dài tối đa 15 ký tự, có thể chứa chữ, số, khoảng trống và các 



ký hiệu. Khi nhập mật mã, Word hiển thị dấu * mỗi khi gõ một ký tự. 

 

24. Làm sao thay đổi mật mã dùng cho tài liệu ? 

 Bạn có thể khai báo mật mã mới bằng cách theo các bước sau: 

1. Mở tài liệu đã được bảo vệ bằng mật mã. Dĩ nhiên, phải biết mật mã cũ mới mở 

tài liệu được. 

2. Chọn menu File -> Save as. Hộp thoại Save as xuất hiện. 

3. Nhấp chọn Options … mở hộp thoại Save. 

4. Xóa các dấu sao * biểu thị mật mã hiện có trong ô Password to Open 

5. Gõ mật mã mới vào ô Password to modify. 

6. Nhấp OK. 

7. Nhấp ok trong hộp thoại Save As để ghi tập tin tài liệu lên đĩa với mật mã mới. 

 

25. Muốn xóa mật mã tập tin thì phải làm sao ? 

 Để xóa bỏ mật mã, dĩ nhiên phải biết mật mã, và thực hiện như sau: 

1. Mở tập tin có mật mã muốn xóa bỏ, phải gõ mật mã mới mở tập tin được. 

2. Nhấp chọn menu File -> Save As hiển thị hộp thoại Save As. 

3. Nhấp nút Options … Hộp thoại Save xuất hiện. 

4. Xóa các dấu sao * trong ô Password to open. 



5. Nhấp OK ở tất cả các hộp thoại. 

 

26. Việc thay đổi kết nối trong Word như thế nào? 

 Word tạo điều kiện dễ dàng cho việc hiệu đính một nối kết có sẵn, thực hiện như sau; 

1. Chọn menu Edit -> Links hiển thị hộp thoại Links, liệt kê tất cả các đường dây 

kết nối trên hộp thoại danh sách Source File. 

2. Chọn kết nối muốn thay đổi hay cập nhật trong hộp danh sách Source File. 

3. Chọn những khả năng khai báo : Đách dấu chọn nút Automatic hoặc Manual 

tuỳ theo muốn Word tự động cập nhật dữ liệu (khi tập tin được kết nối có thay 

đổi) hay đợi lệnh. Để đề phòng trường hợp dữ liệu bị thay đổi do vô ý thức, có 

thể khóa luôn khả năng cập nhật dữ liệu bằng cách chọn ô Locked. Khi nào cần 

cập nhật dữ liệu bình thường, xóa chọn ô Locked. 

4. Muốn bẻ gãy (break) một kết nối, nhấp vào nút Break Link. 

5. Nhấp nút Yes. Kết nối đã gãy rồi thì không thể khôi phục. Dữ liệu thể hiện 

trong tài liệu không còn liên quan gì với tập tin được kết nối lúc trước. 

6. Trường hợp muốn mở tập tin được kết nối ra sửa chữa, nhấp nút Open Source. 

Lúc này trở về tập tin nguồn cung cấp. 

7. Để thay đổi tập tin được kết nối (hoặc chỉ thay đổi sự tham khảo từ phần này 

đến phần khác trong chính tập tin ấy),  chọn Change Source và chọn tiếp tập tin 

khác. 

8. Quyết định cập nhật dữ liệu ngay lập tức bằng cách nhấp nút Update Now. Nếu 

tập tin được nối kết có thay đổi, sẽ thấy ngay thay đổi đó trong tài liệu đang 

soạn thảo. 



9. Sau khi thay đổi xong, nhấp OK để trở về với tài liệu đang soạn thảo 

 

27. Làm sao dùng Word để ghi tập tin dưới dạng văn bản ASCII ? 

 Muốn đưa tài liệu sang dùng trong những chương trình khác (chạy dưới Windows hoặc 

không) hoặc loại máy khác. Tập tin ASCII chỉ chứa những ký tự  được nêu trong bảng mã 

ASCII (chứ không có những ký tự định dạng hoặc điều khiển như khai báo in đậm, in 

nghiêng… như trong tài liệu của Word).Văn bản ASCII thường được gọi là văn bản thuần túy. 

 Để ghi tài liệu Word theo hình thức ASCII, thực hiện như sau: 

1. Tạo tài liệu bình thường.  

2. Nhấp chọn menu File -> Save As. Hộp thoại Save As xuất hiện. 

3. Trong hộp danh sách Save as type, chọn mục MS-DOS Text hoặc Text Only. 

4. Nhấp Ok. 

 

28. Làm sao dể ghi tài liệu của Word theo các dạng thức tập tin khác ? 

 Sau khi soạn thảo văn bản bình thường trong Word, muốn lưu trữ ở dạng thức nào đó, thực 

hiện như sau: 

1. Nhấp chọn menu File -> Save As. Hộp thoại Save As xuất hiện.  

2. Chọn dạng thức tập tin tùy ý trong hộp danh sách Save as type. 

3. Gõ tên tập tin ở ô File name. 

4. Nhấp OK. 



 

   29. Có thể chỉ kiểm tra ngữ pháp mà không cần kiểm tra chính tả không ? 

 Được chứ ! Hoàn toàn có thể rà lại ngữ pháp trong tài liệu của mình mà không cần kiểm tra 

chính tả. Thao tác như sau: 

1. Nhấp chọn menu Tools -> Options, rồi chọn thẻ Spelling & Grammar. 

2. Xóa chọn ô Check grammar with spelling, rồi nhấp OK. 

 

30. Có những phím nào giúp di chuyển nhanh trong phạm vi một bảng không ? 

 Ngoài các phím thường dùng khi soạn thảo, có thể dùng các tổ hợp phím dành riêng cho 

việc thao tác trên bảng như sau : 

 

     

Hàng động  Phím hoặc tổ hợp 

phím tắt 

Chuyển sang ô tiếp theo Chuyển về 

ô trước đó  Chuyển về đầu ô  

Chuyển về cuối ô Chuyển đến ô 

đầu tiên của hàng Chuyển đến ô 

cuối cùng của hàng Chuyển đến ô 

đầu tiên của cột Chuyển đến ô cuối 

cùng của cột  

Tab Shift + Tab 

Home End Alt + 

Home Alt + End Alt 

+ PgUp Alt + PgDn 



 

   

31. Để xóa bảng, tôi chọn bảng và nhấn phím Delete. Sao nó vẫn nằm ra đó ? 

 Khi chọn bảng và nhấn phím Delete, Word chỉ xóa nội dung của bảng chứ cấu trúc bảng 

cùng các thông tin định dạng vẫn còn. Muốn xóa cả nội dung lẫn cấu trúc bảng, hãy đánh dấu 

chọn bảng, rồi nhấp chọn menu Table -> Delete Rows, hay nhấp chọn menu Edit -> Cut. 

 

32. Muốn che giấu các đường kẻ ô của bảng, phải làm sao ? 

 Để thể hiện hay giấu đi các đường kẻ ô của bảng (dùng để phân chia các hàng và cột), nhấp 

chọn menu Table -> Hide Gridlines. Chức năng này hoạt động theo kiểu bật / tắt. Vì thế nó sẽ 

thay đổi giữa Show/Hide Gridlines. Word không bao giờ in ra giấy các đường lưới, dù chúng 

hiển thị/bị giấu trên màn hình. 

 

33. Tôi phải làm sao để tạo bóng (Shading) cho các ô của bảng hoặc cho các đoạn văn ? 

 Dễ lắm ! Bạn làm như sau : 

1. Chọn các ô của bảng hoặc chọn đoạn văn bản muốn tạo bóng.  

2. Nhấp chọn menu Format ->Borders and Shading, chọn tiếp thẻ Shading. 

3. Chọn sắc độ xám (tính theo phần trăm) trong ô Fill. Nhấp OK.  Thế là xong! 

 

34. Muốn định dạng một bảng, làm theo cách nào thì nhanh nhất ? 



 Word có chức năng gọi là Table AutoFormat cho phép nhanh chóng áp đặt một dạng thức 

nào đó lên phần bảng đã chọn. Có thể dùng chức năng này ngay khi lập bảng. 

 Muốn dùng chức năng Table AutoFormat trên một bảng có sẵn, thực hiện như sau: 

1. Di chuyển điểm chèn vào bảng muốn định dạng. 

2. Khởi động chức năng Table AutoFormat trên một bảng có sẵn thực hiện như 

sau: 

 Trỏ vào bảng và nhấp nút phải chuột để cho menu tắt xuất hiện, rồi chọn 

mục Table AutoFormat… Lúc này hộp thoại Table AutoFormat xuất 

hiện. 

 Hoặc nhấp chọn menu Table -> Table AutoFormat. 

 Hoặc nhấp nút AutoFormat trên hộp thoại Insert Table khi tạo bảng 

thông qua lệnh Table -> Insert Table. Cách này chỉ áp dụng cho các 

bảng mới tạo ra, chứ các bảng hiện hữu thì không dùng được. 

3. Khi hộp thoại Table AutoFormat xuất hiện, chọn một trong các dạng thức được 

định sẵn tại hộp danh sách Formats. Mỗi lần chọn một loại khác trong hộp danh 

sách Formats, khung Preview cạnh bên sẽ hiển thị dáng vẻ của bảng. 

4. Mỗi dạng thức gồm nhiều yếu tố như khung(Borders), bóng mờ(Shading), kiểu 

chữ(Font), màu sắc(Color), và khả năng tự so khớp(Autofit), tùy ý chọn các ô 

tương ứng với những yếu tố trên để xác định dạng thức. Chẳng hạn, nếu không 

muốn thay đổi kiểu chữ thì đừng chọn Font. 

5. Xác định các hàng đầu (Heading Row), cột đầu (First Column), hàng cuối (Last 

Column), để áp dụng những khai báo bổ sung của dạng thức được chọn. Những 

chi tiết ấy đều cần có bề ngoài khác với phần còn lại của bảng. 

6. Cuối cùng, nhấp OK để dạng thức đã định được áp dụng thực sự. 



 

35. Khi bảng trải dài qua nhiều trang, tôi muốn hàng tiêu đề của bảng lại xuất hiện ở đầu 

trang sau để người xem phân biệt rõ các cột. Word có cho phép làm như vậy không ? 

 Được chứ ! Word có thể cho lập lại một hay nhiều hàng ở đầu các trang có bảng. Bạn hãy 

làm như sau: 

1. Chọn một hay nhiều hàng thuộc về phần tiêu đề của bảng.  

2. Nhấp chọn menu Table -> Headings. 

 Thế là Word đã hiểu những hàng nào đóng vai trò tiêu đề của bảng. Khi bảng kéo dài qua 

nhiều trang, Word sẽ tự động lập lại các dòng tiêu đề ở đầu mỗi trang. Tuy nhiên, khi dùng 

ngắt trang cứng (bằng cách nhấn tổ hợp phím Ctrl + Enter), Word sẽ không lập lại các hàng 

tiêu đề như vừa nói. 

 

36. Làm thế nào chèn thêm hàng, cột vào bảng ? 

 Tuy bảng đã được lập ra với số hàng và cột theo khai báo ban đầu nhưng sau này, vẫn có 

thể thoải mái thêm cột hay hàng vào bảng khi cần, không sao cả. 

 Muốn chèn thêm cột vào bảng : 

 Chọn ô ở đúng vị trí muốn có cột mới, rồi nhấp chọn menu Table -> Insert Column 

(hoặc nhấp chuột phải vào bảng cho hiện menu tắt và chọn Insert Column trên 

menu đó). 

 Muốn chèn nhiều cột liên tiếp ở chỗ nào, chọn nhiều ô liên tiếp ở chính chỗ đó và 

thao tác theo cách như vừa nói. Kéo con trỏ qua đầu các cột, tại đúng vị trí muốn 

chèn các cột mới. Sau đó, nhấp chọn menu Table -> Insert Columns hoặc trên menu 

tắt(xuất hiện khi bạn nhấp nút phải chuột vào bảng) 



 Các cột mới sẽ được Word chèn vào bên trái các cột đã chọn.  

 Muốn chèn thêm hàng vào bảng, có những cách tương tự như  khi chèn cột: 

 Chọn các ô đúng vị trí muốn có các hàng mới, rồi chọn menu Table -> Insert Rows 

(hoặc nhấp nút phải chuột vào bảng cho hiện menu tắt và thao tác theo cách như 

vừa nói). 

 Kéo con trỏ qua cạnh trái của các hàng, tại đúng vị trí muốn chèn các hàng mới. Sau 

đó, chọn menu Table -> Insert Rows hoặc trên menu tắt (xuất hiện khi nhấp nút 

phải chuột vào bảng). 

 Hai cách nói trên có tác dụng chèn thêm các hàng mới vào phía trên những hàng được 

chọn. Cách khác: 

 Khi đang ở ô cuối cùng của bảng, hãy gõ phím Tab, Word sẽ tạo thêm một hàng ở cuối 

bảng. 

 

37. Tôi có một bảng đang nằm ở ngay đầu tài liệu. Tôi có thể thêm đoạn vào trước bảng 

không ? 

 Muốn chèn thêm văn bản vào trước bảng (bảng nằm ở ngay đầu tài liệu), chỉ việc di chuyển 

đến đầu ô thứ nhất và nhấn phím Enter, Word sẽ thêm một dấu Paragraph mark vào phía trên 

bảng.  Từ chỗ ấy trở đi, có thể soạn thảo văn bản bình thường. 

 

38. Có thể tách một ô thành nhiều ô không ? 

 Được chứ. Để tách một ô thành nhiều ô, thực hiện như sau: 

1. Chọn một hay nhiều ô muốn tách. 



2. Nhấp chọn menu Table -> Split Cells. 

3. Theo mặc định, có thể tách một ô thành hai. Nếu muốn tách một ô thành nhiều ô, 

khai báo con số cụ thể trong Number of columns. 

4. Cuối cùng,  nhấp chọn OK. 

 Khi tách ô, Word phân chia văn bản bên trong ô dựa trên các dấu phân đoạn (paragraph 

mark) có ở đó. Khi chỉ có một dấu phân đoạn,  đối với các ô vừa tách ra từ một ô ban đầu, 

Word sẽ đặt cả văn bản ở ô tận cùng bên trái, các ô bên phải để trống.   

 Khi ô được chọn để phân chia có nhiều dấu phân đoạn, Word sẽ phân phát mỗi phân đoạn 

cho một ô mới tạo thành.  

 

39. Làm thế nào để cho một ô trải dài qua nhiều cột của bảng ? 

 Hoàn toàn có thể gộp các ô ở cạnh nhau thành một ô duy nhất. 

 Chỉ việc chọn các ô muốn gộp, rồi nhấp chọn menu Table -> Merge Cells. 

 Các ô trên cùng hàng (và khác cột, dĩ nhiên ) sẽ được nhập thành một. Nội dung các ô ấy 

trở thành các đoạn văn trong cùng một ô (Word tạo dấu phân đoạn để phân biệt chúng,  nghĩa 

là nội dung của các ô nguyên thủy sẽ được phân cách bởi dấu paragraph mark trên ô mới) 

 

40. Tôi muốn đặt bước Tab vào trong ô của bảng có được không? 

 Bình thường, trong một bảng, khi nhấn phím Tab,  điểm chèn sẽ nhảy từ ô này sang ô khác. 

 Việc chèn bước Tab vào trong ô của bảng biểu cũng thực hiện bình thường như đối với 

đoạn văn bản  



   Muốn di chuyển đến bước Tab trong bảng biểu,  đặt điểm chèn đến ô có chứa bước Tab và 

nhấn tổ hợp phím Ctrl + Tab. 

 

41. Làm sao thay đổi chế độ canh lề đoạn văn bản trong một bảng? 

 Nhập văn bản trên bảng cũng tuân theo quy tắc định dạng đoạn văn bản như đối với đoạn 

văn bản bình thường. Do đó việc định dạng lại các mục trong bảng vẫn theo lề lối chung.  Cụ 

thể,  hãy thao tác như sau: 

1. Chọn các ô,  các hàng hay các cột muốn hay đổi chế độ canh văn bản.  

2. Nhấp chọn menu Format -> Paragraph, hộp thoại Format Paragraph xuất hiện. 

3. Chọn thẻ Indents and Spacing. 

4. Chọn các chế độ canh chỉnh lề khác nhau trong hộp thoại Alignment. 

5. Nhấp OK. 

Để cho nhanh, sau khi chọn các ô,  các cột hay hàng cần thiết,  nhấp vào biểu tượng canh lề 

trên thanh công cụ định dạng  

Có các nút khác nhau ứng với từng chế độ canh chỉnh lề: canh trái(Align Left),  canh phải 

(Align Right), canh giữa (Center) hoặc canh đều hai bên (Justify). 

 

42. Làm sao để thay đổi chiều rộng của cột trong bảng? 

 Lúc đầu, Word tạo các cột của bảng có chiều rộng như nhau. Tuỳ theo yêu cầu, vẫn có hể 

điều chỉnh chiều rộng của cột. Có thể chủ động thay đổi chiều rộng cột hoặc cho Word toàn 

quyền điều chỉnh cột theo nội dung. Thao tác như sau: 



1. Đưa điểm chèn vào cột cần thiết, có thể chọn đồng thời nhiều cột nếu muốn chúng có 

chiều rộng như nhau. 

2. Nhấp chọn menu Table -> Cell Height and Width. 

3. Khi hộp thoại Cell Height and Width xuất hiện, nhấp chọn thẻ Column. 

4. Định chiều rộng cụ thể của cột bằng cách gõ số đo vào ô Width of Column và nhấp 

OK. Nếu muốn Word tự điều chỉnh chiều rộng cột thì chọn AutoFit. 

 Điều chỉnh chiều rộng cột bằng cách kéo điểm phân chia tương ứng trên thước ngang (Nếu 

chưa thấy thước thì hiển thị nó). 

+ Cách khác: 

 Đưa con trỏ vào đường kẻ đứng, để con trỏ chuyển thành hình mũi tên “hai đầu trái phải”, 

rồi kéo đường kẻ ấy đến vị trí mới.  Động tác này có tác dụng thu hẹp hay mở rộng cột ở bên 

trái đường kẻ. 

 Điều đáng chú ý là: Do sự thu hẹp hay mở rộng một cột, mọi cột ở bên phải cột ấy sẽ bị xê 

dịch ngang, sang phải hay sang trái. Do đó, chiều rộng toàn bảng toàn bảng sẽ tăng lên hay 

giảm xuống. Muốn cho chiều rộng toàn bảng không đổi, nhấn phím Shift hay Ctrl khi kéo 

đường kẻ đứng. 

 Khi nhấn giữ phím Shift và kéo đường kẻ đứng, cột bên trái đường kẻ bị thu hẹp thì cột bên 

phải được mở rộng ra. 

 Còn khi nhấn giữ phím Ctrl và kéo đường kẻ đứng, mọi cột bên phải đường kẻ được điều 

chỉnh lại đồng loạt và có chiều rộng như nhau. 

 

43. Có thể phân chia một hàng của bảng ở chỗ sang trang hay không ? 



 Không có trở ngại gì !Word cho phép chia hàng tại chỗ sang trang, nhờ đó một phần của 

hàng nằm ở trang trước,  một phần nằm ở trang sau. Một đường chấm chấm xuất hiện biểu thị 

chỗ sang trang. 

1. Chọn hàng muốn phân chia. 

2. Nhấp chọn menu Table -> Cell Height and Width, hộp thoại Cell Height and Width 

xuất hiện, nhấp chọn thẻ Row. 

3. Đánh dấu chọn ô Allow row to break across pages, rồi nhấp OK. 

 Nếu không chọn ô Allow row to break across pages, khi không đủ chỗ cho hàng ở cuối 

trang, Word tự động “bê” nguyên hàng đó sang trang sau.Khi Word chặt một hàng ngay chỗ 

sang trang, thì một hàng lấm chấm sẽ xuất hiện ngang qua một hoặc nhiều ô trên bảng. 

 

44. Tôi không muốn hàng của bảng bị chia ra ở chỗ sang trang. Vậy phải làm sao? 

 Để Word khỏi chia hàng tại chỗ sang trang, thực hiện như sau: 

1. Chọn các hàng không muốn chia. 

2. Nhấp chọn menu Table -> Cell Height and Width, hộp thoại Cell Height and Width 

xuất hiện. Nhấp chọn thẻ Row. 

3. Xoá chọn ô Allow row to break across pages, rồi nhấp OK. 

 

45. Tôi đưa công thức vào bảng nhưng không thích cái cách mà Word thể hiện kết quả : 

dấu Đô-la, các chữ số thập phân...Cho chúng biến đổi đi được không? 



 Những chi tiết dấu đô-la, các chữ số thập phân... thuộc các dạng thức được áp dụng. Các 

công thức của Word có thể cho kết quả theo dạng công thức mặc nhiên hoặc dạng công thức 

riêng. 

 Dạng thức mặc nhiên được thiết lập trong hộp thoại Regional Settings(thuộc Control panel 

của Windows). Nếu các trị số dùng trong công thức không có phần thập phân, kết quả của công 

thức sẽ có phần thập phân tối thiểu thôi(thể hiện hai chữ số sau dấu chấm thập phân ). Nếu các 

trị số dùng trong công thức có những kí tự định dạng nào đó như dấu đô-la hay dấu phẩy chỉ 

hàng ngàn,  kết quả thu được cũng sẽ có các dấu đó.  

 Muốn thay đổi dạng thức của kết quả tính toán,  có thể làm như sau: 

1. Di chuyển điểm chèn đến công thức muốn thay đổi định dạng. 

2. Chọn menu Table ->Formula.Khi hộp thoại Formular xuất hiện, thì công thức ở ô hiện 

hành xuất hiện ở ô Formular. 

3. Nhấp lên hộp danh sách Number Format ở dưới,  chọn dạng thức có sẵn trong hộp danh 

sách hoặc đưa ra một dạng thức riêng tùy ý. 

Trong các dạng thức có sẵn, có nhiều dạng thức thích hợp để ghi số tiền hay số phần trăm.  

Ký tự # chỉ vị trí của vị trí của chữ số,  chữ số 0 để chỉ rằng chữ số 0 sẽ xuất hiện nếu 

không có chữ số tại vị trí đó. 

Muốn thuận tiện,  nên chọn lấy một dạng thức có sẵn và sửa đổi nó. Chẳng hạn, có thể 

chọn $#,##0.000 ; ($#,##0.000) rồi đổi thành $#,##0;($#,##00) nếu không muốn có các chữ 

số sau dấu chấm thập phân. Dạng thức số gồm hai phần như trên là để phân biệt hai trường 

hợp áp dụng : cho số dương và cho số âm. 

4. Nhấp nút OK, bắt đầu áp dụng dạng thức mới. 

 



46.Có cách nào để ghi lại dữ liệu trong bảng thành một tập tin văn bản bình thường,  với 

các hàng và các cột được sắp sếp bởi ký tự ngăn cách nào đó (Bước Tab chẳng hạn) ? Tôi 

rất cần tập tin như vậy để đưa dữ liệu bảng vào căn cứ dữ liệu của tôi. 

Word cho phép chuyển văn bản bình thường được sắp sếp theo cột và hàng thành một bảng.  

Việc chuyển ngược lại chẳng có gì khó khăn gì.  Thực hiện như sau: 

1. Mở tập tin tài liệu của Word có chứa bảng, sao chép nó và dán vào một tập tin tài liệu 

mới. (Làm việc này khi bảng chỉ là một phần của tập tin tài liệu). Khi ấy ta có một tập 

tin tài liệu chỉ dùng để chứa bảng.  

2. Nhấp chọn menu Table -> Select Table, hoặc nhấn tổ hợp phím Alt + 5(vùng phím 

số, Tắt chế độ Numlock).  

3. Nhấp chọn menu Table -> Convert Table to text. Hộp thoại Convert Table To Text 

hiện lên với bốn nút cho biết loại ký tự dùng làm phân cách các vùng. 

4. Word hỏi muốn chọn ký tự nào để làm dấu ngăn cách, nên dùng bước Tab bằng cách 

chọn nút Tabs. Nhấp OK. 

5. Nhấp chọn menu File -> Save As để chuẩn bị lưu trữ tập tin.  

6. Trong hộp danh sách Save As type,  chọn Text Only. 

7. Có thể đặt một tên mới nào đó trong ô File name thay cho tập tin tài liệu Word, phân 

biệt rõ hai loại tập tin. 

8. Nếu muốn, chọn một thư mục khác để ghi tập tin mới. 

9. Nhấp OK lưu tập tin. 

 Với tập tin được ghi như vậy,  tha hồ dùng nó ở đâu tuỳ ý, trong các phần mềm quản trị căn 

cứ vào dữ liệu hay trong phần mềm bảng tính. 

 



47.Cách thức tạo bảng mục lục như thế nào ? 

 Nếu thiết lập một cấu trúc một cách thích hợp cho văn bản, Word có thể tự động biên dịch 

bảng tạo mục lục. Bí quyết để định dạng lại văn bản nhằm thực hiện các style cấu trúc từ 

Heading1 đến suốt Heading9 cho mỗi đoạn văn bản.  Những mục Heading này cho phép gọi 

lên chín cấp độ của các mục Heading con trong các đoạn văn bản (Nếu không muốn sử dụng 

các style này, có thể thay thế việc định dạng style tuỳ ý). Để biên dịch một bảng mục lục bằng 

cách sử dụng các style thể hiện, hay theo các bước sau đây: 

 Áp dụng các kiểu heading đã được thiết lập đối với những heading đã có trong văn bản. 

Chắc rằng những heading con cùng cấp được định dạng cùng kiểu. Nếu như không thấy các 

heading đã được tạo sẵn trong hộp style, nhấn giữ phím Shift trong khi nhấp vào mũi tên 

xuống để mở hộp danh sách này. 

1. Xác định vị trí của điểm chèn nơi Word sẽ chèn bảng mục lục vào.  

2. Nhấp chọn menu Insert -> Index and Table. 

3. Trong hộp thoại  Index and Table, chọn thẻ Table of Contents. 

4. Trong hộp danh sách Formats, chọn kiểu định dạng để sử dụng cho chỉ mục, khung 

Preview sẽ hiển thị kiểu định dạng.  Sử dụng hộp Show levels gõ vào số mức chỉ mục 

được trình bày trong khung Preview. Sử dụng hộp Tab leader để chọn kiểu tab leader. 

5. Đánh dấu ô chọn Show page numbers đính kèm số trang trên bảng mục lục. 

6. Đánh dấu ô chọn Right align page numbers để sắp xếp các số trang ở số lẻ bên phải của 

trang chỉ mục cho thẳng hàng. Xoá chọn ô này nếu muốn số trang xuất hiện ngay sau 

phần đề mục.   

7. Nhấp OK. 

 Word sẽ thiết lập và chèn nội dung của bảng mục lục vào trong văn bản. 



 Nếu như không muốn sử dụng các kiểu đã được tạo sẵn, có thể định kiểu riêng để tạo các 

cấp độ chỉ mục khác nhau. Từ bước 1 đến bước 5 thực hiện theo chỉ dẫn sau: 

1. Nhấp nút Options trong hộp thoại Index and Tables. 

2. Trong hộp thoại Table of Contents Options, chọn kiểu thể hiện chỉ mục (heading ) 

trong ô chọn Available styles. Trong các phần bỏ trống ở TOC level, gõ vào một số từ 

1 đến 9 để đại diện cho cấp độ một chỉ mục được định dạng trong kiểu này. Xoá tất cả 

cấp độ không phù hợp trong hộp TOC Level. 

3. Nhấp nút OK trong hộp thoại Tables of Contents Optons. 

4. Đánh dấu ô chọn Right align page number để căn chỉnh các số trang bên lề phải của 

bảng mục lục. Không đánh dấu ô này nếu muốn số trang xuất hiện ngay sau phần các 

đề mục. 

5. Đánh dấu ô chọn Show page numbers để kèm số trang trong bảng mục lục. Không đánh 

dấu ô này nếu không muốn chúng xuất hiện. 

6. Nhấp OK. Word thiết lập và chèn bảng mục lục vào trong văn bản của bạn.  

Sau khi đã taọ bảng mục lục, có thể cập nhật nó bằng cách nhấp vào một vị trí bất kì trong 

bảng mục lục rồi nhấn phím F9. Hộp thoại cùng menu xuất hiện, cho phép chọn ô Update 

page numbers only nếu như không muốn chỉnh sửa các mục lục này. Ngược lại nhấp vào ô 

Update entire table để cập nhật cả số trang lẫn bảng mục lục sau khi đã chỉnh sửa. Nhấp nút 

OK thực hiện quá trình cập nhật này. 

 

48.Cách tạo chữ hoa (Drop Cap) ở đầu một đoạn văn bản? 

 Chữ hoa đầu đoạn văn bản làm cho tài liệu trở nên sáng sủa và đẹp hơn. Vậy làm thế nào 

tạo chữ hoa đầu đoạn văn bản bằng Word ? Thực hiện như sau: 



1. Chọn đoạn văn bản cần tạo chữ hoa (Drop Cap). 

2. Nhấp chọn menu Format -> Drop Cap hiển thị hộp thoại Drop Cap. 

3. Ở hộp thoại Drop Cap, trong mục Position nhấp vào một trong các kiểu định dạng thích 

hợp. 

4. Chọn Font chữ thể hiện cho Drop Cap ở khung Font. 

5. Sử dụng khung Lines to drop định chữ hoa sẽ nằm trong khoảng bao nhiêu hàng và 

khung Distance from Text điều chỉnh khoảng cách từ chữ hoa lớn đến ký tự thứ hai của 

đoạn văn bản.  

6. Nhấp OK. 

Nếu muốn tạo nhiều chữ hoa đầu đoạn, chỉ cần đánh dấu chọn nhóm chữ ấy rồi thực hiện 

các bước như trên đã hướng dẫn. 

 

49. Làm thế nào để kết hợp Bullet và Numbering với nhau không? 

 Thực hiện như sau: 

1. Nhấp chọn menu Format -> Bullets and Numbering xuất hiện. Chọn tiếp thẻ Outline 

Numbered. 

2. Nhấp chọn ô có kiểu định dạng thích hợp nhất.  

3. Nhấp nút Customize chọn lựa các kiểu thay đổi dạng Bullets và Numbering theo ý 

muốn. 

4. Nhấp OK ở các hộp thoại.  

 



50. Tôi có thể cho chú dẫn (Callout) vào trong văn bản được không? 

 Được chứ. Word có những hình dáng chú dẫn rất đẹp mắt. Thực hiện như  sau: 

1. Di chuyển đến trang văn bản muốn đặt chú dẫn.  

2. Nhấp biểu tượng Drawing trên thanh công cụ chuẩn. 

3. Nhấp nút AutoShapes trên thanh công cụ Drawing. Trong hộp danh sách chọn Callouts 

hiển thị các kiểu dáng Callout. 

4. Con trỏ chuột khi ấy sẽ biến thành dấu cộng. Kéo dấu cộn này về bên phải và xuống 

dưới để tạo Callout. 

5. Gõ nội dung vào trong vùng Callout này. 

6. Nhấp nút phải chuột, hiển thị menu tắt.  Trong menu tắt này, nhấp chọn Format 

AutoShape hiển thị hộp thoại Format AutoShape. 

7. Thay đổi kiểu định dạng chú giải (kích thước,  màu sắc...) trong hộp thoại này.  

 

51. Tôi có thể duy trì các đoạn trong cùng một cột được không? 

 Thực hiện như sau: 

1. Chọn những đoạn muốn nằm chung cột. 

2. Nhấp chọn menu Format -> Paragragh. 

3. Chọn tiếp thẻ Line and Page Breaks. 

4. Ở mục Pagination, đánh dấu chọn ô Keep with next. 

5. Nhấp OK. Các đoạn đã chọn sẽ được duy trì trong cùng một cột. 



 

52.Làm thế nào để tạo những tựa đề đẹp mắt trong văn bản ? 

 WordArt là một công cụ đắc dụng. Muốn tạo WordArt,  hãy theo các bước sau : 

1. Chọn menu Insert -> Picture -> WordArt. 

2. Word cung cấp hộp thoại WordArt Gallery chứa các kiểu dáng đẹp mắt của WordArt. 

3. Chọn một trong  các kiểu dáng ấy rồi nhấp OK. 

4. Hộp thoại xuất hiện, gõ dòng văn bản muốn tạo WordArt vào khung Text. Các hộp 

Font, Size và nút biểu tượng in đậm, in nghiêng cho phép chọn phông chữ và định dạng 

lại. 

5. Nhấp OK, Word sẽ tự động chèn WordArt vừa tạo vào trang văn bản, đồng thời đưa ra 

thanh công cụ WordArt cho phép tiếp tục chỉnh sửa nếu chưa vừa ý. 

 

53. Làm thế nào hiển thị một khung giữa các cột văn bản? 

 Kẻ một Textbox ở giữa các cột và thực hiện một vài thao tác nhỏ cho textbox sẽ tạo được 

một khung giữa các cột. Thực hiện như sau: 

1. Nhấp nút Column trên thanh công cụ chuẩn để thiết lập số cột văn bản. Nhập văn bản 

vào trong những cột này. 

2. Nhấp chọn menu View -> Page Layout. 

3. Kẻ một textbox tuỳ ý. Nhấp chuột phải mở menu tắt. Trong menu tắt này,  chọn 

Format Text Box.  Hộp thoại Format Text Box xuất hiện.  



4. Định vị trí khung. Ở mục Wrapping style chọn Square. Ở mục Wrap to chọn Both 

sides. 

5. Ngoài ra có thể thực hiện các thay đổi khác như định dạng lại các đường viền khung 

hoặc kích cỡ text box. 

6. Nhấp OK. 

 

54. Tôi có một dòng chữ, và tôi muốn một phần của dòng chữ được canh lề trái,  phần 

còn lại canh lề phải. Làm thế nào đây? 

  Ta dùng bước Tab để định dạng: 

1. Gõ vào toàn bộ nội dung của dòng chữ, cả hai phần canh trái / phải. 

2. Nhấp chọn menu Format -> Tabs. 

3. Hộp thoại Tabs xuất hiện.  Định bước Tab phải ở tận lề bên phải trang giấy.   

4. Nhấn nút Set rồi nhấp OK. 

5. Trở lại trang văn bản, di chuyển điểm chèn đến ký tự đầu tiên của phần văn bản canh lề 

và nhấn phím Tab. 

 

55. Có thể trao đổi thông tin giữa bảng trong Word và phần mềm Excel không? 

 Thật sự thì nếu đưa một bảng tính của Excel vào Word,  Word sẽ biến đổi bảng tính đó 

thành một bảng tính của Word. Và nếu đưa một bảng của Word vào Excel thì Excel sẽ biến đổi 

bảng đó thành một bảng tính. Cần phải biết là không có vấn đề trong việc trao đổi dữ liệu trong 

Word và Excel, tuy nhiên không thể giữ được các hình thức định dạng. 



 

56.Có thể tạo biểu đồ từ bảng không? 

 Nếu Word có những tính năng của bảng tính, dĩ nhiên có thể tạo biểu đồ từ một bảng: 

1. Chọn bảng muốn tạo biểu đồ. 

2. Nhấp chọn menu Insert -> Picture -> Chart. Word sẽ chạy chương trình Microsoft 

Gragh Chart tạo và đưa biểu đồ này vào tài liệu. 

 

57. Làm thế nào để khoảng cách giữa cá dòng chữ dãn ra gấp 1, 5,gấp đôi sau đó lại trở 

về  bình thường được. 

 Thực  hiện như sau : 

Nhấp các đoạn văn bản muốn giản dòng.  

Nhấn tổ hợp phím ctrl+5 khoảng cách giữa các dòng chữ  sẽ giãn ra gấp 1,5. 

Nhấn tổ hộp phím ctrl+o khoảng cách giữa dòng chữ sẽ giãn ra gấp đôi. 

Nếu muốn trở lại khoảng cách dòng bình thường thì nhấn vào tổ hợp phím ctrl+1. 

Trên menu và trong hộp thoại, các chữ gạch chân giúp mở các lệnh cùng với phím alt. 

Ví dụ:nhấn tổ hợp phím alt+o+f để mở hộp thoại font. 

Trong thực tế những người dùng máy tính chuyên   nghiệp thích dùng phím tắt và tổ hợp phím 

theo kiểu này bởi lẽ rất nhanh chóng và dễ thao tác. 

 



58. Tôi muốn xóa bỏ các vệt trắng  ngăn cách trên menu và muốn thêm các vạch ngăn 

cách mới có được không? Cách thực hiện.  

Khi nhấp vào menu File, một menu  dọc xổ xuống, trong đó chứa cùng những vạch ngăn cách. 

Có thể thêm bớt tùy ý những vạch ngăn cách này. Thực hiện các bước sau: 

1. Nhấp chuột phải vào một nút công cụ bất kỳ, chọn mục Customize. Hộp thoại 

Customize xuất hiện.  

2. Nhấp vào menu File, một men xổ xuống xuất hiện. Giả sử   muốn gỡ bỏ vạch phân cách  

dưới lệnh Close, nhấp chuột phải vào lệnh Save, một menu con hiện ra. 

3. Xóa chọn mục Begin a Group. 

4. Nhấp nút Close để đóng hộp thoại Customize. 

Nếu thêm vạch ngăn cách giữa các menu lệnh, thực hiện các bước trên và chọn begin a group. 

Mục đích chính của vạch phân cách này là phân chia các nhóm lệnh với nhau để dể quan sát. 

 

59. Máy tính của tôi cài word 97 và word 2000 nhưng ở nhà lại không máy in, tôi bèn sao 

chép văn bản và cho vào máy cơ quan cài win 3.11 và word D6.0 thì máy không đọc được. 

Vậy có cách nào để văn bản thực hiện được trên máy cài word 97 hoặc word 2000 nếu 

đem đến word D6.0 đọc được không?  

Thực hiện như sau: 

1. Mở lại văn bản trong máy ở nhà ra. 

2. Nhấp chọn menu File -> Save as (hoặc nhấn phím F12), hộp thoại Save as xuất hiện. 

3. Lúc này thực hiện các thao tác  lưu giữ một tập tin mới.  



4. Phần quan trọng nhất là ô Save as type, nhấp vào đó và chọn mục Word 6.0/95 có nghĩa 

là chọn kiểu tương thích với các máy cài Word 6.0. 

5. Nhấp nút save và lưu lại tập tin. 

6. Sao tập tin này vào đĩa mềm và đem đến cơ quan,  máy tính ở cơ quan sẽ mở được văn 

bản của bạn.  

Lưu ý là các định dạng thực hiện bằng Word 97 và Word 2000 mà word 6.0 không chức năng 

đó sẽ bị biến mất. 

 

60. Khi kẻ một hình chữ nhật bằng biểu tượngo trên thanh công cụ Drawing, tôi không 

làm sao chèn chữ được. Giúp tôi đi.  

Thực hiện như sau:  

1. Nhắp vào nút biểu tượng n  Rectangle và vẽ một hình chữ nhật.xuất hiện 8 handle 

trắng xung quanh hình. 

2. Nhấp chuột phải, một menu tắt xuất hiện, nhấp vào mục Add  Text, điểm chèn sẽ nằm 

trong hình chữ nhật, cho phép chèn chữ vào đó. 

 

61. Tôi muốn tìm hiểu xem nút biểu tượng    Autoshapes trên thanh công cụ Drawing 

dùng làm gì, cách dùng? 

Trong nút biểu tượng này có rất nhiều tuỳ chọn, mỗi tuỳ chọn cho rất nhiều kiểu dáng hình vẽ 

như: mặt trăng, kim cương, chữ nhật, sao vàng, dấu móc, hộp chú giải. 

Nội dung các kiểu dáng hình ảnh của AutoShapes như sau: 



1. Muốn chọn các kiểu dáng trong Autoshapes, nhấp vào nút bên trái của biểu tượng này, 

hộp danh xuất hiện. 

2. Chọn tiếp một loại hình trong hộp danh sách, nó sẽ cung cấp tiếp một hộp hình dáng 

các AutoShapes.  

3. Nhấp chuột vào hình dáng tuỳ ý, con chuột sẽ biến thành dấu cộng.  

4. Kéo dấu cộng này vào trang văn bản và kéo rê chuột về bên phải và xuống dưới thả 

chuột sẽ vẽ được Autoshapes đã chọn vào văn bản. 

 

62. Làm thế nào để chèn văn bản vào trong các hình vẽ như cuốn thư, ngôi sao? 

 

Bạn thực hiện các bước sau: 

1. Nhấp chọn Autoshapes - stars and banners và chọn hình vẽ như cuốn thư.  

2. Vẽ hình cuốn như trên văn bản. 

3. Muốn viết chữ vào trong cuốn thư, nhấp chuột phải vào hình cuốn thư, menu tắt xuất 

hiện nhấp vào mục Add text, điểm chèn xuất hiện trong một cuốn thư, cho phép nhập 

văn bản vào hình cuốn thư. 

 

63. Khi sử dụng thanh công cụ drawing vẽ mũi tên / đường thẳng và di chuyển chúng vào 

các vị trí cần thiết,chúng thường xê dịch đi cao hơn, có cách gì để đặt chúng chính xác 

không? 

Thực hiện như sau 



1. Nhấp vào nút Draw trên thanh công cụ Drawing. Hộp danh sách xuất hiện. 

2. Nhắp chọn Grid. Hộp thoại Snap to Grid xuất hiện. 

3. Xóa chọn ô Snap to Grid: điều chỉnh gía trị horizontal spacing và vertical thành 0.1 cm.  

4. Nhắp nút OK. 

Từ nay trở đi việc điều khiển mũi tên / đường thẳng sẽ rất chính xác và dễ dàng. 

 

64. Tôi vẽ mũi tên hay bị cong trông rất xấu, vậy có cách gì để vẽ thẳng được? Cách di 

chuyển mũi tên /hình ảnh trên văn bản? 

 Muốn di chuyển mũi tên hoặc đối tượng bất kỳ trong văn bản, phải chọn đối 

tượng.nói cách khác cho dễ hiểu là nhấp vào đối tượng đó, trên màn hình sẽ thấy 

xuất hiện 8 handle bao quanh, riêng mũi tên chỉ có 2 handle ở hai đầu.  

 Đưa con chỏ chuột vào đó, khi thấy xuất hiện mũi tên 4 đầu thì nhấp chuột và kéo 

đến vị trí định đặt và thả chuột. Một cách khác là sau khi nhấp vào đối tượng, nhấn 

phímç  trên bàn phím để duy chuyển theo các chiều trái/trên/phải/dưới. 

 Muốn vẽ mũi tên thẳng, nhấn Shift trong khi kéo chuột để vẽ. 

 

65.Tôi muốn cho hình ảnh chìm xuống dưới văn bản và mờ đi,đậm lên có được không, 

cách làm thế nào? 

 

Thực hiện như sau : 

1. Nhấp chọn menu Insert/Picture/Clip Art/From File. 



2. Chọn hình ảnh tuỳ ý rồi nhấn nút Insert trên các hộp thoại để chèn hình ảnh vào trang 

văn bản.  

3. Thông thường khi chèn hình ảnh vào văn bản, thanh công cụ Picture sẽ xuất hiện cùng 

lúc. Nếu không, kích hoạt nó bằng cách nhấp chọn menu View/Toolbar, đánh dấu chọn 

Picture.  

4. Nhấp vào nút biểu tượng thứ 5 hoặc thứ 6 trên thanh công cụ này để thay đổi độ sáng 

tối cho ảnh. 

5. Nhấp vào nút biểu tượng thứ 2 trên thanh công cụ picture. Hộp thoại xổ xuống xuất 

hiện. 

6. Nhấp chọn watermark để cho ảnh chìm xuống phía dưới văn bản. 

66. Xin cho biết autotext là gì, cách sử dụng, cách gỡ bỏ autotext. 

Autotext là đặc tính chèn văn bản tự động. Nó được dùng vào các việc sau đây: tạo 

autotext cho những dòng tiêu đề (văn bản, hình ảnh) thường xuyên gặp khi xoạn thảo văn 

bản, tránh việc mất công chỉ gõ đi gõ lại như thế. 

Thực hiện tạo một autotext như sau: 

1. Nhập tiêu đề (hoặc đoạn văn bản) hay sử dụng vào trang văn bản. 

2. Đánh dấu chọn đoạn văn bản này. 

3. Nhấp chọn insert - autotext - autotext, hộp thoại autocorrect, thẻ autotext xuất hiện. 

4. Gõ vào ô enter autotext entries here nhóm ký tự tắt dùng làm ký hiệu của autotext. 

5. Nhấp nút add. 

6. Nhấp OK. 



Muốn sử dụng autotext này, chỉ cần gõ nhóm ký tự tắt và phím F3, lúc đó tiêu (hoặc khối văn 

bản) sẽ chèn vào văn bản.  

Muốn xoá bỏ autotext, vào autotext, gõ phím ký tự tắt vào phím enter auttext entries here (hoặc 

chọn lựa chúng ở danh sách bên dưới), sau đó nhắp delete. 

Từ nay về sau sẽ không sử dụng được autotext này nữa. 

 

67.Tôi muốn ngăn cản người khác không tạo autotext thì làm cách nào, muốn làm 

autotext thì thực hiện ra sao?  

Thực hiện như sau: 

1. Nhấp đúp vào ô có chữ WPH trên thanh trạng thái ở dưới màn hình, một hộp thoại xuất 

hiện. 

2. Nhấp tiếp vào nút options hộp thoại khác lại xuất hiện. 

3. Đánh dấu chọn vào ô help for wordperfect users. 

4. Nhấp OK. 

5. Nhấp nút close. 

 Muốn cài đặt được autotext, thực hiện lại các bước trên và xoá chọn ô help for wordperfect 

users. 

 

68.Tôi soạn một văn bản dài 30 trang, bây giờ tôi chuyển sang tập tin mới. Tôi muốn 

đánh số trang tiếp theo là 31. vậy tôi phải làm thế nào? 

Thực hiện như sau: 



1. Chọn menu - view - header and footer  

2. Nhấn chọn nút  format page number trên hộp thoại này. Hộp thoại page number 

format xuất hiện. 

3. Trong mục start at, gõ số 31  

4. Nhấp OK. 

5. Nhấp nút close trên hộp thoại header and footer 

 

69. Làm thế nào chuyển sang một tài liệu khác đã mở trên word? 

Bất cứ lúc nào có tài liệu đang mở, tên tài liệu này sẽ xuất hiện ở cuối menu window. 

Để mở tài liệu, bạn: 

 Nhấp chọn tên tài liệu muốn mở từ menu window 

 Hoặc mỗi tài liệu đều có một số hiệu được gạch dưới ở trước tên tài liệu tương ứng trên 

menu window. Nhấn tổ hợp phím Alt + w, nhấn tiếp số hiệu của tài liệu để kích hoạt 

nó. 

 

70. Sử dụng thông tin mách nước.  

Assistant có hiển thị mẫu thông tin mách nước mới trong ngày (tip of the day) mỗi lần khởi 

word, và tiếp tục cung cấp mẫu thông tin mách nước khác trong suốt ngày đó. Thông tin mách 

nước hàng ngày tự động xuất hiện, còn các thông tin mách nước khác tự thông báo sự hiện 

diện của chúng bằng biểu tượng có dạng bóng đèn tròn. 

 



Nhấp vào bóng đèn để xem thông tin mách nước. 

Nếu assistant bị giấu, biểu tượng bóng đèn sẽ xuất hiện bên cạnh nút help trên thanh công cụ 

chuẩn, và có thể nhấp vào đó để hiển thị thông tin mách nước 

 

71. So sánh chế độ chèn (insert) và chế độ gõ chồng (overtype) trong word ? 

Mặc định, word nhập văn bản trong chế độ insert (chèn), sao cho khi chèn thêm từ ở giữa dòng 

văn bản, cụm từ ở bên phải từ mới sẽ dời sang phải đến phía trước. Tuy nhiên, cũng có thể vận 

hành trong chế độ overtype (gõ chồng), sao cho từ được gõ vào sẽ thay thế từ ở vị trí đó thay vì 

đẩy nó sang phải. 

Muốn chuyển sang chế độ overtype, nhấn nút ovr trên thanh trạng thái, hoặc chọn tools - 

options, chọn thẻ edit, rồi nhấp chọn overtype mode 

 

72. Tôi loay hoay mãi vẫn không đổi được đơn vị đo trong word. Làm thế nào bây giờ? 

 

Thước đo ở đầu cửa sổ tài liệu chỉ ra chiều rộng của dòng văn bản, và bất kỳ bước tab hoặc 

khoảng thụt vào. Mặc định, đơn vị của thước đo là inch 

Nếu thước đo chưa hiển thị ở đầu cửa sổ tài liệu, nhấp chọn menu view - ruler 

Việc thay đổi đơn vị đo sẽ ảnh hưởng đến tất cả các mục có sử dụng đơn vị đo như định dạng 

trang giấy, kích thước hình ảnh… 

Muốn thay đổi đơn vị đo, thực hiện như sau:  

 



1. Nhấp chọn menu tools - options  

2. Trong hộp thoại options, chọn thẻ general  

3. Ở mục measurement units, chọn đơn vị đo tuỳ ý bằng cách nhấp chọn nó trong hộp 

danh sách xổ xuống  

4. Nhấp OK 

 

73. Tại sao không thụt vào phím tab hoặc spacebar? 

Trong word, có sự khác biệt lớn giữa cách thụt vào bằng phím tab/spacebar với việc dùng các 

dấu indent  

Trong word, nếu nhấn phím tab hoặc phím spacebar sẽ chèn một nhóm ký tự trắng vào dòng. 

Khi nhấn tab để thụt vào dòng đầu của đoạn trong tài liệu mới chẳng hạn, có nghĩa bắt đầu 

dòng này bằng các ký tự trắng. Có hai vấn đề phát sinh:  

Phải nhấn phím tab ở đầu mỗi đoạn để thụt vào một cách nhất quán  

Sau đó nếu trộn đoạn này với đoạn nằm ngay bên trên, word sẽ di chuyển khoảng cách tab 

hoặc ký tự trắng thừa theo đoạn đó  

Bạn phải mất công xóa bước tab để có được khoảng cách thích hợp  

Trái lại, khi định khoảng thụt vào. Word phải bắt đầu đoạn tại vị trí cụ thể trên dòng. Việc làm 

này có hai ưu thế: 

Có thể dể dàng trộn đoạn này với đoạn nằm ngay bên trên, vì không hề có ký tự trắng thừa nào 

xen giữa chúng  

Word sẽ tự động thụt vào mọi đoạn, vì xác lập được thực hiện cùng với các xác lập định dạng 

đoạn khác mỗi lần nhấn phím enter  



Hãy sử dụng các dấu indent của word bất kỳ khi nào có thể, nhằm tiết kiệm thời gian và bảo 

đảm được tính nhất quán trong định dạng  

 

74. So sánh hanging indent và left indent  

Thoạt trông, hanging indent có thể tương tự left indent, có điều ở vị trí khác, vì vậy có nhiều 

người đã cho rằng không có gì khác biệt giữa hai dấu này. Nhưng mà có đấy: 

Khi di chuyển dấu left indent, dấu first line indent cũng di chuyển theo, do đó mối quan hệ 

giữa khoảng thụt vào của dòng đầu so với các dòng còn lại trong đoạn này vẫn được duy trì  

Khi di chuyển dấu hanging indent, dấu first line indent vẫn yên vị tại chỗ, vì thế mối quan hệ 

khoảng thụt vào của dòng đầu so với các dòng còn lại trong đoạn sẽ thay đổi 

 

75.Tôi muốn định lề rộng hơn hoặc hẹp hơn cho chỉ một vài trang văn bản trong tài liệu 

thì sẽ phải làm sao? 

Muốn định lề rộng hơn hoặc hẹp hơn cho chỉ một trang, thực hiện như sau: 

1. Chọn khối văn bản trên trang đó. 

2. Nhấp chọn menu file - page setup 

3. Định lại các xác lập lề (trên, dưới,trái, phải) mới 

4. Trong mục apply to chọn selected text trong danh sách xổ xuống  

5. Nhấp OK 

Khi ấy word sẽ tự động định dạng lề cho khối văn bản đã chọn. Những phần văn bản nào 

không cùng kiểu định dạng lề sẽ được đẩy qua các trang khác  



 

76. Tôi nghe nói nhiều về đặc tính zoom, vậy nó có công dụng gì vậy? 

Ngoài khả năng hiển thị tài liệu ở nhiều khung nhìn khác nhau, word còn cho phép phóng to / 

thu nhỏ nội dung tài liệu nhờ vào đặc tính zoom. Phóng to tài liệu giúp xem được những chi 

tiết nhỏ trong hình ảnh. Thu nhỏ tài liệu rất có ích khi cần hiển thị nhiều phần của tài liệu trên 

màn hình. 

Việc phóng to thu nhỏ tài liệu được thực hiện thông qua menu View/Zoom.Khi sử dụng đặc 

tính zoom, phải định rõ tỉ lệ thu phóng cho nội dung tài liệu :ví dụ, kích thước thực tế là 100%. 

Đặc tính zoom chỉ thay đổi cách xem tài liệu, chứ không ảnh hưởng đến cỡ chữ hoặc kích 

thước hình ảnh sẽ được in ra hay hiển thị trên Web. 

 

77. Hình như Word cho phép đặt tên tập tin dài đến 255 kí tự thì phải ? 

Đúng có thể  đặt tên tập tin dài tối đa 255 kí tự (kể cả kí tự trắng ) trong Word, nhưng không 

được dùng dấu gạch xiên và một và kí tự khác, vì Microsoft Windows sử dụngchúng để nhận 

diện vị trí tập tin. Nếu cố lưu tập tin, Word sẽ hiển thị thông điệp cho biết nó không thể định vị 

thư mục, chắc chắn đã dùng kí tự không thích_hợp trong tên tập tin.  

Một lời khuyên là nên đặt tên tập tin gắn gọn, khoảng 8 kí tự là vừa. 

 

78. Làm thế nào để Word nhận biết thư mục hiện hành ? 

Thư mục hiện hành hiển thị trong hộp thoại Open hoặc Save As là thư mục  sau cùng được mở  

tập tin từ đó hoặc lưu tập tin vào đó. Nếu vừa khởi động Word, thư mục  hiện hành là một địa 

điểm định sẵn,   chẳng hạn thư  mục Mydocument.  



Nếu mở hoặc lưu hầu hết tài liệu trong cùng thư mục, có thể thay đổi địa điểm mặc định cho tài 

liệu, để Word luôn khởi động tại địa điểm này khi mở hoặc lưu tập tin. Muốn định lại địa điểm 

mặc định cho tài liệu  Word, dùng thanh menu Tools trên thanh menu của Word : 

1. Nhấp chọn menu Tools/Options mở hộp thoại Options.  

2. Chọn thẻ File Locations. Thẻ này chứa danh sách dạng thức tài liệu và địa điểm  mặc 

định hiển thị.  

3. Chọn Documen từ danh sách File Type và nhấp nút Modffy. 

4. Trong thoại Modffy Location chọn thư mục mong muốn ở hộp Look  in,  để tên thư mục 

này xuất hiện ở hộp Folder name. 

5. Nhấp nút Ok.  

Kiểm tra nhằm bảo đảm địa điểm thư mục hiển thị cho các Documen đã đúng.  

Nhấp nút Ok đóng hộp thoại Options. 

 

79.Word xử lý văn bản chèn như thế nào ? 

Hộp thoại Insert File hoạt động giống như hộp thoại Open, nhưng nó không hỗ trợ nhiều dạng 

thức tập tin khác nhau.Word sẽ cố hết sức để định dạng văn bản hay dữ liệu được chèn vào tập 

tin.  

Nếu chèn tập tin Word (.dos) vào tài liệu và văn bản trong tập tin được định dạng khác với văn bản 

trong tài liệu. Word sẽ chèn văn bản mà vẫn giữ  nguyên thông tin định dạng. Tuy nhiên Word không 

nhập bất kỳ stype nào gắn liền với văn bản chèn vào. 

Nếu chèn tập tin mà Word không có bộ chuyển đổi dạng thức cho tập tin đó. Word cố mở tập tin 

hoặc hiển thị thông báo cho biết tập tin không mở được.  



Để đỡ mất công định dạng lại hoặc tránh rắc rối, hãy sử dụng tài liệu Microsoft Office khi chèn tập 

tin.  

Muốn bảo toàn dung lượng tập tin khi chèn lượng lớn dữ liệu từ tập tin khác, nên chèn liên kêt 

tập tin thay vì chèn chính tập tin. Để thực hiện đánh dấu chọn ô Link to File trong hộp thoại 

Insert File.  

 

80. Ý tưởng tạo template: 

Tạo và sử dụng Template cho đủ loại mục đích. Sau đây là ý đáng suy nghĩ : 

Tạo template tài liệu công ty như template  Bank docume trên trang General rồi lưu style, phím tắt, 

macro vào để thực thi kiểu mẫu tài liệu chuẩn cho công ty. Đặt vào thư mục templates trên máy phục 

vụ mạng hay phân phát cho người khác trong công ty kèm theo chỉ dẫn về địa chỉ cất giữ trong thư 

mục Template trong đĩa cứng của họ.  

Tạo templates fax hay thư cho cá nhân hoặc công ty thường xuyên gởi thư từ hay fax. Bạn đỡ phải gõ 

vì tên cá nhân hoặc công ty cùng với thông in liên hệ đều xuất hiện  trên mỗi tài liệu mới.  

Tạo templates chứa style, phím tắt, menu hay thanh công cụ cho đủ loại dự án. Bằng cách tạo menu,  

thanh công cụ và lệnh theo ý riêng, có thể lập môi trường Word tối ưu cho từng loại dự án.  

Dùng templates để chuẩn hóa kiểu định dạng cho các tài liệu phức tạp như bản tin  hoặc sách.  

Nếu thấy cứ phải gõ mãi một thông tin hay cứ hiệu chỉnh mãi một xác lập định dạng trong tài liệu,  

hãy template để khỏi mất công thực hiện cho những tài liệu sau này.  

 

81. Word đánh số tự động như thế nào? 

Sau khi đã áp dụng định  dạng số cho danh sách, Word sẽ tự động theo dõi số đầu và số cuối trong  

danh sách rồi điều chỉnh chúng cho phù hợp khi xóa hay sắp xếp lại văn bản.  



Khi bắt đầu đánh số, Word gán số 1 cho khoản mục thứ nhất trong danh sách, số thứ hai cho khoản 

mục thứ hai và cứ thế tiếp tục (trừ phi chọn mở đầu bằng số khác). 

Lúc xóa một khoản mục khỏi danh sách, Word sẽ định dạng lại danh sách và đánh số lại khoản mục. 

Chẳng hạn, nếu xóa đoạn số 3 khỏi danh sach 4 khoản mục, số 4 sẽ tự động đánh số lại thành 3. Khi 

di chuyển các đoạn trong danh sách, Word sẽ tự đánh số lại sao cho con số luôn kế tiếp nhau.  

 

82.Tôi muốn tính dữ liệu từ bảng biểu khác. Làm thế nào bây giờ? 

Trường hợp tài liệu có nhiề bảng biểu, có thể  chen công thức vào bảng biểu này để tính toán các giá 

trị từ bảng biểu  khác. Các bước thưc hiên : 

Chọn bảng lưu giữ các giá tri được tính rồi đặt tên  bookmark.  Nhớ chọn toàn bảng biểu rồi mới 

chèn bookmark.   

Di chuyển đến ô muốn nhập công thức, kế đó nhấp chọn menu Table /Formula.  

Lập công thức,  tham chiếu đến các ô trong bảng biểu khác theo tên bookmark. Ví dụ như bookmark 

là “Table2” và muốn tính tổng dãy ô từ cột B đến C, tham chiếu có dạng  : 

AVERAGE(table2 B2:C5) 

 

83. Có cách nào khống chế đối tượng đồ họa khi vẽ không ? 

Bằng cách giữ shift khi vẽ đối tượng đồ  họa,  sẽ khống chế đối tượng theo một hình dạng hay góc độ 

cụ thể như sau : 

Đường thẳng bị khống chế ở từng góc 15 độ. Ví dụ giữ shift để vẽ đường ngang và đường dọc một 

cách hoàn hảo  

Hình chữ nhật bị khống chế thành hình vuông  



Hình oval bị khống chế thành hình tròn hoàn hảo  

Autoshapes bị khống chế thành các hình dạng ban đầu hiển thị trên các palette hay menu con 

autoshapes  

 

84. Chỉ cho tôi cách thay đổi dạng thức với paste special đi  

Những đối tượng vẽ trong word được lưu trữ theo dạng thức MS Office drawing object nhưng có thể 

chuyển chúng sang dạng thức JPEG, GIF, PNG, WINDOWS METAFILE, hay dạng thức khác, 

thông qua lệnh paste special 

Sao chép hoặc cắt đối tượng vào clipboard  

1. Chọn paste special từ menu EDIT. Hộp thoại paste special xuất hiện và dạng thức hiện hành 

đang được chọn  

2. Chọn dạng thức hình ảnh thay thế. Hộp Result ở dưới cùng sẽ giải thích ưu khuyết điểm của 

mỗi dạng thức 

3. Nhấp OK 

 

85. Có lần tôi muốn đưa hình ảnh vào tài liệu nhưng chẳng làm được vì hình ảnh lớn quá 

khổ của trang giấy. Có cách gì giải quyết được không ? 

Nếu hình ảnh quá lớn so với khổ giấy, không cho phép in ra được toàn hình ảnh, hãy 

thu nhỏ nó lại bằng cách như sau : 

Chèn hình ảnh vào trang văn bản. 

Nhấp đúp hình ảnh để hiển thị hộp thoại Format Picture. 



Trong hộp thoại Format Picture, nhấp chọn thẻ Size. 

Thay đổi giá trị Height, Width trong mục Size and rotate, hoặc tỷ lệ trong mục Scale 

cho đến khi nào hình ảnh nằm trọn vào trang giấy. 

Nhấp OK. 

 

86.Làm thế nào rã nhóm đối tượng Clip Art để sửa đổi theo ý riêng?  

 Nhiều đối tượng Clip Art thật sự là tập hợp đối tượng thành viên được tổ chức chung trên 

cùng lớp thích hợp. Khi làm việc với đối tượng Clip Art không phải là đối tượng đồ họa nội 

tuyến, hãy rã nhóm đó để thay đổi hình dạng hay màu sắc của những thành phần khác nhau. 

Thực hiện như sau : 

Chèn hình ảnh vào trang văn bản. 

Nhấp nút biểu tượng Draw trên thanh công cụ Drawing. Trong hộp danh sách, nhấp 

chọn Ungroup. Nhiều Handle xuất hiện và khó nhận ra Handle nào thuộc phần nào. 

Phóng to tài liệu lên 200% so với kích cỡ gốc hay to hơn nữa. Đối tượng đồ họa trở nên 

lớn hơn, và Handle cách xa nhau hơn. 

Nhấn giữ phím Shift và nhấp chọn phần hình ảnh muốn hiệu chỉnh. 

Thay đổi màu bằng cách nhấp vào nút biểu tượng Fill trên thanh công cụ Drawing. 

 

Đôi khi đối tượng đồ họa được nhóm trong nhiều lớp. Có nghĩa là mỗi lần rã nhóm, các 

phần của nó vẫn chứa nhóm đối tượng nhỏ hơn. Trong trường hợp này chỉ việc chọn nhóm nhỏ 

hơn và rã nhóm một lần nữa. 



Bằng cách rã nhóm đối tượng đồ họa, có thể chỉnh sửa chúng cho nhiều mục tiêu sử 

dụng khác nhau. 

 

87. Một số bí quyết khi tạo biểu đồ: 

 Với quá nhiều loại biểu đồ và tùy chọn định dạng khả dụng trong Microsoft Graph, rất dễ 

mất thời gian chọn tới chọn lui mà cuối cùng lại thu được một biểu đồ không vừa ý. Biểu đồ 

trông rất đẹp mắt bên cạnh tài liệu, nhưnh hãy nhớ rằng mục tiêu của biểu đồ là chỉ ra mối 

quan hệ rõ ràng hơn cả trang bảng tính, bảng biểu hay văn bản. Sau đây là một số nguyên tắc 

cơ bản :  

Chọn đúng loại biểu đồ. Nều chưa nhận ra nét tương quan giữa dữ liệu cần biểu thị với biểu đồ, 

hãy chọn một biểu đồ khác. Chẳng hạn, muốn hiển thị nhiều vạch hơn thanh hay cột trong 

biểu đồ, hãy sử dung biểu đồ vạch để biểu diễn nhiều chuỗi dữ liệu khác nhau. 

Hãy dùng từ ngữ ngắn gọn hay viết tắt trong trục X. Nhãn phân mục có khuynh hướng chạy 

nhập  vào nhau và trở nên khó đọc, đặc biệt khi biểu đồ biểu diễn các nhóm dữ liệu vượt 

trên bốn giai đoạn. 

Sử dụng hai biểu đồ nếu một biểu đồ không đủ đáp ứng hoặc có thể gây nhầm lẫn. Không được 

kết hợp nhiều tập hợp dữ liệu với nhiều chuỗi dữ liệu trong một biểu đồ nhằm biểu diễn hai 

hay nhiều mối quan hệ chính yếu cùng một lúc. 

Không được biểu diễn quá nhiều điểm dữ liệu. Cũng không nên lập biểu đồ cho những tập hợp 

giá trị có giá trị quá cách biệt nhau, chẳng hạn, hai nhóm trong dãy 5 chữ số và một nhóm 

khác trong dãy 3 chữ số. Nếu không, tỷ lệ trục Y sẽ quá lớn đến nỗi không thể nào phân 

biệt những đại lượng nhỏ hơn. 

Tránh chất đống thông tin trên biểu đồ. Dữ liệu được biểu diễn là một điểm nhỏ, và thông tin 

làm người đọc không nhận rõ điểm đó. Nếu cần nhiều thông tin để giải thích biểu đồ, nên 

sử dụng loại biểu đồ khác vốn có khả năng trình bày dữ liệu hiệu quả hơn. Nếu buộc phải 

gán chú thích, hãy sử dụng AutoShape trong Word để tạo khung chú thích. 



Không chọn quá nhiều điểm dữ liệu. Càng nhiều điểm dữ liệu, chúng càng gần nhau và càng 

khó đọc biểu đồ. Dĩ  nhiên, có quyền điều chỉnh kích cỡ biểu đồ để làm cho nó lớn hơn ở 

mọi thời điểm, thế nhưng, điều đó có thể làm hỏng cách bày trí của tài liệu.  

Hãy cẩn thận với hiệu ứng 3-D. Chúng làm cho biểu đồ sống động hơn, nhưng đồng thời cũng 

làm cho biểu đồ trở nên khó đọc hơn. Nếu biểu đồ  3-D trông rối rắm, hãy dùng phiên bản 

2-D. 

Hãy thử in mọi biểu đồ kết quả. Những biểu đồ trông đẹp mắt trên màn hình rất có thể khó đọc 

trên giấy, đặc biệt khi in trên giấy trắng đen. Nếu máy in không in rõ các giá trị Grayscale, 

phải thay thế mẫu tô bằng màu tô. 

 

88.Có thể minh họa một số ví dụ về gạch dưới từ không ?  

 Word 97 cho chín tuỳ chọn gạch dưới. (Trong Word 95, có bốn chọn lựa, và trong Word 6, 

có ba tùy chọn.) Chỉ có tùy chọn gạch đơn dưới các từ và những khoảng trắng giữa các từ là có 

một nút trên thanh công cụ định dạng. Còn tất cả các kiểu gạch dưới đều khả dụng trên hộp 

thoại Font. Bảng sau đây liệt kê tên tùy chọn và ví dụ mẫu về tùy chọn gạch dưới. 

 

 Tên tùy chọn gạch dưới Ví dụ mẫu 

 Single (gạch đơn) A Rose 

 Words Only (Gạch dưới chỉ các từ (không gạch  A Rose 

 dưới khoảng trắng giữa các từ)) 

 Double (Gạch đôi(kép)) A Rose 

 Dotted (Gạch chấm chấm) A Rose 



 Thick (Nét dầy) A Rose 

 Dash (Nét vạch) A Rose 

 Dot Dash (Gạch chấm và vạch) A Rose 

 Dot Dot Dash (Hai gạch chấm và vạch) A Rose 

 Wave (Gạch dạng sóng) A Rose 

 

89. Một số phím tắt được sử dụng khi định dạng ký tự  

 

Phím tắt Tác dụng 

Ctrl + B Bật tắt chế độ in đậm 

Ctrl + I Bật tắt chế độ in nghiêng 

Ctrl + U Bật tắt chế độ gạch dưới liên tục (Gạch 

dưới tất cả khoảng trắng giữa các từ) 

Ctrl + Shift + W Bật tắt chế độ gạch dưới các từ (Không 

gạch dưới khoảng trắng giữa các từ) 

Ctrl + Shift + D Bật tắt chế độ gạch đôi dưới các từ (Không 

gạch dưới khoảng trắng giữa các từ) 



Ctrl ++ Bật tắt chế độ chỉ số dưới (Subscript), ví dụ 

CO2. 

Ctrl + Shift + = Bật tắt chế độ chỉ số trên (superscript), ví 

dụ x
3
. 

Ctrl + Shift + A Bật tắt chế độ đổi thành chữ hoa.  

Ctrl + Shift + K Bật tắt chế độ đổi thành chữ hoa nhỏ  

Ctrl + Shift + F Kích hoạt hộp danh sách Font trên thanh 

công cụ Formatting, nơi bạn lựa tên phông. 

Khi thanh công cụ Formatting tắt, hãy nhấn 

Ctrl+Shift+F lần nữa để hiển thị hộp thoại 

Font 

Ctrl + Shift + P Kích hoạt hộp danh sách Font Size trên 

thanh công cụ Formatting, nơi bạn lựa kích 

cỡ phông. Khi thanh công cụ Formatting 

tắt, hãy nhấn Ctrl+Shift+F lần nữa để hiển 

thị hộp thoại Font 

Ctrl + Shift + H Chuyển đổi qua lại giữa chế độ che dấu 

(làm ẩn) văn bản. 

Ctrl + >   (Ctrl + Shift +.  ) Gia tăng kích cỡ phông tới cỡ phông kế tiếp 



lớn hơn trên máy in hiện hành. 

Ctrl + < Ctrl + Shift +,  ) Giảm bớt kích cỡ phông tới cỡ phông kế 

tiếp nhỏ hơn có thể được trên máy in hiện 

hành. 

Ctrl +] Gia tăng kích cỡ phông lên 1 Point 

Ctrl +[ Giảm kích cỡ phông xuống 1 Point  

Shift + F3 Thay đổi kiểu các ký tự được chọn từ chữ 

thường sang các từ có chữ hoa đầu, từ chữ 

có chữ hoa đầu thành toàn bộ chữ in hoa, 

và từ chữ in hoa thành chữ thường. 

Ctrl + Spacebar Ctrl + Shift + 7 Gỡ bỏ tất cả định dạng văn bản bổ sung, 

dạng thức văn bản sẽ được thiết lập chỉ 

theo Style paragraph. 

Ctrl + Shift + Q Chuyển đổi văn bản được chọn thành 

phông Symbol. 

Ctrl + D Hiển thị hộp thoại Font. 

 

 



90. Trong một tài liệu nhiều trang, muốn di chuyển nhanh trở lại vị trí trước đó phải làm 

thế nào ?  

 Giả sử di chuyển điểm chèn đến một vị trí khác của tài liệu rồi muốn quay điểm chèn về vị 

trí trước đó, hãy nhấn tổ hợp phím tắt Go Back (Shift + F5) để nhanh chóng quay về vị trí 

trước đó. Word nhớ ba vị trí sau chót nơi thực hiện thay đổi. Bằng cách nhấn lại phím tắt Go 

Back, có thể di chuyển điểm chèn giữa ba vị trí sau cùng và vị trí hiện hành. Nếu một trong 

những nơi đó nằm trong một tài liệu khác vẫn còn mở thì Word sẽ chuyển tới tài liệu đó. 

 

91. Di chuyển bằng các phím di chuyển 

 Bảng sau sẽ liệt kê các phím di chuyển và những hoạt động tương ứng của nó. 

Phím Hoạt động 

ž Di chuyển tới ký tự kế tiếp hoặc đến cuối 

vùng chọn. 

• Di chuyển tới ký tự đứng trước hoặc đến 

nơi bắt đầu vùng chọn. 

  Di chuyển xuống một dòng (cùng cột) 

Ÿ Di chuyển lên một dòng (cùng cột) 

Home Di chuyển tới đầu dòng. 



End Di chuyển tới cuối dòng. 

Page Down Di chuyển xuống một cửa sổ. 

Page Up Di chuyển lên một cửa sổ. 

Ctrl + ž Di chuyển tới từ kế tiếp/ cuối vùng chọn. 

Ctrl + • Di chuyển tới từ đứng trước hoăc  nơi bắt 

đầu vùng chọn. 

Ctrl + PageUp Di chuyển tới Browse Object trước đó. 

Ctrl + PageDown Di chuyển tới Browse Object kế tiếp. 

Ctrl + Ÿ Di chuyển tới nơi bắt đầu Paragraph hiện 

hành rồi tới nơi bắt đầu của mỗi paragraph 

trước đó.  

Ctrl +   Di chuyển tới nơi bắt đầu Paragraph kế 

tiếp. 

Alt + Ctrl + PgUp Di chuyển tới nơi bắt đầu của dòng hiển thị 

đầu tiên của cửa sổ. 



Alt + Ctrl + PgDn Di chuyển tới nơi cuối cùng của dòng hiển 

thị cuối cùng của cửa sổ. 

Alt + Ÿ Di chuyển tới khung/ đối tượng trước đó. 

Alt +   Di chuyển tới khung/ đối tượng kế tiếp. 

Ctrl + Home Di chuyển tới nơi bắt đầu của tài liệu. 

Ctrl + End Di chuyển tới điểm cuối tài liệu. 

 

92. Thao tác nhấp chuột: 

Thao tác Dùng để 

Nhấp  Định vị điểm chèn hoặc chọn một hình ảnh 

hoặc đối tượng. 

Nhấp đúp Chọn một từ. 

Nhấp ba Chọn toàn bộ paragraph. 

Nhấn-giữ phím Ctrl, nhấp vị trí bất kỳ Chọn toàn bộ câu. 



trong câu 

 

 Cũng có thể sử dụng các cú nhấp chuột và phím Shift để chọn bất kỳ khối văn bản nào 

bằng cách :  

Nhấp chuột tại nơi bắt đầu khối văn bản muốn chọn. 

Nhấn-giữ phím Shift. 

Nhấp cuối khối văn bản. 

 

93. Có cách nào truy tìm các từ trọn vẹn và các từ có phân biệt chữ thường chữ hoa ? 

Một số từ dài chứa trong chúng những từ ngắn gọn. Ví dụ : an  nằm ở giữa từ  thanh, ngang. 

Một số từ có thể là tên màu sắc (ví dụ : thiên thanh ), và trong những trường hợp khác, chúng 

là tên riêng của người (ví dụ: Thiên Thanh). Hoặc chúng có thể là từ bắt đầu một câu. Trong 

hai trường hợp sau, từ được viết hoa. Khi chỉ muốn truy tìm các từ ngắn (không là một bộ phận 

của từ dài hơn), nghĩa là muốn chỉ thị Word tìm các từ trọn vẹn. Cũng vậy, nếu muốn truy tìm 

các từ có sắp xếp đặt biệt giữa chữ thường và chứ hoa, nghĩa là muốn chỉ thị Word tìm từ có 

phân biệt chữ thường và chữ hoa một cách chính xác. Nếu không muốn chỉ thị Word làm điều 

này, Word sẽ tìm tất cả từ phù hợp bất kể chúng là chữ thường hay chữ hoa. 

Cũng có thể truy tìm các từ trọn vẹn và từ có phân biệt chữ thường và chữ hoa nhằm mục đích 

thay thế.  

Để chỉ thị Word truy tìm các từ trọn vẹn và từ có phân biệt chữ thường và chữ hoa, hãy thực 

hiện các bước sau: 

Chọn menu Edit / Find. Hộp thoại Find hiển thị. 



Gõ từ muốn truy tìm vào hộp Find What. 

Nhấp tiếp nút More. 

Đánh dấu chọn ô Match case để việc truy tìm có phân biệt chữ thường và chữ hoa. Xoá chọn ô 

này để truy tìm tất cả từ phù hợp bất kể chúng là chữ thường hay hoa. 

Đánh dấu chọn ô File whole words only để chỉ truy tìm các từ chọn vẹn. Xóa chọn ô này để 

truy tìm tất cả từ nằm bên trong các từ dài hơn. 

 

94. Di chuyển và sao chép hình ảnh:  

Có thể di chuyển hoặc sao chép một hình ảnh đã vẽ bằng cách sử dụng chuột. 

- Để di chuyển một hình ảnh, nhấp hình ảnh để chọn nó, rồi kéo hình ảnh đến vị trí mới.  

- Để sao chép một hình ảnh, nhấp hình ảnh để chọn, rồi nhấn-giữ phím Ctrl trong khi kéo bản 

sao của  hình ảnh tới vị trí mới. Bản gốc vẫn giữ lại trong vị trí nguyên thuỷ của nó, và bản sao 

được đặt ở vị trí mới. 

 

95.Tôi không thể thiết lập được các tiêu đề đầu trang/cuối trang (Header và Footer) của 

trang chẵn và trang lẻ? Hướng dẫn tôi cách thực hiện đi. 

Thực hiện tạo tiêu đề đầu trang/cuối trang cho các trang chẵn và lẻ như sau: 

- Nhấp chọn menu View / Header and Footer. 

- Hộp thoại Header and Footer xuất hiện cùng khung Header. Điểm chèn nằm trong khung 

Header. 



- Nếu muốn tạo tiêu đề trang chẵn / lẻ khác nhau, nhấp vào biểu tượng & trên thanh công cụ 

này. Hộp thoại Page setup xuất hiện. 

- Trong hộp thoại này, chọn thẻ Layout. Ơ mục Headers and Footers, đánh dấu chọn ô 

Different odd and even. 

- Khung Header sẽ thay đổi Odd Page Header (Tiêu đề trang lẻ). Gõ tiêu đề đầu trang vào trang 

này. 

- Nhấp vào nút biểu tượng trên hộp thoại Header and Footer. 

- Khung Header sẽ thay đổi thành Even Page Header (Tiêu đề trang chẵn). Gõ tiêu đề đầu trang 

vào trang này. 

- Nhấp Close đóng hộp thoại Header and Footer. 

Kiểm tra lại trên màn hình Print Preview xem có phải tiêu đề đầu trang/cuối trang có trang 

chẵn/ lẻ khác nhau hay không. 

 

96. Tôi nghe nói có cách di chuyển và sao chép nôi dung bằng các phím đặc biệt.  Có thật 

thế không? 

Word có các phím đặc biệt dùng để di chuyển và sao chép từ vào vị trí mới mà không phải 

dùng Clipboard. Đó là phím Move (F2) và phím tắt Copy (Shift + F2). 

Để di chuyển nhóm từ hãy làm như sau: 

- Chọn nhóm từ muốn di chuyển. 

- Nhấp phím F2, câu hỏi “Move to where?” xuất hiện trên thanh trạng thái. 

- Đặt điểm chèn vào vị trí mới bằng chuột hay bằng bàn phím. 



- Nhấn Enter để di chuyển tới vị trí mới, hoặc nhấn Escape thay cho phím Enter để huỷ việc di 

chuyển. 

Các bước cho phím tắt Copy (Shift + F2) cũng tương tự như trên. Để sao chép các từ, hãy làm 

như sau: 

- Chọn nhóm từ muốn sao chép. 

- Nhấn Shift + F2, câu hỏi “Copy to where?” được hiển thị trên thanh trạng thái. 

- Đặt điểm chèn vào vị trí mới bằng chuột hay bằng bàn phím. 

- Nhấn Enter để sao chép vùng chọn tới vị trí mới, hoặc nhấn Escape thay thế Enter để huỷ bỏ 

việc sao chép. 

 

97. Trong khi in tài liệu nhiều trang tôi phát hiện có vài trang bị sai lỗi chính tả. Vậy làm 

sao để in lại những trang này? 

Word không buộc phải in toàn bộ tài liệu cùng lúc. Nếu thích, có thể in chỉ một bộ phận của tài 

liệu, có thể in trang hiện hành, các trang riêng biệt, một loạt liên tiếp các trang, trang số lẻ, 

hoặc chỉ những trang số chẵn. Thậm chí có thể in văn bản được chọn. Những mục dưới đây 

giải thích tất cả các mục hiện trong hộp thoại Print. 

Nhấp chọn menu File / Print. 

In trang hiện hành: 

- Word hiểu trang có chứa điểm chèn là trang hiện hành. 

- Để in trang hiện hành, hãy nhấp tuỳ chọn Current Page ở mục Page range. 



In các trang riêng lẻ: 

- Để in các trang riêng lẻ(hoặc không liên tục), hãy gõ các số trang cách nhau bằng dấu phẩy, 

trong hộp Page ở mục Page range - ví dụ: 1,4,7,9.  Khi bắt đầu gõ, tùy chọn tự động được 

chọn. 

- Có thể kết hợp việc gõ các trang liên tục và các trang riêng lẻ: ví dụ: có thể gõ 3,4,8-10,13-

15,18. 

In từ trang này qua trang khác: 

- Có thể in một nhóm các trang liên tục, bắt đầu và kết thúc ở bất kì trang nào. Để làm việc 

này, gõ trong hộp Page số trang thứ nhất, một dấu gạch ngang, và trang cuối cùng - chẳng hạn, 

2-9. 

- Nếu tài liệu chứa các section mà bạn muốn in một dãy các trang, hãy gộp vào những số 

section. Đối với những tài liệu có phân ra các section, gõ p, số trang s, và số section - ví dụ, gõ 

p4s2 để in bốn trang của section 2. Bạn có thể gõ số trang và section kết hợp như một phần của 

dãy trang giống như các trang riêng lẻ ở mục trên - ví dụ:3, p4s2-p5s3, 10-29, 69. 

In các trang lẻ hoặc chẵn: 

- Để in chỉ những trang đánh số lẻ của một tài liệu, hãy chọn Odd pages trong danh sách thả 

xuống Print gần góc phải của hộp thoại Print. Để in chỉ những trang đánh số chẵn trong một tài 

liệu, hãy chọn Even pages trong danh sách này. 

- Tuỳ chọn chuẩn là in tất cả các trang lẻ hoặc trang chẵn. Bạn cũng có thể chọn chỉ trang lẻ 

hoặc trang chẵn trong phạm vi một dãy trang nhất định. Chẳng hạn, nếu bạn gõ vào một dãy 

trang 10-20 và chọn Even pages thì Word in các trang 10,12,14,16,18 và 20. 

In một vùng chọn trong tài liệu: 

Ta in một vùng chọn trong tài liệu bằng cách: 



a) Chọn vùng trong tài liệu muốn in. 

b) Chọn menu File / Print. 

c) Nhấp tuỳ chọn Selection ở mục Page range. 

d) Nhấp OK. 

Khi in một vùng chọn, Word không in tiêu đề đầu trang / cuối trang (header and footer). Cũng 

giống như vậy, việc in bắt đầu tại đỉnh của trang giấy chứ không phải ở nơi văn bản được đặt 

trên trang trong tài liệu. 

 

98.Cách biến đổi một hộp nhập thành khung. 

Nếu đã sử dụng một phiên bản trước đó của Word, có lẽ bạn quen thuộc với các khung. Có thể 

biến đổi một Text box thành một khung nếu thích khung hơn. Lưu ý rằng không thể chèn trực 

tiếp một khung trong Word 97. Để chèn khung, phải chèn Text box, rồi biến đổi nó thành 

khung. Cũng vậy, text box muốn biến đổi không thể liên kết với Text box khác. 

Để biến đổi một Text box thành khung (frame), hãy làm theo các bước sau: 

a) Nhấp Text box. 

b) Nhấp chọn menu Format / Text box mở hộp thoại Format Text Box rồi chọn thẻ Text 

Box. 

c) Nhấp nút Convert To Frame. 

d) Một hộp thông báo xuất hiện. 

e) Nhấp mút OK. 



Khi biến đổi Text Box thành khung, Word sẽ thay đổi các khung viền và bóng đổ, nếu cần, 

thành một trong 16 màu cơ bản. Bất kỳ hiệu ứng khung viền đặc biệt nào cũng được đổi thành 

phẳng. Bạn không thể sử dụng thành công cụ Drawing để bổ xung các hiệu ứng đặc biệt vào 

khung. Text Box cho phép sử dụng nhiều tuỳ chọn định dạng hơn khung. Cũng vậy, Text box 

tránh được các kiểu cách mà người dùng khung lĩnh hội được và thành thạo nhưng không 

thích. 
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PHẦN I: LÀM QUEN VỚI MS WORD 2007 

1. Tạo văn bản đầu tiên 

a. Làm quen với cửa sổ soạn thảo 

 Khi bạn mở Word sẽ có một tài liệu trống xuất hiện, nó trông như một tờ giấy và 

chiếm một khoảng lớn màn hình. 

 

Bạn muốn bắt đầu làm việc nhưng không biết bằng cách nào: 

- Bạn sẽ gõ văn bản ở đâu? Nếu muốn thụt đầu dòng thì phải làm sao? Thay đổi canh 

lề như thế nào? Làm sao để lưu tài liệu? 

- Hãy khởi đầu bằng cách làm quen với một số điểm căn bản của Word. 

b. Bắt đầu nhập liệu  

 Trong chương trình soạn thảo văn bản Microsoft Word 2007 thanh Ribbon được 

đặt ở phía trên vùng làm việc chính. Người dùng sẽ sử dụng các Nút Lệnh của thanh 

Ribbon để thực hiện các hiệu chỉnh. 
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1. Thanh Ribbon nằm phía trên cùng. 

2. Điểm chèn nội dung. 

 Word chờ bạn nhập nội dung. Tại điểm chèn nội dung có một gạch dọc nhấp 

nháy phía trên cùng bên trái cho bạn biết vị trí nơi những gì bạn gõ vào hiển thị. 

 Khoảng trống từ điểm chèn nội dung tới đầu trang và phía bên trái được gọi là 

các Margin (canh lề), bạn sẽ tìm hiểu về các Margin trong phần sau của bài. Bây giờ 

nếu bạn bắt đầu gõ văn bản, trang tài liệu của chúng ta sẽ dần được phủ đầy từ góc 

trên bên trái đi xuống.  

 Nếu bạn muốn gõ văn bản từ phía thấp hơn thay vì ở đầu trang hãy gõ phím 

ENTER trên bàn phím đến khi điểm chèn nội dung nằm ở đúng vị trí mà bạn mong 

muốn.  

 Nếu bạn muốn thụt đầu dòng hãy nhấn phím TAB trước khi gõ, mỗi lần gõ phím 

TAB điểm chèn nội dung sẽ dịch chuyển sang bên phải một khoảng là 1,5 inch.  

 Khi bạn gõ văn bản điểm chèn nội dung sẽ di chuyển dần từ trái sang phải. Khi 

điểm chèn này đi đến phần ngoài cùng bên phải bạn hãy tiếp tục gõ bình thường Word 

sẽ tự động chuyển xuống dòng mới.   

 Để bắt đầu một đoạn mới, hãy nhấn phím ENTER .  

c. Những kí hiệu hỗ trợ 

 

1. Ký hiệu phân đoạn, mỗi ký hiệu tương ứng với một lần nhấn phím ENTER.  

2. Ký hiệu TAB, mỗi ký hiệu tương ứng với một lần nhấn phím TAB.  

3. Ký hiệu SPACEBAR, mỗi ký hiệu tương ứng với một lần nhấn phím SPACEBAR. 

 Hãy tưởng tượng bạn đã gõ một văn bản như hình bên trên. Hai đoạn văn bản có 

vẻ cách nhau hơi xa. Đoạn thứ hai lại dường như thụt đầu dòng hơi nhiều so với đoạn 

đầu. 
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 Bạn có thể dễ dàng kiểm tra bằng cách nhìn vào những ký hiệu định dạng 

(formatting marks) mà Word tự động chèn vào khi bạn gõ văn bản. Các ký hiệu này 

luôn có mặt trong văn bản, tuy nhiên nó được ẩn đi cho đến khi bạn cần thì chúng mới 

hiển thị. 

 Để hiển thị những ký hiệu định dạng hãy sử dụng thanh Ribbon phía trên màn 

hình Word. Chọn thẻ Home, và tìm kiếm nút lệnh trong phần Paragraph, nhấn 

vào đó để hiển thị hoặc ẩn các ký hiệu định dạng.  

 Khi bạn nhìn thấy những ký hiệu định dạng này lần đầu tiên bạn có thể sẽ tự hỏi 

nó là gì và lo ngại nó có được in ra khi bạn in văn bản của mình hay không. Câu trả 

lời là không, các dấu hiệu này không được in dù bạn có nhìn thấy chúng trên màn hình 

soạn thảo.  

 Vậy ký hiệu định dạng là gì? Tác dụng của chúng? Hãy xem xét một ví dụ như 

sau:  

 Word tự động chèn ký hiệu đánh dấu đoạn văn bản (paragraph mark) mỗi 

khi bạn nhấn phím ENTER để bắt đầu môt đoạn mới. Trong hình minh họa trên, giữa 

hai đoạn văn bản xuất  hiện một ký hiệu đánh dấu đoạn văn bản thừa, có nghĩa là bạn 

đã nhấn phím ENTER hai lần thay vì chỉ cần nhấn một. Việc này làm xuất hiện các 

khoảng trống không cần thiết. Hãy xóa ký hiệu thừa này nếu bạn muốn tiết kiệm 

không gian trong văn bản. 

 Mỗi lần nhấn phím TAB sẽ làm xuất hiện một ký hiệu mũi tên . Trong hình, 

có một mũi tên ở đoạn đầu và hai mũi tên ở đạn thứ hai, như vậy phím TAB đã được 

nhấn hai lần ở đầu đoạn thứ hai. 

 Ký hiệu dấu chấm cho biết bạn đã nhấn phím SPACEBAR bao nhiêu lần giữa 

mỗi từ, hoặc khi bạn vô ý nhấn nhầm phím SPACEBAR giữa các ký từ trong một từ. 

Một chấm đại diện một khoảng trống, hai chấm là hai khoảng trống. Thông thường, 

chỉ cần có một khoảng trống ở giữa các từ. Cần lưu ý ký hiệu dấu chấm này khác với 

dấu chấm câu trong văn bản, dấu chấm câu nằm phía dưới chân các ký tự còn ký hiệu 

dấu chấm nằm ở giữa các ký tự.  

d. Những dấu gạch chân trong văn bản 

 Khi bạn gõ văn bản, thỉnh thoảng có thể Word sẽ tự động chèn các dấu gạch 

chân gấp khúc màu đỏ, xanh lá hoặc xanh dương phía dưới một số từ.  
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 Dấu gạch đỏ: có thể do lỗi chính tả hoặc Word không thể nhận dạng được từ 

bạn gõ vào, ví dụ như tên riêng hoặc tên một địa danh nào đó. Nếu từ của bạn gõ là 

đúng chính tả nhưng Word vẫn không nhận ra thì bạn có thể thêm từ đó vào mục từ 

điển Word (Word's Dictionary) để sau này từ đó không còn bị gạch dưới.  

 Dấu gạch xanh lá: Word cho rằng bạn nên kiểm tra lại ngữ pháp (tất nhiên là 

tiếng Anh)   

 Dấu gạch xanh dương: từ bạn gõ vào là đúng chính tả nhưng có thể không hợp 

với ngữ cảnh hoặc ngữ nghĩa của câu.Ví dụ thay vì dùng từ "too" (quá) bạn có thể gõ 

nhầm thành "to".  

 Vậy bạn sẽ phải xử lý những dấu gạch đó như thế nào? Hãy Click-Chuột-Phải 

trên từ bị gạch dưới, Word sẽ tự động đưa ra các đề nghị chỉnh sửa (thỉnh thoảng 

Word cũng có thể sẽ không đưa ra được bất kỳ gợi ý nào). Hãy chọn gợi ý nào bạn 

cảm thấy hợp lý để thay thế từ bị gạch dưới, phần gạch dưới này sẽ biến mất. Các dấu 

gạch dưới này không xuất hiện khi bạn in văn bản.  

 Một lưu ý đối với dấu gạch dưới màu xanh lá và xanh dương: trong đa số trường 

hợp, Word thường chính xác trong việc chỉ ra các lỗi ngữ pháp thông dụng. Tuy 

nhiên, bạn nên cân nhắc khi sử dụng chức năng này. Nếu bạn chắc chắn rằng mình 

đúng và Word đã sai, hãy bỏ qua những gợi ý chỉnh sửa này.  

e. Thay đổi canh lề trang văn bản  

 Canh lề (Margins) là các khoảng trống xung quanh viền của trang văn bản. Phía 

Trên, Dưới, Phải và Trái của trang có một khoảng canh lề bằng 1 inch (tương đương 

2.54cm), đây là khoảng canh lề thông dụng nhất mà bạn có thể sử dụng trong đa số 

trường hợp. 
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 Nếu bạn muốn thay đổi canh lề thì bạn có thể thực hiện dễ dàng vào bất cứ lúc 

nào. Chẳng hạn như khi bạn muốn viết một lá thư, trình bày một công thức hoặc làm 

một bài thơ thì bạn có thể sẽ cần những khoảng canh lề khác.  

 Hãy sử dụng thanh Ribbon để thay đổi các khoảng canh lề. Chọn thẻ Page 

Layout, Trong phần Page Setup click chọn nút Margins bạn sẽ nhìn thấy danh sách 

nhiều khoảng canh lề khác nhau bên cạnh đó là thông số chi tiết cho mỗi phần.  

 Khoảng canh lề đầu tiên trong danh sách là Normal, khoảng canh lề hiện tại. Để 

chọn canh lề nhỏ hơn hãy chọn Narrow. Nếu bạn muốn khoảng trống bên trái và bên 

phải rộng hơn thì hãy chọn Wide. Khi bạn đã chọn xong khoảng canh lề mà mình 

mong muốn, toàn bộ tài liệu sẽ tự động thay đổi theo canh lề mà bạn vừa chọn. 

 Khi bạn chọn một khoảng canh lề nào thì phần nền của nó sẽ thay đổi màu, click 

vào nút Margins một lần nữa màu nền sẽ cho biết khoảng canh lề nào hiện đang được 

áp dụng cho tài liệu của bạn.  

f. Lưu tài liệu 

 

1. Để lưu tài liệu hãy nhấn nút Microsoft Office   
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2. Sau đó nhấn Save.   

 Bạn đã nhập liệu và hiệu chỉnh hoàn thiện câu từ và các đoạn văn bản, hoặc có 

những số liệu quan trọng mà bạn không muốn đánh mất nếu lỡ con mèo nhà bạn vô 

tình dẫm lên bàn phím hay một sự cố điện nào đó làm tắt máy tính đột ngột.  

 Để giữ thành quả công việc của mình được an toàn, bạn phải lưu tài liệu lại. 

Không bao giờ là quá sớm để làm điều đó.  

 Nhấn vào nút Microsoft Office ở phía trên cùng bên trái, sau đó nhấn Save. 

Một hộp thoại (Dialog Box) sẽ xuất hiện. Hộp thoại là một cửa sổ nhỏ để trợ giúp bạn 

thực hiện một việc nào đó. Bạn sẽ sử dụng hộp thoại này để cho Word biết bạn muốn 

lưu tài liệu này ở thư mục nào trên máy tính và đặt tên tài liệu là gì.  

 Sau khi đã lưu lần đầu và trở lại công việc, bạn có thể tiếp tục lưu tài liệu này 

suốt quá trình làm việc, bất cứ khi nào thấy cần thiết. Mỗi lần muốn lưu hãy nhấn nút 

 Save  trên thanh công cụ truy cập nhanh (Quick Access Toolbar) ở góc trên 

bên trái hoặc sử dụng tổ hợp phím tắt Ctrl+S (nhấn phím Ctrl và S cùng 

lúc).  

 Sau khi kết thúc công việc và lưu lại tài liệu, thoát khỏi Word bằng cách nhấn 

vào nút Microsft Office sau đó nhấn Close.  

2. Chỉnh sửa văn bản và tài liệu 

a. Hiệu chỉnh tài liệu 

 Để hiệu chỉnh tài liệu một cách nhanh chóng và hiệu quả bạn cần biết cách di 

chuyển điểm chèn nội dung (Insertion Point), vị trí mà những gì bạn gõ vào sẽ xuất 

hiện. Bạn có thể dùng bàn phím hoặc chuột để di chuyển đến vị trí tài liệu cần hiệu 

chỉnh. 
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 Khi đã đã di chuyển đến đúng vị trí mà bạn muốn chỉnh sữa, bạn có thể gõ thêm 

nội dung mới vào hay chọn đoạn văn bản mà bạn muốn sửa hoặc xóa. Bạn có thể chọn 

một ký tự, một từ, một câu, một đoạn văn bản hoặc toàn bộ tài liệu. Ngoài ra, bạn 

cũng có thể dời vị trí của chúng từ nơi này đến nơi khác trong tài liệu.  

b. Di chuyển vòng quanh tài liệu 

 

1.  Điểm chèn nội dung (Insertion Point), thể hiện bằng một gạch dọc nhấp nháy.  

2. Bạn có thể di chuyển điểm chèn nội dung từ vị trí số 1 sang vị trí số 2 bằng cách 

Click-Chuột-Trái vào vị trí số 2 hoặc dùng các phím Mũi Tên (Arrow Buttons). 

 Nhìn vào hình minh họa phí trên, hãy tưởng tượng bạn muốn gõ một câu mới 

giữa từ "civilization" và "During": "Symphonies and constellations have been named 

for clocks."  

 Điểm chèn nội dung hiện đang nằm ở cuối đoạn thứ hai sau từ "assistance." Để 

gõ văn bản vào nơi bạn muốn bạn phải di chuyển điểm chèn nội dung tới vị trí số 2. 

Bạn có thể thực hiện theo hai cách:  

  

 - Dùng chuột di chuyển con trỏ tới điểm bên phải từ "During", Click-Trái-Chuột 

để di chuyển điểm chèn nội dung vào vị trí đó. Sau đó hãy bắt đầu gõ câu mới vào, nội 

dung mới sẽ xuất hiện phía bên trái của từ "During".  

HOẶC  

 - Nhấn nút mũi tên hướng lên (UP ARROW) để di chuyển điểm chèn nội 

dung lên trên, mỗi lần nhấn điểm chèn sẽ di chuyển lên một dòng. Sau đó dùng phím 

mũi tên trái (LEFT ARROW) để di chuyển điểm chèn sang bên trái, mỗi lần một 

ký tự, đến vị trí mà bạn mong muốn.  

c. Chọn và xóa nội dung 
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 Trong hình bên trên, từ "really" hiện đang được chọn.  

 Sau khi đã thêm một câu mới ở phần b, bạn đọc lại toàn bộ và cảm thấy câu thứ 

hai sẽ hay hơn nếu bỏ từ "really".  

Để xóa trước hết bạn phải chọn từ cần xóa bằng một trong các cách sau: 

 - Dùng chuột: Di chuyển con trỏ tới trên từ "really", sau đó nhấp đúp (double-

click) chuột trái. Hoặc bạn có thể di chuyển con trỏ chuột đến phía trước (hoặc sau) từ 

"really" sau đó Click-Trái-Chuột và giữ nguyên rồi kéo chuột ngang qua từ "really".  

HOẶC  

 - Dùng bàn phím: sử dụng các phím mũi tên để di chuyển điểm chèn nôi dung 

đến bên phải (hoặc trái) từ "really",nhấn và giữ phím SHIFT sau đó dùng phím mũi 

tên trái (hoặc phải) để chọn.  

d. Di chuyển văn bản 

 

1. Chọn nội dung mà bạn muốn di chuyển   

2. Nhấn phím Cut trên thanh Ribbon.  

3. Di chuyển điểm chèn nội dung (Insertion Point) đến vị trí mới nơi bạn muốn chèn 

đoạn văn bản.   

4. Nhấn nút Paste trên thanh Ribbon.    
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 Tiếp tục xem xét đoạn văn bản đầu tiên. Bạn thấy rằng câu mà bạn thêm vào ở 

phần b nên đặt ở cuối đoạn. Bạn không cần phải xóa câu ở vị trí cũ rồi gõ lại ở vị trí 

mới. Thay vào đó, hãy di chuyển nó bằng cách thực hiện các lệnh Cut (cắt) và Paste 

(dán): Cắt để xóa câu ở vị trí cũ và dán để di chuyển nó đến ví trí mới mà bạn mong 

muốn.  

 Đầu tiên hãy chọn toàn bộ câu mà bạn muốn di chuyển như ở hình trên. Chọn 

thẻ Home trên thanh Ribbon, nhấn vào phím Cut trong phần Clipboard. Hoặc bạn có 

thể dùng phím tắt Ctrl + X (tưởng tượng chữ X giống như hình cây kéo).  

 Sau đó di chuyển điểm chèn nội dung tới cuối đoạn.   

 Cuối cùng, nhấn vào phím Paste trên thanh Ribbon. Hoặc bạn có thể dùng phím 

tắt Ctrl + V. Câu bạn muốn di chuyển đã được dời tới nơi bạn mong muốn.  

e. Hủy bỏ các hành động vừa thực hiện 

 

1. Nút Hủy Lệnh (Undo) trên thanh công cụ truy cập nhanh (Quick 

Access Toolbar).  

2. Các lệnh có để hủy: Cut và Paste.   

 Bạn đã di chuyển một câu đến vị trí mới trong phần d nhưng khi xem lại bạn 

cảm thấy không hài lòng. Thật may mắn là bạn không cần phải thực hiện lại chuỗi 

hành động Cut và Paste để chuyển câu trở về vị trí ban đầu. Thay vì vậy, hãy dùng 

chức năng Hủy Lệnh (Undo).  

 Trên thanh công cụ truy cập nhanh ở trên cùng, hãy Click vào mũi tên trên nút 

Undo , chọn 2 lệnh gần nhất mà bạn thực hiện (Cut và Paste) 2 lệnh này sẽ được 

hủy và câu mà bạn vừa di chuyển sẽ quay về vị trí ban đầu.  

 Bạn cũng có thể sử dụng phím tắt Ctrl + Z để thực hiện việc hủy lệnh, các lệnh 

sẽ được hủy theo thứ tự lệnh cuối cùng sẽ được hủy trước.  

f. Sử dụng thanh trượt (Scrollbar) để xem tài liệu 
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1. Thanh trượt (Scrollbar).  

2. Kéo con trượt (Scrollbox) lên xuống để xem tài liệu.   

3. Nhấn vào phím mũi tên để di chuyển lên hoặc xuống.  

 Có thể bạn có một tài liệu dài và muốn đọc hết mà không phải nhấn các phím 

mũi tên liên tục để di chuyển điểm chèn nôi dung lên hoặc xuống. Bạn có thể kéo tài 

liệu đến điểm cần xem một cách dễ dàng bằng cách dùng thanh trượt.  

 Thanh trượt nằm bên phải của cửa sổ Word như hình minh họa bên trên. Để sử 

dụng, bạn hãy Click lên con trượt và kéo nó lên hoặc xuống mà không làm di chuyển 

vị trí của điểm chèn nội dung. Hoặc bạn có thể Click vào các phím mũi tên để cuộn 

văn bản. 

 Để cuộn nhanh văn bản bằng bàn phím hãy nhấn vào phím PAGE UP để 

cuộn lên và PAGE DOWN để cuộn xuống dưới.  

3. Làm cho văn bản trông đẹp mắt 

a. Định dạng chữ và áp dụng các kiểu trang trí 

Trong hình là một phần của một bản thông cáo báo chí, nhưng tất cả mọi thứ đều 

trông giống nhau. Không tiêu đề, không hướng dẫn, không có điểm nhấn quan trọng 

để gây sự chú ý cho người đọc. 
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 Đừng quá lo lắng, bạn có thể nhanh chóng làm cho văn bản trên trở nên bắt mắt 

hơn bằng các công cụ như: In đậm (bold), In nghiêng (Italic), Gạch chân (underline); 

tạo các danh sách (list); sử dụng các kiểu trang trí v.v...Những công cụ đó sẽ giúp bạn 

định dạng văn bản.   

 Hãy xem chi tiết trong các phần tiếp theo.  

b. Tạo các điểm nhấn 

 

 Bảng thông cáo báo chí cho biết lợi nhuận ròng trên mỗi cổ phiếu của Contoso 

Pharmaceuticals. Bạn có thể gây sự chú ý của người đọc bằng cách sử dụng các đinh 

dạng như in đậm (bold), in nghiêng (Italic), gạch chân (underline). Bạn có thể thực 

hiện điều này bằng cách sử dụng các nút trên thanh Ribbon hoặc dùng phím tắt.  

 Chọn đoạn văn bản mà bạn muốn gây chú ý, sau đó chọn thẻ Home trên thanh 

Ribbon, bạn có thể định dạng văn bản bằng các nút trong phần Font. Ví dụ, nếu muốn 

in đậm văn bản hãy Click vào nút Bold (hoặc dùng phím tắt Ctrl + B).  

 Nếu bạn thấy chữ in đậm nhìn không vừa mắt, ngay sau khi thực hiện lệnh in 

đậm hãy nhấn phím Undo trên thanh công cụ truy cập nhanh ở phía trên cùng 
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của cửa sổ Word. Hoặc bạn có thể chọn văn bản vừa in đậm rồi nhấn nút Bold 

(hoặc phím tắt Ctrl + B) một lần nữa. 

 Bạn cũng có thể thay đổi màu sắc để đoạn văn bản trông nội bật hơn nữa. Vẫn tại 

thẻ Home và phần Font trên thanh Ribbon, bạn hãy tìm đến nút Font Color . 

Clcik vào mũi tên trên nút , di chuyển chuột lên trên từng màu trên bảng màu. 

Bạn có thể xem trước đoạn văn bản được chọn sẽ trông như thế nào với từng màu. Khi 

bạn đã chọn được màu mình thích, hãy Click lên màu đó.  

c. Thêm nhanh một kiểu trang trí (Style) 

 

 Bạn có thể thêm điểm nhấn bằng cách in đậm, in nghiêng, đổi font chữ, kích cỡ, 

màu sắc v.v...Nhưng thay vì làm từng bước riêng biệt rất tốn thời gian bạn có thể áp 

dụng các kiểu trang trí nhanh (Quick Styles). Quick Styles là một tập hợp các định 

dạng, bạn có thể thay đổi in đậm, in nghiêng, font chữ, kích cỡ, màu sắc chỉ bằng một 

cái Click-Chuột. 

 Để thêm một kiểu trang trí hãy chọn đoạn văn bản mà bạn muốn, sau đó trong 

phần Styles ở thẻ Home bạn có thể di chuyển con trỏ chuột ngang qua từng kiểu trang 

trí để xem đoạn văn bản thay đổi tương ứng như thế nào.   

 Nếu vẫn chưa chọn được một kiểu vừa ý, hãy nhấn nút  More để mở rộng bảng 

liệt kê các kiểu. Khi đã chọn được một kiểu phù hợp, Click chuột vào đó.  

 Đừng lo lắng nếu bạn chọn sai kiểu trang trí, bạn có thể chọn một kiểu khác bất 

cứ lúc nào bằng cách lập lại các thao tác trên. 

d. Tạo danh sách 

 Bảng thông cáo báo chí chỉ ra các điểm thành công trong Quý vừa qua, các điểm 

này sẽ nổi bật hơn nếu trình bày ở dạng danh sách. 
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 Bạn có thể sử dụng danh sách dạng chữ số (Numbering) hoặc dạng ký hiệu 

(Bullet) để gây sự chú ý.   

 Chọn đoạn văn bản mà bạn muốn tạo danh sách. Tại thẻ Home, phần Paragraph, 

click vào Bullets hoặc Numbering . Word sẽ tự động tạo danh sách cho 

bạn.  

e. Thêm hoặc bớt khoảng trống 

 

 Bạn có thể dễ dàng thay đổi khoảng cách giữa các dòng trong toàn bộ tài liệu 

hoặc trong một đoạn văn bản được chọn.  

 Để thay đổi khoảng cách dòng trong toàn bộ tài liệu đầu tiên bạn phải chọn tất cả 

tài liệu bằng cách nhấn phím tắt Ctrl + A. Để thay đổi khoảng cách dòng trong một 

đoạn văn bản, bạn chỉ cần di chuyển điểm chèn nội dung đến đoạn văn bản đó, không 

cần phải chọ cả đoạn.  

 Sau đó, tại thẻ Home, phần Paragraph, nhấn vào nút Line Spacing . Có 

một ký hiệu cho biết khoảng cách dòng hiện tại. Hãy chọn một khoảng cách mới mà 

bạn mong muốn.  
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f. Sử dụng kiểu định dạng cho toàn bộ tài liệu 

 Bảng thông cáo báo chí của chúng ta hiện trông khá ổn, nó có tiêu đề, các điểm 

nhấn được in đậm, có nhiều màu khác nhau, một danh sách bắt mắt.   

 

 Bước cuối cùng, hãy xem qua Tập hợp các kiểu trang trí nhanh (Quick Style 

sets), đó là tập hợp các kiểu trang trí bạn có thể dùng để thay đổi phong cách trang trí 

của toàn bộ tài liệu với chỉ một cú Click-Chuột. Mỗi Tập hợp (set) bao gồm các định 

dạng trang trí cho Tiêu đề, Tựa, Trích dẫn, font chính v.v...tất cả được thiết kế một 

cách thống nhất.  

 Mỗi khi thay đổi một Style Set, các Style tương ứng sẽ thay đổi mà không bị 

chồng chéo. Ví dụ Style cho Tiêu đề (Heading) mới sẽ thay thế cho Style tiêu đề cũ 

chứ không phải cho Style Tựa (Title) cũ.  

 Để xem tài liệu sẽ thay đổi như thế nào hãy chọn thẻ Home, Click vào Change 

Style trong phần Styles, sau đó chọn Style Set.  

 Di chuyển chuột trên từng Style trong danh sách, mỗi khi con trỏ chuột dừng 

trên một Style nào đó bạn sẽ thấy tài liệu được thay đổi theo Style tương ứng. Khi đã 

chọn được một Style vừa ý, hãy Click lên nó.  
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PHẦN II: LÀM QUEN VỚI PHIÊN BẢN MỚI 

1. Làm quen nhanh với giao diện mới 2007 

a. Làm quen với thanh Ribbon 

 Lần đầu tiên mở Word 2007 lên có thể bạn sẽ ngạc nhiên với giao diện hoàn toàn 

mới so với các phiên bản trước. Phần thay đổi lớn nhất là thanh Ribbon nằm trên 

cùng của cửa sổ chương trình. 

 

 Thanh Ribbon thể hiện sẵn những lệnh thông dụng nhờ đó bạn không phải lục 

tung hàng đống menu để tìm thứ bạn cần. 

 Tại sao lại có sự thay đổi này? Câu trả lời là để giúp cho bạn làm việc dễ dàng và 

hiệu quả hơn. Thanh Ribbon được nghiên cứu và thiết kế sao cho các lệnh được đặt ở 

những vị trí hợp lý nhất. 

b. Có những gì trên thanh Ribbon? 
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 Thanh Ribbon có 3 thành phần căn bản, sẽ rất có ích nếu bạn biết mỗi phần được 

gọi là gì và cách sử dụng chúng.  

1. Tab (thẻ) có 7 Tab cơ bản nằm ngang phía trên, mỗi Tab đại diện cho một vùng 

hoạt động. 

2. Group (nhóm) mỗi Tab bao gồm nhiều Group tập họp các đối tượng có liên quan 

mật thiết với nhau. 

3. Command (lệnh) mỗi Command có thể là một nút, một vùng để nhập nội dung 

hoặc một  Menu (trình đơn). 

 Mọi thứ trên một Tab đều được lựa chọn cẩn thận dựa trên các hoạt động của 

người dùng. Ví dụ Tab Home chứa những lệnh có tần suất sử dụng nhiều nhất chẳng 

hạn như các lệnh trong nhóm Font để định dạng văn bản như: Font, Font Size, Bold, 

Italic, v.v... 

c. Nút hiển thị hộp thoại của từng nhóm 

 

 Mới nhìn qua bạn có thể sẽ không tìm thấy một lệnh nào đó đã có trong các 

phiên bản Word trước. Đừng lo, một số nhóm có một nút hình mũi tên chéo nằm ở 

góc phải bên dưới của nhóm.   

 Nút mũi tên đó được gọi là Dialog Box Launcher (nút mở hộp thoại). Nếu bạn 

Click vào nút đó nó sẽ mở ra các tùy chọn liên quan đến nhóm tương ứng. Các tùy 

chọn này xuất hiện dưới dạng hộp thoại mà bạn vẫn thấy ở các phiên bản Word trước 

đây.  

 Nhân tiện nói về các phiên bản Word trước, bạn có thể tự hỏi liệu bạn có thể 

chọn một giao diện giống như các phiên bản trước trong Word 2007 không. Câu trả 

lời là KHÔNG. Tuy nhiên, sau khi đã quen thuộc với giao diện mới bạn sẽ cảm thấy 

thích thú với sự tiện lợi mà nó mang lại. 

d. Những Tab phụ 
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 Khi bạn chọn một một bức ảnh, tab phụ có tên Picture Tools sẽ xuất hiện, Tab 

này chứa các lệnh liên quan đến việc xử lý hình ảnh trong Word. 

 

 Trong phiên bản 2007, có một số Tab chỉ xuất hiện trên thanh Ribbon khi bạn 

cần đến chúng. Giả sử bạn vừa chèn một tấm ảnh vào tài liệu, bây giờ bạn muốn có 

những hiệu chỉnh liên quan tới tấm ảnh này chẳng hạn như chọn cách văn bản sẽ bao 

quanh tấm ảnh như thế nào hoặc có thể bạn muốn cắt xén những phần thừa trong 

ảnh...Vậy bạn có thể tìm các lệnh liên quan ở đâu?    

1. Chọn ảnh.  

2. Tab phụ Picture Tools xuất hiện, hãy click vào đó.  

3. Các nhóm và lệnh mới sẽ xuất hiện để bạn có thể xử lý hình ảnh, nhóm 

Picture Styles chẳng hạn.  

  Khi bạn click ra ngoài bức ảnh, Tab Picture Tools sẽ biến mất và các nhóm 

khác xuất hiện trở lại.  

e. Toolbar mini 

 Khi bạn chọn một đoạn văn bản hoặc một từ và chuyển con trỏ chuột đén đó, 

một Toolbar (thanh công cụ) nhỏ sẽ xuất hiện dưới dạng mờ. 
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Một số lệnh định dạng hữu dụng đến nỗi bạn muốn nó xuất hiện trong mọi hoàn cảnh. 

Giả sử bạn muốn định dạng nhanh một văn bản trong khi hiện tại bạn đang ở Tab 

Page Layout. Đương nhiên bạn có thể Click vào Tab Home để sử dụng những lệnh 

định dạng trong đó, tuy nhiên có một cách nhanh hơn:  

1. Chọn phần văn bản muốn định dạng sau đó chuyển con trỏ chuốt tới vị trí đó.  

2. Một thanh công cụ nhỏ xuất hiện dưới dạng mờ. Nếu bạn rê chuột đến đọ, thanh 

công cụ này sẽ hiện rõ và bạn có thể sử dụng các tùy chọn trên đó để định dạng văn 

bản.  

 Toobar Mini rất hữu ích cho định dạng nhanh văn bản, tuy nhiên bạn phải làm 

sao nếu muốn một vài lệnh khác cũng xuất hiện thường trực như vậy. Hãy xem phần 

tiếp theo về Quick Access Toolbar (thanh công cụ truy cập nhanh). 

f. Thanh công cụ truy cập nhanh 

 Thanh công cụ truy cập nhanh (Quick Access Toolbar) là một vùng nhỏ nằm 

trên góc trái của thanh Ribbon, nó chứa các lệnh mà bạn dùng ngày này qua ngày khác 

như: Save, Undo, Repeat . Bạn có thể thêm vào những lệnh mà mình thường dùng để 

nó sẽ luôn xuất hiện mà không cần biết Tab hiện tại là gì.  

 

 Click phải chuột vào nút lệnh mà bạn muốn thêm vào Quick Access Toolbar, 

chọn Add to Quick Access Toolbar. 

g. Ẩn tạm thời thanh Ribbon 

 Thanh Ribbon giúp cho mọi thứ trong Word 2007 trở nên tập trung và dễ dàng 

tìm kiếm những thứ cần thiết. Tuy nhiên, đôi khi bạn không cần phải tìm bất cứ thứ gì. 

Bạn chỉ muốn tập trung làm việc với tài liệu của mình và bạn muốn có nhiều không 

gian hơn. Thật đơn giản, hãy tạm ẩn thanh Ribbon.  
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 Cách ẩn thanh Ribbon: Nhấp đúp chuột vào Tab hiện tại, các nhóm của Tab sẽ 

biến mất. Như vậy bạn đã có nhiều khoảng trống hơn.  

 Khi nào bạn muốn thanh Ribbon xuất hiện trở lại, hãy nhấp đúp vào Tab hiện tại 

một lần nữa. 

h. Sử dụng bàn phím 

 

 Những người yêu bàn phím, đây là phần dành cho các bạn. Phìm tắt bắt đầu với 

Ctrl như các phiên bản trước. Ví dụ Ctrl + C là Copy, Ctrl+S là lưu tài liệu...   

 Thiết kế Ribbon dẫn đến hệ thống phím tắt mới với 2 lợi ích lớn so với phiên bản 

trước:   

 - Mọi lệnh đều có phím tắt   

 - Các phím tắt yêu cầu nhấn ít phím hơn 

 - Các phím tắt (Short Cut) có một tên mới: Key Tips. Nhấn phím Alt để các Key 

Tips xuất hiện cho tất cả các Tab, các nút lệnh trên Quick Access Toolbar, nút 

Microsoft Office. Lúc này, bạn có thể nhấn Key Tip cho những Tab mà bạn muốn 

hiển thị, ví dụ nhấn H để hiển thị Tab Home. Các Key Tip cho từng lệnh trong Tab 

Home sẽ xuất hiện và bạn chỉ việc nhấn Key Tip của lệnh mà bạn cần. 
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2. Làm quen nhanh với hệ thống Office 2007 

a. Phiên bản Office mới được thiết kế hướng người dùng 

 Có rất nhiều thay đổi tương tự nhau trong cả bộ Office 2007. Tin tốt lành đó là 

các lệnh và các công cụ đều đã được đưa ra trước mắt người dùng và luôn ở trạng thái 

sẵn sàng. 

 

 Thay vì có khoảng trên dưới 30 thanh công cụ hoặc các lệnh bị vùi dưới hàng tá 

menu hoặc trong các hộp thoại thì giờ đây bạn đã có một trung tâm điều khiển 

(Control Center) duy nhất kết hợp mọi thứ với nhau một cách trực quan. 

 Một khi đã quen thuộc với thanh Ribbon trong một chương trình (Word, Excel, 

Access...), bạn cũng sẽ cảm thấy dễ dàng trong một chương trình khác.  

b. Các lệnh được tổ chức như thế nào? 

 

 Các lệnh Paste, Cut và Copy thường được sử dụng nhất trong Word và Excel, do 

đó, theo logic các lệnh này được đặt ở Tab Home, Tab đầu tiên trên thanh Ribbon. 
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 Các lệnh tổ chức theo cách chúng được sử dụng. Microsoft nhận thấy người 

dùng có một số lệnh ưa thích mà họ dùng đi dùng lại hàng ngày. Những lệnh như thế 

hiện đã được đặt ở những nơi nổi bật và tiện dụng nhất. 

 Ví dụ lệnh Paste là lệnh có tần suất sử dụng cao nhất, như thế tại sao không cho 

nó một khoảng không gian lớn hơn so với các lệnh liên quan là Copy và Cut. 

 Các lệnh thông dụng không còn phải chia sẻ không gian trên thanh công cụ với 

những lệnh liên quan nhưng ít được dùng hơn. Những thứ hữu dụng sẽ được đặt trong 

tầm tay của bạn. 

 Những lệnh có tần suất sử dụng thấp sẽ chỉ có được một phần nhỏ trên thanh 

công cụ. Ví dụ người dùng ít sử dụng lệnh Paste Special hơn lệnh Paste, do đó muốn 

truy cập lệnh Paste Special bạn hãy nhấn phím mũi tên bên dưới lệnh Paste. 

c. Nhiều lệnh chỉ xuất hiện khi cần thiết 

 

 Tab phụ Picture Tools xuất hiện khi bạn chèn một bức ảnh vào Word. 

 Những lệnh bạn thường sử dụng nhất nằm trên thanh Ribbon và luôn ở trạng thái 

sẵn sàng. Trong khi đó, một số lệnh khác chỉ xuất hiện khi bạn thực sự cần. 

 Chẳng hạn nếu bạn không có bức ảnh nào trong tài liệu thì các công cụ để xử lý 

hình ảnh sẽ không cần thiết phải xuất hiện. 

 Nhưng chỉ cần bạn chèn vào một bức ảnh, Tab phụ Picture Tools sẽ lập tức xuất 

hiện cùng với Tab con Format chứa các lệnh để bạn làm việc với các bức ảnh. Khi 

bạn kết thúc công việc với bức ảnh Tab Picture Tools cũng biến mất. 

 Nếu bạn muốn làm việc lại với bức ảnh, chỉ cần Click lên nó, Tab Picture Tools 

sẽ lại xuất hiện. Word biết bạn đang làm gì và cung cấp cho bạn các công cụ cần thiết 

phù hợp. Thanh Ribbon phản ứng với các hành động của bạn. 

 Vậy bạn không cần phải lo lắng khi không luôn nhìn thấy tất cả các lệnh. Hãy 

thực hiện bước đầu tiên, sau đó mọi thứ bạn cần sẽ tự động xuất hiện. 
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d. Sẽ có nhiều tùy chọn hơn mỗi khi bạn cần 

 

 Click vào phím mũi tên ở phía dưới mỗi nhóm khi bạn cần nhiều tùy chọn 

liên quan tới nhóm đó: 

1. Click vào phím mũi tên của nhóm Font 

2. Hộp thoại Font xuất hiện với đầy đủ các tùy chọn. 

 Khi bạn thấy một phím mũi tên nhỏ phía dưới một nhóm có nghĩa là nhóm đó 

có thêm nhiều tùy chọn đang ẩn. Click vào phím mũi tên này (phím này được gọi là 

Dialog Box Launcher) một hộp thoại hoặc một bảng chứa lệnh (Task Pane). 

 Ví dụ trong PowerPoint, nhóm Font ở thẻ Home chứa các lệnh về font chữ như 

thay đổi kiểu chữ, kích thước, màu sắc, in đậm, in nghiêng, gạch dưới... 

 Nhưng nếu bạn muốn sử dụng các lệnh định dạng font ít thông dụng hơn như 

supperscript thì bạn phải click vào phím mũi tên bên dưới nhóm Font để mở hộp 

thoại Font có chứa lệnh supperscript và các lệnh khác liên quan đến font chữ.  

 Sau đó di chuyển điểm chèn nội dung tới cuối đoạn.  

 Cuối cùng, nhấn vào phím Paste trên thanh Ribbon. Hoặc bạn có thể dùng phím 

tắt Ctrl + V. Câu bạn muốn di chuyển đã được dời tới nơi bạn mong muốn.  

e. Xem trước thay đổi trước khi chọn 
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 Bạn đã bao giờ phải rơi vào cảnh lặp đi lập lại các thao tác Chọn Lựa - Hủy 

(Undo) - Chọn Lựa chưa? Bạn chọn một Font chữ, màu sắc, kiểu trang trí hoặc hiệu 

chỉnh một bức ảnh. Nhưng những thay đổi đó dẫn đến một kết quả không vừa ý, thế là 

bạn nhấn Undo, sau đó lại thực hiện những lựa chọn khác. Vòng lặp nhàm chán đó 

diễn ra cho đến khi có một kết quả làm bạn hài lòng.  

 Giờ đây, bạn có thể nhìn thấy ngay kết quả của từng tùy chọn. Mỗi khi bạn rê 

chuột ngang một tùy chọn nào đó phần văn bản hoặc hình ảnh mà bản muốn hiện 

chỉnh sẽ lập tức thay đổi tương ứng. Khi đã chọn được một giải pháp ưng ý, hãy click 

lên nó. Bạn sẽ không phải đụng đến lệnh Undo. 

f. Tạo thanh công cụ của riêng bạn 

 

 Bạn đã bao giờ phải rơi vào cảnh lặp đi lập lại các thao tác Chọn Lựa - Hủy 

(Undo) - Chọn Lựa chưa? Bạn chọn một Font chữ, màu sắc, kiểu trang trí hoặc hiệu 

chỉnh một bức ảnh. Nhưng những thay đổi đó dẫn đến một kết quả không vừa ý, thế là 

bạn nhấn Undo, sau đó lại thực hiện những lựa chọn khác. Vòng lặp nhàm chán đó 

diễn ra cho đến khi có một kết quả làm bạn hài lòng.  

 Giờ đây, bạn có thể nhìn thấy ngay kết quả của từng tùy chọn. Mỗi khi bạn rê 

chuột ngang một tùy chọn nào đó phần văn bản hoặc hình ảnh mà bản muốn hiện 

chỉnh sẽ lập tức thay đổi tương ứng. Khi đã chọn được một giải pháp ưng ý, hãy click 

lên nó. Bạn sẽ không phải đụng đến lệnh Undo. 

g. Sử dụng độ phân giả màn hình khác nhau làm thay đổi cách hiển thị của 

thanh Ribbon 

 Trong hình là một phần của một bản thông cáo báo chí, nhưng tất cả mọi thứ đều 

trông giống nhau. Không tiêu đề, không hướng dẫn, không có điểm nhấn quan trọng 

để gây sự chú ý cho người đọc.  
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 Nhóm Show/Hide trong Tab View hiển thị đầy đủ khi mà hình ở độ phân giải 

cao, khi màn hình có độ phân giải thấp, bạn phải nhấn vào nút mũi tên mới nhìn thấy 

được các lệnh. 

 Những gì bạn đã tìm hiểu về phiên bản Office mới cho đến giờ được áp dụng khi 

màn hình của bạn có độ phân giải cao. 

 Nếu màn hình của bạn có độ phân giải thấp, 800x600 pixel chẳng hạn, thì một số 

nhóm lệnh chỉ hiển thị tên nhóm chứ không hiển thị tất cả các lệnh. Bạn phải nhấn vào 

nút mũi tên bên dưới tên nhóm để truy cập tất cả các lệnh.  

 Nhìn vào hình minh họa trên, ở độ phân giải cao nhóm Show/Hide hiển thị đầy 

đủ các lệnh, trong khi đó với độ phân giải thấp hơn nó chỉ hiển thị tên nhóm mà không 

có lệnh nào. Trong trường hợp này bạn phải nhấn vào nút mũi tên để truy cập các 

lệnh.  

 Tổng quát, một nhóm chỉ hiện tên nhóm ở độ phân giải thấp là những nhóm lệnh 

thường ít được sử dụng.  

 Chế độ Minimize: dù ở bất kì độ phân giải nào, nếu bạn thu nhỏ cửa sổ chương 

trình lại thì một số nhóm sẽ chỉ còn hiển thị tên nhóm. Càng thu nhỏ cửa sổ chưa trình 

thì số nhóm chỉ hiển thì tên sẽ tăng lên.  

 Tablet PC: Nếu bạn dùng Tablet PC (Máy tính dạng bảng) với màn hình nhỏ 

bạn sẽ thấy Office 2007 sẽ hiển thị một phiên bản thanh Ribbon với các Tab và nhóm 

nhỏ hơn. Ngược lại với màn hình lớn.  
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PHẦN III: SỬ DỤNG CÁC BIỂU MẪU CÓ SẴN TRONG 

1. Sức mạnh của các biểu mẫu (Template) 

 Mặc dù có thể bạn đã làm việc với Word và quen thuộc với các tài liệu của 

Word, có thể bạn vẫn không tường tận lắm về các biểu mẫu. Biểu mẫu là gì? Nó có 

thể giúp ích cho bạn ra sao? 

 Một biểu mẫu là một loại tài liệu đã có sẵn nội dung trong đó.như văn bản, kiểu 

trang trí, định dạng; định dạng trang như canh lề, cách dòng; các yếu tố trang trí như 

màu sắc, đường viền...  

 

 Hãy xem biểu mẫu như một trợ giúp hữu ích khi bạn bắt đầu soạn thảo tài liệu. 

Giả sử như hàng tuần bạn đều có một cuộc họp và bạn phải soạn đi soạn lại lịch họp 

với một vài thay đổi nhỏ mỗi lần. Hãy bắt đầu với một số thông tin phù hợp đã được 

chuẩn bị sẵn sẽ giúp bạn tiết kiệm rất nhiều thời gian. 

 Hãy theo dõi một vài ví dụ tạo tài liệu mới từ các biểu mẫu sẵn có trong Word và 

bộ Office ở các phần sau. Bạn có thể sử dụng các biểu mẫu này để tào ra các tài liệu 

chuyên nghiệp và ấn tượng cho riêng mình 

2. Sử dụng các mẫu trang bìa Fax có sẵn 
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 Giả sử công việc của bạn phải thường xuyên gửi Fax cho khách hàng và đối tác, 

bạn luôn cần có một trang bìa ghi lại nội dung của các bảng Fax. Bạn có thể tự tạo 

trang bìa như vậy mỗi khi bạn gửi / nhận Fax. Hoặc bạn cũng có thể sử dụng biểu mẫu 

sẵn có trong Word. 

 Bản sẽ tìm thấy biểu mẫu như trên hình minh họa, giữa rất nhiều biểu mẫu khác 

trong Word. Bạn chỉ cần điền các thông tin phù hợp, in ra và gửi Fax. Thế là xong, rất 

đơn giản và nhanh chóng. Thậm chí bạn có thể thêm hoặc xóa một số phần tùy theo 

nhu cầu cụ thể, tuy nhiên, những gì thiết yếu nhất đã có sẵn và bạn không phải bắt đầu 

từ con số 0. 

3. Sử dụng các mẫu lịch làm việc sẵn có 

 Đây là một ví dụ khác cho thấy các biểu mẫu Word có thể giúp ích cho bạn như 

thế nào. Hãy tưởng tượng bạn được giao nhiệm vụ thiết kế lịch họp hàng tuần cho 

nhóm.   

 

 Trước khi bắt đầu từ một trang tài liệu rỗng, bạn hãy thử tham khảo một số biểu 

mẫu có trên trang Microsoft Office trực tuyến - bạn có thể liên kết trực tiếp tới các 

biểu mẫu này (bạn sẽ được hướng dẫn sau). Có rất nhiều biểu mẫu trong các danh mục 

khác nhau, thông dụng nhất là: Lịch làm việc. Lịch ngày tháng, Thư từ, Sơ Yếu Lý 

Lịch v.v... Có rất nhiều cho bạn lựa chọn. 

Hình minh họa cho thấy 3 biểu mẫu: 

1. Đây là mẫu đơn giản và trực quan với các văn bản và vùng đã được định 

dạng để bạn điền  

2. Một mẫu hoàn chỉnh, theo phong cách nghệ thuật. 

3. Mẫu này sử dụng định dạng Bảng (Table) và sử dụng các màu sắc khác 

nhau để phân biệt giữa các vùng. Đây là một mẫu tương đối phức tạp.  

4. Tìm những biểu mẫu đã được cài đặt kèm với Word 
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 Có khoảng 30 biểu mẫu được cài đặt kèm với Word như: Thư từ, Fax, Báo Cáo, 

Sơ Yếu Lý Lịch và Blog. Bạn sẽ tìm thấy các biểu mẫu này bằng cách: 

1. Click nút Microsoft Office, sau đó chọn New. 

2. Trong cửa sổ New Document chọn Installed Templates. 

3. Click vào các hình đại diện và xem thử biểu mẫu trông như thế nào phía 

bên phải.  

4. Khi chọn được mẫu phù hợp, Click vào nút Create. 

 Một tài liệu mới được tạo ra dựa trên biểu mẫu bạn chọn, và việc của bạn bây 

giờ là điền những nội dung phù hợp.  

5. Tìm các biểu mẫu trên trang Microsoft Office trực tuyến 

 Tạo một tải liệu mới như bước trên, tuy nhiên thay vì chọn Installed Templates 

bây giờ bạn sẽ chọn theo các danh mục phía dưới trong phần Microsoft Office 

Online. 

 

 Hãy Click vào từng danh mục để xem hình đại diện của các biểu mẫu trong danh 

mục đó. Tương tự như với các biểu mẫu được cài đặt sẵn, khi bạn Click vào hình đại 
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diện thì một mẫu xem trước của biểu mẫu đó sẽ hiện lên phía bên phải.Một số danh 

mục như Thư Từ (Letters) có các danh mục con để bạn lựa chọn.  

 Để tải các biểu mẫu về máy bạn hãy chọn hình đại diện của biểu mẫu rồi nhấn 

Download. Biểu mẫu tải về sẽ mở ra một tài liệu mới, sẵn sàng cho bạn làm việc.  

 Biểu mẫu gốc sẽ không bị thay đổi, nó vẫn nằm trên trang Microsoft Office trực 

tuyến. Tuy nhiên, một bản sao đã được lưu về máy tính của bạn, khi cần sử dụng bạn 

hãy mở thư mục My Templates trong Word mà không cần tải về một lần nữa.  

6. Khả năng đặc biệt của biểu mẫu 

 Như đã đề cập ở các phần trước, khi bạn mở một biểu mẫu một tài liệu mới được 

tạo ra dựa trên biểu mẫu mà bạn chọn. Thực chất bạn làm việc với một bản sao chứ 

không phải bản thân biểu mẫu. 

 

 Đó chính là khả năng đặc biệt của biểu mẫu: Tự tạo một bản sao khi được mở, 

bản sao này tạo ra tất cả các thành phần của biểu mẫu trong một tài liệu hoàn toàn 

mới. Bạn làm việc với tài liệu mới đó, thừa hưởng tất cả các thành phần có trong biểu 

mẩu và có thể thêm bớt nội dung tùy ý. 

 Vì bạn làm việc trên một tài liêu mới nên những hiệu chỉnh mà bạn thực hiện sẽ 

không ảnh hưởng tới biểu mẫu gốc, nó luôn được giữ ở trạng thái nguyên bản. Vì vậy, 

một biểu mẫu có thể là nền tảng cho vô số tài liệu. 

7. Biểu mẫu và tài liệu là hai định dạng khác nhau 
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 Biểu mẫu (Template) và Tài liệu (Document) có định dạng file khác nhau. 

 Nếu bạn đã từng lưu nhiều tài liệu Word có lẽ bạn đã quen thuộc với việc chọn 

định dạng sẵn có để lưu file. Đây là sự khác biệt giữa Biểu mẫu và Tài liệu: 

1. Biểu mẫu được lưu dưới dạng Word Template và nó có đuôi file là 

".dotx" (các phiên bản Word trước đây là ".dot"). 

2. Tài liệu được lưu dưới dạng Word Document và nó có đuôi file là 

".docx" (các phiên bản Word trước đây là ".doc"). 

 Biểu mẫu và Tài liệu có định dạng file khác nhau và cách hoạt động của chúng 

cũng khác nhau.  
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PHẦN IV: CÁCH TRÌNH BÀY THÔNG TIN HIỆU QUẢ TRONG 

WORD 2007 

1. Danh sách dạng số và ký hiệu 

a. Một danh sách đơn giản 

 Danh sách (List) là một thành phần rất hữu ích trong tài liệu, nó dùng để tóm 

tắt, liệt kê thông tin giúp người đọc dễ hiểu và hiểu vấn đề sâu hơn. Có 2 dạng danh 

sách là dạng đánh số (Numbering) và dạng ký hiệu (Bullet). Nếu bạn có một chuỗi 

thông tin có phân biệt mức độ hoặc thứ tự thì danh sách dạng số là lựa chọn thích hợp. 

Còn nếu chỉ cần liệt kê thì nên dùng dạng ký hiệu. 

 

 Ví dụ minh họa danh sách dạng chữ và số, đơn cấp và đa cấp.  

  Danh sách còn có sự phân cấp: đơn cấp và đa cấp. Một danh sách đơn cấp là 

danh sách mà trong đó các thành phần loại hoặc tính chất. Danh sách đa cấp có nghĩa 

là một hoặc nhiều thành phần trong danh sách có thể chứa một danh sách khác. Bạn có 

thể thấy sự khác biệt giữa danh sách đơn và đa cấp trong hình minh họa. 

Trong phần này chúng ta thảo luận về một danh sách đơn giản, chỉ có một cấp (đơn 

cấp). Các danh sách đa cấp sẽ được đè cập trong phần sau. 

b. Tạo một danh sách bằng cách gõ các ký tự thích hợp 

 Có nhiều cách để tạo một danh sách, nhưng cách đơn giản nhất là tạo tự động 

bằng cách gõ một số ký tự hoặc tổ hợp ký tự ở đầu câu. Nếu bạn muốn tạo danh sách 

dạng ký hiệu (Bullet) thì hãy đánh dấu sao (*) đầu câu, tiếp theo là một khoảng trắng. 

Dấu * sẽ tự động biến thành một ký hiệu hình chấm đen vậy là danh sách của bạn đã 
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được khởi tạo. Khi đã xong thành phần đầu tiên của danh sách, hãy gõ ENTER, lúc 

này một chấm đen khác sẽ tự động xuất hiện sẵn sàng cho thành phần tiếp theo. 

 

 Nếu muốn tạo danh sách dạng số tự động hãy gõ số 1 và dấu chấm (1.), tiếp theo 

là một khoảng trắng. Đây là một điểm mới trong Word 2007, ở các phiên bản trước 

bạn phải nhấn phím ENTER thì danh sách mới được khởi tạo. 

 Danh sách dạng chữ (a, b, c,...) chỉ là một cách thể hiện khác của danh sách dạng 

số nên cách khởi tạo cũng tương tự: bạn hãy gõ chữ a và dấu chấm (a.) sau đó là một 

khoảng trắng. 

 Ngoài dạng hình chấm đen như trên, danh sách ký hiệu còn có nhiều biểu tượng 

khác để bạn chọn lựa như hình vuông, hình kim cương, hình mũi tên v.v... 

c. Kết thúc một danh sách 

 Bạn đã gõ xong phần cuối cùng trong danh sách, làm sao để kết thúc và các ký 

hiệu hay chữ số không tự động xuất hiện nữa.  

 

 Cách dễ nhất để kết thúc việc tạo danh sách là nhấn phím ENTER hai lần liên 

tiếp. Bất cứ khi nào bạn nhấn ENTER thì một ký hiệu hoặc một con số mới sẽ xuất 
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hiện để chuẩn bị cho một thành phần mới trong danh sách, tuy nhiên nếu bạn nhấn 

ENTER một lần nữa thì ký hiệu / con số đó sẽ biến mất để bạn có thể bắt đầu một 

đoạn văn bản mới. 

 Nếu bạn muốn thực hiện khác một chút chảng hạn như lúc đang ở giữa danh 

sách bạn muốn tạo một dòng mới mà không có ký hiệu hay số phía trước và dòng mới 

này nằm ngang hàng với thành phần phía trên của danh sách. Lúc này, hãy sử dụng 

phím BACKSPACE (xóa lùi) để xóa ký hiệu (hoặc số) đầu dòng trong khi vẫn giữ 

nguyên canh lề so với dòng văn bản phía trên. Nếu bạn muốn dòng mới nằm ngang 

với ký hiệu (hoặc con số) thay vì nằm ngang văn bản phía trên, hãy nhấn 

BACKSPACE một lần nữa. 

d. Ký hiệu hay chữ số 

 Bạn lỡ chọn sai kiểu danh sách? Bạn chọn kiểu danh sách là ký hiệu nhưng bây 

giờ thấy kiểu chữ số sẽ hay hơn, hoặc ngược lại? Không có gì đáng lo, chuyển qua lại 

giữa hai kiểu rất dễ dàng. Hãy Click vào bất cứ vị trí nào trong danh sách, sau đó nhấn 

vào nút Bullet hoặc Numbering trên thanh Ribbon. 

 

 Bạn cũng có thể dùng các nút trên để bắt đầu một danh sách bằng cách Click vào 

nút phù hợp rồi bắt đầu gõ thành phần đầu tiên của danh sách. Hoặc bạn cũng có thể 

chọn những đoạn văn bản mà bạn muốn tạo danh sách rồi nhấn nút phù hợp. Mỗi đoạn 

sẽ tương ứng với một thành phần trong danh sách. 

e. Thay đổi ký hiệu cho danh sách 

 Nếu bạn có một danh sách dạng ký hiệu (Bullet) và cảm thấy nhàm chán với các 

chấm đen hình tròn thì bạn có thể thay thế chúng bằng các ký hiệu khác có sẵn trong 

Word. Hãy Click vào nút mũi tên bên cạnh nút Bullet để xem thư viện Bullet. 
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 Thậm chí nếu bạn không hài lòng với các ký hiệu sẵn có, bạn có thể tự tạo các 

ký hiệu của riêng mình. Hày chọn Define New Bullet để thực hiện điều đó. 

 

Có 2 dạng ký hiệu mà bạn có thể tạo: Biểu tượng (Symbol) và Hình ảnh (Picture).  

 Các ký hiệu biểu tượng sử dụng một ký tự trong các bộ Font đặc biệt như 

Weddings và Windding. Để sử dụng các biểu tượng này bạn phải cài đặt bộ Font phù 

hợp trong máy tính. Bạn cần chú ý điều này vì nếu bạn gửi tài liệu cho một người nào 

đó mà trong máy tính của họ không có bộ Font phù hợp sẽ dẫn đến lỗi hiển thị. 

  Ký hiệu dạng hình ảnh thực chất là những bức ảnh rất nhỏ. Bạn có thể tìm thấy 

rất nhiều dạng ký hiệu hình ảnh trên Microsoft Office Online. Hoặc bạn có thể tự tạo 

cho riêng mình, chỉ cần lưu ý các ảnh này phải rất nhỏ nên đừng sử dụng các hình ảnh 

quá phức tạp.  

  Cùng với Thư viện Bullet còn có Thư viện Numbering hoạt động tương tự. 

Bạn có thể chỉnh sửa Font, màu sắc, kích thước cho các ký hiệu dạng số của danh 

sách.  

f. Định dạng danh sách 
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1. Chọn các số trên danh sách. 

2. Định dạng lại.  

3. Danh sách với kiểu định dạng mới. 

 Bạn có thể định dạnh số hoặc ký hiệu của danh sách mà không làm ảnh hưởng 

đến phần còn lại. Ví dụ thay vì dùng kiểu màu đen in đậm mặc định bạn có thể thay 

bằng màu đỏ. Cách thự hiện như sau: Chọn các chữ số hoặc ký bằng cách Click vào 

một trong số chúng, chú ý không chọn phần văn bản. 

 Sau khí chọn xong hãy dùng các nút lệnh trên thanh Ribbon để định dạng theo ý 

của bạn. Clcik ra ngoài danh sách để xem sự thay đổi.  

g. Làm việc với đoạn văn bản trong danh sách và dán danh sách 

 Giả sử bạn có một danh sách với các dấu chấm màu đen hoặc các con số ở đầu 

dòng, bạn muốn một số thành phần trong danh sách có các đoạn văn bản không có ký 

hiệu nào ở đầu như trên hình minh họa. Có nhiều kịch bản và cách xử lý tùy theo yêu 

cầu và kinh nghiệm của người dùng. 

 

 Giả sử bạn muốn xóa ký hiệu hoặc số ở đầu một đoạn nào đó nhưng vẫn muốn 

giữ canh lề ngang với phần còn lại trong danh sách hãy click chuột ngay sau chấm đen 

rồi nhấn nút BACKSPACE. 

 Nếu bạn muốn xóa ký hiệu hoặc số ở đầu một đoạn và muốn đoạn đó được canh 

lề cao hơn với canh lề của tài liệu thay vì nằm ngang với các thành phần còn lại của 

danh sách hãy chọn vào ký hiệu hoặc con số đầu dòng rồi nhấn DELETE.  

 Để tạo một đoạn văn bản con trong một thành phần của danh sách hãy nhấn 

SHIFT + ENTER thay vì chỉ nhấn ENTER. Lúc này đoạn văn bản phụ sẽ có canh lề 

ngang với các phần trong danh sách nhưng không có ký hiệu hoặc con số ở đầu.  

 Để tiếp tục danh sách sau khi hoàn thành đoạn văn bản con hãy gõ vào số tiếp 

theo trong danh sách và một dấu chấm (.) danh sách sẽ tự động tiếp tục đánh số. Lưu ý 
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là nếu bạn nhấn vào nút Numbering thì Word sẽ khởi tạo một danh sách mới và đánh 

số lại từ đầu. Lúc này có một nút Auto Correct Options xuất hiện bên cạnh danh 

sách mới, hãy nhấn vào nút này sau đó nhấn Continue Numbering để danh sách mới 

sẽ được gắn lại vào danh sách cũ. 
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PHẦN V: THÊM NHỮNG GHI CHÚ VÀ THEO DÕI VIỆC CHỈNH 

SỬA TÀI LIỆU 

1. Kiểm tra tài liệu bằng chức năng Track Changes trong Word 2007 

a. Track Changes và Comments 

 Bạn đang xem lại tài liệu cho Sếp trước khi nó được công bố cho toàn công ty và 

bạn thấy có một số điểm cần chình sửa, bạn muốn Sếp của mình thấy những điểm cần 

chỉnh sữa đó. Hãy bật chức năng Track Changes, tất cả thay đổi từ việc thêm, xóa 

hoặc định dạng văn bản đều sẽ được Word đánh dấu. 

 

 Chọn thẻ Review, nhóm Tracking, chọn Track Changes. Khi bạn click lần đầu 

nền của nút Track Changes sẽ thay đổi màu sắc, bất cứ sự thay đổi nào trong tài liệu 

sẽ được đánh dấu cho đến khi bạn tắt Track Changes bằng cách nhấn nút Track 

Changes lần nữa. 

b. Xem các chỉnh sửa 
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1.  Văn bản bị xóa nằm trong một hình chữ nhật ở góc. 

2.  Văn bản được thêm vào sẽ được gạch dưới và có cùng màu với với viền hình chữ 

nhật chứa văn bản bị xóa.  

3. Những đường đứt quãng chỉ ra những phần có sự thay đổi, nơi nội dung text được 

xóa hay thêm vào. 

 Sau khi bạn mở tab Track Changes, bạn sẽ làm việc trong Word như bình 

thường. Khi chèn hoặc xóa văn bản, hay di chuyển văn bản hoặc đồ họa, thì các 

đường đứt quảng sẽ đánh dấu sự thay đổi này, màu sắc và nội dung thay đổi cũng 

được đánh dấu. 

 Bạn xóa dòng "with hard work and clear thinking.", dòng văn bản này được đặt 

trong một box hình chữ nhật nhỏ ở góc tài liệu, nó được đánh dấu là "Bị xóa 

(Deleted)" để giải thích vì sao nó phải nằm ở đó. Một được đứt quãng màu xanh chạy 

dài từ hình chữ nhật đến nơi mà dòng văn bản đã nằm trước khi bị xóa.  

 Bạn thay từ "twelve" bằng "nine" bạn chọn từ "twelve" và gõ "nine" để thay thế 

nó (hoặc cũng có thể xóa "twelve" rồi gõ "nine" tại vị trí đó). Từ "twelve" bị xóa sẽ 

được chuyển vào hộp một hình chữ nhật ở góc tài liệu. Từ "nine" mới thêm vào sẽ 

được gạch dưới và có cùng màu với viền của hình chữ nhật chứa "twelve".  

 Ngoài ra, có một gạch dọc phía trước mỗi câu mà trong đó có thực hiện chỉnh 

sửa. 

c. Thêm comment 

 Bạn đã thực hiện một số sửa đổi, nhưng bạn cũng muốn giải thích lý do tại sao 

bạn xóa từ "twelve" trong câu đầu tiên. Rất đơn giản: hãy thêm một bình luận (hoặc 

ghi chú) (Comment), đó là những chú thích mà bạn có thể thêm vào các tài liệu. Để 

thực hiện điều đó, chuyển con trỏ vào cuối của văn bản bạn muốn chèn Comment, trên 

thẻ Review, trong nhóm Comments, chọn New Comment. 
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 Một Comment đã xuất hiện ở góc tài liệu, từ mà bạn muốn ghi chú được tô sáng 

cùng màu với màu của hình chữ nhật chứa ghi chú (màu tím nhạt trong hình minh 

họa). Bạn có thể phân biệt Comment và những văn bản bị xóa dựa vào các điểm sau: 

 - Hình chữ nhật chứa Comment có tô màu trong khi hình chứa văn bản bị xóa chỉ 

có viền mới có màu.  

 - Nhãn "Comment" trên hình chữ nhật chứa ghi chú.  

 - Tên người ghi chú.  

Lưu ý: Bạn không cần phải mở Track Changes để chèn Comment, vì bạn có thể thêm 

comment bất cứ thời điểm nào. 

d. Phân biệt việc chỉnh sửa của từng người tham gia review tài liệu 

 Khi có nhiều người review một tài liệu, bạn có thể biết được thay đổi nào đã 

được ai thực hiện. Dưới đây là một số cách biết người nào đã thay đổi những gì. 

 

 Di chuyển con trỏ lên văn bản mới được chèn vào trong tài liệu, hoặc trên các 

văn bản đã bị xóa trong hình chữ nhật ở góc tài liệu. Đối với mỗi sửa đổi, bạn sẽ thấy 

một ScreenTip chỉ ra tên của người sửa và các loại của các sửa đổi, chẳng hạn như 

"đã xóa" (deleted) hoặc "chèn" (inserted). Các ScreenTip cũng hiển thị thông tin đã 

bị xóa hoặc chèn vào văn bản.  

 Một cách khác để phân biệt những người tham gia hiệu chỉnh tài liệu là dựa vào 

màu sắc. Word tự động đánh dấu một màu sắc của từng người tham gia hiệu chỉnh, 

mỗi người một màu khác nhau. Giả sử bạn được Word gán cho màu hồng khi hiệu 

chỉnh tài liệu, nếu bạn muốn xem chỉ những chỉnh sửa của mình thì hãy tìm những 

văn bản có tô sáng hoặc các hình chữ nhật màu hồng ở góc.   

e.Tắt Track Changes không ảnh hưởng đến các đánh dấu thay đổi hoặc ghi chú 

Mặc dù tắt Track Changes, nhưng những sự thay đổi vẫn còn thấy được trong tài liệu. 
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 Nếu bạn muốn biết tắt chức năng Track Changes có làm đánh những đánh dấu 

hoặc ghi chú trong tài liệu không thì câu trả lời là KHÔNG. 

 Như trong hình minh họa, mọi thứ bạn làm với tính năng Track Changes vẫn còn 

ngay khi bạn đã tắt Track Changes. Chỉ có một điểm lưu ý là sau khi tắt Track Change 

thì những thay đổi tiếp theo của bạn sẽ không còn được Word đánh dấu nữa. 

f. Chấp nhận hoặc từ chối comment (ghi chú) và thay đổi 

 

1. Sử dụng nút Accept để chấp nhận sự thay đổi cùng một lúc hoặc liên tục các thay 

đổi, hoặc để chấp nhận tất cả các thay đổi cùng một lúc.  

2. Sử dụng các nút Reject để từ chối sự thay đổi cùng một lúc hoặc liên tục các thay 

đổi, hoặc để từ chối tất cả các thay đổi cùng một lúc. 

3. Sử dụng các nút Previous để xem từng ghi chú hoặc hiệu chỉnh theo hướng lên trên 

của tài liệu. 

4. Sử dụng nút Next để xem theo hướng xuống cuối của tài liệu. 

 Khi tất cả những thay đổi đã được hoàn tất, một người nào đó phải có trách 

nhiệm xem lại tài liệu sau đó chấp nhận hoặc từ chối những thay đổi. 
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 Sử dụng nút Accept hoặc Reject trên Tab Review trong nhóm Changes hoặc 

Click-Chuột-Phải lên tài liệu để chấp nhận hay từ chối thay đổi và comment (bình 

luận, ghi chú). Khi những thay đổi và comment được chấp nhận bị xóa bỏ, tài liệu sẽ 

bị đánh dấu để chi ra rằng comment và những thay đổi đã được xóa ra khỏi tài liệu. 

Nhữn thay đổi được chấp nhận sẻ trở thành một phần của tài liệu khi nó được lưu lại. 

2. Track Changes và Comments - những tính năng nâng cao 

a. Ẩn tạm thời những thay đổi 

 Hãy tưởng tượng rằng bạn sẽ xem lại phần thay đổi tài liệu được thực hiện bởi 

Richard, Kai và Pilar. Bạn muốn xem phần thay đổi của Pilar trước và biết rằng bạn 

có thể tìm góp ý tài liệu của Pilar bằng cách di chuyển con trỏ chuột lên tất cả những 

sự thay đổi để thấy tên Pilar hoặc xem màu sắc được Word gán cho những hiệu chỉnh 

của cô ấy. Tuy nhiên, bạn nghĩ rằng nếu bạn chỉ có thể xem phần sửa chữa của Pilar 

mà không xem được phần của Richard và Kai thì không ổn, đặc biệt đối với những tài 

liệu dài. 

 

 Hãy tiếp tục khám khá bằng cách nào để học về sự thay đổi của track 

 Để chỉ xem những sửa chữa của Pilar, bạn có thể làm ẩn những cái sửa chữa của 

Richard và Kai. Cách thực hiện như sau: 

 Trên tab Review tab, trong nhóm Tracking, click dòng Show Markup, chỉ vào 

Reviewers và xóa dấu chọn trên mục All Reviewers, nó sẽ làm ẩn tất cả những hiệu 

chỉnh, của bất kỳ người nào. Sau đó click dòng Show Markup lần nữa, chỉ vào 

Reviewers và click vào hộp tên Pilar. Nó sẽ hiện ra phần comment và phần hiệu chỉnh 

của chỉ Pilar. Bạn có thể chấp nhận hoặc từ chối những gì đã được hiệu chỉnh bởi Pilar 

ngay tức thì hoặc có thể để sau.  

 Khi bạn đã thực hiện xong, thì hãy xem lại phần đã bị sửa chữa bởi những người 

khác bằng cách click Show Markup lần nữa, sau đó chọn All Reviewers.  
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b. Xem một tài liệu trước và sau khi thay đổi 

 Khi một tài liệu đã có rất nhiều comment và những phần bị sửa chữa, bạn có thể 

tự hỏi rằng tài liệu trước đây như thế nào hoặc bạn có nên chấp nhận hoặc từ chối các 

hiệu chỉnh.  

 

 Tính năng này được thực hiện như sau: Trên Tab Review, trong nhóm 

Tracking, Final Showing Markup là chức năng được chọn mặc định để hiệu chỉnh 

tài liệu. Để xem lại tài liệu trước đây, bạn Click vào Original. Để xem tài liệu sẽ trông 

như thế nào khi các hiệu chỉnh được chấp nhận và những comment đã được xóa, hãy 

Click vào hộp Display for Review và sau đó chọn Final. Nên nhớ rằng comment và 

những gì được hiệu chỉnh sẽ không bị xóa mất. Sau khi review tài liệu, click Final 

Showing Markup để xem lại comment và những hiệu chỉnh lần nữa. 

c. Ẩn những sự thay đổi không làm xóa comment và những cái bị điều chỉnh 

 Như đã đề cập trước đây ẩn comment và những hiệu chỉnh sẽ không xóa mất 

chúng, mà chỉ cho bạn thấy tài liệu sạch (không thấy những hiệu chỉnh hiện lên màn 

hình). 
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Cách để xem những gì ẩn trong tài liệu. 

 Trên tab Review, trong nhóm Tracking, Click Show Markup và chắc chắn rằng 

đã có những dấu check trên Comments, Ink, Insertions and Deletions và Formatting.  

Chọn vào Reviewers trên menu Show Markup và chắc chắn rằng đã có dấu check trên 

All Reviewers. 

d. Kiểm tra comment và những hiệu chỉnh 

 

1. Sử dụng những nút trong nhóm Changes để chấp nhận hay từ chối những hiệu 

chỉnh hoặc xóa những comment. 

2. Để thấy nội dung tài liệu ẩn những hiệu chỉnh hoặc comment, hãy Click bất cứ nút 

nào trong nhóm Comments hoặc Changes. Bạn sẽ thấy một hộp thoại mở lên như 

hình trên, Click Show All để xem tất cả comment và những hiệu chỉnh. 

 Cách duy nhất để làm mất các hiệu chỉnh là chấp nhận hoặc xóa chúng. Cách 

duy nhất làm mất bỏ comment là chấp nhận hoặc từ chối chúng. Khi chấp nhận thì các 

hiệu chỉnh và comment sẽ trở thành một phần của tài liệu và không bị đánh dấu nữa. 

 Khi bạn từ chối hoặc xóa các hiệu chỉnh và comment thì những gì được chỉnh 

sửa sẽ trở lại trạng thái trước khi thực hiện chỉnh sửa. Trước khi bạn phân phối tài liệu 

cho người khác, hãy chắc rằng bạn đã thực hiện các chấp nhận hoặc từ chối xóa với 

những hiệu chỉnh trên tài liệu. Sẽ không chuyên nghiệp nếu tài liệu bạn gửi cho người 

khác còn các nội dung đang chỉnh sửa. 

e. Chọn cách tạo track 
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 Bạn có thích những hình chữ nhật chứa văn bản bị xóa hay các ghi chú không? 

Hay bạn muốn thay đổi kích thước của chúng? Khi text được chèn vào trong tài liệu 

bạn thích đoạn text này xuất hiện với hai dòng gạch chân hay một dòng gạch chân? 

 Bạn có một vài chọn lựa cho việc thể hiện của comment và các hiệu chỉnh. Cách 

làm như sau: trên Tab Review, trong nhóm Tracking, Click vào dòng Track 

Changes, sau đó click Change Tracking Options. Bạn sẽ có nhiều chọn lựa để tùy 

biến những thể hiện của tính năng Track Changes. 
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PHẦN VI: NHỮNG TÁC ĐỘNG CUỐI CÙNG CHO TÀI LIỆU 

1. Căn bản về Header và Footer 

a. Thêm vào số trang, ngày giờ 

 Nếu bạn không chắc cái gì gọi là headers and footers, thì hãy nghĩ đến việc 

định dạng trang sách. Thông thường tên sách thường xuất hiện ở đầu mỗi trang và tên 

chương xuất hiện trang đối diện và ở dưới là số trang. 

 

 Đó là một dạng thể hiện của Header và Footer, nó được ứng dụng một cách 

tương tự trong Word. Thường thì có thể bạn muốn đánh dấu số trang trong suốt tài 

liệu. Các thông tin khác như tên tài liệu, tác giả, ngày in; tên công ty, địa chỉ email, 

địa chỉ web; tên file và vị trí file. 

 Không có qui luật cụ thể nào với Header và Footer, trong Word 2007, bạn có thể 

tạo ra Header và Footer theo ý của mình. 

b. Đánh dấu số trang 
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 Số trang (Page numbers) là sử dụng thông thường nhất của Header hoặc Footer, 

vì nó thật sự cần thiết cho tài liệu. Để đánh dấu số trang vào tài liệu ta làm như sau:  

1.  Trên Tab Insert, trong nhóm Header & Footer, chọn Page Number. 

2.  Chọn nơi mà số trang xuất hiện, ví dụ như trên, dưới, ở giữa... 

3. Sau đó chọn kiểu con số trong thư viện. 

 Số trang được áp dụng trong suốt tài liệu và chúng cũng được thay đổi nếu bạn 

xóa hay thêm vào số trang trong tài liệu. 

c.Thêm vào ngày tháng hiện tại 

 

Một vài Headers và Footers có sẵn trong thư viện bao gồm một Text Area (khu vực 

chèn văn bản) đặc biệt cho việc chèn ngày giờ. Nhưng bạn cũng có thể chèn ngày giờ 

hiện tại độc lập với Headers và Footers. Cách làm như sau:  

1. Click Header hoặc Footer nơi bạn muốn ngày giờ xuất hiện trên tài liệu.   

2. Trong nhóm Insert, chọn Date & Time.  

3. Chọn một loại định dạng ngày giờ. Bạn có thể chọn ngày hoặc giờ hoặc chọn cả 

hai.  

4. Chọn Update Automatically trong ô chọn.  

 Ngày giờ hiện tại sẽ cho bạn biết bất khi nào bạn mở tài liệu ra. Bạn cũng có thể 

cập nhật khi file được mở và điều chỉnh lại trước khi in ấn. 

d. Thêm tên file và đường dẫn đến file 

 Một kiểu Headers hoặc Footers thông thường khác là thêm tên cho tài liệu và 

đường dẫn đến nơi tài liệu được lưu trữ. Để chèn thông tin này một lần nữa bạn phải 

sử dụng Field (trường nội dung). 
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Hãy làm theo cách hướng dẫn sau: 

1. Trong nhóm Insert, click Quick Parts và chọn Field.  

2. Trong hộp Field, under Field names, chọn FileName.  

3. Click vào ô chọn Add path to filename.  

 Field FileName cho bạn cách cập nhật đường dẫn một cách tự động nếu bạn di 

chuyển tài liệu đi nơi khác. 

e. Xóa bỏ header hoặc footer 

 

 Bạn được chuyển một tài liệu và bạn cảm thấy cần xóa bỏ nội dung của Header 

hay Footer.  

1. Giả sử một thông tin ở Footer, chẳng hạn đường dẫn của tài liệu không còn cần 

thiết. 

2. Trong nhóm Header & Footer, chọn Footer.  

3. Chọn Remove Footer. 

 Số trang và Header cũng có chứa lệnh Remove với tác dụng tương tự.  

2. Header và Footer cho từng phần trong tài liệu 
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a. Tạo ra nhiều loại header và footer trong cùng một tài liệu 

 Bạn có một tài liệu nhiều phần và bạn muốn tạo ra nhiều loại Header và Footer 

tương ứng với từng phần. Hình minh họa bên trên cho biết từng phần tài liệu sẽ có 

Header và Footer khác nhau. 

 

 Với trang bìa bạn sẽ không cần số trang cũng như Header và Footer. 

 Đối với các phần đầu, chẳng hạn như Mục Lục, Header và Footer nên thể hiện 

sao cho người đọc biết đây chưa phải là nội dung chính. 

 Với các chương, Header và Footer lúc này rất cần thiết để định hướng cho người 

đọc, nhắc cho họ biết mình đang xem phần nào và ai là tác giả. 

 Bạn đã biết một điểm tiện dụng của Header và Footer là chỉ cần tạo một lần và 

có thể dùng xuyên suốt cả tài liệu. Nhưng với một tài liệu có nhiều phần bạn cần nhiều 

quyền kiểm soát Header và Footer hơn. 

Phải làm như thế nào?  

b.Tạo ra thành những phần khác nhau 

 Nếu tài liệu có nhiều phần bạn muốn tạo ra nhiều loại Header và Footer đi với 

từng phần, điều đầu tiên cần làm là tạo ra section breaks (ngắt đoạn) giữa từng phần 

của tài liệu. 
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 Một section break cho phép tạo ra một một cách trình bày duy nhất cho các 

trang trong phần đó. Với một cách trình bày (layout) được thiết lập, bạn có thể tạo 

Header và Footer theo cách bạn muốn cho từng phần (section). 

c. Cách phân chia từng section 

 

 Bạn chèn section break trong phần chính của tài liệu, chứ không phải bất cứ nơi 

nào trong không gian header và footer. Chính vì vậy, bạn phải đóng màn hình làm 

việc của Header và Footer trước khi thực hiện các bước sau đây: 

1. Chỉ con trỏ nơi bạn muốn bắt đầu một section mới.  

2. Trên Ribbon, chọn Tab Page Layout và chọn Breaks.  

3. Dưới Section Breaks, chọn Next Page. 

Word sẽ tạo ra một section break ở vị trí phía trên con trỏ chuột.  

d. Cách tạo mục lục header và footer khác nhau cho từng section 

 Một section break phân chia những gì bên trên nó thành một phần và những gì 

phía dưới là một phần khác. Vậy với một section break được chèn vào trước Chapter 

1, tất cả những gì trước đó (trang bìa, mục lục...) sẽ là phần 1 (section 1) và Chapter 1 

sẽ trở thành phần 2 (section 2).  

 Khi bạn mở không gian làm việc của Header và Footer, các thẻ đánh dấu sẽ xuất 

cho bạn biết bạn đang làm việc với Header và Footer của phần nào. Trong hình minh 

họa, các thẻ đánh dấu chỉ ra những phần khác nhau và gán cho mỗi phần một con số.  
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1. Footer này chỉ phần kết thúc của phần 1. 

2. Header bên dưới bắt đầu phần 2. 

3. Tab Same as Previous. Nó có ý nghĩa gì? 

 Nó có nghĩa là mặc dù bạn tạo ra những phần khác nhau nhưng Word vẫn có tùy 

chọn cho phép bạn chia sẻ những điểm chung giữa Header và Footer của mỗi phần. 

Trong hình minh họa, thẻ Same As Previous có nghĩa là nội dung của Header hiện tại 

được liên kết với nội dung Header của phần trước đó. Nếu bạn muốn Header hiện tại 

độc lập với Header trước bạn phải xóa liên kết giữa 2 Header. 

Với Footer cũng tương tự như Header.  

e. Cách tạo ra sự khác biệt cho trang đầu tiên 

 

 Khi bạn đã đưa các nội dung đầu (trang bìa, mục lục...) vào một phần riêng, bạn 

thậm chí còn có thể phân chia nó ra thành các phần nhỏ hơn nữa. Giả sử bạn không 

muốn bất cứ gì xuất hiện trên Header và Footer của trang bìa:  

1. Sử dụng chức năng Different First Page như hình trên để thực hiện. Nếu bạn chọn 

tùy chọn Different First Page thì có nghĩa bạn cho phép Header và Footer của trang 
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bìa này khác với phần còn lại của các trang trên cùng một phần (section). Bạn cũng có 

thể làm điều tương tự với các phần khác của tài liệu. 

2. Khu vực Header và Footer bây giờ sẽ có phần văn bản với nội dung "First Page 

Header" and "First Page Footer" (chỉ xuất hiện trong không gian làm việc Header và 

Footer).  

 Nếu bạn có áp dụng đánh số trang thì chứa năng Different First Page cũng ngăn 

không cho đánh số trang bìa.  

f. Header và Footer khác nhau cho các trang chẵn và lẻ 

 Khi bạn sử dụng thư viện Header và Footer được thiết kế sẵn, bạn sẽ thấy một số 

được tạo ra để dành riêng cho trang chẵn và lẻ. Nội dung của Header và Footer được 

đặt ở góc của trang, giống như trong thiết kế của các trang đối diện trong các quyển 

sách. Nếu bạn muốn in ra và đóng tài liệu của mình, có thể bạn sẽ cần định dạng 

tương tự.  

 

 Để tạo ra Header và Footer cho trang chẳng và lẻ, bạn thực hiện một tiến trình 

tương tự như trên: Tạo ra các phần khác nhau trong tài liệu bằng section break, xóa 

liên kết giữa các phần và thêm Header và Footer cho từng phần.  

Lưu ý khi thực hiện: Nếu bạn muốn Header hoặc Footer của các trang chẵn và Lẻ 

nằm ở góc trang bạn phải bật chứa năng Different Odd & Even Pages trong Tab 

Design trước khi thực hiện.  

3. Tìm hiểu về bảng mục lục (Table of contents - TOC) 

a. Cách làm việc với bảng mục lục tự động 

 Mục lục là một danh sách đơn giản liệt kê tên các chương. nó có thể phân thành 

nhiều cấp như trong hình trên.  
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 Mục lục cung cấp cái nhìn tổng quát của tài liệu giúp cho người đọc có thể tìm 

thấy từng phần một cách nhanh chóng. Word 2007 cung cấp cho bạn một cấp lập mục 

lục tự động. 

 

Có 2 bước để tạo mục lục tự động:  

  

1. Chuẩn bị tài liệu bằng cách gán các Heading Styles (kiểu trang trí tiêu đều) cho tên 

các chương và các tiêu đề mà bạn muốn xuất hiện trong mục lục.  

2. Thu thập các tiêu đề đó để tạo thành bảng mục lục.  

b. Bước 1: Chuẩn bị tài liệu cho bảng mục lục 

 Sau khi bạn đã quyết định các tên chương và tiêu đề sẽ xuất hiện trên mục lục 

bạn cần áp dụng một số Style đặc biệt để Word có thể thêm chúng vào mục lục tự 

động.  

 

Các Style này nằm trên tab Home, trong nhóm Styles. Với mỗi chương và tiêu đề làm 

như sau:  



Tìm hiểu Microsoft Office 2007- Tập 1: Tìm hiểu Microsoft Word 2007 

 

Biªn So¹n: Niemtin071@yahoo.com 58 

 

1. Chỉ con trỏ vào tên hoặc các tiêu đề của chương.  

2. Trong nhóm Styles, chọn Heading 1 cho cấp độ cao nhất là tên chương, Heading 2 

cấp độ tiếp theo, có thể là tên của của các phần trong chương và Heading 3 cho tiêu đề 

phụ.  

 Các Heading Styles và bảng mục lục tự động làm việc với nhau để tạo ra bảng 

mục lục cho tài liệu. Word chỉ định mục lục Heading 1 làm cấp độ cao nhất trong 

bảng mục lục, Heading 2 tương ứng với cấp độ cao thứ hai và Heading 3 cho cấp độ 

tiếp theo.  

c. Bước 2: Tạo bảng mục lục cho tài liệu 

 Sau khi chọn các Heading Style phù hợp cho từng phần, thì đã đến lúc thu thập 

tất cả chúng vào trong bảng mục lục, đây là lúc Word làm việc thay cho bạn.  

 

 Đầu tiên bạn chỉ con trỏ nơi bạn muốn bảng mục lục xuất hiện, thông thường thì 

người ta đặt mục lục ở đầu tài liệu. Trên tab References, chọn Table of Contents, sau 

đó click Automatic Table 1 hoặc Automatic Table 2 hoặc cái nào bạn cảm thấy phù 

hợp nhất. Rất nhanh và đơn giản.  

 Bảng mục lục sẽ xuất hiện với một hộp màu xanh nhạt. Đó là một hiệu ứng để 

thông báo cho bạn biết đây là một bản mục lục tự động.   

d. Cập nhật bảng mục lục 
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 Sau khi đã tạo ra bảng mục lục cho tài liệu, có thể bạn phải duy trì nó. Bảng mục 

lục sẽ tự động cập nhật khi tài liệu được mở; và còn hay hơn nữa khi nó cũng tự cập 

nhật bất cứ khi nào bạn thêm tên chương hoặc tiêu đề mới vào và làm thay đổi số 

trang của tài liệu. Chỉ cần thực hiện 2 bước sau:  

 Bạn cập nhật mục lục bằng cách Click vào tab References và sau đó chọn 

Update Table trong nhóm Table of Contents.  

 Khi cập nhật bảng mục lục bạn sẽ được hỏi rằng bạn muốn cập nhật toàn bộ mục 

lục hay chỉ muốn điều chỉnh số trang. Chọn điều chỉnh số trang nếu bạn thêm nội 

dung làm tăng số trang trong tài liệu mà không thêm tiêu đề nào mới, còn nếu bạn 

thêm hoặc thay đổi nội dung tiêu đề thì nên chọn Update entire table.  

 Bạn nên tránh việc sửa chữa trực tiếp vào bảng mục lục, vì nếu bạn đã từng cập 

nhật bảng mục lục thì bạn sẽ mất dữ liệu đã thay đổi. Để thay đổi nội dung trong bảng 

mục lục, thì hãy chỉnh sửa trên tài liệu, chứ không sửa trực tiếp trên bảng mục lục, sau 

đó click Update Table. 

e.Thay đổi bảng mục lục 

Có rất nhiều cách để bạn thay đổi bảng mục lục.  
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 Bên cạnh việc chon nhiều kiểu và định dạng đã có sẵn trong Word, bạn có thể tự 

thiết kế chi tiết bảng mục lục cho riêng mình, chẳng hạn như quyết định số cấp cho 

mục lục, có cho số trang xuất hiện hay không, tạo đường nối bằng dấu chấm giữa tiêu 

đề và số trang, v.v...  

 Bạn sẽ tìm hiểu các vấn đề này ở phần tiếp theo: Thay đổi hình thức bảng mục 

lục.  

4. Điều chỉnh mục lục 

a.Thay đổi hình thức bảng mục lục 

 Bạn đã có một bảng mục lục rồi, nhưng bạn lại muốn thay đổi chúng.  

 Ví dụ tiêu đề trong tài liệu của bạn có màu xanh nhưng trong bảng mục lục thì 

không. Bạn thích màu xanh và muốn trong bảng mục lục cũng có màu trùng với các 

tiêu đề trong tài liệu. 

 Có thể bảng mục lục quá dài và bạn muốn làm nó ngắn bớt. 

 

 Hoặc cũng có thể bạn đã hài lòng về bảng mục lục nhưng vẫn muốn có một thay 

đổi nhỏ. Chẳng hạn bạn muốn thay đỗi các đường chấm đứt quãng giữa các đề mục và 

số trang. Hoặc bạn muốn số trang nằm gần các đề mục hơn.  

 Tất cả những việc đó, và còn nhiều hơn, đề có thể thực hiện. 

b. Thiết kế lại bảng mục lục 

 Bạn đã có bảng mục lục, nó trông có vẻ ổn, nhưng bạn muốn màu sắc tương tự 

như tiêu đề. Đây là cách thực hiện: Trên Tab References, chọn Table of Contents 

trong nhóm Table of Contents và sau đó chọn Insert Table of Contents.  
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 Trong hộp thoại Table of Contents, chắc chắn rằng mục From template đã 

được đánh dấu trong hộp Formats, sau đó chọn Modify. Chọn TOC 1 trong hộp thoại 

Style để chọn cấp độ cao nhất hoặc Level 1, trong bảng mục lục TOC và sau đó chọn 

Modify. Hộp thoại Modify Style được mở ra, sử dụng hộp màu Font trong phần 

Formatting để chọn màu xanh.   

 Sau khi click OK hai lần, hãy xem trong mục Print Preview của hộp thoại Table 

of Contents và bạn sẽ thấy rằng Table of Contents, hay còn được viết tắt là TOC 1 

(hay Level 1), bây giờ là màu xanh.  

 Nếu bạn muốn thay đổi TOC 2 (Level 2) hay TOC 3 (Level 3) cũng thành màu 

xanh, thì bạn cũng làm theo quy trình trên bằng việc chọn TOC 2 hoặc TOC 3 trong 

hộp thoại Style trước khi đi đến hộp thoại Modify Style.  

 Sau khi click OK, một hộp thoại xuất hiện với nội dung hỏi bạn có muốn thay 

đổi bảng mục lục hay không, click OK và kết quả sẽ hiện thành màu xanh như ý 

muốn của bạn. 

c. Thiết kế lại bảng mục lục 
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 Bạn muốn thay đổi nhiều hơn nữa? Word 2007 cho người dùng nhiều tùy chọn 

để chọn lựa trong hộp thoại Modify Style, nhưng hãy luôn nhớ chọn Style mà bạn 

muốn thay đổi trong hộp thoại Style trước khi thực hiện chức năng Modify Style.  

 Chú ý rằng khi click Format, bạn sẽ có lựa chọn thay đổi như Font, Paragraph, 

Tabs, … bạn cũng có thể thay đổi các cài đặt của từng phần và xem lại chúng trong 

mục Preview trước khi áp dụng cho bảng mục lục.  

d. Cách làm ngắn hoặc kéo dài bảng mục lục 

 

 Bảng lục lục quá dài, có lẽ chỉ cần hai cấp độ đầu tiên TOC 1 và TOC 2 là phù 

hợp với tài liệu của bạn. Mục Show levels ở hộp thoại Table of Contents là nơi bạn 

có thể chọn các phân cấp bạn muốn thể hiện trong bảng mục lục. Word 2007 có đến 9 

cấp độ khác nhau.  

 Làm ngắn bảng mục lục bằng cách giảm cấp độ, còn muốn kéo dài bảng mục lục 

thì bạn hãy tăng cấp độ lên. Bạn có thể xem trong Print Preview hoặc Web Preview 

để xem sự điều chỉnh của mình, khi nhận thấy hợp lý, thì click OK hai lần. 

e. Cách thay đổi đơn giản bảng mục lục 

 Bạn có thể thực hiện các thay đổi nhỏ mà không cần rời khỏi hộp thoại Table of 

Contents.  

 Chẳng hạn thay đổi các gạch đứt quãng giữ các đề mục và số trang (gọi là Tab 

Leader), hoặc thay đổi canh dòng (align) của số trang.  
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 Để thay đổi Tab Leader, chọn mục Tab leader để xem lại kiểu gạch ngang và 

dòng. Nếu bạn xóa hộp Right align page numbers, thì số trang sẽ di chuyển lại gần 

hơn đến bảng mục lục và tab leaders sẽ không còn hiệu lực. Nếu bạn muốn xóa bỏ 

toàn bộ số trang thì hãy bỏ dấu chọn ở hộp Show page numbers. 

f. Cách xóa hay tạo lại từ đầu bảng mục lục 

 

 Nếu bạn muốn xóa bỏ bảng mục lục, thì hãy sử dụng lệnh Remove Table of 

Contents. Xóa bỏ bảng mục lục bằng hai cú Click-Chuột: Click lệnh Table of 

Contents và sau đó click Remove Table of Contents ở phần cuối của danh sách.   

 Hãy chắc rằng bạn sử dụng lệnh Remove Table of Contents, nếu bạn xóa thủ 

công trực tiếp bảng mục lục, có thể những mã ẩn sẽ lưu lại trong tài liệu của bạn. 

Những mã ẩn này có thể gây ra lỗi trong các bảng mục lục về sau.  

5. Tìm hiểu các trường và cách tạo nhiều mục lục 

a.Tạo Mục Lục bằng cách sử dụng các trường (field) 
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 Ngoài cách tạo Mục Lục cơ bản có có một cách nâng cao đó là sử dụng các 

trường mục lục (TOC fields).  

 

 Nếu bạn từng sử dụng trường trong Word có lẽ bạn đã thấy được sức mạnh của 

nó. Hãy học sử dụng các trường để tạo Mục Lục.  

 Nếu trường là khái niệm mới mẻ đối với bạn, hãy tìm hiểu chúng qua phần này 

và học cách dùng trường để tạo trực tiếp Mục Lục. Bạn sẽ biết tại sao chúng hữu ích 

nếu bạn muốn điều khiển hoàn toàn bảng mục lục.  

b. Trường (field) là gì? 

 Những ví dụ về trường mục lục. Mã của trường xuất hiện giữa các dấu ngoặc 

móc ({ }).  

 Trường (field) là một tập hợp lệnh chỉ dẫn Word tự động chèn nội dung hoặc 

thực hiện một công việc nào đó trong tài liệu. Trường được ứng dụng khá rộng trong 

Word và có một số việc bạn chỉ có thể thực hiện bằng trường, chẳng hạn như việc bỏ 

đánh dấu số trang cho một vài đề mục trong mục lục.  
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 Có lẽ bạn đã sử dụng các trường nhưng không nhận ra. Ví dụ số trang được điều 

khiển bởi trường, khi bạn tạo bảng mục lục tự động trong các phần trước, thụ ra bạn 

đã tạo ra các trường mục lục ra lệnh cho Word thu thập các đề mục để tạo thành bảng 

Mục Lục.  

 Trường mục lục là những thành phần cơ bản tạo nên bảng mục lục. Các bạn mục 

lục tự động dù được tạo bằng cách nào cũng đều dựa trên các trường mục lục để thu 

thập các đề mục. Khi kết quả thu thập của trường mục lục được hiển thị, bạn nhìn thấy 

bảng mục lục.  

 Bạn có thể xem các trường trong tài liệu bằng cách nhấn tổ hợp phím Alt + F9. 

Trường là những phần có dấu ngoặc móc xung quanh và phần đầu tiên cho biết loại 

của trường đó là gì. Hình minh họa trên là trường mục lục (Table of Content Fields).  

 Để lấy lại góc nhìn bình thường, ẩn đi các trường và xem kết quả hiển thị của 

chúng, hãy nhấn Alt + F9 một lần nữa.  

c. Các công tắc trường 

 Giả sử bạn muốn loại bỏ số trang với một số cấp trong bảng mục lục. Một cách 

làm đó là xóa số trang một cách thủ công và nhớ không cập nhật bảng mục lục. Nhưng 

đó là cách làm không đáng tin cậy, cách tốt hơn là dùng các field switches (công tắc 

trường).  

 

 Field switches là các lệnh bên trong trường để xác định các mã sẽ thực hiện 

những việc gì. Sức mạnh thực sự của các trường chính là các field switches này. Các 

field switches được thêm để kết thúc một trường và được đặt bên trong các dấu ngoặc 

móc, chúng bắt đầu với dấu sổ ngược ( \ ). Bảng mục lục tự động tạo ra các field 

switches thay cho bạn, nhưng bạn có thể thêm, bớt, hoặc hiệt chình các field switches 

này sau.  
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 Một bảng mục lục có thể có nhiều hơn một switch. Bảng mục lục trong hình 

minh họa chứa switch \o "1-3" , nó dùng để tạo mục lục dựa trên các đề mục được 

đánh dấu là Heading 1, Heading 2, và Heading 3. Switch \h làm cho các đề mục 

trong bảng mục lục biến thành các liên kết (hyperlink).  

 Để thêm một switch bạn gõ một dấu sổ ngược ( \ ) và ký tự lệnh vào giữa các 

dấu ngoặc móc, ví dụ để xóa hết các số trang trong mục lục hãy sử dụng switch \n như 

sau:  

{ TOC \o "1-3" \h \n }  

 Bạn có thể dùng hộp thoại Table of Contents để xóa số trang, tuy nhiên nếu bạn 

chỉ muốn xóa số trang ở cấp 2 và 3 thì bạn sẽ phải nhờ tới switch \n bằng cách gõ:  

{ TOC \o "1-3" \h \n "2-3"}  

d. Trường TC 

 Ngoài trường mục lục (TOC field) bạn có thể dùng trường TC (TC field) trong 

bảng mục lục tự động. Trường TC cũng là một cách để đánh dấu những đề mục mà 

bạn muốn xuất hiện trong bảng mục lục.  

Bạn sẽ dùng trường TC khi nào?  

 

 Giả sử có một tiêu đề mà bạn muốn xuất hiện trong mục lục nhưng nó lại quá dài 

và bạn chỉ muốn trích một phần trong đó. Bạn có thể dùng trường TC để lấy một phần 

của tiêu đề làm đề mục trong bảng mục lục.  

 Một ứng dụng khác của trường TC là nếu bạn nhận được một tài liệu có định 

dạng quá lộn xộn và bạn cần phải tạo một bảng mục lục cho nó. Sẽ nhanh chóng hơn 

nếu bạn sử dụng trường TC thay vì phải định dạng lại tài liệu.  
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e. Sử dùng trường TC để tạo đề mục cho bảng mục lục 

 

Đây là cách tạo ra trường TC:  

1. Chọn văn bản mà bạn muốn thêm vào bảng mục lục.  

2. Nhấn tổ hợp phím Alt + Shift + O để mở hộp thoại Mark Table of Contents 

Entry.  

3. Trong hộp thoại, hiệu chỉnh văn bản trong mục Entry nếu cần.  

4. Nếu có hơn một bảng mục lục trong tài liệu (mỗi bảng đại diện bởi một ký tự 

A,B,C...) hãy chọn bảng mục lục mà bạn muốn bằng trong phần Table identifier. Nếu 

chỉ có một bảng mục lục thì không cần lựa chọn phần này.  

5. Chọn cấp độ mà đề mục sẽ xuất hiện trên bảng mục lục trong phần Level.  

f. Thêm trường TC vào bảng mục lục 

 Để trường TC xuất hiện trong bảng mục lục, bạn phải thêm field switch \f vào 

bảng mục lục hiện tại. Field switch \f yêu cầu bảng mục lục thêm trường TC vào. 
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 Bạn có thể mở hộp thoại Table of Contents Options và chọn Table entry fields 

khi bạn tạo hoặc thay thế bảng mục lục. Nhưng có một các dễ hơn để tạo và hiệu 

chỉnh bảng mục lục tự động. Hãy nhấn Alt + F9 sau khi bạn tạo bảng mục lục và gõ 

"\f" vào phần cuối của trường nhu sau:  

{ TOC \o "1-3" \h \f }  

 Sau đó cập nhật trường bằng cách đặt con trỏ chuột vào trường mục lục và nhấn 

F9. Nhấn Alt + F9 lần nữa để xem kết quả.  

g. Tạo nhiều bảng mục lục trong một tài liệu 

 

 Nhiều tài liệu dài có thể có hơn một bảng mục lục, ngoài mục lục chung có thể là 

mục lục của riêng từng chương.  

 Cá loại sách hướng dẫn hoặc nghiên cứu có thể có nhiều bảng mục lục, ví dụ như 

một bảng mục lục cơ bản chỉ chứa tên chương và một bản mục lục chi tiết có chứa các 

phân trong một chương.  

 Bạn sẽ được hướng dẫn 3 cách để tạo nhiều bảng mục lục trong một tài liệu. 

Trong đó có một cách nhanh chóng sử dụng các Heading Styles có sẵn trong Word, 

hai cách còn lại sử dụng trong một số trường hợp đặc biệt.  

h. Cách cơ bản để tạo nhiều mục lục trong một tài liệu 

 Giả sử bạn muốn tạo 2 bảng mục lục cho cuốn sách dạy nấu ăn của mình. Một 

bảng mục lục rút gọn chỉ chứa tên chương và một bảng mục lục chi tiết. Bảng đầu tiên 

chứa tên chương như: Appetizers, Entrees, Sauces...Bảng thứ hai chi tiết hơn với tên 

các chương và các công thức chế biến trong từng chương.  
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 Nếu tài liệu của bạn sử dụng các Heading Styles có sẵn trong Word, cách thực 

hiện rất đơn giản. Tạo 2 bảng mục lục tự động, sau đó ở bảng đầu tiên đổi Swith \o từ 

"1-3" thành "1-1" :  

{TOC \o "1-1" \h}  

Đó là bảng mục lục cơ bản.  

 Vì bảng mực lục thứ hai chứa các đề mục đánh dấu với Heading 1, Heading 2 

và Heading 3 nên nó chính là bảng mục lục chi tiết của bạn.  

 Còn 2 cách khác để tạo nhiều mục lục trong một tài liệu đó là: trường TC và 

Bookmarks mà bạn sẽ được tìm hiểu tiếp theo.  

i. Hai lựa chọn khác để tạo nhiều mục lục trong một tài liệu 

 

 Bổ sung cho cách sử dụng Heading Styles và switch \o ở phần trước là 2 cách 

khác để tạo nhiều mục lục trong một tài liệu:  

 Dùng Table identifiers để đánh dấu mỗi bảng mục lục với một ký tự khác nhau.  

 Bookmark các phần, ví dụ như các công thức nấu bữa ăn sáng, hoặc công thức 

nấu bữa ăn trưa sau đó tạo mục lục cho từng phần. 
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j. Table Identifier 

 Để tạo nhiều hơn một bảng mục lục trong một tài liệu, với mỗi bảng chứa các đề 

mục khac nhau bạn có thể sử dụng Table Identifier.  

 Đầu tiên, bạn cần xác định ký tự đại diện cho mỗi mục lục, ví dụ "A" cho công 

thức nấu nước chấm và "B" cho công thức nấu bữa trưa.  

 

 Sau đó đánh dấu các đề mục mà bạn muốn xuất hiện bằng cách sử dụng trường 

TC như ở phần f , mục Table identifier trong hộp thoại Mark Table of Contents 

Entry dialog là nơi bạn chọn bảng mục lục phù hợp.  

 Khi tạo bảng mục lục bạn chỉ cần sử dụng duy nhất switch \f như sau:  

{ TOC \f B}  

  

Switch \f tạo ra bảng mục lục bằng cách thu thập các mục được đánh dấu bởi trường 

TC. Với ký tự B trong trường mục lục bảng mục lục chỉ hiển thị các trường TC tương 

ứng. Nếu thay B bằng A thì mục lục chỉ bao gồm các đề mục đánh dấu với Table 

identifier là A.  

k. Bookmark 

 Nếu tài liệu của bạn cần bảng mục lục cho một khối văn bản và bạn cũng đã sử 

áp dụng Heading Styles cho tài liệu thì bạn có thể dùng Bookmark để tạo bãng mục 

lục. Một chương trong sách là ví dụ hay về "khối văn bản" và bạn không cần phải 

đánh dấu riêng lẻ từng phần.  

 Bookmark trong Word không chỉ dùng cho bảng mục lục mà nó còn dùng để 

định danh một khối văn bản được chọn để dùng cho mục đích tham chiếu với một cái 

tên tùy ý do bạn đặt.  
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 Đầu tiên bạn cần đánh dấu đoạn văn bản bằng cách chọn toàn bộ khối văn bản. 

Sau đó trên Tab Insert, trong nhóm Links, chọn Bookmarks. Một hộp thoại xuất 

hiện để bạn đặt tên ("Breakfast" chẳng hạn) cho Bookmark vừa tạo. Khi đặt tên xong, 

nhấn Add.  

 Bây giờ hãy tạo mục lục bằng cách sử dụng switch \b cùng với tên Bookmark 

vừa tạo. Ví dụ mục lục cho công thức nấu bữa sáng như sau  

{ TOC \b "Breakfast" }  

 Khi đó, trường mục lục sẽ thu thập tất cả mục được đánh dấu bằng các Heading 

Style trong toàn bộ vùng được đánh dấu (bookmark) có tên Breakfast.  
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PHẦN VII: SỬ DỤNG MAIL MERGE ĐỂ TẠO MAIL HÀNG LOẠT 

1. Mail Merge căn bản 

a. Tìm hiểu và sử dụng mail merge (trộn thư) 

 

Trong bất kỳ Mail Merge nào, bạn làm việc với ba yếu tố khác nhau: 

1. Những tài liệu ban đầu. 

2. Người nhận thông tin, chẳng hạn như tên và địa chỉ của người mà bạn muốn kết 

hợp với các tài liệu chính.  

3. Các tài liệu đã hoàn thành, bao gồm các thông tin trong tài liệu chính cộng thêm 

mỗi thông tin riêng của từng người nhận. 

 Sự hiểu biết những yếu tố này sẽ giúp bạn đạt được những kết quả trộn thư như 

mong đợi.   

b. Tài liệu chính 

 Là những tài liệu có chứa nội dung thông tin giống nhau cho tất cả người. Tài 

liệu chính là điểm bắt đầu, nó có thể là một lá thư, phong bì, e-mail, hoặc thậm chí là 

một phiếu giảm giá.  
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1.  Nội dung là giống hệt nhau ở mỗi bản sao, ví dụ nội dung chính của một bức thư. 

Bạn chỉ cần đánh loại văn bản này một lần, không cần biết bạn sẽ in bao nhiêu lá như. 

2.  Danh sách người nhận bao gồm tên, địa chỉ hoặc có thể thêm nhiều thông tin khác 

như tên công ty, chức vụ. 

c. Thông tin người nhận 

 Trong Mail Merge, mỗi bản sao sẽ chứa thông tin của từng người nhận khác 

nhau, thông tin này được điền vào một khu vực định sẳn (place holder) trong tài liệu 

chính.  

 Thông tin người nhận có thể bao gồm: Địa chỉ trên bao thư, Tên trên câu chào 

trong thư, Tiền lương của từng nhân viên, v.v...  

 

 Thông tin người nhận phải được đặt trong một nguồn dữ liệu (data source), 

nguồn dữ liệu là khái niệm cơ bản bao trùm trong Mail Merge. Ví dụ một danh sách 

liên lạc (contacts) trong Microsoft Oulook là một nguồn dữ liệu. Các nguồn dữ liệu 

khác là một bảng (table) trong Word, một bảng tính Excel, một cơ sở dữ liệu Access, 

thậm chí là một tài liệu văn bản. 

 Thông tin người nhận thường được liệt kê theo dòng và cột như trong hình minh 

họa. Nguồn dữ liệu phải có cấu trúc rõ ràng để có thể xác định thông tin cho từng khu 

vực định sẳn (place holder) trong tài liệu chính. 

d. Bộ tài liệu khi hoàn tất 

 Tập hợp các tài liệu đã hoàn thành trong một thư có nội dung giống nhau mà bạn 

dự kiến đem in hoặc gửi bằng thư điện tử. 
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Khi đã hoàn tất việc trộn thư bạn sẽ có: 

Một tập hợp tài liệu hoàn chỉnh riêng biệt mà bạn có thể in (như thư, bì thư...) hoặc 

gửi qua mạng (như email).  

Nội dung chính được giữ nguyên trong tất cả các tài liệu, chỉ có thông tin người dùng 

sẽ thay đổi trong từng tài liệu. 

2. Chuẩn bị danh sách thông tin người nhận 

a.Thiết lập danh sách người nhận trong mail merge 

 Các cột và hàng trong một danh sách người nhận và khu vực định sẳn (place 

holder) trong tài liệu chính kết hợp cùng nhau để thực hiện việc trộn thư. 

 

 Bạn biết những gì là các yếu tố cơ bản của trộn thư. Bây giờ bạn sẽ tìm hiểu làm 

thế nào để thiết lập tài liệu chính của bạn và kết nối nó với danh sách người nhận.  

 Mail merge gồm hai phần chính là tài liệu và danh sách người nhận. Sau khi bạn 

hiểu những gì đang có hai thành phần chủ chốt và làm thế nào có liên quan, bạn sẽ có 

thể cài đặt và sử dụng thành công Mail Merges 
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b. Tìm hiểu thêm về danh sách người nhận 

 Các cột đại diện cho một loại thông tin người nhận; mỗi hàng là một bộ thông tin 

hoàn chỉnh cho từng người nhận. 

 

 Một danh sách người nhận có thể được thực hiện bằng bất kỳ chương trình nào, 

nhưng thông tin danh sách người nhận phải có cột và hàng. Bạn có thể tạo nó bằng 

cách sử dụng nhiều chương trình khác nhau, chẳng hạn như Excel, Access hoặc 

Outlook. 

1. Các cột trong một danh sách đại diện cho một nhóm hay loại thông tin. Mỗi cột 

được xác định bởi một cột tiêu đề. Ví dụ, một khách hàng trong danh sách bạn có thể 

có các cột cho họ tên, địa chỉ.  

2. Mỗi hàng trong một danh sách đại diện cho một thông tin đầy đủ của người nhận. 

Lưu ý rằng cần thiết phải ghi đúng tên và địa chỉ phải đầy đủ.  

 Từ các tài liệu chính, bạn kết nối vào danh sách thông tin người nhận và sau đó 

bạn có thể thêm bất kỳ cột nào vào một vị trí trong tài liệu chính đó.   

 Khi Mail Merge hoàn thành, sẽ có một tài liệu hoàn chỉnh cho mỗi người mà nó 

có chứa các thông tin từ các mục ở trong một hàng của danh sách người nhận. 

c. Danh sách thông tin người nhận đến từ đâu 
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Trong nhiều trường hợp, danh sách người nhận mà bạn muốn sử dụng đã tồn tại sẵn. 

Ví dụ:  

Thông tin Khách hàng với tên, địa chỉ, và nhiều hơn nữa.  

Các sản phẩm hay dịch vụ mà công ty bạn cung cấp.  

Thông tin về nhân viên của bạn.  

Nếu danh sách đã tồn tại, bạn có thể chỉ cần kết nối với nó với tài liệu chính trong 

Mail Merge.  

Nhưng đừng lo nếu bạn chưa có một danh sách. Mail merge có một bước cho bạn có 

thể tạo một danh sách người nhận từ đầu.   

Lưu ý: Bạn có thể thay đổi các dữ liệu trong danh sách người nhận vào bất kỳ lúc nào 

bằng cách mở hộp thoại Mail Merge Recipients trong khi hợp nhất hoặc bằng cách mở 

tập tin nguồn dữ liệu trực tiếp.  

d. Tìm hiểu Trường (Field) trong Mail Merge 

 Merge fields được bao quanh bởi dấu ngoặc kép (<< >>). 

Sau khi bạn kết nối với những danh sách người nhận, bạn có thể chỉ định các thông tin 

mà bạn muốn có trong thư hợp nhất bằng cách sử dụng các trường (fields). 

 

 Một trường là một tập hợp lệnh điều khiển Word tự động chèn thông tin vào tài 

liệu. Một không chính thức, có thể coi trường là một vị trí định sẵn (place holder). 

 Trong việc tạo và gửi thư hàng loạt, các trường mà bạn sử dụng được gọi là 

merge fields, và chúng là những vị trí định sẵn cho các thông tin đến trực tiếp từ một 

danh sách người nhận. Ví dụ, trong hình minh họa, merge fields đã được cập nhật các 

thông tin được lưu giữ trong các cột Địa chỉ và Tên của một danh sách người nhận. 

e. Tìm hiểu Merge field 
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Merge fields thực ra được tạo bởi các fields khác. Ví dụ, trong field Địa chỉ Block là 

một sự kết hợp của tên, tên họ , địa chỉ đường phố, thành phố, và mã bưu điện. 

«Tiêu Đề» «Họ Tên» 

«Địa Chỉ Tên Đường» 

«Thành Phố», «Bang» «Mã Quốc Gia» 

 Bạn cũng có thể kiểm soát cách nhìn thể hiện của thông tin người nhận trong các 

tài liệu đã hợp nhất (merged) bằng cách định dạng các trường (fields).   

 Ví dụ, bạn có thể muốn tên sẽ được in đậm hoặc màu đỏ. Trong tài liệu chính, 

chọn trường, bao quanh bởi các vạch hình chữ V ( «»). Trên Tab Home, bấm vào bất 

cứ lệnh trong nhóm Font hoặc các nhóm Paragraph, hoặc click vào nút Dialog Box 

Launcher  để thực hiện các tùy chọn định dạng mà bạn muốn. 

f. Thực hiện mail merge 

 

 Một phong bì đã được ghi địa chỉ người nhận bằng cách sử dụng Mail Merge 

Wizard.  

 Trong phần này bạn sẽ học những cách khác nhau để tạo Mail Merge. 
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Sau đó, bạn sẽ có một cơ hội để thực hành một thư hợp nhất (mail merge) của riêng 

bạn bằng cách sử dụng danh sách người nhận mà bạn đã xem trong các phần trước.  

g. Mail Merge Wizard 

 Để thực hiện một thư hợp nhất, chọn Start Mail Merge trên tab Mailings và sau 

đó chọn Step by Step Mail Merge Wizard.  

Trình Wizard sẽ mở ra một cửa sổ bên phải tài liệu. Cửa sổ này có thể di chuyển bằng 

chuột đến một vị trí mới trên màn hình và bạn cũng có thể thay đổi kích cỡ của nó. 

 

 Để thực hiện merge mail cần phải qua 6 bước, bạn làm theo hướng dẫn bằng 

cách chọn những tùy chọn phù hợp rồi nhấn Next ở dưới cùng của hộp thoại, nếu 

muốn quay lại thì nhấn vào Previous.  

 Trong Bước 1, trình Wizard sẽ mở ra với một câu hỏi bạn muốn loại tài liệu nào 

để thực hiện mail merge như Letters (thư), E-mail messages (email), Envelopes (bao 

thư), Lebels (nhãn mác) hay Directory (Thư mục). 

h. Cách tạo tài liệu chính cho mail merge 

 Hãy thử click vào tuỳ chọn Envelope (phong bì), trong Bước 2 của Wizard để 

chọn kích thước và các tuỳ chọn in ấn cho phong bì của bạn. 
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 Bước thứ hai bắt đầu thiết lập tài liệu khởi đầu. Bạn có thể sử dụng tài liệu đang 

mở, thay đổi cách trình bày của tài liệu hoặc chọn tài liệu khác.  

 Chọn Change document layout, sau đó click vào Envelope options nếu bạn 

muốn thay đổi kích thước phong bì.  

 Chọn Start from existing document nếu bạn có một phong bì lưu trước đó mà 

bạn muốn sử dụng mail merge, nhưng màn hình của bạn hiện đang mở một mở tài liệu 

trống, chọn tùy chọn này là nơi để thay thế các tài liệu trống đó cho phong bì của bạn. 

 Chọn Use the current document có nghĩa bạn bắt đầu với một tài liệu trống.   

i. Kết nối đến danh sách người nhận 

 Bước 3: Bạn chọn danh sách người nhận có sẵn hoặc bạn có thể tạo một danh 

sách mới. Trong bước này, bạn kết nối với những danh sách thông tin người nhận mà 

bạn muốn trộn vào vào các tài liệu của bạn. Bạn có ba lựa chọn: 

 

 Chọn Use an existing list nếu bạn đã có một danh sách người nhận có chứa 

những thông tin bạn muốn hợp nhất, hãy chọn đường dẫn cho file danh sách này. 

Chọn Select from Outlook contacts nếu bạn đã có danh sách liên lạc trong Outlook. 

Sau đó chọn Choose Contacts Folder để xác định vị trí file.  

 Chọn Type a new list nếu bạn chưa có danh sách người nhận. Danh sách mới 

được lưu như là một cơ sở dữ liệu Access với kiểu file là (.MDB) trong thư mục My 

Data Sources, nơi mà tài liệu của bạn cũng như thư mục được lưu vào đó. Và bạn 

cũng có thể tái sử dụng lại cho những lần trộn thư sau này.   

 Cách tốt nhất là bạn nên lưu các file danh sách là trong My Data Sources hoặc 

trong thư mục My Documents để thuận tiện cho mail merge. Tuy nhiên, bạn cũng có 

thể kết nối với bất kỳ danh sách thông tin người nhận nào từ vị trí trên máy tính của 

bạn hoặc từ máy chủ.   

j. Chọn danh sách người nhận trong email của bạn 
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 Bạn có thể chọn, phân loại, lọc danh sách và thông mà bạn muốn trong tài liệu. 

Sau khi kết nối với danh sách người nhận, chọn danh sách những người bạn muốn gửi 

thư. 

 Bạn hãy làm tất cả trong hộp thoại Mail Merge Recipients, hộp thoại này sẽ tự 

động mở ra sau khi bạn kết nối hoặc tạo ra danh sách mới.  

1. Tất cả những người nhận đều có một dấu chọn gần bên tên của họ, bạn có thể xóa 

dấu chọn này cho từng người. 

2. Lọc danh sách người nhận bằng cách click Sort... để chọn tên cột mà bạn muốn 

xem lại và sắp xếp. Click Filter... để nhập tên trường hoặc các giá trị trong danh sách 

người nhận mà bạn muốn. Click Find duplicates… để chạy một báo cáo xem có sự 

trùng lặp trong danh sách danh sách hay không . Click Find recipient… để xem thông 

tin một người nhận nào đó. Đối với Validate addresses… thì bạn phải có một chương 

trình dò lỗi địa chỉ thì mới thực hiện được chức năng này. 

k. Sắp xếp tài liệu chính 

Có rất nhiều cách để bạn thay đổi bảng mục lục.  
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 Trong bước 4 bạn sắp xếp lại tài liệu có nghĩa là đặt nội dung vào tài liệu, nó 

bao gồm: 

 Thông tin còn lại trong mỗi copy đã merge.  

 Vị trí định sẵn - Placeholders (fields) cho thông tin người nhận trong mỗi bản 

sao đã được trộn.  

 Cách nhanh nhất thêm một địa chỉ là click Address block trong Wizard. Ban 

đầu nó sẽ thêm «AddressBlock» trên lá thư (envelope), bao gồm họ tên, địa chỉ, 

thành phố, tỉnh thành, mã bưu điện.  

l. Xem lại mail merge 

 Bước thứ 5: Bạn có thể xem lại kết quả thực hiện trước khi hoàn tất việc trộn 

thư. Trong bước này bạn vẫn có quyền thay đổi bằng cách thêm hay bớt các trường 

(field), hạn chế người nhận hay điều chỉnh lại thông tin. 

 

 Sau khi bạn thêm tất cả nội dung và field trong tài liệu, bạn có thể xem lại tài 

liệu được trộn sẽ trông như thế nào. Trong bước 5 này bạn sẽ có một số chọn lựa:  

 Nếu mọi thứ trông có vẻ không ổn thì click Previous để trở lại bước thứ 4 để 

bạn có thể thêm, xóa,... hoặc sửa lại thông tin cho đúng.  

 Nếu mọi thứ đều ổn, click 2 lần vào nút ở trên đầu cửa sổ Wizard để duyệt 

những trang tiếp như hình bên trên.  

 Nếu bạn muốn xem tài liệu đã được trộn của một người nhận cụ thể nào đó thì 

click Find a recipient. Khi bạn xem qua tài liệu, bạn có thể bỏ bất cứ người nhận nào 

trong danh sách bằng cách click Exclude this recipient.  

 Nếu bạn nhận ra rằng trong danh sách có một số người nhận mà bạn không 

muốn có thì hãy click Edit recipient list, hộp thoại Mail Merge Recipients sẽ mở ra 

để bạn có thể bỏ chọn một hoặc nhiều người nhận trong danh sách. 
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m. Bước thứ 6: Hoàn tất việc merge 

 Khi đã hài lòng với những tài liệu merge sau khi xem lại và bạn sẵn sàng in, 

click Print để mở hộp thoại Merge to Printer, nhập thông tin về số trang cần in, sau 

đó nhấn OK. 

 

 Trong bước thứ 6 này bạn cũng còn cơ hội để thay đổi: Nếu bạn vẫn muốn xem 

lại kết quả hoặc điều chỉnh một bao thư (envelopes) cụ thể nào đó, hãy click Edit 

individual envelopes, thì nó sẽ tạo ra một bản trộn riêng bao gồm tất cả bao thư trong 

một tài liệu Word mới. Sauk hi xem lại hoặc sửa chữa các bao thư với tài liệu mới 

này, bạn có thể in ấn chúng. 

 Hoặc bạn có thể lưu trữ tài liệu và sẽ in ấn sau. Nếu bạn muốn giữa lại những 

thay đổi bạn đã thực hiện với bao thư cụ thể nào đó, hãy chắc chắn rằng mình đã lưu 

trữ tài liệu này. File này sẽ được lưu độc lập với tài liệu chính. 

n. Giới thiệu mail merges bằng cách sử dụng Ribbon 

 Các lệnh trong Tab Mailings luôn sẵn sàng khi bạn thực hiện các bước trong 

trình wizard  

 Ribbon cũng là một cách hữu ích để tạo một Mail Merge và quá trình xử lý rất 

giống với các bước trong trình Wizard. Bằng cách sử dụng thanh Ribbon, bạn sẽ có 

thể truy cập vào nhiều tính năng hơn, chẳng hạn như tự động kiểm tra tìm lỗi trước khi 

bạn hoàn tất việc hòa trộn. Ngoài ra còn có những yếu tố nâng cao, chẳng hạn như sử 

dụng các trường để thể hiện các thao tác hoặc tính toán trong tài liệu. 
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Những lệnh bạn dùng trên Tab Mailings trong bốn nhóm sau: 

1. Start Mail Merge: Đây là điểm bắt đầu từ nơi bạn chọn một loại tài liệu và sau đó 

chọn, tạo, hoặc chỉnh sửa danh sách người nhận. 

2. Write & Insert Fields: Đây là nơi bạn có thể chèn các Merge Field và sử dụng 

Rules để thể hiện các thao tác tính toán cho tài liệu. 

3. Preview Results: Bên cạnh việc xem lại tài liệu đã hòa trộn, bạn có thể sử dụng 

tính năng kiểm tra lỗi một cách tự động. 

4. Finish: Hoàn thành merge và kết hợp các tài liệu cá nhân của bạn vào một tài liệu 

toàn diện, hay in chúng ra hoặc gửi thư điện tử. 
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PHẦN VIII: NHỮNG KỸ NĂNG CƠ BẢN 

1. Giới thiệu thanh Ribbon 

a. Thanh Ribbon 

 Office 2007 được thiết kế để giúp bạn làm việc tiện lợi và hiệu quả hơn. Trong 

hệ thống Office 2007 gồm Word 2007, Excel 2007, PowerPoint 2007, Access 2007 

và một phần Outlook 2007 có một tính năng quan trọng mới được đưa vào đó là 

thanh Ribbon nằm ngang ở trên cùng thay thế hệ thống menu (trình đơn) và toolbar 

(thanh công cụ). Thanh Ribbon xuất hiện giúp bạn xử lý các tác vụ dễ dàng và nhanh 

chóng hơn, bao gồm những phím tắt mới.  

 

 Tại sao phải thay đổi? Nhiều nghiên cứu đã được thực hiện để tìm hiểu cách mà 

người dùng sử dụng Microsoft Office, và họ mong muốn chương trình hoạt động như 

thế nào. Giao diện mới là kết quả của tất cả các cuộc nghiên cứu đó. Lệnh và các chức 

năng được nhóm lại với nhau theo cách mà người dùng sử dụng chúng. Vì vậy giờ đây 

bạn không phải mất công tìm kiếm trong khi làm việc, mọi thứ đều nằm ngay trong 

tầm tay của bạn. 

b. Có những gì trên thanh Ribbon? 

 Thanh Ribbon có 3 thành phần căn bản, sẽ rất có ích nếu bạn biết mỗi phần được 

gọi là gì và cách sử dụng chúng. 
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1. Tab (thẻ) có 7 Tab cơ bản nằm ngang phía trên, mỗi Tab đại diện cho một vùng 

hoạt động. 

2.  Group (nhóm) mỗi Tab bao gồm nhiều Group tập họp các đối tượng có liên quan 

mật thiết với nhau. 

3. Command (lệnh) mỗi Command có thể là một nút, một vùng để nhập nội dung 

hoặc một Menu (trình đơn). 

Thanh Ribbon tự điều chỉnh dựa trên đối tượng mà bạn đang làm việc để đưa ra các 

lệnh và thao tác phù hợp. Ví dụ nếu bạn làm việc với biểu đồ trong Excel thì thanh 

Ribbon sẽ hiển thị các lệnh liên quan tới biểu đồ. Nếu không, các lệnh này sẽ được ẩn 

đi. 

c. Có nhiều tính năng mới trong các chương trình sử dụng thanh Ribbon 

 

Các chương trình sử dụng thanh Ribbon có 2 tính năng mới: 

1. Nút Microsoft Office the thế trình đơn File và đó cũng là nơi bạn có thể tìm thấy 

các lệnh cơ bản như trong trình đơn File trước đây, bao gồm: Open, Save và Print 

cũng như các cài đặt của chương trình, chỉnh sửa các thuộc tính tính, v.v... 
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2. The sits above the Ribbon and contains the commands that you want to keep near at 

hand. By default, the Quick Access Toolbar contains the Save, Undo, and Repeat (or 

Redo) commands, but you can customize it with whatever commands you want. 

Quick Access Toolbar (thanh công cụ truy cập nhanh) chứa các lệnh mà bạn muốn 

xuất hiện thường trực. Mặc định, Quick Access Toolbar chứa các lệnh Save, Undo và 

Repeat (hoặc Redo). Tuy nhiên bạn có thể tùy biến thanh công cụ này để nó chứa bất 

cứ lệnh nào mà bạn muốn. 

d. Các loại phím tắt 

Có 2 cách để sử dụng phím tắt. Giả sử để in đậm một chữ bạn có thể sử dụng: 

 

1. Phím truy cập các Tab và lệnh trên màn hình. 

2. Tổ hợp phím không nằm trên thanh Ribbon. 

 Nhiều người cho rằng bất kỳ sự kết hợp của một tồ hợp phím nào dẫn đến việc 

thực thi một lệnh đều có thể gọi là phím tắt, về cơ bản thì đó là một cách nghĩ đúng. 

Nhưng trong bài này chúng ta sẽ có một định nghĩa chính xác hơn về phím tắt. Xác 

định sự khác biệt rất quan trọng vì từng loạt phím tắt khác nhau sẽ có phương thức 

hoạt động khác nhau.  

Access Keys (phím truy cập)  

 Access Key cho phép bạn truy cập thanh Ribbon, nó liên hệ mật thiết với các 

Tab, lệnh và những thứ mà bạn nhìn thấy trên màn hình. Bạn sử dụng Acces Key bằng 

cách nhấn Alt rồi sau đó nhấn tiếp một phím hoặc một chuỗi tuần tự các phím.  

 Mỗi lệnh trên thanh Ribbon, trong trình đơn của nút Microsoft Office và trên 

Quick Access Toolbar đều có một phím truy cập riêng, mỗi phím truy cập được gán 

một Key Tip. Key Tip là một phiên bản mới của hệ thống ký tự gạch chân mà bạn 



Tìm hiểu Microsoft Office 2007- Tập 1: Tìm hiểu Microsoft Word 2007 

 

Biªn So¹n: Niemtin071@yahoo.com 87 

 

quen thuộc ở các phiên bản trước khi muốn truy cập các trình đơn bằng cách sử dụng 

phím Alt.  

Key combinations (tổ hợp phím)  

 Các tổ hợp phím dùng để thực hiện một lệnh nào đó và nó không liên quan tới 

những gì bạn nhìn thấy trên màn hình. Các phím phải được nhấn cùng một lúc để kích 

hoạt các lệnh, trong đa số trường hợp, dù không phải tất cả, đều có liên quan tới phím 

Ctrl (ví dụ nhấn Ctrl + C để copy).  

 Tổ hợp phím không thay đổi trong phiên bản Office 2007, nó hoạt động giống 

hêt 5cac1 phiên bản trước.  

2. Duyệt thanh Ribbon bằng Access Key (phím truy cập) 

 

 Khi bạn muốn dùng bàn phím thay vì các thiết bị trỏ như con chuột để điều 

khiển thanh Ribbon và những thứ khác trên màn hình, trước tiên bạn phải bật chức 

nâm điều khiển bằng bàn phím. Nói cách khác bạn phải chuyển từ chế độ nhập liệu 

sang chế độ thực thi lệnh bằng cách nhấn phím Alt. Sau đó, bạn sẽ có rất nhiều tùy 

chọn để duyệt khắp thanh Ribbon.  

a. Key Tip và các biểu tượng hình khiên (Badges) 
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 Ngay khi bạn nhấn phím Alt, bạn sẽ thấy các nhãn nhỏ, hoặc khiên nhỏ hiện lên 

để chỉ ra Key Tip của từng Tab. Khi bạn nhấn phím để kích hoạt một Tab, các khiên 

nhỏ sẽ hiển thị Key Tip cho từng lệnh trong Tab đó. Nói cách khác, bạn chỉ thấy mỗi 

lần một nhóm Key Tip, và bạn phải nhấn một lựa chọn nào đó trước khi thấy nhiều 

hơn. 

 Key Tip là cách rất tuyệt để sử dụng phím tắt bởi bạn không cần phải ghi nhớ, 

mọi thứ đều hiển thị trên màn hình. 

b. Tìm hiểu thêm về Key Tip 

 

Hình bên trái: Trên Tab Insert Key Tip M được gán cho nút lệnh SmartArt. 

Hình bên phải: Trên Tab Page Layout Key Tip M được gán cho nút lệnh Margins. 

 Các Key Tip có thể trùng lặp trên các Tab khác nhau, trong ví dụ trên M là phím 

tắt cho SmartArt trong Tab Insert nhưng lại là phím tắt cho Margins trong Tab Page 

Layout. 

 Bạn chỉ có thể thấy và làm việc với Key Tip của Tab đang được kích hoạt. Nếu 

bạn lỡ chọn sai Tab thì chỉ cần nhấn Esc để hiển thị lại Key Tip cho Tab và chọn lại 

Tab mà bạn cần. 

 Lưu ý: Nếu có một hộp thoại đang mở dùng cùng một ký tự Key Tip với một 

Tab hoặc một lệnh trên thanh Ribbon, thì Key Tip của hộp thoại này sẽ được ưu tiên. 

c. Di chuyển bằng phím mũi tên 
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 Ngoài Key Tip bạn cũng có thể dùng phím mũi tên để duyệt thanh Ribbon. Đầu 

tiên bạn cũng nhấn phím Alt để chọn thanh Ribbon làm tiêu điểm, sau đó dùng các 

phím mũi tên để di chuyển: 

 Phím MŨI TÊN TRÁI và MŨI TÊN PHẢI để chuyển qua lại giữa các Tab.  

 Phím MŨI TÊN LÊN để chuyển tiêu điểm lên Quick Access Toolbar (từ đây 

bạn có thể dùng phím MŨI TÊN TRÁI để di chuyển sang nút Microsoft Office).  

 Phím MŨI TÊN XUỐNG chuyển bạn vào Tab đang kích hoạt và bạn có thể di 

chuyển tiệp trong đó bằng cách sử dùng phím mũi tên..  

 Một điểm tiến bộ so với phiên bản trước của Microsoft Office là bạn có thể di 

chuyển lên / xuống thay vì chỉ là trái / phải. 

d. Phím TAB và thanh Ribbon 

 Bạn cũng có thể dùng phím TAB để di chuyển quanh thanh Ribbon. Sau khi 

nhấn Alt để chọn thanh Ribbon, bạn hãy nhấn phím TAB liên tục để di chuyển qua 

các nút lệnh theo từng nhóm tại Tab đang kích hoạt. 

 

 Sau khi đi một vòng hết các lện trong Tab hiện tại, tiêu điểm sẽ được chuyển 

theo thứ tự nút Help, nút Microsoft Office, Quick Access Toolbar, các Tab và quay 

trở lại nhóm đầu tiên trong Tab hiện tại. 

 Nhấn Shift + TAB để di chuyển theo hướng ngược lại. Khi đến được lệnh mà 

bạn muốn, hãy nhấn ENTER. 

e. Di chuyển bằng phím F6 
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Hình 1 Nhấn F6 trong Outlook chọn xoay vòng giữa các thư mục trong danh sách: 

các thư mục hoạt động, xem trước các bảng, và To Do Bar.  

Hình 2 Đang nhấn F6 trong Word chọn xoay vòng giữa các tài liệu, mở bất kỳ các 

bảng, thanh trạng thái ở dưới cùng của cửa sổ, và các giao diện.  

 Bạn có thể đến được các vùng khác nhau của các cửa sổ chương trình bằng cách 

nhấn F6. Ví dụ trong Outlook, xem ở mục Mail, tiêu điểm di chuyển giữa các danh 

sách thư mục, mở thư mục, xem trước các bảng, và To Do Bar. Hình ảnh minh họa ở 

trên là hướng di chuyển xung quanh cửa sổ Outlook. 

 Trong các giao diện của các chương trình sử dụng Ribbon, F6 xoay vòng giữa tất 

cả các vùng của cửa sổ, bao gồm các bảng đang mở, thanh trạng thái và thanh Ribbon. 

Ví dụ, nếu muốn để phóng to tài liệu của bạn bạn hãy làm như sau: 

 Nhấn F6 cho đến khi những tiêu điểm được hiển thị trên thanh trạng thái.  

 Nhấn phím TAB hoặc mũi tên qua phải để di chuyển sang nút lệnh hình dấu +.  

Bấm phím ENTER.  

f. Quá quen thuộc với hệ thống phím tắt cũ? 

 Nếu bạn từng làm việc với Mocrosoft Office trong nhiều năm và là một chuyên 

gia về phím tắt, bạn thuộc lòng tất cả các phím tắt. Có thể bạn sẽ bối rối khi tất cả 

trình đơn và phím tắt cũ đã biến mất. Thực ra, thanh Ribbon và phím tắt mới cần có 

một ít thời gian để bạn làm quen nhưng một khi đã nắm bắt được bạn sẽ đánh giá cao 

nó. 
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 Nếu bạn vẫn không hài lòng và muốn trở lại với các phím tắt cũ thì đây là câu trả 

lời: hầu hết phím tắt cũ đều vẫn hoạt động. Tuy nhiên bạn phải nhớ chính xác vì giờ 

đây không còn nơi nào trên màn hình nhắc bạn cần phải nhấn phím nào. 

Đây là cách hoạt động:  

 Trong các phiên bản trước khi bạn nhấn Alt + E thì trình đơn Edit được mở lên 

và bạn nhấn tiếp các ký tự được gạch chân để truy cập các lệnh. Trong Office 2007 

khi nhấn tổ hợp Alt + E (hoặc các ký tự tắt khác) sẽ không có trình đơn nào mở ra. 

Thay vào đó, một thông điệp sẽ hiển thị cho bạn biết bạn đang dùng hệ thống phím tắt 

cũ. Nếu bạn nhớ tổ hợp phím tắt thì chỉ cần nhấn tiếp để thực hiện lệnh. Nếu bạn 

không nhớ, hãy nhấn Esc để hiển thị các Key Tip. 

3. Hãy chú ý đến máy tính của bạn 

 

 Có thể bạn không nhận ra nhưng máy tính của bạn đang bị đặt trong tầm ngắm. 

Không phải chỉ bạn mà tất cả máy tính khác cũng vậy. Có những người đang cố thâm 

nhập vào các máy tính nhằm tư lợi hoặc một mục đích nào đó. Bạn cần phải nhận thức 

được các đe dọa để bảo vệ máy tính của mình tốt hơn.  
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a. Các đe dọa an ninh 

 Có thể một số khái niệm đã quen thuộc với bạn như: virus, trojan, spyware, 

malware, lừa đảo qua mạng. Để bảo vệ máy tính của bạn tốt hơn, bạn cần hiểu các 

mối đe dọa trên là gì. 

 Hầu hết các đe dọa an ninh được biết đến như một phần mềm hoặc một đoạn mã 

độc hại (malicious software / code), các phần mềm này âm thầm điều khiển máy tính 

của bạn mà bạn không hay biết gì. Đa số các phần mềm độ được thiết kế để tự nhân 

bản và lây nhiễm sang các file hoặc các máy tính khác. Một trong các cách lây nhiễm 

là gửi một e-mail có chứa mã độc dưới tên bạn tới các địa chỉ liên lạc trong máy tính 

của bạn.  

 

 Những gì mã độc thực hiện trên máy của bạn phụ thuộc vào nó là dạng gì và tính 

phá hoại ra sao. Có thể nó chỉ tạo ra các thông điệp gây phiền toái hoặc thực sự gây 

tổn hại bằng cách xóa các dữ liệu và chương trình của bạn. 

 Đây là một số định nghĩa về các phần mêm độc, dựa vào đó bạn sẽ biết mình 

đang phái đối mặt với cái gì: 

 Virus Phần mềm hoặc đoạn mã có khả năng tự nhân bản. Một virus lây lan bằng 

cách đính kem nó vào một file hoặc chương trình khác.  

 Worm Phần mềm nhân bản bằng cách tự gửi bản sao của nó qua mạng. 

Trojan horse Phần mềm không gây hại nhưng nó sẽ lợi dụng các lỗ hổng hệ thống để 

mở đường cho một phần mềm khác (virus, worm...) tấn công máy tính của bạn. 

 Trojan horse Phần mềm không gây hại nhưng nó sẽ lợi dụng các lỗ hổng hệ 

thống để mở đường cho một phần mềm khác (virus, worm...) tấn công máy tính của 

bạn. 
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 Spyware Phần mềm thu thập thông tin cá nhân của bạn, hoặc chúng cũng có thể 

thay đổi các thiết lập hệ thống mà không thông qua bạn. Thường máy tính bị nhiễm 

Spyware khi truy cập các trang web không đáng tin cậy. 

 Phishing Một phương thức lừa đảo thông tin tài khoản, thường là thông qua 

email. Một số kịch bản lừa đảo nhằm cài Spyware vào máy tính của bạn. Tin tốt là 

Outlook 2007 đã được tích hợp hệ thống chống Phishing. 

b. Nguồn lây nhiễm 

 Các mã độc lây nhiễm vào máy tính của bạn bằng cách ẩn mình trong một thứ gì 

đó có vẻ vô hại. Chảng hạn như một file đính kèm trong email, một phần mềm tải từ 

Internet, một website mà bạn ghé qua, một file chia sẻ hoặc mạng máy tính, một đĩa 

mềm và thậm chí là một tài liệu Office. Cơ bản thì mọi thứ đến từ một máy tính khác 

đều tiềm ẩn rủi ro. 

 

Lưu ý  Đôi khi các mã độc không ẩn mình và tấn công một cách công khai. 

 Ngoài việc cẩn trọng trước các thông tin đến từ máy tính khác, bạn cũng nên cẩn 

thận khi ghé thăm các website có yêu cầu thông tin cá nhân, hãy xác định đó có phải 

trang web giả mạo không trước khi điền thông tin. Ví dụ bạn phải chắc rằng mình 

đang ở trang web chính thức của ngân hàng bạn mở tài khoản chứ không phải ở một 

trang có giao diện giống nó. 

 Một lưu ý khác là khi bạn lướt qua một trang web thực tế bạn đang tải về các file 

từ Server. Hãy chắc rằng trang web đó đáng tin cậy. 

c. Microsoft Update một cách để hạn chế rủi ro 

 Cách cơ bản nhất để tăng cường an ninh hệ thống là bảo đảm phần mềm tren 

máy tính của bạn luôn cập nhật. Microsoft thường xuyên phát hành các bản cập nhật - 
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thường xuyên. Khi một virus mới xuất hiện trên thế giới, nhà sản xuất phần mềm diệt 

virus thường tung ra bản cập nhật trong vòng vài giờ sau khi nhận diện virus. 

e. Một số thiết lập an ninh khác 

 

Có thể tổng kết các ước bạn cần thự hiện để tăng cường an ninh hệ thống như sau: 

Cài chương trình diệt virus và spyware.  

Sử dụng các mật mã phức tạp (gồm chữ, số và các ký tự đặc biệt như "&" "%" "$"...). 

Cài đặt tường lửa (Firewall) kiểm soát các luồng thông tin  

Thường xuyên sao lưu dữ liệu quan trọng  

f. An toàn cho email 

 Một khu vực nguy hiểm dê bị nhiễm virus nhất là email và các file đính kèm. 

Đôi khi chỉ cần mở một email cũng có thể kích hoạt virus. 

 Ngay cả khi đã cài đặt chương trình chống virus, một virus mới có thể xuất và 

nhà sản xuất chưa kịp cập nhật thông tin về nó. Vì vậy, hãy thận trọng với các file 

đính kèm đặc biệt là khi người gửi là hoàn toàn xa lạ (hoặc có thể là tên một người 

quen như nội dung không phù hợp), hoặc nếu tiêu đề và tên file đính kèm có gì đó bất 

thường.  
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 Lưu ý Outlook 2007 có các tính năng ẩn phòng chống virus trong file đính kèm. 

Ví dụ các loại file thường được dùng để phát tán virus sẽ tự động bị chặn . 

 Ngoài ra nếu bạn vẫn lo lắng về là thông tin bạn nhận được có thể chứa virus thì 

vẫn có một số cách hiệu quả ngoài việc dùng phần mềm. Chẳng hạn bạn có thể gọi 

điện cho người gửi để xác nhận xem có đúng họ đã gửi email cho bạn không hay 

email được gửi từ một kẻ mạo danh nào đó.  

  Lưu ý Đừng bao giờ mở các email và  file đính kèm đáng nghi trước khi bạn có 

thể xác minh thông tin người gửi. 

_The end_ 
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Bài 1: Giới thiệu về MS Word 

1) Vào phần mềm soạn thảo MS Word: 
Cách 1: Nếu khởi động máy xong trên góc phải cao nhất của màn hình có thanh biểu 
tượng Shortcut    ta         bấm vào   

Cách 2: Bấm vào nút lệnh Start ở góc trái dưới cùng → Prorgam → Tìm đến mục 
Microsoft Word. 

Sau khi vào Word nếu bạn chỉ cần động đến một phím là ký tự hoặc số bất  kỳ thì coi 
như bạn đã bắt đầu soạn thảo văn bản. 

2) Thoát khỏi MS Word: 
Nếu mới vào mà thoát ngay:   Bạn bấm vào biểu tượng dấu  ở góc cao nhất bên 
phải màn hình Word. 

Nếu đã soạn thảo: Bấm nút      bạn sẽ thấy xuất hiện hộp thoại yêu cầu ta chỉ ra thư 
mục chứa tập tin và đặt tên cho tập tin mà ta vừa soạn thảo. 

3) Giao diện màn hình của MS Word:T 

- Menubar : Thanh trình đơn, chứa các nhóm lệnh, mỗi nhóm lệnh ứng với một số 
tác vụ. 

- Standard Toolbar : Thanh công cụ, chứa các nút lệnh thực thi các tác vụ.  là mở 
mới một tập tin Word.  Mở một tập tin Word đã có.  Ghi lại tập tin đang soạn 
thảo, . . .  

- Formating toolbar: Thanh công cụ chứa các nút lệnh hoặc cửa sổ phục vụ cho việc 
định dạng văn bản.    cửa sổ Font chữ.     kích 
cỡ  chữ , . . . 

 

 

 

Menu bar 

Formatting toolbar 
 

Standard toolbar 
 

Vùng soạn thảo văn bản 
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4) Tạo mới một tập tin, lưu tập tin vừa soạn thảo: 
Khi vào MS Word, tiến hành soạn thảo văn bản, nếu muốn lưu văn bản đã soạn thảo 
bạn bấm biểu tượng       thì sẽ xuất hiện hộp hội thoại có chứa các thành phần sau: 

Hộp Save in.   Bấm vào hộp thoại và chỉ ra ổ đĩa và thư mục cần chứa tập tin. 

 

 

Hộp file name. Gõ vào tên tập tin. Nên đặt tên có tính gợi nhớ.  

 

 

Hộp save as type: chỉ ra kiểu tập tin cần lưu trữ, mặc định là tập tin dược lưu với 
phần mở rộng .doc. Bạn có thể lưu tập tin với  phần mở rộng .txt, . . . 

Sau khi thực các công việc trên bấm nút Save dể lưu lại tập thi   

5) Mở mới một tập tin đã có: 
 Bấm vào biểu tượng  Open trên thanh công cụ sẽ có hộp hội thoại xuất hiện, 
tìm ổ đĩa, thư mục chứa tập tin có từ tước đó, bấm chột trái để chọn tên tập tin 
cần mở, nhấn phím Enter để mở. 

 

 
 

 

 

 

 

 

 

 

 

 

Chọn ổ đĩa và tên  thư mục 

Chọn tên tập tin cần mở 
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Bài 2: Soạn thảo và định dạng văn bản. 

1) Gõ tiếng Việt trong giao diện MS Word: 
1. Bật biểu tượng Vietkey ở góc phải dưới cùng màn hình về chế độ gõ tiếng 

Việt, sao cho biểu tượng này là chữ V. Nếu biểu tượng này là chữ E  là đang 
ở chế độ gõ tiếng Anh. Nếu máy cài Vietware thì bấm chuột trái vào  biểu 
tượng Vietware phía dưới cùng bên trái của màn hình lên để chọn Kiểu gõ 
và Bảng mã của ký tự cần gõ. Đại đa số các văn bản mới hiện  nay đều quy 
định dùng mã Unicode. Anh (Chị) nên cài Vietkey hoặc Unikey. 

2. Có hai kiểu gõ tiếng Việt là kiểu gõ Vni và Telex. Bảng dưới đây sẽ chỉ rõ 
cách gõ các phím để được các chữ và dấu tiếng Việt: 

Chữ hoặc dấu tiếng  
Việt phải gõ 

Kiểu gõ Vni phải gõ 
cac phím sau 

Kiểu gõ Telex phải gõ 
cac phím sau 

â a và dấu ^ aa  

ă a và số 8 aw 

đ d và số 9 dd 

ơ o và số 7 ow 

ô o và dấu ^ oo 

ư  u  và số 7 w hoặc gõ uw 

ơ o và số 7 o và w 

ê e và dấu ^ ee 

dấu sắc  1 s 

dấu huyền 2 f 

dấu hỏi 3 r 

dấu ngã 4 x  

dấu nặng 5 j 

dấu của chữ ư,ơ 7 w 

 

Khi soạn thảo nên cố gắng sử dụng nhiều ngón tay để gõ. Ban đầu tuy có chậm,  
song rất có lợi khi đã soạn thảo quen, tốc độ soạn thảo nhanh hơn rất nhiều  so với 
gõ mổ cò từng ngón một. 
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2) Các thao tác trong màn hình soạn thảo MS Word: 
1. Di chuyển con trỏ: Ta có thể dùng chuột để chọn vị trí con  trỏ, ngoài ra  cũng có 

thể dùng bàn phím. Sau đây là cách di chuyển con trỏ dùng bàn phím: 

• Về đầu hàng: bấm phím Home. 

• Về cuối hàng bấm phím End. 

• Về đâu văn bản nhấn Ctrl và Home 

• Về cuối văn bản: nhấn  Ctrl và End 

• Nhẩy con trỏ từ đầu từ này về đầu từ khác: nhấn Ctrl  và  phím → hay← 

2. Khối chọn văn bản: khi văn bản đã được khối chọn thì các thao tác tiếp theo 
sẽ chỉ tác động lên khối văn bản đó mà không tác động lên phần văn bản 
khác. 

• Cách 1: bấm chuột trái, giữ nguyên và miết xuống kéo, chuột đi dến đâu 
là văn bản được bôi đen đến đó. 

• Cách 2: nhấn và giữ phím Shift  kèm theo bấm phím → (hoặc ←) 

3.  Thao tác với khối văn bản đã chọn: 

• Sao chép khối văn bản đã chọn: được thực hiện bằng cách chọn khối văn 
bản rồi nhấn phím Ctrl và phím ký tự C, sau đó chỉ chuột  đến vị trí mới 
nhấn Ctrl và phím ký tự V. 

• Cắt dán khối văn bản đã chọn: được thực hiện bằng cách chọn khối văn 
bản rồi nhấn phím Ctrl và phím ký tự X, sau đó chỉ chuột  đến vị trí mới 
nhấn Ctrl và phím ký tự V. 

3) Các thao tác định dạng khối văn bản đã chọn: 
1. Chọn Font chữ: Khối chọn văn bản cần thay đổi font chữ,  bấm tìm chọn kiểu 

font thích hợp trong cửa sổ font                                    của thanh công cụ định 
dạng. 

2. Chọn kích cỡ chữ (Font size):  Khối chọn văn bản cần thay đổi kích cỡ font chữ 
bấm tìm chọn kích cỡ font  thích hợp trong cửa font size                 của thanh 
công cụ định dạng. 

3. Làm đậm, nghiêng, gạch dưới văn bản: Khối chọn khối văn bản rồi bấm chuột 
trái vào các nút        để làm đậm,         để làm nghiêng,       để gạch dưới. 

4. Căn chỉnh văn bản về phía trái, giữa, phải hoặc đều hai bên: khối chon phần 
văn bản, bấm bấm chọn vào một trong các biểu tượng sau đây trên thanh 
công cụ điịnh dangj.  

Ta có thể sao chép định dạng bằng cách khối chọn khối văn bản mẫu ưng ý, bấm 
biểu tượng cái chổi trên thanh công cụ, chỉ chuột đến phần văn bản cần sao 
chép định dạng rồi bấm chuột trái và kéo miết chuột. 
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4) Định dạng đoạn  văn bản  (paragraph): 
Đoạn văn bản hay còn gọi là paragraph: là phần văn  bản giới hạn bởi hai lần gõ 
phím enter.  Khi định dạng theo paragraph thì việc định dạng có tác dụng lên toàn bộ 
paragraph đó. 

Mỗi khi gõ phím enter xuống hàng là Word tự động  chuyển sang một paragraph  
mới. Paragraph sau sẽ có định dạng giống  paragraph  trước đó.  

Giả sử có nhiều paragraph, mỗi  paragraph có định dạng khác nhau,ta có thể sao 
chép định dạng của paragraph này cho một paragraph khác. Cách làm là: đặt con trỏ 
vào paragraph mẫu, bấm chuột trái vào biểu tượng        sau đó chỉ chuột đến  
paragraph khác và bấm chuột trái thêm một lần nữa. 

Sau đây là cách tiến hành định dạng một paragraph. 

1. Đặt con trỏ vào một paragraph, vào mục menu Format chọn  mục paragraph. 

 

 

2. Chỉ định một số mục cho hộp thoại dưới đây: 

 

 

 

 

 

 

 

 

 

• General: hộp Alignment chỉ cách thức căn chỉnh cho paragraph .Left : căn 
trái; Right: căn phải, Centered: căn giữa, Justifield: căn đều hai bên. 
Hộp Outline level: chọn gán cho paragraph hiện hành mẫu mà phần 
mềm Word đã chuẩn bị sẵn. 

• Indentation: Chỉ ra độ dịch trái(Left) hay phải (Right) của paragraph. 
Riêng hộp Special có ba mục chọn. (none) văn pản trong  paragraph hiển 
thị bình thường, First line: chỉ dòng đầu tiên của paragraph  dịch trái so 
với các dòng khác bằng kích thước chỉ ra ở hộp By: 
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 Hanging: chỉ phần văn bản tính từ dòng thứ 2  của paragraph thụt vào 
bao nhiêu so  với dòng đầu tiên, kích thước thụt vào được chỉ  ra trong hộp 
BUy 

• Phần Spacing: 

• Before: chỉ ra khoảng cách paragraph hiện hành cách paragraph  
trên nó bao nhiêu điểm (point) 

• After chỉ ra khoảng cách paragraph hiện hành cách paragraph  
sau nó bao nhiêu điểm (point) 

• Phần Line spacing: chỉ ra khoảng cách giữa các dòng trong một 
paragraph. Có thể chọn khoảng cách này cụ thể bao nhiêu point tại 
hộp UA Ut 

 

 

 

 

 

5) Đánh số trang văn bản 
1. Vào menu Insert chọn mục Page Number, ta nhận được hộp thoại có cấu trúc 

sau. 

 

 

 

 

 

 

2. Chọn vị trí đánh số trang trong hộp Position, nếu chọn Bottom of page thì 
con số mà máy tính đánh số trang sẽ nằm ở phía dưới trang giấy, nếu chọn 
Top of page thì ngược lại. 

3. Chọn căn chỉnh vị trí của con số chỉ trang: Right thì số chỉ trang nằm bên 
phải, Left nằm bên trái, Center nằm ở giữa. 

4. Bấm OK để đồng ý. 
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6) Tạo tiêu đề đầu trang và cuối trang 
1. Vào menu  View chọn Header And Footer, xuất hiện thanh công cụ sau. 

 

 

2. Bấm chọn          để vào phần không gian soạn thảo tiêu đề đầu trang. Lúc này 
màn hình soạn thảo chính sẽ mờ đi, nhường chỗ cho công việc tạo tiêu đề 
trang. 

3. Tại vị trí con trỏ màn hình nhấp nháy, nhập phần văn bản cần xuất hiện trên mỗi 
tiêu đề của trang giấy. Bấm chọn nút lệnh          này một lần nữa để chuyển  

sang phần nhập tiêu đề cuối trang, tiến hành tiếp tục nhập văn bản tạo tiêu đề cuối 
trang. 

4. Bấm nút Close để chấm dứt công việc tạo tiêu đề cho mỗi trang in.  

• Tác dụng của mục lệnh: Insert Auto Text 

 

 

 

 

 

 

 
• Đánh số trang in: 

• Định dạng con số chỉ trang in: 

• Chèn ngày, tháng, năm hiện hành: 

• Chèn giờ, phút, giây hiện hành: 

• Định dạng trang in: 

 
Ở mức độ thông dụng ta chỉ cần tạo được tiêu đề đầu trang, cuối trang, đánh số trang in là đạt yêu cầu. 

 
------------------- ------------------- 

Đánh số trang 

Tác giả, Số trang, Ngày tháng năm 

Tên tập tin,đường dẫn nơi lưu trữ 
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Bài 3: Bullete, Numbering, Tab.  

1) Đặt biểu tượng hoặc số (Bullete And Numbering): 
Bullete, Numbering là các biểu tượng hoặc số dẫn đầu một đoạn  văn bản. Mỗi 
khi xuống hàng sang một đoạn khác thì các Bullete hoặc Numbering sẽ tự động 
được điền và cho mỗi đoạn.  

• Vào menu Format chọn mục         sẽ có hộp hội thoại 
xuất hiện. 

• Thẻ đầu tiên là Bullete. Trong thẻ này có các hộp, hộp chứa chữ 
None nếu được chọn sẽ không có Bullete dẫn  đầu, các hộp còn lại 
chứa các biểu tượng hình ảnh của Bullete. Nếu muốn thay đổi hình 
dạng của Bullete ta bấm nút Customize. 

• Thẻ kế tiếp là Numbering. Trong thẻ này có các hộp, hộp chứa chữ 
None nếu được chọn sẽ không có Numbering dẫn đầu, các hộp còn 
lại chứa các dạng số dẫn đầu của Numbering. Nếu muốn thay đổi  
Numbering ta bấm nút Customize. 

 

 

 

 

 

 

 

 

 

 

 

2) Kẻ đường viền và tô màu cho văn bản (Borders And Shading) 
• Khối chọn phần văn bản định kẻ đường viền hoặc tô màu. 

• Vào menu format chọn  Border and Shading, xuất hiện hộp hội thoại, ta 
chọn thẻ Border, mặc định  là None. Bấm chọn biểu tượng         
hoặc    
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•  Chọn mẫu đường viền trong hộp. 

• Muốn tô màu nền ta chọn thẻ Shading. Mặc định là No Fill, tức không tô 
màu nền. Ta có thể chọn một trong các màu nền đã cho mẫu sẵn và nhấn 
nút OK.  

 

3) Đặt Tab 
Trên bàn phím có phím Tab, phím này chỉ điểm dừng của  con trỏ. Khi nhấn Tab thì 
con trỏ sẽ nhảy đến vị trí do ta chỉ định khoảng cách cho phím Tab đó.  Các loại Tab 
gồm  là Tab căn trái,      Tab căn phải,       Tab căn giữa,      Tab căn lấy chuẩn là 
dấu phân cách phần thập phân. 

Ta có thể đặt các điểm dừng cho phím Tab này và chỉ định các ký tự dẫn trước Tab 
hoặc cách căn chỉnh văn bản dựa trên vị trí của Tab. 

 Cách đặt tab trên thước: 
• Bấm chọn biểu tượng Tab trên thước là Tab trái, phải, giữa,... rồi chỉ 

chuột vào vị trí cần đặt Tab trên thước,  bấm phím trái. Trong hình vẽ 
dưới đây lúc này ta đã đặt được 2 Tab có bước nhảy là 4 cm và 11.5 
cm. 

 

• Muốn gỡ bỏ Tab trên thước ta chỉ chuột trái vào biểu tượng Tab trên 
thước muốn bỏ, nhấn và giữ nguyên chuột trái kéo ra ngoài màn hình 
đang soạn thảo. 

Cách đặt ký tự dẫn trước tab: 
Vào mục Format trên thanh menu, chọn mục Tab, thực hiện theo chỉ dẫn: 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Chọn Tab qua kích thước Tab 

Chọn loại ký tự dẫn trước là ..... 

Nhấn Set và OK để đặt, nhấn Clear để xoá 
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Bài 4: Định dạng văn bản theo khuôn mẫu (Style) 
Styles là một tập hợp các định dạng về Font chữ, Paragraph,Tab, Bullete, cách trình 
bày, ...do người soạn thảo văn bản đã chuẩn bị từ trước. Nó như là một bộ mẫu, 
khi đã có đoạn văn bản mới soạn thảo, chỉ cần gán đoạn văn bản này cho Style 
đã chuẩn bị thì đoạn văn bản sẽ được định dạng như Style này.  

Mục đich của định dạng văn bản theo Style là để có một văn bản định dạng theo 
một số mẫu thống nhất, quá trình định dạng tiến hành nhanh chóng. 

Mỗi một Style có một tên gọi, ta có thể tạo mới và đặt tên một Style do ta tạo ra. 
Word phân biệt bốn loại Style. Character Style : khuôn mẫu ký tự, chỉ có tác động 
lên văn bản đã chọn. Paragraph Style: khuôn mẫu đoạn, tác động lên toàn bộ đoạn 
văn bản. Mọi định dạng do ta thiết lập cho Style mẫu đều có tác dụng lên đoạn văn 
bản mà ta gán. Table Style: khuôn mẫu phục vụ cho định dạng Table. List Style:  
khuôn mẫu phục vụ cho tạo các danh sách. 

Mặc định khi ta tạo một văn bản mới thì MS Word sẽ có sẵn một số Styles, và 
dòng văn bản đầu tiên khi ta gõ sẽ được định dạng theo Style có tênlà Nomal.  

1) Cách  tạo một  style (khuôn mẫu ) 
1.  Vào menu Format chọn Styles And Formating hoặc bấm nút bên phải của 

thanh định dạng           sẽ xuất hiện hộp hội thoại bên phải màn hình soạn 
thảo.  

2. Bấm nút New Style sẽ ra hộp hội thoại. Gõ vào tên Style mới do ta đặt sao 
có tính gợi nhớ trong hộp Name. 

 

 

 

 

 

 

 

 

 

 

 

 

Gõ vào tên Style 

Lựa chọn các định dạng 

Định dạng chi tiết 
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3. Lựa chọn kiểu trong hộp Style Type. Mặc định  nó là Style áp dụng cho 
đoạn văn bản (paragraph). 

4. Chon kiểu Style có trước đó trong hôpk Style Base on để sửa hành 
Style mới. 

5. Chọn Style kế tiếp sẽ đáp ứng trong hộp khi chuyển sang một 
paragraph khác Style following paragraph. 

6. Tiến hành định dạng cho Style vừa tạo trong các của sổ của hộp Format: 
chọn Font chữ     ,kích cỡ chữ,  độ đậm,   ,  

 nghiêng , khoảng cách giữa các dòng       , khoảng cách giữa   

 đoạn này và đoạn trước, sau nó        ,...Ta cũng có thể bấm nút   

 Format để tiến hành định dạng chi tiết. 

Có thể sửa lại định dạng của các Style có sẵn hoặc Style hiện hành trong của sổ 
Style And Formating. Muốn vậy chỉ chuột vào Style cần sửa chữa định 
dạng, bấm chuột phải vào tên Style đó, vào Modify. Lúc này màn hình sẽ 
xuất hiện hộp thoại, chọn Format để vào phần định dạng chi tiết.   

Bấm nút Font để định dạng Font chữ, Paragraph để định dạng cho đoạn đó, 
Tab để đặt Tab, Frame để kẻ khung, Numbering để đánh số,... 

Sau khi định dạng xong ta chỉ cần gán tên Style cho bất kỳ đoạn văn bản nào mà 
ta muốn nó có định dạng giống khuôn mẫu mà ta đã tạo. 

 

 

 

 

 

 

 

2) Sử dụng một Style: 
1. Đặt con trỏ vào đoạn văn bản (paragraph). 

Tên Style mới

Các Style mặc định 

Chọn các loại 
dể định dạng 
chi tiết 



Word 2002 

   77  

2. Chọn tên Style, văn bản sẽ được định dạng như mẫu. 

3) Định nghĩa lại Style có sẵn: 
1.  Vào menu Format chọn Styles And Formating hoặc bấm nút bên phải của thanh 

định dạng           sẽ xuất hiện hộp hội thoại bên phải màn hình soạn thảo.  

2. Bấm nút phải chuột vào tên Style → chọn Modify → tiến hành sửa lại định dạng 
trong các mục mà hộp thoại chỉ dẫn→ nhấn nút OK. 

4) Xóa bỏ một Style: 
1.  Vào menu Format chọn Styles And Formating hoặc bấm nút bên phải của 

thanh định dạng           sẽ xuất hiện hộp hội thoại bên phải màn hình soạn 
thảo.  

2. Bấm nút phải chuột vào tên Style → chọn Delete → xác nhận việc xóa bằng 
việc nhấn nút Yes. 

Bài 5: Tạo bảng (Table). 
Một bảng biểu (table) là một hình chữ nhật gồm có nhiều dòng (rows) và nhiều cột 
(columns). Phần giao của một dòng và một cột được gọi là ô (cell). Ngoài ra trên một 
trang cũng có thể chia thành một vài cột giống như cột báo, việc này đôi khi cũng rất 
cần cho việc trình bày hoặc soạn giáo án. 

1) Cách  tạo bảng biểu: 
1. Đặt con trỏ tại vị trí muốn tạo bảng. 

2. Vào menu Table bấm chọn Insert, sau đó chọn Table, ta nhận được hộp hội 
thoại. 

 

 

 

 

 

 

3. Gõ vào số lượng cột trong hộp Number of columns. 

4. Gõ vào số lượng dòng trong hộp Number of rows. 

5. Chỉ định độ rộng của các cột trong hộp Fixed of column width. 

Gõ vào số cột 

Gõ vào số dòng 
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Nếu Fixed column width và Auto thì bảng tự động điền vào giữa hai ranh giới lề, 
kích thước các cột đều nhau. Nếu là Autofit to contents thì tự động cột sẽ bao 
lấy nội dung văn bản chứa trong nó. Nếu Autofit  Windows được chọn thì bảng 
sẽ thu gọn sao cho nằm trong cửa sổ trình duyệt trang WEB. Nếu hộp kiểm tra 
Remember demension …đựợc đánh dấu thì những chỉ định hiện tại sẽ  được áp 
dụng cho lần tạo bảng sau. 

6. Bấm nút OK 

Ngoài cách dùng trình thanh đơn chỉ định cụ thể việc tạo bảng ta còn có thể áp 
dụng theo cách sau: bấm chột trái  vào nút           trên thanh công cụ, giữ nguyên và 
quét chọn số cột cần tạo. 

2) Các thao tác cần thiết khi tạo bảng: 
1. Chèn thêm cột: bấm chuột trái lên đường biên của dòng kẻ trên cùng sao cho 

con trỏ có hình dạng mũi tên ↓ và bấm chuột trái để chọn đánh dấu cột đó. Vào 
menu Table chọn Insert → Table → Column to the Left để chèn cột mới bên trái 
cột đã chọn. 

 

 

 

 

 

 

 

2. Xóa cột: bấm chuột trái lên đường biên của dòng kẻ trên cùng sao cho con 
trỏ có hình dạng mũi tên ↓ và bấm chuột trái để chọn đánh dấu cột đó. Vào 
menu Table chọn Delete → Table → Columns để xóa cột đã chọn. 

 

 

 

 

 

 

3. Thêm hàng, xóa hàng : Thực hiện tương tự như cột nhưng tthay vì ta chọn 
Column thì ta chọn Rows. 

4. Chia một cột, hàng, ô thành nhiều cột, hàng, ô: 
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Vào menu Table, chọn Draw Table ta thấy xuất hiện thanh công cụ Table and 
Border, bấm chọn biểu tượng bút vẽ → chỉ chuột vào ô hoặc cột cần chia → 
bấm chuột trái kéo. Sau đó lại bấm vào bút để rời bỏ việc chọn bút.  

Ngoài ra ta có thể không dùng bút để chia. Thay vì bấm vào bút ta bấm chuột 
trái vào biểu tượng        Split Cell, sau đó ta sẽ nhận được hộp thoại  

dưới đây. Ta nhập vào ô Number of columns một số chỉ số lượng cột, 
Number of rows một số chỉ số lượng hàng, bấm OK 

 

 

 

 

 

5. Trộn nhiều cột, hàng, ô thành một  ô: 

Khối chọn các ô, cột hoặc hàng lại → Vào menu Table, chọn Draw Table ta thấy 
xuất hiện thanh công cụ Table and Border, bấm chọn biểu tượng merge cells  

6. Căn chỉnh văn bản trong bảng: Trước hết ta khối chọn phần văn bản và chỉ 
chuột vào nút         sao cho xuất hiện hình ảnh biểu thị cách căn chỉnh.  

Sau đó ta bấm chọn cách căn: đỉnh, đáy, trái, phải, ....sao cho vừa ý. 

7.  

 

8.  

 

 

Bài 6: Soạn thảo văn bản dạng cột báo. 

1) Cách chia văn bản thành cột 
1. Nhập nội dung phần văn bản. 

2. Khối chọn phần văn bản cần chia cột. 

3. Vào menu Format chọn Column. 

4. Chọn số cột thông qua biểu tượng số cột, hoặc có thể gõ nhập số cột trong hộp 
Number of column. (Xem hình vẽ) 

Căn đỉnh, trái 

Căn giữa 

Trộn 
một 
thành 
nhiều 

Đổi 
chiều 
chữ  

Tính 
tổng  
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5. Nếu cần đường phân cách giữa các cột ta bấm chọn vào hộp Line between. 

(ta cũng có thể bấm chọn vào biểu tượng Column trên thanh công cụ) 

 

2) Các thao tác cần thiết khi làm việc với cột: 
1. Thay đổi kích thước của cột bằng cây thước: 

• Nếu chưa có cây thước trên màn hình thì vào menu View chọn mục Ruler. 
Cây thước có hình dáng như sau: 

 
 

• Rời con trỏ chuột đến các vị trí                    bấm và giữ nguyên chuột trái  
kéo mở rộng hoặc thu hẹp cột. 

2. Đặt ngắt cột 

• Đặt con trỏ vào vị trí muốn ngắt cột, vào menu Insert, chọn Insert Break. 

• Chọn Column Break, lúc này phần văn bản kể từ dấu nháy sẽ được mang 
sang cột mới. 

3. Con trỏ đang ở vị trí văn bản nhiều cột chuyển về dạng một cột bình thường để 
tiếp tục soạn thảo: 

• Đặt con trỏ vào vị trí của dòng cuối cùng của cột cuối cùng, vào menu 
Insert chọn Break. 

• Chọn Continuous, và bấm  vào nút Column trên thanh công cụ chọn biểu 
tượng 1 cột. 
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Bài 7: Chèn các đối tượng vào văn bản. 
Không phải mọi ký tự, dấu hiệu cần thiết cho việc soạn thảo và trang trí văn bản 
đều có sẵn trên bàn phím, MS Word để riêng các dấu hiệu và các ký tự đặc biệt này 
(Symbol) và cho phép chèn vào văn bản. Các dấu hiệu. 

Cách  chèn ký tự, dấu hiệu đặc biệt (Symbol) 
1.  Tại vị trí muốn chèn vào menu Insert chọn  mục Symbol, sẽ xuất hiện hộp 

hội thoại. 

 

 

 

 

 

 

2. Lựa chọn biểu tượng của Symbol cần chèn và bấm Insert, sau đó bấm 
Close. 

Cách  chèn hình ảnh (Picture): 
1. Vào menu  Insert  → Picture → Clip Art. 

 

 

 

 

2. Bên tay phải màn hình sẽ xuất hiện hộp thoại, ta chọn Clip Organizer ở cuối 
màn hình, sau đó xuất hiện tiếp một màn hình khác, chọn  Office Colections, 
chọn tiếp danh mục phân nhóm hình ảnh, lựa chọn hình ảnh, nhấn Ctrl + C 
dể sao chép, đóng lại giao diện này, nhấn Ctrl + V để dán ảnh ra màn hình 
soạn thảo. Ngoài ra ta có thể bấm nút Search để thấy các hình ảnh, bấm 
chọn ảnh đó. 

Ta cũng có thể chèn tập tin ảnh hoặc nối tập tin Word lưu trữ ở một thư mục nào đó  
vào văn bản đang soạn thảo bằng cách chọn mục File → tìm đến File cần chèn →  
bấm Insert. 

 Định dạng hình ảnh (Picture): 
Sau khi có hình ảnh chèn vào văn bản, thông thường hình ảnh thường có kích 
thước lớn, nằm độc lập với văn bản, ta phải tiến hành định dạng lại hình ảnh. 



Word 2002 

   82  

1.  Bấm chuột phải vào hình ảnh, chọn Format Picture, ra tiếp hộp thoại cho 
phép ta định dạng ảnh. 

2. Chọn mục Layout để định dạng vị trí ảnh so văn bản thông qua các biểu 
tượng In Line with text (nằm riêng trong văn bản, chiếm một số dòng), 
Square (năm riêng trong văn bản nhưng chiếm diện tích hình vuông), 
Tigth (Năm riêng, song văn bản được điền sát với ảnh), Behind Text 
(nằm sau ảnh), In font of text (năm trước) 

 

 

 

 

 

 

3. Sau khi định dạng vị trí xong ta định dạng đường bao cho ảnh: Chọn thẻ 
Color and Lines. Thông thường ta chỉ nên chọn mục Line (đường 
thẳng bao xunh quanh ảnh), Style (mẫu đường bao lớn hay nhỏ), Color 
(màu sắc của đường bao) 

 

 

 

 

 

Tạo ký tự dạng Drop Cap 
Để trang trí cho một đoạn văn bản ta có thể tạo một ký tự lớn, định dạng đặc biệt, 
ký tự này được định dạng riêng kiểu Drop Cap. Cách thức định dạng ta làm như sau: 

1. Khối chọn ký tự đó lại, vào menu Format, chọn Drop Cap, ta nhận được hộp 
thoại như sau: 

2. Chọn một trong hai kiểu Drooped: ký tự ở đầu đoạn, chiếm một vị trí hình 
vuôn, hoặc In margin: ký tự năm riêng ngoài đường biên của văn bản. 

Chọn tương quan giữa 
ảnh và văn bản 

Chọn màu sắc đường bao 
và mẫu đường bao 
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Chọn Font chữ trong hộp Font. 

 

 

 

 

 

 

 

3. Chọn số dòng mà ký tự chiếm chỗ trong hộp Line to drop. 

4. Chọn khoảng cách từ ký tự này vào văn bản trong hộp Distance from text 

Tạo chuỗi ký tự Word Art: 
1. Vào menu  Insert  → Picture → Word Art, 

ra hộp hội thoại WordArt Gallery, chọn 
kiểu chữ, nhấn OK, ta nhận được hộp 
thoại tiếp theo. 

2. Gõ vào văn bản thay thế cho chữ Your 
Text Here, tiến hành định dạng Font chữ, 
Kích cỡ chữ, ....bấm nút OK. 

3. Định dạng đối tượng Word Art giống như định dạng cho hình ảnh: chọn đối 
tượng này,bấm phải, vào menu 
Format Word Art, tiến hành dịnh 
dạng. 

Nối tập tin Word vào cuối văn bản hiện hành: 

Ta có thể nối một tập tin văn bản MS Word khác vào cuối của tập tin đang soạn 
thảo. Thông thường ta nối hai tập tin có khuôn mẫu định dạng (Style) giống nhau 
là tốt nhất. Cách thức thực hiện: 

1. Đặt con trỏ vào cuối của tập tin. 

2. Vào Menu Insert chọn mục File, ta nhận được hộp thoại. 

 

Tạo hộp văn bản (Text Box): 
 

Kiểu dáng của chữ dạng Dropcap 

Định dạng Font chữ 
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Chú 
thích 

3. Bấm vào hộp Look In dể tìm đến thư mục chứa tập tin đó. 

4. Lựa chọn tập tin có trong thư mục đó. 

5. Nhấn nút Insert để nối. 

Tạo hộp soạn thảo văn bản dạng Text Box: 
Text Box là một đối tượng có thể nhập vào văn bản, định dạng văn bản đã nhập, 
đem chèn vào văn bản đang soạn thảo giống như một đối tượng độc lập. Sau khi 
soạn thảo xong ta có thể di chuyển đi bất cứ vị trí 

1. Vào menu Insert → Text Box, con trỏ sẽ có hình dạng dấu cộng, sẵn sàng cho ta 
tạo một hộp văn bản mới. 

2. Chỉ chuột vào màn hình soạn thảo, bấm phím trái, giữ nguyên rồi kéo miết 
chuột. Ta nhận được một đối tượng có  đường bao và trong đó có con trỏ 
chờ nhập văn bản. 

3. Nhập và định dạng văn bản bình thường. 

4. Định dạng đối tượng Text Box: bấm chuột phải vào đối tượng, vào Format 
Text Box. Ta dịnh dạng Text Box giống như dịnh dạng đối tượng hình ảnh. 

Sử dụng các chức năng của thanh Drawing: 
Bật thanh công cụ Drawing: Vào menu View → Toolbars → Drawing. Thanh này thông 
thường nằm ở dưới đáy màn hình. Muốn tắt thanh Drawing ta làm lặp lại như vậy 
một lần nữa. 

1. Hộp Draw:nằm ở bên trái nhất của thanh Drawing, chứa các mục liên quan 
đến việc định dạng đối tượng đã vẽ. 

2. Hộp AutoShapes: chứa các đối tượng có thể soạn thảo văn 
bản trong nó, thích hợp với tạo các phần chú thích. Muốn 
thực hiện ta lựa chọn lấy một đối tượng, bấm chuột trái ra vùng 
cần tạo AutoShapes. Bấm chuột phải vào nó, chọn Add Text hoặc 
Edit Text để thêm phần văn bản trong  AutoShapes. 

3. Vẽ đường thẳng, hình chữ nhật, hình elip, hình tròn, được 
thực hiện qua việc chọn vào một trong các biểu tượng (hình vẽ 
bên). Muốn vẽ ta bấm chọn nó, chỉ chuột ra vùng muốn vẽ bấm 
trái và kéo miết chuột. 

4. Tiến hành định dạng: thực hiện giống như đối tượng Text Box hoặc hình ảnh 
đã học. 

Tạo công thức toán học: 
1. Điều kiện cần thiết: MS Word phải dược cài đặt thành phần phần mềm 

MathType. 
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2. Thực hành: đặt con trỏ tại dòng cần nhập công thức vào mục menu 
MathType bấm chọn nút Insert Inline Equation    , sẽ xuất hiện màn hình 
mới của chương trình phần mềm MathType → lựa chọn một mẫu nhóm 
công thức → chọn dạng công thức và tiên hành nhập công thức. Sau khi 
soạn thảo song thì đóng lại màn hình MathType và bấm Yes để lưu lại công 
thức vừa nhập. 

 

 

 

3. Ví dụ: 
m

n
y x d x= ∫ . Đầu tiên ta bấm chọn                   một trong   

các biểu tượng có dạng như công thức muốn nhập, màn hình soan 
thảo sẽ có dạng công thức và con trỏ chuột nhấp nháy chờ ta nhập 
liệu, bấm chuột vào từng khu vực muốn nhập, tiến hành nhập                                
, đóng lại màn hình MathType, bấm Yes để đưa công thức đã nhập 
vào văn bản. 

4. Tiến hành định dạng đối tượng công thức vừa nhập: Công thức là một dối 
tượng riêng được nhúng vào trong MS Word, việc định dạng giống với định 
dạng hình ảnh. 

Bài 8: Định dạng trang văn bản, In ấn văn bản 
Thông thường ban đầu ta chỉ nhập nội dung văn bản, chưa quan tâm đến văn bản in 
ra loại giấy khổ như thế nào, văn bản nằm ngang hay nằm dọc trang in, lề tính từ 
biên của tờ giấy in vào phần văn bản. Lúc in phải chỉ định cụ thể loại máy in, trang 
in, số bản copy,... 

Định dạng trang văn bản: 

1. Vào menu File chọn  mục Page Setup, sẽ xuất hiện hộp hội thoại. 

 

 

 

 

 

 

 

 

Định dạng lề 

Chọn hướng in cho giấy 
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• Bấm chọn thẻ Margin để định dạng lề: nhập kích thước vào các hộp sau. hộp kích thước  Top 
chỉ phần lề từ mép trên đỉnh tờ giấy xuống phần văn bản. Hộp Bottom chỉ phần lề từ mép đáy tờ 
giấy lên phần văn bản. Hộp Left chỉ phần lề từ mép trái tờ giấy đến phần văn bản. Hộp Right chỉ 
phần lề từ mép phải tờ giấy đến phần văn bản. 

• Trong thẻ Margin  có phần Orientation để chọn hướng tờ giấy in: chọn Portrait để in theo 
hướng thẳng đứng của tờ giấy, Landscape in theo hướng ngang của tờ giấy. 

Các hộp còn lại thông thường để ở chế độ mặc định. 

2. Bấm thẻ Page để chọn các thông số liên quan đến giấy in: 

 

 

 

 

 

Chọn khổ giấy in trong hộp Page size. Thông thường có hai khổ giấy hay 
gặp, khổ A4 kích thước chiều cao (Height) 297mm , chiều rộng (Width) 210 
mm. Khổ giấy A3 kích thước gấp đôi khổ A4. Các hộp còn lại thông thường 
để chế độ mặc định 

3. Bấm nút Default để xác định từ đây về sau các trang giấy sẽ định dạng theo 
chế độ vừa xác lập, bấm OK để hoàn tất việc định dang trang in. 

In ấn văn bản: 

Để in ấn được văn bản trước hết phải có máy in, máy in phải được cài đặt với 
máy tính để máy tinh nhận dạng được loại máy in này. Việc cài đặt máy in được 
tiến hành thông qua một đĩa CD chứa chương trình cài đặt máy in đó. 

Có hai loại máy in: máy in phun, máy in laser. Máy in phun thông thường dùng 
bình mực ướt, có thể in được màu, mực in giá thành cao. Máy in laser dùng mực 
bột khô, đầu  tư ban đầu lớn nhưng giá thành cho một trang in thấp. 

Ta chỉ in văn bản khi đữ tiến hành soạn thảo và định dạng xong văn bản. Các 
thao tác in tiến hành như sau: 

1. Vào menu File chọn Print ta nhận được hộp thoại (xem trang  kế) 

2. Hộp Printer chỉ các thông số liên quan đến máy in. Nếu máy tinh chỉ cài đặt một 
máy in thì trong hộp Name chứa tên của loại máy in đã cài đặt. Nếu máy tinh 
cài đặt nhiều loại máy in thì ta chọn loại máy in nào đang nối trực tiếp với 
máy tinh.  
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3. Hộp Page Range có 3 nút. Nút All nếu được trọn sẽ là in tất cả các trang có 
trong văn bản. Current Page là in trang hiện tại con trỏ màn hình đang 
đứng. Pages là chỉ dịnh cụ thể in trang số mấy. Nếu nhập 3 là in trang số 3, 
nhập 3-5 thì in từ trang 3 đến trang 5. 

4. Hộp Copies chỉ số bản in cho mỗi trang in. Mặc định là 1 bản cho mỗi trang in. 

Lưu ý: Trường hợp trên chỉ áp dụng cho việc chỉ định in cụ thể, văn bản có nhiều 
trang. Trong trường hợp văn bản có một trang thì ta không cần chỉ định thông số in 
theo cách trên mà bấm trực tiếp vào biểu tượng chiếc máy in trên thanh công cụ.  
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Bài tập 1: Nhập và định dạng văn bản. 
Anh (Chị) hãy nhập và định dạng văn bản theo mẫu sau đây: 
 
 
 

TNgười sử dụng sẽ được lợi gì 
khi dùng tên miền tiếng Việt. 

 
 Trong thời gian tới, Trung tâm Internet Việt Nam (Vnnic) phối hợp với 
VietKey Group sẽ triển khai việc đăng ký tên miền trên font chữ tiếng Việt. Hệ thống tên 
miền này sẽ giúp người không biết tiếng Anh sẽ có thể dễ dàng truy cập các trang web 
bằng tiếng Việt. Đồng thời giảm thiểu được nguy cơ gây tranh chấp tên miền. Hơn thế 
nữa, giờ đây  người dùng còn có được địa chỉ email hoàn toàn đúng với tiếng Việt có dấu 
của mình. 
 Phần mềm plug – in xử lý tên miền tiếng Việt do VietKey Group phát triển cho 
trình duyệt Internet Explore (IE 5, 6, chương trình e–mail, ourlook express trên các hệ 
điều hành Window 2000, XP, ME, 98). Phần mềm này cho phép sử dụng tên miền tiếng 
Việt, với các tính năng truy cập trang web, bookmark, history, URL Link trên trình duyệt.  
 
 Ví dụ: một công ty có tên là Nhà đất Hà Nội giờ đây đã có thể đường hoàng đăng 
ký tên miền quốc gia bằng tiếng Việt có dấu là Uwww.nhàđấthànội.com.vn Uthay vì chỉ là 
TUwww.nhadathanoi.com.vnUT 
 
 Trong giai đoạn một, bắt đầu từ tháng 10/2003, Vnnic đã phối hợp thử nghiệm 
tên miền tiếng Việt với các ISP để đánh giá hệ thống. Trong thời gian thử nghiệm có 150 
chủ thể đăng ký. Ở giai đoạn hai, Vnnic sẽ cho người dùng đăng ký thử nghiệm tên miền 
tiếng Việt, thời gian thử nghiệm là 6 tháng. Một kế hoạch chính thức đã được đệ trình lên 
Bộ BCVT duyệt và áp dụng trong thời gian tới 
 
       (Theo PC World tháng 11/2003) 
 
UYêu cầu: U Nhập đúng tiếng Việt, chọn đúng Font chữ kích cỡ chữ. Sau đây là mẫu font 
chữ: 
 
 Mẫu :     Font chữ   Kích cỡ chữ: 
TUwww.nhadathanoi.com.vnUT  Arial    10 
Trung tâm Internet   Letter Gothic  12 
miền tiếng Việt   Courier New  16 
VietKey Group   Times New Roman  12 
Nhà đất Hà Nội    Times New Roman  12 
Theo PC World   Euclid    10 
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Bài tập 2: Tạo bullete, numbering. 
 Anh (Chị) hãy nhập và định dạng văn bản theo mẫu sau đây: 
 
@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@ 
 
I.   HÀM SỐ LƯỢNG GIÁC. 
 1.   Góc và cung lượng giác. 

  ►   Đơn vị đo góc và cung. 
      ●  Độ 
      ●  Rađian 
      ●  Độ dài một cung tròn. 
  ►   Góc luợng giác. 
   ●  Mở rộng khái niệm góc. 
   ●  Định nghĩa góc lượng giác. 
      ●  Số đo của góc lượng giác. 
  ►   Đường tròn lượng giác. 
   ●  Định nghĩa. 
   ●  Biểu diễn cung lượng giác trên vòng tròn lượng giác. 
 2.   Các hàm số lượng giác. 

 3.   Sự biến thiên và đồ thị của các hàm số luợng giác. 

 4.   Công thức lượng giác. 

II.   PHƯƠNH TRÌNH VÀ HỆ PHƯƠNH TRÌNH LƯỢNG GIÁC. 
 1.   Phương trình luợng giác cơ bản. 

 2.   Một số phương trình lượng giác thường gặp. 

 3.   Những phương trình lượng giác khác. 

 4.   Sơ luợc về hệ phương trình lượng giác. 

III.   DÃY SỐ - CẤP SỐ CỘNG - CẤP SỐ NHÂN. 
@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@ 
 
UYêu cầu:U  
Nhập đủ nội dung. Tạo các mục tiêu đề: dùng chức năng Bullete và Numbering.  
(Không được dùng bàn phím để tạo các số, ký hiệu dẫn trước các tiêu đề,  khoảng trắng) 
UGợi ý: 
 Trước hết soạn thảo cho đủ nội dung ở mỗi hàng văn bản. 
 Đặt con trỏ vào mỗi hàng văn bản có cùng Numbering (hoặc Bulleet) giống nhau 
→ Format→ chọn Bullete And Numbering → Chọn thẻ Bullete để tạo biểu tượng, (hoặc 
chọn thẻ Numbering để tạo số) →Chọn loại biểu tượng→OK. Nếu chưa sẵn có Bullete, 
Numbering thì bấm Customize → Character để chọn biểu tượng cho phù hợp. 
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Bài tập 3: Đặt Tab, Bullete, Chèn Symbol. 
 Anh (Chị) hãy nhập và định dạng văn bản theo mẫu sau đây: 
 
 
   Phần  một: VĂN HỌC DÂN GIAN 

    Bài 1: Truyện quả bầu mẹ ........................................................... trang 5 
    Bài 2: Bắt nữ thần Mặt Trời ..............................................................  12 
    Bài 3: Chử Đổng Tử ........................................................................... 18 
    Bài 4: Trầu cau ................................................................................... 26 
    Bài 5: Lấy vợ cóc................................................................................................ 31 

   Phần  hai: VĂN HỌC VIỆT NAM 
    Bài 1: Bình Ngô đại cáo (Nguyễn Trãi)............................................. 92 
    Bài 2: Mời trầu (Hồ Xuân Hương) .................................................. 151 
    Bài 3: Văn tế Trương Quỳnh (Phạm Thái)...................................... 166 
    Bài 4: Chiều hôm nhớ nhà:(Bà huyện Thanh Quan) ....................... 212 
    Bài 5: Đây thôn Vĩ Dạ (Hàn Mặc Tử) ............................................. 215 
    Phần  ba: VĂN HỌC THẾ GIỚI 
    Bài 1: Uylixơ  trở về (Ôdixê) .......................................................... 217 
    Bài 2: Rama buộc tội (Vamiki) ....................................................... 235 
    Bài 3: Tì bà hành (Bạch cư dị) ........................................................ 259 
    Bài 4: Thề nguyền (Rômêo và Juliet).............................................. 282 
    Bài 5: Cô gái bán diêm (Andecxen) ................................................ 300 
 
 
 
UYêu cầuU:  
Nhập đủ nội dung. Đặt 3 Tab (1 cm, trái; 2 cm, trái; 14 cm, phải, có ký tự dẫn trước) để 
căn chỉnh theo đúng mẫu. Chọn hình ảnh Bullete và đặt đúng vị trí của đoạn văn bản.  
 
UCách thực hiện U:  
- Bấm chuột trái chọn Tab → chỉ chuột ra vị trí kích thước trên thước, bấm trái sao cho 
có hình dạng Tab trên thước → vào menu Format → Tab → bấm chọn con số 14 chỉ 
bước nhảy Tab → bấm chọn nút có chứa nét ... → Set → OK 
- Nhập văn bản, dùng phím Tab để di chuyển con trỏ đến vị trí. 
- Chèn Symbol: Đặt con trỏ vào vị trí vào menu Insert → Symbol → Bấm chọn hình 
Symbol → bấm Insert dể chèn. 
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Bài tập 4: Định dạng văn bản theo khuôn mẫu (Style). 
 Anh (Chị) hãy nhập và định dạng văn bản theo mẫu sau đây: 
 

CHƯƠNG 2 
Thiết lập tài khoản người dùng 

I.   Tổng quan: 
 Cho phép người dùng (user account) gia nhập mạng và truy cập tài nguyên mạng. 
Chương 2 giới thiệu ba loại tài khoản người dùng và cung cấp phương pháp sử dụng 
chúng. Phần thực hành tiến hành hoạch định và tạo tài khoản người dùng. 
II   Hoạch định tài khoản người dùng 
 1.   Mục tiêu 

 ►  Mô tả tài khoản người dùng. 
 ►  Mô tả sự khác biệt giữa tài khoản người dùng vùng (domain user acount)   
  và tài khoản người dùng cục bộ. 
 2.   Các loại tài khoản người dùng. 

 3.   Nơi tạo tài khoản 

III   Tạo bộ lưu trữ người dùng 
 
 
UYêu cầu: 
 Soạn thảo đủ nội dung. Tạo mới 3 Style. Style thứ nhất chứa tiêu đề “I. Tổng 
quan” đặt tên là Num1, font chữ Verdana, kích cỡ chữ 13, đậm. Numbering là I, II, 
III,...Style theo sau là Nomal. Paragraph có Before: 6, After: 3. Style thứ hai chứa tiêu đề 
“1.  Mục tiêu” đặt tên là Num2, font chữ Arial, kích cỡ chữ 11, đậm. Numbering là 1, 
2, 3,...Style theo sau là Nomal. Paragraph có Before: 3, After: 3. Style thứ ba chứa tiêu đề 
“► Mô tả tài...” đặt tên là Num3, font chữ Times New Roman, kích cỡ chữ 12, 
Numbering là ► ,...Style theo sau là Nomal. 
 
UCách thực hiện U:  
 - Soạn thảo 3 dòng đại diện cho 3 cấp tiêu đề. 

- Đặt con trỏ vào tiêu đề đầu tiên → menu format chọn mục Style And Formating 
→ xuất hiện hộp thoại bên phải màn hình → New Style → xuất hiện hộp thoại nữa → gõ 
vào tên trong hộp Name: Num1 → bấm chọn nút Format để chọn các mục định dạng 
Paragraph, Numbering → OK. Lặp lại cho ba cấp độ tiêu đề. 
 - Tiếp tục soạn thảo phần còn lại → sao chép định dạng cho mỗi loại tiêu đề bằng 
cách đặt con trỏ vào dòng tiêu đề đã định dạng → bấm chuột trái vào biểu tượng cây chổi 
→  bấm chuột trái vào dòng cần sao chép định dạng tới 
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+ 
Bài tập 5: Tạo bảng, Tô màu nền. 
 Anh (Chị) hãy tạo Table và định dạng sao cho đúng mẫu sau đây: 
 

THỜI KHÓA BIỂU 
 

                   Tiết 
Thứ 1 2 3 4 5 

SÁNG Chào cờ 12A1 (GT) 12A1 (GT) 11A1 (ĐS) 11A1 (ĐS)

H
ai

 

CHIỀU  Bồi dưỡng Bồi dưỡng   

SÁNG   12A2 (GT) 12A2(GT)  

B
a 

CHIỀU      

SÁNG 12A1 (GT) 12A1 (GT) 11A1(H) 11A1(H)  

T
ư 

CHIỀU      

SÁNG   12A2 (GT) 12A2 (H) 11A1(H) 

N
ăm

 

CHIỀU  Họp HĐ    

SÁNG Soạn GA Soạn GA Soạn GA Soạn GA Soạn GA 

Sá
u 

CHIỀU      
SÁNG 12A2 (H) 12A1 (H) Dự giờ Dự giờ  

B
ảy

 

CHIỀU      

 
UYêu cầu:  
Kẻ đúng số lượng cột, hàng như mẫu. Định dạng văn bản đúng mẫu chữ dọc, chữ ngang. 
Tô được màu nền cho các hàng. 
 
UCách thực hiện U: 
- Vào menu Table → Insert → Table → Gõ hộp Number of column: 6 (cột), Number of 
row: 15 hàng). 
- Vào menu Table → Draw Rable để hiện thanh Tables and Borders→ chọn bút vẽ chẻ 
chéo ô trên cùng bên phải , → chẻ đôi cột thứ nhất cho các ô còn lại của cột này. 
- Trộn 2 ô để ghi thứ: dùng chuột quét chọn 2 ô → bấm nút Merge trên thanh Tables and 
Borders để trộn. 
- Nhập văn bản. 
- Quay dọc chữ: quét chọn chữ trong ô, bấm nút  Change Direction  
- Tô màu nền: quét chọn  các ô → Borders and Shading → Shading →  Chọn màu đen 
nhạt → OK. 
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Bài tập 6: Chia văn bản thành cột (Column). 
 
Anh (Chị) hãy nhập và định dạng văn bản theo mẫu sau đây: 

 
 

KỲ THI OLYMPIC TOÁN QUỐC TẾ 
 
Thành phần:                   
Mỗi đoàn đại biểu đến dự 
kỳ thi IMO (Internetionnal 
Mathematics Olympiad) có 
nhiều nhất là 8 người, gồm 
6 thí sinh và 2 trưởng, phó 
đoàn. Trong hai ngày thi 
liên tiếp, các thí sinh sẽ làm 
hai bài thi, mỗi bài gồm ba 
bài toán, mỗi bài toán được 
7 điểm tối đa. 
 

Đề thi: vcbvbvbvbvbvbbb                                 
Mỗi nước được 
mời sẽ gởi tới 
nhiều nhất là 6 
bài toán dự 
tuyển. Tất cả sẽ được tuyển 
chọn thành một tập gồm 30 
bài bởi Ban tuyển chọn đề 
thi IMO của nước chủ nhà, 
và sẽ được đệ trình lên Ban 
Giám khảo Quốc tế. Ban 
Ban Giám khảo Quốc tế sẽ 
có cuộc họp trước kỳ thi 
vài ngày, nhằm tuyển ra 6 
bài toán cuối cùng làm đề 
thi. 

Thí sinh: bbbbbbbbbbbb                              
Thí sinh cần phải có sức 
khoẻ để phải trải qua 2 
ngày thi căng thẳng, liên 
tiếp nhau, mỗi ngày 4 giờ 
rưỡi, không giải lao. Thông 
thường bài toán 1 dễ nhất, 
bài toán 6 
khó nhất. 
Sau khi thi, 
trong lúc ban 
Giám khảo chấm 
bài và chuẩn bị công bố kết 
quả thì các thí sinh được 
tham gia các chương trình 
giải trí, giao lưu văn hoá 
do nước chủ nhà tổ chức.

 
 
 
UYêu cầu: U Chia văn bản thành ba cột. Tô màu nền cho các tiêu đề như mẫu đã cho. Chèn 
hình ảnh đúng vị trí. 
 
UCách thực hiện: U  
 

- Nhập văn bản và chia cột: Nhập phần nội dung căn bản cho xong → khối chọn 
toàn bộ văn bản → vào menu Format →  Columns → nhập 3 vào ô Number of 
columns → đánh dấu vào hộp Line between → OK. 

- Ngắt phân chia số cột: Ra phần soạn thảo, đặt con trỏ vào vị trí nào muốn ngắt 
sang cột khác → vào menu Insert →  Break →  ra hộp thoại, chọn nút Column Break 
→  OK. 

- Tô màu nền: Khối chọn dòng văn bản →  vào menu Format →  Border And 
Shading →  ra hộp thoại bấm chọn thẻ Shading →   chọn màu →  OK. 

- Chèn hình: vào menu Insert →  Picture →  Clip Art →  ra hộp thoại bên phải 
màn hình →  bấm Search để ra các hình →  bấm chọn biểu tượng hình ảnh để cho hình 
chèn vào. 

- Điều chỉnh và định dạng ảnh: Thu nhỏ vừa đủ kích thước →  bấm phải vào ảnh 
→   Format Picture →  bấm thẻ Layout →  chọn Tight →  OK →  di chuyển hình sao 
cho đúng vị trí . 
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Bài tập 7:  Chia cột, Chèn các Word Art, Hình vẽ, Tiêu đề, Đánh số  trang. 
Anh (Chị) hãy nhập và định dạng văn bản theo mẫu sau đây: 
 

 
 

 
 
Bài toán:  
Cho  tứ diện S.ABCD có thể tích V. Một 
mặt phẳng tuỳ ý cắt 3 cạnh SA, SB, SC. Gọi 
V’ là thể tích tứ diện S.A’B’C’D’. Lúc đó ta 

có 
' ' ' '. .

. .
V SA SB SC
V SA SB SC

=  

 
Chứng minh :  
Gọi góc α  là góc giữa SC và mặt phẳng 
(SAB), hiển nhiên đây cũng là góc giữa SC’ 
và mặt phẳng (SA’B’); gọi β  là góc đỉnh S 
của tam giác SAB, đây cũng là góc đỉnh S 
của tam giác SA’B’. Dễ nhận thấy: 

V =SC.sinα .dt(SAB), 
V’=SC’.sin β .dt(SA’B’). 

Sử dung các công thức  

dt(SAB) = 1 .
2

SA SBsinβ , 

dt(SA’B’) = ' '1 .
2

SA SB sinβ , 

 học sinh dễ dàng đi đến điều cần chứng 
minh. 
 
 
 
 
 
 
 
 
 
  
 
 

 
UYêu cầu:  
- Phần tiêu đề "Định lý tỉ thể tích" là chuỗi ký tự kiểu Word Art. 
- Văn bản chia làm hai cột. 
- Sử dụng MathType nhập được công thức toán học. 
- Sử dụng Line, Text Box  của thanh Drawing để vẽ và ghi chú thích cho hình tứ diện. 
- Định dạng được các đối tượng Line, Text Box như hình vẽ yêu cầu: nét liền, nét đứt, 
các đỉnh phải nằm đúng vị trí. 
 
UHướng dẫn thực hiện: 
- Phần tiêu đề: vào menu Insert →  Picture → Word Art → Chọn kiểu như mẫu → Gõ 
vào chuỗi ký tự →  chọn Font chữ → OK. 
- Phần công thức toán: Bấm chọn MathType → Chọn nhóm mẫu công thức → Nhập...→ 
OK. 
- Phần khối tứ diện: Vẽ đối tượng đường thẳng. Nhấn phím Ctrl và nhắp phím mũi tên →, 
←,... để di chuyển cho đúng vị trí. 
- Phần chú thích: Các đỉnh nên cho nằm trong các Text Box. Bấm chọn đối tượng Text 
Box để tạo → nhập đỉnh A (B, C, ...) xong → bấm trái vào Text Box  → hộp Draw → 
Order → Send Behind Text. 
- Đánh số thứ tự trang in bên góc phải dưới của tờ giấy in. Tiêu đề đầu trang là chuỗi “Microsoft 
Word 2002”. Tiêu đề cuối trang là chuỗi “Thực hành Word”. 
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 Bài 8: Định dạng trang in, chèn đối tượng 
Anh (Chị) hãy nhập và định dạng văn bản theo mẫu sau đây: 

 
 
 
UBài tập Đại số 

1. Giải hệ phương trình:
2 5 90

5 2 80

y y
x x

y y
x x

A C

A C

⎧ + =⎪
⎨

− =⎪⎩
 

2. Tính tích phân sau:
1

6

0

( 2)I x dx= +∫  

3. Tính tổng sau:
6 5 4 3 2

0 1 2 3 4 5 6
6 6 6 6 6 6 6

2 2 2 2 2 2 1
1 2 3 4 5 6 7

S C C C C C C C= + + + + + +  

4. Chứng minh rằngvới mọi số x:
0

1 (2 1)
2

n
n k k

nn
k

x C x
=

= −∑ , với n là số tự nhiên. 

UPhương trình chính tắc của  ParabolU 

 
 
 
 
 
 
 
 
 
 
 2 2y px=  
Trục đối xứng:  Ox 

Tiêu điểm:  F ,0
2
p⎛ ⎞

⎜ ⎟
⎝ ⎠

 

Đường chuẩn:  ∆: 0
2
px + =   

Tâm sai:  e=1 

Bán kính qua tiêu điểm: r =MF=
2
p x+  

của M(x,y) ∈  (P) 
 

2 2y px= −  
Trục đối xứng:  Ox 

Tiêu điểm:  F ,0
2
p⎛ ⎞−⎜ ⎟

⎝ ⎠
 

Đường chuẩn:  ∆: 0
2
px − =   

Tâm sai:  e=1 

Bán kính qua tiêu điểm: r =MF=
2
p x−  

của M(x,y) ∈  (P) 

UYêu cầu:  
- Tiêu đề “Sử dụng MathType” dạng Word Art.  
- Dùng phần hỗ trợ MathType để nhập công thức toán học, thanh công cụ Drawing để vẽ hình, dùng đối 
tượng Text Box để ghi chú thích cho hình vẽ. Chia cột, định dạng các đối tượng như mẫu văn bản đã cho 
- Đặt lề trang in: Left 2.5 cm, Right 2 cm, Top 2 cm, Bottom 2 cm. Hướng in giấy đứng thẳng. 

------------------- ------------------ 
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Câu hỏi trắc nghiệm 
1. Kích chuột phải trong Word có nghiã là:  

A. Xoá đối tượng  
B. Mở một menu tắt chứa các lệnh tác dụng 

lên đối tượng. 
C. Chọn đối tượng 
D. Không làm gì cả. 

2. Tổ hợp phím nào sau đây chọn toàn bộ tài 
liệu? 

A. <Alt> + <A>. 
B. <Shift> + <Ctrl> + <A>. 
C. <Ctrl> + <A>. 
D. <Alt> + <F8>. 

3. Phím nào để xoá ký tự đứng trước điểm 
nháy? 

A. <Page Up>. 
B. <Page Down>. 
C. <Delete>. 
D. <Backspace>. 

4. Cách nhanh nhất để chọn một từ? 
A. Kéo chuột qua từ đó. 
B. Di chuyển điểm nháy đến chữ đầu, giữ 

phím shift và dùng các phím mũi tên. 
C. Bấm chọn chức năng Select Word Wizard 

trên thanh công cụ và làm theo hường dẫn. 
D. Nhấp đúp vào từ. 

5. Khi một khối văn bản đã được chọn, ta có thể 
thay thế khối đó bẳng văn bản mới dùng cách: 

A. Gõ văn bản mới. 
B. Chọn File -> Insert New Text từ menu. 
C. Không thể thay thế  văn bản đã chọn với 

văn bản mới. 
D. Bấm nút Replace Text trên thanh công cụ. 

6. Cách nào sau đây dùng để lưu tài liệu hiện 
hành? (đánh dấu chọn nhiều mục nếu có thể). 

A. Bấm <Ctrl> + <S>. 
B. Vào menu  File, chọn Save . 
C. Bấm nút Save trên thanh công cụ. 
D. Bấm Save trên nút Start của Windows. 

7. Hiển thị trang in trên màn hình bằng cách: 
A. Bấm nút Print Preview trên thanh công cụ. 
B. Vào menu File chọn View Onscreen  
C. Vào menu File chọn WYSIWYG . 
D. Word không thể hiển thị định dạng trang in 

trên màn hình. 
8. Để lưu tài liệu đang mở dưới một tên mới: 

A. Bấm nút Rename trên thanh công cụ. 
B. Chọn File -> New File Name Save từ menu. 
C. Chọn File -> Save As  từ menu. 
D. Word  không thể lưu thành một tên khác. 

9.  Để di chuyển về cuối tài liệu nhấn: 
A. <Ctrl> + <End> 
B. <Ctrl> + <Page Down> 
C. <End> 
D. <Page Down> 

10. Phím nào sau đây đưa con nháy về đầu dòng 
hiện hành? 

A. <Ctrl> + <Home> 
B. <Ctrl> + <Page Up> 
C. <Home> 

D. Không có phím nào. 
11. Ta muốn thay thế tất cả từ “hay” trong một tài 
liệu dài bằng từ “tuyệt vời”, cách làm như sau: 

A. Chọn Edit -> Replace từ menu , gõ “hay” 
trong hộp Find what ,  gõ từ “tuyệt vời” trong 
hộp Replace with rồi bấm nút Replace All. 

B. Không có cách nào thay thế hàng loạt bạn 
phải xoá và gõ lại từng từ . 

C. Bấm nút Find and Replace trên thanh công 
cụ, sau đó làm theo chỉ dẫn trên màn hình. 

D. Chọn Tools -> Replace từ menu , gõ “hay” 
trong hộp Find what ,  gõ từ “tuyệt vời” trong 
hộp Replace with rồi bấm nút Replace All. 

12. Ta muốn xem vị trí của các ký tự đặc biệt như: 
khoảng trắng, tab, enter,... Làm sao để hiển thị 
chúng trên màn hình? 

A. Chọn Tools -> Reveal Codes  từ menu. 
B. Bấm nút  Show/Hide  trên thanh công cụ. 
C. Nhấn <Ctrl> + <R> 
D. Chọn Edit -> Reveal Codes từ menu. 

13. Lệnh nào sau đây không phải là lệnh cắt ?  
A. Bấm nút Cut trên thanh công cụ. 
B. Nhấn <Ctrl> + <C>. 
C. Nhấn <Ctrl> + <X>. 
D. Chọn Edit -> Cut  từ menu. 

14. Cách nhanh nhất để đi đến một trang bất kỳ? 
A. Chọn Edit -> Go To từ menu. 
B. Bấm nút Go To trên thanh công cụ. 
C. Chọn Edit -> Jump To  từ menu. 
D. Chọn Edit -> Find  từ menu. 

15. Làm cách nào để thực hiện lệnh in 3 bản ? 
A. Chọn File −> Print từ menu và gõ số 3 vào 

hộp Number of copies . 
B. Nhấn  <Ctrl> + <P> + <3>. 
C. Chọn File −> Properties từ menu và gõ số 3 

vào hộp Copies to print . 
D. Bấm nút Print trên thanh công cụ và mang tới 

máy Photocopy chụp ra 2 bản khác nữa. 
16. Khi nào dùng lệnh Save As trong menu File 
thay cho lệnh Save? 

A. Để lưu một tài liệu dưới một tên khác hoặc tại 
vị trí khác. 

B. Để gửi tài liệu cho ai đó qua thư điện tử. 
C. Để thay đổi tần số thực hiện chức năng phục 

hồi tự động (AutoRecovery) . 
D. Để chỉ định Word luôn luôn tạo bản sao dự 

phòng cho tài liệu. 
17. Để thay đổi kích cỡ của font? 

A. Chọn văn bản, chọn số kích cỡ trong hộp font 
size trên thanh công cụ. 

B. Chọn văn bản, bấm chuột phải, chọn font 
trong menu tắt, chọn kích cỡ font trong hộp 
thoại rồi bấm OK. 

C. Chọn văn bản, chọn Format -> Font từ menu, 
chọn kích cỡ font trong hộp thoại rồi bấm OK. 

D. Cả 3 câu trên đều đúng. 
18. Để sao chép định dạng, ta có thể: 
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A. Sử dụng lệnh Edit -> Copy Format và Edit -
> Paste Format từ menu. 

B. Sử dụng nút Format Painter trên thanh công 
cụ. 

C. Không có cách nào. 
D. Mở hộp thoại Copy and Apply Formatting  

bắng cách dùng lệnh Format -> Copy 
Formatting từ menu. 

19. Muốn dùng Format Painter để áp đặt định 
dạng cho nhiểu dòng không liên tiếp: 

A. Bấm nút Format Painter trên thanh công cụ. 
B. Bấm đúp nút Format Painter trên thanh 

công cụ. . 
C. Không thực hiện được. 
D. Mở hộp thoại Copy and Apply Formatting  

bắng cách dùng lệnh Format -> Copy 
Formatting từ menu. 

20. Câu nào sau đây là không đúng? 
A. Bấm nút Center trên thanh công cụ sẽ canh 

đoạn hiện hành hoặc đã chọn vào giữa 
trang. 

B. Khoảng cách canh cột mặc nhiên là ½ inch. 
C. Khi đặt một nút canh cột nó sẽ có tác dụng 

trên tất cả các đoạn văn bản trong tài liệu. 
D. Hai loại canh lề đặc biệt là: First Line  và 

Hanging. 
21. Cách nào sau đây không phải dùng để canh 
lề một đoạn? 

A. Đưa con trỏ tới cạnh trái hoặc phải của 
đoạn văn bản và dùng thao tác kéo thả để 
canh lề. 

B. Bấm nút Increase Indent trên thanh công 
cụ. 

C. Kéo thả điểm canh lề trên thước ngang. 
D. Chọn Format -> Paragraph  từ menu rồi 

chỉnh sửa các thông số trong mục 
Indentation.  

22. Cách nào sau đây không phải để làm chữ  
đậm? 

A. Chọn Format -> Font từ menu và chọn Bold 
trong khung Font style . 

B. Nhấn <Ctrl> + <B>. 
C. Nhấp chuột phải và chọn Boldface từ menu 

tắt. 
D. Bấm nút Bold trên thanh công cụ. 

23. Khi nhấn  <Enter> để tạo ra đoạn mới, đoạn 
mới đó sẽ có định dạng giống hệt như đoạn 
trườc đó. (đúng/sai?) 
24. Để canh giữa một đoạn: 

A. Bấm nút Center trên thanh công cụ. 
B. Bấm mũi tên canh thẳng hàng trên thanh 

công cụ rổi chọn center 
C. Nhấn <Ctrl> + <C>. 
D. Chọn Edit -> Center từ menu. 

25. Các loại nút canh cột bao gồm (có thể chọn 
nhiểu câu trả lời): 

A. Trái 
B. Giữa 
C. Phải 
D. Thập phân 

26. Thay đổi ký hiệu đánh dấu đầu đoạn (bullet) 
bằng cách: 

A. Bấm nút Bullets trên thanh công cụ rồi chọn 
ký hiệu.  

B. Không thể thay đổi ký hiệu đó. 
C. Chọn Edit -> Bullet Symbol từ menu, chọn ký 

hiệu từ danh sách. 
D. Chọn Format -> Bullets and Numbering từ 

menu, chọn bulleted list rồi bấm nút 
Customize, và chọn ký tự muốn sử dụng. 

27. Ta muốn đặt một đường kẻ dưới của đoạn. 
Cách nào sau đây cho phép thực hiện? 

A. Bấm nút mũi tên Border trên thanh công cụ, 
và chọn các loại đướng kẻ. 

B. Chọn đoạn văn bản và bấm nút Underline trên 
thanh công cụ. 

C. Chọn Edit -> Border từ menu và bấm chọn vị 
trí muốn kẻ đường. 

D. Chọn Insert -> Border  từ menu. 
28. Cách nào sau đây không thể tạo được bảng? 

A. Chọn Table -> Insert Table  từ menu. 
B. Bấm nút Insert Table trên thanh công cụ. 
C. Chọn Insert -> Table  từ menu. 
D. Chọn View -> Toolbars -> Tables and Borders 

để hiển thị thanh công cụ Tables and Borders 
A. rồi sử dụng nút Draw Table để kẻ bảng. 

29. Câu nào sau đây là không đúng? 
A. Có thể thực hiện định dạng ký tự và định 

dạng đoạn trong table. 
B. Có thể sắp xếp thông tin trong một bảng theo 

thứ tự được chỉ định. 
C. Có thể tách một ô thanh nhiểu ô nhỏ, hoặc 

gộp nhiều ô thanh một ô chung. 
D. Có thể thực hiện các tính toán hoặc công 

thức giống như trong bảng tính Excel. 
30.  Phím nào sau đây có thể dùng để nhập dữ liệu 
và di chuyển trong table? 

A. <Tab>  để di chuyển qua ô kế tiếp, <Shift> + 
<Tab>  để đi theo hướng ngược lại. 

B. <Enter> để di chuyển qua ô kế tiếp, <Shift> + 
<enter>  để đi theo hướng ngược lại. 

C. < Mũi tên > để di chuyển qua ô kế tiếp, 
<Shift> + < mũi tên >  để đi theo hướng 
ngược lại. 

D. Tất cả đều đúng. 
31.  Câu nào sau đây là không đúng? 

A. Chức năng AutoFit  tự động điều chỉnh bề 
rộng của cột. 

B. Ta có thể ngăn không cho một hàng bị ngắt 
trang bằng cách: Vào menu Table, chọn Cell 
Height and Width, đánh dấu  Allow row to 
break across pages. 

C. Đường lưới của bảng thì luôn luôn xuất hiện 
khi in. 

D. Có thể trộn nhiều ô thành một và có thể tách 
một ô thanh nhiều ô. 

32. Thủ tục nào sau đây được sử dụng để kề 
đường biên cho một bảng? 
(có thể chọn nhiều câu trả lời) 
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A. Chọn khối ô, sau đó chọn đường kẻ trong 
nút Borders của thanh công cụ định dạng 
hoặc của thanh công cụ Tables and 
Borders. 

B. Chọn Tables -> Table Border Wizard từ 
menu và thực hiện theo hướng dẫn. 

C. Bấm nút Draw Table trên thanh công cụ 
Tables and Borders và sau đó vẽ đường 
biên. 

D. Chọn khối ô, chọn Format -> Borders and 
Shading từ menu, và chỉ định các loại 
dường biên. 

33. Một bảng rất dài kéo qua nhiều trang. Làm 
cách nào để đặt tiêu đề cột xuất hiện ở đầu mỗi 
trang? 

A. Không thực hiện được. 
B. Chọn hàng chứa tiêu đề, sau đó bấm nút 

Table Headings trên thanh công cụ Tables 
and Borders. 

C. Sử dụng chức năng Office Assistant để 
được hướng dẫn làm từng bước  

D. Chọn hàng chứa tiêu đề, vào menu Table 
chọn lệnh Headings . 

34. Muốn trộn 4 ô thanh một ô lớn. Cách nào sau 
đây có thể thực hiện được ( có thể chọn nhiều 
câu trả lời) 

A. Chọn 4 ô và bấm nút Merge Cells trên 
thanh công cụ Tables and Borders. 

B. Chọn 4 ô và chọn Table -> Merge Cells  từ 
menu. 

C. Chọn 4 ô và chọn Table -> Combine Cells 
từ menu. 

D. Chọn 4 ô rồi nhấn <Ctrl> + <M>. 
35. Cách sắp xếp  theo thứ tự Alphaber? 

A. Chọn Tools -> Sort  từ menu. 
B. Bấm nút Sort Ascending (A to Z)  trên thanh 

công cụ Tables and Borders . 
C. Bấm nút Sort Ascending (A to Z)  trên thanh 

công cụ  định dạng. 
D. Chọn Edit -> Sort  từ menu. 

36. Template là gì? 
A. Một tài liệu Word có thể đọc bởi các 

chương trình xử lý văn bản khác. 
B. Một loại tài liệu đặc biệt chứa các khuôn 

dạng, macro, style,...dùng để tạo một tài 
liệu mới. 

C. Một cách đặt tên cho tài liệu chính của chức 
năng mail merge. 

D. Một tài liệu Word chỉ chứa hình mà không 
có chữ. 

37. Trong Microsoft Word, Style là: 
A. Cùng nghĩa với style trong thế giới thời 

trang. 
B. Một tập hợp các định dạng lưu trữ thành 

một tên gọi riêng và dễ dàng áp đặt lên các 
đối tượng khác bằng một thao tác duy nhất. 

C. Một loại tài liệu đặc biệt. 
D. Một thành phần định dạng chỉ dùng trong 

trang Web. 

38. Thủ tục để tạo ra một Style mới? ( có thể chọn 
nhiều câu trả lời) 

A. Chọn ký tự hoặc đoạn văn bản chứa các định 
dạng mẫu, bấm vào hộp style trên thanh công 
cụ và gõ tên mới. 

B. Bấm nút New Style trên thanh công cụ. 
C. Chọn Format -> Style từ menu, bấm New, gán 

tên mới rồi thực hiện các chỉ định định dạng. 
D. Chọn File -> Style từ menu, bấm New, gán 

tên mới rồi thực hiện các chỉ định định dạng. 
39. Khi ta sửa đổi một tùy chọn định dạng trong 
một style, tất cả các văn bản hoặc đoạn văn bản 
thuộc style đó sẽ được tự động cập nhật 
(đúng/sai) 
40. Tên của template mặc nhiên dùng cho các tài 
liệu mới: 

A. Blank.DOT. 
B. Default.DOT. 
C. Không có. 
D. Normal.DOT. 

41. Câu nào sau đây là không đúng? 
A. Giữ phím <Shift> khi vẽ elip, hình chữ nhật sẽ 

tạo ra đường tròn, hình vuông. 
B. Trong thanh công cụ Drawing chứa các công 

cụ vẽ đường thẳng, vẽ hình tròn,.... 
C. Không thể định dạng nội dung trong hộp 

textbox. 
D. Có thể thay đổi kích cỡ hộp textbox bằng 

cách chọn và kéo thả. 
42. Cách nào sau đây dùng để chọn nhiều đối 
tượng trên tài liệu ? (có thể chọn nhiều câu trả 
lời.) 

A. Bấm nút Select Object trên thanh công cụ, 
bấm các đối tượng cần chọn, nhấn enter khi 
chọn xong. 

B. Giữ phím <Shift> khi chọn mỗi đối tượng. 
C. Chỉ có thể chọn một đối tượng mỗi lần. 
D. Bấm nút mũi tên trên thanh công cụ Drawing  

và kéo một hình chữ nhật bao quanh các đối 
tượng cần chọn. 

43.  Có thể định dạng các đối tượng drawing bằng 
cách: (có thể chọn nhiều câu trả lời.) 

A. Chọn đối tượng và sử dụng thanh công cụ 
Drawing. 

B. Chọn đối tượng, chọn Format -> AutoShape 
từ menu, và chỉ định các thông số định dạng 
trong hộp thoại Format AutoShape . 

C. Bấm nút phải chuột, chọn Format AutoShape 
từ menu tắt và chỉ định các thông số định 
dạng trong hộp thoại Format AutoShape. 

D. Chọn đối tượng, nhấn <Ctrl> + <F>, và chỉ 
định các thông số định dạng trong hộp thoại 
Format AutoShape. 

44. Có thể thay đổi độ sáng tối và độ tương phản 
của một hình, cắt xén một hình bằng cách sử 
dụng các nút trên thanh công cụ Drawing . 
(đúng/sai?) 
45. Block Arrows, Stars and Banners, và Callouts  
là các ví dụ của: 

A. Các kiểu trò chơi xây dựng của trẻ em. 
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B. Các chủ đề Clip art trong bộ sưu tập 
Microsoft Clip Gallery. 

C. Các chủ đề AutoShape . 
D. Một thuật ngữ kỹ thuật chưa xác định. 

46. Giả sử ta cần đưa vào trong tài liệu nhiều 
hình ảnh minh họa. Khi tiếp tục hiệu chỉnh và 
dàn trang, các hình đó khó giữ được các vị trí 
tương đối ban đầu. Giải pháp nào sau đây giúp 
ta xử lý tình huống trên? 

A. Xóa hình và chèn hình lại khi định dạng 
trang bị thay đổi. 

B. Chọn tất cả các hình, bấm nút phải và chọn 
lệnh Group. 

C. Chọn Edit -> Select pictures từ menu mỗi 
khi di chuyển và làm việc  với nhiều hình. 

D. Không phải các cách trên. 
47. Một số AutoShapes có hình thoi màu vàng. 
Hình thoi đó là gì và có tác dụng ra sao? 

A. Đó là nút kích cỡ, dùng để thay đổi kích 
thước của đối tượng AutoShapes. 

B. Đó là nút di chuyển, dùng để kéo đối tượng 
AutoShape tới một vị trí khác. 

C. Đó là nút điều chỉnh, dùng để thay đổi hình 
dạng của đối tượng AutoShapes.  

D. Không phải ba tác dụng trên. 
48. Các lợi điểm khi làm việc trong chế độ 
Outline view? 

A. Ta có thể thấy cấu trúc tổng thể của các tài 
liệu dài bằng cách chỉ xem những mức tiêu 
đề. 

B. Có thể dễ dàng sắp xếp lại thứ tự các đề 
mục. 

C. Có thể nâng cấp hoặc giáng cấp tiêu đề 
trong tài liệu. 

D. Cả ba câu trên đều đúng. 
49. Trong chế độ Outline view, ký tự đứng cạnh 
tiêu đề chỉ ra rằng: 

A. Tiêu đề đã được thêm vào trong lần mở ra 
gần đây nhất. 

B. Tiêu đề thuộc về mức 1. 
C. Tiêu đề chứa các tiêu đề con và có nội 

dung. 
D. Tiêu đề là tiêu đề đầu tiên của tài liệu. 

50. Thủ tục để chuyển đổi qua chế độ  Outline 
view? (có thể chọn nhiều câu trả lời.) 

A. Bấm nút Outline View ở phía bên trái thanh 
cuộn ngang. 

B. Bấm nút Outline View trên thanh công cụ. 
C. Chọn View -> Outline  từ menu. 
D. Chọn Tools -> Outline từ menu. 

51. Cách nào sau đây không được dùng để 
giáng cấp tiêu đề? 

A. Chọn heading style trong Style list trên 
thanh công cụ. 

B. Bấm nút Show Level 2 trên thanh công cụ 
Outlining . 

C. Nhấn phím <Tab> . 
D. Bấm nút Demote trên thanh công cụ 

Outlining. 

52. Ta muốn kết hợp nhiều tài liệu nhỏ thành một 
tài liệu lớn. Cách làm tốt nhất là: 
A. Thay đổi cách đánh số trang trong từng tài liệu, in 
từng tài liệu riêng rẽ, sau đó đóng bìa chung. 

A. Tạo một tài liệu chủ ( master document) và 
chèn các tài liệu con vào. 

B. Tạo một tài liệu mới và sao chép/cắt dáng các 
tài liệu con vào tài liệu mới đó. 

C. In từng tài liệu nhỏ, dùng bút xoá xoá số trang 
rồi đóng bìa chung. 

53. Khi ta mở một tài liệu chủ, Word đồng thời mở 
các tài liệu con( đúng/sai)? 
54. Cách tạo một bảng tham chiếu? 

A. Chọn Insert -> Cross-reference từ menu. 
B. Bấm chọn Cross Reference trên thanh công 

cụ Long Documents. 
C. Chọn Tools -> Cross-reference từ menu. 
D. Nhấn <Insert> + <C> + <R>. 

55. Câu nào sau đây không đúng? 
A. Một bảng tham chiếu được tự động cập nhật 

mỗi khi các đề mục của nó bị di chuyển đi. Ví 
dụ:  .See Page 5. có thể trở thành .See Page 
8.. 

B. Word có thể taọ ra một bảng mục lục dựa trên 
các mức tiêu đề đã có. 

C. Để đảm bảo Word tự động cập nhật bảng 
mục lục khi in, chọn Tools -> Options từ 
menu, chọn thẻ Print, đành dấu chọn ô 
Update fields . 

D. Để thêm đề mục chọn Tools −> Index Entry  
từ menu. 

56. Câu nào sau đây là không đúng? 
A. Để lưu một tài liệu thành một trang Web,  

chọn File -> Save as Web Page từ menu. 
B. Một siêu liên kết (hyperlink) là một liên kết 

dẫn đến một tài liệu đích khi được kích chuột. 
C. Khi Word lưu một tài liệu thành một trang 

Web, tất cả các hình hay đối tượng đi kèm 
đều được lưu chung vào một tệp. 

D. Các trang Web chứa các định dạng theo 
chuẩn của ngôn ngữ HTML. 

57. Khi lưu một tài liệu Word thành một trang 
HTML, một số định dạng có thể mất. (đúng/sai?) 
58. Một siêu liên kết có thể dẫn tới các đích sau 
đây ? ( có thể chọn nhiều câu trả lời.) 

A. Một trang Web trên Internet. 
B. Một vị trí khác trên cùng một tài liệu Word. 
C. Một tài liệu khác. 
D. Một tập tin tạo bởi một chương trình khác. 

59. Làm cách nào đưa siêu liên kết vào tài liệu? 
(có thể chọn nhiều câu trả lời.) 

A. Nếu đích của liên kết là một trang Web trên 
Internet,  chỉ cần gõ điạ chỉ của trang web đó, 
Word tự động nhận ra và định dạng như một 
siêu liên kết. 

B. Chọn Tools −> Hyperlink từ menu. 
C. Chọn nút Insert Hyperlink  trên thanh công cụ. 
D. Chọn văn bản muốn tạo liên kết, nhập phải 

chuột và chọn Hyperlink từ menu con  . 
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60. Có thể chỉnh sửa siêu liên kết bằng cách 
nhấp phải chuột và chọn Edit Hyperlink  từ 
menu tắt . (đúng/sai?) 
61. Củng giống như tài liệu  Word, các trang 
Web dùng các styles có sẳn để định dạng văn 
bảng và đoạn ( đúng/sai)? 
62. Câu nào dưới đây là không đúng? 

A. Có thể thay đổi vị trí của một thanh công cụ 
bằng cách kéo điểm di chuyển của thanh 
đó. 

B. Có thể hiển thị thanh công cụ bằng cách 
chọn View -> Toolbars và chọn  thanh công 
cụ muốn hiển thị từ danh sách.  

C. Có thể hiển thị thanh công cụ bằng cách 
bấm vào nút Toolbar trên thanh công cụ 
chuẩn, sau đó chọn tên thanhn công cụ cần 
mở. 

D. Các thanh công cụ gắn chặt với các cạnh 
của cửa sổ chương trình. 

63. Câu nào dưới đây là không đúng? 
A. Có thể hiệu chỉnh một thanh công cụ bằng 

cách nhấp phải chuột vào bất kỳ thanh 
côntg cụ nào và chọn customize từ menu 
tắt. 

B. Có thể hiệu chỉnh một thanh công cụ bằng 
cách nhấp chọn View -> Toolbars -
> Customize từ menu. 

C. Một khi hộp thoại Customize đang mở bạn có 
thể thêm các nút bằng cách bấm đúp trên 
thanh công cụ tương ứng. 

D. Hộp thoaị Customize đang mở bạn có thể 
thêm các nút bằng cách kéo chúng thả vào 
thanh công cụ. 

64. Câu nào dưới đây là không đúng? 
A. AutoCorrect tự động kiểm tra và sữa chữa 

các lỗi nhập thông thường, ví dụ: hte được 
chỉnh thành the .. 

B. AutoCorrect kiểm tra mỗi từ được nhập ngay 
khi ta nhân phím <Enter>. 

C. AutoText  cho phép  lưu trữ các khối văn bản 
thường sử dụng, ví dụ các tiêu đề công văn 
địa chỉ người gữi người nhận V.v... 

D. Cách nhanh nhất và dễ nhất để chèn một đề 
mục AutoText là chọn Insert -> AutoText 
−> AutoText từ menu, chọn đề mục AutoText 
cần sử dụng và bấm Insert. 
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của Text Effect trên thanh công c  t i thẻ Menu Home, một menu đổ xuống cho phép 

b n lựa chọn các hi u ứng c n áp d ng 

Và b n hoàn toàn có thể áp d ng các hi u ứng có trong Text Effect với văn bản của 

mình. 

Nếu như phải lựa chọn Edit để hi u ch nh nội dung cho WordArt thì giờ đ y người 

dung có thể ch nh s a trực tiếp nội dung văn bản có hi u ứng của WordArt 

 

Người dùng có thể chèn, x a hay thay đổi Font, kích thước Font, màu sắc, đánh dấu  

với văn bản mang hi u ứng của WordArt 

Chú ý: Chức năng này ch  s  d ng cho những file Word được t o ra từ Word 2010 và 

c  định d ng *.docx nếu người d ng lưu file dưới d ng *.doc thì các hi u ứng này sẽ 

tự động bị gỡ bỏ khỏi văn bản 
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Phím tắt để lưu tài li u là Ctrl+S (giống Word 2007). Cách khác: Nhấn Microsoft 

Office Button (hoặc Tab File), chọn Save. 

Nếu file tài li u này trước đ  chưa được lưu l n nào, b n sẽ được y u c u đặt t n file 

và chọn nơi lưu. 

Để lưu tài li u với t n khác (hay định d ng khác), b n nhấn Microsoft Office Button 

(hoặc Tab File), chọn Save As (phím tắt F12, tương tự như Word 2007). 

Mặc định  ưu tài  i u d ng Word 2003 trở về trước 

Mặc định, tài li u của Word 2010 được lưu với định d ng là *.DOCX, khác với 

*.DOC mà b n đã quen thuộc. Với định d ng này, b n sẽ không thể nào mở được tr n 

Word 2003 trở về trước nếu không cài th m bộ chuyển đổi. Để tương thích khi mở 

tr n Word 2003 mà không cài th m chương trình, Word 2007 cho ph p b n lưu l i với 

định d ng Word 2003 (trong danh sách Save as type của hộp tho i Save As, b n chọn 

Word 97-2003 Document). 

Muốn Word 2010 mặc định lưu với định d ng của Word 2003, b n nhấn Microsoft 

Office Button (hoặc Tab File), chọn Word Options để mở hộp tho i Word Options. 

Trong khung b n trái, chọn Save. T i m c Save files in this format, b n chọn Word 

97-2003 Document (*.doc). Nhấn OK. 
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Giảm thiểu khả năng mất dữ li u khi chương trình bị đóng bất ngờ 

Để đề ph ng trường hợp treo máy, c p đi n làm mất dữ li u, b n n n bật tính năng 

sao lưu tự động theo chu kỳ. Nhấn Microsoft Office Button (hoặc Tab File), Word 

Options, chọn Save 
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nhưng ch  lưu   một điều là để c  thể d ng được cách này thì tuỳ chọn Drag-and-drop 

text editing (menu Tools-Options-thẻ Edit) phải được đánh dấu. 

e.  Phóng to hoặc thu nhỏ tài  i u   

Khi c n ph ng to hoặc thu nhỏ tài li u, thông thường b n sẽ chọn từ n t Zoom tr n 

thanh Standard, nhưng như thế c ng hơi bất ti n vì phải qua hai ba thao tác. Nếu chuột 

của b n c  3 n t thì c  thể nhanh ch ng ph ng to hay thu nhỏ tài li u từ n t chuột 

giữa, bằng cách nhấn giữ phím Ctrl trong khi đ y n t chuột l n (ph ng to) hoặc xuống 

(thu nhỏ). 

f. Mở nhanh hộp tho i Tabs và Page Setup   

Khi c n ch nh s a chi tiết các dấu tab dừng trong đo n văn bản, b n sẽ phải nhờ đến 

hộp tho i Tabs, hay khi thay đổi các thiết lập trang giấy thì b n l i phải d ng đến hộp 

tho i Page Setup. Thay vì mở các hộp tho i đ  từ menu Format-Tabs hay menu File-

Page Setup, b n c  thể nhanh ch ng mở ch ng bằng cách bấm k p bất kỳ chỗ nào 

trong thanh thước ngang (trong khoảng cách nhập văn bản, ở dưới các hàng số để mở 

hộp tho i Tabs hoặc tr n hàng số để mở hộp Page Setup). 

g.  Đánh khối toàn bộ tài  i u   

Trước khi cung cấp một d ng nào đ  cho toàn bộ văn bản, điều đ u ti n mà b n sẽ 

làm là đánh khối toàn bộ ch ng và b n c  thể d ng những cách như bấm menu Edit-

Select All hoặc nhấn Ctrl+A. Nhưng b n hãy th  cách này xem, ch  c n đưa chuột về 

lề trái văn bản (m i t n trỏ chuột sẽ nghi ng về phải) và bấm nhanh 3 l n c ng c  thể 

chọn toàn bộ tài li u được đấy. 

4.2 Thao tác với bàn phím 

Các phím thường d ng trong Winword gồm các phím:  

  

Các phím di chuyển con trỏ:  

Phím ↑: Di chuyển con trỏ l n một d ng.  

Phím ↓: Di chuyển con trỏ xuống một d ng.  
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Phím →: Di chuyển con trỏ sang phải một k  tự.  

Phím ←: Di chuyển con trỏ sang trái một k  tự.  

  

Các phím xoá k  tự:  

Phím Delete: Xoá k  tự t i ví trí con trỏ (b n phải con trỏ).  

Phím Backspace: Xoá k  tự liền trái vị trí con trỏ.  

Phím Insert: Để chuyển đổi giữa chế độ chèn (Insert) và thay thế (Overwrite) k  tự.  

  

Các phím điều khiển:  

Phím Home: Chuyển vị trí con trỏ về đ u d ng văn bản chứa con trỏ.  

Phím End: Chuyển vị trí con trỏ về cuối d ng văn bản chứa con trỏ.  

Phím Page Up: Chuyển vị trí con trỏ l n tr n một trang màn hình.  

Phím Page Down: Chuyển vị trí con trỏ xuống dưới một trang màn hình.  

Muốn về đ u văn bản: ấn đồng thời Ctrl+Home.  

Muốn về cuối văn bản: ấn đồng thời Ctrl+End. 

Thao tác nhanh trong văn bản với các phím tắt thông dụng 

 

TT  Phím tắt  Tác dụng  

1  Ctrl+1  Giãn d ng đơn (1)  

2  Ctrl+2  Giãn d ng đôi (2)  

3  Ctrl+5  Giãn dòng 1,5  

4  Ctrl+0 (zero)  T o th m độ giãn d ng đơn trước đo n  
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5  Ctrl+L  Căn d ng trái  

6  Ctrl+R  Căn d ng phải  

7  Ctrl+E  Căn d ng giữa  

8  Ctrl+J  Căn d ng chữ dàn đều 2 b n, thẳng lề  

9  Ctrl+N  T o file mới  

10  Ctrl+O  Mở file đã c   

11  Ctrl+S  Lưu nội dung file  

12  Ctrl+P  In ấn file  

13  F12  Lưu tài li u với t n khác  

14  F7  Kiểm tra lỗi chính tả tiếng Anh  

15  Ctrl+X  Cắt đo n nội dung đã chọn (bôi đen)  

16  Ctrl+C  Sao ch p đo n nội dung đã chọn  

17  Ctrl+V  Dán tài li u  

18  Ctrl+Z  Bỏ qua l nh vừa làm  

19  Ctrl+Y  
Khôi ph c l nh vừa bỏ (ngược l i với 

Ctrl+Z)  

20  Ctrl+Shift+S  
T o Style (heading) -> D ng m c l c tự 

động  
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21  Ctrl+Shift+F  Thay đổi phông chữ  

22  Ctrl+Shift+P  Thay đổi cỡ chữ  

23  Ctrl+D  Mở hộp tho i định d ng font chữ  

24  Ctrl+B  Bật/tắt chữ đậm  

25  Ctrl+I  Bật/tắt chữ nghi ng  

26  Ctrl+U  Bật/tắt chữ g ch ch n đơn  

27  Ctrl+M  
L i đo n văn bản vào 1 tab (mặc định 

1,27cm)  

28  Ctrl+Shift+M  L i đo n văn bản ra lề 1 tab  

29  Ctrl+T  
L i những d ng không phải là d ng đ u của 

đo n văn bản vào 1 tab  

30  Ctrl+Shift+T  
L i những d ng không phải là d ng đ u của 

đo n văn bản ra lề 1 tab  

31  Ctrl+A  Lựa chọn (bôi đen) toàn bộ nội dung file  

32  Ctrl+F  Tìm kiếm k  tự  

33  
Ctrl+G (hoặc 

F5)  
Nhảy đến trang số  

34  Ctrl+H  Tìm kiếm và thay thế k  tự  

35  Ctrl+K  T o li n kết (link)  
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36  Ctrl+]  Tăng 1 cỡ chữ  

37  Ctrl+[  Giảm 1 cỡ chữ  

38  Ctrl+W  Đ ng file  

39  Ctrl+Q  L i đo n văn bản ra sát lề (khi d ng tab)  

40  Ctrl+Shift+>  Tăng 2 cỡ chữ  

41  Ctrl+Shift+<  Giảm 2 cỡ chữ  

42  Ctrl+F2  Xem hình ảnh nội dung file trước khi in  

43  Alt+Shift+S  Bật/Tắt ph n chia c a sổ Window  

44  Ctrl+enter  Ngắt trang  

45  Ctrl+Home  Về đ u file  

46  Ctrl+End  Về cuối file  

47  Alt+Tab  Chuyển đổi c a sổ làm vi c  

48  Start+D  Chuyển ra màn hình Desktop  

49  Start+E  Mở c a sổInternet Explore, My computer  

50  Ctrl+Alt+O  C a sổ MS word ở d ng Outline  

51  Ctrl+Alt+N  C a sổ MS word ở d ng Normal  

52  Ctrl+Alt+P  C a sổ MS word ở d ng Print Layout  
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53  Ctrl+Alt+L  Đánh số và k  tự tự động  

54  Ctrl+Alt+F  Đánh ghi ch  (Footnotes) ở ch n trang  

55  Ctrl+Alt+D  Đánh ghi ch  ở ngay dưới d ng con trỏ ở đ   

56  Ctrl+Alt+M  
Đánh ch  thích (nền là màu vàng) khi di 

chuyển chuột đến mới xuất hi n ch  thích  

57  F4  Lặp l i l nh vừa làm  

58  Ctrl+Alt+1  T o heading 1  

59  Ctrl+Alt+2  T o heading 2  

60  Ctrl+Alt+3  T o heading 3  

61  Alt+F8  Mở hộp tho i Macro  

62  Ctrl+Shift++  Bật/Tắt đánh ch  số tr n (x2)  

63  Ctrl++  Bật/Tắt đánh ch  số dưới (o2)  

64  
Ctrl+Space 

(dấu cách)  
Trở về định d ng font chữ mặc định  

65  Esc  Bỏ qua các hộp tho i  

66  Ctrl+Shift+A  
Chuyển đổi chữ thường thành chữ hoa (với 

chữ tiếng Vi t c  dấu thì không n n chuyển)  

67  Alt+F10  Phóng to màn hình (Zoom)  
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- Chọn đo n text b n muốn g ch dưới.  

- T i thẻ Home, nh m Font, b n nhấn n t m i t n ở g c dưới b n phải.  

 

- Trong hộp Underline style, b n chọn Word only. Nhấn OK.  

* Gạch đôi ở dưới từ:  

Thực hi n bước 1, 2 tương tự tr n.  

Trong hộp Underline style, b n chọn biểu tượng d ng đôi. Nhấn OK.  

* Đường gạch dưới trang trí:  

Thực hi n bước 1, 2 tương tự tr n.  

- Trong hộp Underline style, b n chọn kiểu mình thích.  

- Để đổi màu của đường g ch dưới, nhấn chuột vào hộp Underline color và chọn màu 

mình thích. Nhấn OK.  

Đổi màu chữ  

1. Chọn đo n text b n muốn đổi màu, di chuyển con trỏ chuột vào v ng chọn để xuất 

hi n thanh công c  Mini.  

2. Nhấn n t Font Color và chọn màu mình thích.  

Đổi kích cỡ chữ  

1. Chọn đo n text, di chuyển con trỏ chuột vào để xuất hi n thanh công c  Mini.  

2. Để tăng kích cỡ chữ, b n nhấn n t Grow Font (phím tắt Ctrl+Shift+>). Để giảm 

kích cỡ chữ, nhấn n t Shrink Font (phím tắt Ctrl+Shift+<).  

Đánh dấu (High ight) đo n text  

Đánh dấu đo n text để làm n  trông nổi bật hơn. Cách thực hi n:  
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1. T i thẻ Home, nh m Font, b n nhấn vào m i t n b n c nh n t Text Highlight Color 

.  

2. Chọn một màu d ng để tô sáng mà b n thích (thường là màu vàng).  

3. D ng chuột tô chọn đo n text muốn đánh dấu.  

4. Muốn ngừng chế độ đánh dấu, b n nhấn chuột vào m i t n c nh n t Text Highlight 

Color, chọn Stop Highlighting, hoặc nhấn ESC.  

Gỡ bỏ chế độ đánh dấu text  

1. Chọn đo n text muốn gỡ bỏ chế độ đánh dấu.  

2. Trong thẻ Home, nh m Font, b n nhấn chuột vào m i t n c nh n t Text Highlight 

Color.  

3. Chọn No Color.  

Định d ng ch  số tr n (Superscript), ch  số dưới (Subscript)  

1. Ch  số tr n (Superscript); 2. Ch  số dưới (Subscript).  

 

Chọn đo n text c n định d ng. Trong thẻ Home, nh m Font, b n nhấn n t Superscript 

(phím tắt Ctrl+Shift+=) để định d ng ch  số tr n, hoặc nhấn n t Subscript (phím tắt 

Ctrl+=) để định d ng ch  số dưới.  

CANH CHỈNH VĂN BẢN  

Canh trái, phải, giữa, hoặc canh đều hai b n  

1. Chọn đo n văn bản b n muốn canh ch nh.  
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2. Trong thẻ Home, nh m Paragraph, nhấn n t Align Left để canh lề trái, nhấn Align 

Right để canh phải, nhấn n t Center để canh giữa (giữa 2 lề trái và phải), hay nhấn n t 

Justify để canh đều hai b n.  

Canh ch nh nhiều chế độ tr n cùng 1 dòng  

1. Chuyển chế độ xem văn bản là Print Layout hoặc Web Layout (Trong thẻ View, 

nh m Document Views, chọn n t Print Layout hoặc Web Layout).  

2. Nhấn chuột vào d ng mới và thực hi n như sau:  

- Chèn đo n text canh trái: Di chuyển con trỏ chuột chữ I sang trái cho đến vị trí c n 

g  text, nhấn đ p chuột và g  vào đo n text.  

- Chèn đo n text canh giữa: Di chuyển con trỏ chuột chữ I vào khoảng giữa d ng cho 

đến vị trí c n g  text. Nhấn đ p chuột và g  vào đo n text.  

- Chèn đo n text canh phải: Di chuyển con trỏ chuột chữ I sang phải cho đến vị trí c n 

g  text, nhấn đ p chuột và g  vào đo n text.  

Thay đổi các canh ch nh theo chiều dọc đo n text  

1. Trong thẻ Page Layout, nh m Page Setup, nhấn chuột vào n t m i t n ở g c dưới 

b n phải.  

2. Trong hộp tho i Page Setup, nhấn vào thẻ Layout. T i m c Vertical alignment, b n 

chọn một lo i canh ch nh mình thích (Top, Center, Justified, Bottom).  
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3. T i m c Apply to, b n chọn ph m vi áp d ng là Whole document (toàn văn bản), 

This section (v ng hi n t i), hay This point forward (kể từ đ y trở về sau). Nhấn OK.  

Canh giữa  ề tr n và  ề dưới  

1. Chọn đo n văn bản b n muốn canh giữa so với lề tr n và lề dưới.  

2. Trong thẻ Page Layout, nh m Page Setup, nhấn chuột vào n t m i t n ở g c dưới 

b n phải.  

3. Trong hộp tho i Page Setup, nhấn vào thẻ Layout. T i m c Vertical alignment, b n 

chọn Center.  

4. T i m c Apply to, chọn Selected text. Nhấn OK.  

Thụt  ề dòng đầu ti n của đo n  
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1. Nhấn chuột vào đo n mà b n muốn th t lề d ng đ u ti n.  

2. Trong thẻ Page Layout, nhấn vào n t m i t n g c dưới b n phải của nh m 

Paragraph.  

3. Ở hộp tho i Paragraph, chọn thẻ Indents and Spacing. T i m c Special, b n chọn 

First line. T i m c By, chọn khoảng cách th t vào. Nhấn OK.  

Điều ch nh khoảng cách thụt  ề của toàn bộ đo n  

1. Chọn đo n văn bản muốn điều ch nh.  

2. T i thẻ Page Layout, nh m Paragraph, nhấn chuột vào m i t n l n, xuống b n c nh 

m c Left để tăng, giảm khoảng cách th t lề trái, hay t i m c Right để điều ch nh th t 

lề phải.  

Thụt dòng tất cả, trừ dòng đầu ti n của đo n  

1. Chọn đo n văn bản mà b n muốn điều ch nh.  

2. Tr n thanh thước ngang, hãy nhấn chuột vào dấu Hanging Indent và r  đến vị trí 

b n muốn bắt đ u th t d ng.  

Nếu b n không thấy thanh thước ngang đ u cả, hãy nhấn n t View Ruler ở phía tr n 

của thanh cuộn dọc để hiển thị n .  

T o một thụt âm  

Thay vì th t d ng vào trong, b n c  thể điều ch nh th t ra ngoài so với lề trái bằng 

cách: 

1. Chọn đo n văn bản mà b n muốn mở rộng sang trái.  

2. T i thẻ Page Layout, nh m Paragraph, nhấn n t m i t n hướng xuống trong m c 

Left cho đến khi đo n văn bản nằm ở vị trí b n vừa  .  

THAY ĐỔI KHOẢNG CÁCH TRONG VĂN BẢN 

T o khoảng cách đôi giữa các dòng cho toàn bộ tài  i u  

Khoảng cách mặc định giữa các d ng cho bất kỳ tài li u trống nào là 1.15. B n c  thể 

t o khoảng cách đôi (2) nếu muốn bằng cách sau:  
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1. Trong thẻ Home, nh m Styles, nhấn chuột phải vào n t Normal, chọn Modify.  

 

2. B n dưới nh m Formatting, nhấn n t Double Space. Nhấn OK.  

Thay đổi khoảng cách dòng cho đo n văn bản đang chọn  

1. Chọn đo n văn bản muốn thay đổi.  

2. Trong thẻ Home, nh m Paragraph, nhấn n t Line Spacing.  

3. Chọn khoảng cách b n muốn, chẳng h n 2.0  

Ghi chú: Nếu muốn đặt nhiều khoảng cách giữa các d ng nhưng khoảng cách này 

không c  trong menu xuất hi n khi nhấn n t Line Spacing, b n hãy chọn Line Spacing 

Options, và nhập vào khoảng cách mà b n thích.  

Các kiểu khoảng cách d ng mà Word hỗ trợ:  

- Single (d ng đơn). T y chọn này hỗ trợ font lớn nhất trong d ng đ , th m vào một 

lượng khoảng trống nhỏ bổ sung. Lượng khoảng trống bổ sung t y thuộc vào font chữ 

mà b n đang s  d ng.  

- 1.5 lines: Gấp 1,5 l n khoảng cách d ng đơn.  

- Double: Gấp 2 l n khoảng cách d ng đơn.  

- At least: Lựa chọn này xác lập khoảng cách d ng tối thiểu c n thiết để ph  hợp với 

font hoặc đồ họa lớn nhất tr n d ng.  

- Exactly: Cố định khoảng cách d ng và Word sẽ không điều ch nh nếu sau đ  b n 

tăng hoặc giảm cỡ chữ.  
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- Multiple: Xác lập khoảng cách d ng tăng hoặc giảm theo t  l  % so với d ng đơn mà 

b n ch  định. Ví d , nhập vào 1.2 c  nghĩa là khoảng cách d ng sẽ tăng l n 20% so 

với d ng đơn.  

Thay đổi khoảng cách trước hoặc sau các đo n  

1. Chọn đo n văn bản b n muốn thay đổi khoảng cách trước hoặc sau n .  

2. Trong thẻ Page Layout, nh m Paragraph, b n nhấn chuột vào m i t n c nh m c 

Before (trước) hoặc After (sau) để thay đổi bằng giá trị b n muốn.  

Thay đổi khoảng cách giữa các ký tự  

1. Chọn đo n văn bản mà b n muốn thay đổi.  

2. Trong thẻ Home, nhấn chuột vào n t m i t n ở g c dưới phải của nh m Font để mở 

hộp tho i Font.  

3. Nhấn chọn thẻ Character Spacing ở hộp tho i này. Trong m c Spacing, nhấn 

Expanded để mở rộng hay Condensed để thu hẹp khoảng cách và ch  định số khoảng 

cách trong m c By.  

 

Co dãn văn bản theo chiều ngang  

1. Chọn đo n văn bản b n muốn căng ra hoặc thu l i.  

2. Trong thẻ Home, nhấn chuột vào n t m i t n ở g c dưới phải của nh m Font để mở 

hộp tho i Font.  
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3. Nhấn chọn thẻ Character Spacing ở hộp tho i này. T i m c Scale, nhập vào t  l  % 

mà b n muốn. Nếu t  l  này lớn hơn 100% thì đo n văn bản sẽ được k o ra, ngược l i, 

n  sẽ được thu l i.  

Đánh dấu sự thay đổi và ghi chú trong tài  i u  

Theo d i sự thay đổi trong khi ch nh s a  

1. Mở tài li u mà b n muốn theo d i.  

2. Trong thẻ Review, nh m Tracking, nhấn n t Track Changes.  

3. Thay đổi tài li u theo   b n (chèn, x a, di chuyển hay định d ng văn bản...). Lập 

tức ở b n hông trang tài li u sẽ xuất hi n những bong b ng hiển thị sự thay đổi này.  

Tắt chế độ theo dõi sự thay đổi  

Trong thẻ Review, nh m Tracking, nhấn vào n t Track Changes một l n nữa để tắt 

chế độ theo d i trong khi ch nh s a.  

Thay đổi cách Word đánh dấu  

- B n c  thể đổi màu và những định d ng mà Word d ng để đánh dấu sự đổi trong tài 

li u bằng cách nhấn vào m i t n b n c nh n t Track Changes, và nhấn chọn m c 

Change Tracking Options.  

 

- Nếu b n muốn xem tất cả những thay đổi ngay trong tài li u thay vì hiển thị những 

bong b ng b n hông tài li u, ở nh m Tracking, nhấn vào n t Ballons, sau đ  chọn 

Show all revisions inline.  

- Để làm nổi bật v ng hiển thị những bong b ng (b n lề tài li u), hãy nhấn n t Show 

Markup và chọn Markup Area Highlight.  
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- Presets  : các mẫu chia cột 

- One – Two – Three : Các cột c  độ rộng bằng nhau 

- Left – Right : Các cột c  độ rộng khác nhau 

- Number of Columns : Số cột (nếu muốn số cột chữ >3) 

- Line Between : Đường kẻ giữa các cột 

- Width and Spacing : Điều ch nh độ rộng và khoảng cách  

- Equal column width :Các cột có độ rộng cột bằng nhau nếu nhắp chọn vào ô 

vuông phía trước 

Cách thứ hai: chia cột trước, g  văn bản sau (d ng trong trường hợp toàn bộ văn 

bản được chia theo d ng cột báo). 

- T i thẻ Page Layput, nhóm Page Setup b n chọn các mẫu cột do Word mặc nhiên 

ấn định - Nhập văn bản vào. 

- T i thẻ Page Layput, nhóm Page Setup b n chọnBreaks, Column Break: để ngắt 

cột khi b n muốn sang các cột còn l i. 
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b. Cài đặt điểm dừng tab (Tab stops)  

Để cho vi c cài đặt tab được thuận ti n, b n n n cho hiển thị thước ngang tr n đ nh tài 

li u bằng cách nhấn n t View Ruler ở đ u tr n thanh cuộn dọc.  

 

B n c  thể nhanh ch ng chọn tab bằng cách l n lượt nhấn vào ô tab selector – là ô 

giao nhau giữa thước dọc và thước ngang (ở g c tr n b n trái trang tài li u) cho đến 
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khi chọn được kiểu tab mong muốn, sau đ  nhấn chuột vào thanh thước ngang nơi b n 

muốn đặt tab.  

T y từng trường hợp c  thể mà b n c  thể s  d ng một trong các lo i tab sau:  

 Tab trái:  Đặt vị trí bắt đ u của đo n text mà từ đ  sẽ ch y sang phải khi 

b n nhập li u.  

 Tab giữa:  Đặt vị trí chính giữa đo n text. Đo n text sẽ nằm giữa vị trí đặt 

tab khi b n nhập li u.  

 Tab phải:  Nằ m ở b n phải cuối đo n text. Khi b n nhập li u, đo n text sẽ 

di chuyển sang trái kể từ vị trí đặt tab.  

 Tab thập phân:  Khi đặt tab này, những dấu chấm ph n cách ph n thập ph n 

sẽ nằm tr n c ng một vị trí.  

 Bar Tab:  Lo i tab này không định vị trí cho text. N  sẽ chèn một thanh 

thẳng đứng t i vị trí đặt tab.  

 

- Default tab stops: Khoảng cách dừng của default tab, thông thường là 0.5” 
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- Tab stop position: gõ tọa độ điểm dừng Tab 

- Alignment chọn một lo i tab là Left – Center – Right – Decimal – Bar (lo i tab 

ch  c  tác d ng t o một đuờng kẻ dọc ở một tọa độ đã định) 

- Leader chọn cách thể hi n tab 

o 1 None Tab t o ra khoảng trắng 

o 2-3-4 Tab t o ra là các dấu chấm, dấu g ch hoặc g ch liền nét 

- Các nút l nh: 

o Set : Đặt điểm dừng tab, tọa độ đã g  được đưa vào danh sách 

o Clear : xóa tọa độ đã chọn 

o Clear all : xóa tất cả tọa độ điểm dừng tab đã đặt 

Nếu b n muốn đặt điểm dừng tab t i vị trí ph  hợp mà không thể xác định chính xác 

khi nhấn chuột l n thanh thước ngang, hoặc b n muốn chèn k  tự đặc bi t trước tab, 

b n c  thể d ng hộp tho i Tabs bằng cách nhấn đ p chuột vào bất kỳ điểm dừng tab 

nào tr n thanh thước.  

Sau khi cài đặt điểm dừng tab xong, b n c  thể nhấn phím Tab để nhảy đến từng điểm 

dừng trong tài li u.  

c. Numbering 

Số thứ tự tự động cho phép b n định d ng và tổ chức văn bản với các số, các 

bullet (dấu chấm tròn). 
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Bulleted and Numbered 

Các danh sách Bullet c  các dấu chấn tr n, danh sách các Number c  các số và danh 

sách các Ountline là sự phối hợp giữa các số và các chữ cái ph  thuộc vào sự tổ chức 

của danh sách. 

Để th m một thứ tự tự động vào văn bản c  sẵn: 

• Lựa chọn văn bản b n muốn để t o một thứ tự tự động 

• Trong nh m Paragraph trên tab Home, kích vào n t danh sách Bulleted hoặc 

Numbered 
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Để t o một thứ tự tự động mới: 

• Đặt con trỏ vào nơi b n muốn chèn thứ tự tự động trong tài li u 

• Chọn nút danh sách Bulleted hoặc Numbered 

• Rồi nhập nội dung bình thường 

Số thứ tự tự động  ồng 

Số thứ tự tự động lồng là danh sách c  một vài cấp độ. Để t o một thứ tự tự động 

lồng: 

• T o thứ tự tự động của b n theo sự hướng dẫn phía tr n 

• Chọn nút Increase Indent hay Decrease Indent 

 

Định d ng danh sách thứ tự tự động 

Hình ảnh chấm tr n và số c  thể được thay đổi bằng cách s  d ng hộp tho i Bullets or 

Numbering. 

• Lựa chọn toàn bộ thứ tự tự động để thay đổi tất cả các dấu chấm tr n hay số, hoặc 

đặt con trỏ l n một d ng trong danh sách thứ tự tự động để thay đổi một Bullet 

• Chọn phải chuột 

• Chọn vào m i t n b n c nh danh sách Bulleter hay Numbered và chọn một Bullet 

hay Numbering khác. 
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Một menu xổ xuống với các Header, Footer mẫu cho b n chọn. Kế đến b n nhập nội 

dung cho Header hay Footer đ . Nhập xong nhấn đ p chuột vào v ng nội dung của 

trang, lập tức Header/ Footer sẽ được áp d ng cho toàn bộ trang của tài li u. 

Thay đổi Header / Footer cũ bằng Header / Footer mới  

T i thẻ Insert, nh m Header & Footer, b n nhấn chuột vào n t Header hay Footer. Sau 

đ  chọn l i một Header / Footer mới để thay cho Header / Footer hi n t i.  

Không s  dụng Header / Footer cho trang đầu ti n  

T i thẻ Page Layout, b n nhấn chuột vào n t g c dưới phải của nh m Page Setup để 

mở hộp tho i Page Setup. Kế đến mở thẻ Layout ra. Đánh dấu kiểm m c Different 

first page b n dưới m c Headers and footers. Nhấn OK.  
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Vậy là Header / Footer đã được lo i bỏ khỏi trang đ u ti n của tài li u.  

Trong Word 2003, b n c ng c  thể lo i bỏ Header / Footer cho trang đ u ti n bằng 

cách vào menu File – Page Setup > chọn thẻ Layout > đánh dấu check Different first 

page > OK.  

Áp dụng Header / Footer khác nhau cho trang chẵn và trang  ẻ  

T i thẻ Page Layout, b n nhấn chuột vào n t g c dưới phải của nh m Page Setup để 

mở hộp tho i Page Setup. Kế đến mở thẻ Layout ra. Đánh dấu kiểm m c Different 

odd and even b n dưới m c Headers and footers. Nhấn OK.  

B y giờ b n c  thể chèn Header / Footer cho các trang chẵn tr n một trang chẵn bất 

kỳ, chèn Header / Footer cho các trang lẻ tr n một trang lẻ bất kỳ.  
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Trong Word 2003, b n c ng c  thể thực hi n tương tự bằng cách vào menu File – 

Page Setup > chọn thẻ Layout > đánh dấu check Different odd and even > OK.  

 

Thay đổi nội dung của Header / Footer  

T i thẻ Insert, nh m Header & Footer, b n nhấn chuột vào n t Header hay Footer. Kế 

đến chọn Edit Header / Edit Footer trong menu xổ xuống để ch nh s a nội dung của 

Header / Footer. Trong khi ch nh s a b n c  thể định d ng l i font chữ, kiểu chữ, màu 

sắc... cho ti u đề Header / Footer bằng cách chọn chữ và s  d ng thanh công c  Mini 

xuất hi n b n c nh.  

Ch nh s a xong b n nhấn đ p chuột ra ngoài v ng nội dung của trang tài li u.  

Xóa Header / Footer  
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T i thẻ Insert, nh m Header & Footer, b n nhấn chuột vào n t Header hay Footer. Kế 

đến chọn Remove Header / Remove Footer trong danh sách xổ xuống.  

 

T o Header / Footer khác nhau cho các vùng khác nhau của tài  i u  

- Trước ti n, b n c n t o các ngắt v ng để ph n chia các v ng trong tài li u. Nhấn 

chuột vào vị trí muốn đặt một v ng mới. Trong thẻ Page Layout, nh m Page Setup, 

nhấn n t Breaks và chọn một kiểu ngắt v ng ph  hợp trong Section Breaks, ví d  

Continuous (ch ng ta sẽ tìm hiểu kỹ hơn về ngắt trang / ngắt v ng ở những bài viết 

sau).  
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Số trang này sẽ được đưa vào Header hay Footer t y   b n. Để thực hi n, b n chọn 

thẻ Insert, t i nh m Header & Footer, b n nhấn n t Page Number. Trong menu xuất 

hi n, b n trỏ tới Top of Page (chèn số trang vào ph n Header) hoặc Bottom of Page 

(chèn vào Footer). Word 2010cung cấp sẵn khá nhiều mẫu đánh số trang và b n ch  

vi c chọn một trong các mẫu này là xong.  

  

Thay đổi d ng số trang   

B n c  thể thay đổi d ng số trang theo   thích của mình mà định d ng chu n không c  

sẵn. Để thực hi n, b n nhấn đ p vào Header hay Footer, nơi b n đã đặt số trang. T i 

thẻ Design, nh m Header & Footer, b n nhấn n t Page Number, chọn tiếp Format 

Page Numbers.  
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Number format: Chọn d ng số thứ tự 

Include Chapter Number: Số trang sẽ được kèm với số chương 

Continue From Previous Section: Số trang nối tiếp với section trước đ  

Start at : Số trang được bắt đ u từ số 

Trong hộp tho i Page Number, t i m c Number format, b n hãy chọn một kiểu đánh 

số mình thích, sau đ  nhấn OK. 

Thay đổi kiểu chữ, cỡ chữ, màu sắc của số trang  

Nhấn đ p chuột vào Header hay Footer, nơi b n đã đặt số trang t i đ .  

D ng chuột chọn số trang. T i thanh công c  mini vừa xuất hi n ở b n tr n, b n c  thể 

chọn l i font chữ, cỡ chữ, định d ng l i chữ đậm, nghi ng, hay chọn màu t y thích. 

Khi hi u ch nh xong b n nhấn đ p chuột vào v ng nội dung chính của tài li u.  

Bắt đầu đánh số trang bằng một số khác  

B n c  thể bắt đ u đánh số trang bằng một con số khác, thay vì 1 như mặc định. Cách 

thực hi n: T i thẻ Insert, nh m Header & Footer, b n nhấn n t Page Number, chọn 

Format Page Numbers. Trong hộp tho i xuất hi n, b n chọn Start at và nhập vào con 

số bắt đ u khi đánh số trang. Nhấn OK.  

Ghi chú: Nếu tài li u của b n c  trang bìa và b n muốn trang đ u ti n sau đ  được bắt 

đ u bằng 1, t i ô Start at, b n hãy g  vào 0.  
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Để thay đổi hướng, kích thước hay cột của trang:  

• Chọn tab Page Layout trên nhóm Ribbon 

• Trong nh m Page Setup, Chọn Orientation, Size hay Columns 

• Chọn kiểu thích hợp. 

 

Áp dụng đường viền trang và màu sắc  
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Đế áp d ng đường viền trang hay màu sắc: 

• Chọn tab Page Layout trên nhóm Ribbon. 

• Trong nh m Page Background, Chọn Page Colors và lựa chọn màu muốn áp d ng 

cho trang hoặc Page Borders và chọn đường viền thích hợp cho trang. 

 

T o một ngắt trang 

Để chèn một ngắt trang: 

• Chọn tab Page Layout trên nhóm Ribbon 

• Trong nh m Page Setup, Chọn menu Breaks. 

• Chọn Page Break. 
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Chèn một Trang bìa  

Để chèn một trang bìa: 

• Chọn tab Insert trên nhóm Ribbon 

• Chọn nút Cover Page trên nhóm Pages. 

• Chọn một kiểu trang bìa. 
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Chèn một trang trống  

Để chèn một trang trống: 

• Chọn tab Insert trên nhóm Ribbon. 

• Chọn nút Blank Page trên nhóm Page. 
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Xuất hi n c a sổ chọn kiểu bi u đồ 

 

Chọn một kiểu biểu đồ và nhập hoặc s a nội dung bảng dữ li u trực tiếp trên bảng dữ 

li u Data Sheet của màn hình Excel.  
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Đ ng chương trình Excel, biểu đồ lưu l i trên màn hình Word 

 

a.  Thay đổi   i kiểu biểu đồ  

Chọn biểu đồ, tr n Tab Design chọn nh m Type, Change Chart Type. 

 

- Hãy lựa chọn lo i biểu đồ theo danh sách Chart type và chọn hình biểu đồ b n ô 

Chart sub-type.  

- Chọn n t Set as default chart nếu muốn để kiểu biểu đồ đã chọn sẽ được d ng cho 

những l n vẽ biểu đồ sau. 

Nhấn n t OK để hoàn thành vi c thay đổi kiểu biểu đồ  

Ch nh s a nội dung hiển thị tr n biểu đồ  

-  Chọn biểu đồ ch nh s a biểu đồ, Tab Layout  
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Có thể ch nh s a nội dung trong nhóm Labe s và nhóm Axes. 

Labels: 

- Chart title: T n biểu đồ  

- Axis title: Ti u đề tr c 

- Legend: Ch  giải 

- Data Labels: Hiển thị dữ li u và các nhãn giá trị 

- Data Labels: Hiển thị dữ li u và các nhãn giá trị 

Axes: 

- Axes: ch nh s a, hiển thị dữ li u tr n tr c tọa độ 

- Gridlines: Thay đổi đường kẻ mặt đáy biểu đồ 

-  Quay & hiển thị biểu đồ theo hình ảnh 3-D  

Chọn biểu đồ ch nh s a biểu đồ, Tab Layout, nh m Background chọn 3-D Rotation  

 

Xuất hi n hộp tho i Fỏmat Chart Area:  
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• Chọn nút Equation trên nhóm Symbols 

• Chọn công thức toán học ph  hợp hoặc Chọn Insert New Equation 

 

• Để ch nh s a công thức toán học: Kích chọn công thức và tab Design sẽ xuất hi n 

trên vùng Ribbon 
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Nhập dữ  i u trong một bảng  

Đặt con trỏ vào ô b n muốn nhập thông tin. Và bắt đ u nhập 

Ch nh s a cấu trúc bảng và định d ng bảng 

Để ch nh s a cấu tr c của bảng: 

• Chọn vào bảng và b n sẽ thấy c  hai tab mới tr n v ng Ribbon là: Design và 

Layout. Hai tab này d ng để thiết kế và bố trí bảng. 

 

 

Trên tab Design, b n c  thể chọn:  

• Table Style Options  
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- Chọn tiếp Design, nhấn vào nút Border chọn All Borders  

 

- Chọn các kiểu đường viền và nhấp OK 

b. Tô nền cho bảng 

Phối hợp màu sắc để t o nền cho Tables. B n có thể thực hi n theo các bước sau:  

-  Chọn các ô c n tô màu, sau đ  nhấn vào Tables Tools chọn Design.  

-  Chọn tiếp m c Shading và chọn màu nền cho ô đ .  
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- Nhập công thức tính theo hai cách t i ô Formula: 

e  

+ Tính trực tiếp theo cách d ng địa ch  theo d ng và cột của Excel. Trong trường hợp 

c  thể này, Số  ượng  à cột D, Đơn giá  à cột C, dòng cần tính  à dòng 2, nên công 

thức tính sẽ là =c2+d2 

+ Hoặc c  thể s  d ng các hàm c  trong ô Paste Function ở b n dưới hoặc g  t n 

hàm vào. Trong Word c  thể s  d ng các hàm cơ bản như: Sum (tính tổng), Count 

(đếm), Average (tính trung bình cộng), Max (giá trị  ớn nhất), Min (giá trị nhỏ 

nhất), Product (nhân)   và c  thể s  d ng địa ch  ô và v ng như Excel. Để tính 

Thành tiền c  thể viết như sau: = Product( eft) hoặc = Product(c2 d2) 

- Chọn chế độ định dạng tại ô Number Format (ví d : #,##0) 

Bước 3. Sao ch p xuống các ô b n dưới: Bôi đen kết quả vừa tính, chọn copy và paste 

xuống các ô b n dưới của cột thành tiền rồi bấm F9 để cập nhật theo d ng. 

Bước 4. Tính tổng: kích chuột vào ô cuối c ng của d ng Thành tiền và chọn 

Layout/Formula, nhập công thức =sum(above) và chọn chế độ định d ng t i ô Number 

Format rồi OK. 

Trong quá trình làm vi c, nếu dữ li u t i các cột Số lượng và Đơn giá c  điều ch nh 

thì ch  c n bôi đen cột Thành tiền và bấm F9 thì máy sẽ tự động cập nhập kết quả theo 

số li u mới. 
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- Hiển thị hộp tho i sau: 

 

- Dùng các ký hi u để phân cách nội dung trong ô thuộc Table 

o Paragrahp marks dấu ph n đo n (tương đương nhấn phím Enter) 

o Tabs có khoảng cách phím Tab 

o Commas dấu ph y 

o Other dấu khác các dấu đã n u b n tr n, b n gõ 

vào dấu b n muốn bên c nh 

- Nhấn OK 

 Chuyển đổi từ  Text sang Table: 

- Chọn dữ li u muốn chuyển đổi thành Table 

- Trong thẻ Insert, nhóm Tables, nhấn Convert Text to Table 
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- Hiển thị hộp tho i sau: 

 

- Chọn tùy chọn thích hợp sau đ  nhắp nút OK 

- Dùng các ký hi u để phân cách nội dung trong ô thuộc Table 

o Paragrahp marks : dấu ph n đo n (tương đương nhấn phím Enter) 

o Tabs : có khoảng cách phím Tab 
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-  

- Correct TWo INitian CApitals : nếu hai k  tự đ u ti n trong một từ được g  

bằng chữ in thì n  sẽ thay chữ in thứ hai bằng chữ thường.  

VD: gõ TWo INitian CApitals sẽ được thay bằng Two Initian Capitals  

- Capitalize first letter of sentences : Word nhận biết sau dấu chấm sẽ bắt đ u 

một câu mới và ký tự đ u câu sẽ được đổi thành chữ in nếu chúng ta gõ bằng 

chữ thường 

- Capitalize name of days : Ký tự đấu tiên của thứ (ngày trong tu n được gõ 

bằng tiếng Anh) sẽ đổi thành chữ in. 

- Correct accidental usage of cAPS LOCK key : khi g  phím Caps Lock, đèn 

Caps Lock trên bàn phím  sáng, lúc này chúng ta có thể gõ nh m tr ng thái của 

bàn phím bằng cách giữ phím Shift gõ ký tự đ u tiên của một từ, sau đ  nhả 
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phím Shift gõ các ký tự còn l i của từ, sau khi gõ xong từ này Word sẽ đổi từ 

đã g  về đ ng d ng đồng thời làm tắt luôn đèn caps lock. 

- Replace text as you type : tự động gõ từ sai thành từ đ ng 

Trong hộp ho i trên, từ sai được li t kê ở bên cột trái tương ứng với từ đ ng ở bên cột 

phải. Như vậy ch  khi nào g  đ ng từ sai ở bên trái thì Word sẽ tự động thay thế từ 

đ ng ở bên phải. 

Nhập nội dung viết tắt vào hộp Replace. Nhập nội dung thay thế cho nội dung viết 

tắt vào hộp With, sau đ  click n t Add để đưa vào danh sách AutoCorrect. 

Thực hi n tu n tự các bước để nhập thêm các từ viết tắt khác. 

Khi thực hi n xong, nhấn OK để thoát khỏi hộp tho i. 

Muốn xoá từ viết tắt nào, b n click chọn từ trong danh sách và nhấn Delete. 

Muốn s a đổi, chọn từ trong danh sách và nhập l i vào nội dung trong khung 

Replace hoặc With. 

Trong khi g  văn bản, muốn s  d ng AutoCorrect b n nhập vào từ viết tắt, sau đ  

nhập thêm dấu phân cách từ (ký tự trắng, dấu ph y, dấu chấm, dấu chấm hỏi, . . .) 

để đưa nội dung thay thế tương ứng vào văn bản. 

b. Macro 

Macros  à các tính năng ti n tiến, có thể  àm tăng tốc độ hi u ch nh hay định 

d ng mà b n có thể thực thi thường xuy n trong một tài  i u Word. Ch ng ghi l i 

chuỗi các lựa chọn mà b n chọn để cho một lo t các hành động c  thể được hoàn 

thành trong một bước. 

Ghi một Macro 

Để ghi một Macro: 

• Chọn tab View trên vùng Ribbon 

• Chọn vào m i t n phía dưới Macros  
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• Chọn Record Macro, hộp tho i xuất hi n như sau: 

 

• Nhập t n (không chứa dấu cách) 

• Chọn vào nơi b n muốn gán cho một n t (tr n Quick Access Toolbar) hay bàn 

phím (chuỗi các phím) 

• Để gán Macro cho một n t tr n Quick Access Toolbar: 

- Chọn Button 

- Dưới Customize Quick Access Toolbar, lựa chọn tài li u mà b n muốn Macro c  

sẵn. 
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- Dưới l nh chọn: Chọn Macro mà b n đang ghi 

- Chọn Add 

- Chọn OK để bắt đ u ghi Macro 

- Thực thi các hành động b n muốn được ghi trong Macro 

- Chọn Macros 

- Chọn vào Stop Recording Macros 

 

• Để gán một n t Macro cho một phím tắt: 

- Ở hôp tho i Record Macro, Chọn Keyboard 

- Trong hộp Press New Shortcut Key, nhập phím tắt mà b n muốn gán cho n t 

Macro và Chọn Assign 
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- Chọn Close để bắt đ u ghi Macro 

- Thực thi các hành động b n muốn được ghi trong Macro 

- Chọn Macros 

- Chọn Stop Recording Macros 

Ch y Macro 

Ch y một Macro ph  thuộc vào nơi n  được th m vào Quick Access Toolbar hay nếu 

n  được gán là một phím tắt. 

• Để ch y một Macro từ Quick Access Toolbar, Chọn vào biểu tượng Macro 

 

• Để ch y một Macro từ phím tắt, ch  c n ấn các phím mà b n đã lập trình để ch y 

Macro. 
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2. Trong hộp tho i xuất hi n, b n dưới m c Personalize..., b n nhập vào t n của mình, 

sau đ  nhấn OK.  

 

Lưu   là những ghi ch  kể từ b y giờ trở đi mới c  tác d ng với t n mới.  

In tài  i u kèm theo ghi chú và những đánh dấu thay đổi  

1. Nhấn n t Microsoft Office Button (hoặc Tab File) , sau đ  chọn Print.  

2. Trong hộp tho i Print, t i m c Print what, chọn Settings, Print và nhấn OK.  



Phiên bản thử nghiệm – Lưu hành nội bộ - Microsoft Vietnam 

83 

 

 

b.Bảo v  tài li u Word 

Word 2010 hỗ trợ sẵn tính năng đặt password bảo v  văn bản với tính bảo mật cao.  

B n nhấp vào biểu tượng tab File phía tr n g c trái > chọn Info > Click Protect 

Document and  

Click Encrypt with Password > nhấp OK. Xác nhận l i password > nhấn OK. 

Click the File tab, then Click Info.  On the menu to the right Click Protect Document 

and  
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Click Encrypt with Password. 

 

 Hộp tho i Encrypt Document, b n nhập password vào. Click OK 

 

  

Từ b y giờ, mỗi khi mở file văn bản này, Word sẽ hiển thị c a sổ y u c u nhập 

password. Ch  người nào biết password mới c  thể xem được nội dung của file. 
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- Ở m c Find what, b n nhập vào đo n văn bản muốn tìm.  

- Ở m c Replace with, b n nhập vào đo n văn bản muốn thay thế.  

- Để tìm đo n văn bản tiếp theo, b n nhấn Find Next.  

- Để thay thế đo n văn bản, b n nhấn Replace. Sau khi nhấn xong, Word sẽ 

chuyển sang đo n văn bản tiếp theo.  

- Để thay thế tất cả các đo n văn bản tìm được, b n nhấn Replace All.  

Tìm và tô sáng đo n văn bản tìm được  

Để d  dàng nhận biết các c m từ tìm được, b n c  thể tô sáng n  tr n màn hình 

(không tô sáng khi in ra).  

- Trong thẻ Home, nh m Editing, nhấn n t Find (Ctrl+F).  

- Trong hộp Find what, nhập văn bản mà b n muốn tìm.  

- Nhấn Reading Highlight, sau đ  chọn Highlight All.  

- Tất cả từ tìm được sẽ được tô sáng. Để tắt tính năng này đi, b n nhấn Reading 

Highlight l n nữa, chọn Clear Highlighting.  
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Tìm và thay thế những định d ng đặc bi t  

- Trong thẻ Home, nh m Editing, b n nhấn n t Replace (Ctrl+H).  

- Nhấn n t More nếu b n không nhìn thấy n t Format.  
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- Để tìm kiếm đo n văn bản với định d ng đặc bi t, b n hãy nhập đo n văn đ  trong ô 

Find what. Nếu ch  để tìm kiếm định d ng, hãy để trống ô này.  

- Nhấn n t Format, sau đ  chọn định d ng mà b n muốn tìm.  

- Nhấn vào ô Replace with, sau đ  nhấn Format, chọn định d ng thay thế. Nếu b n 

c ng muốn thay thế bằng đo n văn bản, hãy nhập đo n text đ  vào ô Replace with.  

- Nhấn Find Next, nhấn tiếp Replace để tìm và thay thế các định d ng đặc bi t. Để 

thay thế toàn bộ, nhấn Replace All.  

Tìm và thay thế các dấu đo n, ngắt trang và các mục khác  

- Trong hộp tho i Find and Replace xuất hi n sau khi nhấn Ctrl+H, b n nhấn n t More 

nếu không thấy n t Special.  

- Nhấn vào ô Find what, sau đ  nhấn n t Special và chọn một m c c n tìm.  

- Nhập những gì b n muốn thay thế trong ô Replace with.  

- Nhấn Find Next, Replace hoặc Replace All.  

S  dụng ký tự đ i di n khi tìm kiếm  

- Bật hộp tho i Find and Replace l n.  

- Nhấn n t More để mở rộng hộp tho i.  

- Đánh dấu kiểm vào ô Use wildcards.  

- Nhập từ c ng những k  tự đ i di n vào ô Find what.  

- Nhập những gì b n muốn thay thế trong ô Replace with.  

- Nhấn Find Next, Replace hoặc Replace All.  

Bảng các ký tự đại diện  

Đ i di n  Nhập Ví dụ 

Một k  tự bất kỳ  ? “s?t” tìm “sat” và “set”. 

Một dãy k  tự * “s*d” tìm “sad” và “started”. 
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Spelling and Grammar 

Để kiểm tra chính tả và ngữ pháp của một tài li u: 

• Đặt con trỏ vào đ u của tài li u hoặc đ u của bất kỳ đo n văn bản mà b n muốn 

kiểm tra 

• Chọn tab Review trên vùng Ribbon 

• Chọn biểu tượng Spelling & Grammar trên nhóm Proofing hoặc ấn phím tắt (F7). 

 

 

• Bất kỳ một lỗi nào sẽ hiển thị một hộp tho i cho ph p b n chọn một cách viết hay 

ngữ pháp thích hợp hơn. 
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Nếu b n muốn kiểm tra chính tả của một từ c  thể, b n c  thể kích chuột phải vào bất 

kỳ từ nào được g ch dưới bởi Word và chọn một sự thay thế. 

 

Từ điển đồng nghĩa  

Từ điển đồng nghĩa cho ph p b n xem các từ đồng nghĩa. Để s  d ng từ điển đồng 

nghĩa: 

• Chọn tab Review trên vùng Ribbon 

• Chọn nút Thesaurus trên nhóm Proofing. 

• Công c  từ điển đồng nghĩa sẽ xuất hi n ở phía b n phải màn hình và b n c  thể xem 

các t y chọn. 

 

B n c ng c  thể truy cập vào từ điển đồng nghĩa bằng cách kích phải vào bất kỳ từ 

nào và chọn Synonyms trên menu. 
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T o một từ điển mặc định mới  

Thường thì b n c  các từ ngữ kỹ thuật chuy n môn mà c  thể không được công nhận 

bởi công c  kiểm tra chính tả và ngữ pháp trong Word. Do vậy mà b n c  thể t y 

ch nh từ điển để c  những từ b n muốn cho vào. 

• Chọn nút Microsoft Office 

• Chọn nút Word Options 

• Chọn tab Proofing 

• Chọn tab When Correcting Spelling 
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• Chọn Custom Dictionaries, và hộp tho i Custom Dictionaries xuất hi n. 

 

 

• Chọn Edit Word List  

• Nhập các từ c  thể s  d ng của b n mà không c  trong từ điển hi n thời trong Word. 

 

 

ĐẾM SỐ TỪ TRONG TÀI LIỆU  
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Word 2010 c  thể đếm số từ của tài li u trong khi b n g  văn bản. Ngoài ra chương 

trình c n c  thể đếm số trang, số đo n, số d ng, số k  tự c  hoặc không c  khoảng 

trắng.  

 

Đếm số từ trong khi gõ văn bản  

Trong khi b n g  văn bản, Word 2010 sẽ tự động đếm số trang và số từ c  trong tài 

li u. Thông tin này được hiển thị tr n thanh tr ng thái ở g c dưới b n trái màn hình: 

m c Page (số trang) và Wor ds (số từ).  

Đếm số từ trong vùng chọn  

B n c  thể đếm số từ trong các v ng chọn, và các v ng chọn này không nhất thiết 

phải liền m ch nhau.  

- Trước ti n b n d ng chuột chọn v ng c n đếm. Nếu các v ng không liền m ch nhau, 

sau khi chọn v ng đ u ti n, b n giữ phím Ctrl và chọn th m các v ng khác.  

- Tr n thanh tr ng thái ở cuối màn hình sẽ hiển thị số từ c  trong v ng chọn. Ví d  

110/1025 c  nghĩa là trong v ng chọn c  110 từ tr n tổng số 1025 từ của tài li u.  

Bao gồm cả textbox, footnote và endnote trong khi đếm từ  

- Trong thẻ Review, nh m Proofing, nhấn n t Word Count.  

- Trong hộp tho i Word Count, đánh dấu check vào m c Include textboxes, footnotes 

and endnotes.  

Đếm số từ trong textbox  
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- Paper Size : chọn lo i giấy, kích thước tương ứng sẽ hi n ra trong width và height, 

nếu chọn Custom phải cho số đo kích thước giấy trong width và height 

 Đặt lề cho trang in – Tab Margins 

 

- Top  : Lề đ nh của trang in 

- Bottom  : Lề đáy của trang in 

- Left  : Lề trái của trang in 

- Right  : Lề phải của trang in 

Nếu có dùng l nh Mirror Margins để làm sách (t o tính đối xứng giữa các trang) thì 

l nh left và right sẽ trở thành Inside và Outside 
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- Gutter : Khoảng cách d ng để đ ng gáy sách 

- From edge: Khoảng cách từ mép của tờ giấy đến header hoặc footer 

- Orientation : chọn hướng in 

o Portrait : Giấy dọc 

o Landscape : Giấy ngang 

- Mirror margins : Đặt lề đối xứng nhau. Nếu l nh này có dùng, giấy sẽ được 

phân bi t là có trang lẻ và trang chẵn (Odd and Even), thường áp d ng để in 

sách. 

In tài li u 

-Tab File, chọn Print 



Phiên bản thử nghiệm – Lưu hành nội bộ - Microsoft Vietnam 

98 

 

 

- Copies: chọn số bản in 

- Printer : chọn t n máy in tương ứng đã được cài đặt trong Windows. Nếu máy in 

đang s  d ng không c  t n trong danh sách này (nghĩa là n  chưa được khai báo) thì 

phải thực hi n các bước sau: 

o Nhắp Start, chọn Settings và nhắp Printers. 

o Nhắp đ p vào biểu tượng Add Printer. 
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Địa ch :  

Mời  sắp xếp thời gian đến dự cuộc phỏng vấn tuyển nhân sự cho Công ty. 

Thời gian: giờ,  ngày  

Địa điểm:  

 Giám Đốc 

 Trần Văn A 

Bước 2. T o tập tin nguồn dữ li u tr n Excel với các cột c  t n tương ứng 

(ch    là t n cột không n n viết dấu tiếng vi t, và phải bắt đ u dữ li u ngay 

t i Cell A1).  

* Ch   : tập tin dữ li u này b n c  thể t o bằng WORD, tuy nhi n nếu thể 

hi n trong Excel b n sẽ c  lợi hơn nếu bảng dữ li u đ  c  hổ trợ nhiều ph p 

tính và hàm phức t p. 

OBC HOTEN PHAI NS DIACHI THPHO BANG 

Ông Đinh như Quí Nam 1965 11 L  Lợi TP.HCM ĐH 

Bà Hồ L  Ngọc Nữ 1966 22 Thùy Vân V ng Tàu ĐH 

Ông Hoàng văn Bình Nam 1975 33 Lê Lai TP.HCM   

Ông Phan thành Tâm Nam 1970 

44 L  Thường 

Ki t TP.HCM   

Bà 

Nguy n Th y 

Hồng Nữ 1968 55 Lê Thánh Tôn TP.HCM ĐH 

Ông Tr n H a Bình Nam 1969 66 L  Thái Tổ Biên Hòa ĐH 

Bà L  Thị Mộng V n Nữ 1973 

77 Tr n Hưng 

Đ o 

Thủ D u 

Một   

Ông L  Văn Lợi Nam 1967 88 Ngô Đức Kế TP.HCM   
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Bà Hàng thị Ngọc Hà Nữ 1968 99 H ng Vương V ng Tàu   

Bà 

Hoàng thị L  

Tường Nữ 1969 96 Pasteur TP.HCM ĐH 

Bước 3. Tr n tập tin Main chính trong Word 

Chọn Start Mail Merge trên tab Mailings và sau đ  chọn Step by Step Mail Merge 

Wizard.  

 

Trình Wizard sẽ mở ra một c a sổ bên phải tài li u. C a sổ này có thể di chuyển bằng 

chuột đến một vị trí mới trên màn hình và b n c ng c  thể thay đổi kích cỡ của nó. 
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Để thực hi n merge mail c n phải qua 6 bước, b n làm theo hướng dẫn bằng cách 

chọn những tùy chọn phù hợp rồi nhấn Next ở dưới cùng của hộp tho i, nếu muốn 

quay l i thì nhấn vào Previous. 

Trong m c Select document type đã chọn sẵn Letters. Chọn Next qua bước 2 

 

Trong m c Select sartting document đã chọn sẵn Use the current document. Chọn 

Next qua bước 3 
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Trong m c Select recipients nhấn nút Browse. Chọn va mở file danh sách excel đã 

lưu. 

 

Chọn Sheet1, OK 
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Ở hộp tho i Mail Merge Recipents, ta có thể lo i bỏ hoặc trích lọc những hàng không 

muốn t o thư mời. 

Nhấn OK. 

Nhấn Next qua bước 4. 
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Trong m c Write your letter, nhấn chọn More items… 

 

Đặt con trỏ text ở vị trí xác định trong văn bản mẫu, nơi c n chèn dữ li u vào, l n lượt 

chèn các field vào trong main document như sau: 
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Nhấn Next sang bước 5, ở bước này nhấn vào n t >> đề xem trước các thư mời tiếp 

theo 

 

Nhấn n t Next sang bước thứ 6. 
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Chọn Print  nếu muốn in các thư mời trực tiếp ra máy in, chọn Edit indidual 

letters nếu muốn xem trước các thư mời trong văn bản. 

 

Trong hộp tho i Merge to New Document có thể chọn t o ra toàn bộ các thư mời có 

trong danh sách hoặc ch  chọn t o thư mời cho một số người. 

b. Envelopes 

T o những bì thư bằng cách Mail Merge. Thực hi n tương tự ph n From letter nhưng 

chọn Envelops thay vì chọn From letter ở bước1. 

c. Labels 
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a. Phím truy cập các Tab và l nh trên màn hình.  

b. Tổ hợp phím không nằm trên thanh Ribbon.  

Nhiều người cho rằng bất kỳ sự kết hợp của một tồ hợp phím nào dẫn đến vi c thực 

thi một l nh đều có thể gọi là phím tắt, về cơ bản thì đ  là một cách nghĩ đ ng. Nhưng 

trong bài này chúng ta sẽ có một định nghĩa chính xác hơn về phím tắt. Xác định sự 

khác bi t rất quan trọng vì từng lo t phím tắt khác nhau sẽ c  phương thức ho t động 

khác nhau. Access Keys (phím truy cập) Access Key cho phép b n truy cập thanh 

Ribbon, nó liên h  mật thiết với các Tab, l nh và những thứ mà b n nhìn thấy trên 

màn hình. B n s  d ng Acces Key bằng cách nhấn Alt rồi sau đ  nhấn tiếp một phím 

hoặc một chuỗi tu n tự các phím.  

Mỗi l nh tr n thanh Ribbon, trong trình đơn của nút Microsoft Office và trên Quick 

Access Toolbar đều có một phím truy cập riêng, mỗi phím truy cập được gán một 

Key Tip. Key Tip là một phiên bản mới của h  thống ký tự g ch chân mà b n quen 

thuộc ở các phiên bản trước khi muốn truy cập các trình đơn bằng cách s  d ng phím 

Alt. Key combinations (tổ hợp phím) Các tổ hợp phím d ng để thực hi n một l nh 

nào đ  và n  không li n quan tới những gì b n nhìn thấy trên màn hình. Các phím 

phải được nhấn cùng một l c để kích ho t các l nh, trong đa số trường hợp, dù không 

phải tất cả, đều có liên quan tới phím Ctrl (ví d  nhấn Ctrl + C để copy). Tổ hợp phím 

không thay đổi trong phiên bản Office 2007, nó ho t động giống h t các phiên bản 

trước. 
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b n c n. Lưu ý: Nếu có một hộp tho i đang mở dùng cùng một ký tự Key Tip với một 

Tab hoặc một l nh trên thanh Ribbon, thì Key Tip của hộp tho i này sẽ được ưu ti n. 

c. Di chuyển bằng phím mũi t n 

Ngoài Key Tip b n c ng c  thể d ng phím m i t n để duy t thanh Ribbon. Đ u 

tiên b n c ng nhấn phím Alt để chọn thanh Ribbon làm ti u điểm, sau đ  d ng các 

phím m i t n để di chuyển: Phím MŨI TÊN TRÁI và MŨI TÊN PHẢI để 

chuyển qua l i giữa các Tab. Phím MŨI TÊN LÊN để chuyển ti u điểm lên 

Quick Access Toolbar (từ đ y b n có thể dùng phím MŨI TÊN TRÁI để di 

chuyển sang nút Microsoft Office). Phím MŨI TÊN XUỐNG chuyển b n vào 

Tab đang kích ho t và b n có thể di chuyển ti p trong đ  bằng cách s  dùng phím 

m i t n.. Một điểm tiến bộ so với phiên bản trước của Microsoft Office là b n có 

thể di chuyển lên / xuống thay vì ch  là trái / phải.  

d. Phím TAB và thanh Ribbon  

B n c ng c  thể d ng phím TAB để di chuyển quanh thanh Ribbon. Sau khi nhấn 

Alt để chọn thanh Ribbon, b n hãy nhấn phím TAB liên t c để di chuyển qua các 

nút l nh theo từng nhóm t i Tab đang kích ho t. 

Sau khi đi một vòng hết các l n trong Tab hi n t i, ti u điểm sẽ được chuyển theo 

thứ tự nút Help, nút Microsoft Office, Quick Access Toolbar, các Tab và quay 

trở l i nh m đ u tiên trong Tab hi n t i. Nhấn Shift + TAB để di chuyển theo 

hướng ngược l i. Khi đến được l nh mà b n muốn, hãy nhấn ENTER. 

Nếu b n từng làm vi c với Mocrosoft Office trong nhiều năm và là một chuyên gia 

về phím tắt, b n thuộc lòng tất cả các phím tắt. Có thể b n sẽ bối rối khi tất cả trình 

đơn và phím tắt c  đã biến mất. Thực ra, thanh Ribbon và phím tắt mới c n có một 

ít thời gian để b n làm quen nhưng một khi đã nắm bắt được b n sẽ đánh giá cao 

nó. 

Nếu b n vẫn không hài lòng và muốn trở l i với các phím tắt c  thì đ y là c u trả 

lời: h u hết phím tắt c  đều vẫn ho t động. Tuy nhiên b n phải nhớ chính xác vì 

giờ đ y không c n nơi nào tr n màn hình nhắc b n c n phải nhấn phím nào. Đ y là 
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Ctrl+T L i những d ng không phải là d ng đ u của đo n văn bản vào 1 

tab 

Ctrl+Shift+T L i những d ng không phải là d ng đ u của đo n văn bản ra lề 1 

tab 

Ctrl+F Tìm kiếm k  tự 

Ctr +G (hoặc 

F5) 

Nhảy đến trang số 

Ctrl+H Tìm kiếm và thay thế k  tự 

Ctrl+K T o li n kết (link)  

Ctrl+] Tăng 1 cỡ chữ 

Ctrl+[ Giảm 1 cỡ chữ 

Ctrl+Shift+> Tăng 2 cỡ chữ 

Ctrl+Shift+< Giảm 2 cỡ chữ 

Alt+Shift+S Bật/Tắt ph n chia c a sổ Window 

Ctrl+Enter Ngắt trang 

Start+D Chuyển ra màn hình Desktop 

Start+E Mở c a sổ Internet Explorer, My computer 

Ctrl+Alt+N C a sổ MS word ở d ng Normal 

Ctrl+Alt+P C a sổ MS word ở d ng Print Layout 

Ctrl+Alt+L Đánh số và k  tự tự động 
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Để khởi t o đối tượng, ta chọn menu Insert rồi chọn nh m đối tượng trong ph n 

Illustrations. 

- Với Picture, người s  d ng phải chọn tranh ở nơi chứa (ví d  trong My Pitures) 

- Với ClipArt, người s  d ng phải chọn tranh trong kho có sẵn của chương trình 

- Với Shapes, người s  d ng phải chọn hình vẽ rồi kích chuột vào văn bản 

- Với SmartArt, người s  d ng phải chọn lo i sơ đồ rồi OK 

- Với Chart, người s  d ng phải nhập số li u 

- Với Word Art, người s  d ng phải chọn mẫu và nhập nội dung 

Sau khi t o đối tượng xong, người s  d ng phải kích chuột vào đối tượng đ  và 

chuyển sang menu Format để định d ng. Đ y là nơi tập trung các công c  để định 

d ng đối tượng vừa t o, bao gồm 

 

 

+ Nh m Adjust: điều ch nh độ sáng tối, độ tương phản, gồm: 

- Brightness: điều ch nh độ sáng 

- Contrast: điều ch nh độ tương phản 

- Recolor: điều ch nh tông màu. Với tính năng này, người s  d ng có thể chuyển toàn 

bộ ảnh thành d ng đơn sắc theo một tông màu nào đ . Đặc bi t, trong đ  c  tính năng 

Set Transparent Color d ng để chuyển một mảng màu trở nên trong suốt (thường dùng 

để lo i bỏ nền ảnh) 

- Compress Pictures: d ng để nén ảnh. Các ảnh nguyên gốc có thể c  dung lượng rất 

lớn (vài MB một ảnh), khi chèn vào trong văn bản thì dung lượng của file Word sẽ 
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bằng dung lượng ký tự cộng với dung lượng của toàn bộ ảnh. Như thế có thể một văn 

bản có kích cỡ lên tới 100MB. Để giảm dung lượng ảnh, ta dùng chế độ nén với 03 

mức: Print 220 ppi - tốt cho khi in ra máy và hiển thị, Screen 150 ppi – hiển thị tốt 

trên màn hình, Email 96 ppi – dung lượng nhỏ - chất lượng hiển thị không tốt 

- Change Picture: thay đổi ảnh 

- Reset Picture: khôi ph c ảnh trở về tr ng thái gốc 

- Nhóm Picture Styles: các chế độ định d ng cho ảnh, gồm: 

- Picture Shape: chọn kiểu khung ảnh (ch  có với đối tượng d ng ảnh) 

- Picture Border: chọn kiểu viền khung ảnh 

- Picture Effects: chọn kiểu hi u ứng cho ảnh 

 

 

+ Nhóm Shape Styles: các chế độ định d ng cho các đối tượng d ng hình vẽ và đồ thị, 

gồm: 

Shape Fill: chọn kiểu nền 

- Shape Outline: chọn kiểu viềt 

- Shape Effects: chọn kiểu hi u ứng cho hình vẽ 

+ Nh m Arrange: căn ch nh vị trí, khoảng cách giữa các đối tượng đồ họa, gồm: 

- Position: Chọn vị trí đối tượng so với d ng văn bản 

- Bring to front: đưa l n tr n c ng 

- Send to back: đưa xuống dưới cùng 
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- Text Wrapping: chọn chế độ d ng văn bản bao quanh đối tượng (bao theo hình 

vuông, bao chặt hay phủ l n tr n  ) 

- Align: d ng hàng các đối tượng được chọn 

- Group: nhóm và bỏ nh m các đối tượng được chọn 

- Rotate: quay, lật các đối tượng 

+ Nh m Size: điều ch nh kích cỡ chính xác các đối tượng 

- Height: điều ch nh chiều cao 

- Width: điều ch nh độ rộng 

- Crop: cắt tranh 

+ Nhóm Shadow Effects: lựa chọn các hi u ứng bóng hai chiều 

+ Nhóm 3-D Effects: lựa chọn các hi u ứng bóng ba chiều 

+ Nhóm WordArt Styles: chọn mẫu định d ng chữ ngh  thuật 

+ Bên c nh menu Format để định d ng chung các đối tượng đồ họa, thì với những lo i 

như biểu đồ, đồ thị còn có thêm hai menu là Design và Layout 

- Design: ch nh s a thiết kế, dữ li u (đối với đồ thị) 

- Layout: ch nh s a giao di n 

Có một điểm c n lưu  , tất cả các tính năng n i tr n của Word 2010 ch  hiển thị khi 

văn bản được t o và lưu theo định d ng Word 2010 (c  đuôi là .docx). Nếu lưu ở định 

d ng Word 2003 thì những tính năng ri ng c  của Word 2010 như các d ng biểu đồ 

đặc bi t, các kiểu định d ng đổ bóng, t o hi u ứng nổi   sẽ bị  n đi. 
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Bước 2  Chương trình sẽ nhắc b n đăng ký tài khoản của blog với ứng d ng. Nhấp 

nút Register now. Nếu b n không gặp hộp tho i y u c u t o tài khoản b n c  thể nhấp 

vào 

n t quản l  tài khoản Manage account tr n thanh công c  Blog Post. 

 

Bước 3  Trong bảng quản l  tài khoản, b n nhấp 

New để t o tài khoản tới tài khoản của Blog. Tiếp đến, b n chọn h  thống blog nào 

b n đang dung, Cung cấp username và password. 

 

Bước 4  Giờ thì b n c  thể so n bài viết của mình tr n Word 2007.  

Sau khi hoàn thành, để xuất bản l n Blog, b n click n t Publish >> chọn Publish để 

đăng bài ngay hay nút publish as draff để lưu l i bản nháp.  

http://www.helloict.com/tag/blog
http://www.helloict.com/tag/blog
http://www.helloict.com/tag/blog
http://www.helloict.com/tag/blog
http://www.helloict.com/tag/password
http://www.helloict.com/tag/word
http://www.helloict.com/tag/blog
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• Nếu style b n muốn không xuất hi n, Chọn Save Selection as New Quick Style 

 

Để đánh dấu các m c: 

• Lựa chọn nội dung b n muốn t o Heading 

• Chọn tab References 

• Chọn Add Text trong nhóm Table of Contents 

• Chọn Level b n muốn áp d ng cho nội dung đã chọn 

 

T o mục  ục tự động 

Để t o m c l c tự động 

• Đặt con trỏ vào tài li u nơi b n muốn đặt m c l c tự động 

• Chọn Tab References 
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• Chọn nút Table of Contents, Chọn vào Insert Table of Contents và định d ng m c 

l c theo cách ri ng của mình. 

 

 

 

Cập nhật Tab e of contents 

Sau khi đã t o ra bảng m c l c cho tài li u, có thể b n phải duy trì nó. Bảng m c l c 

sẽ tự động cập nhật khi tài li u được mở; và c n hay hơn nữa khi n  c ng tự cập nhật 

bất cứ khi nào b n th m t n chương hoặc ti u đề mới vào và làm thay đổi số trang của 

tài li u. Ch  c n thực hi n 2 bước sau: B n cập nhật m c l c bằng cách Click vào tab 

References và sau đ  chọn Update Table trong nhóm Table of Contents.  
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Khi cập nhật bảng m c l c b n sẽ được hỏi rằng b n muốn cập nhật toàn bộ m c l c 

hay ch  muốn điều ch nh số trang.  

 

Chọn điều ch nh số trang nếu b n thêm nội dung làm tăng số trang trong tài li u mà 

không th m ti u đề nào mới, còn nếu b n thêm hoặc thay đổi nội dung ti u đề thì nên 

chọn Update entire table. B n nên tránh vi c s a chữa trực tiếp vào bảng m c l c, vì 

nếu b n đã từng cập nhật bảng m c l c thì b n sẽ mất dữ li u đã thay đổi. Để thay đổi 

nội dung trong bảng m c l c, thì hãy ch nh s a trên tài li u, chứ không s a trực tiếp 

trên bảng m c l c, sau đ  click Update Table. 

Xóa mục  ục tự động 

Để x a m c l c tự động: 

• Chọn tab Referencs trên nhóm Ribbon 

• Chọn Table of Contents 

• Chọn Remove Table of contents. 
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Điều ch nh mục  ục 

B n đã c  một bảng m c l c rồi, nhưng b n l i muốn thay đổi chúng. Ví d  ti u đề 

trong tài li u của b n c  màu xanh nhưng trong bảng m c l c thì không. B n thích 

màu xanh và muốn trong bảng m c l c c ng c  màu tr ng với các ti u đề trong tài 

li u. Có thể bảng m c l c quá dài và b n muốn làm nó ngắn bớt. 

Hoặc c ng c  thể b n đã hài l ng về bảng m c l c nhưng vẫn muốn có một thay đổi 

nhỏ. Chẳng h n b n muốn thay đỗi các đường chấm đứt quãng giữa các đề m c và số 

trang. Hoặc b n muốn số trang nằm g n các đề m c hơn. 

Thiết kế   i bảng mục  ục 

B n đã c  bảng m c l c, nó trông có vẻ ổn, nhưng b n muốn màu sắc tương tự như 

ti u đề. Đ y là cách thực hi n: Trên Tab References, chọn Table of Contents trong 

nhóm Table of Contents và sau đ  chọn Insert Table of Contents. 

Trong hộp tho i Table of Contents, chắc chắn rằng m c From template đã được 

đánh dấu trong hộp Formats, sau đ  chọn Modify. Chọn TOC 1 trong hộp tho i 

Style để chọn cấp độ cao nhất hoặc Level 1, trong bảng m c l c TOC và sau đ  chọn 

Modify. Hộp tho i Modify Style được mở ra, s  d ng hộp màu Font trong ph n 

Formatting để chọn màu xanh. Sau khi click OK hai l n, hãy xem trong m c Print 

Preview của hộp tho i Table of Contents và b n sẽ thấy rằng Table of Contents, hay 

c n được viết tắt là TOC 1 (hay Level 1), bây giờ là màu xanh. Nếu b n muốn thay 

đổi TOC 2 (Level 2) hay TOC 3 (Level 3) c ng thành màu xanh, thì b n c ng làm 

theo quy trình trên bằng vi c chọn TOC 2 hoặc TOC 3 trong hộp tho i Style trước khi 

đi đến hộp tho i Modify Style. Sau khi click OK, một hộp tho i xuất hi n với nội 

dung hỏi b n có muốn thay đổi bảng m c l c hay không, click OK và kết quả sẽ hi n 

thành màu xanh như   muốn của b n. 

B n muốn thay đổi nhiều hơn nữa? Word 2010cho người dùng nhiều tùy chọn để chọn 

lựa trong hộp tho i Modify Style, nhưng hãy luôn nhớ chọn Style mà b n muốn thay 

đổi trong hộp tho i Style trước khi thực hi n chức năng Modify Style. Chú ý rằng khi 

click Format, b n sẽ có lựa chọn thay đổi như Font, Paragraph, Tabs,   b n c ng c  
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thể thay đổi các cài đặt của từng ph n và xem l i chúng trong m c Preview trước khi 

áp d ng cho bảng mục lục. 

Cách làm ngắn hoặc kéo dài bảng mục  ục 

 

Bảng l c l c quá dài, có lẽ ch  c n hai cấp độ đ u tiên TOC 1 và TOC 2 là phù hợp 

với tài li u của b n. M c Show levels ở hộp tho i Table of Contents là nơi b n có thể 

chọn các phân cấp b n muốn thể hi n trong bảng m c l c. Word 2010c  đến 9 cấp độ 

khác nhau. Làm ngắn bảng m c l c bằng cách giảm cấp độ, còn muốn kéo dài bảng 

m c l c thì b n hãy tăng cấp độ lên. B n có thể xem trong Print Preview hoặc Web 

Preview để xem sự điều ch nh của mình, khi nhận thấy hợp lý, thì click OK hai l n. 

Cách thay đổi đơn giản bảng mục  ục 

B n có thể thực hi n các thay đổi nhỏ mà không c n rời khỏi hộp tho i Table of 

Contents. Chẳng h n thay đổi các g ch đứt quãng giữ các đề m c và số trang (gọi là 

Tab Leader), hoặc thay đổi canh dòng (align) của số trang. 
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Khi c  h m thư e-mail do một máy chủ hỗ trợ (theo giao thức IMAP hoặc POP3), b n 

c  thể d ng Outlook Express, Microsoft Express. Hòm thư webmai  của Goog e 

(Gmai ) hay Yahoo cũng hỗ trợ giao thức POP3 (nhưng Yahoo ch  dùng được 

tính năng này ở bản đóng phí). 

Các bước thực hi n như sau: 

- Mở một tập tin muốn g i 

- Vào menu File > Share > Send Using E-mail. Chọn tiếp một kiểu để gởi email 

Như đã n i ở tr n, l nh này ch  thành công khi Word phát hi n một h  thống e-mail 

tương thích và ho t động khi các chương trình đ  đã được cài đặt. 

- L c này giao di n g i thư hi n ra với các d ng như To..., CC...., Subject... Nếu 

không nhớ e-mail của người g i, b n nhấn vào biểu tượng hình quyển vở để đọc sổ 

địa ch  và chọn > OK. 

- Biểu tượng c  dấu m i t n màu xanh và dấu chấm than sẽ gi p b n đặt e-mail g i đi 

của mình ở cấp độ ưu ti n nào (thấp, bình thường, cao). B n c ng c  thể đính kèm các 

file khác ngay tr n môi trường Word bằng cách nhấn vào biểu tượng chiếc kẹp ghim. 

- Sau đ , nhấn vào m c Send a copy. 
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Chọn New Tab, l n lượt đổi tên thành Tab Caculator, và group Tinh Toan 

Ở cột Choose commands from, chọn All commands, di chuyển thanh cuốn chọn 

Tools Calculate. Nhấn nút Add để thêm vào biểu tượng vào Tab Caculator 

Kế tiếp, b n hãy nhập vào một ph p tính, chẳng h n ((90+10)*2)/50. Hãy đánh dấu 

khối ph p tính này rồi nhấp chuột l n n t Tools Calculate. Kết quả của ph p tính sẽ 

được trình bày ở g c dưới trái của c a sổ so n thảo văn bản (nằm ngay sau dòng 

chữ The sesult of the calculation is).  
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nút Trust Center Settings 

 

Và nhấn vào Privacy Options.  Sau đ  nhấn chuột đánh dấu m c Warn before 

printing... và bấm nút OK. 

 

             

Ngoài ra còn có một cách định d ng khác đối với những tài li u mang nội dung riêng 

tư, đơn giản đ  là giải pháp không cho in văn bản ra giấy. B n c n lựa chọn toàn bộ 

trang văn bản (Ctrl+A), sau đ  bấm nút chuột phải và chọn m c Font trong trình đơn 

thả, đánh dấu vào m c Hidden rồi ấn nút OK.  
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Kết thúc bước này, nội dung văn bản của b n đã được  n đi. Để hi n l i trên màn 

hình, b n vào Tab File/Options, nhấn đánh dấu m c Hidden text sau đ  đừng quên 

nhấn nút OK.  

 

Hoàn thành bước này, toàn bộ nội dung văn bản hiển thị trở l i trên màn hình tuy 

nhiên nếu in b n sẽ ch  được kết quả là trang giấy trắng.  


